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1 
Welcome 

Welcome to e-MDs’ premier suite of office automation tools! e-MDs Chart is our full-
featured longitudinal electronic medical record, offering rapid, complete clinical 
documentation (with integrated ICD, CPT, and HCPCS coding), prescription and 
medication management, referral/consult letter generation, and automated E&M 
coding. Your practice management needs are exceeded with the e-MDs Bill and e-
MDs Schedule applications. All applications reside in a common database, with no 
data bridges, affording remarkable flow of information from one module to another. 

In addition to those fundamental programs, other modules improve workflow 
processes, enhance communication, and enable the office to truly operate in a 
paperless environment. 

Because of their tight integration with Chart module functionality, Fast Forms, 
Tracking Board, and the Rules Engine are described in the this user guide.  See the 
e-MDs Solution Series Utilities Guide for information on using the following tools: 

• DocMan 

• TaskMan 

• Snapshot (Digicam) 

• Forms/Letter Builder 

• Spell Checker 

• Signatures 

• Continuity of Care Records (CCR) 

• Continuity of Care Documents (CCD) 

Visit us at http://www.e-MDs.com to check out our latest product offerings! 

Continued on the next page... 

 

http://www.e-mds.com/�
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Using This Guide 
This guide leads you from the beginning of an office visit through the visit conclusion when billing is 
enabled.  Using Chart you can track and code a patients medical information and provide prenatal, 
maternity and postnatal care.  This guide also details Chart's prescription processing, lab interfaces, and 
telephone interactions with patients. 

As you go through this guide, you will notice that each set of steps to perform a task begins with an 
indented heading starting with "To" and ending with a colon (:).  That heading is then followed by indented 
steps to be performed in a prescribed sequence.  For example, after a brief overview of why you will add 
a health problem from a template to a patient's chart, the procedure looks like the contents of the 
following box: 

To add a problem from a template: 
1. With a visit note open, click the template launch icon  to the right of the Current Problems 

header in the note. 

2. Select the Current Problems template from the Template Link window. 
 

The template is organized by body system (for example Heart, Lungs, Bones/Joints, etc.).  A 
question that has a Current Problem Extended Attribute linked to it will display a stethoscope icon 

 at the right. 

3. Navigate to the diagnosis you want and select it by clicking the question. 
OR 
Select multiple problems, if needed. 

4. Close the template and the diagnosis will drop into the Current Problems list. 

Related Documentation 
Documentation for Solution Series modules is provided in PDF (Portable Document Format) files for 
viewing and printing individually, and in Help format for easy access from each product module.  Both 
formats and access methods provide the same information.  The documentation library is updated 
extensively for each major product release as well as updated and corrected periodically, as needed.  For 
the latest version of any Solution Series documentation, go to the documentation section of the e-MDs 
Support site at Online Support > Downloads > Documentation. 

The following documents are available to all Solution Series users: 

• e-MDs Solution Series Administration Guide is your starting point for initializing and customizing 
Solution Series modules for use in your organization.  This guide provides step-by-step 
instructions for licensing your software, adding system users and defining access levels, adding 
and modifying user groups, and setting up default handling of various module tasks. 

• e-MDs Solution Series Bill User Guide provides instructions for working with insurance codes and 
electronic claims, setting fee schedules and rules, defining policies, posting and billing 
transactions and reversals, and performing numerous other practice management tasks. 

• e-MDs Solution Series Formulary Benefits User Guide describes how to determine the pharmacy 
benefits and drug copays for a patient’s health plan, determine if a prescribed medication is 
covered (in formulary) under a patient’s plan, display therapeutic alternatives with preference rank 
(if available) within a drug class for non-formulary medications, determine if a patient’s health plan 
allows electronic prescribing to mail order pharmacies, and download a historic list of all 
medications prescribed for a patient by any provider. 

https://supportcenter.e-mds.com/ics/support/default.asp?deptID=3222�
https://supportcenter.e-mds.com/ics/support/default.asp?deptID=3222�
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• e-MDs Solution Series Installation and Upgrade Guide leads you through the preparation of your 
site for Solution Series, the database and application installation steps, and post-installation 
configuration.  If Solution Series is already installed at your facility, use the update instructions 
provided to update your system. 

• e-MDs Solution Series Schedule User Guide leads you through scheduling and tracking 
appointments, setting up and modifying patient accounts, blocking time on the calendar to restrict 
appointment scheduling, checking patients into the facility and tracking their progress through 
each encounter with a provider, and checking eligibility. 

• e-MDs Solution Series Reports User Guide lists the reports available through Solution Series.  A 
description of each report is provided, along with the location of the report within Solution Series 
modules, the available fields and filters used to select specific data for the report, and samples of 
most reports, illustrating what you can expect when running a report at your facility. 

• e-MDs Solution Series Utilities Guide covers tools and utilities that may be used with various 
Solution Series modules.  This includes using: 

○ DocMan to graph lab results, process incoming faxes, and generate and send documents to 
patients and external resources such as specialist referrals and labs. 

○ TaskMan to automatically send messages, implement secure e-mail, and track tasks to be 
performed within Solution Series. 

○ Snapshot/Digicam to capture images of patients/staff and add them to patient and user 
records. 

○ Forms/Letter Builder to generate, print and send forms and letters from within Solution 
Series.  This includes the use of Microsoft Word and the e-MDs database to create 
customized/merged letters and documents. 

○ Registry Processor to create, view, distribute and print customized reports based on patient 
demographics and healthcare records. 

Additional documentation is also available on the e-MDs Support site for performing specific tasks and for 
using e-MDs interface products for working with labs and other organizations.  See the e-MDs Support 
site for access to the latest versions of these documents. 

Getting Additional Help and Information 
e-MDs realizes that one of the most important elements of any software system is the support services 
backing it up. There are a number of support resources available to help you optimize the use of your 
system and participate in the e-MDs community.  

Help Screens 
Help is accessible on each Solution Series application and module by going to Help > Search Topic on 
each application's top toolbar.  Related help files, such as this guide, the Utilities Guide, and the Reports 
User Guide, are generally accessible from the same help screen.  After opening each help file, you can 
use the table of contents, index or search function to locate the specific information you need.  

Online Help files are also available through the application toolbar for Portal applications by clicking the 
question mark. The following Help is available for the Portal application: 

• e-MDs Patient Portal: The Clinic’s Guide to Using the Portal provides instructions for maintaining 
user access on a Patient Portal, working with patient appointments scheduled through the Portal, 
communicating with patients through a Portal e-mail interface, processing prescription refill 
requests, and auditing Patient Portal usage. 

https://supportcenter.e-mds.com/�
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• e-MDs Patient Portal: The Patient’s Guide to Using the Portal instructs patients on the use of the 
Patient Portal to communicate with their healthcare provider, view their own healthcare 
information, and submit requests for appointments and prescription refills.  This HTML file is 
provided on your Patient Portal for easy online viewing or printing by patients. 

User Guides 
The e-MDs Solution Series user guides contain comprehensive information about all standard product 
functions. This includes dealing with many of the complex situations that can arise in a medical office. 
Use the table of contents, index or search option to locate items of particular interest.  These guides are 
very similar to the application help screens.  See Related Documentation for a brief description of the 
Solution Series user guides available. 

Solution Series guides are always available in electronic format (Adobe .pdf files).  You can put copies on 
each computer in the network.  You can download the Adobe Acrobat Reader for free from 
www.adobe.com  Updated user guides are included on the CD-ROMs you will receive with each upgrade, 
as well as on the support pages at www.e-mds.com.   

To download files from the e-MDs Support site, you will need your clinic password.  Instructions on how to 
apply for a password are on the Web site.  Only one password is issued per customer account, so please 
ensure you communicate this to your staff. 

Using the e-MDs Support Center 
The e-MDs Support Center is an online customer meeting place for clients with an active account.  It is 
accessed from the Support pages at www.e-MDs.com or 
http://supportcenteronline.com/ics/support/default.asp?deptID=3222 .  If you don’t have an account, you 
can request one by using the Request New Account button on the login page.  We strongly encourage 
each staff member in a clinic to have their own logins instead of one generic one for all people.  The 
primary reason for this is that when we need to push information such as update notifications it is sent to 
everyone meaning there is a smaller chance that the information will not be disseminated such as if 
someone is sick or ignores the message. 

Support Center includes the following tools that can be of great assistance to helping your practice work 
more efficiently with the e-MDs Software: 

• Forums/Newsgroups: The online forums are an e-MDs User Community where you can post 
messages related to support, general discussions, suggestions, tips and more.  It is a great non-
urgent support tool and is also searchable.  You can subscribe to various forums that interest you 
and get an e-mail notification if someone posts to them.  You can also elect to get an e-mail if 
someone posts to a specific message.  This is really useful if you post a question and want to 
know when it is answered.  Support forums are monitored by the e-MDs support team and a 
number of our customers also chip in with their knowledge. 

• Downloads: Downloads include shared templates for Chart, Word Forms, reports, updates to 
content such as ICD and CPT codes, bug patches, etc. 

• Knowledge Base: The knowledge base includes an extensive list of articles that you can use for 
troubleshooting, setup and so on.  These are generally posted based on questions from 
customers. 

• Troubleshooter: This search utility makes it easy to quickly locate the information you’re looking 
for.  It cross-references multiple parts of the support center and returns hyperlinks to articles, 
downloads and the like. 

• Surveys: Occasionally e-MDs will gauge your opinions about something via surveys which can 
be distributed via Support Center. 

• “Push” e-mails: If we want to let you know about something, we can push information to you 
from Support Center.  

http://www.adobe.com/�
http://www.e-mds.com/�
http://www.e-mds.com/�
http://supportcenteronline.com/ics/support/default.asp?deptID=3222�
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2 
Getting Started with Chart 

The Solution Series applications work together to perform your healthcare record 
management and practice management tasks.  For that reason, it may sometimes be 
difficult for newcomers to understand where one application ends and another begins.  
Sometimes you may not know exactly where to go for the information you need to 
perform specific tasks.  To help you get started, we are dedicating this chapter to an 
overview of Chart and how you can begin working with patient charts.  We will not try 
to tell you everything in one short chapter, but you should have a better idea of what 
you are dealing with after reading through this information.   

After reading this chapter and looking at the corresponding Solution Series screens, 
you should be able to log on, open Tracking Board and Chart, add a new patient 
account, check a patient into the facility, open and update a Visit or Order Note, and 
check a patient out.   

Note that the overview provided in this chapter does not take the place of formal 
training in Chart or related modules.  It just lays some very basic groundwork for the 
remaining chapters in this guide.  After you have dipped your toe in the water, you 
should be ready to forge ahead with instructions for performing the specific tasks 
described in later chapters and other e-MDs Solution Series documentation. 

Continued on the next page... 
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Using the Dashboard 
The Solution Series Dashboard is a platform that hosts applications/modules.  You do not have to use it, 
but there are several advantages. 

• User Application and Toolbar Preferences: Dashboard remembers your preferred applications, 
whether to open them automatically or not, and your preferences for where buttons should be 
located on the Dashboard toolbar. 

• Multiple User Sessions: Dashboard also permits multiple sessions of certain applications to be 
run on the same computer for different logins.  This accommodates the workflow in many 
practices where multiple users share a computer.  One user can log in and start working on 
his/her set of tasks, use various modules, and then log out.  When the next user logs in on the 
same computer, that user will see his/her own set of preferences and, in some cases, can be 
using exactly the same module but for a different task.  It is worth noting that, because multiple 
instances of modules may be started, this can affect memory.  If that happens, Dashboard will 
notify the user trying to log in that there is not enough free memory to run modules optimally.  
Dashboard does not know what effect third-party applications have so, if you have a lot of system 
sharing with many users, consider adding more than the minimum memory required per 
workstation. 

Logging in and Setting Application Preferences 
Dashboard is the default entry point for any e-MDs Solution Series environment.  The e-MDs shortcut 
icon on the desktop automatically loads Dashboard. 

To log in to and out of Dashboard: 
1. Double-click the e-MDs desktop 

shortcut.  

2. Enter your user name and 
password.  

3. If necessary, verify that you are 
pointed to the correct login group 
(database and server) by clicking 
the button with the downward 
arrows.   

4. Click OK.  Dashboard starts. 

There are several ways to log out: 

○ Simple Log Out: Click the 
button at the top-left of the 
Dashboard bar with a gold key icon , or click the minimize button at top-right.  This 
minimizes everything and presents a login window.  It does not close modules so, if the same 
user logs in again, the system returns to the last place that user worked for most applications.  
If another user logs in, the new user’s preferences are loaded in a different session. 

○ Close Session Applications Without Shutting Down: To log out of a session completely 
and close all the modules you’re using, click the button next to it with the gold key with boxes 
behind it .  The system attempts to close all modules correctly.  In some cases a particular 
task will prevent it from doing this.  When this happens, a window appears showing the logged 
in user sessions and the applications they are running.  It is best to note the ones in your user 
“tree”, then click “Do not shutdown”, then go into the different modules and close them 
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correctly.  Once all modules are closed down, the system minimizes and shows the login 
window again. 

○ Exit: To close Dashboard completely, click the X at top right.  Dashboard attempts to close all 
modules gracefully.  If it cannot close them, it shows which are still running so you can 
complete any processes and then try to close again. 

Note that setting the Run > Options timeout value is a way to execute a simple logout and preserve 
security should a user forget to minimize or log out. 

To set up Dashboard applications and preferences: 
1. Click Run.  A menu of applications appears.  The list is determined by how many of the 

Dashboard security privileges were added for the user.  If applications are on the list but are 
grayed out, it usually means that the program file was not installed. 

2. Click an application to add a button for it to the Dashboard bar.  Repeat for additional modules.  
You can add any modules you wish but may have to scroll to see the buttons for these in the 
Dashboard bar depending on the number and your screen resolution. 

3. When you add applications from the Run menu they are also started at the same time.  The next 
time you log in, you will see this application button on the bar too.  You can click a button at any 
time to toggle to the module. 

4. You can right click a Dashboard application button to load a menu that provides further 
customization options. 

Dashboard Button Options: 

○ Button Order:  The Move option lets you set the order of applications in the bar. 

○ Auto Run:  To start the application automatically when you log in to Dashboard, click this 
option.  A check mark appears to the left of the Auto Run option for those with this property.  
Click it again to undo.  If you typically use several applications during a session, it’s a good 
idea to set this for all of them.  Although it will take slightly longer to open the system it saves 
you from waiting a few seconds the first time you click each button to go into the application.  
The application you typically use first should be moved to the right of the bar since Dashboard 
opens them left to right.  It’s also a good idea to open any modules that have task counters 
(e.g. TaskMan, Order Tracking, Refill Requests, Phone In Scripts) since the counters are only 
displayed when the application is running. 

○ To remove an application from the bar, make sure it is closed.  (Buttons for open 
applications have a yellowish background.)  Then right-click the button and click Remove. 

To set Dashboard options: 
To set the Dashboard options, click Run then Options.  There are four options that can be set. 

• Time Out: The timeout feature for Dashboard minimizes the application after a user defined 
period of inactivity.  This period of inactivity is based on the time (in seconds) entered into the 
timeout field. Once the application minimized the user is required to log back in to reopen the 
application. This is a security feature to prevent viewing or manipulation of information when the 
machine is not being used.  

Note:  This setting overrides the timeout settings for the other modules that run in the 
Dashboard. 

• Dashboard Button Colors: This option lets you set the background color for Dashboard buttons 
so they are more apparent than the pale yellow color that is used by default.  Be aware that the 
color you select does not affect the red or black button label colors so you’ll need to find a color 
that works with them. 
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• SmartID: This is a special interface that is being used on a very limited basis. You can disregard 
it unless you have installed and are implementing that interface. If you are implementing SmartID, 
follow the instructions in the documentation provided at the time of installation. 

• Search Bar: This option allows you to enable or disable an Internet search from the Dashboard. 
This Search Bar allows you to search a designated online repository for medical information. By 
default, the Search Bar Enabled check box has been selected (activated). To disable this option, 
click the check box to deselect it. The Search Bar will appear on the Dashboard only if it is 
enabled on this screen. 

The UpToDate option is set as the default search engine. If you prefer a different option, click the 
down-arrow in the Default Search Engine field and select a different search engine.  

Click Save to retain any changes made on this screen. For instructions on using the Search Bar 
after it is enabled, see Searching External Databases for Medical Information. 

Understanding Dashboard Sessions 
As explained previously, you can run multiple sessions of Dashboard for different users on the same 
computer.  In some cases, different instances of the specific modules are run in system memory, but for 
most of the clinical modules this is not the case.  Depending on the number of users logging in on a 
computer as well as the number of modules they like to run, this can obviously take up memory.  
Eventually the system will notify a user trying to log in that there is not enough free memory to operate 
optimally.  If some modules have been swapped to disk for a logged out user, it may take a little longer to 
start up again but that is temporary.  Of course, this is not really an issue for users with a dedicated 
computer or tablet. 

The log out options described about can optimize the system.  For example, logging out and closing 
applications frees up resources for the next user faster. 

You can see which users are logged into a computer as well as the number of modules that they have 
open and memory usage by clicking Run > Sessions.  Shared Memory indicates modules that don’t have 
separate sessions for each login. 

It is very important that you close all your applications correctly when decide to completely end your 
session.  This means you must click the button for each application, then close any open processes.  To 
be sure, use the Exit function within the module.  If another user has an open session on the computer, it 
can be closed by going to the Run > Sessions window, selecting the user and clicking the button with the 
red X. 

To see the details of the sessions for a user, select the line then click the View Details button.  This 
shows the specific module and how much memory it is using. 

Searching External Databases for Medical Information 
The Solution Series Dashboard provides a method of accessing online resources for medical information 
without leaving the application. This option is enabled by default, but can be suppressed if a user prefers 
or if your facility does not have an account that allows you to access those sites. The following resources 
are currently supported through this feature: 

• UpToDate is an online repository of medical information that has been submitted, peer-reviewed 
and is maintained by expert clinicians. See http://www.uptodate.com/home/about/index.html for 
more information. 

• Physician's Desk Reference (PDR) is a commercially published compilation of manufacturers' 
prescribing information on prescription drugs, updated annually. The PDR Network is the online 
source for that guide. See http://www.PDR.net for more information. 

• Apixio: See http://www.apixio.com/ for more information. 

http://www.uptodate.com/home/about/index.html�
http://www.pdr.net/�
http://www.apixio.com/�
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Note:  You must have an active membership to access these databases. When you use the search 
function to go to those sites through the Dashboard for the first time, you will be prompted to provide 
your account information. 

• WebEx option will open a web browser to the e-MDs Webex website conveniently from within the 
Solution Series application. This allows you to quickly begin a Webex session with the e-MDs 
Support Team if necessary. 

To search an online resource through Dashboard: 
1. With Dashboard active on your desktop, locate the Search Bar in the upper-right corner of the 

Dashboard. 

2. If you prefer to search a different resource rather than the default search engine, click the down-
arrow next to the search engine icon and select a different option. Note that the search engine 
icon will change to reflect the currently-selected search engine. 

 
3. Type your search string in the field and click the search engine icon immediately after the search 

field (or press Enter on your keyboard).  

Using your default Internet browser, a new window will open at the selected site. 

Note:  If this is the first time you have accessed the site, you will be asked to enter your account 
information to register. 

4. Review the information that is returned or begin a new search on the site, as needed. 

5. When you have completed viewing the information, close the browser window.  

Note:  If you want to disable the Search Bar, select Options from this drop-down list to go directly to 
the Chart Options screen. To disable this option, click the check box next to Search Bar Enabled to 
deselect it, then click Save. The Search Bar will disappear from the Dashboard. 

Opening Chart from the Dashboard 
Before performing the tasks in this guide, you must log in to Chart. This is most frequently done from the 
Dashboard (or from the Tracking Board, as described below). 

1. Double-click the desktop shortcut. 

2. Log in using your Solution Series user name and password. 

3. Click OK.  Dashboard starts. 

4. Click the Chart tab on the toolbar.  

 
OR 

If the Chart tab does not currently appear on the toolbar, click Run and select Chart from the 
drop-down list.  
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Opening a Patient's Chart from Tracking Board 
If a patient’s name appears anywhere within Tracking Board (such as in the Waiting Room, in an exam 
room, or Checked Out), click it and select Open Chart. 

To open any other patient, click File and then select Open Patient Chart. Or, click the Open Patient 
Chart button (the first button on the toolbar, with the yellow chart icon). Search for the patient, select the 
name from the search results, and click Select. 

Adding New Patient Accounts 
Note:  Because patient records may already exist in your system for individuals that indicate they are 
new patients, you must always search the database for potential existing accounts before adding a new 
patient.    Therefore, when adding a new patient, first follow the patient search procedure below and then, 
if a match is not found, perform the new patient addition steps that follow. Failure to search for an existing 
patient before adding a new account may result in duplicate accounts that will ripple through the system, 
affecting everything from patient health records to lab reports and financial accounting.  

To search before adding a new patient: 
1. On the main e-MDs Chart toolbar, click Demographics and then select the Patients menu 

option.  

OR 

Click the yellow folder icon near the upper left corner of e-MDs Chart. Either method will open the 
Find Chart Patient window. 

Note:  Pressing Cancel at any time during the search process will return you to the Find Chart 
Patient window. 
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2. Type at least the first few characters of the patient’s last name in the Name field.  This can be as 

little as one letter (A, C, F, etc.) or as much as the patient’s full last (Smith, Jones, Rodriguez, 
etc.). 

3. Click Search to list any patients that match the search criteria.  The names of matches that are 
found display on the screen in the top patient list. 

 

Note:  When searching for a patient, you may prefer to select a value in the Alternate ID field to 
list only patients that have a specific Alternate ID assigned to them.   
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4. If possible matches are found, review the list to determine if the patient may already have an 
account in the system.  Since Social Security numbers are unique, check that column first.  If you 
find a close match, select that name and then click Edit to open the Patient Maintenance window 
to view that patient’s information. 

○ If the selected chart appears to be a valid match, verify the chart information with the patient to 
ensure it is indeed the same person.  If it is the same person, update the Patient Maintenance 
screen as necessary and save the changes.  Since a valid match was found, it will not be 
necessary to create a new account. 

○ If the selected chart is not a valid match upon further investigation, close that window to return 
to the Find Chart Patient window and repeat this step for any other possible matches.  
Continue with step 5 below. 

5. If no valid matches were found on your system, continue with “To add a new patient after 
searching.” 

To add a new patient after searching: 
1. Return to the Find Chart Patient window and click New to open the Patient Maintenance window. 

2. Begin to enter a first or last name on the screen. 

At this time, Chart will automatically perform a secondary search to determine if another person  
already in the system may match the information appearing on this screen.   

3. If a matching person is found, you will be prompted to accept or reject the matching person’s 
information.  If you accept that information, the Patient Maintenance screen will be updated with 
the found person’s information, overwriting any information in prepopulated fields. 

OR 

If a matching person is not found, or if you reject a found person’s information, nothing will be 
changed on the screen. 

4. Continue inserting information in any blank fields on the Patient Maintenance screen.  The only 
required fields (under all tabs) are the patient’s name, date of birth, and gender.  For an overview 
of the fields of note for this screen, see Patient Maintenance Window Options. 

5. Click Save to update and close the Patient Maintenance window. 

Patient Maintenance Window Options 
General Tab  
Prefix, Suffix Form of address and following letters. 
Last, First, Middle If a last-first name combination that already exists for another person entity is 

entered, a system prompt asks if you wish to view matches. 
Display This is for nicknames or other names by which the person prefers to be addressed 

and is displayed in e-MDs Chart and on patient super bills. 
Birth/Maiden Name Self explanatory; searchable field containing patient's birth name. 
Date of Birth Self explanatory.  If a patient is less than 2 years old, additional fields appear for 

Time of Birth, Normal Birth and Premature check box options, and fields to enter 
Gestational age at birth.  These values are used for plotting preemie growth charts 
in e-MDs Chart. 

Gender Self explanatory.  The gender is set automatically if one has been designated under 
the Options tab for the internal medical facility in which the patient is added. 

Race Use this field to select the patient’s race.  This information is particularly helpful in 
diagnosing conditions that are prevalent with some races and for gathering 
statistical information for various reports.  See To designate a patient’s race as 
multi-racial for instructions on specifying more than one race for this option. 
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Ethnic Group Select the main ethnic origin that the patient associates with his/her heritage.  To 
select Hispanic subgroups, select Hispanic or Latino, click the Search button, then 
select the appropriate subgroup. If an appropriate option is not listed, you can leave 
the field blank (<none>) or select Declined. 

Language Select the language most commonly spoken by the patient.  This will help identify 
the need for an interpreter if the patient’s primary language is not normally spoken in 
the clinic. 

Account Number Set automatically based on the internal medical facility account numbering options. 
SSN` Other than a blank field, duplicates are not permitted for person records. A warning 

appears if a duplicate is entered. 
Guarantor Click Self to automatically create a guarantor account with the same information 

contained in the patient’s demographics.  This automatically sets the relationship 
field to Self.  If the guarantor is someone other than the patient, click the magnifying 
glass to search for or create a different guarantor, then set the correct relationship.  
It should be noted that the guarantor is not always the policyholder, although it is 
used as a default to save time when adding insurance for the patient.  For billing 
purposes, this is the financially responsible party in the event that insurance does 
not pay.  It may be the patient, or a child’s parent, or an elderly adult’s child.  It might 
also be a legal entity for personal injury patients, or an employer for corporate 
patients. 

Relationship to Guarantor If the patient is the Guarantor, leave this option with Self selected.  However, if the 
Guarantor is someone other than the patient, use the drop-down list to select a 
different relationship. 

Primary Provider If the appointment is being made for a provider resource, the provider should be set 
to that person’s name. Otherwise, select a default for the patient either by typing 
letters to filter the list, or clicking the magnifying glass to search.  The system adds 
this person automatically as the DOS Provider when generating invoices that are not 
from Chart. 

Address Lines 1 & 2 Self explanatory. 
Zip Upon entering a known zip code, the system automatically fills in the City and State. 
Phone Numbers Solution Series provides space for up to three phone numbers for each account.  To 

designate one of these phone numbers as the favorite/preferred phone number, 
click the star-shaped button next to the field.  Only one phone number can be 
designated as the favorite phone number.  By default, the first phone number 
entered will become the "favorite" phone number or, if only one number is provided 
for the account, that number will be the favorite phone number.  If additional phone 
numbers are added to the account, the option to select a favorite number will be 
activated and a different number can be selected, if desired. 
• Phone (H): If a number is entered that is already in the system for other person 

entities, the address details are filled automatically.   
• Phone (Cell): Self explanatory. 
• Phone (Work): Self explanatory. 

E-Mail An e-mail account is required for access to the e-MDs Patient Portal.  This e-mail 
address will receive messages that are sent from the portal regarding appointment 
reminders, appointment confirmation and history forms needed prior to the next 
appointment. 

Preferred Contact Method Use this option to designate a patient's preferred contact method.  The available 
options are Phone, Text Message, Mail, Email, Secure Email, and Patient Portal.  
When a contact method is selected here, the corresponding information field must 
already be populated with the appropriate information.  For example, if Phone is 
selected as the preferred method, at least one phone number must be provided for 
this account.  If the related information is missing for a method selected here, an 
error message will display when this option is selected. 
Note:  If the patient is not an active Portal patient, the Patient Portal method will 
be unavailable for selection here. 
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Preferred Reminder 
Method 

Use this option to designate a patient's preferred contact method for reminders.  The 
available options are Cell Phone, Cell Phone Only, Home Phone, Home Phone 
Only, Office Phone, Office Phone Only, Mail, Mail Only, Email, Email Only, 
Patient Portal, and Patient Portal Only.  As with the Preferred Contact Method 
option, the corresponding information field must be complete for the method 
selected and the Patient Portal methods will be disabled for patients who do not 
have active Portal accounts. 
Note:  The available methods listed for this option are very specific to avoid 
excessive reminders going to patients using multiple methods.  If a method 
indicating "Only" is selected, no alternative method should be used to remind the 
patient of upcoming appointments or procedures. 

Financial Group Extremely important field for e-MDs Bill users.  Select the Financial Group Code 
(such as MDC, PPO,  HMO ) that identifies the type of financial resource being 
used. This code is also used when filtering accounts for reporting purposes. 

Type of Patient Patients can be assigned to one of the types set up in the Patient Type reference 
database. The background color of any appointment for the patient is filled with this 
to alerting users about any special conditions that apply to this type. 

Default Referral Set a default referral for a patient if required. If the patient is Medicare, and this is 
primary care clinic, the field should be set to the same person as the Provider to 
default on claims with lab or diagnostic tests. When the record is saved, a 
referral/authorization for the patient is created under the Tools > 
Referral/Authorization work list and appears in red for which there can only be one 
for a patient.  The default referral is used on claims unless another one is created for 
a specific authorization, or the User Provider as Referral if None Set option in the 
Bill > Options window is checked. 

Marital Status Select from the list. A faster method is by starting to type the start letters of a known 
status and then pressing tab when it is highlighted. 

Driver's License No, Date 
Expired, State 

The driver’s license information is useful for skip tracing in e-MDs Bill.  To store an 
image of the driver’s license, click the camera button at the end of the field.  This 
loads a window in which the image(s) can be stored.  You can capture the image 
directly from a scanner or camera using the scanner button above each image 
section (see the help on the Image Capture tool).  You can also import an image by 
clicking the folder icon to open a window from which you can browse for and select 
a .jpg image previously scanned.  To clear an image, click the button with the minus 
sign in the scans window.  The Driver License Photos and the Patient Maintenance 
window can be positioned side by side so you can open the driver license image 
and then type the information into the demographics at the same time. 

Insurance To add an insurance company, click the Add button. A search window for insurance 
companies appears. Search for an insurance company and select a group to return 
to the Patient Insurance Maintenance window where the policy number, as well as 
effective dates and images of the insurance card can be added. Click Save.  For 
expanded help, see the “Patient Insurance” section below. 

  

Addresses Tab  
Self explanatory.  If necessary, insert additional addresses and phone numbers for the patient. The ones added in 
the General tab will appear here when the record is saved.  Each one added here must be given a type. You can 
insert an unlimited number for any entity, although most reports will use specified types.  If you add two addresses 
of phones for a patient of the same type, the one with the Primary flag set to Y will be used, where necessary, for 
reporting and other display purposes. 
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Misc. Tab  
External Medical Facility The default external facility where the patient is treated should they be hospitalized, 

in a nursing home, etc. Having a default external facility set can save a great deal of 
time during daily operations.  It will preset the facility for a patient when scheduling 
rounds visits, and is also used by e-MDs Bill to prefill insurance claim forms where 
the place of service is not home or office.  In both cases, users can change the data 
for the round or claim if it is not the default. 

Alternate FileID A place to store a different record number such as a medical chart number, or a 
number used by a previous computer system.   

Country of Origin If the patient’s country of birth is listed for this field, select that country.  If no 
appropriate country is listed, leave this field blank (<none>). 

First Visit Date, Last Visit 
Date, Release Date, 
Release Flag, Patient 
Signed Date 

The first, release and signed dates are set automatically to the date of first 
registration, but can be overtyped. The Last Visit date is updated by e-MDs Bill 
every time and invoice is generated. The release flag relates to the level of release 
of information authorized by the patient and is used on claims. Most clinics typically 
make patients sign a release that authorizes them to supply all information required 
to pay a claim (Y). Otherwise, set the flags to N (No), or M (Conditional). 

Account Status Set to Active, Hold, Collect or Inactive. The Active/Hold/Collect/Inactive settings 
control statement printing in e-MDs Bill.  When a patient is set to Inactive, the 
record is hidden from searches in the patient search window unless the Include 
Inactive Patients? flag is checked.  Note that the system still performs duplication 
checks against inactive patients. 

Super Bill ID A special Superbill can be printed for patients who generally don’t get the normal 
one. Setting the default here helps staff who don’t have to remember to select the 
special one every time the patient is seen. 

Super Bill Comment Free text or lookup field. This prints in bold at the top of Superbills generated for the 
patient, as well as the top of the e-MDs Chart window. The purpose is to serve as an 
alert to the provider of care. Text can be added to a lookup comment. The comment 
group code must be SB in order to be stored in this field.  You can add a 
combination of a comment and text by loading the comment then adding text. 

Billing Block This is used if a patient is on hold for accounting reasons.  When set, it generates 
warnings in various e-MDs Solution Series applications as the patient is loaded and 
can be used in tandem with the account status and a patient alert to stop staff from 
scheduling such patients. 

Marketing Referral Is used in e-MDs Bill for a marketing tracking report that looks at business volume 
by referral.  Link the marketing source for the patient such as word-of-mouth, Yellow 
Pages, advertisement, etc. 

Poverty Level These fields are used in Bill for indigent care billing.  Enter the # Family Members 
and Family Income, then check the Set Poverty Level box.  This cross references to 
the Sliding Scale and Poverty discount reference tables in Bill.  If the box is 
checked, when generating an invoice for patients with no insurance, the discount 
adjustment and copay are automatically calculated. 

Recall Dates e-MDs Bill has a recall system including the Notice Processor which includes a list 
report, and the Patient Dates Roster reports based on recall dates. Click Add, then 
select the recall type and date. There is no limit to the number of recalls per patient. 
The same recall type with different dates can be linked multiple times to one patient.  
Note that although the purpose is similar, this is different to the clinical 
rules/preventive reminders created for patients by Rule Manager in Chart which can 
also be used for recall report printing.  These fields can also be used for purposes 
other than recalls. 

  
Contacts Tab  
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An unlimited number of family and emergency contacts can be linked to a patient. The primary contact can be free 
text typed and upon saving is added to the list at the bottom of the screen. Additional contacts must be added by 
clicking the + button at the top of the list at the bottom. A relationship is required.  To edit the default contact whose 
information appears in expanded form at the top of the Contacts tab, select the record from the list and click Edit.  
The name information will be grayed out after it is saved for the first time making it ineditable. 

 
Fax Contacts Tab  
This is where a list of fax contacts related to the patient can be added.  These f chart ax contacts show up in the Fax 
Recipient form when a user is faxing from within a patient or DocMan account.  These contacts are people or 
organizations that you typically need to copy documentation to when you see the patient.  For example, these could 
be insurance companies, specialists or referring physicians. Click the Add button then search for entities by 
Provider, Organization or Person.  Make sure you have a fax number for the entity. 
Note:  The patient’s default referral physician is added to this list automatically. 

 
Facilities Tab  
The facilities tab is used by Chart.  Enter the External Medical Facility (i.e., hospital, nursing home, etc.) Registration 
Facility and any Pharmacies where a patient normally fills prescriptions.  The pharmacies will appear on a short list 
for doctors when prescribing medications, making it quicker to fulfill the prescription electronically.  Multiple 
pharmacies can be linked to a patient but only one can be designated as the Default. 

 
Employment Tab  
The current employment status as well as a complete employment history, sorted in date order can be added for a 
patient. Only the most recent one is used for claims. The default status is set to Unknown. 

 
Note Tab  
Used as an internal communication tool for billing and other messages between users. The check boxes above the 
note can be set to make this note appear as a warning in other e-MDs Solution Series modules. If the e-MDs 
Schedule option is checked, the note pops up automatically upon scheduling a patient, and the Edit Appointment 
window Alert button label is red. In e-MDs Bill, there is a red alert button in the invoicing module and in Chart there 
is a yellow triangle icon on the patient toolbar with an exclamation mark that turns red. Up to 5,000 characters are 
supported. An example of a note “Patient owes $20.00 copay from 10/02/2002 visit, transfer to billing office before 
scheduling an appointment!” 

 
Aging Totals Tab  
Shows current aged balances in e-MDs Bill. 

  
File History Tab  
This is where users can generate a report of any claim generated for the patient.  The specific claims histories are 
located in the claims themselves.  Click the Print button for a hard copy of the report. 

  
Alternate IDs Tab  
The alternate IDs tab is where you can add custom fields to the record.  An administrator with appropriate security 
privileges can set up a list of available fields.  To add one of these to the record, click Add, select the Alternate ID 
Type by clicking the list box to see the field names, then enter the Value specific to this record and click Save.  You 
can use the alternate IDs in claims by setting up definitions. This option can also be used to filter groups of patients 
when performing a search. 

Managing Patient Accounts 
Here are a few useful tips to remember when working with patient accounts: 

• Instead of giving established patients a blank intake form, print the Chart Cover report and ask 
the patient to verify the information on this report.  That will save time for both you and patient. 
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• If you change a telephone number, be sure to read the prompts regarding guarantor linking or 
linking to other entities.  Failure to do so can result in other entities with the same number or no 
number being updated.  As part of being able to update family groups from one screen the 
system checks for other entities with the same number.  If you have used a placeholder number, 
or have left it blank, you may be prompted to update other entities with the new number.  Only do 
so if you are absolutely sure.  In most cases you should select option to create a new one.  You 
may have patients calling other patients because all entities linked will be affected (patients, 
organizations, etc.).  If you need to clear a number, use the red X button.  Do not enter blanks. 

• Patients can only be deleted if they are not linked to other data. As soon as a medical record, 
invoice or appointment has been generated for a patient record, it cannot be deleted until the 
other data is deleted first. If any information for that patient has been locked such as signed off in 
e-MDs Chart, then it is impossible to delete the patient. 

• To simplify the faxing and phoning of prescriptions or referrals to other providers, you can link one 
or many pharmacies or providers to the patient.  When adding pharmacies to a patient account, 
you can designate a Default pharmacy that is the most commonly used by that patient. 

To edit or delete a patient: 
1. On the main e-MDs Chart toolbar, click Demographics and then select the Patients menu 

option.  

OR 

Click the yellow folder icon near the upper left corner of e-MDs Chart. Either method will open the 
Find Patient window 

2. Enter search criteria into any of the fields (such as patient name, social security number, or 
account number) and then press Enter or click Search. 

○ You can perform searches on either all or only part of a patient name.  

○ To search on first and last name, type a few letters of the last name, followed by a comma, 
then a few letters of the first name. 

3. To edit patient demographics, highlight the correct patient from the search results, and click Edit. 
Make changes as desired, and then click Save. 

4. To delete a patient, highlight the correct patient from the search results, and click Delete. If Visit 
or Order Notes are attached to the patient, deletion is not allowed. 

To designate a patient’s race as multi-racial: 
1. Click the down-arrow to the right of the Race field.  A basic list of races appears.   

2. Click Other Race to select that option. 

3. Click the Search button (magnifying glass) to the right of the Race field to open the Select Race 
window. 

4. Scroll down the screen to locate the first race to be selected. 

OR 

Type a search string in the Description field and click Search to locate the matching race(s). 

5. If the first race is to be specified as the Primary race, click the check box in the second column 
(under the gold star) before the race name. 

6. If the first race is not the Primary race, click the check box in the first column . 

7. Continue to locate additional races to be specified and click the appropriate check box before 
each race.  (There can be only one Primary race selected.) 
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8. After all appropriate races have been selected, click the Save button to save your selections and 
close the window. 

9. When you return to the Misc. tab, notice that the Race field is no longer selectable.  However, if 
you move the mouse over the field, the selected races will be listed in a hint box (for example, 
Other Race, African American (Primary), American Indian). 

10. If you need to change the race designation after selecting multi-racial values, click the Search 
(magnifying glass) icon next to the Race field.  From this screen you can: 

○ Click the red X button at the bottom of the window to specify Remove Selected Races. 

○ Click to clear one or more races selected earlier. 

○ Click additional check boxes to add one or more races to the selection. 

11. If you change anything on the Select Race window, click Save to keep your changes and close 
the window. 

To add a provider fax contact to a patient account: 
1. On the main e-MDs Chart toolbar, click Demographics and then select the Patients menu 

option.  

OR 

Click the yellow folder icon near the upper left corner of e-MDs Chart. Either method will open the 
Find Patient window 

2. Enter the search criteria into any of the fields (such as patient name, social security number, or 
account number) and then press Enter or click Search. 

3. Select the desired patient from the search results and click Edit. 

4. Click the Fax Contacts tab and click + Add. 

5. Type the provider contact information in the appropriate fields. 

6. Click Save to retain the changes and close the window. 

To add a pharmacy/default pharmacy to a patient account: 
1. On the main e-MDs Chart toolbar, click Demographics and then select the Patients menu 

option.  

OR 

Click the yellow folder icon near the upper left corner of e-MDs Chart. Either method will open the 
Find Patient window 

2. Enter the search criteria into any of the fields (such as patient name, social security number, or 
account number) and then press Enter or click Search. 

3. Select the desired patient from the search results and click Edit. 

4. Click the Facilities tab and click + Add. 

The Find Pharmacy window will open. 

5. Type the name of pharmacy in the Organization Name field and search, search results will show 

6. Click the desired pharmacy name and click Select OR double-click the pharmacy name 

7. In the Patient Pharmacy Maintenance screen the pharmacy name will populate the Pharmacy 
field 
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8. Add some information into Mail Order Text field if this is a mail order pharmacy. Typically this 
information would be a patient account number or some other insurance identifier required by the 
mail order pharmacy to identify the patient.  

Note:  Information entered here will show up on the prescription if the prescription is faxed using 
this mail order pharmacy. 

9. Click the check box labeled Default to make the pharmacy the default for the patient. 

Copying Patient Records 
The Copy feature is used to speed up data entry for new patients that share demographic information 
with others already in the system. The fields that are not copied are: First, Middle, Prefix, Suffix, Display, 
Maiden, DOB, Gender, SSN, Marital Status, Account Number and relationship to Guarantor. All insurance 
information is also copied, although the policyholder relationship must also be edited. 

To create patient records using the copy key: 
1. Click Demographics > Patient (Alt+D, P). 

2. Search for the patient already in the database and highlight the record. 

3. Click Copy (Alt+C). A new patient data entry screen appears with many fields already filled. 

4. Enter missing information and overtype fields in which the information needs to be altered. 

5. Open each insurance on the file and change the policy holder relationship. 

6. Click Save (Alt+S). 
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3 
Managing Patient Chart 

Information 
This section provides detailed instructions for performing the day-to-day tasks 
required for managing, tracking, and reporting patient chart information.  Many of the 
tasks described in this chapter can also be accessed from the Tracking Board 
application.  See the Tracking Board section for information on that module.  

Continued on the next page ... 



 

e-MDs Solution Series Chart User Guide 8.0 R01 21 

Opening and Closing Patient Charts 
The following instructions apply only when running e-MDs Chart as a standalone application or in the 
Dashboard, but not when launching e-MDs Chart from the Tracking Board application. 

To open a patient chart from the e-MDs Chart application: 
1. Open the Chart module as described in Opening Chart from the Dashboard. 

2. Locate the patient. There are three ways to get to the Patient Search window:  

Click Demographics on the main Chart toolbar and select Patients from the menu 

OR 

Click the yellow folder icon just below the main toolbar. 

OR 

Click the white text on the desktop that indicates Click "Open Patient Chart" in the File Menu 
to Begin.  

Note:  This option only works when no charts open, such as when the e-MDs Chart application 
is first launched. 

After using one of these methods, a Find Chart Patient form opens.  

3. Type a few letters of the patient’s last name (or part of the last name, a comma, and then a few 
letters of the first name), and click the Search button at the top of the screen (or simply press 
Enter on the keyboard). 

A list of patient names matching the search criteria displays.  

4. Click to select the desired patient and click Select (or double-click the patient’s name) to open the 
chart. 

See the Tracking Board section for information on opening a patient chart from within the Tracking 
Board application. 

To open multiple patient charts: 
1. Open the first patient chart as described above. 

2. With the first chart still open, select the second patient chart in the same manner, and so on. 

3. To quickly switch between charts when more than one chart is open, click the Current Chart 
drop-down menu (located just below the main application toolbar).  This drop-down menu 
displays the names of all patients with open charts. 

4. Click to select any name in the drop-down menu to jump directly to that patient’s chart. 

 
Note:  This functionality is not supported with Tracking Board because the charts for all patients 
seen on a given day are already easily accessed from the main Tracking Board window. 

To close a patient’s chart: 
Close any patient chart by simply clicking the X in the blue patient identification bar (to the far right of 
the patient’s name and demographic information).  

Important!  Be careful that you click the correct X.  Clicking the uppermost X will close the 
application, as well as all open patient charts.  
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To close all open charts: 
Click the Close All Charts button (this button is located to the right of the Current Chart drop-down 
box and is identified by the black outline of two intersecting boxes). 

OR 

Click File and select the Close All Charts menu option.  

OR 

Select the Log Off and Close All Charts item. 

Understanding the Chart Interface 
The following pages provide an overview of the various screens in the Chart application. The individual 
tasks performed in those sections are described in detail later in this chapter. 

MedlinePlus Information for Providers 
The toolbar in a patient’s chart contains an Info button (the letter i in a blue circle). 

 
The Info button provides quick access to MedlinePlus information for all current problems, medications, 
and lab orders/results included in the patient’s chart. MedlinePlus information can be viewed, saved, or 
printed. This button is visible only if the chart_infobutton privilege has been added to the users login 
account. 

Note: The Info button is designed to support provider education rather than patient education. Viewing, 
printing, or saving the information accessed using this button does NOT meet the MU certification criteria 
for patient education. 

Primary Chart Screen – Reminders  
Upon opening a patient's chart, the Reminders tab is displayed. Basic reminders appear at the top of the 
tab and the rule-based reminders appear at the bottom of the tab. 
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Reminders 
The Reminders section is intended to allow "sticky" type notes to be attached to the chart. Use these 
notes to temporarily document information that can be deleted at a later date (if desired). You can return 
to this section at any time by clicking the Reminders tab, located just below the blue patient identification 
bar.)  

The Reminders screen is split into two sections: 

• The left side displays a tree view of all New and Old Reminders, along with their priority levels, 
dates generated, and subject lines.  

• The right side displays the full text of the selected reminder. After a New ("active") Reminder is 
acted on, it can be moved to the Old Reminders section. Old ("inactive") Reminders can either 
be maintained in the Old Reminder folder or permanently deleted. 

Use the toolbar located immediately above the Reminders pane to add, delete, edit and restore 
reminders, as needed.  For detailed information on this feature, see Using Reminders. 

Rule-Based Reminders 
The automatically generated rule-based reminders section is located across the bottom third of the 
window. (You can return to this section at any time by clicking the Reminders tab, located just below the 
blue patient identification bar.) 

 
Clinical Rules are reminders for overdue (or soon due) items including preventive care, disease 
management, drug management, and immunizations. Rather than batch reports, these are patient-
specific reminders, presented to the clinician at the point of care.  

The rule description and due date are displayed in this section. A rule is satisfied by ordering the test in 
question in a Visit or Order Note. In addition, you can choose other options, such as Deferred, Waived, 
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or Refused. To learn more about addressing rules in the patient record, see the Clinical Rules Engine 
section  

Note:  If there are clinical rules that are due for a patient, the Reminders tab in Chart will display the 
word Reminders in red text as a visual cue that there are clinical rules that need addressing. 

Visit and Health Summary 
This window provides information about the selected patient's current health and related history. The 
Health Summary consists of: 

• Current Problem List 
• Current Medication List 
• Allergies/Adverse Reactions 
• Past Medical History 
• Surgical History 
• Family Medical History 
• Social History 
• Tobacco/Alcohol/Supplements 
• Substance Abuse History 
• Mental Health History 
• Communicable Disease History. 

To access this section, click the Visit / HS (Health Summary) tab, located just below the blue patient 
identification bar.  

 
Health Summary 
The Health Summary is displayed in the left window pane with details from the most recent visit in the 
right pane. (To view the Health Summary in full screen mode, un-check the Note check box on the 
toolbar located in the upper-right corner below the blue patient identification bar.)  

Note:  If the patient is currently an obstetrical patient, the patient's OB Module overview will be displayed 
in the right pane by default if the OB Module if installed at your facility. If the patient is not currently an 
obstetrical patient, or OB Module is not installed, the Last Visit tab will be displayed by default. 

To display hidden information: 
1. Click anywhere on a section bar in the Health Summary to open that section. 

2. Click the bar again to close the section.  

3. Click Expand All on the gray toolbar in the Health Summary to open every section. 



 

e-MDs Solution Series Chart User Guide 8.0 R01 25 

4. Click Collapse All to close all sections. 

To change screen font size: 
1. Click the down-arrow to the right of Health Summary and select Font Size. The Font Size 

adjustment box will open. 

 
2. Click + Font repeatedly to increase the size of the displayed text. Click - Font to decrease the 

size.  

3. Click the X to close the Font box. 

In a Free Text window, font size is also controlled by the + and – Font buttons. 

  
Note:  Changes in font are only reflected in the on-screen display, and not in the printed version of 
the Health Summary. 

Last or Current Visit  
To navigate to this section of a patient’s chart, click the Visit Note/HS (Health Summary) tab, located just 
below the blue patient identification bar. The most recent Visit Note is displayed in the right pane. (To 
view the Visit Note full screen, hide the Health Summary by un-checking the Health Summary check box 
in the toolbar located below the blue patient identification bar.)  

When a chart is initially opened, this screen will display the last Visit Note. That will be replaced with the 
current note when a new Visit Note is opened.  

An active Visit or Order Note is displayed in typical SOAP format (Subjective, Objective, Assessment, and 
Plan). Headers within each of those main four sections further subdivide the note (such as Chief 
Complaint, History of Present Illness, Review of Systems). Health Summary items can be included in a 
note under the appropriate headers (such as Current Medications, Allergies, Current Problem List). Click 
headers within the note for documentation options. Individual blue bars identify each of these sections. If 
information exists in a given section, a green check mark will be present on the blue bar. 

Instead of scrolling through the note, you can click the central vertical row of buttons to quickly jump from 
one section to another. The black text labels on the buttons turn blue as the corresponding chart sections 
are addressed. 

Within the body of the note, gray squares with black check marks indicate areas where templates may be 
available. Click any square to see a list of linked templates appropriate for that section. To add free text to 
the note, click any tiny gray circle (which turns into a yellow square when the cursor runs over it). See 
Entering Data for more information. 
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Also see Health Summary Report Print Options. 

Chart View 
One of the most frequently used windows in e-MDs Chart is the Chart View. Access this window in an 
individual patient's chart by clicking the Chart View tab, located just below the blue patient identification 
bar.  

The Chart View, a subsection of an individual patient’s chart, consists of ten different sections, which are 
described in the following table. 

Chart View Tab  
Visit Notes   A reverse chronological view (most recent note on top) of all Doctor Visit, Nurse Visit 

and Order Notes. Notes can be viewed in their entirety or in a tree displaying the 
diagnoses, prescriptions, and orders associated with the visit or order. Order Notes 
may or may not be associated with an office visit and can be used to track and verify 
the completion of orders for patient care beyond an office visit. Order Notes must be 
signed off by the provider after completion of the order(s). See the Working with Visit 
and Order Notes section for details. 

Telephone/Log/Rx Notes A reverse chronological view of all telephone notes, log notes, prescription notes 
and TaskMan notes. Telephone notes document phone conversations with the 
patient. Log notes store any free-text chart documentation that is not related to a 
Visit Note or a Telephone Note, such as a notation that the patient’s old records 
were reviewed, or a summary of a conversation with the patient’s other physician(s). 
Prescription notes document any information related to prescriptions. TaskMan 
notes are internal e-mail messages that contain patient-specific information and 
have been saved to the patient’s chart.  Notes are displayed in a tree, identified by 
date and author. Select any note in the tree to view it in its entirety. See the Create a 
New Log/Phone Note section for details. 
When viewing a note and any associated addendums to that note, the original note 
appears in a pane at the top and the most recent addendum (if there are 
addendums) appears at the bottom of the pane below the note.  When opening a 
note for viewing, the screen will automatically display the most recent note or 
addendum first.  You can then scroll up and down to view other notations, or right-
click anywhere in the addendum pane and select Jump to Top or Jump to Bottom 
to quickly move around to view other addendums or the original note. 

Chronology Lists all Visit Notes (Doctor and Nurse Visits), Order Notes, Telephone Notes, Log 
Notes, TaskMan notes and DocMan documents in reverse chronological order. 
Items are displayed in a tree, identified by date and author. Select any item in the 
tree to view it. See the View All Notes in Chronological Order section for details. 

Labs/Tests Lists all labs, tests, and procedures that have ever been ordered for the patient. Can 
be viewed in Grouped or Chronological fashion. Also hosts a view of Pending orders 
which works in conjunction with the Order Tracking module to provide a tracking 
mechanism for labs and tests (see Order Tracking Module for details).  Orders are 
displayed in a tree, identified by the visit date and ordering physician. The 
associated Visit or Order Note can be displayed in its entirety. See the View 
Labs/Tests/Procedures section for details. 

Diagnoses Displays all diagnoses ever assigned to the patient, whether they came from the 
Assessment section of a Visit or Order Note or were added directly to the Current 
Problem list. Can be displayed in Grouped or Chronological fashion. Details such as 
Severity and Progression can be viewed. Diagnoses are displayed in a tree, 
identified by the visit date and physician (if applicable). Any associated Visit or Order 
Note can be displayed in its entirety. See the "View Diagnoses" section for details. 
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Medications Displays all medications the patient has ever received, whether a prescription was 
written or the medication name was just added to the Current Medications list (i.e. 
prescribed by another physician or over-the-counter medications). Can be displayed 
in Grouped or Chronological fashion. Details such as Prescriber, Start and Stop 
Dates and Reason for Discontinuation can be viewed. Also hosts a view of Refill 
Requests.  This view works in conjunction with the Refill Request module to provide 
a workflow for dealing with refills (see the Refill Request Module for details).  
Medications are displayed in a tree, identified by the visit date and physician (if 
applicable). Any associated Visit Note can be displayed in its entirety. See the "View 
Medications" section for details. 

Consults/Referrals Displays all Consuls and or Referral Letters that were generated through the 
Consults/Referrals section.  Information available includes the initiating and 
consulting physician’s names. Besides viewing of the information this is also the site 
in which new letters are generated. See the Create a Referral/Consult Letter section 
for details. 

Documents This section hosts the scanned or imported documents that are stored in the 
DocMan module.  Access to these documents from the Chart View section allows 
for faster and easier access to important clinical information (see the Documents 
section of Chart View for more details). 

Cases This option allows users to view Patient cases. Patient case management is a 
component of the Bill application and it allows users to link multiple visits together to 
achieve billing, clinical, and other efficiencies.  Cases can link together many 
different items such as appointments, chart notes and invoices for each encounter 
related to a case as well as any DocMan scans/forms.  This information is available 
from within a single interactive window as well as a report.  This ability to access all 
information without having to bounce around to different modules is extremely 
efficient.  See Patient Case Management for details. 

Legend This option provides a legend for each of the icons that are used in the Chart View 
section. 
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FlowSheets 
The FlowSheet module of e-MDs Chart is a very powerful and flexible component that allows you to 
define, capture and track virtually any type of clinical information.  This information is displayed in a grid 
format much like a spreadsheet that allows you to view large amounts of data in a single, consolidated 
view.  

 
To access this section of an patient’s chart, click the FlowSheets tab, located just below the blue patient 
identification bar.  

See FlowSheets for more information. 

Basic Reminders 
Reminders help keep chart information current and serve as memory joggers that assist in dealing with 
patients on a more personal level.  This section provides instructions for adding, using, and removing 
basic reminders, which are reminders that are entered by users. (Rule-based reminders, which are 
automatically generated by rules defined in the Rules Manager, are covered in the next section of this 
chapter.) 

To add a new reminder: 
1. Within a patient’s chart, click the Reminders tab (below the blue horizontal patient identification 

bar).  

2. At the bottom of the Reminders left-side window, click Add to open the New Reminder form.  

3. The current date, sender’s name (person logged in at the time), patient’s name, and a priority 
level of normal are filled in automatically.  

4. Enter information into the subject line and change the priority level if desired. (The priority levels 
are High, Normal, and Low. Notes are sorted according to their date and priority level.)  
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5. Type the text message into the bottom part of the form.  

6. Click Save. 

To edit a reminder: 
1. Within a patient’s chart, click the Reminders tab (below the blue horizontal patient identification 

bar.) 

2. Highlight the note to be edited, and click Edit (at the bottom of the left-sided Reminders window).  

3. The Reminder window will open and changes can be made to the text message. Once changes 
have been made, click Save. 

To move a reminder to the Old Reminders folder: 
1. Within a patient’s chart, click the Reminders tab (below the blue horizontal patient identification 

bar.) 

2. Highlight the note to be moved, and click Remove (at the bottom of the left-sided Reminders 
window). This will move the item to the Old Reminders folder, making it an inactive reminder.  

3. To move an Old Reminder back into the New Reminder folder, highlight the note and click the 
Restore button.  

4. To permanently delete the note, see “Delete a Reminder.” 

To delete a reminder: 
1. Within a patient’s chart, click the Reminders tab (below the blue horizontal patient identification 

bar.) 

2. Reminders can only be deleted from the Old Reminders folder. (See “Move a Reminder to the 
Old Reminders Folder.”) Highlight the Old Reminder to be deleted, and click Remove (at the 
bottom of the left-sided Reminders window).  

3. In the pop-up Warning window, click Yes to confirm the decision to delete. This permanently 
deletes the reminder and it cannot be restored. 

Rule-Based Reminders (Automated) 
Rule-based reminders are automatically generated by the Rule Manager when defined conditions are 
met. Rule-based reminders generally focus on health care items that need attention, such as 
recommended preventive care screenings or best practice procedures for diagnosis-based disease 
management. (See Using the Rule Manager for more information about how rules work.) 

If rule-based reminders have been generated for a patient, the Reminders tab in Chart will display the 
word Reminders in red text as a visual cue that there are clinical rules that need to be addressed. 

 
The reminders generated by clinical rules are displayed in the lower third of the Reminders tab. 

Views and Action Buttons  
To the left of the rule-based reminders is a set of icons (shown below). Hold the mouse over an icon to 
see the icon label. 

 - Current view 
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 - Pending view 

 - History view 

 - Patient Rules view 

  - Legend view 

Clicking either of the first two icons (Current or Pending) displays a particular view of rule-based 
reminders. Clicking the third icon (History) displays an audit trail of actions that have been performed on 
rule-based reminders for the specific patient. Clicking the fourth icon (Patient Rules) displays any rules 
that apply only to the specific patient. 

The fifth icon displays a legend, which provides information about the color coding of Due Dates for rule-
based reminders. Dates are displayed in three colors: 

• Black:  Dates displayed in black are dates for items that are not expired. 

• Green:  Dates displayed in green denote items that are not overdue but that are coming due 
within a short period of time. 

• Red:  Dates displayed in red denote items that are overdue. 

Note: To adjust the width of the columns in the first four views, position the cursor over the vertical splitter 
bar between the column headers until a left/right arrow appears, and then drag the column in either 
direction while holding down the left mouse button. 

Action buttons are associated with several of these views. More detailed information about views and 
action buttons is included in the following paragraphs. 

The Current View 
The Current view is the default view and is represented by a white paper icon .  This view is displayed 
automatically when a user clicks the Reminders tab in the chart. The Current view includes four columns, 
which are described below. 

Columns  
Date Last This column displays the last date that actions, tests or documentation dictated by 

this clinical rule were performed. If the necessary action, test or documentation has 
never been performed, N/A will display. 

Due Date This column displays the Due Date for the displayed rule.  Red text indicates the 
required action, test or documentation is overdue.  Rules can be set to display in 
advance of the due date, so it is possible to view rules that are “coming due” but not 
yet overdue.  These rules will be displayed in green text. 

Status This column displays the Order Status. When a new reminder is generated, the 
status will read “Not Addressed.”  If action is taken during that patient encounter (i.e. 
the appropriate CPT code is ordered to satisfy the rule), this rule reminder will 
disappear the next time the Rules Engine runs.  The provider may choose to 
document the action as “Do Now” or “Order.” 

Description This column displays the text that is entered in the rule when it is created; this will 
typically be the name of the lab or test that is needed.  The descriptions can also 
describe the parameters of the rule.  For example, a rule description might simply 
state “Mammogram” or may offer more details, such as “Mammogram to be 
performed annually in women >/= age 40.”  See Rule-Based Reminders for more 
information about these items. 

Along the left side of the Current view are five action buttons labeled Order, Override, Run All, Add 
Rule, and Source.  Use these buttons to perform and/or document actions taken with regard to the rule-
based reminders listed for the patient. 
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Action Buttons  
Order This button is intended to document that the user is going to order a test or 

procedure OR is requesting that someone else order the item related to the 
reminder.  Clicking this button loads any ICD and CPT codes that are linked to the 
rule into the Cached CPT Code module and thereafter when a note is opened a 
warning message will be displayed to give the user an opportunity to add these 
linked codes to the note for both documentation and billing reasons. For example if 
the reminder showed that a patient was overdue for a mammogram, the user could 
mark the rule using the Ordered button and then when the note for the encounter 
was finally opened a warning message would be displayed explaining that there was 
a pending CPT code that needed to be dealt with.  The user could then drop that 
CPT code into the note to ensure that the visit was correctly documented. 

Override This button opens the Edit Rule Result window, in which a user can document that 
the test or procedure indicated in the reminder has been refused, deferred, or 
waived, and by whom.  The user can also indicate the reason for the override, and 
can change the Due Date (the date change causes the reminder to reappear at a 
later date determined by the user). 

Run All This button runs the entire rule set.  It can be used after a visit so that the clinician 
can see if any new alerts have appeared, based on new data entered. 

Add Rule This button gives the user the ability to add a patient-specific iteration of the 
selected rule.  This allows for refinements to accommodate special situations with 
patients.  

Source Selecting a reminder and then clicking the Source button displays a window that 
contains information about the source of the clinical guidelines on which the rule is 
based.  

See the Addressing Rule-Based Reminders section to read more about the use of these buttons to take 
action on rule-based reminders during the patient encounter. 

The Pending View 
This view includes a list of all rule-based reminders for which a user clicked the Override option and then 
changed the Due Date.  This causes the reminder to be removed from the Current view and to reappear 
at that later date.  Until the date is reached and the reminder reappears in the Current view, the reminder 
will be displayed in the Pending view.  In other words the Due Date has changed and the reminder is in a 
“pending” mode until that date is reached. 

Rule-based reminders in the Pending view are displayed in four columns: Due Date, Description, 
Status, and Override By.   

Along the side of this view are three action buttons labeled Edit, Reset, and Delete. 

Action Buttons  
Edit This button allows the user to edit the pending reminder and change the Due Date. 
Reset This button allows the user to reset a rule when a reminder has been refused, 

waived, or deferred, and remove it from the Pending view and return it to the Current 
view. 

Delete This button allows the user to delete a pending reminder. 

The History View 
This view provides an audit trail of actions that have been performed on rule-based reminders for the 
specific patient.  Any action that is taken by clicking one of the buttons (except the Run All button) in the 
Current or Pending views is documented in this view. Clicking any of the reminders listed in this section 
will display any associated note in the gray area at the bottom of the section. 

The History view displays information in 5 columns labeled Last Date, Log Date, Due Date, Status and 
Override By.  Last Date, Due Date, and Status columns are the same as those described in "The Current 
View" section.  The Log Date column displays the date that the action was taken on the rule-based 
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reminder. The Override By column indicates who deferred, refused, or waived the reminder. (Information 
is pulled from the Edit Rule Result window that is displayed when user clicks the Override button in the 
Current or Pending view.) 

There are no action buttons associated with the History view. 

The Patient Rules View 
This view includes reminders generated by any patient-specific rules created for the patient. 

Action buttons associated with this view are described below. 

Action Buttons  
Run Runs all the patient specific rules. 
Edit Allows the user to edit the patient specific rule. 
Delete Allows the user to delete the patient specific rule. 

 

Addressing Rule-Based Reminders 
Rule-base reminders for individual patients are displayed in the Tracking Board and on the Reminders tab 
of the patients’ chart in e-MDs Chart. Instructions for addressing the reminders are identical, regardless of 
which application is used. 

You can address most rule-based reminders in three ways: 

• You can “satisfy” the rule by ordering the lab or test (CPT code) required by the rule. 

• You can override the reminder (when the lab or test is refused, deferred or waived). 

• You can take no action. 

To address a rule-based reminder by ordering the recommended lab or test : 
In the current Visit or Order Note, add the appropriate CPT to the Orders section (in the Plan).  For 
example, if the rule-based reminder indicates that the patient is overdue for a mammogram, add a 
mammogram CPT to the Orders. 

• Orders must be added within a note.  

• Ordering the lab or test adds the corresponding CPT to the database.  The next time the rule 
runs, this CPT will be recognized as satisfying the rule.  Therefore, the next time the patient’s 
chart is opened, that particular reminder will no longer be displayed. 
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To override a rule-based reminder:  
1. Click the Override button at the top of the Current view.  The Edit Rule Result window opens.  

 
2. Select (click) the applicable option in the Override Type, Override By, and Override Reason 

sections.  

3. Select (click) one of the options in the Next Due Date section.  (If you select Set next due date, 
click the down arrow to pick a new date for when the reminder should reappear in the Current 
view. 

4. Optional: If you want to document the last time the test or procedure was done, click the Set Last 
Date check box and then click the down arrow to select the date.  

5. Click OK to save the changes. 

The next time the rule runs, the Refused, Deferred, or Waived flag will be recognized, and that 
particular rule will not appear again until the new Due Date is reached. 

Note:  Even though the patient refuses the recommended item at this visit, the provider may want to 
revisit the issue at a later date.  To do so, reset the Due Date to a date in the near future (example a 
year from now).  On the other hand, although it is not recommended to do so, a provider may decide 
that it is not worth revisiting the issue and may choose to select the never run this rule for this 
patient option (in the Next Due Date section) so that the warning does not reappear. 

Important!  When a reminder is marked as Refused, Deferred or Waived, it is displayed in the 
Pending view. (See the “Rule-Based Reminder Views” information provided previously in this 
chapter.  If a reminder generated by a rule is inadvertently marked as Deferred or Waived OR if the 
Due Date for a pending item needs to be changed (for example the wrong Due Date was chosen), 
this can be done by selecting the item in the Pending section and clicking the Reset button. 

To take no action: 
If no action is taken on a rule-based reminder, the next time the patient’s chart is accessed the 
reminder will again be displayed in the patient’s chart with the status of Not Addressed. 
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To reset a rule-based reminder: 
1. Click the Pending button to view rules that have been Refused, Waived or Deferred. 

2. Click the rule to be reset. 

3. Click the Reset button.  A confirmation window asking if you want to reset the rule will appear. 

4. Answer Yes at the confirmation window.  The rule will be reset and the reminder will be removed 
from the Pending view and returned to the Current view. 

Recording Information with Fast Forms 
Fast Forms are paper forms derived from existing templates that allow patients to record their own 
Review of Systems (ROS). 

• Using the Fast Form Editor, an existing template is converted into a Fast Form. In this 
conversion, the user may choose to delete any items within the original template. In addition, any 
medical terminology can be converted into layman’s terms (or into a foreign language). 

• Using the Fast Form Processor, the Fast Form is printed onto paper, along with a barcode 
identifying the patient and the template. The paper lists the template data elements with "bubbles" 
next to each answer option. 

• After the patient answers the questions by filling in the "bubbles" with pencil, the Fast Form is 
scanned. The scanning process will check for errors, such as no answer (if desired) or both "yes" 
and "no" answers to a single question.  

• The template check boxes are automatically clicked, according to the patient’s answer set. With a 
Visit or Order Note open, the healthcare provider can click a button to drop the "pre-answered" 
template into the note. At that point, the provider can add additional information or change any 
answers as appropriate. 

Creating a Fast Form Template 
The Fast Form Editor uses existing ROS (Review of Systems) templates to create and/or edit Fast Forms 
for use in the Fast Form Processor. 

To create a new Fast Form: 
1. Open the Fast Form Editor.   A shortcut to this module is not automatically created when the 

application is installed.  

To create a shortcut: 
a. Browse the computer’s Program Files to find the e-MDs directory.  
b. Open the e-MDs Chart folder.  
c. Right-click the Fast Form Editor menu item. 
d. Select Send To > Desktop (create shortcut).  

The Login Name and Password are the same as for e-MDs Chart. 

2. Click Create.  

The Editor window will display a tree node labeled Review of Systems.  

3. Click the plus sign located to the left of the Review of Systems label.  

This expands the tree to show the four core ROS templates (Adult Female, Adult Male, Pediatric 
Female, Pediatric Male), plus any other ROS templates created by the user. These templates are 
exactly as they appear in e-MDs Chart. 

4. Click the title of the template that is being converted to a Fast Form.  



 

e-MDs Solution Series Chart User Guide 8.0 R01 35 

5. In the pop-up menu, choose whether this template will be two or three levels deep.  

A two-level ROS template lists the organ system (i.e. Cardiovascular) in the first level and the 
symptom (i.e. chest pain) in the second level. A three-level template may expound on that 
symptom (i.e. at rest, with exertion, etc.) 

6. In the next pop-up window, supply a descriptive label for the Fast Form.  

This title prints on the form. Any text enclosed by <brackets> will not print. If several physicians 
are each creating personalized Fast Forms from the same core template, it is helpful to type the 
physician’s name in brackets, so that the correct Fast Form is chosen at the time of use. 

The full template expands to the third level, with a check mark next to every data element.  

7. Clear the box next to any data element that should not appear in the final Fast Form.  

Notes:   
○ If a two-level template was chosen, the third level is still visible at this point. Do not be 

concerned about this. It is not necessary to clear all of the third-level boxes. 

○ Be sure that all desired changes are made prior to the next step, as there is some limitation to 
the types of changes that can be made at the next level (see below). 

○ When in Create mode, you can click the Fast Form title at any time to reset the check boxes 
back to default (all boxes checked). 

8. Click Edit and then click the plus sign next to the appropriate Fast Form. 

At this point, any medical terminology in the Fast Form can be converted to layman’s terms.  

9. Click the word to change, and then click the Edit Node Text menu option.  

10. Edit the text and press the Enter key. 

11. After making edits, click the title of the Fast Form to either Save the template, Save As a different 
title, Delete the Fast Form template, or perform additional edits to the text.  

If the template is NOT saved in this manner, when the Fast Form Editor is closed, you will be 
prompted to Save Fast Form, Save Fast Form As…, Abandon Changes, or Cancel Exit. 

The newly created Fast Form is now available for the Fast Form Processor. (There is no Save 
button.) 

To edit an existing Fast Form: 
There is no way to return an existing Fast Form to the "Create" step, in which nodes are chosen to be 
included or excluded. However, the text of the existing nodes can be edited. 

1. Click Edit for a list of all existing Fast Forms.  

2. Click any node to edit the text, as described above. 

3. To delete any item from the Fast Form, click the item to be deleted and select Exclude Answer 
from Template.  

If this is a "parent" item, the subsequent level "children" items will be deleted as well. The title of 
the Fast Form will now appear in red text, prompting the user to save the edited Fast Form. 

4. Once in Edit mode, new items cannot be added to the Fast Form. But, in a newly created Fast 
Form (if the Fast Form Editor has not yet been closed), click the Create button.  

This step should show the previously selected "checked boxes" of the Fast Form.  

5. Add the new item(s) and then click Edit again if further editing is desired. 

6. When finished, click the title of the Fast Form and select the Save Fast Form Template option to 
replace the original Fast Form.  



 

e-MDs Solution Series Chart User Guide 8.0 R01 36 

OR 

Select the Save Fast Form Template As… option (and supply a title) to retain both the original 
and the newly edited Fast Form. 

To delete a Fast Form: 
1. Click Edit for a list of all existing Fast Forms. 

2. Click the title of the Fast Form to be deleted and select the Delete Fast Form Template option. 

3. Click Yes in the Delete Confirmation window. 

Setting Up the Fast Form Processor 
The Fast Form Processor prints ROS (Review of Systems) Fast Forms (created in the Fast Form Editor) 
with a barcode identifying the template and the patient. After the patient fills in the answers, the Processor 
then accepts scanned Fast Forms and identifies potential problems, such as questions with both a "yes" 
and "no" response selected. Several steps are required before the initial use of the Processor. 

To set up a temporary file to hold Fast Forms: 
1. After a patient has completed a Fast Form, and it has been scanned, it is temporarily stored in a 

file until the Fast Form is used in a Visit or Order Note.  

Create this temporary if one does not exist.  

2. On the computer that will be storing scanned Fast Forms, set up a C:/temp directory.  

After the temporary file is available, the Fast Form program will create an additional directory 
folder called C:/temp/FastForm for storage of processing files.  

3. Do not delete this directory. If deleted by mistake, simply recreate that directory. 

To open the Fast Form Processor: 
1. Open the FastForm Processor.  

A shortcut to this module is not automatically created when the application is installed.  

2. To create a shortcut for the machine that will typically be used to print Fast Forms, browse the 
computer’s Program Files to find the e-MDs directory.  

3. Open the e-MDs Chart folder.  

4. Right-click the FastFormProcessor.exe file and select Send To > Desktop (create shortcut).  

The Login Name and Password are the same as for e-MDs Chart. 

To set up the scanner and printer: 
1. Click Select and choose the Scanner menu option.  

2. In the Select Source window, highlight the correct printer driver and click Select.  

3. If no scanner drivers appear in this window, install the appropriate drivers for your scanner. 

Note:  If other hardware (such as other scanners or digital camera) is installed on this computer, 
each time the FastForm Processor is launched, you must reselect the driver for the scanner that 
processes the Fast Forms.  

4. Click Select on the tool bar again, and choose the Printer menu option.  

The Fast Form Processor automatically selects the computer’s Windows default printer.  

5. If necessary, change the printer in the Print Setup window.  

6. Click OK.  
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To validate ambiguous answers: 
1. Click Setup. 

2. Select the Options menu item. By default, the Validate button is active. 

The Fast Form Processor is designed to handle ambiguous answers ("yes" and "no" selected for 
a single question) and non-answers (questions the patient did not answer). If the Validate button 
is pressed (highlighted green), the Processor automatically disregards ambiguous answers (the 
final template will have neither answer checked). 

To manually review ambiguous answers:  
1. Click the Validate button again to disable it (the button will now be gray/black).  

2. After scanning the Fast Form, under Scan and Score in the Fast Form Processor, review the 
ambiguous and unanswered items. Ambiguous answers are colored RED and non-answers are 
PURPLE.  

3. Click any item to launch another screen displaying an image of the patient’s responses. A menu 
next to the image provides the option to save the answer as YES or NO or to DISCARD it.  

To generate a thumbnail view of Fast Forms: 
1. Click Setup and select the Options menu item. By default, the Thumbs button is inactive. 

2. To present a thumbnail of a scanned Fast Form, click the Thumb button to activate it (highlighted 
green). Click the corresponding size of the thumbnail to select your preference. 

3. Now, whenever a Fast Form is scanned, a thumbnail will be displayed on screen. To enlarge the 
thumbnail, double click it. This launches the Image Review screen, allowing review of the 
patient’s responses. 

Calibrating the Scanning Processor 
Currently Fast Forms have default settings for scanning that include the position of the barcode and the 
four corner points. The processor uses one corner point as a reference to assist in identifying the 
remaining points and the barcode. Therefore, these default settings should not need to be adjusted. 

The Answer Sets also come with default settings, but you cannot adjust their position and sensitivity at 
this point. These settings can be reviewed following the scanning/processing of the first Fast Form.  

To test the settings of the Answer Set position and sensitivity:  
1. Create a Fast Form for a sample patient and fill it out.  

After printing the Fast Form, a pending Fast Form for that patient should be visible under the 
Scan & Score tab.  

2. Go to Setup > Options and click the Validate button to active (highlighted green). The Thumbs 
activation is optional.  

Note:  The Calibrate option will not be active at this point. 

3. Place the completed Fast Form sheet in the scanner tray and click the Scan button.  

This will open the Scan & Score Progress Monitor which shows processing details. If the initial 
Fast Form is "read" successfully (including the barcode and four corner points), the following 
message should be displayed: “FastForm: "[name of FastForm]" scored and stored successfully.” 

If an error message appears stating that “BARCODE NOT READ, or LESS THAN 3 POINTS 
IDENTIFIED,” re-scan the Fast Form.  

4. Make sure that the Fast Form is facing DOWN in the scanner feeder tray, that all four corner 
points are printed and visible, and that the barcode is printed and visible as well. 
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After the Fast Form is scanned/processed successfully, the calibration functionality should be 
active.  

5. To review the position and sensitivity settings, go to Setup > Options > Calibrate. 

This launches the Fast Form Setup – Mark Sense Calibration screen along with the Thumbnail if 
it was not previously active.  

6. Double-click the thumbnail to launch the Image Review For Arbitrating window. 

This window displays the position of the CIRCULAR data point in relation to the computer’s 
associated SQUARE data point. The blackened circles need to be as close to the center position 
of the square as possible. This ensures that the scanner will read the data correctly.  

7. Make adjustments through the Setup Mark Sense Calibration window, which should be still be 
open on the desktop.  

8. Click the window’s title bar to make it active. 

Horizontal arrows move the position of the circle left or right and Vertical arrows move the 
position of the circle up or down.  

9. Sensitivity determines the amount of coloring required to fill the circle.  

Move the pointer to the right to require less shading of the circle in order to be accepted as a valid 
data point. Move the pointer to the left to require more shading to be present in the circle and still 
be acceptable as a valid data point. In other words, if the pointer is moved to the right, the patient 
will be required to fill in the circle less, and, if moved left, more pencil mark will be acceptable. 

10. After appropriate changes are made to the Horizontal, Vertical, and Sensitivity fields, click the 
Reprocess button in the calibration window to rerun the processing of this Fast Form.  

The Image Review window will close and new results will be displayed in the Scan and Score 
Progress Monitor.  

11. Review these results to make sure that the data was captured correctly. If still not capturing the 
data correctly, repeat the steps to adjust the position and sensitivity settings. 

12. Click Store Settings to save these new settings.  

OR 

Click Restore Defaults to return to the preset position and sensitivity defaults.  

13. Click Close to end the calibration process. This closes all windows except the Fast Form 
Processor Window. 

Printing and Scanning Fast Forms 
To begin using Fast Forms to capture patient information, you must select and print the appropriate Fast 
Form template.  You will then give this printed form to the patient to complete. 

To print and scan the Fast Form template: 
1. Open the FastForm Processor.  

Note:  If a shortcut to this module is not on the desktop, browse the computer’s Program Files to 
find the e-MDs directory.  

2. Open the e-MDs Chart folder.  

3. Right-click the FastFormProcessor.exe file and go to Send To > Desktop (create shortcut).  

The Login Name and Password are the same as for e-MDs Chart. 
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The Processor opens defaulted to the Scan & Score tab to alert you to any pending Fast Forms 
that have yet to be entered into e-MDs Chart. The Processor window can be resized and moved 
to anywhere on the desktop.  

Note:  The Fast Form Processor will not allow creation of a new Fast Form for a patient who 
currently has one DONE (scanned, but not yet dropped into a Visit or Order Note) or PENDING 
(awaiting scanning). 

4. Click the Fast Form Templates tab.  

5. Click the plus sign next to the Review of Systems label to expand the tree and view all available 
ROS Fast Forms. 

6. Select the desired Fast Form by clicking the check box to the left of the title. 

7. Click Patient (the first button, with the yellow folder icon).  

8. Enter the search criteria and press the Enter key or click Search.  

9. Highlight the correct patient’s name from the search results and click Select.  

Note:  If the Fast Form selected is either age or gender specific, and the patient does not match 
the criteria defined for one or both demographics, an error message will appear indicating the 
mismatch and printing will be cancelled.  This will allow you to return to the earlier step and select 
a Fast Form more appropriate for the selected patient. 

10. Click Print (the second button, with the printer icon). 

This will print a Fast Form for the patient to complete. The barcode on the left side identifies the 
patient and the template.  

11. Instruct the patient to complete the Fast Form with a pencil, answering either Yes or No for each 
question.  

Note:  Questions may be left unanswered. Remind the patient to fill in the circle as completely 
as possible. Avoid check marks, dots, or filling outside of the circle as this may increase errors 
while collecting the data by scanner. 

When a Fast Form has been printed, a notice is sent to the Scan & Score tab as a reminder that 
a Fast Form has been generated and is PENDING (awaiting scanning).  

12. If a pending Fast Form is no longer needed, it can be deleted (and a new one generated, if 
desired).  

To delete a pending Fast Form: 
a. Click the Patient Name data line. 

b. Select the Delete Pending Fast Form menu option. 

Note:  When the first Fast Form is printed, it is possible to select Print prior to Patient; in this 
case, you are prompted to do a patient search. After that first Fast Form, however, clicking Print 
will automatically print the Fast Form for the previously selected patient, and not give the option to 
search for a different patient.  

To scan in a completed Fast Form: 
1. With the Scan & Score tab selected, place the completed Fast Form in the scanner and click 

Scan (the third button, with the scanner icon).  

If the scanner is able to read all four corner points correctly, the light buttons turn to green on the 
left side of the Fast Form Scan & Score Monitor. The Monitor displays a message with the patient 
name and Fast Form title, stating that the form was scored and stored successfully.  
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Under the Scan & Score tab, the Patient Data line will now show the Fast Form as DONE. It 
remains at this status until the Fast Form is used in a e-MDs Chart Visit or Order Note. 

Notes:   
○ No more Fast Forms for this patient can be created until the current form is added to a Visit 

or Order Note in e-MDs Chart.  

○ If the Fast Form Processor application is closed and re-opened, only the PENDING Fast 
Forms will be displayed in the Fast Form Processor. The DONE Fast Forms, however, are 
still available. 

If the scanner fails to identify any of the four corner points on any page of the Fast Form, it will not 
complete the task, and the form must be re-scanned.  

Under the Scan & Score tab, the Patient Data line will still show the Fast Form as PENDING. 
The Fast Form Scan & Score Monitor will display an error message similar to: “ERROR: No 
BitMap for 604661750000006421. Process TERMINATED!”  OR “Less than 3 points Identified” 
OR “Image Discarded! Missing Page! Image Discarded!” 

2. Place the entire Fast Form back in the scanner.  

3. Verify that the Scan & Score tab is clicked.  

4. Click Scan.  

Remember, with Validate activated (see the “Set Up the Fast Form Processor” section for details), the 
Fast Form Processor automatically disregards ambiguous answers. If Validate is turned off, ambiguous 
answers must be manually corrected. 

The Fast Form Scan & Score Monitor displays a summary of non-answers and of ambiguous answers. 
Ambiguous answers (those with both a "yes" and "no" response) are shown in RED. Non-answers 
(questions left blank by the patient) are shown in PURPLE. 

To validate ambiguous answers: 
1. Click any red (ambiguous answer) or purple (non-answer) item to display a menu with three 

choices.  

2. Mark as YES, NO, or DISCARD.  

Another window opens with a scanned image of the Fast Form, showing the "actual pencil error."  

3. Review the error circled in red, and either correct the information with the patient (mark YES or 
NO) or DISCARD the item entirely for review by the provider in the exam room. 

After all ambiguous items have been corrected, the Patient Data line under the Scan & Score tab 
will show the Fast Form as DONE.  

To use a Fast Form template in a Visit or Order Note: 
1. Print the appropriate ROS (Review of Systems) Fast Form. 

2. Have the patient fill in the answers and scan the form back into the system.  

3. Ensure that the scanning process was completed without errors 

4. In an active note, click the Add Fast Form button located on the toolbar directly above the Visit 
or Order Note.  This will open the ROS template, with the patient’s answers checked off. 

Note:  If no Fast Forms are available for that patient, a pop-up window will indicate that fact. 

5. At this point, you can add additional information to the template and change any of the patient 
answers, as appropriate.  

6. Close the template when finished. 
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After the Fast Form has been dropped into the note, it is deleted from the database and cannot 
be reused. There is no indication in the Visit or Order Note that the information was collected via 
a Fast Form. 

Note:  If any existing template is edited in the Template Editor, all Fast Forms derived from that 
template will be deleted. See the "Association between Templates and Fast Forms" section for 
details.  

Setting Preferences for Visit and Order Notes 
As a user preference, a provider can choose to automatically add certain elements of the Health 
Summary to new Visit and Order Notes. These items drop into the note as soon as the Visit Details 
window is completed. Alternatively, other elements can be hidden based on user preferences. 

In order to set preferences for a specific provider, the provider must first log in to e-MDs Chart and 
perform the steps described below. This login step links the preferences selected to the correct provider. 
(However, in actual use, the preferences used will be those of the provider whose name appears in the 
Health Care Professional field of the Visit Details window. This allows other clinical staff to be logged 
into e-MDs Chart to initiate the note, and still maintain the doctor’s preferences.) 

 



 

e-MDs Solution Series Chart User Guide 8.0 R01 42 

Note:  The steps described below are basically the same for both Visit Notes and Order Notes.  Just 
select the appropriate tab in the Chart Options window to set preferences for each type note. 

To create user preferences for new Visit Notes and Order Notes: 
1. Click File and select the Options menu option. 

2. In the e-MDs Chart Options window, click the Visit Notes (or Order Notes) tab. 

3. In each section, click to select the check box before each desired option as described in the Visit 
Notes and Order Notes Options table. 

4. Click Save to retain the settings. 

 

Visit Notes and Order 
Notes Options 

 

When creating a new 
[visit|order note], 
automatically drop the 
following into the note: 

• Allergies (Drug) 
• Allergies (Non Drug) 
• Current Medications 
• Current Problem List 
• Immunizations 
• PMHx: Selecting PMHx will add the entire history to the note, including: Past 

Medical History, Surgical History, Family History, Social History, 
Tobacco/Alcohol/Supplements, Substance Abuse History, Mental Health History, 
and Communicable Disease History. Currently, there is no way to add a subset 
of that history. 

When creating or editing 
[a visit|an order note], hide 
the following visit 
sections: 

A new Visit Note or Order Note includes headers for all possible sections of a SOAP 
note (such as HPI, ROS, PMHx, Current Problems, etc.). This allows you to hide 
note headers for sections that you rarely address. These headers can be hidden, 
but the associated button in the vertical button column will still be visible. Therefore, 
if a particular section is hidden, it can still be accessed. 
Note:  There is some crossover between sections that can be set to automatically 
drop into the note and those that can hidden. In those cases, if data exists, it will be 
added to the note. For example, if a user sets Allergies to automatically drop into the 
note, but he also has selected to hide that section, the patient’s allergies will show 
up in the note. 

When creating a new 
[visit|order note], default 
to: 

The Type of Encounter is a required field in the Visit Details window. This 
information prints in the header of the note and is also used in calculating the E&M 
code. If you typically see a single type of encounter, you may set that type as a 
default. 
The default setting is Office/Outpatient Visit. Click the down-arrow to show the 
other options in a drop-down list. 

 
Note:  Those selections displayed in blue text are used by the E&M Coder. 
Options in black text either represent E&M codes that are purely time-based (and, 
therefore, are not used by the E&M Coder) or are main Encounter Type categories. 
For example, the "Consultations" Type of Encounter is not specific enough to be 
used by the E&M Coder; it is better to select a more specific (blue) Encounter Type, 
such as "Confirmatory Consultations" or "Initial Inpatient Consultations." 
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Automatically show: • E&M Codes at sign-off if no E&M Code (99201-99499) in note: e-MDs Chart 
includes an E&M Code Calculator; this calculation is an automated process 
provided that templates are used for documentation, rather then free text.  
The results of the calculation (i.e. the E&M code) will not be automatically 
added to the Visit or Order Note until authorized by the user. At any time, the 
user can open the E&M Coder (by clicking the Plan header and choosing the 
E&M Coder menu option) to see the progress of the code calculation. While in 
the E&M Coder, the user can click Accept to add the E&M code to the Orders 
section of the note. 
There is a mechanism built in to remind the user to check this calculation and 
either accept the suggested E&M code or choose an alternate code. This 
feature is a user preference, and can be turned either on or off. If turned on, 
when the user clicks the Note Conclusion button and an E&M code has not yet 
been added to the note, the E&M Coder will automatically pop up. 

• Hide E&M Codes if CPTs marked in CPT editor are "Encounter" kind of 
service: This option is used to accommodate specific situations that arise with 
some CPT codes that do not fall into the official range for an E&M code but 
which ARE considered to be usable as E&M codes (for example 99024 is used 
for postoperative visits and considered as a replacement for a typical E&M code 
but does not exist in the “official” range of E&M codes).  In cases where these 
non-typical E&M codes are present in a note the user may not want the E&M 
wizard to automatically pop up at the end of the visit since the non-typical code 
satisfies the E&M requirement.   
To avoid having the E&M Coder pop up in these situations, check the box 
labeled “Hide E&M Coder if CPTs marked in CPT editor are “Encounter” 
kind of service.” If this option is checked then the E&M coder will treat any 
CPT codes that are marked as “Encounter” as if they were official E&M codes. 
Note:  This feature is designed to work with CPT codes whose Kind of 
Service type is marked as “Encounter” in the CPT details. To set a CPT code as 
an “Encounter” kind of service, click Reference in the Chart module.  Search for 
the CPT code, click the description of the code then click Select.  Click the 
Details button on the main toolbar to show the detailed information for the 
selected code.  Select Encounter from the Kind of Service dropdown list in the 
CPT Search screen (see screen shot below). 

 
• Diagnosis Properties: e-MDs Chart includes an E&M Code Calculator (see 

the Automation of the E&M Coder section for details); this calculation is an 
automated process. Part of the Medical Decision Making component of the 
E&M code is based on the number of diagnoses and their properties. For 
example, a new (acute) problem gets more ‘points’ than a single, stable chronic 
problem. 
There are three types of Diagnosis Properties: Severity (mild, moderate, or 
severe), Progress (improving, stable, or worsening), and Course (acute or 
chronic). 
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 To calculate the correct E&M code, therefore, it is critical that the properties of 
diagnoses in the Visit or Order Note are set correctly. At any time, you can 
select a diagnosis (in Assessment) and choose the Properties (severity) menu 
option to check these properties. Better yet, there is a mechanism built in to 
remind the user to check the diagnosis properties prior to closing the note. This 
reminder is a user preference, and can be turned on or off. If turned on, when 
the user clicks the Note Conclusion button, a pop up window will display all of 
the ICD codes and their properties. Any of the properties can be changed 
directly from that window. 

• Show Global Period Alert: The Global Period is the number of days that apply 
to a code being used for a patient.  If the code is used again within this period 
with the same primary diagnosis, then the other global rules are invoked.  A 
global alert is triggered if the patient is in a global period for any code.  The 
detail of the alert can be viewed to see the codes and date of service that 
triggered it, what the global period end date is, the physician who did the 
procedure and the diagnosis.   

Other Options: • Close Chart on Note Conclusion: For security purposes the patient chart can 
be set to automatically close when the note is signed-off.  Any time the note is 
closed through the Note Conclusion window, whether the provider chooses to 
Close Note/Edit Later or Close Note/Permanent Sign Off, the chart will 
automatically close if this option is chosen.   
Note:  To prevent the chart from closing automatically, clear the Close Chart 
on Note Conclusion option. 

• Use Outline Text As Default: This option sets the default view of the HPI 
section of any Visit or Order Note to Outline. In the HPI section, with the full 
generated text, it can sometimes be challenging to quickly pick out pertinent 
information.  The outline text feature allows you to decide if you want to see the 
HPI information with all the grammar and wording or just an outline of the 
pertinent information. By default, for a new install, the setting is to show the full 
text view.  Clicking the check box next to the Use Outline Text as Default field 
will change the default view to Outline.    
Note:  The view can be turned off and on “on the fly” by clicking a button at 
the top of the note (Outline View or Full Text View).  

• Show Detail In Current Problems: The Current Problems list shows 
diagnoses descriptions by default. There is a button in the Current Problems list 
that allows you to show a detailed view that adds the name of the person that 
added the problem to the list and the date it was added.  

• Print E&M Code on [Visit|Order] Notes: This will print the E&M code on 
whether the note is faxed or printed. 

• Show CPT Codes In Order Section: This option allows users to hide the CPT 
and HCPCS codes in the Orders section of all Visit an Order Notes.  This allows 
the note to be saved and printed with just the descriptions for these items 
showing.   
The default setting is to not show codes in the note. If you want codes to show 
up simply click add a check mark to the check box next to the choice. 
Note:  This option is user specific and can be set differently for each provider 
in the clinic.  When a note is created, the option for showing or not showing the 
codes is based on the preferences of the provider listed in the Visit Details. 
Therefore, no matter who starts the note (provider or assistant) the preference 
will be that of the provider of note. 
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 • Show CPT Codes In Plan Section: This option allows users to hide the CPT 
and HCPCS codes in the PLAN section of all Visit and Order Notes.  This 
allows the note to be saved and printed with just the descriptions for these 
items showing.  The default setting is to NOT show codes in the note. If you 
want codes to show up simply click add a check mark to the check box next to 
the choice. 
This option is user specific and can be set differently for each provider in the 
clinic.  When a note is created, the option for showing or not showing the codes 
is based on the preferences of the provider listed in the Visit Details. Therefore, 
no matter who starts the note (provider or assistant) the preference will be that 
of the provider of note. 

• Show Signature in Lab/Radiology Reports: Some Lab and Radiology test 
centers require a physician signature on the order forms that are sent to them.  
If this option is checked, the same signature that is used for signing faxed 
prescriptions will be added to any printed or faxed lab/radiology report that is 
created under the user’s name. 
Note:  In order for this option to work the user must have scanned signatures 
in the system (see the Utilities Guide: “Signatures” chapter for details).   

• Disable the Visit Summary (Meaningful Use): This user-specific setting gives 
users who are not participating in Meaningful Use an option to disable the Visit 
Summary. 
If the check box is selected, Visit Summary features that allow printing, 
exporting and sending a Visit Summary from the Note Conclusion screen will be 
disabled.  This will also disable the export of the Visit Summary into DocMan at 
note signoff.   
Upon saving this setting, whether disabling or re-enabling, a TaskMan message 
will be sent to the Administrator/User that is set for Break Security notification in 
the Administration Section of Chart Options.  The disabling or enabling of this 
option will also be tracked and reported in the Chart Audit Log.  See e-MDs 
Solution Series Reports User Guide for information on that report. 
When upgrading to a new version of Solution Series, the Options setting saved 
in the previous application version is retained.  New installs default to an 
enabled (clear check box) Visit Summary status. 

• Disable the OB Visit Summary (Meaningful Use): This user-specific setting 
gives users who are not participating in Meaningful Use an option to disable the 
OB Visit Summary. This works the same as the Disable the Visit Summary 
(Meaningful Use) option, except for OB visits. 

Visit/HS Options 
You can set options to auto expand specified sections of the Health Summary on a patient chart (blue 
header bars) whenever the chart is opened.  This allows providers to always have certain information 
open and available whenever they are in a chart. For example, the provider might want to set the Current 
Problems and Current Medications sections to always be open when the chart is open. 

Notes:   
• It is probably best to keep these choices down to a minimum number because of the limited 

desktop space. If you choose to open too many of the Health Summary sections you will have to 
scroll to see most of the information. 

• Before performing the steps below, the provider must first be logged into e-MDs Chart. This login 
links the preferences to the correct provider.  

To set the Health Summary options: 
1. Click File, and choose the Options menu option. 

2. In the e-MDs Chart Options window, click the Visit/HS tab. 

In the tab, a list of Health Summary items will be shown with check boxes to the left of each one. 



 

e-MDs Solution Series Chart User Guide 8.0 R01 46 

3. Place a check mark in the box next to those sections of the Health Summary that you want to 
default to open. 

Chart View Options 
The Chart View section of a patient’s chart has many different views of patient information.  Some users 
want to default to a certain view of Chart View whenever they open that section.  For example, some 
users want to see the Visit Notes pane, while others prefer to see the Chronology view.  This default view 
can be set as a user preference. 

Note:  The provider must first be logged into e-MDs Chart.  This login links the preferences to the 
correct provider.   

To set the Health Summary options: 
1. Click File, and choose the Options menu option. 

2. In the e-MDs Chart Options window, click the Chart View tab. 

3. In the dropdown field, choose the desired default view for Chart View by clicking the selection you 
want. 

The chosen selection will show up in the field. 

Health Summary Report Print Options 
In addition to the Current Problems, Allergies, Current Medications, Past Medical, Family and Social 
History information, the Health Summary report also prints upcoming tests/health maintenance items that 
are due for the patient and tests and procedures that have been performed on the patient. These last two 
choices are optional and users can choose not to print them. 

To set the Health Summary report print options: 
1. Click File then Options 

2. Select the Printing tab.   

3. Under the section labeled Health Summary Printing Options are two check boxes labeled “Print 
upcoming Tests/Health Maintenance items with Health Summary” and “Print Tests and 
Procedures with Health Summary.” If you don’t want these new sections to print with the Health 
Summary, clear the check box next the option or options you want. 

When you print all or part of the Health Summary, the clinic and patient demographics information will be 
inserted automatically in the printout.  

Entering Data 
e-MDs Solution Series provides several methods to streamline the entry of data in Chart. Those methods 
are described in detail below. 

Fast Forms 
Fast Forms offload some of the burden of data entry onto the patient. Because most offices would not be 
equipped to offer electronic data entry in the waiting room, and because all patients are familiar with filling 
out paper forms, e-MDs’ first attempt at patient-generated data is in the form of paper. Our patent-
pending process converts these paper forms into electronic data. 

For more information, read about Fast Forms in general in Recording Information With Fast Forms. Also 
read that section to learn how to create a Fast Form, how to print and scan it, and how to add the patient-
generated data to a note. 
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Templates 
Templates are documentation tools used in nearly every portion of Visit and Order Notes. A template is 
an organized series of data points preceded by check boxes. Only those items that the user checks are 
added to the note. Sometimes checking a box causes another "level" of the template to open, allowing 
more detailed documentation. For example, in an HPI template, if you check that the patient has had a 
cough, the next level may ask for details such as duration and character. For the most part, these details 
are not required documentation elements; answer them if desired, or ignore them. 

For detailed information on using templates in a note, see Accessing Templates in Visit and Order Notes. 

Entering Free Text 
Because every possible situation cannot be anticipated, Chart also provides free-text areas where you 
can enter your unique detailed information. 

To add free text: 
1. Click the Free Text icon. 

Free text can be added in the Health Summary, Visit Note, or Order Note at any place with a Free 
Text icon, which is represented as a small gray circle that turns into a yellow square when the 
cursor hovers over it.  

2. Type into the Free Text window and then click Save. 

To edit or delete free text: 
1. As the cursor is run over the free text in a Visit or Order Note, text fragments highlight red. With 

any red-highlighted text fragment, perform a single left mouse click to reopen the Free Text 
window. 

2. To edit free text, simply make changes as necessary in the Free Text window, and then click 
Save. 

OR 

To delete the entire text from a Free Text window, click Clear and then click Yes in the Delete 
Confirmation window. 

Paste Text from Another Source into a Patient's Chart 
Electronic text copied from another source can be pasted into the Health Summary, Visit Note, or Order 
Note at any place with a Free Text icon, which is represented as a small gray circle. When the cursor is 
run over a Free Text icon, it turns into a yellow square.  

To paste text from another source: 
1. Click the Free Text icon. 

2. Paste text into the Free Text window and then click Save. 

Hint! Highlight text to be copied and then press Ctrl+C. This copies the text to the computer’s 
clipboard. When the Free Text window is open, paste the copied material by pressing Ctrl+V. 

Use Voice Recognition in a Visit or Order Note 
e-MDs does not warrant that any speech recognition software will work within e-MDs Chart, and no 
application-specific voice commands have been developed. However, most voice recognition software is 
designed to work within any Windows-based product. In limited testing, most of the typical voice-to-text 
functions appear to work within the Free Text windows of e-MDs Chart. Expanded functionality, such as 
voice correction of misrecognitions may not be possible. Another option is to dictate into the speech 
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recognition product’s dictation window (with it’s full functionality), and then copy and paste the text into e-
MDs Chart as described above. 

To add speech recognition-generated text to the chart: 
1. Click any Free Text icon. 

In the Health Summary, a Visit Note or an Order Note, Free Text icons are represented as small 
gray circles that turn into yellow squares when the cursor is run over them.  

2. With the Free Text window open, turn on the microphone and begin speaking. Text will appear in 
this window.  

3. When finished, turn off the microphone and click Save. 

To add medical art to a note: 
1. With a Visit or Order Note open, click the Art button at the bottom of the Chart navigation bar.   

This navigation bar runs vertically between the Health Summary and the note.  This opens the 
Medical Art Quick Selector window.  The age and gender of the patient will determine the body 
figure that is displayed. 

 
2. To view and select art associated with a specific area of the body or “Hotspot”, select the type of 

art desired by clicking one of the tabs at the top right.  Choices include Exam, Patient Ed, or 
Reference.   
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3. To view linked images after selecting the type of art, click the area of the body for which medical 
art is needed. 

 
4. Click the Hotspot area to open the thumbnails window.  This displays all linked Medical Art 

images. 

 
5. Click the image desired to open the image in the Medical Art Editor window. 

 
6. Close the Medical Art Editor window by clicking the X in the top-right corner.   

The image will be added to the Medical Art Quick Selector Thumbnail Strip prior to its addition to 
the note. 
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7. If desired, repeat the above steps to insert additional linked medical art images in the Thumbnail 

Strip that will also be added to the note. 

8. When done, close the Medical Art Quick Selector window.  This adds the art displayed on the 
Thumbnail Strip to the bottom of the note. 
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Beginning a New Note 
Use the following procedure to start any new Visit or Order Note in Chart. 

To open a new Visit or Order Note: 
1. Use one of the following methods to select the patient:  

○ If using e-MDs Chart as a standalone application, click Demographics on the main toolbar 
and then select the Patients menu option.  

Additional options to access a patient chart include clicking the yellow folder icon near the 
upper-left corner of e-MDs Chart or clicking the white prompt indicating Click Open Patient 
Chart in the File Menu to Begin.  Either method will open the Find Patient window. 

○ If launching e-MDs Chart from Tracking Board with the patient’s name appearing anywhere in 
that window, click the name and select either the Collect Vitals/Visit Note, 
Physician/Provider Start, or Show Chart menu option.  

If the patient's name does not appear within the Tracking Board window, use one of the 
methods described in the above item (clicking Demographics, the yellow folder icon, or the 
white text prompt). 

2. Enter the search criteria into any of the fields (such as patient name, social security number, or 
account number) and press Enter or click Search. 

3. Select the correct patient from the search criteria and either double-click the name or click Select. 

4. Click the New Note icon on the gray toolbar below the blue patient identifier bar. This icon is a 
white sheet of paper (immediately to the right of the FlowSheets tab). 

 
5. Select the Doctor’s Visit, Nurse’s Visit/Verbal Orders, Order Note, or Telephone/Log/Rx 

Note menu item. The only difference between a Doctor’s Visit and Nurse’s Visit/Verbal Orders 
is the Visit Details window. These two notes are generally referred to as "Visit Notes." Selecting a 
Nurse Visit allows the nurse to be the primary healthcare provider for the visit, including the 
responsibility of permanently signing the note. 
Order Notes may or may not be associated with an office visit and can be used to track and verify the 
completion of orders for patient care beyond an office visit. Order Notes must be signed off by the provider 
after completion of the order(s).The Telephone/Log/Rx Note provides an option to make notes of 
patient’s calls, to log information that is not related to a specific clinic visit, and to make notes 
regarding prescription handling. 



 

e-MDs Solution Series Chart User Guide 8.0 R01 52 

 
Notice that this note also includes an OB check box that is checked automatically when the 
patient has been identified as pregnant.  The OB- notation is also added to the subject line 
automatically to highlight any logged information as being related to a pregnant patient.  When 
the OB check box is selected, the Confidential check box is also disabled, giving priority to the 
OB status. 

6. Complete the fields in the Visit Details window. See Visit Details Options for more information. 

Visit Details Options 
The Visit Details window of the Visit Note or Order Note must be completed prior to initiating a new note. 

 
For a description of available Visit Details options, see the following table. 
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Doctor's Visits, Nurse's 
Visits/Verbal Orders 
and Order Note Options 

 

Date and Time The current Date and Time that a note is initiated is automatically recorded. At any 
point prior to signing the note, the date can be changed. Time can be changed, but 
cannot be erased. Note that although the note date may change, any prescriptions 
written or CPTs ordered will retain the actual date. 

Healthcare Professional 
Type (Order Note Only) 

Two options are available: 
• Provider: Selecting this option will cause a drop-down list of active staff 

providers to be displayed. 
• Clinical Staff: Selecting this option will cause a drop-down list of clinical staff 

members to be displayed. 
Type of Encounter Doctor:  Type of Encounter is a required field. This information is recorded at the 

top of the note and is used in calculating the E&M code for the visit or order. If you 
typically have one type of encounter, such as Office or Other Outpatient Services, 
this can be set as a default.  
Nurse:  This includes a wide range of nursing and non-nursing services such as 
emergency room, home services, rest home, and so forth. 

Health Care Professional Click the down-arrow in the Health Care Professional field and select the primary 
care provider for the current Visit or Order Note. 
Note:  Physician Assistants and Nurse Practitioners should perform "Doctor’s 
Visit" notes rather than Nurse Notes. 

Supervisor Doctor:  If the Health Care Professional is a Physician Assistant or Nurse 
Practitioner, his or her Supervising Physician should be entered in the Supervisor 
field. If a default Supervisor was specified, this field will automatically be filled in. 
(See Physician Assistant and Nurse Practitioner set-up instructions in e-MDs 
Solution Series Administration Guide for information on selecting a default 
Supervisor). If no default Supervisor has been selected, click the down arrow in that 
field to choose a supervising physician. 
Nurse:  The Nurse or Medical Assistant responsible for the Nurse Visit can 
document his/her Supervising Physician in the Supervisor field. Click the down 
arrow in that field to choose a physician. 
Order:  If the Healthcare Professional Type selected in an Order Note is a clinical 
staff member, the Supervisor field is a required field and a value must be selected. 
This is to ensure that any lab order forms resulting from the Order Note will list the 
correct ordering provider. 

Assistant Doctor:  If desired, an Assistant (such as a nurse or medical assistant) can be 
documented in the third field. Click the down arrow for a list of all Clinical Staff 
members. 
Nurse:  If the primary provider was assisted by another Nurse or Medical Assistant, 
that assistant’s name can be documented in the third field. Click the down arrow for 
a list of all Clinical Staff members. 

Location Document the location of the visit in this field. If a default location has been assigned 
to the computer, this field will already be filled in. (For details on setting a default 
location, see e-MDs Solution Series Administration Guides.) If a default location has 
not been assigned, click the down-arrow for a list of all facilities. 

Appointment This field shows the appointment that corresponds with the current day's visit note.  
This field should be filled out automatically, but you can click the Search button 
(magnifying glass icon) to search for and select an appointment to link to the visit. 
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Telephone/Log/ 
Rx Notes 

 

Note Class The classification of the note – Log, Phone or Prescription. 
Note Type Permanent (which requires a signature) and Sticky (no signature required). 
Confidential Follows standard Chart handling of confidential information. 
Subject A brief identification of the purpose of the note. 
Text Field The body of the note itself. 

Using Past Visits and Shortcuts 
A Past Visit loads the information contained in a previous visit into the current visit. This includes all 
templates, medications, orders, and patient education handouts. The only items that do not transfer are 
vital signs and health summary data (such as past medical history, allergies, current medications, current 
problem list, and immunizations). 

To load a past visit: 
1. In an active Visit or Order Note, click the CC heading (Chief Complaint) and select the Past Visit 

menu item.  

OR 

Click the black arrow next to the CC button in the vertical button column and select the Past 
Visit option. 

Note:  To use a past visit, it must be loaded prior to documenting any section of the note that 
carries forward from the prior visit. This means that only vital signs and health summary data 
(such as Past Medical History, Current Problem List, Immunizations, Allergies, Current 
Medications) can be documented prior to loading the past visit. If any other section of the current 
note (i.e., Chief Complaint, HPI) contains data, the past visit cannot be loaded (the Past Visit 
menu item will be disabled). 

This opens the Load Visit window. Past Visits are identified by date, provider, and diagnoses. 
Every prior visit for this patient that has been signed off will appear in this window. 

Note:  If a Doctor’s Visit is initiated, the Load Visit window will show only prior physician 
encounters and not any Nurse Visits (and vice versa). 

2. Click to select and load the desired past visit.  

OR 

Click Cancel to close the window without loading a past visit. 

Note:  Template-generated text from the past visit is a grayish-blue color. This serves as a 
visual clue that the documentation came from a past visit. If any template is reopened (possibly 
for editing or deleting information), the templated text in the note will then turn black. 

3. After the past visit is loaded, you can edit, delete, or augment any portion of that documentation. 
You can also add other items to the note at this point. 

Loading a Shortcut Visit 
Shortcuts offer rapid documentation by loading the majority of the note with one click, and allowing the 
physician to concentrate on "documenting by exception." Documentation from a shortcut can include 
templates, free text, prescriptions, orders, E&M coding, and patient education handouts. The only items 
that cannot be included in a shortcut are vital signs and health summary data (such as past medical 
history, allergies, current medications, current problem list, and immunizations). 
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To load a shortcut visit: 
1. In an active Visit or Order Note, click the CC heading and select the Shortcut menu item.  

OR 

Click the black arrow next to the CC button in the vertical button column and select the Shortcut 
option. 

To use a shortcut visit, it must be loaded prior to documenting any section of the new note that 
might be included in a shortcut. That means that vital signs and health summary data (such as 
Past Medical History, Current Problem List, Immunizations, Allergies, Current Medications) can 
be documented prior to loading the shortcut. If any other section of the current note (i.e. Chief 
Complaint, HPI) contains data, the shortcut visit cannot be loaded (the shortcut menu item will be 
disabled). 

This opens the Load Shortcut window. Shortcuts are listed by title, and the window includes a 
search field. 

Note:  Shortcuts may involve templates that are age or gender specific, and they may not be 
available for all patients. For example, a shortcut visit created on a male patient that uses the 
Male Exam template will not be available in female patients’ charts. The user must either create 
shortcut visits for both sexes, or create gender-neutral templates for use with shortcuts. 

2. Click the desired shortcut to load it.  

OR 

Click Cancel to close the window without loading a shortcut. 

Note:  Template-generated text from the shortcut is a grayish-blue color. This serves as a visual 
clue that the documentation came from a shortcut. If any template is reopened (possibly for 
editing or deleting information), the templated text in the note will then turn black. 

3. After the shortcut is loaded, go ahead and edit, delete or augment any portion of that 
documentation. You can also add other items to the note at this point. 

Documenting the Visit 
The information included in the Visit and Order Notes provides a comprehensive description of the 
patient's overall health status. 

Adding the Chief Complaint 
In an active Visit Note or Order Note, scroll to the CC (Chief Complaint) heading, or click the CC button in 
the vertical navigation button row. 

 
The best option for documenting the Chief Complaint is through a template. There are two specific 
advantages of using a template. First, Chief Complaint templates can automatically drop the patient's 
age, gender, and race (if this has been entered in the demographics) into the note. Second, these 
templates can be built to automatically add the correct ICD-9 code to the visit based on the chief 
complaint(s) selected. 

Another option is to type the Chief Complaint as free text. 
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To use a CC template: 
1. Click the template icon (a gray square with a black check mark) located next to the CC heading to 

see a list of available CC templates.  

2. Click the title of the desired template. 

3. When the template opens, select the appropriate answers.  

Note:  In e-MDs’ template, the chief complaint may be a symptom, a disease, or a specific type 
of visit, such as "Annual Physical." The patient demographics are added automatically by virtue of 
using the template, so there is no need to click any check boxes for this to occur. 

4. To close the template, click anywhere outside the template levels 

OR 

Close the template when finished by clicking the X in the upper-right corner of Level One (the first 
template window). There is no need to close each window individually because closing Level One 
will close the entire template. 

See Accessing Templates in Notes for more information. 

To use free text: 
1. Click the free text icon (the white circle with a gray outline, located to the right of the template 

icon). This opens a Free Text window.  

2. Type in this window and click Save. 

Using Automatic ICD-9 Coding with Templates 
Items in the CC (Chief Complaint) templates can be linked to ICD-9 codes. Linking structured pieces of 
data to template items is done using components called Extended Attributes in the Template Editor.  

With a CC template containing ICD-9 Extended Attributes, as you click off the reason for the visit (such as 
"sore throat", "annual physical"), the corresponding ICD-9 code is automatically added to the Assessment 
section in the note. (A diagnosis is not required; ICD-9 codes exist for symptoms and other complaints, as 
well.) 

In addition, the reason for the visit is added to the HPI (History of Present Illness) section, along with the 
ICD code, although the code is not visible on screen. This eliminates the ICD search that was required 
there in prior versions of e-MDs Chart. Remember that templates are linked to ICD codes, so in order to 
find the corresponding HPI template(s), ICD-9 code(s) need to be present in the HPI. Therefore, selecting 
a complaint in a CC template eliminates the need for a manual ICD search in the HPI, and automates the 
process of presenting the appropriate template(s) in the HPI. 

The primary Chief Complaint template created by e-MDs already has ICD-9 codes linked to it. You can, 
however, easily change it in the Template Editor if necessary (see the "ICD-9 Extended Attributes" 
section in e-MDs Solution Series Administration Guide in the Template Editor chapter for details). ICD-9 
Extended Attributes can be incorporated into any new CC templates created by the user. 

Any ICD-9 codes added in the HPI can be changed in the Assessment section. This is helpful when the 
patient presents with a symptom and, after a thorough history and examination, a more specific diagnosis 
can be made. For example, if the presenting complaint is "earache", the ICD-9 code for that symptom can 
be changed to the code for "Otitis Media" in Assessment. Changing the ICD-9 code in Assessment will 
not affect any of the text in the CC or HPI sections. 

Documenting the History of Present Illness (HPI) 
The easiest way to add a problem to the HPI is to select it in the CC (Chief Complaint) template. The 
complaints in the CC template are linked to ICD codes, eliminating the need to do a separate ICD search. 
See Using Automatic ICD-9 Coding with Templates for more information. 
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A diagnosis, symptom or other reason for the visit can also be selected in the History of Present Illness 
(HPI) section. 

 

Note:  If the reason for the visit is for follow up of an established diagnosis, see the To add a follow-up 
diagnosis procedure for steps to document the visit follow up. 

To add new problems: 
1. In an active note, click the HPI (History of Present Illness) heading and select the New menu 

option.  

OR  

Click the black arrow next to the HPI button in the vertical button column, and select New. 

Medicapaedia search option: Medicapaedia is a database of clinical terminology. It includes 
diagnosis/symptom descriptions and associated codes. 

2. In the Search field, type the first few letters of a diagnosis or symptom (or type the ICD code) and 
then click the Search button located on the toolbar at the top of the Medicapaedia Search window 
(or just press the Enter key). 

3. In the search results, select (click) the check box next to each description to be entered in the 
note and then click the Select button on the toolbar. 

This action adds the diagnosis code to the Assessment section of the note and adds the 
diagnosis description to the HPI and Plan sections. 

If the patient is returning with an established diagnosis, the diagnosis can be added to the HPI section as 
a follow-up. (The user still has the option to choose that diagnosis in the Chief Complaint template 
instead.) 

To add follow-up problems: 
1. In an active Visit or Order Note, click the HPI (History of Present Illness) heading and then select 

the Follow Up menu option.  

OR 

Click the black arrow next to the HPI button in the vertical button column, and then select Follow 
Up. This displays the patient’s Current Problem List.  

2. Click any problem in the list to add it to the note.  

OR 

If the problem is not listed in the Current Problem List, click All Problems at the bottom of that 
window for a list of all diagnoses ever assigned to that patient. Then click any problem from that 
list to add it to the note. 

This action adds the diagnosis code to the Assessment section and the diagnosis description to 
the HPI and Plan sections. 

Problems can be removed from the note from either the HPI or Assessment section.  

To remove a problem: 
1. Click the bold black diagnosis description and select the Delete menu option.  
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2. Click Yes in the Delete Confirmation window. 

Notes:   
○ If a diagnosis is deleted from HPI, it will automatically be removed from the Assessment and 

Plan sections. Associated HPI and Plan templates and free text will also be deleted. Any 
existing orders and prescriptions will be moved to the non-linked Other Orders and Other 
Prescriptions section of Plan. 

○ If a diagnosis is deleted from the Assessment section, it will automatically be removed from 
the Plan. Information gathered in the HPI section, however, will not be affected. Associated 
Plan templates and free text will also be deleted. Any existing orders and prescriptions will be 
moved to the non-linked Other Orders and Other Prescriptions section of Plan. 

To document the HPI: 
1. In an active Visit or Order Note, click the HPI (History of Present Illness) heading.  

OR 

Click the HPI button in the vertical button column to "jump" to that section of the note. 

Note:  Complaints, Symptoms, or Diagnoses must first be entered in the HPI section. This can 
be done through the CC (Chief Complaint) template, an ICD search, or by choosing a Follow Up 
problem from the Current Problem List. Then, the history itself can be documented.  

The template icon (a gray square with a black check mark) will appear to the right of the bold 
black diagnosis heading.  

2. Click the template icon to see if any linked HPI templates are available for the given diagnosis. 
For information about the template icon and the Template Links, see the Accessing Templates in 
a Visit or Order Note section. 

3. If a linked template is available, choose whether to use the blank template, a pre-clicked 
template, or a past template (see Accessing Templates in Visit and Order Notes section for 
information).  

Open the appropriate template type, document by clicking the check boxes, and close the 
template. Template-generated text will drop into the chart. In addition, free text can be typed to 
document any information not covered in the template. 

4. If no linked templates are available, you can choose to use either a generic HPI template or free 
text (typing) to document basic information. Note that calculation of the E&M Code depends, in 
part, on the number of questions asked in the HPI. The automatic calculation of the E&M Code 
will be inaccurate if a template is not used to document this history. 

Documenting the Review of Systems (ROS) 
As with other sections, Review of Systems supports the use of both Fast Forms and Templates to 
document information. 

 

To document the ROS: 
1. In an active Visit or Order Note, scroll to the ROS (Review of Systems) heading.  

OR 
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Click the ROS button in the vertical button column to "jump" to that part of the note. 

2. You can choose to use a Fast Form to document the Review of Systems (ROS). To drop a Fast 
Form answer set into a given note, click the Fast Form option, located on the gray bar just above 
the note. 

3. Another option is to use a template. The template icon (a gray square with a black check mark) 
will appear to the right of the bold blue ROS heading. Click it for a list of age and gender-linked 
ROS templates. (See the Accessing Templates in Visit and Order Notes section for information 
about the template icon and the Template Links.) 

When using a template, you can choose whether to use the blank template, a pre-clicked 
template, or a past template (see the Accessing Templates in Visit and Order Notes section for 
information).  

4. Open the appropriate template type, document by clicking the check boxes, and close the 
template. Template-generated text will drop into the chart.  

5. In addition, free text can be typed to document any information not covered in the template. Note 
that calculation of the E&M Code depends, in part, on the number of systems reviewed in the 
ROS; the automatic calculation of the E&M Code will be inaccurate if a template is not used to 
document the ROS. 

Recording Past Medical, Family Medical, Social Histories 
If this is the patient's first visit, you will need to add information about the patient's current and past health, 
along with family medical and social histories. Medical History refers to the following sections:  

• Past Medical History 

• Surgical History 

• Family History 

• Social History 

• Tobacco/Alcohol/Supplements 

• Substance Abuse History 

• Mental Health History 

• Communicable Disease History 

Updates to any of these sections should be made in the Health Summary. 

Note:  Using SNOMED codes to document history for a first degree relative is a Stage 2 Meaningful Use 
requirement. The diseases in the FMH by Individual (positive/negative responses) template have been 
linked to the required codes. Family Medical History will display in a C-CDA file only if you use the FMH 
by Individual (positive/negative responses) template. 

You can choose to automatically add the Medical History to every new Visit or Order Note (see 
Automatically Add Health Summary to Note for details). Note that if this automated option is chosen, the 
entire Medical History will be added to the note. The non-automated process described below permits 
inclusion and exclusion of the various subsections of Medical History. 
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To add medical history items to the current note: 
1. In an active note, click the PMH/FMH/SH (Past Medical History/ Family Medical History/ Social 

History) heading and select the Add option.  

OR 

Click the black arrow to the right of the PMH button in the vertical button column, and then select 
Add. 

2. This will open the Past Medical History Options window. 

3. Click the check box next to each blue history element that is to be added to the note.  

○ Click Select All to automatically check every check box and add the complete History to the 
note. Deselect All will clear every check box. 

○ Legacy Data is clinical history converted from e-MDs Chart 3.0 into e-MDs Chart 4.0 or 4.1. If 
no conversion was run, or if the patient did not have clinical data recorded in e-MDs Chart 3.0, 
there will be no Legacy Data. 

4. Decide whether the note will merely indicate that the selected History items were reviewed or 
whether the entire History text itself will be displayed.  

○ Click the Reviewed Notation button under any History item to add the quote "Reviewed" to 
the note. (For example: "Past Medical History: Reviewed.") Click Set Selected to Reviewed 
Notation to automatically click this button for every checked History item. 

○ Click the Complete Text button under any History item to add the entire History text to the 
note. Click Set Selected to Complete Text to automatically click this button for every 
checked History item. 

5.  Click Save. 

6. If the Medical History has not yet been added to the note, edit the History in the Health Summary 
(see the "Add/Edit/Delete History Items" section for details), and then add the History to the note 
(see the To add medical history items to the current note procedure for details.)  

7. If the Medical History has already been added to the note, it can still be updated (in both the 
Health Summary and the note) by following the steps outlined below. 
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To edit medical history and refresh the note: 
1. In an active Visit or Order Note, scroll to the PMH/FMH/SH (Past Medical History/ Family Medical 

History/ Social History) section, or click the PMH button in the vertical button column to ‘jump’ to 
that part of the note. View the History that has been added to the note. 

2. Click the PMH/FMH/SH heading or the black arrow next to the PMH button (in the vertical button 
column), and select Edit. This opens the Medical History sections of the Health Summary. Make 
edits just as you would in the Health Summary (see the Add/Edit/Delete History Items section for 
details).  

3. Close the Past Medical History Maintenance window by clicking the X in the upper right corner. 

4. At this point, the changes have only been made in the Health Summary, not in the note. To 
update the note with these changes, click the PMH/FMH/SH heading or the PMH button and then 
select Refresh. 

OR 

Click the Refresh All button on the toolbar above the note 

 

Note:  The Refresh All will refresh ANY Health Summary items that are in the note.  It will not 
add Health summary information that was not previously added to the note.  

To delete medical history from a Visit or Order Note: 
In an active note, click the PMH/FMH/SH (Past Medical History/ Family Medical History/ Social 
History) heading and select Remove.  

OR 

Click the black arrow next to the PMH button in the vertical button column, and then select Remove. 
This removes the History from the note, but not from the Health Summary. 

Updating the Current Problem List 
Updates to the Current Problem List should be made in the Health Summary (see "Add a Problem 
Directly to the List" for details.) Follow the directions below to add the Current Problem List to a Visit or 
Order Note. 

Users may choose to automatically add the Current Problem List to every new Visit or Order Note (see 
the "Automatically Add Health Summary to Note" section for details). The following instructions describe 
how to add that information to the note in the case that auto-population is not chosen. 

To add current problem list to a Visit or Order Note: 
In an active Visit or Order Note, click the Current Problems header in the note and select the Add 
option.  

OR 

Click the black arrow next to the Prblm button in the vertical button column, and then select Add. 

Notes:   
○ Additional free text can be added to any of the Current Problems by clicking the free text icon 

following the problem description. 

○ The entire Current Problem List must be added to the note; it is not possible to add only a 
portion of the list. 
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To edit current problems and refresh the note: 
If the Current Problem List has been added to the note (see the To add current problem list to a Visit 
or Order Note procedure for details), and then the list is updated in the Health Summary, those 
updates can be reflected in the Note. 

In an active Visit or Order Note, click the Current Problems header in the note and select the 
Refresh option.  

OR 

Click the black arrow next to the Prblm button in the vertical button column, and then select Refresh. 
This will update the note with the changes recently made in the Current Problem List. 

OR 

Click the Refresh All button on the toolbar above the note. 

 

Note:  The Refresh All will refresh ANY Health Summary items that are in the note.  It WILL NOT 
add Health summary information that was not previously added to the note.  

To delete current problem list from a Visit or Order Note: 
In an active Visit or Order Note, click the Current Problems header in the note and select the 
Remove option.  

OR 

Click the black arrow next to the Prblm button in the vertical button column, and then select Remove. 
This removes the Current Problem List from the note, but not from the Health Summary. 

Tracking Immunizations 
Updates to the Immunization Log should be made in the Log directly (see Document an Immunization for 
details.) Follow the directions below to add the Immunization Log to a Visit or Order Note. 

Users may choose to automatically add the Immunization Log to every new Visit or Order Note (see 
Setting Preferences for Visit and Order Notes for details). The following instructions detail how to add that 
information to the note in the case that auto-population is not chosen. 

To add immunization log to a Visit or Order Note: 
In an active Visit or Order Note, click the Immunizations header in the note and choose the Add 
option.  

OR 

Click the black arrow next to the Immz button in the vertical button column, and then select Add. 

Notes:    
○ Additional free text can be added to any of the immunizations by clicking the free text icon 

following the vaccination description. 

○ The entire Immunization Log must be added to the note; it is not possible to add only a portion of 
the log. 
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To edit immunization log and refresh the note: 
If the Immunization Log has been added to the Visit or Order Note (see the To add Immunization Log 
to a Visit or Order Note procedure for details), and then the log is updated, those updates can be 
reflected in the note. 

In an active Visit or Order Note, click the Immunizations header in the note and select the Refresh 
option.  

OR 

Click the black arrow next to the Immz button in the vertical button column, and then select Refresh. 
This will update the note with the changes recently made in the Immunization Log. 

OR 

Click the Refresh All button on the toolbar above the note. 

 

Note:  The Refresh All will refresh ANY Health Summary items that are in the note.  It WILL NOT 
add Health summary information that was not previously added to the note.  

To delete immunization log from a Visit or Order Note: 
In an active Visit or Order Note, click the Immunizations header in the note and select the Remove 
option.  

OR 

Click the black arrow next to the Immz button in the vertical button column, and then select Remove. 
This removes the Immunization Log from the note, but otherwise does not affect the original 
Immunization Log.  

Tracking Allergies 
Updates to Allergies or Adverse Reactions should be made in the Health Summary (see Add an Allergy 
or Adverse Reaction section for details.) 

Users may choose to automatically add Allergies to every new Visit or Order Note (see Setting 
Preferences for Visit and Order Notes for details). Note that if this automated option is chosen, only the 
Drug Allergies will be added to the note. The non-automated process described below permits inclusion 
of the Non-Drug Allergies, if desired. 

The following instructions describe how to add that information to the note in the case that auto-
population is not chosen. 

To add allergies to a Visit or Order Note: 
1. In an active Visit or Order Note, click the Allergies header in the note or click the black arrow 

next to the Allrg button in the vertical button column.  

2. Select Add to add just the Drug Allergies to the Note.  

OR 

Select Add Details to be choose either both Drug and Non-Drug Allergies or just Non-Drug 
Allergies. 
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Notes:    
○ Additional free text can be added to any of the allergies (or adverse reactions) by clicking the free 

text icon following the allergen name. 

○ The entire list of Drug (and/or Non-Drug) Allergy/Adverse Reactions must be added to the Visit or 
Order Note; it is not possible to add only a portion of either list. 

If the Allergy/Adverse Reaction list has been added to the Visit or Order Note (see the To add allergies to 
a Visit or Order Note procedure for details), and then the Allergy List is updated in the Health Summary, 
those updates can be reflected in the Note. 

To edit allergies and refresh the Visit or Order Note: 
1. In an active Visit or Order Note, click the Allergies header in the note or click the black arrow 

next to the Allrg button in the vertical button column.  

2. Click the Refresh All button on the toolbar above the note. 

 

Note:  The Refresh All will refresh any Health Summary items that are in the note.  It WILL 
NOT add Health summary information that was not previously added to the note.  

To delete allergies from a Visit or Order Note: 
1. In an active Visit or Order Note, click the Allergies header in the note or click the black arrow 

next to the Allrg button in the vertical button column.  

2. Click Remove. This removes the Allergies from the note only, and does not affect the Health 
Summary. 

Updating the Current Medication List 
Updates to the Current Medications should be made in the Current Medications section of the Health 
Summary (see “Add a Drug to the Current Medication List” for details).  To expedite entry of this 
information, the Current Medication template can also be used. 

Users may choose to automatically add Current Medications to every new Visit or Order Note (see Setting 
Preferences for Visit and Order Notes for details).  

The following instructions describe how to add that information to the note in the case that auto-
population is not chosen. 

To add current medications to a Visit or Order Note: 
1. In an active Visit or Order Note, click the Current Medications header in the note or click the 

black arrow next to the Meds button in the vertical button column.  

2. Click Add. 

Notes:    
○ Additional free text can be added to any of the medications by clicking the free text icon following 

the medication. 

○ The entire Current Medication List must be added to the note; it is not possible to add only a 
portion of the List. 

○ If there are no medications in the Current Medication list and the user chooses to add Current 
Medications to the note (automatically or manually) a notation of “None” will appear in the note. 
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If the Current Medication List has been added to the note (see the To add current medications to a Visit 
or Order Note procedure for details) and then the list is updated in the Health Summary, those updates 
can be reflected in the Visit or Order Note. 

To edit current medications and refresh Visit or Order Note: 
1. In an active Visit or Order Note, click the Current Medications header in the note or click the 

black arrow next to the Meds button in the vertical button column. 

2. Click the Refresh All button on the toolbar above the note. 

 

Note:  The Refresh All will refresh ANY Health Summary items that are in the note.  It WILL 
NOT add Health summary information that was not previously added to the note.  

To delete current medications from a Visit or Order Note: 
1. In an active Visit or Order Note, click the Current Medications header in the note or click the 

black arrow next to the Meds button in the vertical button column.  

2. Click Remove. This removes the Current Meds from the note only, and does not affect the 
Current Medications in the Health Summary. 

Documenting Lab and Test Results 

To document lab or test results in a Visit or Order Note: 
1. In an active Visit or Order Note, scroll to the Lab/Test Results section, or click the Labs button in 

the vertical button column. 

Note:  This section is meant to document lab or test results that are available during the visit, 
not results that come in at a later date. 

2. Use a template to document results. The template icon (a gray square with a black check mark) 
will appear to the right of the bold blue Lab/Test Results heading. Click it for a list of available 
templates. (See the Accessing Templates in a Visit or Order Note section for information about 
the template icon and the Template Links.) 

3. Choose whether to use the blank template, a pre-clicked template, or a past template (click any of 
the underlined items for further information). Open the appropriate template type, document by 
clicking the check boxes, and close the template. Template-generated text will drop into the 
Chart.  

4. If needed, type free text to document any information not covered in the template. 

Note:  Also see Accessing FlowSheets in Templates for information on capturing lab and test results 
in FlowSheets for inclusion in notes. 

Collecting Vital Signs 
Setting User Preferences in Vitals 
With no user preferences set, the Vital Signs window displays General Vitals, consisting of weight, height, 
body mass index, waist circumference, temperature, respiration, blood pressure, and pulse. The default 
data entry mode units of measurement are: Weight = lb, Height = ft and in, Waist circ = in, Head circ = 
cm, Temp = F, Fundal Ht = cm.  In the Vitals module, the user can enter standard or metric data into the 
fields based on their preferences.  The corresponding unit per field will be Read Only. 
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User Preferences allow the user to add other types of Vitals, such as Respiratory (peak flow and oxygen 
saturation), OB-Gyn, Ophthalmology, Pain Index, and Intensive Care Vitals. The data entry mode can be 
changed to Metric or Standard combinations.  As User preferences are saved, the corresponding field will 
be disabled/Read Only.  The User Preferences are tied to the current user’s login, and only that user will 
see the changes. 

To set user preferences: 
1. Open the Vital Signs window. To do that, either:  

Click the Vitals button on the Chart toolbar (with the red thermometer icon). 

OR 

In an active Visit or Order Note, click either the Vitals heading or the Vital button (in the vertical 
button column), and then click the Edit Vitals button. 

2. In the Vital Signs window, click the User Preferences button. 

3. In the Vitals User Preferences window, be sure that A Permanent Change is checked. (Check 
This Instance Only to make changes to User Preferences on the fly. These changes will apply 
only to the current visit, after which the Preferences will revert back to the user’s original settings.) 

4. Select Standard or Metric combinations. Note that if a standard measurement is entered, its 
metric equivalent is also displayed, and vice versa. Selecting the mode determines which fields 
will allow data entry or become disabled/Read Only. 

5. Click the check boxes next to the desired Vital Signs types to add them to the User Preferences. 

6. Click Save. 

Note that the additional Respiratory Vitals and the Pain Index appear under the General tab. OB-Gyn 
and Intensive Care Vitals appear under their own tabs. Ophthalmology and Auditory vitals appear on 
a shared tab labeled. Visual/Auditory.  OB-Gyn Vitals will not appear for male patients. 

Adding, Editing, and Deleting Vital Signs 
Note:  To view information about the source of vital sign ranges or calculations, click the Info button 
located in the Vital Signs window and then select an option to display the respective source information. 

 
If the physical layout of the clinic includes a separate vital sign station (prior to the patient being checked 
into an examination room), vital signs may be entered into the patient’s chart prior to the note being 
opened. 

To add vitals outside of a Visit or Order Note: 
1. Open the patient’s chart. 

2. Click the Vitals button on the Chart toolbar (with the red thermometer icon). 

3. Enter values for any vital signs and click Save. 

4. Later, after the current note has been opened, click either the Vitals heading in the Visit or Order 
Note, or the black arrow next to the Vital button in the vertical button column, then select the Add 
Existing Vitals menu option. This will add the previously recorded vital signs to the current note. 

Notes:   
○ Once Existing Vitals are added to a Visit or Order Note, those vitals are deleted from the 

original Vitals window (the window that opens from clicking Vitals on the Chart toolbar). 
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○ Do not use the Vitals entry from the toolbar to enter any vital signs that will not eventually be 
dropped into a Visit or Oder Note, as they will not be saved in the Vitals History. 

○ If the user is unaware that Existing Vitals have been done, and mistakenly enters new vitals in 
the note, the original set of vitals can still be used. Click Add Existing Vitals and the original 
(first) vitals will appear in the Current Vitals section, and the second set of values will be 
displayed as Repeat Vitals. 

○ If the user preference for height units has been set for feet and inches, the user can enter the 
total feet and additional inches separately, or can convert the feet to inches and insert the total 
height in the inches field if preferred.  In either case, the height will be retained in the database 
as total inches for use in computing the Body Mass Index.    

To add vitals directly to a Visit or Order Note: 
1. In an active Visit or Order Note, click either the Vitals heading or the black arrow next to the 

Vitals button in the vertical button column. 

2. Select the Edit menu option to open the Vital Signs window. 

3. Enter the desired vital sign values and click Save. 

For additional information, see the following related sections for managing note information. 

To edit or delete vital signs: 
1. In an active Visit or Order Note, click either the Vitals heading or the black arrow next to the Vital 

button in the vertical button column.  

2. Click Edit to open the current Vital Signs window.  

3. To change any existing vital sign, highlight the value in its data entry field and type in the correct 
value.  

OR 

To delete a value, highlight it and press the Delete key. 

Note:  Historical vital signs cannot be edited or deleted from the note. 

4. Click Save. 

Verifying Abnormal Vital Signs (Error Checking) 
If the values entered in the vital sign module are outside of a normal range for the patient a visual 
feedback for most of the vital signs will be provided. This visual feedback consists of displaying the 
entered values in red text.  

This feature addresses two issues. The first issue is to provide a warning when a patient’s vitals are too 
high or too low.  A visual cue to the user prevents issues from slipping thought the cracks or being 
ignored.  In addition to the red text cue in the vital sign window, these out of range values appear in bold 
text in the note to alert the provider to the situation. 

The second issue addressed by this feature is to catch data entry errors that may occur inadvertently.  
For example when entering a weight of 200 pounds for a patient a slip of the keyboard could produce a 
weight of 2000 pounds instead.  Many times errors like this can go unnoticed but since the value is 
outside of the normal range for a patient it will appear in red and should be easily noticed and corrected. 

Vitals history 

To view historical vitals: 
1. Open the Vital Signs window.  

2. In an active Visit or Order Note, click either the Vitals heading or the black arrow next to the 
Vitals button in the vertical button column, and then select Edit. 
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3. In the Vital Signs window, click the History button. 

4. In the Vital Sign History window, click the down arrow in the Type of Vital field.  

5. Click the desired vital sign type in the list.  

Note:  Only those vital types that have previous values recorded will appear in this list. 

All previously recorded values for that vital type will appear, in reverse chronological order (most 
recent first). 

If desired, historical vitals can be added to a note as a point of reference, or comparison, to current vital 
sign values. See the following procedure for detailed steps. 

To add historical vitals to a current Visit or Order Note: 
1. In the Vital Signs window, click the History button. 

2. In the Vital Sign History window, click the down arrow in the Type of Vital field.  

3. Click the desired vital sign type in the list.  

Note:  Only those vital types that have previous values recorded will appear in this list. 

All previously recorded values for that vital type will appear, in reverse chronological order (most 
recent first).  

4. Highlight any item in that list and then click Note (there will be no visual confirmation that the 
value was added.)  

5. Continue highlighting and clicking Note until all desired values have been added. 

6. Click Exit. 

The selected values will appear under the Historical Vitals header in the Vitals section of the note. 

Repeating Vital Signs 
Occasionally, repeat vital signs will be recorded within a single Visit or Order Note. For example, a high 
blood pressure reading may prompt another reading. 

To record additional (or repeat) vitals: 
1. In the Vital Signs window, any vital type preceded by a blue plus sign will allow the recording of a 

repeat value. 

Record the initial value normally (see To add vitals directly to a Visit or Order Note for details). 

2. For the next reading, click the blue plus sign preceding the vital type. 

The Additional window will display the initial value.  

3. Press the Enter key or click the New button in the middle of the window. 

4. Enter the vital sign value into the appropriate field(s).  

5. If desired, attach a comment to the value. (For example, it may be helpful to note the 
circumstances of the reading, such as a temperature taken after Tylenol was given, or a peak 
flow recorded after a nebulizer treatment.) 

6. Click the Save button in the middle of the screen to save that value and keep the Additional 
window open for entering another value.  

OR 

Click the Save button in the upper left corner to save that value and close the window. 
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Tracking the Calculated GFR 
Automatic calculation of the Glomerular Filtration Rate (GFR) for patients is available as part of the vitals 
section. The calculation occurs automatically if the patient chart has a recent value for a Creatinine level.  
This Creatinine must be stored in a patient FlowSheet and linked to a Master Lab Code in order for the 
application to be able to use it. If a patient does not have a Creatinine level then the user can manually 
enter one into the Creatinine field.  The GFR value is calculated for both adult and pediatric patient (using 
a different formula for each). Below are screenshots of what the GFR section of Vitals looks like for both a 
pediatric and adult patient. 

Pediatric: 

 
Adult: 

 
Notes:   
• Clicking the blue underlined text in the GFR section will display the formula that is used to 

calculate the GFR.   

• Adjustments are made to the calculation based on gender but the formulas used do not adjust for 
race. 

Viewing Growth Charts 
Growth charts can be accessed directly from the Chart toolbar or within the Vital Signs window. In either 
location, click the Growth Charts button (with the pink and blue icon of two people). 

Depending on the age and gender of the selected patient, appropriate growth charts will be displayed. 
Growth Charts are based on the Centers for Disease Control (CDC) data published in 2000 and show the 
percentile curves for the 3rd, 5th, 10th, 25th, 50th, 75th, 90th, 95th, and 97th percentiles.  

Children from birth through age 20 years will have graphs for Weight, Height (Length), and Weight-for-
Length. Birth through age 3 years will also display Head Circumference. Ages 20-20 will also graph Body 
Mass Index. 

Red dots (and a red connecting line) show the child’s placement on the curve, and yellow label boxes 
display the actual values. In addition, a grid in the right windowpane displays the age, date, value, and 
percentile of each point that has been plotted. 

See the following related sections for additional information: "Plot Points Directly from Vital Signs," "Plot 
Historical Points" and "Print Growth Charts." 

Plotting Points Directly from Vital Signs 
In an active Visit or Order Note, when a child’s height, weight, and/or head circumference is entered into 
the Vital Signs window, that value is automatically plotted on the appropriate growth chart.  

In addition, the value’s percentile (i.e. where is falls on the standard growth chart curves) is returned to 
the Vital Signs window. (The percentile is displayed in the last field of the Weight, Height, and Head 
Circumference data entry lines, marked with a percent sign.) 

See the "View the Growth Charts" section for more information about the Growth Charts. 
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Plotting Historical Points 
Height, weight, and head circumference entered in Vital Signs as part of a current visit are automatically 
plotted on the Growth Charts (see the "Plot Points Directly from Vital Signs" section for details).  

To plot past points: 
1. Open the patient’s chart. 

2. Open Growth Charts.  

These can be accessed directly from the Chart toolbar or within the Vital Signs window. In either 
location, click the Growth Charts button (with the pink and blue icon of two people). 

3. Over the grid in the right windowpane, click Add. 

4. Enter the date of the prior vitals and their values and click Save.  

5. Repeat the process to enter another set of values, and so on. 

Using Preemie Growth Charts 
• If an infant is documented in the demographics module as being premature and a gestational age 

is also documented then the growth charts for that patient will change to display an additional line 
on each chart that will document the patient’s status on the growth chart based on their 
gestational age.  The preemie line is colored blue while the normal birth line is colored red. 

• Fields in the Demographics and Vitals Signs forms of patients up to the age of 36 months allow 
for the documentation of Normal Birth, Premature and Gestational Age (in weeks and days).  
For a new patient the Normal Birth field is set by default and the Gestational Age fields are set to 
0 weeks and 0 days.  The user can document that an infant was born prematurely by checking 
the check box in the Premature field and then filling out the Gestational Age.  If the 
documentation indicates that the infant was premature the gestational age values will be used to 
supplement the growth charts by displaying a premie growth line. 

Recording Auditory Vitals 
Auditory vitals can be documented in the Vital Sign section.  The auditory vitals are not part of the vital 
signs that appear by default. To show the auditory vitals you must set your User Preferences to show 
them. Once set to show they appear in a tab labeled Visual/Auditory and appear with the Ophthalmology 
vitals if they are set to show. 

In the User Preference window, you have the ability to customize the auditory vitals to suit your needs.  
For example, you can choose what range of Hz/sec that displays in the section.   

To document results, select a value from the drop-down list for each range that you want to document. In 
addition users can also document whether a patient uses hearing aids (left, right or both). See image 
below for an example. 
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The information that is captured in the Auditory Vitals section can be graphed and printed if desired.  On 
the graph the right ear values will be shown in Red and the left ear values in Blue. See image below for 
an example. 

 

Documenting the Exam 

To document the physical exam: 
1. In an active Visit or Order Note, click either the Exams heading in the note, or the Exam button in 

the vertical button column.  

2. Use a template to document results. The template icon (a gray square with a black check mark) 
will appear to the right of the bold blue Exams: heading. Click it for a list of available templates.  

3. A General (full body) Exam template appropriate for age and gender will always be available as a 
choice. In addition, depending on the complaints listed in HPI, specific exams (i.e. Knee Exam, 
Mental Status Exam) linked to those diagnoses may be listed (see the Accessing Templates in a 
Visit or Order Note section for information about the template icon and the Template Links), 

Another way to access the Complaint-Specific Exam templates is to use Generic Templates. 
Typically, if the complaint in HPI (for example, Knee Pain) warrants a Complaint-Specific Exam 
(Knee Exam, in this example), that exam template will appear in the Template Links window. But, 
for example, if there is a reason to use the General (full body) Exam template, a Complaint-
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Specific Exam template can be inserted anywhere within the General Exam by using Generic 
Templates. (In this example, open the Knee Exam template within the General Exam, at the 
musculoskeletal portion of that template.) 

4. Choose whether to use the blank template, a pre-clicked template, or a past template. Open the 
appropriate template type, document by clicking the check boxes, and close the template. 
Template-generated text will drop into the Chart.  

5. In addition, free text can be typed to document any information not covered in the template. Note 
that calculation of the E&M Code depends, in part, on how comprehensive the Exam is; the 
automatic calculation of the E&M Code will be inaccurate if a template is not used to document 
the exam. 

6. If necessary, use Medical Art to illustrate significant findings. 

Adding Procedures to a Note 

To add a procedure note to a visit: 
1. In an active Visit or Order Note, scroll to the Procedures heading in the note, or click the Prcdr 

button in the vertical button column to ‘jump’ to that section of the note.  

2. Note that each diagnosis in Assessment also appears as a bold, black subheading under 
Procedures. As Procedure templates are linked by ICD-9 codes, document the Procedure next to 
the appropriate diagnosis header. A template icon (a gray square with a black check mark) will 
appear to the right of each diagnosis subheading. Click it for a list of available templates. For 
information about the template icon and the Template Links, see Accessing Templates in a Visit 
or Order Note. 

3. Choose whether to use the blank template, a pre-clicked template, or a past template. Open the 
appropriate template type, document by clicking the check boxes, and close the template. 
Template-generated text will drop into the Chart.  

If templates are created correctly, the corresponding CPT code for the procedure documented will 
automatically drop into the Orders section of the Plan. See “CPT Extended Attributes" for 
information about embedding CPT Extended Attributes into templates. 

4. In addition, free text can be typed to document any information not covered in the template. 

Documenting the Assessment 
Entering the Diagnoses from the History of Present Illness 
The reason for the visit as documented in the HPI (History of Present Illness) will automatically appear as 
a diagnosis (with an associated ICD-9 code) in the Assessment. (This is true whether the diagnosis was 
added directly to the HPI or came from a Chief Complaint template.) If multiple complaints are 
documented in the HPI, each one will appear in the Assessment.  

At that point, these diagnoses can be deleted, the descriptions can be edited, or the associated ICD-9 
code can be changed. Click any of the underlined topics for more details. 

Adding a New Diagnosis 
If a complaint was entered in CC (Chief Complaint) or HPI (History of Present Illness), the Assessment 
will already contain a diagnosis, with an associated ICD-9 code. However, additional diagnoses can be 
added directly to the Assessment. 

To add a diagnosis to the assessment: 
1. In an active Visit or Order Note, click either the Assessment heading in the note, or the black 

arrow next to the A button in the vertical button column. 
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Medicapaedia search option: Medicapaedia is a database of clinical terminology. It includes 
diagnosis/symptom descriptions and associated codes. 

2. In the Search field, type the first few letters of a diagnosis or symptom (or type the ICD code) and 
then click the Search button located on the toolbar at the top of the Medicapaedia Search window 
(or just press the Enter key). 

3. In the search results, select (click) the check box next to each description to be entered in the 
note and then click the Select button on the toolbar. 

This action adds the diagnosis code to the Assessment section of the note and adds the 
diagnosis description to the HPI and Plan sections. 

Adding a Follow-Up Diagnosis 
If a complaint was entered in the CC (Chief Complaint) or HPI (History of Present Illness), the 
Assessment will already contain a diagnosis, with an associated ICD-9 code. However, additional 
diagnoses can be added directly to the Assessment.  

If the patient is returning with an established diagnosis, add the diagnosis to HPI as a follow-up.  

To add a follow-up diagnosis: 
1. In an active Visit or Order Note, click either the Assessment heading in the note, or the black 

arrow next to the A button in the vertical button column. 

2. Click Follow Up to view the patient’s Current Problem List.  

3. Click any problem in the list to add it to the Assessment section of the current Visit or Order 
Note. If the problem is not listed in the Current Problem List, click All Problems at the bottom of 
that window for a list of all diagnoses ever assigned to that patient. Click any problem from that 
list to add it to the note. 

To delete a diagnosis: 
Problems can be removed from the Visit or Order Note in either the HPI or Assessment section. 
Simply click the bold black diagnosis description and select the Delete menu option. Click Yes in the 
Delete Confirmation window. 

• If a diagnosis is deleted from HPI, it will automatically be removed from Assessment and Plan. 
Associated HPI and Plan templates and free text will also be deleted. Any existing orders and 
prescriptions will be moved to the non-linked Other Orders and Other Prescriptions section of 
Plan. 

• If a diagnosis is deleted from Assessment, it will automatically be removed from the Plan. 
Information gathered in HPI, however, will not be affected. Associated Plan templates and free 
text will also be deleted. Any existing orders and prescriptions will be moved to the non-linked 
Other Orders and Other Prescriptions section of Plan. 

Documenting Diagnosis Properties 
Editing the Properties of a Diagnosis 
The Properties of a diagnosis include: description, date of onset, severity, progression, and chronicity.  

Some of these properties are needed to determine the E&M Code for the visit. Because e-MDs Chart 
offers automation of the E&M Coding and because the diagnosis properties are critical in determining the 
correct E&M Code, Visit and Order Notes can be set to automatically pop up a screen detailing the 
diagnosis properties (and permitting changes) prior to note sign-off. It is strongly recommended that users 
select this option. See "Show Diagnosis Properties" for more information. 

However, the properties can also be addressed in the note prior to note sign-off, as described below. 
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To edit the diagnosis properties: 
1. In an active Visit or Order Note, scroll to the Assessment section or click the A button in the 

vertical button column to ‘jump’ to that part of the note. 

2. Click any bold black diagnosis description and select the Properties menu option. 

3. Select the option values described in the "Code Properties Window Options" table below.   

4. Click Save. 

Code Properties 
Window Options 

 

Code Numerical ICD-9 code selected. 
Description Change the diagnosis description, if desired, by typing directly into that field. 
Confidential The Confidential check box can be checked. 
Date of Onset The Date of Onset field defaults to the current date, but can be changed by clicking 

the down arrow in that field to open a calendar. 
Location Change the Location by clicking the appropriate buttons. The default setting is None 

but can be changed to Left, Right or Bilateral for those diagnoses that have a 
location that needs to be documented. If a follow-up diagnosis is selected, these 
settings will reflect the last changes made to their properties by any user. 

Severity Change the severity by clicking the appropriate buttons. The default settings for 
Severity is Moderate. Other choices are Mild and Severe. If a follow-up diagnosis 
is selected, these settings will reflect the last changes made to their properties by 
any user. 

Progress Change the progress by clicking the appropriate buttons. The default setting 
Progress is Stable. Other choices are Improving and Worsening. If a follow-up 
diagnosis is selected, these settings will reflect the last changes made to their 
properties by any user. 

Course Change the course by clicking the appropriate buttons. The default setting for the 
Course field is determined by a setting in the ICD data. If a follow-up diagnosis is 
selected, these settings will reflect the last changes made to their properties by any 
user. 

Add to Current Problems When checked, this code information will be added to the Health Summary Current 
Problems section. 

Auto Age When a problem is recovered from the Resolved list, you have the option to auto 
age the problem so that it resolves itself after a specified number of days.  If you do 
not want the problem to be automatically resolved do not check the Auto Age check 
box.  

Resolve in (days) If the Auto Age option is checked, the number of days for resolution will default to 
30. If you prefer, you can specify a different numerical value in this field. 

To edit the description of a diagnosis: 
1. In an active Visit or Order Note, scroll to the Assessment section or click the A button in the 

vertical button column to ‘jump’ to that part of the note. 

2. Click any bold black diagnosis description and select the Change Text menu option. 

3. Type the desired descriptive phrase in the Text Maintenance window, and click Save.  

Note:  The new text will still be linked to the original ICD-9 code. To change the ICD-9 code, 
click Change Code instead of Change Text. See “Change the ICD Code of a Diagnosis” for 
details. 

Changing the ICD Code of a Diagnosis 
The ICD Code associated with a Diagnosis can be changed in the Assessment section of a Visit or Order 
Note.  There are two ways to accomplish this.  One way to change the code is by using the ICD Search 
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module to select another code.  The second way is to use the Differential Diagnosis (DDx) module to 
substitute a code from a pre-existing list (see What is the DDx module? for details).  Both methods are 
valid however the DDx module is a faster and simpler process (provided the DDx module is pre-populated 
appropriately). 

To change the diagnosis code using the ICD search: 
1. In an active Visit or Order Note, scroll to the Assessment section or click the A button in the 

vertical button column to ‘jump’ to that part of the note. 

2. Click any bold black diagnosis description and select the Change Code menu option. 

This launches the ICD search with the current code already in the search results. Options at this 
point include conversion to a Full Search (rather than a Short Search of favorite codes), 
expanding the current code (if it is a "red" code that can be further expanded to four or five digits), 
or using the Parent button. See Searching for an ICD-9 Code for detailed instructions regarding 
the ICD search. 

3. Highlight the correct diagnosis from the search results and either double-click or click Accept. 
This action adds the diagnosis code to Assessment and the diagnosis description to the HPI and 
Plan sections. 

If the search does not return an acceptable diagnosis, it is recommended that you type in a different 
search term. However, at that point, you may choose to click No Code to type in a free-text diagnosis. 
This button is disabled until the first search is run. This is obviously not recommended since the correct 
ICD code is required for billing. 

To change the diagnosis code using the DDx: 
1. In an active Visit or Order Note, scroll to the Assessment section or click the A button in the 

vertical button column to ‘jump’ to that part of the note. 

2. In the Assessment section, click the text labeled DDx under the desired ICD code. 

3. The DDx window will open with the selected ICD code highlighted in the left pane. 

4. A list of differential diagnoses will appear in the right pane.  

Note:  Not all diagnosis codes have differentials linked to them, however links can easily be 
created.  For details on linking differentials to a diagnosis code, see Editing Differentials Linked to 
Diagnosis Codes.  

5. Click the check box next to the diagnosis that should replace the highlighted diagnosis in the left  
pane.  More than one diagnosis can be added by clicking the check box next to multiple 
differentials, but only the first diagnosis in the list will replace the highlighted code. The others will 
be added to the list. 

6. When all the diagnoses are selected, click the Sub button located between the left and right 
panes. 

The selected diagnosis will replace the highlighted diagnosis in the left pane. 

7. Click the OK button to save the changes and return to the note. The substituted diagnosis will 
replace the previous diagnosis in the Assessment section of the note. 

Moving the Position of a Diagnosis 
If using e-MDs Solution Series, the order of diagnoses in the Assessment section is important. The first 
diagnosis listed will be transferred to the billing invoice as the primary diagnosis (that is, the primary 
reason for the visit or most serious diagnosis). 
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To move a diagnosis to the first position: 
1. In an active Visit or Order Note, scroll to the Assessment section or click the A button in the 

vertical button column to ‘jump’ to that part of the note. 

2. Click the bold black diagnosis description of the diagnosis to be moved and select the Move First 
menu option. 

The remainder of the diagnoses can be reshuffled, if desired, by using a combination of the Move 
Before (another diagnosis), Move Up, and Move Down menu options. 

Tracking the Differential Diagnosis (DDx) 
The Differential Diagnosis (DDx) module, in its most basic usage, provides a simple method to document 
possible other diagnoses to consider for each diagnosis listed in the Assessment section of the Visit or 
Order Note.  This can be helpful in dealing with undifferentiated problems over a period of several visits.  
An additional powerful feature of the DDx module allows for the addition or substitution of more specific 
diagnosis codes to the Assessment. This gives the user the option to drop a non-specific diagnosis into 
the Visit or Order Note when starting the documentation and then, as information is collected from the 
patient, to add or substitute one (or many) more specific diagnoses into the note.  

Accessing the DDx 
The DDx module can only be accessed from the Assessment section of an OPEN Visit or Order Note.  It 
cannot be accessed in a note that has been permanently signed off.  Within the Assessment section ICD-
9 codes and descriptions are listed as diagnoses and under every diagnosis code will appear wording 
labeled DDx.  Clicking the text labeled DDx will open the module. 

Customizing the DDx Window 
Users can set up the DDx module to suit their own workflow and preferences by resizing the columns in 
module.  DDx window itself can also be resized to fit in Portrait mode on a tablet with 1024 x 768 
minimum screen resolution. 

To resize the columns, place the cursor on the dividing line between 
the column headers and the cursor will change from an arrow to 
double arrowed icon.  When this icon appears, click and hold the 
mouse button while moving your mouse left or right (depending on 
whether you are widening or narrowing the column).  Any changes 
made to the column widths will be saved as the preference of the user 
that is logged in at the time the change is made. 

The entire DDx window can also be resized as a user preference. To resize the window, place the cursor 
on the left, right, top or bottom border and the cursor will change to a double headed arrow.  Click and 
hold the mouse button while dragging the mouse left, right, up or down to resize the window. 

Updating the Diagnosis Section 
• When the DDx window opens, any diagnosis code that is listed in the Assessment will appear in 

the left pane of the window.  These diagnoses will be listed in the order they are shown in the 
Assessment section and are displayed in columns labeled Code and Description.  

• This pane also includes a Delete button which can be used to remove a diagnosis from the DDx 
window and the Visit or Order Note.   

Using the Substitution Short List and DDx List 
The next two sections are labeled the Substitution Short List and the DDx List.  The Substitution Short 
List is used to substitute more specific diagnoses for the diagnosis in the note while the DDx List shows a 
list of true differentials.  There are two lists for just for organization purposes.  Additions of differentials 
and substations of more specific codes can be done from either list but for organization purposes there 
are two lists. 

Both sections have the same layout and functionality and are described below. 
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• Highlight one of the diagnoses in the left pane, by clicking it, to display the substitution list and a 
list of differentials and/or more specific diagnoses in the middle and right panes of the window.  
Each item in the two lists will have a check box in front of it.  If the check box is clicked the 
diagnosis will be marked as selected. 

• The text at the top of these panes is the ICD-9 code and description for the diagnosis that is 
highlighted in the left pane. 

Note:  A list of substitutions and differentials will only appear for those diagnoses that have 
differentials linked to them.  e-MDs has pre-linked common differentials to many of the more 
general ICD-9 codes that are used in Chart but not all ICD codes have these links.  Users can 
easily add substitutions and differentials to any codes that do not have links or edit those that do 
(see Editing Differentials Linked to Diagnosis Codes for details).  

• Across the top and bottom of both panes is a row of check boxes and buttons as shown in 
"Substitution Short List and DDx List Options." 

Updating the Differential Text Section 
Running horizontally across the middle part of the window is a gray section with radio buttons.  Each 
radio button has specific wording associated with it (the differential text).  Clicking a radio button will drop 
its associated text into the DDx section of the Assessment once the DDx window is closed.  There are 
four radio buttons in the section with the following differential text as choices: 

• Differential: A, B, C 

• INCLUDES - Differential includes A, B, C. Based on current evaluation, there is insufficient 
information to make a more definitive diagnosis. If additional signs or symptoms manifest over 
time, a definitive diagnosis may become possible. 

• EXCLUDES - Differential considered and excluded includes A, B, C.  Current evaluation does not 
support a life or limb threatening condition. 

• CO-MORBID - Associated co-morbid conditions considered include A, B, C. 

Note:  The A, B, C listed in each of differential text choices represents place holders for the 
differential descriptions that will appear in the text.  The differentials will be inserted in the same order 
they are listed in the right pane.  For example, choosing the INCLUDES selection above for a chest 
pain diagnosis and then selecting Acute MI and Unstable Angina as differentials would generate text 
that reads:  Differential includes Acute MI, Unstable angina. Based on current evaluation etc. where 
Acute MI and Unstable Angina are substituted for A and B in the text.  Note that Acute MI appeared in 
the list ahead of Unstable Angina so it is inserted into the text first.  Keep in mind that although only 3 
letters are shown as place holders (A, B, C) the differential text can handle more than 3 differential 
substitutions. 

Updating the Differential Text Preview Section 
At the very bottom of the DDx window is a section where the DDx text that is chosen by clicking a radio 
button is previewed.  This allows the user to see the actual text that will drop into the note.  For example, 
in the example listed above for chest pain, the actual text that would drop into the note would be shown in 
this section as: Differential includes Acute MI, Unstable angina. Based on current evaluation, there is 
insufficient information to make a more definitive diagnosis. If additional signs or symptoms manifest over 
time, a definitive diagnosis may become possible. 

To add diagnosis substitutions and differentials to notes: 
1. Select the diagnosis in the list on the left in the Diagnosis section  

2. Click the Insert List from Other ICD button under the Substitution or DDx list.   

The ICD search will open.  

3. Search for and select the ICD code from which you want to copy the list. 
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4. Close the ICD search and the list will be populated from the selected ICDs list. 

Substitution Short List and DDx List Options 
Top Check Boxes and 
Buttons 

 

Show ICD Code Checking this check box will show the ICD code in parenthesis after the diagnosis 
description. 

Check/Uncheck All Items This check box will toggle the status of all the check boxes to the left of the 
differentials (Select boxes).  It will also clear any check marks in the Delete column 
to the right of each differential (Delete boxes). 
Note:  If more than half the select boxes in either list are checked when this 
button is pressed then all the boxes will clear.  If more than half the boxes are 
cleared when this button is pressed then all the boxes will check.  In the event that 
exactly half the boxes are checked when this button is pressed then all the boxes 
will be checked. 

Add To List Clicking this opens the ICD-9 Search module to allow adding more differentials to 
the list. 

Save Clicking this button saves any changes that have been made to the differential list.   
A Clicking this button toggles the differential descriptions between a user specified 

sequence and an alphabetical sequence.  When the A button is depressed the 
sequence is alphabetical and the Up and Down arrows are grayed out and disabled. 

Up Arrow This button is only enabled when the A button is off (not depressed).  Clicking this 
button will move the highlighted differential up one position in the list. 

Down Arrow This button is only enabled when the A button is off (not depressed).  Clicking this 
button will move the selected differential down one position in the list. 

Delete Clicking this button will remove any differential codes that have a check mark in the 
Delete column. 

 
Bottom Check Boxes 
and Buttons 

 

Move To These buttons will move the selected diagnoses from the one list to the other. For 
example if you have a diagnosis in the Substitution list that you want moved to the 
DDx list you can click the check box for that diagnosis and then click the Move To > 
button under the Substitution list to move the item.  To move from the DDx to the 
Substitution list select the diagnosis and click the < Move To button under the DDx 
list. 

Copy To These buttons work the same as the Move To buttons but instead of moving from 
one list to the other the diagnoses are COPIED. 

Insert List from Other ICD In some situations a diagnosis may have a Substitution or DDx list that could be 
used for another diagnosis. For example heartburn may have a list of differentials 
that would be useful to use with a GERD diagnosis. The Insert List from Other ICD 
button allows a user to select an ICD and have the Substitution or DDx list copied 
from that diagnosis (heartburn) to the diagnosis in question (GERD). 

 
Vertical Buttons  
Add Adds any differentials in the right Differential pane that are marked with checks 

over to the Diagnosis section. 
Sub Replaces the highlighted code in the left Diagnosis pane with the first  checked item 

in the right pane and then adds any additional checked ICD9s in the right pane to 
the list of codes in the left pane. 
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Bottom DDx Buttons  
OK Closes the DDx window and applies any changes to the note. 
Cancel Opens a confirmation window if any changes have been made in the DDx window 

but not saved.  If no changes have been made or the Save button was pressed after 
any changes were made then clicking the Cancel button simply closes the DDx 
window and returns the program to the note. 

Editing Differentials Linked to Diagnosis Codes 
e-MDs has pre-linked common differentials to many of the more general ICD-9 codes that are used in 
Chart but not all ICD codes have these links.  However, users can easily add differentials to any codes 
that do not have links or edit and make changes to those that do.   

There is no editor to link Differential Diagnoses to ICDs so the linking must be done from within a Visit or 
Order Note.  The user can choose to either create these links “on the fly” in a real patient’s note or in a 
note created for a fake patient.  In a busy practice it may be better to use a fake patient and do the linking 
during off hours. 

To add linked differential diagnoses to an ICD: 
1. In an active Visit or Order Note, scroll to the Assessment section or click the A button in the 

vertical button column to ‘jump’ to that part of the note. 

2. Add the desired ICD code to the Assessment section of the note. 

3. Click the DDx text that appears under the diagnosis code. 

The DDx window will open with the selected ICD-9 code highlighted in the left pane. 

4. A list of Substitutions and Differential Diagnoses linked to that ICD-9 code will appear in the 
middle and right panes (in those cases where there are no linked differentials the panes will be 
empty). 

5. To add a link, click the Add to List button at the top of the appropriate pane. 

The ICD-9 Search module will open. 

6. In the Keywords field type in part of the name of the diagnosis code to be searched for and click 
the Search button.  (see Searching for an ICD-9 Code for details) 

7. In the search results highlight the desired code and click Accept. 

The code will drop into the appropriate pane at the bottom of the list. 

8. The code can be repositioned in the list by clicking the Up or Down Arrow buttons at the top of 
the list. 

There may be cases where users want to remove a differential that is linked to an ICD-9.  

To delete a linked differential diagnosis from an ICD: 
1. In an active Visit or Order Note, scroll to the Assessment section or click the A button in the 

vertical button column to ‘jump’ to that part of the note. 

2. Add the desired ICD code to the Assessment section of the note. 

3. Click the DDx text that appears under the diagnosis code. 

The DDx window will open with the selected ICD-9 code highlighted in the left pane.  A list of 
Substitutions and Differential Diagnoses linked to that ICD-9 code will appear in the middle and 
right panes. 

4. Click the Delete check box to the right of the differential or differentials to be removed. 

5. Click the Save button at the top of the right pane to delete the differential(s) 
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Note:  To clear any Delete boxes that are checked by mistake, click the Check/Uncheck All Items 
button at the top left of the right pane.  This will check (or clear) the Select check boxes to the left of 
each differential as well as clear the Delete check box of all differentials.  It may require clicking this 
button twice to clear out all check boxes. 

Differential Diagnoses are listed in the right pane in the order that they will drop into the note if they are 
added to the Assessment or listed as DDx.  Because of this it may become necessary to reorder the list to 
place certain differentials before or after others. 

To customize the order of differentials in the list: 
1. Highlight the differential to be moved in the right pane. 

2. Click the Up Arrow button at the top of the right pane to move the item up a level.  Click the 
button as many times as necessary to move the item to the desired location. 

OR 

Click the Down Arrow button at the top of the right pane to move the item down a level.  Click the 
button as many times as necessary to move the item to the desired location. 

3. Click the Save button at the top of the right pane to Save the changes made to the order of the 
differentials in the list. 

There may be times when the differential list needs to be listed in alphabetical order.  For example, listing 
these items in alphabetical order can make it easier to find a specific item.  

To list the differentials in alphabetical order: 
1. With the DDx window open and a differential list showing in the right pane, click the A button at 

the top of the right pane to reorder the list alphabetically. 

2. Click the A button again to revert the list to the original order.  

Note:  When the A button is pressed it will appear depressed.  As long as the button is 
depressed the list will remain in alphabetical order however this is not a permanent state.  Once 
the DDx window is closed, the differential list will revert back to its original order. 

Use the following procedure to document other possible diagnoses to consider for each diagnosis listed in 
the Assessment section of the note. 

To add differential diagnoses to the Visit or Order Note: 
1. In an active Visit or Order Note, scroll to the Assessment section or click the A button in the 

vertical button column to ‘jump’ to that part of the note. 

2. In the Assessment section, click the text labeled DDx under the desired ICD code. 

3. The DDx window will open with the selected ICD code highlighted in the left pane. 

4. A list of Substitutions and Differential Diagnoses linked to that ICD-9 code will appear in the 
middle and right panes. 

Note:  Not all diagnosis codes have differentials linked to them however links can easily be 
created.  For details on linking differentials to a diagnosis code see Editing Differentials Linked to 
Diagnosis Codes. 

5. Click the check box to the left of the substitution or differential to be added.  More than one 
differential can be documented by clicking the check box next to multiple differentials. 

6. Note that an asterisk (*) will appear in front of the diagnosis code in the left pane when a 
differential has been selected for it.  This asterisk denotes that a differential has been selected for 
that diagnosis. 
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7. Select the Differential Text that will drop into the note by clicking the radio button next to the 
desired choice.  There are four choices of that can be selected for Differential Text. 

○ Differential: A, B, C 

○ INCLUDES - Differential includes A, B, C. Based on current evaluation, there is insufficient 
information to make a more definitive diagnosis. If additional signs or symptoms manifest over 
time, a definitive diagnosis may become possible. 

○ EXCLUDES - Differential considered and excluded includes A, B, C.  Current evaluation does 
not support a life or limb threatening condition. 

○ CO-MORBID - Associated co-morbid conditions considered include A, B, C. 

Note:  The A, B, C listed in each of differential text choices represents place holders for the 
differential descriptions that will appear in the text.  The differentials will be inserted in the same 
order they are listed in the right pane.  For example, choosing the INCLUDES selection above for 
a chest pain diagnosis and then selecting Acute MI and Unstable Angina as differentials would 
generate text that reads:  Differential includes Acute MI, Unstable angina. Based on current 
evaluation etc. where Acute MI and Unstable Angina are substituted for A and B in the text.  
Note that Acute MI appeared in the list ahead of Unstable Angina so it is inserted into the text 
first.  Keep in mind that although only 3 letters are shown as place holders (A, B, C) the 
differential text can handle more than 3 differential substitutions. 

After a choice has been made for the Differential Text, a preview of the text that will show up in 
the note will appear in the Preview field at the bottom of the DDx window. 

8. Once the differentials have been chosen and the text selected, click OK to save the changes and 
return to the note. 

9. The Differential Text will appear directly under the appropriate diagnosis code in the Assessment 
section of the note.   

Editing the Differential Text 
The Differential Diagnosis appears in the Assessment section of the note directly under its ICD-9 code.  
The text cannot be edited directly but the differential that is documented for a specific ICD code can be 
changed or additional text can be added to the documentation. 

To change the differential diagnosis: 
1. In an open Visit or Order Note that has Differential Diagnoses associated with an ICD-9, click the 

text describing the differential.  It will be located directly below the appropriate ICD in the 
Assessment section of the note. 

The DDx window will open.  The selected ICD will be highlighted in the left pane.  The 
substitutions or differentials attached to the ICD will appear in the right pane marked with a check 
in the check box to the left of the description. 

2. Clear any differentials that are to be removed or add checks next to items to add to the 
differential. 

3. Click OK to save the changes and return to the note. 

Including Additional Diagnoses 
One of the more powerful features of the DDx module is that it can be used for more than just 
documenting the Differential Diagnoses.  It can also be used to quickly and easily add additional ICD 
codes to the Assessment section of the note. 

To insert additional diagnosis codes: 
1. In an active Visit or Order Note, scroll to the Assessment section or click the A button in the 

vertical button column to ‘jump’ to that part of the note. 
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2. In the Assessment section, click the text labeled DDx under the desired ICD code. 

The DDx window will open with the selected ICD code highlighted in the left pane. 

3. A list of Substitutions and Differential Diagnoses linked to that ICD-9 code will appear in the 
middle and right panes. 

Note:  Not all diagnosis codes have differentials linked to them; however, links can easily be 
created.  For details on linking differentials to a diagnosis code, see Editing Differentials Linked to 
Diagnosis Codes. 

4. Click the check box to the left of the diagnosis to be added.  More than one diagnosis can be 
added by clicking the check box next to multiple differentials. 

5. When all the diagnoses are selected, click the Add button that is between the left and right 
panes. 

6. The selected diagnoses will be added to the list in the left pane. 

7. Click the OK button to save the changes and return to the note.  The selected diagnoses will now 
be added to the list of ICD codes in the Assessment section of the note. 

Substituting More Specific Diagnoses 
One of the more powerful features of the DDx module is that it can be used for more than just 
documenting the Differential Diagnoses.  It can also be used to quickly and easily substitute more specific 
ICD codes to the Assessment section of the Visit or Order Note in place of non-specific codes. 

To substitute a more specific diagnosis: 
1. In an active Visit or Order Note, scroll to the Assessment section or click the A button in the 

vertical button column to ‘jump’ to that part of the note. 

2. In the Assessment section, click the text labeled DDx under the desired ICD code. 

3. The DDx window will open with the selected ICD code highlighted in the left pane. 

4. A list of Substitutions and Differential Diagnoses linked to that ICD-9 code will appear in the 
middle and right panes. 

Note:  Not all diagnosis codes have differentials linked to them; however, links can easily be 
created.  For details on linking differentials to a diagnosis code see Editing Differentials Linked to 
Diagnosis Codes.  

5. Click the check box to the left of the diagnosis that will replace the diagnosis that is highlighted in 
the left pane.  More than one diagnosis can be added by clicking the check box next to multiple 
differentials but only the first diagnosis in the list will replace the highlighted code.  The others will 
be added to the list. 

6. When all the diagnoses are selected, click the Sub button that is between the left and right 
panes. 

7. The selected diagnosis will replace the highlighted diagnosis in the left pane. 

8. Click the OK button to save the changes and return to the note.  The substituted diagnosis will 
replace the previous diagnosis in the Assessment section of the note. 

Deleting Diagnosis Codes 
Diagnosis codes that are inadvertently added to the left pane of the DDx window can be deleted.   

To delete a diagnosis: 
1. Highlight the code in the left pane that is to be deleted. 

2. Click the Delete button at the top of the left pane. 
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3. Click Yes in the confirmation screen. 

4. Click OK to save the changes and return to the note. 

Updating the Orders Section 
The Orders section aggregates all the Meds Prescribed, Radiology/Tests Orders, Lab Orders, Procedure 
Orders and Other Orders that are associated with the note.  This is the same information that is listed in 
the Plan section but in the Plan section each item is placed in a subsection under the diagnosis that it 
was prescribed or ordered to treat.  This can make it difficult to get an overall view of all the treatments 
that have been ordered for the patient in a single consolidated view.  In the Orders section this 
information appears without being segregated by diagnosis so that all the Meds are listed together, the 
Labs together, etc.  

This section is strictly for display purposes.  No entering or editing of data occurs in this section. All 
inserts, edits and deletions of medications, tests or procedures occurs in the Plan section and the 
resulting information is simply displayed in this section. 

Note:  As with other sections of the Visit or Order Note, the Orders section can be hidden, if desired. 

Managing the Plan Section 
Each diagnosis that shows up in the PLAN section of a Visit or Order Note has text generated from 
templates listed below it and in addition there are sub-headers for Prescriptions, Orders and Patient 
Education underneath it. Each of these can also contain information.  This can make it difficult to easily 
get from one diagnosis to another without using the scrollbar.  The Diagnosis Navigation feature in the 
Plan allows users to quickly navigate between these diagnoses.  The feature is accessible from a menu 
that lists the diagnoses that are part of the current note. (see images below for example) 

To access this menu: 
Right-click anywhere in the PLAN section of the Visit or Order Note, 

OR 

Click the black arrow on the navigation button labeled P (for PLAN section). 

OR 

Click the PLAN header in the Visit or Order Note. 

Each of these actions will pop up a menu that lists all available diagnoses that are part of the current 
note. Clicking a diagnosis will bring that diagnosis to the top of the note page. This allows for quick 
navigation when there are several diagnoses in the note.         
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To document the plan: 
1. In an active Visit or Order Note, scroll to the Plan heading or click the P button in the vertical 

button column to ‘jump’ to that section of the note.  

2. Each diagnosis (from Assessment) will have its own section in Plan. The diagnosis will appear in 
bold black text, followed by a template icon and a free text icon.  

3. Use a template to document the treatment plan. The template icon will appear to the right of each 
bold black diagnosis heading. Click it for a list of linked templates. For information about the 
template icon and the Template Links, see Accessing Templates in a Visit or Order Note. 

a. If a linked template is available, choose whether to use the blank template, a pre-clicked 
template, or a past template. Open the appropriate template type, document by clicking 
the check boxes, and close the template. Template-generated text will drop into the Chart. 
In addition, free text can be typed to document any information not covered in the 
template. 

Note:  It is preferable to use a template rather than free text to document the Plan, so 
that CPT codes linked to Labs, Tests, and Procedures can be automatically added to 
Orders simply by clicking off these items in the Plan template. See "Add Orders Directly 
from Plan Templates" for more information. 

b. If no linked templates are available, the user may choose to use either a Generic Plan 
template or free text (typing) to document basic information. 

Three sections, labeled Prescriptions, Orders, and Patient Education, follow each diagnosis 
heading. (See "Write a Prescription Linked to a Diagnosis", "Add an Order to a Note Manually" 
and "Add Patient Education to a Visit or Order Note" to read more about those sections.)  

Note: A Care Plan template is available in the Plan section of a note. This template allows users to select 
general and diagnosis-specific guidelines for the patient. These guidelines are displayed in the visit note 
and are also included in C-CDA files. Inclusion of a care plan in the C-CDA provides the patient with 
ready access to individualized guidelines for healthier living and better outcomes. 

Writing Prescriptions 

To write a prescription linked to a diagnosis: 
1. In an active Visit or Order Note, scroll to the Plan heading or click the P button in the vertical 

button column to ‘jump’ to that section of the note. 

The Plan section of the Visit or Order Note will display each diagnosis from Assessment. 
Prescriptions are linked to diagnoses.  
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2. Choose the correct diagnosis header (displayed in bold black text), and click the Prescriptions 
subheading (displayed in blue text and underlined). 

This opens the Refill Grid window. For detailed information about selecting a drug and writing a 
prescription, see Prescription Writing Basics. 

After the prescription is completed, it will appear in the Scripts Written windowpane of the 
Prescribe a Drug window. Additional prescriptions written for the same diagnosis can be written 
before closing this window.  

Note:  Another option is to write all of the prescriptions for the visit while in this window, and then move 
the prescriptions to the correct diagnoses later. 

Important!  It is important to keep in mind that NO ONE can write a prescription unless they have the 
correct privileges.  Even if a provider has all script writing privileges, no prescriptions can be written under 
their name unless the person logged in also has script writing privileges.  

The Medical Assistants security group is given ScripWriter Non-Schedule privileges by default.  If a 
provider wants to limit the ability of a Medical Assistant to write ANY scripts this privilege needs to be 
removed from this particular security group.  Additionally, if a provider wishes to delegate authority to 
Medical Assistants to write ALL types of prescriptions the ScriptWriter Schedule 3-5 and ScriptWriter 
Schedule 2 privileges need to be added to this security group.  See Edit a Security Group. 

Prescriptions can be written directly from templates if the template item has an Extended Attribute of 
Prescription linked to it (see Prescription Extended Attributes for details). 

To write a prescription from a template: 
1. In an active Visit or Order Note, scroll to the Plan heading or click the P button in the vertical 

button column to ‘jump’ to that section of the note. 

2. The Plan section of the Visit or Order Note will display each diagnosis from Assessment.  

3. Choose the correct diagnosis header (displayed in bold black text), and open the template for that 
diagnosis. 

4. Most PLAN templates have a Medications section.  Click the medications question and select the 
desired drug from the following levels. 

When the template is closed a modified Refill Grid will open. 

5. Change the prescription information, if necessary, and the click Save. 

The prescriptions will be added to the Prescription header under the appropriate diagnosis 

Note:  For detailed information about writing a prescription from a template, see Prescriptions from 
Templates. 

When new prescriptions are written, they should be linked to an appropriate diagnosis. However, it is 
possible to write a new prescription in a Visit or Order Note without linking it to a diagnosis. 

To write a prescription without a linked diagnosis: 
1. In an active Visit or Order Note, scroll to the Plan heading or click the P button in the vertical 

button column to ‘jump’ to that section of the note. 

2. At the bottom of the Plan section, click the bold blue heading labeled Other Prescriptions (rather 
than clicking any of the Prescriptions subheadings, displayed in blue text and underlined). 

This opens the Prescribe a Drug window. For detailed information about selecting a drug and 
writing a prescription, see Prescription Writing Basics. 

Important!  It is important to keep in mind that NO ONE can write a prescription unless they have the 
correct privileges.  Even if a provider has all script writing privileges, no prescriptions can be written under 
their name unless the person logged in also has script writing privileges.  
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The Medical Assistants security group is given ScripWriter Non-Schedule privileges by default.  If a 
provider wants to limit the ability of a Medical Assistant to write ANY scripts this privilege needs to be 
removed from this particular security group.  Additionally if a provider wishes to delegate authority to 
Medical Assistants to write ALL types of prescriptions the ScriptWriter Schedule 3-5 and ScriptWriter 
Schedule 2 privileges need to be added to this security group.  See Edit a Security Group for details. 

To move a prescription to a different diagnosis: 
1. In an active Visit or Order Note, scroll to the Plan heading or click the P button in the vertical 

button column to ‘jump’ to that section of the note. 

The Plan section of the Visit or Order Note will display each diagnosis from Assessment. 
Prescriptions are linked to diagnoses and are listed under the Prescriptions subheadings 
(displayed in blue text and underlined). 

2. Click any prescription and select the Move to Another Diagnosis menu option. 

3. This opens a window listing all of the diagnoses for the current visit. Select any one to move the 
prescription to that diagnosis. 

To edit a prescription in a Visit or Order Note: 
1. In an active Visit or Order Note, scroll to the Plan heading or click the P button in the vertical 

button column to ‘jump’ to that section of the note. 

The Plan section of the Visit or Order Note will display each diagnosis from Assessment. 
Prescriptions are linked to diagnoses and are listed under the Prescriptions subheadings 
(displayed in blue text and underlined). 

2. Click any prescription and select the Edit menu option.  This opens the Write a Prescription 
window.  

3. Make desired changes and click Save. For detailed information on writing a prescription, see 
Prescription Writing Basics. 

To delete a prescription from a Visit or Order Note: 
1. In an active Visit or Order Note, scroll to the Plan heading or click the P button in the vertical 

button column to ‘jump’ to that section of the note. 

The Plan section of the Visit or Order Note will display each diagnosis from Assessment. 
Prescriptions are linked to diagnoses and are listed under the Prescriptions subheadings 
(displayed in blue text and underlined). 

2. Click any prescription and select the Delete menu option. 

3. Click Yes in the Delete Confirmation window. 

Documenting Orders 
Add Orders Directly from Plan Templates 
Items in the Plan templates can be linked to CPT codes. Linking structured pieces of data to template 
items is done via a process called "Extended Attributes" in the Template Editor.  

With a Plan template containing CPT Extended Attributes, as the user clicks off Orders in the template 
(such as for Labs, Tests, and Procedures) the corresponding CPT code is automatically added to the 
Orders section of the Plan. This eliminates the CPT search that was required in prior versions of e-MDs 
Chart.  

A Few Rules: 
• A CPT can be deleted from the note by reopening the Plan template and clearing the associated 

order in the template. However, it is much faster to delete a CPT directly from the Orders. When 
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this occurs, the item will automatically be cleared in the template, correcting the generated 
template text as well. 

• A given CPT can be added to the note more than one time. If the same CPT is checked off in two 
separate templates, a warning message will appear telling the user that the code already exists in 
the note and asking if they want to add a duplicate.  This gives the user the ability to add 
duplicate CPT codes when desired. 

Plan templates created by e-MDs already have CPT codes linked to them, although these can easily be 
changed in the Template Editor (see CPT Extended Attributes for details). CPT Extended Attributes can 
be incorporated into any new Plan (as well as Procedure and Exam) templates created by the user. 

The easiest way to add Orders to the note is automatically, via the Plan templates. However, in cases 
where an appropriate Plan template does not exist, one could either use a Generic Plan template or add 
the Order manually, as described below. 

To add an order to a note manually: 
1. In an active Visit or Order Note, scroll to the Plan heading or click the P button in the vertical 

button column to ‘jump’ to that section of the note. 

The Plan section of the Visit or Order Note will display each diagnosis from Assessment. Orders 
are linked to diagnoses.  

2. Select the correct diagnosis header (displayed in bold black text), and click the Orders 
subheading (displayed in blue text and underlined). 

This opens the Linked CPTs window, listing orders appropriate for the given diagnosis (as 
determined by the users).  

3. Click all desired orders and then click Accept. (Once an order is selected, it can be clicked a 
second time to clear it.) 

Note:  e-MDs Chart comes preloaded with a few linked orders as an example. Users can create 
ICD-to-CPT links in the Code Linker. In addition, orders can be added to the Linked CPTs 
window, on the fly, in a note. See "Add an Order to a Note Manually" for details. 

Adding a CPT Code to the Linked Orders Window 
The easiest way to add Orders to the note is automatically, via the Plan templates. However, in cases 
where an appropriate Plan template does not exist, the Order can be added manually from the Linked 
Orders window. 

Appropriate orders can be linked to diagnoses via the Linked CPTs window. For the most common 
diagnoses, appropriate ICD-to-CPT links should be made ahead of time in the Code Linker. However, if 
the desired order does not appear in the Linked Orders window, it can be added on the fly, in the Visit or 
Order Note. 

To add a linked order to a diagnosis in a Visit or Order Note: 
1. In an active Visit or Order Note, scroll to the Plan heading or click the P button in the vertical 

button column to ‘jump’ to that section of the note. 

The Plan section of the Visit or Order Note will display each diagnosis from Assessment. Orders 
are linked to diagnoses.  

2. Select the correct diagnosis header (displayed in bold black text), and click the Orders 
subheading (displayed in blue text and underlined). 

This opens the Linked CPTs window, listing orders appropriate for the given diagnosis (as 
determined by the users).  

3. To add another CPT to this window, click Add CPT to launch the CPT search. 
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4. Highlight the correct CPT from the search results and either double-click or click Accept.  (For 
detailed instructions regarding the CPT search, see "Search for a CPT Code.")  

This permanently adds the CPT to the Linked CPTs window, and that order is now linked to the 
selected diagnosis. 

Note:  Removal of an inappropriately linked order can only be performed in the Code Linker. 

5. Highlight the newly added order and click Accept to add the CPT to the note. 

Deleting a CPT Code from the Linked Orders Window 
Appropriate orders can be linked to diagnoses via the Linked CPTs window. For the most common 
diagnoses, appropriate ICD-to-CPT links should be made ahead of time in the Code Linker. However, if 
the desired order does not appear in the Linked Orders window, it can be added on the fly, in the Visit or 
Order Note. Sometimes, an inappropriate CPT code will be linked to a diagnosis. This link can be broken 
in the Code Linker, but it is much faster to delete it on-the-fly in a note. 

To delete an incorrectly linked order: 
1. The Plan section of the Visit or Order Note will display each diagnosis from Assessment. Orders 

are linked to diagnoses. Select the correct diagnosis header (displayed in bold black text), and 
click the Orders subheading (displayed in blue text and underlined). 

2. This opens the Linked CPTs window, listing orders for the given diagnosis (as determined by the 
users).  

3. To delete any CPT(s) from this window, highlight those to be unlinked and click Delete. 

Note:  This breaks that ICD-CPT link for ALL users. 

To delete an order from a note: 
1. In an active Visit or Order Note, scroll to the Plan heading or click the P button in the vertical 

button column to ‘jump’ to that section of the note. 

The Plan section of the Visit or Order Note will display each diagnosis from Assessment. Orders 
are linked to diagnoses and are listed under the Orders subheadings (displayed in blue text and 
underlined). 

2. Click the order to be removed and select the Delete menu option. 

3. Click Yes in the Delete Confirmation window. 

Note:  If the Order was added directly, via a template, deleting the CPT from the Orders section 
will also automatically clear that item in the Plan template, correcting the generated template text. 

Updating Order Properties 
Orders are found in the Plan section of an active Visit or Order Note, linked to diagnoses and listed under 
the diagnosis’ Orders subheading (displayed in blue text and underlined). 

To edit the properties of an order: 
1. Click the order and select the Properties menu option. (Alternatively, click directly on the "In 

House" or "Send Out" statement that follows the order in parentheses.) 

2. Select the values for the properties as described in the Order Properties Options table.  

3. When editing is complete, click Save. 
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Order Properties 
Options 

 

Description This description can be changed. Note that the new text will still be linked to the 
original CPT code, so if the wrong order was entered, it must be deleted. 

Number of Occurrences The default is 1, but this can be changed by typing directly into that field or clicking 
the up/down arrows. This value is the number of times the order should be 
performed (the quantity reflected on the Lab or Radiology Order Form).   

Quantity The default is 1, but this can be changed by typing directly into that field or clicking 
the up/down arrows. There are some CPT codes that can be charged multiple times. 
For example, CPT code 90472 is billed for "each additional immunization 
administered" beyond the first injection. So, if 3 immunizations are given, code 
90472 is billed with a quantity of "2". 

In House This box should be checked if the order will be performed in-house and billed. If 
checked, the CPT code for the order will appear on the Superbill/Charge Capture 
form. For labs or procedures that will be done elsewhere (and billed for by another 
party), make sure that this box is not checked. 
Note:  Orders routinely done in-house can be defaulted to always check the In 
House box. See "View the Billing Details of a CPT Code" for details. 
If the In House box is not checked, a Billable check box will appear. If this box is 
checked, the CPT code for the order will appear on the Superbill/Charge Capture 
form, even though it is a "send out" test. This allows appropriate billing for those labs 
done elsewhere and charged to the clinic, where the clinic then, in turn, bills the 
patient. 

Stat Check this box for orders that are to be performed immediately. The "stat" 
designation will appear in the note as well as on the Laboratory Orders form. See 
"Lab Tracking" for details. 

Comments Use this free-text field to add specific information about each order in the note. 
Print Comment By default, this check box will be selected to print the Comments field text on the 

order. To avoid inclusion of the comments on the order output, deselect this check 
box.  

Track Check this box to mark an item to be tracked through the Lab Tracking module for 
this instance only.  Or clear the box to mark and item to NOT be tracked. 

Urgent Check this box to change the priority of the Overdue Message generated and sent 
by TaskMan. Once received in TaskMan, a RED “P” flag is added to this message if 
the Urgent box is checked. See "Notification of Overdue Labs" for details. 

Due After Enter a value in this field to note to specify the number of days after which the item 
will be considered overdue.  If there is a default value already set for this item the 
field will be prepopulated with this value.  See "Setup Tracked Items" for details. 

Due Date This field is a calculated date based on the value in the Due After field and 
represents the date after which the item will be considered overdue. 

Confidential Check this box if the item is to be hidden for privacy reasons. 
Print Separately Check this box to generate a lab or radiology order with only the displayed CPT 

code and its details. All other CPT codes ordered in the Visit or Order Note will print 
together on a lab or radiology order form. 

Print Each Occurrence 
Separately 

Check this box to print an individual order form for the quality of that order. For 
example, if an INR is ordered with a quality of 6 (see Number of Occurrences field 
above), checking this option will generate 6 separate Lab Order Forms. 

 

Editing the Description of an Order 
Orders are found in the Plan section of an active Visit or Order Note, linked to diagnoses and listed under 
the diagnosis’ Orders subheading (displayed in blue text and underlined).  
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The Linked CPTs window (which displays orders appropriate for the given diagnosis) automatically 
displays the "official description" for any CPT. This process cannot be changed. However, once an order 
is dropped into a Visit or Order Note, the description can then be altered. 

Order descriptions that drop into the note directly from a Plan template can be permanently changed, by 
editing the description assigned to the Extended Attribute. See "CPT Extended Attributes" for details. 

To edit the description of an order in the note: 
One way to modify the text description of an order is by editing the order’s properties. See Updating 
Order Properties for details.  

OR 

Another way is to choose an Alternate Description. For that method, click the order in the right pane 
and select the Alternate Descriptions menu option. In the pop-up window, click the desired 
description to select it. 

To learn how to create additional Alternate Descriptions for CPT codes, see “Add an Alternate 
Description for a CPT Code.” 

Orders are found in the Plan section of an active Visit or Order Note, linked to diagnoses and listed under 
the diagnosis’ Orders subheading (displayed in blue text and underlined).  

To add a modifier to a CPT code: 
1. Click the order and select the Modifiers menu option. (Alternately, click directly on the five-digit 

numerical CPT code of the order.) 

2. Highlight the appropriate modifiers from the Linked CPT Modifiers window and then click Accept. 

3. If the appropriate modifiers do not appear in the Linked CPT Modifiers window, click Add 
Modifiers.  

4. In the CPT Modifiers window, highlight correct modifiers and then click Accept. This will 
permanently add the modifiers to the Linked CPT Modifiers window. Then, proceed as outlined in 
step 2 above. 

Managing CPT Codes Linked to an Order 
Occasionally, when selecting one order, it is appropriate to also bill for a related order. For example, 
when billing the CPT code 90657 (Influenza vaccine), the user should also bill CPT code 90471 
(Immunization administration). To aid charge capture and minimize lost billing opportunities, e-MDs has 
created CPT-to-CPT links. 

Note:  Orders are found in the Plan section of an active Visit or Order Note, linked to diagnoses and 
listed under the diagnosis’ Orders subheading (displayed in blue text and underlined).  

To add CPT codes to the visit charges: 
1. Click the order and select the Linked CPTs menu option. 

The Linked CPTs window will show all CPTs linked to the selected order.  

2. Highlight any CPT(s) in the list and click Accept to add them to the current Visit or Order Note. 

Note:  e-MDs has pre-linked a few related orders, but the responsibility for creating the CPT-to-
CPT links rests with the user. If the Linked CPTs window does not show the desired order, click 
Add CPT. Select the appropriate CPT from the full CPT search and click Accept. This will add the 
order to the Linked CPT window. Then, select the order from that window and click Accept to add 
the order to the current note. 

Managing HCPCS Codes Linked to an Order 
Occasionally, when selecting an order (i.e. a CPT code), it is appropriate to also bill for related supplies 
(i.e. HCPCS codes). For example, when billing for serum laboratory tests, it may be appropriate to also 
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charge for the syringe and needle. To aid charge capture and minimize lost billing opportunities, e-MDs 
has created CPT-to-HCPCS links. 

It is assumed that these supplies are only used when an Order is performed "in house." Therefore, 
whenever an in-house CPT is added to a note, an automatic pop-up window will prompt the user to 
charge for supplies. This happens regardless of whether the Order was added via a template or directly 
from the Linked Orders window. In addition, this Linked HCPCS window can be viewed at any time by 
clicking an order in the note and selecting the HCPCS menu option.  

Note:  There is no way to prevent this pop up reminder from appearing. Currently, the window will 
appear even if there are no linked HCPCS. This will be handled differently in a future version of e-MDs 
Chart. 

To add HCPCS to the visit charges: 
1. The Linked HCPCSs window will show all HCPCS codes linked to the selected order (CPT). 

Highlight any HCPCS(s) in the list and click Accept to add them to the current Visit or Order 
Note.  

OR 

Click Accept All to choose all of the HCPCS in the list. 

The selected HCPCS code(s) will be added to the Orders section of the note, following the CPT 
code to which they are linked. Both the HCPCS code and description will appear, along with a 
quantity which defaults to 1 and is displayed as "(x1)" following the description.  

2. To change the quantity, click "(x1)" and type into that field or use the up/down arrows to change 
the number. 

Note:  e-MDs has pre-linked a few HCPCS, but the responsibility for creating the CPT-to-
HCPCS links rests with the user.  If the Linked HCPCSs window does not show the desired 
supply, click Add HCPCS. Select the appropriate HCPCS from the full HCPCS search and click 
Accept. This will add the supply to the Linked HCPCSs window. Then, select the supply code 
from that window and click Accept to add the HCPCS code to the current note. 

If any HCPCS codes are linked incorrectly, simply highlight the code(s) in the Linked HCPCS 
window and click Delete. This breaks the CPT-HCPCS link for ALL users. 

Orders are found in the Plan section of an active Visit or Order Note, linked to diagnoses and listed under 
the diagnosis’ Orders subheading (displayed in blue text and underlined).  

To move an order to a different diagnosis: 
1. Click any order and select the Move to Another Diagnosis menu option. (The Move to Another 

Diagnosis option is only active if the order was entered manually. Due to the linking created, an 
order entered via a template will not have this option available.) 

2. This opens a window listing all of the diagnoses for the current visit. Select any one to move the 
prescription to that diagnosis.   

Note:  Currently, it is not possible to link a single order (CPT) to more than one diagnosis (ICD) 
in either the note display or the Superbill/Charge Capture. 

Using Cached CPT Codes 
The Cached CPT Code module works in conjunction with the Clinical Rules Engine (Rule Manager) and 
the Rule-Based Reminders window to assist in automating the documentation and/or billing of CPT codes 
for tests or procedures that are deemed necessary during the process of a visit.  The module does this by 
presenting a window that contains linked ICD and CPT codes appropriate for the selected rule.  If codes 
exist in the CPT Cache window it will appear whenever a note is opened or closed and also on demand 
(see Accessing Cached CPT Codes for details).  Once the window opens the user has the option of 
dropping these codes into the note for documentation and/or billing purposes. 
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Rules are created in the Rule Manager and these rules query the database to provide information about a 
patient’s status concerning preventive health, disease management, medication management, and 
immunizations.  As part of the process of creating these rules, CPT codes that represent the test or 
procedure identified by the rule can be associated with the rule. Reminders generated by the rule provide 
the user with information about tests or procedures that are overdue (or coming due in the near future), 
and these reminders are visible within the individual patients’ chart.  Once the reminders are displayed in 
the patient’s chart, the user then has the option of addressing those reminders in several ways (see 
Addressing Rule-Based Reminders for details).  One of the options for addressing a rule-based reminder 
is to use the Ordered button.  Clicking this button inserts ICD and CPT codes into the Cached CPT Code 
module and when the note is opened the user has the option to drop these codes into the note. 

Accessing Cached CPT Codes 
The Cached CPT Code module presents the user with a CPT Cache window that contains ICD and CPT 
codes that are linked to specific rule-based reminders.  This window is populated whenever a rule-based 
reminder is addressed by using the Ordered button in the Rule-Based Reminders section of a patient’s 
chart and if the rule has codes linked to it (see Create a New Rule for details).  The CPT Cache window 
can be accessed in 3 ways; automatically on the opening of a Visit or Order Note, automatically on the 
closing of a Visit or Order Note and manually on demand. 

To access cached CPT codes: 
1. Access CPT Cache upon opening a Visit or Order Note. 

2. Whenever a Visit or Order Note is created or opened, a warning message is presented if Cached 
CPT codes exist for that patient.  This message reads:   
There are outstanding orders (CPT codes) for this patient that have not been 
dealt with.  Please evaluate these “Cached CPT Codes” and handle as 
appropriate. 

Display “Cached CPT Codes”? 

3. If you select Yes, the CPT Cache window opens and you are given the opportunity to drop the 
codes into the note or to cancel.  

OR 

If you select No, the CPT Cache window will not open and the note can be documented as 
necessary. 

Note:  If a shortcut or past visit is going to be used, you should choose No or the CPT Cache 
window should be canceled.  Dropping cached codes into the note at this point will prevent the 
loading of a shortcut or past visit.  If the CPT Cache window is canceled, you will be reminded 
again at the note conclusion. 

To access CPT cache on Visit or Order Note conclusion: 
1. Anytime the Note Conclusion icon is clicked, a warning message is presented if Cached CPT 

codes exist for that patient.  The message reads: 
There are outstanding orders (CPT codes) for this patient that have not been 
dealt with.  Please evaluate these “Cached CPT Codes” and handle as 
appropriate. 

Stop the conclusion of this note and display “Cached CPT Codes”? 

2. If you select Yes, the CPT Cache window will open and you will be given the opportunity to drop 
the codes into the note or to cancel.  

3. If you select No, the CPT Cache window will not open and the note conclusion will proceed as 
usual. 

Note:  If you click the X at the top right of the patient chart or at the top right of the Chart 
application window, the CPT Cache window will NOT be displayed. 



 

e-MDs Solution Series Chart User Guide 8.0 R01 93 

To access CPT cache manually: 
1. Click the Plan header and select Cached CPT Codes from the pop-up menu. 

OR 

Click the arrow to the right of the Plan button (one of the navigation buttons on the left side of the 
note) and select Cached CPT Codes from the pop-up menu 

The CPT Cache window will open.   

2. If any codes exist, drop them into the note now. 

Dropping Cached CPT Codes into a Note 
The Cached CPT Code module presents the user with a CPT Cache window that contains ICD and CPT 
codes (and the date they were generated) that are linked to specific rule-based reminders.  This window 
is populated whenever a reminder is satisfied by using the Ordered button in the “Rule-Based Reminders 
section of a patient chart and if the Rule has codes linked to it (see Create a New Rule for details).  
Selection of one of these two methods inserts ICD and CPT codes into the Cached CPT Code module 
and when the note is opened the user has the option to drop these codes into the note. 

Dropping Cached CPT codes into a Visit or Order Note serves two purposes.  One is to satisfy the Rule 
that it was generated from so that the rule will no longer show up in the Rules Result window (until it 
becomes due again).  The other is to ensure that reimbursement occurs for those items that are 
performed in-house. 

To drop cached CPT codes into a note: 
1. With the Cached CPT window open (see Accessing Cached CPT Codes for details). 

2. Select the desired code to highlight it. 

3. Click additional codes to drop multiple codes into the note (to clear a code, click it a second time). 

4. After all codes are selected, click the Drop Into Note button. 

5. The ICD code will be added to the note as a diagnosis under the PLAN section and the CPT will 
be added under that diagnosis under the Orders subhead. 

Note:  If a CPT is cached without an associated ICD code the CPT will be added to the note 
under the Other Orders header.  From there it can be move to an appropriate diagnosis if one 
exists (see Move an Order to Another Diagnosis for details). 

Deleting Codes from the Cached CPT Window 
Cached CPT codes are generated when a user clicks the Ordered button to address a rule-based 
reminder on the Reminders tab of a patient’s chart (provided the rule has ICD or CPT codes linked to it).  
If the cached codes are not dropped into a Visit or Order Note they will remain in the Cached CPT 
window and will appear whenever a note is opened or closed for that patient.  To avoid this problem it is 
always best to drop the cached codes into a note at the time of the visit.  However if this does not happen 
the codes can be removed from the Cached CPT window at any time. 

To delete codes from the cached CPT window: 
1. With the Cached CPT window open (see Accessing Cached CPT Codes for details). 

2. Select the code to be deleted to highlight it. 

3. Click additional codes to delete multiple codes at one time (to clear a code, click it a second 
time). 

4. Once all codes are selected, click the Delete From Cache button. 
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Updating E&M Coding 
Automating Coding with the E&M Coder 
e-MDs Chart offers an automated E&M (Evaluation and Management) coding wizard. To see the current 
status of the E&M documentation at any point during a note, click the Plan heading and then click E&M 
Coder. Alternately, click the black arrow next to the P button in the vertical button column, and then select 
E&M Coder.  

Although the E&M Coder will suggest an E&M code based on the level of documentation, it will not 
automatically add that code to the note. The healthcare provider is required to view the E&M Coder and 
Accept the suggested code (or change it) in order to drop an E&M code into the note. (Alternately, the 
user can bypass the E&M Coder altogether and select an E&M code from a list.) So that the physician 
does not forget to include an E&M code, the system can be set to pop-up the E&M Coder at the time of 
note conclusion if a code has not already been added to the Orders. 

Follow the steps in the next sections to understand the automation and how the code is calculated. 

1. Service Type and Patient Type  

2. History  

3. Examination  

4. Medical Decision Making  

5. Accept or Change the Code  

Note:  There are inherent difficulties in automating the determination of the E&M Code. This 
includes (but is not limited to) the amount of time that may be spent in counseling and 
coordination of care and the subjective nature of determining the level of risk in "Medical Decision 
Making" section. Therefore, e-MDs does not warrant the validity of any calculated E&M code. The 
calculated code is meant to merely be a guide, and the physician must use his or her best 
judgment in adjusting that code, if necessary. 

E&M Coder: Service Type and Patient Type 
1. Service Type: This field is located at the uppermost portion of the E&M Coder window. It will 

already be filled in based on information from the Visit Details window. This identifies the setting 
of the patient encounter, which determines the appropriate subset of E&M codes.  

2. Patient Type: The Patient Type- New or Established- will already be filled in, based on an 
automated check of the database for any prior Visit or Order Notes. This information is very 
important as the amount of documentation required to reach a particular code level depends upon 
this status.  

E&M Coder: History 
3. History Data: This is recorded on the first horizontal row of the E&M Coder. There are 3 

questions that must be answered to obtain a History Summary. Filling out this data automatically 
calculates the level of detail of the History and displays this in the History Summary field (located 
to the right of the arrow in the first row).  

4. History of Present Illness: The number of questions asked in the History of Present Illness 
(HPI) - either 1-3 questions or 4+ questions. 

If this history is documented via HPI templates with E&M Extended Attributes, the number of 
questions will automatically be tallied. If some or all of the history is documented via free text 
(typing or voice recognition), the user must manually select the correct check box in the E&M 
Coder. 

5. Review of Systems: The number of organ systems addressed in the Review of Systems (ROS) - 
either 1, 2-9, or 10+ systems. 
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If this history is documented via an ROS template (or Fast Form) with E&M Extended Attributes, 
the number of systems addressed will automatically be tallied. If some or all of the ROS is 
documented via free text (typing or voice recognition), the user must manually select the correct 
check box in the E&M Coder. 

6. Past Medical/Family/Social Histories: Documents whether Past Medical History, Family 
Medical History, and/or Social History are addressed. 

If these various sections have been added to the note, they will automatically be counted.  

If ANY of the following sections are added to the note, credit is given for Past Medical History: Current 
Problem List, Allergies, Current Medication List, Past Medical History, Surgical History, Mental Health 
History, and/or Communicable Disease History.  

If ANY of the following sections are added to the note, credit is given for Social History: Social History, 
Tobacco/Alcohol/Supplements, and/or Substance Abuse History 

E&M Coder: Examination 
7. Examination Data: This is recorded on the second horizontal row of the E&M Coder, to the right 

of the text window. The only data field asks for the number of exam items performed—choose 
either 1-5, 6-11, 12+, or 18+ (which must involve at least 9 organ systems). 

If the exam is documented via a Plan template whose title begins with "Exam with E/M Coding: 
__", the number of qualifying "exam items" will automatically be tallied. If any other template is 
used, or if all or part of the exam is documented via free text, the user must manually select the 
correct number of exam items. 

8. When the number of exam items is selected (either automatically or manually), the level of detail 
of the Exam is calculated and displayed in the Exam Summary field (located to the right of the 
arrow in the second row). 

E&M Coder: Medical Decision Making 
Medical Decision Making Data is documented on the bottom horizontal row of the E&M Coder. There are 
3 questions that must be answered to obtain a Summary. These items will be calculated automatically, 
but can be changed by the user. When the check boxes for each of the 3 questions are addressed, the 
level of complexity of the Medical Decision Making is automatically calculated and is displayed in the 
Medical Decision Making Summary field (located to the right of the arrow in the third row).  

9. Number of Diagnoses or Management Options: Choices include minimal, limited, multiple , or 
extensive. Click the bold header in that box to learn more about how this decision is made. 
"Points" are assigned based on the total number of diagnoses in Assessment, as well as whether 
the problems are acute or chronic, and stable or worsening. For this reason, it is critical that the 
user record the diagnosis properties accurately. 

Note that a limitation of the E&M Coder is the inability to distinguish between a "new problem not 
needing further workup" (which is worth 3 points) and a "new problem requiring additional work-
up" (worth 4 points). Therefore, if the Assessment includes a diagnosis that does need further 
work-up, and the "Multiple" option is automatically selected, the user will need to manually 
change that to "Extensive." 

10. Amount and Complexity of Data to Review: Choices are none/minimal, limited, moderate, or 
extensive. Click the bold header in that box to learn more about how this decision is made. 

"Points" are assigned, in part, based on whether lab, radiology, and/or other tests are ordered. 
These points are counted automatically, based on the Orders section of the Visit or Order Note. 

(CPTs are divided into categories of "lab", "radiology" and "other." Note that one point is assigned 
for lab, regardless of the number of labs ordered. Similarly, one point is allowed for "other" orders, 
regardless of the number. But, there is no maximum number of points for "radiology.") 

Additional points can be counted if the physician discusses results with a specialist, decides to 
obtain old records, and/or reviews old records or obtains a history from someone other than the 
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patient. There is no way to automatically tally these points. So, if the user performs any of these 
actions, the check box may need to be changed manually. 

11. Risk of Complications: The third field assesses the risk of complications and/or morbidity or 
mortality. Click the bold header in that box to learn more about how this decision is made. 

Three categories are used to determine the risk: the types of problems (acute/chronic, 
stable/worsening, etc.), the types of procedures ordered (and their relative risks), and the types of 
management (prescription medications, IV fluids, surgery, etc.) The highest level of risk in any 
one of the three categories determines the overall risk. 

Because the type of problem contributes to the determination of risk, it is critical that the user 
record the diagnosis properties accurately. 

In regard to the risk for each type of procedure, e-MDs has internally coded each CPT with a risk 
level, from 1 to 4. This level is not visible to the user or editable. 

One important aspect of the type of management is that prescription drugs are considered a 
moderate risk. Therefore, if any prescriptions are written through the Script Writer, the system will 
automatically score (at least) a moderate level risk. If, for some reason, a prescription is not 
written in the Script Writer (i.e. it is hand-written or samples are given), the user will need to 
manually mark the Moderate risk level. 

E&M Coder: Accept or Change the Code 
12. The Calculated E&M Code: Based upon the History, Exam, and Medical Decision Making 

Summaries, the E&M code is calculated and displayed in blue at the bottom of the E&M Coder 
window. If the user chooses to override a result in the Summary column, the calculated code will 
appear in red. The answers to any of the data fields may be changed at any time, which may 
automatically change a particular section’s summary, and, ultimately, the final E&M code. 

○ Click Accept to drop the calculated E&M code into the current Visit or Order Note and close 
the window.  

○ Click Reset to clear all of the fields and calculate another E&M code.  

○ Click Cancel to close the window.  

Selecting a Code Without the E&M Coder 
13. In an active Visit or Order Note, either click the Plan heading or the small black arrow next to the 

P button in the vertical button column, and then click the Select E&M Code option.  

This opens a Linked CPT window, displaying E&M codes that are in the user’s "short list " of 
favorite codes.  

14. If the desired code is in that window, click it to highlight it, and then click Accept. This will add the 
E&M code to the Orders section of the note, linked to the primary (first) diagnosis. 

15. If the desired code is not present in the Linked CPT window: 

a. Click Add CPT. This opens the CPT search.  

b. Click the Outline button, and then click the plus sign next to the Evaluation and 
Management folder.  

c. Continue drilling down to open subfolders. Check the "short list" check box next to every E&M 
code to be displayed in e-MDs Chart.  

d. When finished with all selections, click Exit. 

Dropping Preventive Care E&M Codes Into Notes 
Preventive Care E&M codes are automatically dropped into the Visit or Order Note when the appropriate 
ICD is added.  For example, when V20.2 is added to a Well Child visit, the patient’s age will be assessed 
along with whether they are new or established and then the appropriate preventive E&M will 
automatically drop into the note without any intervention from the user. The preventive code will also be 
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available in the E&M wizard IF the Type of Encounter for the Visit or Order Note is set to Preventive 
Medicine Services. 

Note:  If a well visit diagnosis is added to a note the preventive E&M will be added automatically 
whether the Type of Encounter in the visit details is set to Preventive Medicine Services or not.  For 
example even for a visit marked as Office/Outpatient Visit if a well diagnosis is added to the note the 
preventive E&M will be dropped in automatically. 

An feature related to the Preventive E&M code is that if there is a “sick” diagnosis code in the note as well 
as a “well visit” diagnosis then an additional window will pop up at Note Conclusion (in lieu of the E&M 
Wizard) prompting the user to add a second E&M code (along with a 25 modifier) to the note IF desired 
(see screenshot below for an example). This new screen is similar to the E&M wizard in that it provides 
codes based on whether the patient is a New or Established patient. e-MDs will not try to calculate an 
E&M level for the sick visit. The decision for picking an appropriate sick visit code is left up to the user.  

 

Tracking Time with the E&M Coder 
To enhance the process of generating E&M codes there is a time tracking component available in the 
E&M Coder as seen in the screenshot below. 

 
Time for a visit is tracked based on a timeframe that starts when the provider part of the note is started in 
Tracking Board and ending when the E&M wizard is opened or when the patient is checked out of the 
exam room in Tracking Board.  This timeframe is an estimate and may not reflect the exact amount of 
time that is spent with the patient.  Because this is an estimate an amount of time can also be chosen 
from a dropdown list so that the user can adjust the time to more accurately reflect time that was spent 
with the patient (see screenshot below for an example). 
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Whether you choose to use the calculate time or pick a time from the list, you can choose to add 
documentation to the Visit or Order Note that reflects the time spent with the patient. To do this simply 
click the check box labeled Add to Note to the right of the time field.  If this check box is checked the time 
of the visit will be added to the description of the E&M code in parenthesis. For example documentation in 
the note would read: Office/outpatient visit; established patient, level 3 (15 minutes). 

Note:  Changes in the E&M code are not automatically calculated using the time documented.  That is to 
say that e-MDs does not recalculate the E&M code at a higher or lower level based on the estimated time 
spent with the patient.  The time is provided as a convenience and if the user wishes to make changes to 
the code based on time spent with the patient they must do so manually.  

Adding a Modifier in the E&M Coder 
To enhance the process of generating E&M codes there is a Modifier button available in the E&M Coder 
window. 

 
This button allows users to access the Linked CPT Modifiers window where the user can choose to add 
one or more modifiers (to a maximum of 4) to the E&M code that is displayed in the E&M Coder window. 
Once one or more modifiers are chosen they will be reflected in the E&M Coder window appended to the 
E&M code (see screenshot below for an example) and dropped into the Visit or Order Note. 

 
Using the Global Detail View in E&M Coder 
The E&M coder has a Global Detail button which opens a summary of the CPTs for which a patient is in a 
global period.  The button label is red if the patient is in a global period. 

 

Providing Patient Education 
A wide variety of Patient Education materials are included in e-MDs Chart, including information about 
diseases, symptoms, procedures, preventive health measures, and alternative therapies. To enable quick 
searches of the material, each document is linked to one or more diagnosis (ICD) and/or procedure (CPT) 
codes. When these codes are used in a Visit or Order Note, the linked Patient Education documents are 
presented. (To read about editing these documents, see Edit a Patient Education Document.) Patient 
education resources from Krames and MedlinePlus are also available. 
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Adding Patient Education to a Visit or Order Note 
In the Plan section of the Visit Note, you can add patient education for diagnoses, lab orders or results, 
and medications. Instructions are provided below. 

To add patient education (e-MDs or Krames) to a Visit or Order Note: 
1. In an active Visit or Order Note, scroll to the Plan heading or click the P button in the vertical 

button column to ‘jump’ to that section of the note. 

The Plan section of the note will display each diagnosis from Assessment. Patient Education 
documents are linked to diagnoses.  

2. Select the correct diagnosis header (displayed in bold black text) and click the Patient Education 
Handouts subheading (displayed in blue text and underlined). 

3. Select Print e-MDs Patient Education to print the related documentation available in e-MDs 
Chart.  In the Linked Patient Education window, highlight the title(s) of appropriate handout(s) and 
click Accept.  The selected documentation queues the handouts in the printer. 

OR 

Select Krames to review the available Krames patient education documentation.  An Internet 
browser window will open at the Krames website and a list of appropriate patient education 
material will be displayed.  Select the desired item(s) and click the Web browser Print option.  
The items selected will print after you close this window. 

This step adds documentation to the Visit and Order Note indicating that those specific handouts 
were given to the patient on that date.  For more information about printing the handouts, see the 
To print and fax visit related items procedure. 

4. If an appropriate handout does not appear in the Linked Patient Education window, click Add 
Patient Ed for the full Patient Education search. If a document is found in that search, highlight its 
title and click Accept. This will add that document to the Linked Patient Education window, linking 
the document to the corresponding diagnosis. 

To add patient education (MedlinePlus) to a Visit or Order Note 
1. In an active Visit or Order Note, scroll to the Plan heading or click the P button in the vertical 

button column to ‘jump’ to that section of the note. 

2. Click the Patient Education Handouts link to open the Patient Education window. 

3. At the top of the window are several buttons. Click the Medline+ button to display a list of the 
problems, lab orders, lab results, and medications included in the Visit Note. 

 
4.  Click the check box next to each item for which you want to view or print MedlinePlus 

information. (To view information for all problems, lab orders, lab results, and medications, click 
the Select All button.) 
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5. To view information for the selected items: 

○ Click the Display button. MedlinePlus Connect opens in a web browser, and each selected 
item is displayed as a link. 

○ Click a link to display the related MedlinePlus information in a web browser. (You can print the 
information from the web browser.) 

6. To add information to the Chart Note: 

○ Click the Accept button. A list of the selected MedlinePlus patient education items is added to 
the note.  

Adding Drug Education to a Visit or Order Note 
Drug Education materials for the most commonly prescribed medications are included in e-MDs Chart. 
Handouts discuss indications, contraindications, common and serious side effects, general directions for 
taking the medication, drug interactions, and warnings. To enable quick searches of the material, each 
document can be linked to one or more diagnosis (ICD) codes. When these codes are used in a Visit or 
Order Note, the linked Drug Education documents are presented. To read about editing these documents, 
see Edit a Drug Education Document. 

To add drug education to a Visit or Order Note: 
1. In an active Visit or Order Note, scroll to the Plan heading or click the P button in the vertical 

button column to ‘jump’ to that section of the note. 

2. The Plan section of the Visit or Order Note will display each diagnosis from Assessment. Drug 
Education documents are linked to diagnoses. Choose the correct diagnosis header (displayed in 
bold black text), click the Patient Education Handouts subheading (displayed in blue text and 
underlined), and then select the Drug Education menu option. 

3. In the Linked Drug Education window, highlight the title(s) of appropriate handout(s) and click 
Accept. This adds documentation to the Visit or Order Note that those specific handouts were 
given and queues up the handouts in the printer. (See the To print and fax visit related items 
procedure for details about printing the handouts). 

4. If an appropriate handout does not appear in the Linked Drug Education window, click Add Drug 
Ed for the full Drug Education search. If a document is found in that search, highlight its title and 
click Accept. This will add that document to the Linked Drug Education window, linking the 
document to the corresponding diagnosis. 
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Using Spanish-Language Patient Education Handouts 
Both the Patient Education and Drug Education handouts are available in Spanish. Follow the instructions 
for locating the appropriate document in English and dropping it into the Visit or Order Note (see Add 
Patient Education to a Visit or Order Note for details). 

To use Spanish patient education handouts: 
1. After the document has been added to the Plan section of the active Visit or Order Note, click the 

title of the handout, and select the Properties menu option. 

2. In the Properties window, change the Language field selection from English to Spanish. 

3. Click Save. 

Note:  When the Patient (or Drug) Education material is printed, the Spanish version will print. The 
Visit or Order Note documentation includes a notation that the Spanish version was given to the 
patient. 

The following scenario should not happen frequently, since Patient Education Handouts are linked to 
diagnoses. 

To move a patient education handout to another diagnosis: 
1. Drop a linked Patient (or Drug) Education handout into a Visit or Order Note. (See Add Patient 

Education to a Visit or Order Note for instructions.) 

2. Click the title of the handout and select the Move to Another Diagnosis menu option. 

3. This opens a window listing all of the diagnoses for the current visit. Select any one to move the 
Patient Education handout to that diagnosis. 

Note:  If the document is linked to the wrong diagnosis, it must be removed from that link 
window in the Code Linker module. 

To delete a patient education handout from a Visit or Order Note: 
1. The Plan section of the Visit or Order Note will display each diagnosis from Assessment. Patient 

(and Drug) Education documents are linked to diagnoses, and are displayed under the Patient 
Education Handouts subheading (displayed in blue text and underlined). 

2. Click the title of the document to remove, and select the Delete menu option. 

3. Click Yes in the Delete Confirmation window. 

Documenting Patient Recommendations 

To add recommendations related to a diagnosis: 
1. In an active Visit or Order Note, scroll to the Patient Recommendations heading or click the 

PtRec button in the vertical button column to ‘jump’ to that section of the note. Patient 
Recommendations print separately from the note and can be given to the patient to take home. 

2. Patient Recommendation text can come directly from templates. Note that many of the Plan 
templates include a section titled Patient Recommendations. Clicking off items in this part of the 
template will document the checked recommendations in both the Plan and in the Patient 
Recommendations.  

○ Like any template-generated text, this information cannot be edited directly. See the Template 
Editor instructions to learn how to add, edit, or delete this Patient Recommendation text. 

○ The only way to remove this text from Patient Recommendations is to reopen the 
corresponding template and clear the boxes.  
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3. Patient Recommendations can also be typed. The Patient Recommendations of the note will be 
subdivided with headers for each diagnosis. Click the free text icon (the gray circle that becomes 
a yellow square when the cursor hovers over it) to the right of any of these headers. Type 
recommendations in the Free Text window and click Save. 

To add recommendations related to a medication: 
1. In an active Visit or Order Note, scroll to the Patient Recommendations heading or click the 

PtRec button in the vertical button column to ‘jump’ to that section of the note. Patient 
Recommendations print separately from the note and can be given to the patient to take home. 

2. Medication Recommendations can be typed into the Patient Recommendations section of the 
note. The Patient Recommendations of the note will be subdivided with headers for each 
prescription written. Click the free text icon (the gray circle that becomes a yellow square when 
the cursor hovers over it) to the right of any of these headers. Type recommendations in the Free 
Text window and click Save. 

Capturing Charges with the Superbill 

To display the Superbill: 
1. In an active Visit or Order Note, click the blue Charge Capture heading.  

OR 

Click the $$ button in the vertical button column to ‘jump’ to that section of the note. The Superbill 
(or Charge Capture form) prints separately from the note.  

2. The Superbill is built automatically as a result of ICD, CPT (including E&M), and HCPCS codes 
being added to the Assessment and Plan. Information that is not correct in the Superbill must be 
corrected in the Assessment and Plan. 

3. All diagnoses (along with their ICD-9 codes) will transfer from Assessment to the Superbill.  

4. All orders (along with their CPT codes) that are marked as either "In House" or "Send 
Out/Billable" will transfer from Plan. 

5. All supplies (along with their HCPCS codes) that are attached to either "In House" or "Send 
Out/Billable" orders will transfer from Plan. 

6. The black $$ on the Charge Capture button in the vertical button column turn blue as codes begin 
to appear in the Superbill. If red dollar signs ($$) appear instead, it indicates one or more of the 
following problems: 

○ A "no code" diagnosis (without an ICD-9 code) exists, 

○ A "red code" diagnosis (requiring the addition of a fourth or fifth digit) exists, 

○ One or more orders (CPTs) appear in the Other Orders section, rather than linked to 
appropriate diagnoses (ICD-9s). 

Using Laboratory and Radiology Order Forms 
Laboratory Order Forms and Radiology Order Forms are automatically generated whenever lab or 
radiology procedures are ordered in the Plan section of a Visit or Order Note, but are only printed (or 
faxed) if the user decides to do so. To assist with workflow, these order forms can be routed to a printer or 
fax machine in the lab. (See the To print and fax visit related items procedure for details.)  

The header of these forms include the clinic name, address, phone and fax numbers, the patient name 
and date of birth, the ordering healthcare provider, and the date. The orders contain the test description 
and CPT code, the ICD code (diagnosis) for which the procedure is being ordered, whether the procedure 
is to be done in-house or sent out, and whether the procedure is to be performed immediately. 
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Laboratory Order Forms and Radiology Order Forms follow e-MDs format, and this format cannot be 
altered. 

Concluding the Visit Note 
When note documentation is complete, click the Note Conclusion button (the yellow clipboard with the 
green check mark located on the toolbar above the note). Normally, this action will open the Note 
Conclusion window, allowing you to choose which items to print (or fax) and permits sign-off of the note. 
However, you can choose to have two pop-up reminder windows appear prior to the Note Conclusion 
window. 

Setting User Preferences for Pop-Up Reminders 
The first window allows verification of the diagnosis properties (severity, course, chronicity), which is 
important for accurate E&M code calculation.  

The second window is a reminder to select an E&M code. This window appears only if an E&M code has 
not already been added to the note. It displays the automatically calculated code, allowing the user to 
accept that code or make changes. 

Whether or not these windows appear is a user preference. Each user must choose to show these 
windows under his or her user preference options.   

To set user preferences: 
The provider must first be logged into e-MDs Chart. This login links the preferences to the correct 
provider.  

1. Click File, and choose the Options menu option. 

2. In the e-MDs Chart Options window, click the Visit Notes or Order Notes tab. 

3. In the lower-left corner of the e-MDs Chart Options window, click either or both of the check 
boxes next to Automatically show: Diagnosis Properties and/or Automatically show: EM 
Coder. 

Verifying Diagnosis Properties 
For accurate E&M coding, it is very important that the diagnosis properties (severity, course, and 
chronicity) be recorded. This can be done at any time from the Assessment section of the note. However, 
because the physician may frequently forget to address this, it is recommended that user preferences be 
set to allow a pop-up reminder at the time of note conclusion. 

If the user preference is activated, when the provider clicks Conclude Visit Note, the All Visit ICDs 
window opens. This window lists every diagnosis from the note, by ICD code and description. Columns 
display the Severity, Progress, and Course of each diagnosis. 

• Choices for Severity include Mild, Moderate, or Severe. All problems will default to Moderate. 
(Except if a follow-up diagnosis was selected; in that case, the last recorded Severity for that 
problem will be displayed.)  

To change the Severity, click the radio button next to the desired severity choice.  

• Choices for Progress include Improving, Stable, or Worsening. All problems will default to Stable. 
(Except if a follow-up diagnosis was selected; in that case, the last recorded Progress for that 
problem will be displayed.)  

To change the Progress, click the radio button next to the desired progress choice.  

• Choices for Course include Acute or Chronic. All ICDs in the database have been set to either 
Acute or Chronic by e-MDs, and the diagnosis will display that default setting. (Except if a follow-
up diagnosis was selected; in that case, the last recorded Course will be displayed.)  
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To change the Course, click the radio button next to the desired course choice.  

• When all diagnosis properties have been set correctly, click Save. 

Selecting the E&M Code 
At any point during documentation of the Visit or Order Note, you can either manually select an E&M 
code or view the progress of the automated code calculation in the E&M Coder.  

However, if no E&M code has been added to the note (and preferences have been set to be prompted for 
an E&M code), when you click Conclude Visit Note, the E&M Coder window will open. (Depending on 
your preferences, the window used to verify diagnosis properties may open first, and then the E&M Coder 
window.) 

In the e-MDs E&M Coder window, view the calculated E&M code displayed in blue text in the lower left 
corner. Depending on whether structured templates were used to collect data (versus free text typing), 
this data may or may not be accurate. At this point, the user can manually change the data in any of the 
seven data collection fields (the boxes located to the left of the arrows).  

Overriding any of the three Summary fields (to the right of the arrows) will turn the calculated code red, 
indicating that the code may be incorrect. It is better to instead correct any of the check boxes in the 7 
data collection fields, allowing the E&M Coder to then recalculate the summary. 

If the Calculated Code is deemed to be accurate, click Accept to add this E&M code to the note. It will 
automatically be tied to the primary (first) diagnosis. 

Click Reset to clear all the data fields.  

Click Cancel to close the E&M Coder without adding the E&M code to the note. 

Note:  There are inherent difficulties in automating the determination of the E&M Code. This includes 
(but is not limited to) the amount of time that may be spent in counseling and coordination of care and the 
subjective nature of determining the level of risk in "Medical Decision Making" section. Therefore, e-MDs 
does not warrant the validity of any calculated E&M code. The calculated code is meant to merely be a 
guide, and the physician must use his or her best judgment in adjusting that code, if necessary. 

Using Automated Preventive Care E&M Coding 
Preventive Care E&M codes are automatically dropped into the Visit and Order Notes when the 
appropriate ICD is added.  For example, when V20.2 is added to a Well Child visit, the patient’s age will 
be assessed along with whether they are new or established and then the appropriate preventive E&M 
will automatically drop into the note without any intervention from the user. The preventive code will also 
be available in the E&M wizard IF the Type of Encounter for the note is set to Preventive Medicine 
Services. 

Note:  If a well visit diagnosis is added to a note the preventive E&M will be added automatically 
whether the Type of Encounter in the visit details is set to Preventive Medicine Services or not.  For 
example even for a visit marked as Office/Outpatient Visit if a well diagnosis is added to the note the 
preventive E&M will be dropped in automatically. 

An feature related to the Preventive E&M code is that if there is a “sick” diagnosis code in the note as well 
as a “well visit” diagnosis then an additional window will pop up at Note Conclusion (in lieu of the E&M 
Wizard) prompting the user to add a second E&M code (along with a 25 modifier) to the note, if desired 
(see screenshot below for an example). This new screen is similar to the E&M wizard in that it provides 
codes based on whether the patient is a New or Established patient. e-MDs will not try to calculate an 
E&M level for the sick visit. The decision for picking an appropriate sick visit code is left up to the user.  
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Printing or Faxing Visit-Related Items 

To print and fax visit related items: 
1. At the conclusion of a Visit or Order Note, click the Conclude Note button, located on the Chart 

toolbar (clipboard with a green check mark button). 

2. The Note Conclusion window contains two columns labeled Print and Fax  with check boxes in 
each column corresponding to each report type that can be printed or faxed (EXAMPLE: Visit 
Notes, Patient Ed, Superbill, etc.).  

3. To print or fax a report, click the check boxes in the Print column next to those items to be printed 
AND/OR in the Fax column for those items to be faxed.  Anything not checked will not be printed 
(or faxed).  

Important!  The exception to the Print and Fax column check boxes is the Prescription report.  
It only has one check box which is under the Print column.  This check box represents that the 
prescriptions will be PROCESSED (either printed or faxed depending on the way prescriptions 
were designated when they were created).  It is important that this check box ALWAYS be 
checked; otherwise the prescriptions will not be printed or faxed. 

4. If the item is to be faxed, click the Edit button (pencil icon) in the Edit column to the right of the 
report name 

5. A compact version of the Fax Monitor will open and you can enter information such as Title, To, 
From and the Phone (Fax) number.  

6. After the information is entered, click the OK button to save the information into the Note 
Conclusion window. 

7. If the item is to be printed, each report type (i.e. Visit Note, Order Note, Prescriptions, etc.) can be 
routed to any printer.  This is typically set up in advance in Print Options, but can be changed on 
the fly by clicking the Print Options button in the Note Conclusion window OR by clicking the 
Printer Icon in the Options column.  The Printer Icon in the Options column provides for faster 
access to the print options of the specific report chosen. 

8. After all print and fax issues have been dealt with, address the Conclude Note portion of this 
window.  See “To sign off a Visit or Order Note” below for details. 

9. Click OK. 
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Successive messages will appear on screen as each report is routed as a print job to the 
appropriate printer(s).   

Signing Off the Note 

To sign off a Visit or Order Note: 
1. At the conclusion of a Visit or Order Note, click the Conclude Note button, located on the Chart 

toolbar (yellow clipboard with a green check mark button). 

2. Address the Print Options in the top half of the Note Conclusion window. (See the To print and 
fax visit related items procedure for details.) 

3. Decide whether the documentation is complete or needs editing at a later point in time.  

○ If incomplete, check Close Note/Edit Later. This enables printing or faxing of reports (such as 
Prescriptions and Patient Education), while permitting later editing of the note. 

○ If the note is finished, check Close Note/Permanent Sign Off. Enter your application 
password. Permanent sign off requires that the note’s author: 1.) be logged in, 2.) be 
designated as the Healthcare Provider in the Visit Details section of the Note, and 3.) use 
his/her password as a signature. 

Note:  After a note is permanently signed, it cannot be edited with out un-signing it. However, 
a time-stamped addendum can be added to the bottom of the note. See "Add an Addendum to 
a Signed Off Note" for details. See the "Un-sign Note Feature" section for details on un-
signing a note. 

4. Choose whether or not to flag the note as Ready to Bill. 

○ If a note is permanently signed, it is considered "ready to bill." Because the note cannot be 
edited, it is assumed that no further billing charges will be added. So, if the Close 
Note/Permanent Sign Off option is selected, the Ready to Bill check box is disabled.  

○ On the other hand, a common scenario is that the note documentation is not complete, but all 
of the billing codes have been added. In this case, select Close Note/Edit Later and put a 
check mark next to Ready to Bill. If this is done, e-MDs Bill will display the visit in red text to 
identify the fact that the note is unsigned, and a check mark will appear in the Ready to Bill? 
column, informing billing personnel that the final invoice can be built. 

Note:  In order to identify all unsigned patient notes that have been designated as “ready to bill,” 
you can select that filter in the “Unsigned Notes (Crystal Reports Version)” in e-MDs Reports 
User Guide. 

5. When finished, click OK, or click Cancel to close this window and return to the note. 

Customizing, Printing, or Exporting the Clinical (Visit) Summary  
During each patient visit, information about that visit is automatically compiled to create a summary 
document that can be printed or exported for the patient. This summary includes, among other things: 

• Provider's contact information 

• Reason(s) for the visit 

• Instructions based on clinical discussions that took place during the visit 

• Information on immunizations and medications administered during the visit 

• Time and location of next appointment, testing, or recommended appointment schedule 

You can access the summary document by selecting it for printing or electronic transmission (exporting) 
on the Note Conclusion screen that is displayed during the Visit and Order Note sign off process.   
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Users have the option of excluding certain sections of the summary from the Note Conclusion screen. 
(HIPAA requirements allow healthcare providers to exclude patient information the provider deems as 
harmful for the patient.) 

To select sections to include or exclude in the Clinical (Visit) Summary: 
1. Select (click) the check box in the Print or Elec column for the Clinical (Visit) Summary. The 

pencil icon in the Edit column will become active. 

2. Click the Edit (pencil) icon in the Clinical (Visit) Summary row to open the Clinical (Visit) 
Summary Options window. 

3. Click the check box before each section you want to include, or deselect sections to be excluded 
if sections are already checked.  

4. To keep these settings for all future patients, click the check box before the Save as Default 
Settings option at the top of the screen. When this window opens in the future, your saved 
settings will be preselected. If you do not check this option, you will need to select and/or deselect 
sections for each patient.  

Note:  If you save these options as your default settings, they will affect only your Clinical (Visit) 
Summary output. Other users will need to set their own default settings when logged in under 
their own login names. These are not global defaults for your facility. 

5. Click OK to save your choices and continue the Note Conclusion process. 

Printing and Saving a Clinical (Visit) Summary 
If Print is selected on the Note Conclusion screen, the summary will print on the default printer.  If Elec 
(electronic transmission) is selected, a Save CCD file check box will be displayed to allow you to save the 
Clinical (Visit) Summary as a C-CDA (XML) file.  See e-MDs Solution Series Utilities Guide for information 
about C-CDA files. 

• If the patient is a Portal user, a pop-up window will be displayed, and you will have the option to 
send the Clinical (Visit) Summary to the patient's account on the Portal.  (The patient would then 
be able to view the summary, save the summary to a location outside the Portal, or send the 
summary to another provider using Direct messaging.)  Click Yes to add the summary document 
to the patient's Portal account.  Click No to skip this step. 
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• After the Visit or Order Note is concluded (by selecting Close Note/Edit Later or Close 
Note/Permanent Sign Off), the Clinical (Visit) Summary is automatically saved to the Visit Notes 
folder in DocMan for future reference, as needed.  

Note: The Clinical (Visit) Summary C-CDA can be viewed in a browser window. If your browser is 
Internet Explorer version 9, the browser Security Setting “Access data sources across domains” 
must be selected in order to view the C-CDA in human readable format. 

• To print the Clinical (Visit) Summary from DocMan, locate the summary in the Visit Notes folder, 
right-click the summary, and select Print.  

See e-MDs Solution Series Utilities Guide for more information on printing documents 
from DocMan. 

• A record of the Clinical (Visit) Summary creation and distribution will be tracked and listed on the 
Chart Audits report.  See e-MDs Reports User Guide for information on how to list and view this 
logged information. 

Generating and Exporting a Transition of Care file (Chart Summary) 
When you need to export a summary of the information documented in all Visit Notes (this would 
essentially be the information in the Health Summary), you can use the Export Transition of Care (C-
CDA) option that is available when you click the CCD icon in the patient-specific toolbar in Chart. This 
export option is available in the Chart and DocMan modules. 

See e-MDs Solution Series Utilities Guide for instructions on importing and exporting Transition of Care 
(C-CDA) files. 

Using the Un-Sign Note Feature 
This feature allows users to un-sign a note. This feature allows the provider that signed a note off (and 
only that provider) to un-sign the note and make changes before re-signing it.  Notes can only be un-
signed within 24 hours of when the note was originally signed.  The feature was added to allow users to 
make simple changes within 24 hours of the end of a visit. This can be for items such as adding additional 
orders or prescriptions that may have been forgotten or overlooked during the visit.   

To un-sign a note: 
1. Go to Chart View and select the note to be edited.  

2. Click the Addendum button on the right side of the screen and choose Unsign-off Note from the 
pop-up menu.  

If the choice is not available, then it has been more than 24 hours since the note was signed off. 

 

Reopening a Previous Note 

To reopen an unsigned note for editing: 
1. First, select the patient. (On either the main e-MDs Chart or Tracking Board toolbar, click File and 

then select the Open Patient Chart menu option. Or, click the yellow folder icon near the upper 
left corner of either application. Either method will open the Find Patient window.) 
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2. Enter search criteria into any of the fields (such as patient name, social security number, or 
account number) and then press Enter or click Search. 

3. Either double-click the correct patient name from the search results screen or select the patient 
from the results screen and click Select. 

4. Click the Edit Prior Note icon on the gray toolbar below the blue patient identifier bar. This icon is 
an open yellow folder located to the right of the word "Note:". 

5. Select either a Doctor’s Note, Nurse’s Note or Order Note to list unsigned notes. 

The Load Visit window displays all unsigned notes of that type (doctor, nurse or order note), 
identified by date, healthcare provider, and diagnoses.  

6. Click to select the appropriate note. 

Notes:   
○ Completed (signed) visits will not show up in the Load Visit window. This window only displays 

incomplete (unsigned) notes. 

○ If a padlock icon appears next to any visit in the Load Visit window, that visit is "locked" and 
cannot currently be opened. This means that some user is currently working in that note, and 
the message "Locked by: __" identifies that user. 

Health Summary 
Current Problem List 
All diagnoses that are added in a note are automatically added to the patient’s Current Problem list.  
Chronic problems are shown in bold text and do not automatically get removed from the list.  Acute 
problems will “age” and fall off the list based on a global option.  This global option is set to 60 days by 
default but can be changed in the Administration Options section of Chart. 

Current Problem List Interface 
The Current Problem list has a toolbar that runs along the top of the window.  This toolbar allows users to 
view the list in a Detail view.  They can also view the Current list (default setting) as well as the Resolved 
list (list of historical problems for the patient). 

In addition there is a button toolbar that runs down the right side of the list.  These buttons allows users to 
Add a problem, Edit the properties of a problem, Resolve a problem and Delete a problem. 

Detail View of Current Problems 
In the default setting the Current Problem list shows only the description of the problem.  In the Detail 
view the diagnosis code (ICD-9 code), the date of onset of the problem, when the problem was added 
and the person’s name that added the problem are also shown. 

You can always choose to turn the detailed view on or off. 

To turn on the Detail View on the fly: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar.) The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Current Problems to open that section. 

3. Click the check box labeled Detail View. 

The display will change to a detailed view 

You can choose to set your default preference to always show the detailed view.  
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To turn on the Detail View as a default: 
1. Within a patient’s chart, click File then Options 

2. Click the Visit Notes tab. 

3. At the bottom of the form in the section labeled Other Options, click the check box labeled Show 
Detail in Current Problems. 

This sets the default setting to show detail. 

The default setting for the Current Problems list is to show only the current problems for the patient.  
Users can select to view the resolved problems. 

To view resolved problems: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar.) The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Current Problems to open that section. 

3. Click the radio button labeled Resolved 

4. The view will switch to showing only the patient’s prior problems. 

Recover Resolved Problems 
Items that have been ”resolved” and removed from the Current Problems list can be recovered and 
brought back to the current problems list.  This is handy for when a patient presents with an acute 
problem that was resolved in the past or when a diagnosis is mistakenly resolved.   

To recover a resolved problem: 
1. Click the Resolved radio button in the Current Problems. 

2. Highlight the problem. 

3. Click the Edit button (pencil icon). 

4. The Properties window for that diagnosis will open and at the bottom of the screen is a check box 
labeled Add to Current Problems.  Placing a check mark in the check box will return the diagnosis 
to the Current Problems list. 

Note:  When a problem is recovered from the Resolved list the user has the option to Auto Age 
the problem so that it resolves itself after a specified number of days.  If you do not want the 
problem to be automatically resolved do not check the Auto Age check box. If the Auto Age box is 
checked the “Resolve in (days)” field will default to 30 days but can be changed to suit the user. 

 

To add a problem directly to the list: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar.) The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Current Problems to open that section. 

3. Click the yellow plus sign   

Medicapaedia search option: Medicapaedia is a database of clinical terminology. It includes 
diagnosis/symptom descriptions and associated codes. 
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4. In the Search field, type the first few letters of a diagnosis or symptom (or type the ICD code) and 
then click the Search button located on the toolbar at the top of the Medicapaedia Search window 
(or just press the Enter key). 

5. In the search results, select (click) the check box next to each description to be entered in the 
note and then click the Select button on the toolbar. 

6. The Properties of a diagnosis include its Description, Date of Onset, Location, Severity, 
Progression, Course and Confidential status. To edit any of these properties, right-click the 
diagnosis and select the Properties menu option. See the Edit the Properties of a Diagnosis 
section for detailed information about the Properties. 

Note:  Problems marked as Severe will be displayed in Red. Problems marked as Chronic will 
be displayed in Bold. 

All problems added to a Visit or Order Note, whether added from the HPI or the Assessment, are 
automatically added to the Current Problems list unless the option is turned off.  To turn the option off: 

To turn off the option to add a problem from the visit assessment: 
7. Click File, then Options 

8. Click the Administration tab.   

You must have the correct privilege in order to see the Administration tab. 

9. Clear the box labeled Automatically add new problems to the current problems list. 

This is a Global option and will effect ALL users. 

Adding a Problem from Current Problem Template 
The Current Problem template allows for users to quickly document a patient’s list of diagnoses.  Items in 
this template that have an Extended Attribute of type Current Problem will populate the Current Problem 
list when chosen. See Current Problem Extended Attributes for details. 

This allows a nurse or medical assistant to quickly and easily gather the patient’s medical history 
information and populate the Current Problem list without having to do a search of the ICD-9 database, 
which can be confusing and time-consuming. 

To add a problem from a template: 
1. With a Visit Note or Order Note open, click the template launch icon  to the right of the Current 

Problems header in the note. 

2. Select the Current Problems template from the Template Link window. 

The template is organized by body system (for example Heart, Lungs, Bones/Joints, etc.). 

A question that has a Current Problem Extended Attribute linked to it will display a stethoscope 
icon  at the right. 

3. Navigate to the diagnosis you want and choose it by clicking the question. 

4. Select multiple problems, if needed. 

5. When the template is closed, the diagnosis will drop into the Current Problems list. 

Current Problems 

To edit the properties of a problem: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar.) The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Current Problems to open that section. 
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3. Highlight the problem that requires editing. 

4. Click the Edit button . 

OR 

Right-click the problem and select the Properties menu option. 

5. The Properties of a diagnosis include its Description, Date of Onset, Location, Severity, 
Progression, Course and Confidential status. See the Edit the Properties of a Diagnosis section 
for detailed information about the Properties. 

Notes:    
○ Problems marked as Severe will be displayed in Red. Problems marked as Chronic will be 

displayed in Bold. 

○ When a patient returns with an established diagnosis, it is very important to add that problem 
to the Visit or Order Note as a Follow-Up (see "Add Follow-Up Problems" for details). This 
way, changes in severity or progression can be tracked over time.  

Resolving a Diagnosis 
If a problem in the Current Problems list has resolved, it can be moved to the Resolved list. This merely 
removes the diagnosis from the Current Problems list, but not from the database. That problem can still 
be found under the Diagnoses tab in Chart View as well as the Resolved view in the Health Summary 
Current Problems section. 

To resolve a diagnosis: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar.) The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Current Problems to open that section. 

3. Click the problem to be resolved and select then click the Resolve button .  

4. Click Yes in the confirmation window. 

Note:  The Delete option is only available for problems that were not added to a note. To 
remove problems from a Visit or Order Note, edit the note and remove the problem. 

Deleting a Problem 
Diagnoses added in error to the Current Problems list can be deleted only if they come from a note that 
has not been signed off. 

To delete a problem: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar.) The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Current Problems to open that section. 

3. Highlight the problem to be deleted and click the Delete button .  

4. Select a reason for deleting the diagnosis. 

○ Dx in error 

○ Not Relevant 

○ No Reason 

There will be no confirmation number. 

Note:  If the diagnosis is a permanent part of the patient record (for example, is part of a Visit 
Note or Order Note), it cannot be deleted. 



 

e-MDs Solution Series Chart User Guide 8.0 R01 113 

Specifying No Current Problems (NCP) 
Using the No current problems (NCP) check box under the Current Problem List section in Health 
Summary, shows how many patients were queried for current problems and did not have any problems.  
Once the NCP box is checked, the Current Problems header in Health Summary will display as Current 
Problems – No Current Problems.  No Current Problems (NCP) will also display in the Visit or Order Note 
based on the auto-drop preference set in Chart Options. 

Note:  If an acute illness, such as a URI ages off of the Current Problem list to the Resolved list, the 
system will ensure that the NCP check box is selected for a patient. 

Clearing the NCP check box yields the following prompt: “Are you sure you want to uncheck this box?”  
Click Yes to remove the check mark and No Current Problems text from the header.  Or click No to leave 
the check mark and No Current Problems text in the header. 

Reviewing the Health Summary 
To view information about the last known reviewer, click the Review button within all categories of Health 
Summary.  Doing so will populate the category with the last known reviewer’s Name and the last 
Date/Time reviewed.  The Review All button will allow all categories to be populated with one click 
(excluding Pregnancy Summary). 

To Review or Review All in Health Summary: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar.) The Health Summary is in the left windowpane. 

2. To populate ALL health Summary categories at once, click Review All.   

Identifying Allergies/Adverse Reactions 

To mark a Visit or Order Note as No Known Drug Allergies: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar.) The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Allergies to open that section. 

3. Check the NKDA (No Known Drug Allergies) box. 

Notes:   
○ If allergies have already been documented, they must be deleted before NKDA can be 

checked. 

○ It is possible to document non-drug allergies and still check the NKDA box. 

To add an allergy or adverse reaction: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar.) The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Allergies to open that section. 

3. Click the Add Allergy button (the yellow plus sign) to open the Add Allergy window. 

Note:  Users have the choice of adding Drug or Non Drug allergies or adverse reactions. 

To add a Drug Allergy/Adverse Reaction: 
1. When the Add Allergy screen opens, determine whether the patient has a true allergy or merely 

an adverse reaction to the allergen, and select the appropriate choice. (The default selection is 
Allergy.) 

2. Select a Severity level, if desired. (The default selection is Moderate.) 
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3. To activate the Date/Time of Occurrence (if known) fields: 

a. Click the box before the Date field to activate that option.  A calendar will open with today’s 
date selected by default. 

b. Select a past or current date on the calendar.  When a past or the current date is selected, 
the time field will also activate. 

c. Click the box before the Time field and type in a time/time of day (AM or PM).  A time can 
only be entered if a date has been previously selected on the calendar. 

4. If you want to document one of the most common drug allergies, under Drug, click the desired 
drug choice. 

5. In addition to the common drug allergy choices, there is a radio button labeled “Other Common 
Drug Allergy.” Selecting this radio button gives you a choice of a much larger list of common 
allergies in a search screen window.  By using the search field or by scrolling down the list of 
choices, you can select the other common allergy that you want to document by clicking the drug 
name and then clicking Select or by double-clicking the drug name. Once the drug is selected, 
the drug name will become a selection on the Common list on the first screen. 

There is also another radio button labeled “Other Drug” that allows you to search for and select 
ANY drug in the database.  When this choice is selected, the Select a Drug window will open and 
you can search and select any drug in the database. Once the drug is selected, the drug name 
will become a selection on the Common list. 

6. Click the Other Common Allergy radio button to open the Other Common Drug Allergy list.   

7. Search for the drug and click Select or double-click the drug name. After the drug is selected, the 
drug name will become a selection on the Common list.  

8. After your choice is made (common, other common or other drug), you can choose to add further 
information about the allergy, if desired. 

If desired, the actual Reaction (e.g. nausea, hives) can be recorded in a structured manner.  

9. Click the yellow plus sign in the Reaction section to open the Select Allergy Reaction window.  

The Reaction window will open pre-populated with a list of the most common reactions. 

10. Type a few letters of the reaction type and either press Enter or click Search OR browse the list 
using the scrollbar on the right.  

Search options for reactions including Common drug reactions (the default setting), Drug Specific 
reactions (those reported to have occurred with the drug in question), or All reactions. If you do 
not find the reaction you are looking for in the common list, try changing the search filters by 
clicking the radio button next to Drug Specific or All and searching again. 

11. Multiple reactions can be added at the same time by selecting them in the search results. When a 
reaction is selected it will be added to the pane at the bottom of the screen. 

12. Click Save to add the reactions to the allergy. 

Any extra information can be typed in the Notes field if desired. 

13. Click Save to save your changes back to the Allergy section of the Health Summary. 

To add a non-drug allergy/adverse reaction: 
1. In the Add Allergy screen, just below the Drug section is a field labeled Non Drug.  This field is a 

drop down list of allergens that can be chosen to document non-drug allergies or adverse 
reactions. 

2. In the dropdown box, type a few letters of the allergen or click the down arrow to view the full list.  
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Note:  Non-drug allergens can now be added to the list of allergen available (see Adding Non-
Drug Allergens for details) 

3. Select the allergen from the search list by highlighting it. 

4. To activate the Date/Time of Occurrence (if known) fields: 

a. Click Date to activate the Date field.  A calendar will open with today’s date selected by 
default. 

b. Select a past or current date on the calendar.  When a past or the current date is selected, 
the time field will activate. 

c. Click Time to open the field and type in a time/time of day (AM or PM).  A time can only be 
entered if a date has been previously selected on the calendar. 

5. Determine whether the patient has a true allergy or merely an adverse reaction to the allergen, 
and select the appropriate choice. (The default selection is Allergy.) 

6. Select a severity level, if desired. (The default selection is Moderate.)  

If desired, the actual reaction (e.g. nausea, hives) can be recorded in a structured manner.  

7. Click the yellow plus sign in the Reaction section to open the Select Allergy Reaction window.  

The Reaction window will open pre-populated with a list of the most common reactions. 

8. Type in a few letters of the reaction type and either press Enter or click Search. 

OR  

Browse the list using the scrollbar on the right.  

9. Search options for reactions include Common drug reactions (the default setting), Drug Specific 
reactions (those reported to have occurred with the drug in question), or All reactions. If you do 
not find the reaction you are looking for in the common list, try changing the search filters by 
clicking the radio button next to Drug Specific or All and searching again. 

Multiple reactions can be added at the same time by selecting them in the search results. When a 
reaction is selected it will be added to the pane at the bottom of the screen. 

10. Click Save to add the reactions to the allergy. 

11. Any extra information can be typed in the Notes field, if desired. 

12. Click Save to save your changes back to the Allergy section of the Health Summary. 

Note:  Once the newly added allergy (or adverse reaction) appears in the Allergies section, 
details such as the allergen, reaction, user name, date entered, and date/time occurred can be 
viewed by using the cursor to hover the Allergies section.  Details can also be viewed by double-
clicking specific allergen or by highlighting it and clicking the Edit Allergy button (with the pencil 
icon). 

To edit/delete an allergy or adverse reaction: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar.) The Health Summary appears in the left pane. 

2. Click anywhere on the blue bar labeled Allergies to open that section. 

3. To edit allergies/adverse reactions: 

a. Highlight an allergy/adverse reaction and click the Edit Allergy button (with the pencil icon) 
to open the Edit Allergy window. 

b. Make changes to the Date/Time of Occurrence, Type, Severity, Reactions and Notes 
fields, as needed. 



 

e-MDs Solution Series Chart User Guide 8.0 R01 116 

c. Click Save. 

To delete allergies/adverse reactions: 

a. Highlight an allergy/adverse reaction and click the Delete Allergy button (with the red minus 
sign). 

b. The Stop Allergy window will open, 

c. Select a stop reason and click Save. 

Stopped allergies are moved to the Past Allergies section and are documented with a stop 
reason, date deleted, and the name of the person that deleted the allergy. 

To undelete allergy/adverse reaction (move past allergies back to current allergies): 

a. Select the Past allergies radio button. 

b. Highlight a past allergy/adverse reaction and click Undelete Allergy (yellow + icon). 

c. Click Yes in the Undelete Confirmation window. 

The allergy/adverse reaction will be returned to the Current Allergies view. 

If non-drug allergies have been recorded, you can decide whether or not to view these in the Allergies 
window. 

To view/hide non-drug allergies: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar.) The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Allergies to open that section.  Using the cursor to hover 
the Allergies section will reveal details such as the allergen, reaction, user name, date entered, 
and date/time occurred. 

By default the Non-Drug Allergies show up in the Allergies section of the Health Summary.   

3. Click the Non-Drug Allergies button in the bottom right corner of the Allergies section (the 
green spore icon) to toggle between showing and hiding Non-Drug Allergies.   

Note:  Non-drug allergies appear in red text to denote that they aren’t included in automatic allergy 
checking.   

Specifying Reasons for Stopping Allergy Notation  
The Stop Allergy screen provides a quick pick list of reasons for stopping an allergy.  This list consists of 
six specific reasons and one “other” reason.  The list is pre-populated with reasons provided by e-MDs 
but the screen is a customizable to suit individual user. To select a reason for stopping an allergy simply 
click the radio button to the left of the desired reason.  Use of the “other” button brings up the “Manage 
Medication and Allergies Stop Reasons” screen where the user can select a different reason or create a 
new one. 
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Users can choose to document a reason that is not in the list of quick pick Stop reasons by clicking the 
Other button choice. This will bring up a list of other reasons that can be chosen.  This change is 
temporary and will not permanently become a choice in the list. 

To choose an “other” stop allergy reason: 
1. Click the radio button to the left of the choice labeled Other… 

2. The Manage Medication and Allergy Stop Reasons maintenance screen will open. 

3. The window will populate with Allergy stop reasons. 

4. If the list is too long you can type in some search criteria in the Reason Text field and click 
Search to narrow your choices. 

5. Pick a reason from the list and click the Select button or double click the selected reason. 

To create a new stop allergy reason: 
1. With the Manage Medication and Allergy Stop Reasons maintenance screen open click the New 

button on the toolbar. 

2. The Reason for Stopping and/or denying a Medication or Allergy maintenance screen will open. 

3. Type in a description for the stop reason in the Reason field. 

4. In the Also Perform section leave the radio button labeled None checked. 

5. In the Use For section select “stopping allergy” 

6. Click Save when finished. 

The newly created reason will appear in the Manage Medication and Allergy Stop Reasons list. 
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Users can customize the Stop Allergy Reason screen to suit their individual needs. New reasons can be 
substituted for the reasons that ship with the product be default. 

To customize the Stop Allergy Reason screen: 
1. In the Stop Allergy screen, right-click to select a reason that you want to substitute another 

reason for. 

2. A menu item labeled Change Selected Option will pop up, click the menu selection. 

3. The Manage Medication and Allergy Stop Reasons maintenance screen will open. 

4. Select a reason from the list of stop reasons (or create a new reason) and double click or click the 
Select button. 

5. The newly selected reason will appear in place of the original stop reason. 

6. This change will now become the default setting for the person making the change. 

To document that allergies have been reviewed: 
In the Allergies section of the Health Summary, click the Review button to document the date that 
allergies/adverse reactions were last reviewed and by whom.  This feature is useful for providing 
notification to users whether this section has been reviewed recently. 

Current Medication List 
Note "No Known Medications" 
Much like the No Known Allergies feature in the Allergy section, users can choose to mark a patient’s 
Current Medication list as having No Known Medications. This is a proactive approach to documenting 
that a patient is not on any medications.  An empty Current Medication list does not necessarily denote 
that the patient is not on any medications. It could be that no one has asked. With the No Known 
Medications choice, there is an active notation in the chart that the patient is not on any meds. See 
screenshot below for an example. 
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To mark a chart as No Known Medications: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar.) The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Medications to open that section. 

3. Check the NKM (No Known Medications) box. 

Note:  If medications have already been documented, they must be deleted before NKM can be 
checked. 

Write a New Prescription 
If a patient is present for an appointment, any prescriptions written during that visit should be initiated in 
the Plan section of the active Visit or Order Note (see "Write a Prescription Linked to a Diagnosis" for 
details), not in the Current Medications section of the Health Summary. However, sometimes there is a 
need to write a prescription outside of a Visit or Order Note. In that situation, follow the steps outlined 
below. 

To write a new prescription outside a Visit or Order Note: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar). The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Medications to open that section. 

3. Within the Current Medications window, click the Write New Script   button (the uppermost 
button on the vertical toolbar, with the Rx pad icon). 

4. A provider (doctor, nurse practitioner, physician assistant) must be responsible for the 
prescription. If the user is a provider, the Drug Search (aka Choose Medications window) screen 
opens immediately.  

○ If the user is a non-provider (nurse, medical assistant, etc.), a pop-up window states that a 
provider responsible for the prescription must be selected. It will then ask if the selected 
provider will be responsible for ALL prescriptions written during that session that the Script 
Writer is open.  

○ Click No to write a single prescription under that provider’s name. The provider search will 
then be required for each prescription written. Click Yes to assign multiple prescriptions to the 
provider. 

Note:  An audit trail records which logged-in users prescribe medications under a physician’s 
name. In the current version of e-MDs Chart, a SQL query is needed to extract that information, 
but a future version of e-MDs Chart will include a report of that audit log. 

5. In the Find Staff Provider window, type a few letters of the provider’s name and press Enter or 
click Search.   

6. Highlight the correct name from the search results and click Select. 

7. This opens the Drug Search window. Proceed with writing the prescription (see “Write a New 
Prescription from the Current Med List” for details).  



 

e-MDs Solution Series Chart User Guide 8.0 R01 120 

Refilling Prescriptions 
Medications that have been previously prescribed or added for documentation purposes to the Current 
Medications list can be refilled.  Users can choose to refill one, some or all prescriptions at one time by 
using the Refill Grid.  See Refill Grid for details. 

To refill prescriptions: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar).  The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Medications to open that section. 

3. Within the Current Medications window, highlight the drug to refill and click Refill Medication (the 
second button on the vertical toolbar, with the pill bottle icon). 

The Refill List (Refill Grid) window will open.  This window lists all the medications in the Current 
Med List in a grid format.  

4. Click the check box next to each medication that is to be refilled. 

After a medication is checked to be refilled, the fields associated with the medication become 
editable. 

5. You can change the Form Strength, Sig, Quantity, Units, Refills, Substitution, Print Separately, 
Send Method, Pharmacy and Notes fields, if needed.   See the Refill Grid section for details on 
each field. 

6. When, and if, changes to any selected medications have been made, click the Save button on the 
toolbar to process the prescriptions 

7. If faxing or printing or electronically transmitting the prescriptions, a Sending confirmation window 
will open 

8. Click Send to print or fax or electronically transmit the prescriptions. 

Note:  Medications that have been Added to the Current Med List will appear in the Refill Grid but 
may not necessarily have a form/strength or sig associated with them.  To refill those medications 
simple check the refill check box and then complete the prescription by filling out the appropriate 
fields.  See the Add a Drug to the Current Medication List for details on adding drugs. 

Refills of medications that have been previously prescribed or added to the Current Medications list can 
be denied. This feature keeps an accurate record of the number of times that a patient requests a refill, 
even if that request is denied. 

To deny a prescription refill: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar.) The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Current Medications to open that section. 

3. Within the Current Medications window, highlight the drug to deny and click Deny Refill of 
Medication (the third button on the vertical toolbar, with the red X through the pill bottle). 

OR  

4. Within the Refill Grid, highlight the desired medication and click the Deny button on the toolbar. 

5. If desired, select a Denial Reason and type Additional Notes. 

6. Click Save. 

In Current Medications, click the plus sign next to the medication to review the prescription history 
of that drug, listed in reverse chronological order (most recent first). When a refill is denied, it will 
be in that list, preceded with the words DENIED REFILL. Discontinued and denied prescriptions 
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appear in red text. Double click the yellow notepad icon next to any denied refill to view the 
reason for denial. 

Deny Medication Reasons 
The Deny a Refill screen provides a quick pick list of reasons for denying a refill.  This list consists of 
eleven specific reasons and one “other” reason.  The list is pre-populated with reasons provided by e-
MDs but the screen is a customizable to suit individual user. To select a reason for denying a refill simply 
click the radio button to the left of the desired reason.  Use of the “other” button brings up the “Manage 
Medication and Allergies Stop Reasons” screen where the user can select a different reason or create a 
new one. 

 
Users can choose to document a reason that is not in the list of quick pick Deny reasons by clicking the 
Other button choice. This will bring up a list of other reasons that can be chosen.  This change is 
temporary and will not permanently become a choice in the list. 

To choose an “Other” refill denial reason: 
1. Click the radio button to the left of the choice labeled Other… 

The Manage Medication and Allergy Stop Reasons maintenance screen will open.  The window 
will populate with Deny a Refill reasons. 

2. If the list is too long, you can type in some search criteria in the Reason Text field and click 
Search to narrow your choices. 

3. Pick a reason from the list and click the Select button or double-click the selected reason. 

To create a new refill denial reason: 
1. With the Manage Medication and Allergy Stop Reasons maintenance screen open, click the New 

button on the toolbar. 

The Reason for Stopping and/or denying a Medication or Allergy maintenance screen will open. 

2. Type in a description for the stop reason in the Reason field. 

3. In the Also Perform section, leave the radio button labeled None checked unless the deny a refill 
reason is one associated with the patient having a allergy or adverse reaction to the medication. 



 

e-MDs Solution Series Chart User Guide 8.0 R01 122 

In that instance you might want to choose “add to allergy as the action performed when this 
reason is chosen.  This choice will automatically give the user the option to add the medication to 
the patient’s allergy list if the reason is chosen. 

4. In the Use For section, select Denying Refill. 

5. Click Save when finished. 

The newly created reason will appear in the Manage Medication and Allergy Stop Reasons list. 

Users can customize the Deny a Refill Reason screen to suit their individual needs. New reasons can be 
substituted for the reasons that ship with the product be default. 

To customize the Deny a Refill Reason screen: 
1. In the Deny a Refill screen, right-click a reason that you want to substitute another reason for. 

2. Click the pop-up Change Selected Option menu selection 

The Manage Medication and Allergy Stop Reasons maintenance screen will open 

3. Select a reason from the list of stop reasons (or create a new reason) and double click or click the 
Select button 

The newly selected reason will appear in place of the original stop reason.  This change will now 
become the default setting for the person making the change. 

Patients may be on a number of medications that are prescribed by other physicians or are available 
over-the-counter. Even though the patient gets these drugs from another source, they are important to 
add to the chart so that Allergy and Drug-Drug Interaction checking is complete. In these cases, add the 
medications directly to the Current Medications list, without writing a prescription. The user may choose to 
add just the drug name, or add as much detailed information (e.g. date initiated, strength, sig, etc.) as 
desired. The user can also write samples from this screen. 

To add a drug to the Current Medication list: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar.) The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Current Medications to open that section. 

3. Within the Current Medications window, click Add Current Medication (the fourth button on the 
vertical toolbar, with the yellow plus sign). 

4. From the menu, select either Drug (to launch the Drug Search) or Free Text (to type). It is 
strongly recommended that the Drug Search be chosen. Drug Allergy and Interaction checking 
cannot be run on Free Text additions. 

○ If Drug is chosen: 

a. Type a few letters of drug name and press Enter or click Search.  

b. Highlight the correct drug from the search results and click Select.  

c. If desired, select a prescriber, change the prescribe date, pick a form strength, and 
choose a Sig (or edit an existing Sig, or create a new Sig).  

d. Click Save.  

○ If Free Text is chosen: 

a. Type the drug name and directions into the Free Text window.  

b. If desired, search for and select a provider and change the prescribe date if needed.  

c. Click Save. 
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○ If Sample is chosen: 

a. Type a few letters of the drug name and press Enter or click Search.  

b. Highlight the correct drug from the search results and click Select.  

c. Enter the form/strength and, if desired, enter the Sig, quantity, lot number and expiration 
date. 

Add a Current Medication from a Template 
Medications can be added from the Current Medication Template.  This is the same functionality as 
described in the section above (medications that are prescribed by other physicians or are available over-
the-counter) but the data entry is via template. Any questions that have an Extended Attribute type of 
Current Medication will populate the Current Med list when checked (see Current Medication Extended 
Attributes for details).  This feature allows a nurse or medical assistant to quickly and easily gather the 
patient’s medication information and populate the Current Medication list without having to do a search of 
the drug database. 

To add a current medication from a template: 
1. With a Visit or Order Note open, click the template launch icon  to the right of the Current 

Medications header in the note. 

2. Choose the Current Medication template from the Template Link window. 

The template is organized by therapeutic class (for example Anti-depressants, Antibiotics, 
Asthma medications, etc.). 

A question that has a structured medication linked to it will display a button labeled FS  (for 
form strength) at the right. A question that has a Free Text medication linked to it will display a 
button labeled FT  (for free text) at the right.  

Note:  A Free Text medication could be a notation that the patient is on a medication but cannot 
remember the name (Example: An unknown blood pressure medicine).  This allows 
documentation with a placeholder until the patient can bring in or remember the name of the 
actual medication. 

3. Navigate to the medication you want and choose it by clicking the question. 

4. Pick multiple medications, if needed. 

When the template is closed the medications will drop into the Current Medications list. 

Occasionally, a patient’s medication will change. For example, a different strength or new directions for 
taking the drug may be ordered. In this case, the drug can be edited in the Current Medications list.  

To edit a current medication: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar). The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Medications to open this section. 

3. Within the Current Medications window, select the medication to edit and click Edit Current 
Medication (the sixth button on the vertical toolbar denoted by the pencil icon). 

4. Change information in the Edit Current Medication window as desired, and then click Save.  

This method of editing a Current Medication can be used when documenting medication changes 
that take place outside of an office visit (i.e. telephone call after reviewing lab, telephone call from 
patient to report adverse effects). 
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Discontinue (Stop) a Current Medication  
Medications can be stopped from either the Current Medications List or from the Refill Grid. 

To discontinue (stop) a medication from the Current Medications list: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar.) The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Medications to open that section. 

3. Highlight the medication to discontinue and click Stop Medication (the seventh button in the 
vertical toolbar denoted by a red stop sign icon). 

4. The current date will be entered as the default Discontinuation Date. To change the date, click the 
down arrow in the date field to access a calendar. 

5. If desired, choose a Reason for Stopping. 

6. Click Save. 

To discontinue a medication from the Refill Grid: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar.) The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Medications to open that section. 

3. Within the Current Medications window, highlight the drug to refill and click Refill Medication (the 
second button on the vertical toolbar, with the pill bottle icon). 

The Refill List (Refill Grid) window will open.  This window lists all the medications in the Current 
Med List in a grid format.  

4. Select the medication to be discontinued and click the Stop Medication (stop sign) button. 

5. The current date will be entered as the default Discontinuation Date. To change the date, click the 
down arrow in the date field to bring up a calendar. 

6. If desired, select a Reason for Stopping. 

7. Click Save. 

Note:  When a prescription is discontinued, it will move from the Current Medications list to the Past 
Medications list.   To see Past Medications, while in the Current Medications section, click the Past 
button at the top.  All discontinued medications will appear in the Medication History list, in red text, 
along with their discontinuation dates.   

Stop Medication Reasons 
The Stop Medication screen provides a quick pick list of reasons for stopping or discontinuing a 
medication.  This list consists of eleven specific reasons and one “other” reason.  The list is pre-populated 
with reasons provided by e-MDs but the screen is a customizable to suit individual user. To select a 
reason for stopping a medication simply click the radio button to the left of the desired reason.  Use of the 
“other” button brings up the “Manage Medication and Allergies Stop Reasons” screen where the user can 
select a different reason or create a new one. 
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Users can choose to document a reason that is not in the list of quick pick Stop Medication reasons by 
clicking the Other button choice. This will bring up a list of other reasons that can be chosen.  This 
change is temporary and will not permanently become a choice in the list. 

To choose an “Other” Stop a Medication reason: 
1. Click the radio button to the left of the choice labeled Other… 

The Manage Medication and Allergy Stop Reasons maintenance screen will open. The window 
will populate with Stop a Medication reasons. 

2. If the list is too long, you can type in some search criteria in the Reason Text field and click 
Search to narrow your choices. 

3. Pick a reason from the list and click the Select button or double-click the selected reason. 

To create a new Stop a Medication reason: 
1. With the Manage Medication and Allergy Stop Reasons maintenance screen open click the 

New button on the toolbar. 

The Reason for Stopping and/or denying a Medication or Allergy maintenance screen will open. 

2. Type in a description for the stop reason in the Reason field. 

3. In the Also Perform section, leave the radio button labeled None checked unless the stop 
medication reason is one associated with the patient having an allergy or adverse reaction to the 
medication. In that instance you might want to choose Add to allergy as the action performed 
when this reason is chosen.  This choice will automatically give the user the option to add the 
medication to the patient’s allergy list if the reason is chosen. 

4. In the Use For section, select Stopping a medication. 

5. Click Save when finished. 

The newly created reason will appear in the Manage Medication and Allergy Stop Reasons list. 

Users can customize the Stop a Medication Reason screen to suit their individual needs. New reasons 
can be substituted for the reasons that ship with the product be default. 

To customize the Stop a Medication Reason screen: 
1. In the Stop a Medication screen, right-click a reason that you want to replace with another 

reason. 

2. When the menu item labeled Change Selected Option pops up, click the menu selection 



 

e-MDs Solution Series Chart User Guide 8.0 R01 126 

3. The Manage Medication and Allergy Stop Reasons maintenance screen will open 

4. Select a reason from the list of stop reasons (or create a new reason) and double click or click the 
Select button. 

The newly selected reason will appear in place of the original stop reason.  This change will now 
become the default setting for the person making the change. 

If a prescription is lost or misplaced, it can be resent (reprinted, re-faxed, re-sent electronically or phoned 
in). 

To resend (reprint) a prescription:  
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar.) The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Medications to open that section. 

3. Highlight the medication to be re-sent and click Resend Script (the fourth button in the vertical 
toolbar, with the printer icon). 

A pop-up menu with choices for As Is and With Changes will appear 

4. Select As Is if you want to resend the prescriptions just like the first time it was sent. 

OR 

Select With Changes if you want to change the SEND method.  You can choose to send the 
prescription by a different method (from print to fax, etc.) but you cannot change anything else 
about the prescription.  

Note:  For print, fax and electronic, you will get the Sending confirmation screen.  Clicking Send 
will re-process the prescription.  

View Prior 'Send Methods' for Prescriptions 
When a prescription is written, the physician chooses a Send Method in the Script Writer (e.g. Print, 
Phone-In, Fax or Electronic). When reviewing a prescription at a later date, this information can be easily 
retrieved in the Current Medications list by placing the cursor in the blank space just to the left of the 
prescription. (Note: The cursor should be placed very close to the prescription. If too far to the left – in the 
space reserved for allergy and drug interaction icons-- that hover hint will not appear.) 

When the cursor hovers over this space, a blue highlighted hint will appear in place of the prescription, 
that will read either PRINT, PHONE, FAX or ELECTRONIC. For Phoned-In, Faxed or Electronic 
prescriptions, the name of the pharmacy will also be displayed. 

For medications that have been refilled multiple times, click the plus sign (to the left of the prescription in 
the Current Medications list) to expand the entire refill history. Now, hover the cursor to the left of each of 
those refills to view the "send method" of each one. 

Medication history can be reviewed in either Chart View (see "View Medications" for details) or in the 
Health Summary (as described below).  

To view the entire history of a single medication: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar). The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Current Medications to open that section.  

Note:  The Current Medications will be displayed. To review the history of a discontinued 
medication, click the Past button at the top of the Current Medication list. 

3. Within the Current Medications (or Medication History) window, click the plus sign next to the 
medication to review those medications.  
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The prescription history of that drug is displayed in a tree, listed in reverse chronological order 
(most recent first). When a refill is ordered, the current iteration of the prescription is automatically 
discontinued. Discontinued prescriptions (and denied refills) appear in red text.  

The end of each medication line shows the initiation and discontinuation dates.  

4. Double click the yellow notepad icon next to any prescription to view notes, such as the reasons 
for discontinuation or denial of refill. 

Medication history can be reviewed in either Chart View (see "View Medications" for details) or in the 
Health Summary (as described below).  

To view all discontinued medications: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar). The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Current Medications to open that section. 

The Current Medications will be displayed.  

3. To review Discontinued Medication, click the Past button at the top of the Current Medication list. 

This opens the Medication History window. All discontinued medications appear in red text. The 
end of each medication line shows the initiation and discontinuation dates.  

4. Double-click the yellow notepad icon next to any prescription to view notes, such as the reason 
for discontinuation. 

Notation of Allergies and Drug Interactions 
When a medication is prescribed or a drug is added to the Current Medications list, an automated check 
for drug allergies, drug-drug and drug-disease interactions, and duplicate therapy is run, and appropriate 
warning icons are displayed in the Health Summary.  

These icons appear to the left of the medication name in the Current Medications list or in the Itx or Al 
columns of the Refill Grid. 

• A yellow triangle indicates a reported adverse reaction to that medication (or to another 
medication in the same class). 

• A red triangle indicates a reported Allergy to that medication (or to another medication in the 
same class). 

• Colored circles represent drug-drug interactions, the color signifying the severity: green is mild, 
yellow is moderate and red is major. Note that both medications that are part of the drug-drug 
interaction will display the interaction icon. Double click any drug interaction icon to read more 
detailed information regarding the interaction. 

• A red "X" indicates a contraindicated drug combination. Double click the icon for further 
information. 

• A blue circle signifies duplicate therapy. Double click the icon for further information. 

To view the icon legend: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar). The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Current Medications to open that section. 

3. Click the last button on the vertical toolbar in Current Medications. 

The legend displays icons for allergies, adverse reactions, and drug interactions. In addition, 
icons related to formulary information appear. 
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Past Medical/Family/Social Histories 

To add, edit or delete history items: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar). The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bars labeled PMH/FMH/SH (Past Medical History -- including Surgical 
History/ Family Medical History/ Social History), Tobacco/ Alcohol/ Supplements, Substance 
Abuse History, Mental Health History, or Communicable Disease History to open those sections. 

Information is added to these sections via templates or free text.  

3. Within any section, click the Edit button to open the Past Medical History Maintenance window.  

4. Click the template icon (the gray square with a check mark) to find appropriate templates.  

See "Blank Templates" for details about using templates.  

Alternately, click any free text icon (tiny gray circles that turn into yellow squares when the cursor 
hovers over) to type information (See “Add/Edit/Delete Free Text” for details). 

Record Locking on the Health Summary Templates 
When a user has a patient’s PMH template open it will “lock” the Health Summary section (templates for 
PMH, Social, Family, etc.) so that only one user at a time can EDIT the info. Multiple users can VIEW the 
info at the same time but if you try to edit it when another user has it open you get a message that is 
similar to the chart message that says the record is locked by the person that is editing the information 
(see screenshot below). 

 
This locking of the section is to prevent the loss of information that could happen if more than one person 
had one of the Health Summary templates (Past Medical, Social, Family, Tobacco/Alcohol, Substance 
Abuse, etc.) open at the same time.  This can and has lead to the problem of the “last person to close 
wins” where a Health Summary that was incomplete or blank could overwrite a full Health Summary 
template. 

To prevent this, the Health Summary templates cannot be opened by clicking the text in the section. Each 
section of the Health Summary that uses templates for data input now has an Edit button at the top of the 
section. To add new information or to edit existing information you have to click the Edit button to open a 
window that allows you to access the templates by clicking the text or the template link icon. 

View Legacy History after Data Conversion 

Note:  The following information does not apply to users whose original purchase of e-MDs Chart was 
version 4.0 or later. 

e-MDs Chart version 3.0 (and earlier versions) were based on a non-SQL database, limiting the ability to 
convert the Past Medical History data to the newer SQL database. When converting a database from e-
MDs Chart 3.0 to e-MDs Chart 4.0 (or later), legacy history data (Past Medical History, Family Medical 
History, and Social History) will be recovered and displayed in the form of a non-editable image. To find 
this legacy data: 
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To view legacy history after data conversion: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar). The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled PMH/FMH/SH (Past Medical History -- including Surgical 
History/ Family Medical History/ Social History) to open that section. 

At the bottom of the section, there is a blue heading labeled Legacy Data. (If no legacy data 
exists for the selected patient, the heading will not appear). The previously recorded history 
appears under this heading. 

○ Free text additions to the Legacy Data are not permitted. All new information must be entered 
into the templates or free text areas of the various PMH/FMH/SH sections. 

○ Once Legacy Data has been re-entered into the new templates, the Legacy Data can be 
deleted. To do this, right-click the Legacy Data heading and choose the Delete menu option. 

Clinical Reconciliation (Transition of Care) 
You can import allergies, medications, and current problems directly from an imported transition of care 
document. 

To perform clinical reconciliation: 
1.  In the Health Summary area of the Visit/HS tab, click dropdown arrow and choose Clinical 

Reconciliation. 

 
A Clinical Reconciliation window opens (Example shown below). On the left side of the window are 
three tabs: Medications, Allergies, and Problems. On the right side of the window is a display area for 
transition of care documents. 
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2. To open a transition of care document, click the DocMan button in the Clinical Reconciliation 

window. 

An Importing from DocMan window opens and displays a list of all documents available in the 
patient’s DocMan. 

3. Click the desired transition of care document and then click the Select button located above the 
list of documents. 

The system compares the patient information in the selected document with the patient 
information in the chart and displays a message indicating whether the document matches the 
patient. 

4. Click the OK button to display the transition of care document. 

When a DocMan document is displayed in the Clinical Reconciliation window, the Source of File 
field becomes available. The purpose of this field is to identify the source of the transition of care 
document (such as Emergency Dept., Inpatient Hospital, Specialist, etc.), and it is a required field 
when you perform reconciliation using a document from DocMan 

Click the down arrow in the Source of File field to display source options, and then click an option 
to select it. e-MDs has selected Patient by default but this can easily be changed by using the 
drop down options. 

5. Click the down arrow in the Source of File field to display source options, and then click an option 
to select it. 

Note: If the transition of care document contains structured information (as in a C-CDA) about 
medications, allergies, or problems that are not included in the patient’s Health Summary, that 
information will be listed in the Pending for Approval area located in the lower part of the 
respective tab in the Clinical Reconciliation window. You can then perform reconciliation by 
importing the information directly into the patient’s Health Summary. 

For all reconciliations, now the Reviewed and No Changes check box will default to selected.  
Once a user makes any edits to the patient information, it will automatically deselect the box 
leaving the Reconcile button available. 

6. To reconcile Medications: 

• In the Clinical Reconciliation window, click the Medications tab. 
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• In the Pending for Approval area, click the check box next to the medications that you want to 
add to the Health Summary and then click the Accept button. 

• Click the check box next to the medications that you do not want to add and then click the 
Decline button. 

• To add a medication not listed in the Pending for Approval area, click the Add button located 
at the top of the Medications tab. 

• To edit or stop a medication, select the medication and then click the respective button 
located at the top of the Medications tab. 

• When you have completed all desired changes, click the Reconcile button located below the 
Pending for Approval area. (Or, if there are no changes, click the “Reviewed and no changes” 
check box and then click the Reconcile button.) 

7. To reconcile Allergies: 

• Click the Allergies tab. 

• In the Pending for Approval area, click the check box next to any allergies that you want to 
add to the Health Summary and then click the Accept button. 

• Click the check box next to any allergies that you do not want to add and then click the 
Decline button. 

• To add an allergy not listed in the Pending for Approval area, click the Add button located at 
the top of the Allergies tab. 

• To edit or remove an allergy, select the allergy and then click the respective button located at 
the top of the Allergies tab 

• When you have completed all desired changes, click the Reconcile button located below the 
Pending for Approval area. (Or, if there are no changes, click the “Reviewed and no changes” 
check box and then click the Reconcile button.) 

8. To reconcile problems: 

• Click the Problems tab. 

• In the Pending for Approval area, click the check box next to any problems that you want to 
add to the Health Summary and then click the Accept button. 

• Click the check box next to any problems that you do not want to add and then click the 
Decline button. 

• To add a problem not listed in the Pending for Approval area, click the Add button located at 
the top of the Problems tab. 

• To edit, resolve, or delete a problem, select the problem and then click the respective button 
located at the top of the Problems tab. 

• When you have completed all desired changes, click the Reconcile button located below the 
Pending for Approval area. (Or, if there are no changes, click the “Reviewed and no changes” 
check box and then click the Reconcile button.) 

Using the Chart View 
The Chart View is probably the most frequently accessed screen in the Chart module.  It is used each 
and every time a patient visits the office, calls for consultation, or a prescription is modified. 



 

e-MDs Solution Series Chart User Guide 8.0 R01 132 

Working with Visit and Order Notes 
A Visit Note tracks everything that happens during an office consultation. Order Notes may or may not be 
associated with an office visit and can be used to track and verify the completion of orders for patient care beyond an 
office visit. Order Notes must be signed off by the provider after completion of the order(s). Both types of notes can 
be started and completed by several members of the medical staff during or after a consultation. 

To view notes in a tree: 
1. Within a patient’s chart, click the Chart View tab (below the blue horizontal patient identification 

bar).  

2. In Chart View, click the Visit Notes tab.  

The left pane lists all Doctor Visit Notes, Nurse Visit Notes, and Order Notes in a tree format, in 
reverse chronological order (most recent date first). Each note is represented by an icon (a 
clipboard for Doctor Notes, a clipboard with a red cross for Nurse Notes, and a clipboard with a 
beaker for Order Notes), and is identified by the visit or order date and the healthcare provider’s 
name.  

3. Click the plus sign next to any note to expand the tree. The expanded tree view lists items 
associated with that visit or order, such as all diagnoses (identified with a stethoscope icon), 
prescriptions (script pad icon), CPT codes/orders (test tube icon), and medical art (paintbrush 
icon). Click any of these items to display detailed information about the selected item in the right 
pane. 

4. Click to select a note in the left pane (with the date and provider name) to view the entire note in 
the right pane.  

Note:  Double-click this main tree node to simultaneously expand the tree and display the note. 

To view notes in a grid: 
1. In Chart View, click the Visit Notes tab.  

2. In the left pane, click the first tree node, labeled Visit Notes. 

This will display a grid in the right pane with a summary of information about every note, including 
the visit or order date, whether the note has been permanently signed, the provider name, the 
location (clinic name), and the diagnoses from that visit. 

To edit or delete a note: 
1. Within a patient’s chart, click the Chart View tab (below the blue horizontal patient identification 

bar).  

2. In Chart View, click the Visit Notes tab.  

3. Click to select the note in the left pane (with the date and provider name) to view the entire note 
in the right pane. At the top of the note on the right is a small toolbar with buttons, labeled Edit, 
Delete, Addendum and Print. 

4. Click Edit to reopen the note to make changes. If the note has been permanently signed off, it 
cannot be edited but you can add an addendum. 

OR 

Click Delete to delete the note, then click Yes in the Delete Confirmation window. If the note has 
been permanently signed off, you cannot delete it. 
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To add an addendum to a signed off note: 
1. Within a patient’s chart, click the Chart View tab (below the blue horizontal patient identification 

bar).  

2. In Chart View, click the Visit Notes tab.  

3. Click to select the note in the left pane (with the date and provider name) to view the entire note 
in the right pane. At the top of the note on the right is a small toolbar with buttons, labeled Edit, 
Delete, Addendum and Print. 

4. Click the Addendum button located at the top of the note on the right. 

5. In the Free Text window, type the addendum and click Save. 

The addendum will be identified by the author, date, and time, and it will appear appended to the 
bottom of the note. 

To view full text of a note: 
Click the Full Text radio button to the right of the Print icon when viewing a note to see all of the 
information associated with a visit or order.  All sections of the note that contain information will 
appear and all information that is in those sections will appear with all associated grammar. This is 
the default setting. 

Note:  As with the other choices on this screen, whatever is selected when the Print button is 
pressed is what will print.  Therefore,  if you have the Full Text view selected, that is what will print. 

To view outline text of a note: 
Click the Outline Text radio button to the right of the Full Text choice when viewing a note to see a 
“bullet” list of just the pertinent information associated with the note.  All sections of the note that 
contain information will appear but the information will be displayed without much of the associated 
grammar that is available in the Full Text view. 

Note:  As with the other choices on this screen, whatever is selected when the Print button is 
pressed is what will print.  So if you have the Outline view selected, that is what will print. 

To view the summary of a note: 
Click the Summary radio button to the right of the Outline Text choice when viewing a note to see a 
summary view that just displays the information in the Assessment, Orders (if set to view) and Plan 
sections.  This view is intended to give the user a quick view of pertinent information, such as why the 
patient was seen (diagnoses in the Assessment section) and what was done about it (tests, 
procedures and medications in the Plan section). 

Note:  As with the other choices on this screen (Full Text and Outline Text), whatever is selected 
when the Print button is pressed is what will print.  So if you have the Summary view selected, that is 
what will print. 

Log/Phone/Rx Notes 
Log, Phone and Rx Notes are used to attach medical or other pertinent information to the patient chart 
outside of a Visit Note. Phone Notes are intended to document telephone conversations while Log Notes 
are used to document medical information that is collected outside a visit or a phone call. Prescription 
notes are intended to document information related to prescriptions. Any user can create a Log or Phone 
or Rx Note. The original author of the note is the only person authorized to edit or delete it, but any other 
user can add an addendum to another’s note. Only providers (doctors, nurse practitioners, physician 
assistants) can permanently sign notes. Once a note is permanently signed, it cannot be edited or 
deleted.  
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To add a new Log/Phone/Rx Note: 
1. Within a patient’s chart, click the Chart View tab (below the blue horizontal patient identification 

bar).  

2. In Chart View, click the Log/Phone/Rx Notes tab.  

3. Click New in the gray toolbar located above the left windowpane. 

4. In the Edit Chart Note window, assign a Note Class – either Log Note, Phone Note or 
Prescription Note. 

5. Assign a Note Type – either Permanent or Sticky. Permanent notes can be signed and 
permanently attached to a patient’s chart while "sticky" notes are intended to be temporary. 
"Sticky" notes do not print when the entire chart is printed. 

6. Type the message into the white free-text area. 

7. Click Save to close the window and save the note. Or, click Sign Off to close the window and 
permanently sign the note. 

Note:  Only providers (doctors, nurse practitioners, physician assistants) can permanently sign a 
Phone Note or Log Note. If the user logged in is not a provider, the Sign Off button will be 
disabled. 

To view prior Log/Phone/Rx Notes: 
1. In Chart View, click the Log/Phone/Rx Notes tab.  

A reverse chronological list of all notes appears in the left windowpane, identified by author and 
date. Permanent Log Notes display an icon of a pink sheet of paper. Permanent Phone Notes 
have an icon of a pink sheet of paper with a phone in the middle. Permanent Prescription Notes 
have an icon of a pink sheet of paper with a Rx in the middle. Sticky Log, Phone and Prescription 
notes look the same, except the paper is yellow. 

2. Click any node in the left tree to display the full text of the note in the right windowpane. 

When viewing a note and any associated addendums to that note, the original note appears in a 
pane at the top and the most recent addendum (if there are addendums) appears at the bottom of 
the pane below the note.  When opening a note for viewing, the screen will automatically display 
the most recent note or addendum first.  You can then scroll up and down to view other notations. 

To edit a Log/Phone/Rx Note: 
The original author of the note is the only person authorized to edit or delete it, but any other user can 
add an addendum to another’s note.  

1. In Chart View, click the Log/Phone/Rx Notes tab.  

A reverse chronological list of all notes appears in the left windowpane, identified by author and 
date.  

2. Click any node in the left tree to display the full text of the note in the right windowpane. 

3. Click Edit, located above the note in the right windowpane, and select whether to edit the Note or 
an Addendum in the menu options. Make changes to the note and click Save. 

If the Edit button is disabled, either the user is not the author or a provider has permanently 
signed the note (and it is no longer editable). 

While any user can create a Log or Phone or Prescription Note, only providers (doctors, nurse 
practitioners, physician assistants) can permanently sign notes. Once a note is permanently signed, it 
cannot be edited or deleted.  
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To sign off a Log/Phone/Rx Note: 
1. In Chart View, click the Log/Phone/Rx Notes tab.  

A reverse chronological list of all notes appears in the left windowpane, identified by author and 
date.  

2. Click any node in the left tree to display the full text of the note in the right windowpane. 

3. Click Sign Off, located above the note in the right windowpane. 

If the Sign Off button is disabled, either the note has already been signed, the user is not a 
provider, or the note type is sticky (only permanent notes can be signed). 

Any user can create a Log or Phone or Prescription Note. The original author of the note is the only 
person authorized to edit or delete it, but any other user can add an addendum to another’s note.  

To add an addendum to a Signed Log/Phone/Rx Note: 
1. In Chart View, click the Log/Phone/Rx Notes tab.  

A reverse chronological list of all notes appears in the left windowpane, identified by author and 
date.  

2. Click any node in the left tree to display the full text of the note in the right windowpane. 

3. Click Sign Off, located above the note in the right windowpane. 

4. Type the addendum and click Save. 

Up until the point that the note is signed off, the author can still Edit the addendum. 

The original author of the Log or Phone or Prescription Note is the only person authorized to delete it. 
Once a note is permanently signed, it cannot be deleted 

To delete a Log/Phone/Rx Note: 
1. In Chart View, click the Log/Phone/Rx Notes tab.  

A reverse chronological list of all notes appears in the left windowpane, identified by author and 
date.  

2. Click any node in the left tree to display the full text of the note in the right windowpane. 

3. Click Delete, located above the note in the right windowpane, and select whether to delete the 
Note or an Addendum in the menu options.  

4. Click Yes in the Delete Confirmation window.  

Note:  If the Delete button is disabled, either the user is not the original author of the note, or the 
note has been signed off. 

Chronological View 
The chronology section of Chart View combines all notes and documents (Provider and Nurse Visits, Log, 
Phone Notes, TaskMan notes and DocMan documents) into one list. 

To view all notes in chronological order: 
1. Within a patient’s chart, click the Chart View tab (below the blue horizontal patient identification 

bar).  

2. In Chart View, click the Chronology tab.  

The left windowpane displays a list of all items, identified by author and by date (in reverse 
chronological order). Icons identify the note type: clipboard for Provider Visit, clipboard with red 
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cross for Nurse Visit, piece of Pink or yellow paper for Log Note (permanent vs. sticky), and piece 
of pink or yellow paper with a blue phone for Phone Note (permanent vs. sticky).  

3. Click the date and author of any note or the description of a document to display the note or 
document in the right windowpane. 

4. If the note is a Visit or Order Note, click the plus sign to the left of the icon to display additional 
information about the visit such as diagnoses, labs ordered, prescriptions written, and any 
medical art that is attached to the visit. Click any of these additional items will display detailed 
information about those items in the right windowpane. 

5. For a different view, click the All Notes header in the left windowpane to display a grid with 
summary information about every note in the right windowpane. This detail includes the note 
date, author, whether the note has been permanently signed, who signed the note, and, if it is a 
Visit or Order Note, the diagnoses from that encounter. 

Labs/Tests/Procedures 

To view labs/tests/procedures: 
1. Within a patient’s chart, click the Chart View tab (below the blue horizontal patient identification 

bar).  

2. In Chart View, click the Labs/Tests tab.  

3. Choose Grouped View or Chronological View. Make this selection in the gray toolbar at the top 
of the left windowpane. Note that this is merely a display of CPTs which have been ordered, not 
necessarily of test results. Although results can be entered here manually, most users choose to 
scan or import results directly into DocMan. 

4. Grouped View: This default view lists all items that have ever been ordered, sorted by CPT 
code. Items are grouped together so that only one instance of any unique lab, test or procedure is 
shown.  

○ Click any CPT Code/Description in the tree to display a grid in the right windowpane. The grid 
lists the CPT code, description, every date that CPT has been ordered, and the ordering 
physician. 

○ Click the plus sign next to any CPT Code/Description in the tree to expand a list of Visit and 
Order Notes from which the orders were generated, along with the date of the visit and the 
provider. Click any Visit or Order Note in the tree to display the full text of the note in the right 
windowpane.  

5. Chronological View: This view lists every instance of a lab, test or procedure that has been 
ordered in reverse chronological order.  

○ Click any CPT Code/Description in the tree to view the Visit or Order Note that generated the 
order in the right windowpane. Click the plus sign next to any CPT Code/Description to 
expand the tree to the diagnosis to which the order was linked. 

○ Click the first tree node, labeled Labs, Tests, & Procedures to display a grid in the right 
windowpane. The grid lists every CPT code, description, date ordered, and the ordering 
physician. 

 Pending: In this view users can see a list of all notes that have at least one CPT or HCPCS 
code that is marked as “Tracked.”  Users can view the ‘’tracked” labs/tests and if a result 
has been linked to the code they can also see that result. 

Notations regarding lab results can be entered manually, as described below. This is labor-intensive and 
is not the recommended method. It is far preferable to scan or import labs into DocMan. 
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To enter lab/test/procedure results: 
1. Within a patient’s chart, click the Chart View tab (below the blue horizontal patient identification 

bar).  

2. In Chart View, click the Labs/ Tests tab.  

3. Choose Chronological View. Make this selection in the gray toolbar at the top of the left 
windowpane. 

4. Select the correct CPT Code/Description in the left windowpane. This will open the right 
windowpane, with a blue results field on top and a copy of the associated Visit or Order Note on 
the bottom.  

5. In the blue windowpane, place the cursor after the Results and Notes heading. Type results or 
notes. 

6. Click Save. 

Note:  These free text notes are not permanent and can be deleted or edited at any time. 

Diagnoses 

To view diagnoses: 
1. Within a patient’s chart, click the Chart View tab (below the blue horizontal patient identification 

bar).  

2. In Chart View, click the Diagnoses tab.  

3. Choose Grouped or Chronological View. Make this selection in the gray toolbar at the top of the 
left windowpane. 

4. Grouped View: This default view lists all diagnoses that have ever been given, arranged 
alphabetically. Items are grouped together so that only one instance of any unique diagnosis is 
shown.  

○ Click any ICD-9 Code/Description in the tree to display a grid in the right windowpane. The 
grid lists the ICD-9 code, description, every date that diagnosis has been used, its severity 
and progression, and the diagnosing physician. 

Note:  "Moderate" severity and "Stable" progression will not show. Mild or Severe and 
Improving or Worsening will be displayed. For more information about these diagnosis 
properties, see "Edit the Properties of a Problem." 

○ Click the plus sign next to any ICD-9 Code/Description in the tree to expand a list of Visit and 
Order Notes from which the diagnoses were generated, along with the date of the visit and the 
provider. Click any Visit or Order Note in the tree to display the full text of the note in the right 
windowpane.  

Note:  If the diagnosis was added directly to the Current Problems list, there will not be an 
associated Visit. 

5. Chronological View: This view lists every instance of a diagnosis in reverse chronological order.  

○ Click any ICD-9 Code/Description in the tree to view the Visit or Order Note that generated the 
diagnosis in the right windowpane. (Note: If a diagnosis was added directly to the Current 
Problems list, there will not be an associated Visit.) Click the plus sign next to any ICD-9 
Code/Description to expand the tree to the orders and medications to which the diagnosis was 
linked. 

○ Click the first tree node, labeled Diagnoses to display a grid in the right windowpane. The grid 
lists the ICD-9 code, description, every date that diagnosis has been used, its severity and 
progression, and the diagnosing physician. 
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Note:  "Moderate" severity and "Stable" progression will not show. Mild or Severe and 
Improving or Worsening will be displayed. For more information about these diagnosis 
properties, see "Edit the Properties of a Problem." 

Medications 
The easiest way to review the medication history is directly from the Current Medications list in the Health 
Summary; from this location, the entire history of a single drug can be reviewed and all discontinued 
medications can be displayed. However, information can also be retrieved from Chart View, as described 
below. 

To view medications: 
1. Within a patient’s chart, click the Chart View tab (below the blue horizontal patient identification 

bar).  

2. In Chart View, click the Medications tab.  

3. Choose Grouped or Chronological View. Make this selection in the gray toolbar at the top of the 
left windowpane. 

4. Grouped View: This default view lists all medications that the patient has taken, arranged 
alphabetically. Medications are grouped together so that only one instance of any unique 
medication is shown.  

○ Click any medication in the tree to display a grid in the right windowpane. The grid lists the 
medication, initiation and discontinuation dates, strength, sig, and prescribing physician. A 
check box marked Script is checked if an actual prescription was written. If the box is not 
checked, the medication was added directly to the Current Medications, without a prescription. 

○ Click the plus sign next to any medication in the tree to expand a list of dates that the 
medication was used. This may reflect the date of the Visit or Order Note in which the 
medication was prescribed, or the date that the drug was added to Current Medications. Click 
the date of any Visit or Order Note in the tree to display the associated diagnosis for which the 
medication was prescribed.  

5. Chronological View: This view lists every instance of the medication in reverse chronological 
order.  

○ Click any medication in the tree to view the Visit or Order Note that generated the prescription 
in the right windowpane. Note that medications added directly to the Current Medications list 
are identified by an asterisk and do not have an associated Visit.  Click the plus sign next to 
any medication to expand the tree to the associated diagnosis. 

○ Click the first tree node, labeled Medications to display a grid in the right windowpane The grid 
lists the medication, initiation and discontinuation dates, strength, sig, and prescribing 
physician. A check box marked Script is checked if an actual prescription was written. If the 
box is not checked, the medication was added directly to the Current Medications, without a 
prescription. 

 Refill/Refill Request: This view lists the patient’s modified current medication list.  This 
view is used to show Refill Requests for the patient (see the Refill Request Module for 
details) 

Consults and Referrals 
The Referrals module allows structured data to be inserted from a Visit or Order Note into a letter that can 
be sent or faxed to another physician. Because the information comes from a Visit or Order Note, this 
module can generate both Referral Letters from generalist to sub-specialist, as well as Consultation 
Letters from the specialist back to the referring physician. 
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To create a referral/consult letter: 
1. Within a patient’s chart, click the Chart View tab (below the blue horizontal patient identification 

bar).  

2. In Chart View, click the Referrals tab.  

3. The left windowpane displays a tree with two primary nodes, Referrals (if any exist), Visit Notes 
and Order Notes. To create a new note, first click the plus sign next to Visit or Order Notes. Notes 
are displayed by visit/orderdate and provider. Click any line to view the entire note in the right 
windowpane. Select the correct Visit or Order Note and click New (in the gray toolbar at the top of 
the left windowpane). 

4. In the Edit Referral window: 

a. Select the Letter Template to be used. This template is created ahead of time and determines 
which pieces of information will be pulled from the Visit or Order Note into the Referral Letter 
(see "Create a Letter Template for Referrals/Consults" for details). 

The provider listed in the Visit Details section of the note will be recorded as the Referring 
(or Consulting) Provider.  

b. Click the magnifying glass in that field to change this name, if desired. 

c. Select who to Refer To (i.e. the physician that will be receiving this letter). Click the 
magnifying glass in this field to search for the correct physician. 

Note:  If the physician does not exist in the database, click New. Add information in the 
NonStaff Provider Maintenance window. The only required fields are the First and Last 
Names. But remember, if the Letter Template being used inserts the physician’s address and 
phone/fax numbers, you will want to add this information here. When finished, click Save. 

d. If desired, select the Primary ICD (the primary reason for the referral; e.g. Chest Pain) and/or 
Primary CPT (the test that the consulting physician performs; e.g. Stress Test). Click the 
small down arrow in each field for a list of all diagnoses and orders from that visit. 

Primary ICD and Primary CPT are structured insert fields. They will not show up in the 
Referral Letter if these fields are not included in the Letter Template. 

e. Add Comments, if desired. 

Comments is a structured insert field. It will not show up in the Referral Letter if this field is 
not included in the Letter Template. 

f. Click Save. 

5. In the left windowpane, click the Referrals node. The newly generated letter will appear at the top 
of the list, identified by the date, the Primary ICD/CPT (if included), and the physician to whom 
the letter is being sent. Click anywhere on this line to view the Referral Letter in the right 
windowpane. 

6. At this point, the letter can be edited, if needed. When finished, print or fax the letter. Click the 
underlined topics for details. 

To edit or delete a referral/consult letter: 
1. Within a patient’s chart, click the Chart View tab (below the blue horizontal patient identification 

bar).  

2. In Chart View, click the Referrals tab.  

3. The left windowpane displays a tree with two primary nodes, Referrals and Visit Notes. To edit an 
existing Referral Letter, first click the plus sign next to Referrals. Letters are displayed by create 
date and by provider to whom the letter is addressed.  

4. Click any line to view the entire letter in the right windowpane. 



 

e-MDs Solution Series Chart User Guide 8.0 R01 140 

5. Click Edit (in the gray toolbar at the top of the left windowpane). 

6. In the Letter Template creator, make changes to the letter as desired. When finished, click Save. 

7. At this point, the letter can be printed or faxed (see "Print or Fax a Referral/Consult Letter" for 
details). 

To print or fax a referral/consultation letter: 
1. Within a patient’s chart, click the Chart View tab (below the blue horizontal patient identification 

bar).  

2. In Chart View, click the Consults/Referrals tab.  

The left windowpane displays a tree with two primary nodes, Referrals and Visit Notes.  

3. To print or fax an existing referral letter, first click the plus sign next to Referrals in the left pane.  
Letters are displayed by creation date and by provider to whom the letter is addressed.  

4. Click the line to view the entire referral letter in the right window pane. 

5. To print the letter, click Print (in the gray toolbar at the top of the left windowpane), select the 
appropriate printer in the Print window, and click OK. 

OR 

To fax the letter, while holding down the Shift key, click Print to open the e-MDs Fax Monitor 
window.  

6. Complete the required fields, including the fax recipient, and then click Submit.  

The fax machine must be set up before performing the above steps.  See “Setting Up Print and Fax 
Options” for more information. 

Documents 
Documents stored in the DocMan module are also available for viewing in the Chart View section of the 
patient’s chart.  This allows users to access pertinent patient information without having to open DocMan.  
There is a DocMan tab with an orange document icon to show the patient’s DocMan folders.  The 
complete Chronology view also includes documents (also using an orange document icon) so you can 
access everything from one view.  Just clicking the heading on the left shows the image on the right. 

The display of documents in Chart View provides some but not all of the functions of DocMan.  Users can 
view documents, sign them off, edit the descriptions, etc. but this module does not include the ability to 
scan documents or import them directly into Chart View.  Scanning and importing of documents needs to 
occur in the DocMan application. 

DocMan documents can be attached to TaskMan messages.  When the recipient opens the attachment 
the document will be displayed in the Chart View section of the patient’s chart. This feature allows users 
to easily access and review additional pertinent patient information if necessary. 

To view a document in Chart View: 
1. Open the patient chart. 

2. Click the Chart View button. 

3. Click the Documents tab in Chart View. 

On the left side of the Documents section is a tree view of DocMan folders. 

4. Double-click the desired folder to expand the tree. 

5. Select the desired document description. 

The document will be displayed in the right pane. 
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Case Management 
A full blown case management system is accessible from the Cases tab in Chart View.  It can also be 
accessed in other applications including Schedule and Bill. If a case has particular forms required, 
DocMan also comes in to play.  In Chart View the Cases tab shows visits grouped by case.  You can also 
open cases from within the Misc. tab of the patient file.  More details about the case management system 
are described in the Case Maintenance section of this document.  A brief synopsis: 

• Cases make it much easier to manage treatment based cases such as for workers comp, motor 
vehicle accident, corporate and other “non-normal” billing scenarios where there are 
demographics that override the patient’s normal guarantor and insurance.  You can also set up 
policies, rules and a host of other information related to the case that will change the information 
in and routing of a claim, as well as affects how the system prompts the user to follow the correct 
case pathway from appointments through charting and billing. 

• A patient can have multiple concurrent cases with separate descriptors.  The last one used is 
remembered, but it’s easy to pick a different one as needed. 

Legend 
The Legend tab is represented by a question mark icon.  The legend section of Chart View displays a list 
of icons that are used in the various sections of Chart View and give descriptions of what they represent. 
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Immunizations 
In addition to documenting immunizations to provide a complete record for a patient, this information can 
also be captured, reported, and printed for external organization and agency requirements, such as 
school admission and state registries. 

See the "Setting Chart Administration Options" section in e-MDs Solution Series Administration Guide for 
information on customizing the immunization functionality to meet your specific requirements. 

Immunization Registries 
An Immunization Registry module is provided to address the need to submit information to immunization 
registries at a state level.  This new module queries the database and generates a file that contains the 
appropriate immunization information. This file can then be uploaded to the state registry. 

This module works with the CDC recommended HL7 format for immunization information.  Contact your 
local immunization registry for information about the format that they use. 

Documenting Immunizations for Patients 
All immunization documentation is performed from the Chart Visit/HS, Chart View, or FlowSheets tab for 
the selected patient. You can document that an immunization was administered or deferred, and you can 
document presumed immunity based on history of disease. 

To document administration of an immunization: 
1. Click the Immunization button (with the green syringe icon) on the chart toolbar to open the 

Immunizations window.   

2. All immunization information documented for the patient is displayed in the Immunizations 
window. If no immunization information has been added, the window will be blank. 

Note: You can change the order of the columns in the Immunizations window by clicking a 
column header and dragging the column to the desired location. 

3. On the toolbar at the top of the Immunizations window, click New. 

The Immunization Documentation window is displayed. 

4. In the Consent to Share field, click the down arrow and select the consent status. 

 
Opt In indicates that the patient has consented to have personal and health information 
transmitted to the state immunization registry. 

Opt Out indicates that the patient has denied consent to have personal and health information 
transmitted to the state immunization registry. 

When you select the consent status, the Consent Date field is activated: Enter the date the 
patient signed the consent. 



 

e-MDs Solution Series Chart User Guide 8.0 R01 143 

5. If the immunization was given at a different location and you are just documenting the 
information, click the Given at other location check box.  Clicking that check box activates the 
Location field: Click the down-arrow in that field to select the location.  (If you select the Free 
Text option, you can type directly into the Location field.) 

6. In the Immunization field, click the down arrow to select the immunization from a comprehensive 
list. (Or, you can type the first few letters of the immunization name to display matching 
immunizations.) Example shown below. 

 
When you select the immunization, the system will automatically populate many of the remaining 
fields, including Date Administered, Time, Dose, Route, and Administered By, but you can 
change the information by clicking the down arrow or the magnifying glass next to the field. 

7. To enter the Manufacturer, click the down arrow and select a manufacturer – or click the 
magnifying glass to search for a manufacturer.  

Note: Clicking the magnifying glass in the Manufacturer field opens the Find Vaccine 
Manufacturer window. In that window, you can access the Vaccine Manufacturer Maintenance 
window by selecting the manufacturer and clicking the Edit button. (In the Vaccine Manufacturer 
Maintenance window, you can add or remove a vaccine from the list of vaccines associated with 
a manufacturer, and you can add or remove manufacturers.) 

8. Enter the Lot Number and Expiration Date. You can type directly into the Lot Number field, or 
you can click the down arrow to select a lot number that has been entered previously. 

Note: If you want to delete a lot number, click the magnifying glass in the Lot Number field to 
access the Lot Number Maintenance window. In that window, search for the lot number. In the 
search results, click the lot number to be deleted and then click the Delete button. Note that the 
lot number and expiration date are linked. 

9. Enter the VIS information. (For combination vaccines, you can add VIS information for each 
component of the vaccine.) 

If a VIS Revision Date has been linked to the vaccine, the VIS Revision Date field will display the 
revision date, language and a comment (if one exists). 

The VIS Given On check box will be auto-checked and today’s date will be displayed. If this field 
is checked the Immunization Detail report will include the date the VIS was given. If you do not 
provide the VIS information, clear the check box. If you want to change the date it was given, click 
the down arrow and select a different date. 

10. Select the VFC eligibility and funding information. (VFC stands for the Vaccines for Children 
program, and the VFC eligibility status is used to designate a funding source for this immunization 
program.) 

11. Click Save to add the immunization to the patient’s chart. (To exit the window without saving any 
of the information, click the Cancel button.) 

Note: If you are adding multiple immunizations and want to bundle them into one VXU message 
to be sent to the registry, click the Save/Add button, then add the next immunization. 
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To document a deferred immunization: 
9. Click the Immunization button (with the green syringe icon) on the chart toolbar to open the 

Immunizations window. 

10. On the toolbar at the top of the Immunizations window, click Deferred. 

The Deferred Immunization window is displayed. 

 
11. Click the check box next to each immunization that was deferred. 

12. When you select an immunization, a Refusal/Deferral Details window is displayed. In 
that window, click the applicable radio buttons to indicate whether the immunization was refused, 
deferred, or waived, by whom, and the reason. 

13. Click Save to save the information. 

To document presumed immunity based on history of disease 
1. Click the Immunization button (with the green syringe icon) on the chart toolbar to open the 

Immunizations window. 

2. On the toolbar at the top of the Immunizations window, click Hx of Disease.to display the History 
of Disease window. 

 
3. Click the down arrow in the Hx of Disease field to display a list of diseases and then click a 

disease to select it. 
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4. If the date the patient had the disease is known, click the down arrow and select that date. 
(Otherwise, leave today’s date in the field and note in the comments field that the patient is 
unsure of the date.) 

5. Click Save to add the information to the Immunizations window.  

All documented immunizations information is shown in the Immunizations window. 

 

Viewing or Editing Immunization Details 
To view or edit the details of an immunization, select (click) the immunization name and click the Edit 
button on the toolbar. 

Note that you can add Administration Notes to an immunization record. Those notes are displayed in the 
Comments column of the Immunizations window and are not linked to the Reaction Memo. 

Documenting an Immunization Adverse Reaction 
IMPORTANT! There is only one Reaction Memo for any given patient: That memo is attached to the 
patient’s entire immunization record and not to a specific vaccination. When you document a reaction, it is 
important to include the name(s) of the vaccine(s) in question and the date administered along with the 
type of reaction. 

To add an immunization reaction: 
1. Click the Immunizations button (with the green syringe icon) on the Chart toolbar. 

2. On the Immunizations window toolbar, click the Reaction button. 

Note: If no reactions have been documented, a blue plus sign is displayed on the Reaction 
button. If reaction has been added to the Reaction Memo, a yellow triangle with a red exclamation 
mark is displayed on the Reaction button. 

3. In the Reaction Memo, type the reaction information and click Save. 

To edit an immunization reaction: 
1. Click the Immunizations button (with the green syringe icon) on the Chart toolbar. 

2. On the Immunizations window toolbar, click the Reaction button. 

3. Change the information in the Reaction Memo window as appropriate and then click Save. 

Deleting an Immunization  
Deleting an immunization does not remove it from the patient’s record; instead, it moves the immunization 
to deleted status. You can view deleted immunizations by clicking the Display deleted immunization 
records check box located at the top of the Immunizations window. 
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To delete an immunization: 
1. Select the immunization and click the Delete button.  

2. In the Delete Immunization Maintenance window, click the drop-down arrow located next to the 
Delete Reason field.   

3. Click to select a reason from the list of default reasons and click Save. 

Editing Immunization Delete Reasons 

To access the Delete Reasons Editor: 
1. Select an Immunization and click the Delete button.   

2. In the Delete Immunization Maintenance window, click the magnifying glass icon button located 
next to the Delete Reason field. 

3. At the Find Delete Reason window, click the Search button to list all of the current Delete 
Reasons. 

4. Click the Edit button to make changes to the current Delete Reason. 

5. Click the Delete button to remove any of the Delete Reasons. 

6. Click the New button to create new Delete Reasons.   

7. Click the Select button to add the reason to the Delete Reason field as well as select it from the 
drop down menu.   

8. Click the Exit button to return to the Delete Immunization Maintenance window. 

Viewing Schedules and Catch-up Schedule 
To view the CDC recommended immunization schedules for Pediatric immunizations, Catch-up 
immunizations, and Adult immunizations, click the Schedules button located on the toolbar at the top of 
the Immunizations window. 

Note:  If the computer that is used to access the immunization module has an Abode PDF reader 
installed the documents will be displayed in .PDF format.  If the computer has Word installed the 
documents will be displayed as Word documents.  The computer must have one or the other of these 
applications installed in order to access the documents. 

Printing the Immunization Log or Detail Report 
The patient’s Immunization Log or "shot record" can be printed or faxed if necessary. Two formats are 
available: Immunization Log and Detail Record.  Both include the patient’s name and date of birth, the 
immunization type, and the date administered.  The Detail Record includes additional information. 

Note: The printed record will be routed to the printer set up to print All Notes in Print Options. 

Note: To fax an immunization record, hold the Shift key on the keyboard while clicking the Printer icon 
and selecting Immunization Log or Detail Record.  In the Printing Explanation window, select the reason 
for printing and click OK. In the Select Fax Recipient window, fill in the information for faxing this report.   

To print the immunization log: 
1. Click the Immunizations button (with the green syringe icon) on the chart toolbar to open the 

Immunizations window. 

2. Click the Print button on the Immunizations window toolbar and select Immunization Log or Detail 
Report. 

3. In the Printing Explanation window, select the reason for printing and click OK. 
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4. A Print Preview window will be displayed. In that window, click the Printer icon to print the 
immunization information. 

You can also print an immunization record from the patient’s chart by clicking the Printer icon and 
selecting Immunization Log.  

 

Linking Vaccines to Manufacturers 
When you install e-MDs Solution Series, the vaccines available for selection have been associated with 
the manufacturer that makes the vaccine.  However, in the event you need to link a vaccine to a different 
manufacturer, a mechanism is available. 

To associate a vaccine to a manufacturer: 
1. Click the Edit menu in the Immunization module and select Manufacturer. 

The Find Vaccine Manufacturer screen will open. 

2. Search for the desired manufacturer, highlight it and click Edit. 

3. At the bottom of the Vaccine Manufacturer Maintenance screen, click the Add button. 

The Immunization Type Vaccine Manufacturer Maintenance screen will open.  The selected 
manufacturer will be displayed in the Vaccine Manufacturer field 

4. Click the down-arrow and select a vaccine in the Immunization Type field. 

5. To make this the default, click the Default check box. 

VIS Revision Dates 
As part of the Immunization module, you can document Vaccine Information Sheet (VIS) Revision Dates 
for vaccines given along with the date that the VIS was given. This allows you to document revision dates 
associated with a VIS at the time of documenting other information associated with a vaccination.  The 
date associated with the VIS will be printed on the Immunization Detail Report.  In order to document a 
VIS Revision date you must first add a revision date to a vaccine.  The system allows you to add more 
than one VIS revision date to a vaccine and to designate one as the default VIS revision date.  In 
addition, you can create VIS revision dates for VIS documents in languages other than English. 

Note:  In order to add a VIS revision date you must have the Immunization: VIS Revision Date 
privilege with at least Read/Write access. 

When documenting an immunization, a VIS Revision date for the vaccine can be documented.  If there is 
a default revision date it will automatically be inserted into the VIS Revision Date field.  Sometimes there 
is no revision date associated with the vaccine and sometimes a different revision date needs to be 
chosen. 

To select a VIS revision date: 
Privileges Required:  Immunization: VIS Revision Date 
1. From within the Immunization module, click the magnifying glass in the VIS Revision Date field. 

2. The Find Revision Date screen will open. 
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3. A list of vaccines and revision dates will be displayed.  

4. Select the appropriate one and click Select. 

5. If the desired revision date does not exist, click the New button and follow the directions in the 
next section. 

To add a VIS revision date: 
Privileges Required:  Immunization: VIS Revision Date 
1. From the main Chart menu click Tools then VIS Revision Date. 

2. The Find Revision Date screen will open. 

3. A list of vaccines and revision dates will be displayed.  

4. To add a new revision date for a vaccine, type the name of the vaccine in the Immunization 
Type field. 

5. Once the vaccine is selected in the Immunization Type field, click the New button on the toolbar. 

6. The VIS Revision Date Maintenance screen will open with the vaccine name showing in the 
Immunization Type field. 

7. Type a date in the Revision Date field. This is a required field. 

8. Select a Language from the drop down list.  The default language is English but can be changed. 
This is a required field. 

9. In the Comment field you can type in additional information if needed. This field allows for a 
maximum of 650 characters. 

10. Click the Default check box if this is to be the default revision date.  Only one default revision 
date can be selected per vaccine. 

Note:  When a patient has a language other than English associated to their demographic account 
the VIS for that language will be selected by default in the VIS Revision Date field. If a VIS for that 
language does not exist then the English revision date will be selected. 

Referral/Consult Letter Editor 
This module is similar to a mail merge program. It allows templates to be built for various referral or 
consultation letters. The templates are created using structured fields from the database, such as 
demographic information for the patient and the physician, ICD-9 and CPT codes, and sections from a 
Visit or Order Note (HPI, Exam, Assessment, Plan, etc.).  

See "Create a Referral/Consult Letter" for details about using the letter templates to create a referral letter 
in e-MDs Chart. 

To create a new letter template: 
1. In the main e-MDs Chart toolbar, click Tools and then select the Letter Editor menu option. 

The Select Letter window will open.  

2. Click New to open the Letter Generator window. 

3. Assign a title to the Letter Template by typing a descriptive name in the Letter Description field. 

4. To insert any field into the Header, Body or Footer of the letter, highlight the desired field in the 
list on the right and click the Insert Field button. 

5. Additional information can be added to the letter by typing directly into the Header, Body or 
Footer sections as necessary.  
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6. Format any text or inserted fields in the template as necessary by using the toolbar buttons 
(Undo, Cut, Copy, Paste, Font Size, Font Selection, Bold, Italic, Underline, Alignment and Bullet.) 

7. Click the Save button 

8. Click the Exit button or click the X in the upper right corner of the Select Letter window. 

To edit an existing letter template: 
1. In the Select Letter window, click Search for a list of all existing Letter Templates. 

2. Highlight the correct Letter Template in the search results and click Edit. 

3. Make changes as desired in the Letter Generator window, and click Save. 

To delete a letter template: 
1. In the Select Letter window, click Search for a list of all existing Letter Templates. 

2. Highlight the Letter Template to be deleted in the search results and click Delete. 

3. Click Yes in the Delete Confirmation window. 

Printing and Faxing from e-MDs Chart 
From virtually any place that you can print a job you can now also fax the same file.  To do this, simply 
hold down the Shift key prior to clicking the print icon and this will launch a compact version of the Fax 
Monitor.  The name of the end user logged in to the computer will be automatically filled in the From field.  
Use the Title field for the name of the document OR to add a note to the recipient.  Click the magnifying 
glass icon to search for a Person or Organization fax number as described in the Phone Number 
Database section or enter a fax number manually.   

Note:  Please note that the fax phone number should be in the following format (512)555-5555 to 
properly dial out.  Not having this format may prevent the program from dial fax phone numbers correctly. 

Once the fax number is entered, clicking OK will submit these faxes directly to the Fax Manager for 
processing.   

Note:  Unlike the full Fax Monitor, this compact version will only send one Fax print job to one recipient. 

Print/Fax Items from Chart View 
Visit Notes, Order Notes, Log Notes, Phone Notes, and Referral Letters can be printed or faxed from 
Chart View. 

To print or fax Visit or Order Notes from Chart View: 
1. Within a patient’s chart, click the Chart View tab (below the blue horizontal patient identification 

bar).   

2. In Chart View, click the appropriate tab (Visit Notes or Chronology).   

3. In the tree on the left, select the appropriate note. 

4. When the full text of the note appears in the right windowpane, click Print (located on the toolbar 
directly above the note in the right windowpane). 

In the Note Conclusion window there are two columns with check boxes next to each report type 
(Visit Note, Medical Art, Superbill, etc.) one labeled Print and one labeled Fax. 

5. If the item is to be printed, click the check box under the Print column. 

6. Click OK to print the report 
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7. If the item is to be faxed, click the check box under the Fax column. 

8. If the item is to be faxed, click the Edit button (pencil icon) in the Edit column to the right of the 
report name. 

A compact version of the Fax Monitor will open and you can enter information such as Title, To, 
From and the Phone (Fax) number. See Fax for details. 

9. After the information is entered, click the OK button to save the information into the Note 
Conclusion window. 

10. Click the OK button in the Note Conclusion window to print or fax the selected reports. 

To print or fax log and phone notes from Chart View: 
1. Within a patient’s chart, click the Chart View tab (below the blue horizontal patient identification 

bar).   

2. In Chart View, click the appropriate tab (Log/Phone/Rx Notes or Chronology).   

3. In the tree on the left, select the appropriate note. 

4. When the full text of the note appears in the right windowpane, click the Print button to print the 
note.  

5. To Fax the note hold down the shift key on the keyboard while clicking the Print button 

6. A compact version of the Fax Monitor will open and you can enter information such as Title, To, 
From and the Phone (Fax) number. See Fax for details. 

7. Click OK to fax the note. 

To print or fax referral letters from Chart View: 
1. Within a patient’s chart, click the Chart View tab (below the blue horizontal patient identification 

bar).   

2. In Chart View, click the Referrals tab.   

3. In the tree on the left, select the appropriate letter to print. 

4. When the full text of the note appears in the right windowpane, click the Print button to print the 
letter.  

5. To Fax the letter hold down the shift key on the keyboard while clicking the Print button 

6. A compact version of the Fax Monitor will open and you can enter information such as Title, To, 
From and the Phone (Fax) number. See Fax for details. 

7. Click OK to fax the letter. 

To print or fax Items when concluding a Visit or Order Note: 
1. At the conclusion of a Visit or Order Note, click the Conclude Note button, located on the Chart 

toolbar (clipboard with a green check mark). 

2. The Note Conclusion window contains two columns labeled Print and Fax  with check boxes in 
each column corresponding to each report type that can be printed or faxed (EXAMPLE: Visit 
Notes, Order Notes, Patient Education, Superbill, etc.).  

3. To print or fax a report, click the check boxes in the Print column next to those items to be printed 
AND/OR in the Fax column for those items to be faxed.  Anything not checked will not be printed 
(or faxed).  

Important!  The exception to the Print and Fax column check boxes is the Prescription report.  
It only has one check box which is under the Print column.  This check box represents that the 
prescriptions will be processed (either printed or faxed depending on the way prescriptions were 
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designated when they were created).  It is important that this check box always be checked; 
otherwise the prescriptions will not be printed or faxed. 

4. If the item is to be faxed, click the Edit button (pencil icon) in the Edit column to the right of the 
report name 

5. A compact version of the Fax Monitor will open and you can enter information such as Title, To, 
From and the Phone (Fax) number. See Faxing Documents for details. 

6. Once the information is entered, click the OK button to save the information into the Note 
Conclusion window. 

7. If the item is to be printed, each report type (i.e. Visit Note, Order Note, Prescriptions, etc.) can be 
routed to any printer.  This is typically set up in advance in Print Options (see Print Options for 
details), but can be changed on the fly by clicking the Print Options button in the Note 
Conclusion window OR by clicking the Printer Icon in the Options column.  The Printer Icon in 
the Options column provides quick access to the print options of the specific report chosen. 

8. Once all print and fax issues have been dealt with, this Visit or Order Note can be closed without 
permanent sign off or it can be permanently signed off if the provider is completely finished with 
all visit documentation.  See Visit and Order Note Sign Off for details. 

9. Click OK. 

10. Successive messages will appear on screen as each report is routed as a print job to the 
appropriate printer(s).   

Print/Fax the Health Summary 
The Health Summary can be printed or faxed at the conclusion of a Visit or Order Note (see Print/Fax 
Visit Related Items for details).  Additionally, items can be printed independently by clicking the Print 
Patient Reports button on the chart toolbar (paper and printer icon).  Select the Health Summary menu 
item to be printed.  The Health Summary will be routed to the printer designated in the print options. 

To Fax the Health Summary, hold down the Shift key on the keyboard while clicking the Health 
Summary menu item.  A compact version of the Fax Monitor will open and information such as Title, To, 
From and Phone or Fax number can be entered. See Print Options for details. 

Note:  Growth Charts can only be printed or faxed from the Growth Chart module. 

To print or fax growth charts: 
1. Open the Growth Chart module by clicking the Growth Charts button on the chart toolbar (pink 

and blue people icon).  Growth Charts can also be accessed from the Vital Signs window. 

2. In patients over 20 years of age, Growth Charts are not available and the Growth Charts icon will 
not display. 

3. Click the tabs across the top of the Growth Charts to view the desired chart (e.g. weight).  Click 
the Print button to print the growth chart.  

4. To print another chart (e.g. height), click the appropriate tab in Growth Charts, then click Print. 

5. The actual Growth Chart curves and plotted data points will print.  The grid listing the individual 
dates, values, and percentiles does not print. 

6. The Growth Charts will be routed to the printer set up in print options (see Print Options for 
details) 

7. To Fax Growth Charts use the same steps as outlined above.  Holding down the Shift key on the 
keyboard while clicking the Print button brings up a compact version of the Fax Monitor.  
Information such as Title, To, From and the Phone or Fax number can be entered in this 
window.  See Printing and Faxing from Chart for details. 
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To print, fax or create an electronic file when printing the entire chart: 
1. Click the Print Patient Reports icon on the chart toolbar (paper and printer).   

2. Select Entire Patient Chart.   

3. Click Yes in the confirmation window(s). 

The Print or Fax Entire Chart Options window will open and display options to print, fax or create 
an electronic file.   

4. If faxing the selected item, click the Fax Options button to select a recipient. See Print/Fax 
Options for details. 

5. After the recipient is selected, click Done to save the information. 

6. If printing the selected item, each report type (i.e. Visit Note, Order Note, Prescriptions, etc.) can 
be routed to any network printer.  This is typically set up in advance in Print Options (see 
Print/Fax Options for details).  These options can be changed “on the fly” by clicking Print 
Options. 

Successive messages will appear on screen as each report is routed as a print job to the 
appropriate printer(s).   

7. If an electronic file needs to be created, select a file destination to save the text file.  

8. Create a File Name. 

9. Click Save. 

10. Limit by Date will allow you to choose a date range for documents included in this file. 

11. Choices include Visit Notes, Order Note, Log/Telephone/Rx Notes, Health Summary, Hidden 
Health Summary, Immunization Log and Medical Art.   If all items need to be selected, place a 
check mark next to Select All. 

12. Click OK. 

 

Generating the Chart Audit Report 
When you first access this screen, the results grid at the bottom of the screen will be blank. The following 
are some basic tasks you can perform from this screen. 

To quickly view audited Chart activities for the current date: 
1. Click the Today button in the Date of Activity section. The current date will be selected for both 

begin and end dates. 

2. Click View on the top toolbar to generate and view the results. 

To view records for a set period of time: 
1. Use the drop-down list after the From and To fields to select the date range you want to query. 

2. Select any other filter options in the User, Patient, Action and/or Type of Record fields. 
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3. Click View on the top toolbar to generate and view the results in the lower portion of the screen 
and the following window opens: 

 
If the number of records that match your filter selection exceeds 10,000 records, the following 
window will pop up instead: 

 
Both windows indicate the system is in the process of obtaining the requested records from the 
database. If the database return is under 200 records, no window will pop up. Similarly, with a 
very fast database, it will be too fast to read. 

4. When this window pops up, you have two choices: 

If you do not want to complete the query, click Cancel Query. The query will be cancelled and 
the bottom portion of the screen will remain unpopulated. 

OR 

If you want to continue the query and display all the returned records, this window will 
automatically close when the process is complete, and the returned results will display in the 
bottom portion of the Chart Audit Report screen. 

To print query results: 
1. Use either of the query methods above to list the required records. 

2. Click Print to send the results to the report printer function. 

To perform a query and export the results to a file: 
1. Select the date(s) for the query as described above. 

2. Select any other options on the screen to set additional filters. 

3. Click the Export button in the top toolbar. The query will begin and the following screen will pop 
up to tell you how many records are being exported (in this case 412 records): 
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4. Click Yes to continue exporting the records to a text file. Continue with the next step below. 

OR 

Click No to end the query and export.  

5. If you clicked Yes, the following window will appear for you to give the export file a name: 

 
6. Enter the file name and click Save. (If you wish, you can also change the location for the file by 

changing the folder path in the Save in field at the top.)  

The following window appears, with the actual number of records reflected in the message. 

 
7. If you decide to stop the export action, click the Cancel button.  (Clicking the Exit button (x) will 

close the window but the file export will continue until complete.) 

8. When the Cancel button on this window changes to Close, the export is complete and the text 
file is available for viewing, mailing or other processing. 

9. Upon completion of the export, click the Exit button to close the window. 
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Generating the Demographics Audit Output 
When you first access this screen, the results grid at the bottom of the screen will be blank. The following 
are some basic tasks you can perform from this screen. 

To quickly view audited Demographics activities for the current date: 
1. Click the Today button in the Date of Activity section. The current date will be selected for both 

begin and end dates. 

2. Click View on the top toolbar to generate and view the results. 

To view records for a set period of time: 
1. Use the drop-down list after the From and To fields to select the date range you want to query. 

2. Select any other filter options in the User, Patient, Transaction Type and/or Audit Alias Type 
fields. 

3. Click View on the top toolbar to generate and view the results in the lower portion of the screen 
and the following window opens: 

 
If the number of records that match your filter selection exceeds 10,000 records, the following 
window will pop up instead: 

 
4. When this window pops up, you have two choices: 

If you do not want to perform the query, click Cancel. The process will be cancelled and the 
bottom portion of the Demographics Audit Report screen will remain unpopulated. 

OR 

If you want to run the query and display all the returned records, click Continue and this window 
will close when the process is complete, and the returned results will display in the bottom portion 
of the Demographics Audit Report screen. 

To print query results: 
1. Use either of the query methods above to list the required records. 

2. Click Print to send the results to the report printer function. 
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To perform a query and export the found records to a file: 
1. Select the date(s) for the query as described above. 

2. Select any other options on the screen to set additional filters. 

3. Click the Export button in the top toolbar. The query will begin and the following screen will pop 
up to tell you how many records are being exported (in this case 412 records): 

 
4. Click Yes to continue exporting the records to a text file. Continue with the next step below. 

OR 

Click No to end the query.  

5. If you clicked Yes, the following window will appear for you to give the export file a name: 

 
6. Enter the file name and click Save. (If you wish, you can also change the location for the file by 

changing the folder path in the Save in field at the top.)  

Note:  Note: The only acceptable file type is .csv (Comma Separated Values). 

The following window appears, with the actual number of records reflected in the message. 
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7. If you decide to stop the export action, click the Close button.  (Clicking the Exit button (x) will 

close the window but the file export will continue until complete.) 

8. When the Close button on this window changes to Complete, the export is finished and the text 
file is available for viewing, mailing or other processing. 

Upon completion of the export, click the Exit button to close the window. 

Unsigned Notes Reports 
The standard Unsigned Notes Report (described below) is available in the Chart module under the drop-
down Reports menu.  Another report named “Unsigned Reports (Crystal Reports Version)” expands the 
function of that report including the use of nurse notes, OB module notes, and “ready to bill” patient Visit 
or Order Notes.  To learn more about this report, see the “Chart Reports” chapter of e-MDs Reports User 
Guide. 

To generate reports of Unsigned Notes: 
1. In the main e-MDs Chart menu, click Tools and select the Unsigned Notes Report. 

2. Select the type of unsigned note report from the six choices: 

○ All Notes. Displays all un-signed notes (Doctor Visits, Nurse Visits, Log and Phone Notes) for 
all authors. Select either By Patient or By Author to sort the report alphabetically by either 
patient’s or author’s last name. 

○ All Log/Phone/Rx Notes. Displays all un-signed Log and Phone Notes for all authors. Select 
either By Patient or By Author to sort the report alphabetically by either patient’s or author’s 
last name. 

○ All Visit Notes. Displays all un-signed Visit Notes (Doctor and Nurse notes). Select either By 
Patient or By Author to sort the report alphabetically by either patient’s or author’s last name. 

○ My Notes. Displays all un-signed notes (Doctor or Nurse Visits, Order Notes, Log and Phone 
Notes) created by the user logged into the application at the time this module is accessed. 

○ My Log/Phone/Rx Notes. Displays only the un-signed Log Notes and Phone Notes created 
by the user logged into the application at the time this module is accessed. 

○ My Visit Notes. Displays only the un-signed Visit Notes created by the user logged into the 
application at the time this module is accessed. 

The Print Preview window will open.  

3. To view the report on screen, use one of the sizing buttons on the toolbar (Whole Page, Page 
Width, 100%) or type in a % to enlarge or reduce the report to the best viewing size. Click one of 
the scroll buttons (First Page, Prior Page, Next Page, Last Page) or type in page # to go to a 
specific page if necessary. 

4. To print the report, click the Print button. 

5. Click Close to exit the window when finished. 
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Code Linker 
Code Linker is a utility within e-MDs Chart that enables the user to link various data items together to help 
shortcut documentation. Items that can be linked include Billing Codes (ICD-9, CPT, HCPCS), 
Educational Documents (Patient Education, Drug Education, and Curbside Consults), Templates, and 
Medical Art. 

Examples of how links are used in e-MDs Chart: 

• Template-to-ICD: When a diagnosis (ICD) is chosen in History of Present Illness (e.g. abdominal 
pain), the appropriate templates (e.g. HPI: Abdominal Pain, PLAN: Abdominal Pain) are available. 
Although the user can search "all templates", it is quicker to present the linked templates so that a 
search is not required.  

• ICD-to-CPT: For a specific diagnosis (ICD), appropriate orders (CPT codes) are available in the 
Plan section of the Visit and Order Notes. Again, the user can search "all CPTs", but it is helpful 
to display a list of linked orders first. 

• ICD-to-Patient Education: Rather than search thousands of documents, the user is presented 
with a short list of Patient Education handouts linked to the diagnoses (ICDs) assigned in that 
visit. 

Create/Delete Links 

To create a link: 
1. Click Tools on the main e-MDs Chart toolbar, and select the Code Linker menu option.  

2. Log into Code Linker with the same username and password used in e-MDs Chart. 

3. In the Code Linker, the left vertical sidebar presents the various linking options. These include 
ICDs, CPTs, HCPCS, Templates, Patient Ed., Drug Ed., Curbside Consults, and Art. Select one 
of these options as the primary item to which links will be made. For example, click ICDs. 

4. Depending on which item was chosen, a search window will appear. In our example, the ICD-9 
search opens. Perform a search, select an individual item (in this case, a single ICD-9 code), and 
click Accept. 

See the following topics for further search information:  

○ Search for an ICD-9 Code 

○ Search for a CPT Code 

○ Search for a HCPCS Code 

○ Search for Medical Art 

○ Search for a Patient Education Document 

○ Search for a Drug Education Document 

○ Search for a Curbside Consult 

○ Search for a Patient Instructions Document 

5. This closes the search window and drops the individual item into the Code Linker. That item will 
appear at the top of the Code Linker window, highlighted in yellow. 

6. Below the yellow highlighted item are several blue collapsible bars, representing data elements 
that can be linked to the highlighted item. In our example, an ICD-9 code is highlighted, and the 
blue bars are labeled CPTs, Curbside Consults, Patient Education Documents, Drug Education 
Documents, Templates, and Art. 
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7. Click the plus sign on the blue bar of the data element to be linked. In our example, click the plus 
sign next to CPTs to link CPT codes to the highlighted ICD-9 code. 

8. When that section opens, click Add. This will launch an appropriate search. In this example, the 
CPT search is launched. 

○ To link a single item, select it from the search results and click Accept. 

○ To link multiple items, select items from search results by right clicking them and choosing the 
Add Code(s) to Select List menu option. This opens a Select List window, listing all chosen 
items. Additional searches can be performed at this time. When all desired items are in the 
Select List, click Accept. 

To select multiple codes at one time, click the first code to be linked, hold down the Shift key, and 
then click another code to select a contiguous series of codes. Or if the codes are not in a series, 
click the first code to be linked, and then while holding down the Ctrl key, click the other codes. 
When the group of codes is properly highlighted, right click and choose Add Code(s) to Select 
List. 

9. The linked items (CPT codes, in this case) will now appear in the Code Linker window. 

To delete a link: 
1. Select one member of the link so that it is highlighted in the Code Linker. For example, to delete 

an ICD-to-CPT search, first select ICD in the left vertical sidebar and search for the correct ICD-9 
code. 

2. Highlight the link to be deleted. In this case, with the ICD highlighted yellow, click the blue CPT 
bar, and click the CPT link to be eliminated.  

Note:  Hold down the Shift or Ctrl keys to select more than one item for deletion. 

3. Click Remove Selected. 

Notes:   
○ Links are not user-specific. Therefore, links made by any user will be visible to all users.  

○ Links are two-way, or circular. For example, if a document is selected and an ICD-9 code is 
linked to it, a link is also made from the ICD-9 code to the document. The only exception is 
CPT-to-CPT links; these are one-way links, so carefully choose which CPT is primary (i.e. is 
highlighted in Code Linker). 

A helpful feature is the ability to copy links. For example, suppose the user links multiple orders (CPTs), 
templates, and Patient Education handouts to a single ICD-9 code for diabetes. However, dozens of ICD-
9 codes for diabetes exist, and the user does not want to manually recreate those links for every ICD-9 
code. In this case, he simply copies the links, as described below. 

To copy links from one item to another: 
1. Open the Code Linker so that an item is highlighted and all of its links are visible. 

2. To copy every link: 

a. Click Select All at the top of the Code Linker window (above the highlighted item). 

b. Click Copy Selected, and choose the correct menu item indicating to where the links will be 
copied. In the example above, the links to the ICD code are to be copied to another ICD 
code, so the ICD menu option is selected. 

c. Perform the search to find the correct item to copy the links to. In this case, perform a search 
for the correct ICD code. 

 To copy the links to multiple items, select items from search results by right clicking them 
and choosing the Add Code(s) to Select List menu option. This opens a Select List 
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window, listing all chosen items. Additional searches can be performed at this time. When 
all desired items are in the Select List, click Accept. 

 To select multiple codes at one time, click the first code to be linked, hold down the Shift 
key, and then click another code to select a contiguous series of codes. Or, if the codes are 
not in a series, click the first code to be linked.  Then, while holding down the Ctrl key, click 
the other codes. When the group of codes is properly highlighted, right-click and choose 
Add Code(s) to Select List. 

3. To copy a subset of links: 

a. Click Select All in the subsection that is to be copied. For example, to copy only the CPT 
links, click Select All located below the blue bar labeled CPTs. 

b. Click Copy Selected, and choose the correct menu item indicating to where the links will be 
copied.  

c. Continue as outlined above. 

Lab Tracking 
Lab Tracking is a module that works with e-MDs Chart, DocMan and TaskMan to track labs, radiology 
tests, and procedures, and to notify the ordering provider when results for these items are overdue.  It 
works like a tickler file to help providers keep track of outstanding items by their respective CPT and 
HCPCS codes.  A pre-defined rule within Rule Manager determines if these items are overdue and 
automatically sends a message, using TaskMan, to the ordering physician and/or designated medical 
assistant. All CPT and HCPCS codes can now be set to “trackable” status, so that once they are selected 
within a Visit or Order Note in e-MDs Chart, a pre-defined “clock” is started.  

To prepopulate the database, due dates for a select subset of codes were determined and loaded into the 
system based on the TYPE OF SERVICE parameter the code belongs to such as Diagnostic Labs, 
Diagnostic X-rays, and Medical Care (includes procedures).  These due dates may or may not represent 
the actual expected due dates for individual users and are completely customizable. 

Lab Tracking Interface - Overview of Lab Tab 
The Lab Tracking Window provides a patient specific view of pending labs/tests/procedures and allows 
those items to be marked as complete.  At the top of the window, identifying information including the 
patient’s name, date of birth, gender and age are displayed.  On the Lab tab, a split screen displays due 
dates, codes and descriptions for CPTs in the upper part and due dates, codes and descriptions for 
HCPCS in the lower part.  The codes listed here represent items that were ordered for this particular 
patient and are currently being tracked.  This list can include items that are both coming due and that are 
already overdue.  A total of three messages identifying overdue items will be sent to the ordering provider 
(as well as the assistant designated in the Visit Details of the note) when items are determined to be 
overdue.  Even after all messages have been sent the item will remain in this list until it is marked as 
done. 

Pending items can be marked as complete (the results for these items have come in) by selecting the 
check box that appears next to each item in the list and then clicking the Save button.  This marks the 
items as done and prevents overdue messages from being sent for those items. 

To select all items in the list, click the check box located at the very top of the list (next to the column 
titles). Clicking that check box automatically checks all the remaining check boxes. 

At the top of the window is a button labeled Groups. The Groups button opens a User Group window that 
allows the provider to identify additional people to be notified of overdue items.  By default the provider 
and assistant specified in the visit details of a note are the only people notified unless otherwise indicated 
in the User Group window. 
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Accessing the Lab Tracking Window 
The Lab Tracking window shows patient specific pending labs/tests/procedures and allows those items to 
be marked as complete.  It can be accessed from within both Chart and DocMan. 

To access the Lab Tracking window from Chart: 
1. Open a patient chart and click the Lab Tracking icon which can be found on the gray patient 

specific tool bar that runs across the top of the patient’s chart just below the blue demographic 

bar.    

2. To access the Lab Tracking window from DocMan: 

3. Open a patient chart and click the DocMan icon to open DocMan.  Then within the DocMan 

module, click the Lab Tracking icon on the main toolbar.   

OR 

Open a patient record in the DocMan stand alone module.  Then within the DocMan module click 
the Lab Tracking icon on the main toolbar.   

OR 

Open a patient record and click TOOLS then LAB TRACKING on the main DocMan toolbar. 

OR 

Open a patient record, select a specific category that is marked for tracking such as LABS, 
RADIOLOGY, etc… and click NEW DOCUMENT prior to scanning. 

OR 

Select a specific category that is marked for tracking such as LABS, RADIOLOGY, etc. and click 
TOOLS then IMPORT DOCUMENT from the main DocMan menu. 

Mark Tracked Labs as Complete 
CPT and HCPCS items that are ordered in a Visit or Order Note will be designated as pending and 
overdue messages will be sent, via TaskMan, unless the items are marked as complete (results are in). 

The Lab Tracking Window provides a patient specific view of pending labs/tests/procedures and allows 
those items to be marked as complete.  At the top of the window identifying information including the 
patient’s name, date of birth, gender and age are displayed.  At the bottom of the window a split screen 
displays due dates, codes and descriptions for CPTs in the upper part and due dates, codes and 
descriptions for HCPCS in the lower part.  Next to each CPT and HCPCS code is a check box.   

To mark items as complete in Chart: 

1. Open the Lab Tracking window from within Chart by clicking the Lab Tracking icon   

2. Click the check box next to the item or items for which results have been obtained. 

3. Click the Save button to activate the changes. 

4. This marks the items as done and prevents overdue messages from being sent for those items. 

To mark items as complete in DocMan: 

1. Open the Lab Tracking window from within DocMan by clicking the Lab Tracking icon  or 
click Tools then Lab Tracking on the main DocMan menu toolbar. 

2. Click the check box next to the item or items for which results have been obtained. 
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3. Click the Save button to activate the changes. 

4. This marks the items as done and prevents overdue messages from being sent for those items. 

OR 

1. Open a patient record.  

2. Scan an item into a Category in DocMan that is set up for tracking in DocMan such as Labs or 
Radiology (see Lab Tracking in DocMan for details on setting up tracking categories). 

3. Click New Document prior to scanning. 

4. This will launch the Lab Tracking screen so pending items can be marked as complete (this will 
prevent overdue messages from being sent).  

5. Click the check box next to the item or items for which results have been obtained. 

6. Click the Save button to activate the changes. 

7. This marks the items as done and prevents overdue messages from being sent for those items. 

8. To finish the scan, select a document type along with the option to send or not send a message 
(with the scanned image attached) to the ordering provider as notification that the results have 
arrived. 

OR 

1. Open a patient record  

2. Import an item into a Category in DocMan that is set up for tracking in DocMan such as Labs or 
Radiology (see Lab Tracking in DocMan for details on setting up tracking categories). 

3. Click Tools then Import Document on the main DocMan menu toolbar. 

4. This will launch the Lab Tracking screen so pending items can be marked as complete (this will 
prevent overdue messages from being sent).  

5. Click the check box next to the item or items for which results have been obtained. 

6. Click the Save button to activate the changes. 

7. This marks the items as done and prevents overdue messages from being sent for those items. 

8. In the next window pick the document to be imported and click Open. 

9. In the Document Info window click the … button and select a provider to be messaged. 

10. This will send a message to notify the provider that the results are available. 

Tracking Radiology Results 
When a user imports a radiology result (narrative report or image), the result is listed on the Radiology tab 
in the Lab Tracking window. The user can then take various actions by clicking the drop-down button in 
the Document Type field, selecting an option, and then clicking Save. 
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Remove From Tracking Options 
The Remove From Tracking options allow the user to document that no further result is expected and to 
indicate whether the result received is a narrative report or image or combination of both. When a user 
selects one of these options and then clicks Save, several things happen: 

• The result is removed from the Lab Tracking window. 

• The result is linked to the CPT code in the chart. 

• The result is flagged as an image or narrative report. (This information is used for certain 
Meaningful Use reports.) 

• A note indicating the type of result received is appended to the Orders Descriptions column in the 
Order Tracking window.  

Leave On Tracking Options 
The Leave On Tracking options allow the user to leave the result in the Lab Tracking window and to 
document that a narrative result has been received and the image is expected (or vice versa). Selecting 
one of these options and clicking Save also links the result to the CPT, flags the result as an image or 
narrative, and appends a note to the Orders Descriptions column in the Order Tracking window. 

Notification of Overdue Labs 
The Lab Tracking module tracks labs, radiology tests, and procedures, and notifies the ordering provider 
when results for these items are calculated to be overdue. These notifications are sent in the form of a 
TaskMan message that contains information about the patient that includes the patient name and date of 
birth, as well as information about the overdue item that includes the calculated due date and the CPT or 
HCPCS code and description. 

A total of three messages identifying overdue items will be sent to the provider, as well as to the medical 
assistant designated in the Visit Details of the note, when items are determined to be overdue.  These 
messages will be sent on 3 consecutive days as reminders to investigate the overdue item.  After the third 
and final message is received no more messages will be sent.  These messages will be stored in a 
message category in TaskMan labeled Lab Tracking and any messages marked as URGENT will be 
designated as such by a red ‘P’ flag. 

Notifying Additional Staff 
By default only the Provider and Assistant listed in the Visit Details window of a note are notified of an 
overdue item.  The Provider is a required field in the Visit Details but the Assistant is not, so be sure to list 
an ASSISTANT if you would like someone other than the PROVIDER of the Visit or Order Note to be 
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notified of overdue labs, tests, procedures.  Additionally, other staff members can be chosen to be notified 
by using the Groups button at the top of the Lab Tracking window.  

Note:  Additional staff can be added either permanently or temporarily.  Adding names temporarily can 
be useful for coverage of absences such as vacation schedules. 

To select additional staff for notification: 
1. Click the Groups button at the top of the Lab Tracking window. 

2. A window labeled User Group will open displaying a list of users for the facility. 

3. Select the desired staff member by clicking their name in the left column. 

4. Click the right-pointing arrow in the middle column to add the selected name to the Group list 
(multiple names can be added to the list). 

5. Once the desired name or names have been added to the Group list click the OK button to save 
the changes. 

Note:  To remove a name from the list highlight the name and click the left pointing arrow in the 
middle column and then click the OK button to save the changes. 

Setup Tracked Items 
The Lab Tracking module tracks labs, radiology tests and procedures based on their CPT and HCPCS 
codes and a number of days value associated with the codes.  This number of day’s value represents the 
number of days that an item will be considered pending before it becomes overdue. For example, if a 
CBC has a number of days value of 7 associated with it and it is ordered in a Visit or Order Note, it will be 
considered pending for 7 days and will become overdue as of day 8 if no results are available within that 
time. 

As part of the content included in the database that ships with Solution Series products, e-MDs provides 
default values for most labs, radiology tests, and procedures.  These values are set based on the specific 
TYPE OF SERVICE (TOS) under which the code is categorized.  The following table denotes the default 
values set in the database. 

 
CPT (TOS)  HCPCS (TOS)  Due Date 
Diagnostic Labs  Diagnostic Labs  2 weeks 
Diagnostic X-Rays* Diagnostic X-Rays* 3 weeks 
Medical Care  Medical Care  8 weeks 
 
*Mammograms are set to 6 weeks. 
 
The tracking values set for these codes can be left at the default setting or if they do not meet the user’s 
requirements they can be edited to reflect values based on an individual clinic’s preferences. 

Permanent changes to tracking must be made in the Billing Details of either the CPT or HCPCS reference 
menu.   

Lab Tracking Rule 
Lab Tracking works in conjunction with Rule Manager to track overdue rules.  A default rule named Lab 
Tracking is installed with Rule Manager to accomplish this.  As with any other rule in Rule Manager this 
rule can be set to run daily, weekly or monthly.  As part of the default setup the Lab Tracking rule is set to 
run on a daily basis although to have rules run automatically the Windows Scheduler needs to be set up 
work with the Rule Manager.  To set up the Windows Scheduler to work with Rules Manager see Set Up 
the Rule Schedule for details. 
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Note:  When setting up Lab Tracking to run automatically, it is recommended that this rule be run at 
night since it may need to query a large number of records in the database depending on the size of the 
practice. 

To disable this rule so that Lab Tracking does not occur: 

To turn off Lab Tracking: 
1. Login in to Rule Manager using the same login and password used for Chart. 

2. Select the Lab Tracking rule by clicking it. 

3. Click the Edit Rule button on the main toolbar of Rule Manager. 

4. In the Edit Rule, clear the Rule Active check box. 

Note:  There is a Reset Lab Tracking button in the Lab Tracking rule window.  This button will set all 
labs to a status of NOT being tracked and will also delete any automated Overdue Lab TaskMan 
messages that were sent notify users of overdue labs.  This feature allows users to reset the system 
to start lab tracking over. It is especially useful in cases where Lab Tracking is not turned on 
immediately after the Chart product is installed.  In those cases a large number of Overdue lab 
messages can accumulate. 

Tracked items (CPT and HCPCS codes) can be edited to change their expected due dates or to turn 
them off completely.  Tracked items can only be changed permanently in the Billing Details section of 
either the CPT or HCPCS Search module. 

To edit tracked items permanently: 
1. Log into e-MDs Chart and click the Reference menu item on the main Chart menu toolbar then 

select CPT Search (or HCPCS Search) from the popup menu. 

2. Once the Search module opens, select a code and then click the Details button on the main 
toolbar. 

3. The Lab Tracking setup is found below the Code Valid section of the Details section. 

4. Check the ON box to track this code and set day(s) time line for overdue notices. 

Edit of a Tracked Item on the fly can only occur within an open Visit or Order Note.  It is anticipated that 
this will most likely occur at the time the order is created but can occur at a later time as long as the note 
has not been permanently signed. 

To edit tracked items on the fly: 
1. In the PLAN section of an open Visit or Order Note, add a CPT or HCPCS code. This can be 

done by clicking a lab or test item in a PLAN template that has Extended Attributes linked to it.  
click here for details 

OR 

By adding a CPT or HCPCS code under the Orders header in the PLAN Section of an open note 
click here for details 

2. Once a code (CPT or HCPCS) has been added to the Orders section, click the code and select 
Properties from the popup menu 

OR 

Click the (In-House) or (Send-Out) text at the end of the CPT code description (this is for CPT 
codes ONLY). 

3. The Order Properties window will open. 
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4. There is a tracking section in the bottom of this screen consisting of 4 fields: a Track check box, 
an Urgent check box, a Due Days field and a Date Due date field. 

○ If the Track box is checked the code is set to be tracked.   

○ Check the Urgent box to change the priority of the Overdue Message generated and sent by 
TaskMan.  Once received in TaskMan, a RED “P” flag is added to this message if the Urgent 
box is checked.  

○ If the Track box is checked a default value will appear in the Due After days field section. This 
default value can be changed for this instance only by typing a different number into the field.  

Note:  To receive an Overdue Message the very next time the Lab Tracking rule is run, set 
this value to 0 days. 

○ The Due Date is calculated from the Visit or Order Note date by adding the Due After day’s 
value. 

○ If the Track box is NOT checked the item is not set to be tracked. To set it to be tracked for 
this instance only, simply check the box and complete the Due After days field as well.  The 
program will automatically calculate the Due Date based on the Visit or Order Note date by 
adding the Due After day’s value entered. 

Note:  The Stat check box is for the Printed orders form only.  It is NOT currently being used in Lab 
Tracking. 

Setting Up Tracking Categories in DocMan 
Categories can be set up in DocMan so that when a document is scanned or imported into that category 
the Lab Tracking window will automatically open to allow pending items to be marked as completed. 

To set up tracking categories: 
Privileges Required:  Immunization: DocMan Control Panel 
1. Log in to DocMan. 

2. Click the Control Panel button on the main DocMan toolbar and select Category. 

3. Click a specialty in the left column and then select a category such as Labs in the middle column. 

4. Click Edit then check the Set Lab Tracking check box. 

This will launch the Lab Tracking screen any time an item is scanned or imported into that 
category. 

View Graphed Lab Results in Chart 
e-MDs provides a Graphing module that can be accessed from within both DocMan and Chart.  When lab 
results are scanned into a patient’s record, an image of the lab report is saved and the numeric results 
are not recorded in a structured way.  In response, e-MDs has added the ability to graph lab results.  
Manual data entry is required, but is very easy to accomplish and can be performed while viewing the 
scanned lab report on screen.  We do not expect that the user will want to graph every lab, but may have 
a few key data types (such as cholesterol or HgbA1c) that are worth the effort.  More information about 
graphing lab values is available in the Graphing Lab Results in DocMan section of the help and User 
Guide.   

See the following sections for more information: 

• Create Data Types to Graph 

• Add Data Points to a Graph 



 

e-MDs Solution Series Chart User Guide 8.0 R01 167 

• Edit or Delete Data Points from a Graph 

• View All Graphed Labs for a Given Patient 

To access graphing from within Chart: 
1. Open Chart and open the appropriate patient’s record. 

2. Click the Graph button (with the yellow cog icon) on the patient-specific toolbar just below the 
blue bar with the patient’s name and demographic information. 

This opens the Image Data/Graph window.  All Data Types that have previously recorded values 
for the given patient are listed in the Patient Results window. 

3. Highlight the desired Data Type in the Patient Results window.   

When a Data Type is selected, the upper right window displays all prior values for this Data Type 
as a graph, and the lower right window displays the results in a grid.   

The graph is titled with the Data Type and Patient Name, and represents numerical results over 
time.  Red and blue horizontal bars represent expected maximum and minimum normal values, 
respectively.  Plotted values are identified by black squares with yellow labels that display the 
individual numerical results.  Successive values are connected with a black line.  The horizontal 
axis, representing time, will lengthen or narrow depending on the number of plotted points. 

Referral Authorization Window 
The Referrals/Authorizations window provides the user with the ability to track multiple referrals per 
patient.  It is designed to be an on-screen processing tool although a hard copy printout of data can also 
be generated. 

Note:  The Referrals/Authorizations window is a Practice Management module.   Access to this module 
is dependent on the clinic having the billing component of the Solution Series.  If e-MDs Bill is not 
present, this module will not be accessible. 

Referral Authorization Window Options 
Referral Authorization  
Retrieve Retrieves a list of referrals based on filter settings. 
New Click this to create a new referral. 
Edit Opens the highlighted referral in edit mode. 
Select Used when selecting a referral from other parts of the system, such as when 

browsing from an invoice to link a referral to a claim. 
Print Prints the referral report. 
Edit Patient Opens the patient demographics form for the patient whose referral is currently 

highlighted. 
Print Form Opens the Word forms module.  The system automatically selects the patient in the 

referral/authorization highlighted at the time the button is clicked. 
Reset Filter and Filter These are the buttons at the bottom left .  If a work list has already been retrieved, 

the Reset Filter button can be used to return filter settings to their defaults.  The 
Filter button is used to update the list if any filter criteria have been changed with a 
list already loaded. 

The following filters are available for work list creation. 
Authorization Start Date 
Range and Authorization 
End Date Range 

By default the system will use the start date as the search range so the box for this 
is checked.  To use the end date range, check the box above that filter.  You can 
use both at the same time.  Enter date ranges. 

Facility Shows referrals for this facility, or all facilities to which the user has access rights. 
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Patient Shows referrals for a specific patient. 
PCP/Referring Physician On the referral. 
Specialty The list can be filtered by the specialty of the PCP/Referring Physician on the 

referral. 
Specialist The first specialist on a referral. 
Insurance Patient primary insurance. 
Provider Patient’s primary provider . 
Show Default Referral Default referrals are entered in the patient demographics file but are still stored in 

the authorizations tables.  They are displayed in red in the referrals module but are 
excluded from the search list unless this box is checked. 

# Days Until Expiration Tracks against the authorized date range of a referral. This can be filtered for any 
number of days, referrals with at least or less than a number of days, and a specific 
count. This filter is useful for finding referrals that are expiring, but may have a high 
count of visits authorized remaining. 

# of Remaining Visits Tracks against the authorized visit count. This can also be filtered by any number of 
remaining visits, referrals with at least or less than a number of visits, or a specific 
visit count remaining. 

Type Filters by the inbound and outbound classifications. 
Status Filters by the Active, Inactive or Pending classifications. 

Referral Workflow 
This section is a brief explanation of how you might use the referral/authorization tool in your office. 

• Create a Referral “Order”: The office needs to get a referral for a patient (inbound, or on behalf 
of a patient being sent to another specialist). Nurse or other staff member goes to the referral tool 
and creates a pending referral. 

• Convert Pending Referrals by Getting Authorization: The staff member assigned to this 
functional task creates a work list in the referrals window and calls the insurance companies listed 
for each pending referral. Information required by the insurance is looked up from within the 
window by opening the patient or the pending referral order. When the authorization is received, 
the number and other data is added to the referral, and the referral is changed to Active. 

• Notify Patient and Specialist: When the authorization is received (or denied), the staff member 
can contact the patient and schedule an appointment, or tell them to contact a recommended 
specialist in their network. A referral authorization information sheet can be printed for the patient 
to take with him/her. It includes information about the patient, insurance and referral and is useful 
for staff members in other offices. 

• File Claims: The active referral is linked to invoices and tracked automatically. 

• Ensure Compliance: If necessary, someone can generate a referral work list to find referrals that 
are expiring but where there are still authorized visits remaining. 

Adding a Referral/Authorization 
An unlimited number of referrals can be added to a patient. Referrals are either inbound (applicable to 
this organization for tracking purposes), or outbound. They can also be tracked as pending, active or 
inactive. These classifications affect whether the referral is a work list for a user, tracked by the system, or 
historical. 
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To create a Referral Authorization: 
1. Go to Tools > Referral/Authorization (Alt+T, R).  Alternative methods of accessing the referrals 

module which may be more convenient depending on work flow are: 

○ Click the Referrals button in the Schedule Check In module.  This saves having to search for 
a patient when creating the new referral since the person is already known. 

○ Double-click the A column in the Bill daily work list.  This also filters for the patient, saving 
keystrokes. 

○ From within an invoice, click the Find button next to the Referral field. 

2. Click New (Alt+N).  If loaded from the Tools menu, a patient must be searched for and selected 
first. 

3. In the Patient Referral window, fill out fields as required.  See Referral/Authorization Window 
Options for a description of available options. 

4. Click Save to store the referral. The system will ask if this is the Active referral. If so, click Yes. 
Subsequent invoices for the patient will be tracked against it. If the referral status is Not Active, 
another pop-up asks for verification. 

Referral/Authorization Window Options 
Referral/Authorization  
Medical Facility Referrals are facility specific for tracking purposes.  The default is the facility in 

which you are working, but another can be selected if necessary. 
Inbound/Internal, 
Outbound/External 

Set this based upon whether the referral will be tracked for billing purposes in this 
office (internal) or by another clinic to which the patient is being referred (external). 
Only inbound referrals are tracked for warnings. 

Status Pending indicates a referral that needs to be authorized by insurance. Users can run 
a report of all pending referrals and use it as a work list. Active referrals are ones 
that can be used for billing and scheduling tracking. Inactive referrals are retained 
for historical tracking. The status type is summarized in the referral view with codes 
of A, I and P. 

Authorization Number The number issued by the insurance company for the treatment. 
Referral Number Additional referral identifier that may be assigned by the insurance company. 
PCP/Referring Physician The person that will be identified on claims as the referring physician. 
Specialist, Second 
Specialist 

Up to two physicians authorized to perform treatment can be entered, e.g. a surgeon 
and an anesthesiologist. 

Approved Visit Count Set to the number of visits authorized for the treatment. Based on the Setup Options 
to track authorizations by appointment or invoice, the Remaining field decrements 
by 1 for each invoice tagged to this referral. When the number remaining has 
expired, users get warnings when scheduling or invoicing patients. 

Start and End Date Enter the date range within which treatment must be rendered. 
Allowed Amount Enter the maximum allowed amount. If an invoice allowed balance exceeds the 

Remaining amount, a warning appears upon saving. If the remaining amount is <= 
0.00, a warning will also be issued when trying to schedule an appointment. 

Out Patient Check the box. This is for information only. 
Comment Type a comment into the field to give more information about the referral, or click 

Find to select a standardized comment from the comment reference table. A 
combination of a standard comment and free text is permitted. 
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ICDs Type ICD codes into the field then press Enter or click Add for the codes to appear 
in the list. When an invoice is created with codes that are not part of a referral linked 
to the invoice, the system warns users upon saving. To remove an ICD, click 
Remove. 

CPTs Enter CPT code ranges for the procedures authorized. For a single code, enter the 
same code in both the start and end fields, then click add. Custom sets of 
authorized codes can be created in a Referral Types support table (see Referral 
Types on page 48). Click Find to browse and select a type. To remove a CPT, click 
Remove. 

The referral authorization sheet can be used by staff as a checklist for working a referral, or can be given 
to a patient to take to a specialist, etc. It prints all the patient, physician and insurance demographics, as 
well as details about the referral. 

To print a referral/authorization: 
1. Select the referral in the Referral/Authorization window and click Edit. 

2. Click Print in the Patient Referral window. 

3. Select a printer and click OK. 

Note:  A custom referral form can also be generated using Word forms and then printed by clicking 
the Print Form button in the Patient Referral window. 

This feature allows users with the Chart: Secure Chart privilege to determine who can and cannot access 
a specific patient chart. Chart Security allows users access to charts in general, but can be set to block 
certain users from accessing particular patient charts.  This feature is useful when there is a need to lock 
access to charts of staff members (who also happen to be patients), charts of a celebrity or other VIP 
patients, patients with privacy issues such as HIV, mental health, or other patient charts where there is a 
need to limit access. 

To set security for specific patient charts:  
Privileges Required:  Chart: Secure Chart 

1. Within a Patient chart, click the Padlock icon . 

Users can be moved to the “Excluded Users” window on the right by highlighting the user’s name 
and using the middle arrows to move them.  Multiple users can be selected by holding down 
CTRL on the keyboard or select all users by clicking the double black arrows. 

2. Click Close. 
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4 
Prescribing and Refilling 

Medications 
This section provides instructions on how to use the Solution Series script tools to 
prepare and submit new prescriptions, approve and submit refills, check for drug-drug 
and drug-disease interactions, and work with a patient's formulary to ensure proper 
insurance coverage.  The features covered are: 

 Using Script Writer to search for drugs and their descriptions; write new 
prescriptions; and refill current and past prescriptions. 

 Processing new prescriptions and refills through print, fax, phone and electronic 
transmission (using SureScripts). 

 Using prescription tools to effectively support these requirements.  Those tools 
include: 

 Prescription Tracker to follow and report the status of prescriptions 
(especially the processing of electronically submitted prescriptions). 

 Dose Calculator to compute the appropriate therapeutic dose range for a 
selected drug based on the patient's age, weight and diagnosis. 

 Quick Picks to list the most commonly prescribed drugs used in a 
particular practice. 

 Phone-In Script module to manage prescriptions to be called in to a 
pharmacy.  

 Medication Reconciliation to reconcile a list of medications from an 
external source with the medications previously or currently prescribed in 
the current facility. 

 Refill Request module to manage requests for refills received from pharmacies. 

Continued on the next page .... 
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Understanding Script Writer 
Script Writer is a prescription generator with the following features: 

• A search mechanism to find a drug by name or by therapeutic class. 

• Access to Drug Consults which consist of summary information about the medication’s 
indications, contraindications, dosing, pregnancy and lactation warnings, adverse effects, drug 
interactions and precautionary information.  

• Automatic Drug-Drug and Drug-Disease Interaction checking with warning messages and 
recommendations where appropriate. 

• Automatic Drug Allergy and Drug Adverse reaction checking. 

• Choice of printing, faxing, electronic or phoning in prescriptions. 

• A Quick Pick generator, which creates a short list of complete prescriptions frequently used in the 
facility that enables one click generation of prescriptions. 

• Ability to check for other available brands, forms or strengths of a drug. 

• Ability to view list of similar drugs that exist within the same therapeutic class. 

• Option to print Patient Recommendations specific to the medications prescribed. 

• A Dose Calculator that indicates whether a selected sig for a medication falls within the daily 
Minimum and Maximum dose range based on diagnosis and patient weight. 

e-MDs offers a Formulary Benefits add-on package that provides these additional functions: 

• Ability to download a patient’s Formulary Benefits Information (such as medication coverage, 
restrictions, and medication copay amounts) from Chart and Schedule applications. 

• If a medication to be prescribed in ScriptWriter is non-formulary (not covered under patient’s 
plan), provides a list of in formulary therapeutic alternatives for possible substitution. 

• Ability to prescribe electronically to mail order pharmacies (if allowed by patient’s plan). 

• Ability to download a comprehensive list of all medications prescribed for a patient. The list 
includes prescriptions written by all providers and filled by any pharmacy, and that were 
processed through the PBM.   

Contact e-MDs for more information or to purchase Formulary Benefits. 

See e-MDs Solution Series Formulary Benefits User Guide for details about how these functions work 
within ScriptWriter. 
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Writing New Prescriptions 
There are several ways to write new prescriptions, including: 

• Searching for and selecting a drug in the Medications section of the Visit Note/HS (Health 
Summary) tab. 

• From the Current Medications List and Visit Notes. 

• From copies of new or existing prescriptions that are then changed to meet the patient's needs.. 

• From Quick Pick lists that identify frequently prescribed medications. 

Searching for a Drug 
When Script Writer is opened (as described below), the Prescribe a Drug window opens. This is the drug 
search window. Medications can be found in the database either by name (brand or generic) or by 
therapeutic class. 

To search for a drug: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar.) The Health Summary is in the left windowpane. 

2. Click anywhere on the blue bar labeled Medications to open that section. 

3. In the Health Summary, under the Medications header, click the Write New Script button on the 
right side of the Current Medications window. It is the top button, with the Rx pad icon . 

OR 

In the Health Summary, under the Medications header, click the Refill Medication button on the 
right side of the Current Medications window. It is the second button, with the Rx bottle icon; this 
will open the Refill Grid (Medication List grid). Click the New button on the toolbar to open the 
drug search screen (Choose Medications). 

OR 

From within an active Visit or Order Note, in the Plan section, click the underlined text titled 
Prescriptions or Other Prescriptions.  This will open the Refill Grid (Medication List grid). Click 
the New button on the toolbar to open the drug search screen and write a new prescription. 

4. To find a drug by name, type a few letters of the drug name (brand or generic) in the search field 
labeled Drug. As soon as the first two letters are entered, the search will automatically begin. All 
medications matching the search criteria will appear in the Drugs section. Results may also 
appear in the Quick Picks section if any exist for that drug (see Add/Delete Quick Picks for 
details). 

5. To find a drug by therapeutic class, click Find in the toolbar and select the Find by Class menu 
option. This will open a Find Drug by Class window. Type in a Class Description ("beta blocker" 
for example) and press Enter or click Search. All drug classes that match the search criteria will 
appear in the upper window.  

6. Select a class in the upper window to display all member drugs in the lower window. Double-click 
a drug name in the list to open the Script Pad so that a prescription can be written. 

Note:  The search criteria defaults to Begins With. To change the search criteria, click the 
buttons marked Contains or Exact Match. 
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Writing a New Prescription from the Current Medications List and 
Visit or Order Notes 
New prescriptions can be written from the Current Medications list and from an active Visit or Order Note. 

Important!  Keep in mind that no one can write a prescription unless they have the correct privileges.  
Even if a provider has all script writing privileges, no prescriptions can be written under their name unless 
the person logged in also has script writing privileges.  

The Medical Assistants security group is given ScriptWriter Non-Schedule privileges by default.  If a 
provider wants to limit the ability of a Medical Assistant to write any scripts, this privilege needs to be 
removed from that particular security group.  Additionally, if a provider wishes to delegate authority to 
Medical Assistants to write all types of prescriptions, the ScriptWriter Schedule 3-5 and ScriptWriter 
Schedule 2 privileges need to be added to the security group.  See e-MDs Solution Series Administration 
Guide for more information about security groups and privileges. 

Notes:    
• Prescriptions written from the Current Medications list cannot be deleted, but they can be 

discontinued.  

• Prescriptions written in a Visit or Order Note can be edited or deleted up until the point that the 
note is permanently signed off.  

To write a new prescription from the Current Medications list: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar.) The Health Summary is in the left window pane. 

2. Click anywhere on the blue bar labeled Current Medications to open that section. 

3. In the Health Summary, under the Current Medications header, click the Write New Script 
button on the right side of the Current Medications window. It is the top button, with the Rx pad 
icon . 

Note:  If a message displays indicating you must select a provider responsible for this 
prescription, locate and select a provider on the Find Active Staff Provider screen and save that 
change.   

The Choose Medication screen appears. 

4. To find a drug by name, type a few letters of the drug name (brand or generic) in the search field 
labeled Drug. As soon as the first two letters are entered, the search will automatically begin.  

All medications matching the search criteria will appear in the Drugs section. Results may also 
appear in the Quick Picks section if any exist for that drug (see Add/Delete Quick Picks for 
details). 

5. If an appropriate Quick Pick exists, double-click the item 
in the Quick Pick section, or highlight it and click 
Prescribe.  

The Quick Pick information will appear in the Pending 
Scripts pane on the right side of the Prescribe a Drug 
window. 

Note:  If you want to make changes to Quick Picks, 
you can do so in the Refill Grid (also known as the "Medication List grid") after the Choose 
Medications window closes  

6. If no matching Quick Pick entry exists, double-click the medication name from the Drugs section, 
or highlight it and click Prescribe to add the selected drug to the Pending Scripts pane. See the 
example image below where Biaxin was chosen as a Quick Pick and Accupril was not. 
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You will have the opportunity to complete the prescription in the Refill Grid window (see Refill 
Grid for an overview of the interface).   

7. Repeat the process if you are prescribing more than one medication. 

Note:  If a medication is inadvertently added to the Pending Scripts pane, you can click the 
button in the top-right corner  to remove it from the pending scripts list. 

8. Click the Next button and the Medication List/Refill Grid opens. 

This screen displays all Current Medications in a grid format.  The new prescription(s) just written 
will appear at the bottom of the list and will be identified by a script pad icon  in the first 
column. 

 

Notes:   
○ The Quick Pick item (Biaxin, in this example) is completely filled out. If it does not need 

changes, you can click the Save button to prescribe the medication.  If the Quick Pick item 
does need changes, you can make the changes by clicking the appropriate cell on the row of 
the medication that needs modification.  For example, if you want to change the quantity, click 
in the cell under Qty/DS. The cell then becomes active and changes can be made (the cells 
are highlighted when active). 

○ The non-Quick Pick prescription (Accupril in this example) shows only the drug name.  In this 
situation you must fill in the information for Form strength, Sig, QS OR Qty/DS, Units, #Rfs, C, 
Sub?, Sep, Send and possibly Pharmacy (if the Send method is Fax, Phone or Electronic). 

If the patient is being given sample drugs, you can document that transaction by clicking the 
Sample icon to open the Select a Drug screen.  From there you can search for and select the 
drug being given, then complete the Edit Medication Sample screen to describe the sample.  
After saving that information, the sample entry will appear in the Medication List with a light blue 
background and the Sample icon in the first column. Note that samples can be refilled like any 
other medication, if desired. 

9. After all changes are made, click the Save button to complete the prescription writing process. 

If Electronic is selected as the Send method, and Surescripts has been implemented, an 
Electronic Rx Preview window is displayed so you can review all prescription details. 

10. If all details are correct, click OK to save the prescription and proceed to the Sending 
Prescriptions dialog box. (If you click Cancel, you will return to the Medication List and nothing is 
saved.) 

If the prescription is to be printed, faxed or sent electronically, a Sending Prescriptions dialog 
window will open with Send and Don’t Send choices.  

Important!  Some states allow controlled substances to be electronically faxed and others 
have more stringent requirements. By default, e-MDs software does not allow electronic faxing of 
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Schedule 2 (controlled substance) prescriptions. You must check individual state regulations to 
verify whether or not you can use the prescription faxing option for your controlled prescriptions. 

11. Select Send to process the prescription,  

OR 

Select Don’t send to just record the prescription in Chart.  

Note:  Phone-In prescriptions will not have the Sending Prescriptions dialog because the 
prescriptions will automatically be listed on the phone-in list. See Phone-In Script Module. 

To write a new prescription from a Visit or Order Note: 
1. In an active Visit or Order Note, scroll to the Plan heading or click the P button in the vertical 

button column to ‘jump’ to that section of the note. 

The Plan section of the note will display each diagnosis from the Assessment section.  

2. Select the correct diagnosis header (displayed in bold 
black text) and click the Prescription header that is 
listed below it.  This will open the Refill Grid.  

Note:  The Refill Grid opens so that you can write a 
new prescription or refill an existing one. 

3. Click the New button on the toolbar of the Refill Grid to 
open the Choose Medications (the Drug Search) screen.  

The process for writing a prescription in this manner is 
the same as writing it from the Current Medication List. See Write a New Prescription from the 
Current Med List for details. 

Prescriptions can be written directly from templates if the template item has an Extended Attribute of 
Prescription linked to it (see Prescription Extended Attributes for details) 

To write a new prescription from a template: 
1. In an active Visit or Order Note, scroll to the Plan heading or click the P button in the vertical 

button column to ‘jump’ to that section of the note. 

The Plan section of the Visit or Order Note will display each diagnosis from the Assessment 
section.  

2. Select the correct diagnosis header (displayed in bold black text), and open the template for that 
diagnosis 

3. In the PLAN templates Medication section, click the medications question and select the desired 
drug from the following levels. 

Note:  Questions that have a Prescription Extended Attribute linked to them will have a 
prescription pad  icon on the right side of the question. 

At the time the question with a Prescription Extended Attribute is chosen, drug interaction and 
allergy checking will occur. If there are warning messages they will appear at this time. 
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4. When a question with a Prescription Extended Attribute is chosen, the Diagnosis Navigator 

window (see Diagnosis Navigator for details) will change to display a list of the medications 
chosen in the template. 

 

The list of medications will show the drug name on the left and a green Quick Pick icon  on the 
right.  

Note:  The absence of a Quick Pick icon indicates that the medication does not have any 
associated Quick Picks. In the above example, the Guaifenesin does not have matching Quick 
Pick entries. 

5. For those items that have Quick Picks, click the QP icon  to access a list of Quick Picks 
entries. 

6. Select the desired Quick Pick item from the list and double-click to select it. The medication list on 
the left will change to display the Quick Pick information. 

 
7. When finished documenting the PLAN, close the template. 

A modified Refill Grid will open, displaying only those medications that were written in the 
template. 
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The medications with Quick Picks chosen will have all the information filled out while those 
without Quick Picks will only have the drug name. 

Note:  If the patient is being given sample drugs, you can document that transaction by clicking 
the Sample icon to open the Select a Drug screen.  From there you can search for and select the 
drug being given, then complete the Edit Medication Sample screen to describe the sample.  
After saving that information, the sample entry will appear in the Medication List with a light blue 
background and the Sample icon in the first column. Note that samples can be refilled like any 
other medication, if desired. 

8. Make any needed changes. For example, with Quick Picks you may want to change the send 
method and pick a pharmacy.  Or, with the medications that do not have Quick Pick entries, you 
will need to fill out the pertinent information (such as form strength, sig, qty, etc.). 

9. Click Save when finished 

The medications will appear under the Prescription header under the appropriate diagnosis. 

Copying a Prescription 
The copy feature enables a similar or duplicate prescription to be written without exiting the Script Pad or 
performing another drug search. This is helpful, for example, if a mail-in prescription is written for a three-
month supply of a medication. In this case, the patient may also need a short-term prescription for the 
same medication to be filled at a local pharmacy. 

To copy an existing prescription: 
Note:  From within the Refill Grid you can only copy prescriptions that are being refilled.  See the 
“Refill Grid” section for details on the grid. 

1. Click the refill check box to the left of the medication to be refilled. 

2. After the medication is selected for refill, click the Copy button on the Refill Grid toolbar. 

The prescription will be copied and will be displayed at the bottom of the grid with a Copy icon 
(two pieces of white paper) replacing the refill check box 

3. Make any desired changes to the original or the copy and, when finished, click the Save button. 

To create a new prescription and then make a copy: 
1. Write the first prescription as usual (see Write a New Prescription from the Current Med List for 

details). 

2. When finished, click the Copy button (instead of clicking Save). 

The prescription will be copied and will be displayed at the bottom of the grid with a Prescription 
Pad icon replacing the refill check box 

3. Make changes to the prescription, as needed. 
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4. Click the Save button when finished. 

Note:  If the form and strength of the drug are identical in both prescriptions, the medication will 
appear only once in Current Medications. However, if the plus sign is clicked to expand the 
medication, both active prescriptions will be displayed. 
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Refilling Prescriptions 
There are several ways to refill prescriptions, including from the: 

• Current Medications List (in the Health Summary) 

• Visit and Order Notes 

• Past Medications List 

• Refill Grid 

• Refill Module 

Refilling Prescriptions from the Current Medications List 
Prescriptions can be refilled from the Current Medications list (in the Health Summary) and from an active 
Visit or Order Note. 

To refill a prescription from the Current Medications list: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar.) The Health Summary is in the left window pane. 

2. Click anywhere on the blue bar labeled Medications to open that section. 

3. In the Health Summary, under the Medications header, click the Refill button on the right side of 
the Current Medications window. It is the second button from the top and is a prescription bottle  
icon. 

The Refill Grid will open.  It displays all current medications in a grid format. 

4. To refill a medication, click the check box to the left of each medication that is to be refilled. 

Note:  You can click the check box at the top of the first column to select all medications for 
refill. 

 
5. Make changes to the medication by clicking in the cell that needs to be changed (the cells are 

highlighted when active). For example, if the quantity is changing, click the Qty/DS cell and 
change the quantity. 

6. When all desired medications have been selected, and any changes have been made, click the 
Save button to refill the medications. 

Notes:   
 When the Refill Grid opens, it shows Current Medications by default.  You can select the 

Past or All radio buttons to show the patient’s past medication list or all medications. Refills 
for past medications are submitted using the same method as for Current Medications. 
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 If the patient is being given sample drugs, you can document that transaction by clicking the 
Sample icon to open the Select a Drug screen.  From there you can search for and select 
the drug being given, then complete the Edit Medication Sample screen to describe the 
sample.  After saving that information, the sample entry will appear in the Medication List 
with a light blue background and the Sample icon in the first column. Note that samples can 
be refilled like any other medication, if desired. 

To refill a prescription from a Visit or Order Note: 
1. In an active Visit or Order Note, scroll to the Plan heading or click the P button in the vertical 

button column to ‘jump’ to that section of the note. 

The Plan section of the note will display each diagnosis from the Assessment section.  

2. Select the correct diagnosis header (displayed in bold 
black text) and click the Prescription header that is 
listed below it.  

This will open the Refill Grid which displays all Current 
Medications in a grid format.  

The Refill Grid opens so that you can refill medications 
or write a new prescription, as needed. 

3. To refill a medication, click the check box to the left of 
each medication that is to be refilled. 

You can click the check box at the top of the check box column to select all medications for refill. 

 
You can make changes to the selected medication by clicking in the cell that needs to be 
changed (the cells are highlighted when active). For example, to change the quantity, click the 
Qty/DS cell and change the quantity. 

4. When all of the desired medications have been selected, and any changes have been made, click 
the Save button to refill the medications. 

Note:  When the Refill Grid opens, it defaults to show Current Medications.  You can also select 
the Past or All radio buttons to show the patient’s past medication list or all medications. Refills 
for past medications are submitted using the same method as for Current Medications. 

Refilling Prescriptions from the Past Medications List 
Medications that have been stopped are moved to the Past Medication List.  These prescriptions can be 
refilled, if necessary.   For refills, only the With Changes option can be selected.  That option will open 
the Script Pad and allow you to make changes before filling. 
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To refill with changes/notes: 
1. Within a patient’s chart, click the Visit Note/HS (Health Summary) tab (below the blue horizontal 

patient identification bar.) The Health Summary is in the left window pane. 

2. Click anywhere on the blue bar labeled Current Medications to open that section. 

3. In the Health Summary, under the Current Medications header, click the Past button just below 
the Current Medications label. 

The display will change to show the past medications 

4. Highlight the medication to be refilled and click the Refill button  on the right. 

A menu item will appear with the options As Is (which is grayed out) and With Changes/Notes. 

5. Select With Changes/Notes. 

The Script Pad will open with the prescription information fields already filled out. 

 
6. Select a Form Strength (such as 250 mg tablets) from the drop-down list. All available Form 

Strengths for the selected drug should be in this list. 

7. Select a Sig (such as 1 tab p.o. BID) from the drop-down list. Common Sigs for the selected drug 
will appear in the list.  
OR 
If an appropriate Sig is not in the list, either click New to create a new Sig or highlight an existing 
Sig and click Edit. 

8. Select a quantity to be dispensed from the Disp drop-down list (quantities usually default to 30, 
60 and 90-day supplies in the drop-down list) or type in a quantity to be dispensed. Select a unit 
to be dispensed (for example, Tablets, 30 gm tube, etc.) 
OR 
Alternatively, check QS (quantity sufficient) and select a number of days (for example, dispense 
QS 10 days). 

9. Select the number of Refills authorized for the prescription. 

10. Check or clear the Allow Substitution box. By default, every prescription is checked to allow 
(generic) substitution. 

11. OPTIONAL: The Label in Alternate Language box can be changed. The default language is 
English and this message does not print on the label. This field is a message to the pharmacist to 
label the directions on the prescription in an alternate language (if possible) for the convenience 
of the patient. 



 

e-MDs Solution Series Chart User Guide 8.0 R01 183 

12. Click Save when finished. 

If the prescription is to be printed, faxed or sent electronically, a Sending Prescriptions dialog 
window will open with Send and Don’t Send choices.  

Important!  Some states allow controlled substances to be electronically faxed and others 
have more stringent requirements. By default, e-MDs software does not allow electronic faxing of 
Schedule 2 (controlled substance) prescriptions. You must check individual state regulations to 
verify whether or not you can use the prescription faxing option for your controlled prescriptions. 

13. Select Send to process the prescription. 

OR 

Select Don’t send to just record the prescription in Chart.  

Note:  Phone-In prescriptions will not have the Sending Prescriptions dialog because the 
prescriptions will automatically be listed on the phone-in list. See Phone-In Script Module. 

Refilling Past Medications from the Refill Grid 
In addition to refilling past medications directly from the Past Medications list, you can also refill past 
medications from the Refill Grid (Medication List grid).   

To refill past medications from the Refill Grid: 
1. Open the Refill Grid by clicking the Refill button .  The Medication List grid (Refill Grid) will 

open. 

2. In the section labeled Medications shown, click the radio 
button labeled Past to list past medications in the grid. 

3. Select the past medication(s) to be refilled by clicking the 
check box at the left. 

4. Make edits to the prescription(s), if desired. 

5. Click Save when finished. 

Note:  You can also choose to see all medications (current and past) in the same list by clicking 
the radio button labeled All. 
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Processing Prescriptions 
There are a number of ways you can process a prescription with Solution Series: 

• Print a prescription and give it to the patient. 

• Call a prescription in to a pharmacy. 

• Fax a prescription directly to a pharmacy. 

• Transmit a prescription electronically. 

The method you use will depend on a number of factors, including: 

• The patient's current location – at the office or elsewhere.  If the patient is in the office, he/she 
may prefer to have a written prescription to carry to the pharmacist or for another reason. 

• The availability of pharmacies and what types of prescriptions they will accept – printed, 
telephone, faxed or electronic.  The patient's preferred pharmacy may not accept all types of 
prescription submissions. 

• If the prescription is for certain types of controlled medications, the prescription cannot be faxed 
in most states.  Local, state and federal regulations play a part in how certain drugs are ordered, 
dispensed, and tracked. 

• You may not currently have SureScripts installed at your facility.  See Transmitting Prescriptions 
Electronically for more information on this interface module. 

In the end, it all comes down to what works best for your organization in any given situation.  Solution 
Series provides the flexibility to use the appropriate tool for each and every circumstance. 

Printing Prescriptions from Script Writer 
Before you ever write or refill a prescription in Solution Series, you must set up your preferences for all 
printed prescriptions.  This is not only selecting a printer, but also includes identifying what should print o 
the prescription in addition to the drug-related information.  This might include the name and address of 
your facility, specific license numbers and provider information, and much more.  See the e-MDs Solution 
Series Administration Guide for instructions on setting user preferences for your facility for script printing. 

After setting your user preferences, you can just select Print in the Send column of the Medication List  
grid. 

Calling In Prescriptions to Pharmacies 
One of the most frequently used methods of processing a prescription is to call it in to the patient's 
pharmacy of choice.  If this is your preferred method, all the necessary information should have already 
been entered in the patient's chart. 

If the pharmacy information is place for the patient, you can select Phone in the Send column of the 
Medication List grid.  This will pass the necessary information to the Phone-In module for processing.  
This prescription information, along with other patients prescription information, will be queued for calling 
in on a scheduled basis.  See Phone-In Script Module for how this feature works. 

Faxing Prescriptions from Script Writer 
A few things need to be set up in advance for seamless faxing from Script Writer.  See the e-MDs 
Solution Series Administration Guide for how to: 

• Add pharmacies to the database.  

• Set up the faxing printer. 
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To write and fax a prescription in Script Writer: 
1. Select Fax in the Send Options area of the script pad. 

A Pharmacy field will appear.  

2. Begin typing the name of the pharmacy or click the small down arrow in the field to scroll the list.  

3. Click the desired pharmacy to select it. 

There is nothing more to do!  At the time of Note Conclusion, the prescription(s) will be routed to 
the fax printer and faxed. 

If the prescription is faxed from Current Medications instead of inside a note, a Sending Prescriptions 
dialog window will open with Send and Don’t Send choices. Selecting Send will process (fax) the 
prescription, Don’t send will just record the prescription in the patient's chart.  

Legal Issues with Faxing Prescriptions 
Important!  Some states do not allow faxed prescriptions at all and others have more stringent 
requirements.  e-MDs software does not currently support electronic submission of Schedule 2 (controlled 
substance) prescriptions.  

You must check individual state regulations to verify whether or not you can use the prescription faxing 
option.  Faxes generated from e-MDs Chart include a printed line at the top allowing the pharmacy to 
verify that the fax did indeed originate from the physician’s office as well a footer with information that 
includes the following statement: 

“This prescription has been electronically generated by e-MDs Solution Series and faxed to: 
<Pharmacy Name>, <Pharmacy Address>, <Pharmacy Phone Number>, <Pharmacy Fax Number> 
on  <Fax Date and Time> by <Full Name of Person Logged In and Title>. “ 

This footer meets the requirements for faxed prescriptions in some specific states and, together with the 
signatures, should cover the majority of states that allow faxed prescriptions.  

Signatures can be scanned and attached to faxed prescriptions (for faxed prescriptions only) in those 
states that allow this feature. See the Utilities Guide: “Signatures” chapter for details. 

Transmitting Prescriptions Electronically 
The ability to send prescriptions and receive refill requests electronically is included as part of the Script 
Writer functionality.  The electronic transmission of prescriptions is performed through SureScripts, a 
third-party vendor.  SureScripts acts as a “clearing house” for prescriptions and e-MDs works in 
conjunction with them to ensure compatibility with the Script Writer module.  This functionality permits 
prescriptions to be sent through a very secure connection to the e-MDs server, then on to SureScripts.  
SureScripts then forwards the prescriptions to the designated pharmacy and an acknowledgement is sent 
back to the prescriber.   

Refill requests can also be sent from the pharmacies to the clinic electronically. These electronic refill 
requests will show up in the Refill Request module and they will be designated as having come from 
SureScripts.  See Refill Request Module for more information on electronic refill processing. 

Important!  While there is no licensing fee charged by e-MDs for the SureScripts functionality, there is 
a nominal setup fee that must be paid before this new feature can be used.  Until you purchase the 
implementation service and e-MDs Support staff sets up your clinic for electronic prescriptions, you will 
not see any of the electronic features of the system. You can request information about implementing 
SureScripts by contacting the e-MDs Sales Department. 

See the e-MDs Solution Series Administration Guide for information on setting up, maintaining and 
troubleshooting SureScripts for electronic prescription processing. 

If you select Electronic in the Send column of the Medication List grid after SureScripts is implemented, 
Script Writer passes the prescription to SureScripts for processing.    
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Note:  Recently the DEA approved the electronic prescribing of controlled substances (EPCS) for 
Schedule 2, 3, 4, and 5.  However, there are some stringent requirements that must be met before that 
processing is allowed.  e-MDs is currently working on requirements and business relationships that will be 
needed to support that functionality.  At this time, Script Writer will not allow you to select the Electronic 
send method if the prescription is for a Scheduled medication.  When this functionality has been fully 
implemented, e-MDs will publish that information to Solution Series users. 

To send a prescription electronically using SureScripts: 
1. When you complete a prescription in e-MDs Chart, select Electronic as the Send method.  

 

Note:  Accurate electronic transmission of the prescription requires selection of a specific 
quantity for a single unit.  For example, to prescribe 20 ounces of a medication, you must select 
Quantity: 20 and Unit: ounce, rather than Quantity: 1 and Unit: 20 ounce bottle.  See Writing New 
Prescriptions for more detailed information about entering prescriptions in the electronic medical 
record. 

Important!  Units that appear light grey are flagged Units that cannot be sent electronically. 
Those Units can be viewed for packaging and/or saved for Phone, Fax or Print transmission. 
Selecting a flagged Unit for electronic submission will change the Unit to red and incur a Warning 
message. The Unit or Send choice must be changed to save the prescription.  

 
 

2. Click Save. 

If Electronic is selected as the Send method, and Surescripts has been implemented, an 
Electronic Rx Preview window is displayed so you can review all prescription details. 

3. If all details are correct, click OK to save the prescription and proceed to the Sending 
Prescriptions dialog box. (If you click Cancel, you will return to the Medication List and nothing is 
saved.) 

4. In the Sending Prescriptions dialog box, click Send. 

 
Solution Series Chart processes the prescription for transmission and displays a message that 
may indicate successful electronic transmission.  This message refers to transmission from Chart 
to SureScripts, but it does not indicate that it was successfully transmitted from SureScripts to the 
pharmacy. 
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For information about checking the status of transmission from SureScripts to the pharmacy, see 
To check a prescriptions electronic transmission status. 

Important!  Be aware that transmission status provides information about delivery of a 
prescription; it does not confirm that a pharmacist has reviewed the request or that the 
prescription is being filled. 

Troubleshooting Electronic Prescription Processing Issues 
If you encounter an issue when attempting to transmit a prescription electronically, please provide the 
prescription to the pharmacy via fax or telephone immediately to avoid a delay in filling the prescription for 
the patient.  Then contact e-MDs Support within 24 hours.  You can contact e-MDs Support at 800-565-
5564 or https://supportcenter.e-mds.com. 

When you contact the Support Center, please provide the following information: 

• Provider’s SPI number (see To find a provider's SPI number) 

• Message ID for the prescription (see procedure below) 

• Name of the pharmacy to which the prescription was sent 

• Date prescription was sent 

Important!  To effectively troubleshoot an e-prescribing issue, e-MDs Support must have access to 
information contained in the message details.  These details are retained in the system for 15 days from 
the date of transmission. 

To check electronic prescription details and transmission status: 
1. In e-MDs Chart, access the SureScripts Administration module (Tools > SureScripts 

Administration) and click the SureScripts Messages tab. 

2. Select the From and To dates, then click Show. 

 
The message ID is shown in the first column, with message details to the right of the message ID. 

 
The last column in the message details shows the status of the message. 

https://supportcenter.e-mds.com/�
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 A status of Successful means that SureScripts received the prescription and forwarded it 
to the pharmacy, and the pharmacy software confirmed delivery. 

 A status of Unknown means that SureScripts received the prescription and forwarded it to 
the pharmacy, but the pharmacy software did not confirm delivery. 

Note:  If a pharmacy denies receipt of a prescription, but the transmission status shows 
Successful or Unknown, please contact e-MDs Support (800-565-5564 or 
https://supportcenter.e-mds.com) and provide the message ID for investigation.  The message ID 
is retained in the database for 15 calendar days from the date of transmission. 

To find a provider's SPI number: 
1. In Chart, access the SureScripts Administration module (Tools > SureScripts Administration). 

2. Click the Provider Registration tab, click Show, and scroll to find the provider’s name.  The 
number is shown in the SPI column to the right of the provider’s name.  

 
Removing Stuck SureScripts Refill Requests 
From time to time, a clinic encounters a "stuck" refill request that cannot be approved or denied because 
it is linked to a medication that has already been fulfilled.  Solution Series provides a utility to remove 
such requests from your system.  Note that you can only remove this type of request if it is seven days 
(one week) or older.  This restriction is to reduce the chances of accidentally removing current requests 
that are not stuck or have not been filled yet.   

To remove stuck SureScripts refill requests: 
Privileges Required:  SureScripts Administration 
1. In Chart, access the SureScripts Administration module (Tools > SureScripts Administration). 

2. On the Overview tab, click I want to remove stuck refill requests. 

OR 

Click the Refill Request Admin tab. 

 
3. Click the down-arrow after the date field to display a calendar. 

https://supportcenter.e-mds.com/�
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4. Select an appropriate date for when the refill requests should be removed.  For example, by 
selecting a date of 12/21/2010, all refill requests dated before 12/21/2010 will be removed if this 
update is run.  The date must be at least seven days prior to the current date. 

5. Enter your login password to authorize the request removal process and click Run. 

A message screen, similar to the following example, will display indicating the number of requests 
prior to the selected date that have been removed (where 0 will be replaced with the actual 
number of requests that were removed and 2/9/2011 will be the date you selected on the Refill 
Request Admin screen). 

 
A record of the transaction will be tracked and listed on the Chart Audits report.  See e-MDs Reports User 
Guide for information on how to list and view this logged information. 

Unlinking SureScripts Refill Requests 
When electronic refill requests are received from a pharmacy, some refill requests are automatically 
linked by SureScripts and some will require manual linking.  If a linking error occurs, use the following 
steps to manually unlink a refill request from a Chart patient or medication. 

To unlink a SureScripts refill request: 
Privileges Required:  Scriptwriter: SureScripts Patient Linking 
1. At the bottom of the patient's Medication List grid, right-click the linked 

medication and select Unlink SureScripts Request.  The Unlink Refill 
Request dialog box will appear. 

2. To unlink the refill request from the medication only, select the 
Medication radio button.  The request will remain in the grid but will turn 
red to indicate the request is still linked to the patient but will require linking to a different 
medication. 

3. To unlink the refill request from both the medication and the patient, select the Patient & 
Medication radio button  The refill request will be removed from the patient's bottom grid and will 
appear in the Link Refill Request window.   

4. To link the unlinked refill request to a different medication or patient, follow the instructions in 
"Linking Electronic Refill Requests." 

A record of the unlinking action will be tracked and listed on the Chart Audits report.  See e-MDs Reports 
User Guide for information on how to list and view this logged information. 

Using Prescription Tools 
To ensure efficient handling of prescriptions and refills, Solution Series provides a number of tools to: 

• Track active prescriptions (Prescription Tracker) 

• List details of all current prescriptions for each patient (Refill Grid) 

• Check for allergies, drug-drug interactions, and drug-disease interactions (Automatic Allergy, 
Drug, and Drug-to-Disease Interaction Checking) 

• Calculate the appropriate dosage for each medication based on the patient's age, weight and 
diagnosis (Dose Calculator) 
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• List and view frequently prescribed medications (Quick Picks) 

• List prescriptions to be phoned in (Phone-In Script Module) 

• Reconcile medication lists (Medication Reconciliation) 

• Manage workflow (Refill Request Module) 

Prescription Tracker 
The Prescription Tracker is a feature to help keep track of the status of prescriptions by patient.  
Specifically the feature was intended to provide status information for electronic prescriptions but the 
functionality was extended to provide some feedback on all prescriptions no matter the send method.   

This module is opened by clicking the Tools menu in Chart and then selecting Prescription Tracker 
from the menu.  If you are in a patient chart when you open the Tracker the current patient’s information 
will be displayed in a grid as shown below.  If you are not in a patient chart when the Tracker is opened 
the grid will be blank and you can search for a patient using the Patient Search field. 

When the window opens the date range fields will default to today’s date but can be changed to view 
prescriptions written on other dates.  Information displayed in the grid includes the patient name, the 
prescription information (drug name, strength, sig, qty and refills), date, status and the submit method. 

 
• For Electronic prescriptions the status will display Successful if a successful acknowledgement 

was received from the pharmacy and Rejected if there was an error. 

• For Phone-In prescriptions the status will display Pending when the script is first sent to the 
Phone In module and Successful once the user (nurse or aide) has marked it as being phoned in 
to the pharmacy. 

• For Faxed prescriptions the status will always display as N/A in this version.  Currently, 
information on the status of faxes is not available. 

• For Printed prescriptions the status will always display as N/A.  While information that the script 
has been sent to the printer is available, information about whether the script actually printed is 
not (ex. the printer could be out of paper or have a paper jam). 
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Refill Grid 
The Refill Grid (Medication List grid) displays all Current Medications in a grid format and allows users to 
easily and quickly refill one, some or all medications with a minimum of clicks.   

The Refill List window buttons are described below.  The window also lists the medications from the 
Current Med List.  The medications are listed one per line in the grid.  There are twenty different columns 
for each medication and each column contains different information related to refilling the medication.  
These columns are described below. 

 

Medication List Window Options 
Toolbar Buttons and 
Other Options 

 

Save Saves and processes the medications that have been selected for refilling and any 
changes to the medications made in this module 

Cancel Cancels any refills and changes made to the medications in this module with the 
exception of discontinuing a med by using the Stop button.  Using the Stop button 
discontinues the medication instantly and the cancel button does not reverse this 
action. 

New This button opens the Prescribe a Drug screen (aka Drug Search) and the user can 
search for and then write a new prescription. 

Deny Allows the user to deny a refill.  This feature keeps an accurate record of the 
number of times that a patient requests a refill, even if that request is denied. 

Stop This button allows the user to discontinue a medication.  Medications can also be 
discontinued from the Current Med List. To Stop a medication, highlight it by clicking 
the name and then click the Stop button.  See Discontinue a Current Medication for 
details. 

Copy Allows the user to quickly and easily copy a med that is being refilled.  This is useful 
when patients have mail order pharmacies and you need to quickly write a 90 day 
supply as well as a short term script to be filled locally.  See the Copy a Prescription 
section for details. 

Sample Allows the user to document medication samples provided to the patient on the 
Medication List. 

Consult Opens the consult window for the selected medication.  To select a medication, 
check the refill check box to the left of the medication and click the Consult button 
OR simply highlight the med (without checking the refill box) and click the Consult 
button. 
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Link If an electronic refill request is received for a recognized patient, but a match cannot 
automatically be made to a drug in the patient’s list, this button will be active. An 
unmatched medication can be caused by a difference in a drug dose or name, and 
so forth. Click this button to open the Link Refill Requests window where you can 
manually link the requested medication to a drug in the patient’s medication list. 
Note:  If no match exists (for example, the request is for a drug the patient is not 
on), then you have the option to deny the refill request from within the Link Refill 
Requests window. 

Rx Calc This button opens the Dose Calculator. 
Help This button opens the help file. 
Legend This button opens the list of associated icons with explanations of what the 

represent. 
Padlock The padlock button in the Refill Grid turns the confidentiality feature off.  When this 

button is depressed (locked) any medications that are marked confidential will be 
blacked out and unreadable.  If a user needs to see a hidden medication while in the 
Refill Grid they can use the padlock to reveal the med.  
Within the Refill grid, user can only unlock the Lock button to view the medications. 

Medications Shown By default, only current medications are shown in the grid. To view earlier 
prescriptions, select Past.  Or, to view all prescriptions for the selected patient, 
select All. 

Label in Alternate 
Language 

This option allows you to select a different language for the label. To select a 
different language, click the check box, then use the drop-down list to select the 
language to be used. 

 
Column Headings/ 
Options 

 

Refill Check Box This is the first column and is represented by a check box or square at the top of the 
column.  The check boxes in this column are used to select the medications that are 
to be refilled.  You can select a single medication to be refilled by clicking the check 
box in that medication’s row.  You can select multiple medications by checking the 
check box next to each of the desired meds or you can select ALL meds to be 
refilled by checking the check box in the column header (at the top of the column).  
See the Refilling Prescriptions section for details. 

Itx Possible interactions or contraindications: If Drug Interactions between medications 
or between medications and a documented diagnosis exist an interaction icon will 
be displayed in this column next to the meds that interact.  See Display of Allergies 
and Interactions in the List for details. 

Al If Allergies or Adverse Reactions exist for a medication an icon will be displayed in 
this column.  See Display of Allergies and Interactions in the List for details. 

Fm Formulary Status (used by Formulary Benefits) Indicates whether the medication is 
part of the patient’s formulary. Icons indicate if the drug is approved, preferred, not 
in formulary, not reimbursable or status cannot be determined. 

Rk Formulary Preference Level (used by Formulary Benefits) - There can be multiple 
therapeutic alternatives within a drug class.  Alternatives are ranked from 1 to 99 - 
with higher values indicating a greater preference. 

 Coverage or CoPay Information Available (used by Formulary Benefits) Indicates 
that Formulary Coverage and/or CoPay information is available for this medication 
for this patient. 

Drug This column contains the brand or generic name of the medication. For over-the-
counter medications, the drug name will have a prefix of OTC.  

Form Strength This column contains the Form Strength of the drug.  This information includes the 
form of the drug (ex. Tablet, Capsule, Syrup, etc.) as well as the strength (Example:  
250mg, 5mg/ml, etc.). 

Sig The directions or sig for the prescription is listed in this column.` 
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QS This column represents Quantity Sufficient which is an abbreviation for instructions 
to the pharmacist to calculate the quantity of medication to dispense.  For example, 
QS for 10 days tells the pharmacist to calculate (based on the number of tablets or 
mls given according to the sig) a quantity of the medication sufficient to last 10 days.  
This field can be used in lieu of a quantity for the prescription.  It is used in 
conjunction with the Days Supply column. 

Qty/DS This column represents Quantity or Days Supply depending on whether the QS 
column is used.  If the QS column is NOT CHECKED (used) this column represents 
the quantity of medication that is to be dispensed.  For example, a Qty of 30 would 
represent that 30 capsules (or tablets, etc.) are to be dispensed.  If the QS column 
IS CHECKED then this column represents the number of days that are used by the 
pharmacist to calculate how much to dispense.  See the QS column description 
above for details. 

Units This column displays the either the units that are to be dispensed OR will display the 
word Days if QS is selected.  Units are the form of the drug that is to be dispensed. 
For example a prescription for a 250mg Tablet could display tablet(s) as the units 
while an ophthalmic drop might have choices for a 5ml bottle, 10ml bottle or 15ml 
bottle as the unit. 

#Rfs This column represents the number of refills associated with the prescription. 
C This column denotes whether the prescription is Chronic or Acute.  A check in the 

check box means the prescription is Chronic.  The preloaded prescriptions that 
come with the product are already correctly marked as Chronic or Acute but if a 
change needs to be made it can be done in this column. 

Sub? This stands for Substitution and denotes whether the provider will allow the 
prescription to be generically substituted or requires a brand name medication to be 
dispensed.  This field is always defaulted to allow substitution (the check box is 
checked). 

Sep This stands for Separate and denotes whether the prescription will print together 
with other prescriptions for the patient or on a separate sheet of paper.  A check 
mark in this field denotes that the prescription will print separately.  This can be set 
as a user option.  See User Preferences for Script Printing and Faxing for details. 
Note:  Some states require that ALL prescriptions be printed on separate pages. 
 

Send This column represents the send method for the prescription.  Send method can be 
Print, Fax, Electronic or Phone. 

Pharmacy If the Send method is Fax or Phone or Electronic, this column is used to pick the 
pharmacy to which the script is to be phoned or faxed or sent electronically. 

Note? This column will contain a Note icon (yellow sheet of paper) if there is an interaction 
or allergy note associated with the prescription.  Users can also add a note by 
clicking in the appropriate cell on the row of the medication that they want to add a 
note to.  When the note field opens the user has a choice of adding a note to the 
pharmacist that is printed on the face of the prescription (middle section of the form 
OR adding a note that is attached to the prescription and is strictly for internal use 
(bottom section of the form). 
Note:  If a note is being added to print on the prescription make sure the check 
box at the very top of the form labeled “Add the following warning message to the 
printed prescription” is checked. 

QP This column allows the user to create a new Quick Pick by clicking the check box.  
When the check box is clicked a menu appears that allows you to Add Personal 
Quick Pick, Add Organizational Quick Pick, Remove Quick Pick. (See Add/Edit 
Quick Picks for more details.) 
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Automatic Allergy, Drug, and Drug to Disease Interaction Checking 
During the process of prescribing medications, e-MDs Chart automatically checks for relevant patient 
allergies (or adverse reactions) as well as the Current Medication and diagnosis list for potential 
interactions. Appropriate warning messages and icons appear, as described below. 

Drug and Interaction Warning Messages 
When initiating a new prescription, the user selects a medication in the Script Writer. If the chosen drug is 
problematic, appropriate Drug Allergy (or Adverse Reaction), Drug-Drug or Drug-Disease Interaction 
warning messages will pop up. The prescription cannot be completed until a decision is made in the 
Warning window. 

Note:  Each drug interaction is classified by a level of severity (minor, moderate, major, and 
contraindicated). You can decide which levels of interactions should prompt a warning message (see 
“User Preferences for Script Writer” section for details).  

The warning message indicates the nature of the allergy, adverse reaction, or drug interaction. In many 
cases, if a drug interaction is the problem, precautionary measures are outlined.  If you plan to prescribe 
the medication despite the warning, you can check the Print Warning on Script box. This informs the 
pharmacist that the prescriber is aware of the potential allergy or interaction, alleviating the need for a 
phone call. 

In the drug interaction warning window you must select one of three buttons:  

• Cancel to cancel the prescription. 

• Ignore to ignore the warning and proceed with the prescription. 

• Ignore with Notes to proceed with the prescription and attach an explanation justifying the 
decision. 

Note:  Because warning icons are always visible (see below), the pop-up warning message only 
appears with the patient’s initial prescription, and not with refills. 

Drug and Interaction Warning Icons 
If a prescription is written despite a warning, it will appear in Current Medications preceded by an icon. At 
any time, users can click the icons to review the warning. 

Drug-Drug and Drug-Disease interaction warnings use the same icons: 

• A red or yellow triangle indicates an allergy or adverse reaction, respectively.  

• A colored circled represents a drug interaction (green is minor, yellow is moderate, red is major).  

• A red X identifies a contraindicated drug combination.    

• A blue circle represents duplicate medication. 

To review the meanings of the icons in Current Medications: 
1. Click the Display Legend button (the last button, with the blue question mark). 

If a justification note was attached to the prescription, a yellow notepad icon will appear next to 
the medication in Current Medications.  

2. Click the yellow notepad icon to read the note. 

Note:  So that all healthcare providers will be aware of potentially problematic medications or drug 
interactions, the icons in Current Medications cannot be hidden or turned off.  

Dose Calculator (Rx Calc) 
The Dose Calculator computes the therapeutic dose range for a selected drug (basing the calculation on 
age, weight, and diagnosis); displays minimum and maximum dose ranges based on the type of dose; 
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lists sigs linked to the selected drug, and indicates whether each selected sig falls within the therapeutic 
dose range calculated for that patient. 

Note:  Most pediatric drug dose range values are reported as mg/kg/day while ranges for many adult-
prescribed medications are given as mg/day. 

The Dose Calculator is accessed from the Medication List window of Script Writer. 

 

Dose Calculator 
Options 

 

Demographics These are retrieved from the patient’s chart and include Patient Name, Date of Birth 
(DOB), Age, and Gender. 

Weight This is the most recent recorded weight for this patient. Not all dose calculations 
(especially adult doses) require a weight. If no patient weight has ever been 
recorded (and weight is required for a calculation), the user receives an error 
message stating that a weight must first be recorded. If a weight is required for a 
calculation and the displayed weight is not current (i.e. was not collected today), a 
warning message about the weight displays. 
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Date weight collected Indicates when the weight used in calculation was collected. If the most recent 
weight was not collected the same day as the calculation, the Date appears in red 
text. 

 
Drug Name of drug selected from the medication list to be used in dose calculation. 

Form Strength If a form/strength was selected on the Medication List, it displays here. The user can 
also select the form strength (or change it) from here by using the drop down list.  A 
form strength must be selected to view dosing information. 
Note:  If you select certain form strength and then a specific diagnosis where 
there is no dosing information for that diagnosis, you will receive a message 
indicating “Using All Common Indication Dose Range.” 

Diagnosis The system defaults the Diagnosis field to the selection Common Diagnoses. 
Users can select a specific diagnosis from the drop down list to view different dosing 
information. Note that some dose range calculations do not require a specific 
diagnosis for computation. If the Script Writer Dose Calculator is accessed from 
within the Plan section of a Visit or Order Note, and a diagnosis was recorded in the 
note, the system attempts to match that diagnosis (if available) in the dose 
calculator. When a prescription is written under this diagnosis, that diagnosis will be 
linked to the prescription. 

Dose Type Selection Grid For the given diagnosis, select (click) the Type of Dosing (maintenance, 
prophylactic, etc.) for treatment using this medication. Note recommended dose 
ranges also display with each type. 

 
Calculated Daily Dose This displays the minimum and maximum daily dose range for the selected dosing 

type, diagnosis, and current patient’s weight. 
Available Sigs Grid Sigs displayed are those associated with the drug and Form/Strength selected. 
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Sig Range Indication Icons appearing in far left column of Available Sigs Grid indicate whether selecting 
that sig would provide the proper therapeutic dosing for that patient. Each sig is 
labeled as falling within, above, or below the Calculated Daily Dose; or, that the 
dose range cannot be determined from the information provided. The icons and their 
meanings are as follows: 

 Sig Within Therapeutic Range 
 

 Sig Below Therapeutic Range (sub-therapeutic dose) 
 

 Sig Above Therapeutic Range (high dose) 
 

 Unable to calculate. 

Any sig can be selected to prescribe whether it falls within, above, or below the 
therapeutic range. 

Patient Daily Dose This is the calculated daily dose in units/kg/day a patient would receive if that sig 
were selected. This value is based on weight. 

Total Daily Dose This is the total daily dose a patient would receive from the selected sig. Total Daily 
Dose is generally calculated by multiplying the selected drug strength by the dose 
frequency. 

To use the Dose Calculator: 
1. Confirm that a weight is documented in the patient record. 

If the most recent weight recorded for a patient is not current (i.e.: was not recorded the same day 
as the dose calculator is used), a warning displays. The user must decide if using a weight that 
was not collected today is appropriate. An old weight for adults or older children may or may not 
impact the dose calculation. For small children and infants, using an old weight could be 
significant if the patient’s weight has changed since the most recently documented weight was 
collected. 

 
If the provider chooses to continue, the most recent recorded weight is used in the calculation.  
If no weight has been recorded for the patient and the dose range calculation requires a weight, 
the same warning message appears. In this situation, the dose calculator still displays the 
Minimum and Maximum therapeutic dose range by dosing type, but cannot compute the 
Calculated Daily Dose nor display any sigs for selection. 

2. In the Medication List window of Script Writer, select a drug and click the Dose Calculator icon.  

A Form Strength must be selected in either the Medication List window or on the Dose Calculator 
before dosing information can display in the calculator.  
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3. If desired, select a different diagnosis (the default is “All Diagnoses”) in the Diagnosis field, then 
select the type of dose (single, maintenance, prophylactic, etc). 

 
4. Sigs documented in e-MDs Solution Series that are linked to the selected form strength/type of 

dose for this drug are displayed in the Available Sigs Grid.  To prescribe using one of these Sigs, 
click the desired sig, and then click Select. 
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To edit/insert sig window: 
Click the Edit icon  on a line of the Available Sigs grid to open the Edit/Insert Sig window.  

Note:  While you cannot edit the selected sig, you can edit and save the Total Daily Dose for that 
sig. Only user-entered Sigs (not those provided by e-MDs) can be edited.  

e-MDs is unable to calculate a Total Daily Dose (TDD) for user-entered sigs. Without a TDD, the dose 
calculation for these sigs cannot be performed.  To display whether a user-entered sig is in range or not, 
the user must edit the sig and add a TDD. 

To perform your own calculations without leaving this page, click the Calculator button to open another 
window containing a calculator to perform basic math functions.  Click Exit on the Calculator screen when 
you are finished with it. 

 
Example 
A 2 year old 20kg pediatric patient is being prescribed Amoxicillin 400mg/5ml for an ear infection (otitis 
media). On the Dose Calculator, the user selects a dose type of Maintenance which shows a therapeutic 
range of 20mg/kg/day to 90mg/kg/day. 
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The user wants to select the sig “Take 1 tsp by mouth bid for 3 days” but the range indication icon shows 
 (unable to calculate). The user clicks the Edit icon  to open the Edit / Insert sig window. 

 
Calculating  the total daily dose for this sig yields 800 mg/day (400mg X 2 =800mg/day), which is entered 
in the first Total Daily Dose field, and mg is selected as the unit of measure. Clicking Save updates the 
sig on the Dose Calculator. 

 
The selected sig now shows as within therapeutic range as indicated by the icon .  

 

Quick Picks 
Every provider has a list of most commonly prescribed drugs, and, in most cases, the prescription for a 
particular drug is written the same way every time. These common prescriptions can be saved ahead of 
time (or on the fly) as Quick Picks. A Quick Pick is a complete prescription, including directions (sig), 
amount dispensed, and refill authorization. A single drug can have multiple Quick Pick prescriptions, 
covering variations in dose or refills, for example. 

Quick Picks are saved in the drug database. When performing a drug search to write a prescription, 
matching Quick Picks will also be displayed in the search results. A Quick Pick can be selected, enabling 
the user to write the prescription with just one click!  

If a particular drug cannot be found in the drug search, the medication can be added by the user.  Also 
keep in mind that only medications added by the user can be edited or deleted. 

There are two types of Quick Pick: Personal and Organization. A Personal Quick Pick is available only to 
the person who created it and appears in regular black text. Organization Quick Picks can be accessed 
by all prescribers in the organization and are displayed in bold black text.  
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To create a Quick Pick ahead of time: 
1. In the Drug Search (Choose Medications) window of the Script Writer, search for drug by brand or 

generic name. 

2. Highlight the drug in the search results, click File in the toolbar, and select the Create Quick Pick 
menu option. 

3. Write the complete prescription in the Script Pad. 

4. Under Options, check either Personal Quick Pick or Organization Quick Pick. (By default, 
Personal Quick Pick will be checked, but this can be changed.) 

5. Click Save.  

To create a Quick Pick on the fly: 
1. Write a prescription normally (see Script Writer for details). 

2. Check the check box in the last column on the right labeled QP.  Choices are  

○ Add Personal Quick Pick (available only for your login) 

○ Add Organizational Quick Pick (available to all users)  

○ Remove Quick Pick 

Note:  The Remove Quick Pick choice is used to remove a Quick Pick that was inadvertently 
created during the current session and will not to delete an existing Quick Pick.  To delete an 
existing Quick Pick, see the next section. 

3. Make the appropriate choice from the menu. 

4. Click Save. 

To delete a Quick Pick: 
1. In the Drug Search (Choose Medications) window of the Script Writer, search for the Quick Pick 

drug by brand or generic name. 

2. Highlight the Quick Pick and click Delete on the tool bar. 

3. Click Yes in the Delete Confirmation window. 

To view all strengths and forms of a medication: 
1. In the Script Writer, search for a drug (see Search for a Drug for details).  Drugs matching the 

search criteria are displayed in the middle of the window, under the Drugs heading.  

2. Right-click to select a drug in the search results, and select the Show All Forms and Brands 
menu option. 

To view all other drugs in the same class as a medication: 
1. In the Script Writer, search for a drug (see Search for a Drug for details). Drugs matching the 

search criteria are displayed in the middle of the window, under the Drugs heading.  

2. Right-click a drug in the search results, and select the Show All Drugs in the Same Class menu 
option. 

To add a drug to the database: 
1. In the Drug Search (Choose Medications) screen, click File and select the Create Drug menu 

option. 

2. In the Add/Edit Drug window, type the drug name. 
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3. Click the yellow plus sign to add a Form/Strength (e.g. 250 mg tablet), a Dispensed Unit (e.g. 
tablets), and designate the schedule for a controlled/non-controlled substance. All fields are 
required.  

Note:  To edit a Form/Strength, click the pencil icon. To delete one, click the red minus sign.  

4. When finished, click Save.  

5. Repeat this step to add additional Form/Strengths. 

6. Click Save. Note that user-entered drugs will appear with an asterisk after the drug name- this 
cannot be changed. 

7. When writing a prescription for the newly added drug, common sigs (directions for taking the 
medication) can be added in the Refill Grid. 

To edit a user-added drug in the database: 
1. In the Health Summary, under the Current Medications header, click the Write New Script button 

on the right side of the Current Medications window. It is the top button, with the Rx pad icon . 
2. In the Drug Search (Choose Medications) screen, search for the drug to be edited. 
3. Highlight the drug name. 
4. Click File and select the Edit Drug menu option. 

The Add/Edit Drug window will open 
5. Change the name, edit the form strength or add a new form strength, as necessary. 
6. Click Save when finished. 

To delete a user-added drug in the database: 
1. In the Health Summary, under the Medications header, click the Write New Script button on the 

right side of the Current Medications window. It is the top button, with the Rx pad icon . 
2. In the Drug Search (Choose Medications) screen, search for the drug to be deleted. 
3. Highlight the drug name. 
4. Click File and select the Delete Drug menu option. 
5. Click Yes at the Delete confirmation warning. 

Phone-In Script Module 
The Phone-In Script module displays a list of prescriptions that were designated in Script Writer to be 
phoned in to a pharmacy. Sufficient information is presented to the user so that they can call a pharmacy 
and relay all the pertinent information that is needed to fill the prescription.  This allows you to use the 
module as an electronic work list for prescriptions. The module can also display a record of past 
prescriptions that have been phoned or faxed to pharmacies. 
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File Menu  
Options Options can be used to customize the behavior of the application to suit the needs 

of individual users. 
• Display Phone In Prescriptions count in red if greater than: This option can 

be used to set the behavior of the Phone In Scripts button in the Dashboard.  
When pending prescriptions are present for the selected provider (or providers) 
the Phone In Scripts Dashboard button will display the number of pending 
prescriptions for the selected provider(s).  Ordinarily this number shows up in 
black however users can use this preference to show the number in red if it 
exceeds a specified number.  For example a user can set this option to 10 and 
once the number of pending prescriptions reaches 11 the number displayed on 
the Dashboard button will appear in red.  This feature can be used as a prompt 
to the user to deal with items when they reach a certain workload. 

• Default HIPAA Compliance: A user can decide to display No Patient Name, 
Initials Only or Full Patient Name in the Patient column of the grid.  This is a 
common feature that is available in several of e-MDs applications and is useful 
for hiding or limiting the display of the patient name in situations where the 
computer screen can be seen by non-staff individuals such as visitors or other 
patients.  This option sets the preference for the default behavior of this feature.  
The user can still temporarily change the setting “on the fly” by clicking the 
desired HIPAA icon on the toolbar (see Toolbar section) and this choice will be 
maintained as long as the current session of the application is open.  But if the 
application is closed the setting will always return to the default the next time it 
is opened.  The default setting for this feature is initially set to No Patient Name 
but can be changed by clicking the radio button next to the desired choice.  

Exit The exit menu choice will close the application. 
 

Help Menu  
Search Topics Selection of this choice will open the built in help files and allow users to search for 

help on specific topics. 
About Selection of this choice will display a screen that shows the current version number 

of the application.  This information can be helpful when tracking down problems 
and may be asked for by the support department. 

 

Toolbar Items  
Search The search button will perform a search and return only the scripts that need the 

search criteria that has been entered into the Patient Last Name and/or the 
Pharmacy Name fields on the toolbar. 

Exit The exit button choice will close the application. 
Help Selection of this choice will open the built in help files and allow users to search for 

help on specific topics. 
View Users can choose to view Phone script, Fax scripts or Both by making a choice from 

the dropdown menu. 
Status Users can choose to view prescriptions that have note been dealt with (Not Done), 

that have been dealt with (Done) or Both. 
Show Patients for This field allows the user to select the provider or providers whose information will 

show up in the Phone In Scripts grid.  See Set up Options for details. 
Patient Last Name Typing a patient’s last name into this field and then pressing the Search button or 

the Refresh button will filter the records to only show prescriptions for that patient (if 
they exist). 

Pharmacy Name Typing a pharmacy name into this field and then pressing the Search button or the 
Refresh button will filter the records to only show prescriptions that are marked to be 
called in to that pharmacy (if they exist). 
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Filter by Date If the check box in this field is checked, the date fields become enabled.  Type in a 
Start and End date and then press the Search or Refresh buttons to only show 
prescriptions that fall into that date range. 

HIPAA This feature consists of a set of three icons that allow the user to select how the 
patient’s name will be displayed in the grid.  A user can decide to display No Patient 
Name, Initials Only or Full Patient Name by click the first, second or third icon 
respectively. 

Refresh Pressing this button will manually refresh the data in the grid. 
Order By This section determines how the grid is sorted.  By default it is set to filter first by 

pharmacy name and then by patient’s name. The Provider Name, Prescription Date, 
Submit Method and Status are additional filters that can be set. The filter that 
appears in the first drop down is the primary sort filter. For example with the default 
setting the grid sorts with the Pharmacy first so that all prescriptions for pharmacy A 
appear first and then pharmacy B, etc. The patient name is the secondary filter so 
that within pharmacy A’s list the prescriptions are sorted by patient so that all of 
patient X’s scripts are together.  This makes it easier to work down the list so that 
users can call pharmacy A and give all the prescription information for patient X and 
then the next patient, etc. 
Note:  In addition to sorting the grid by using the Order By fields, users can also 
click the header of each column to sort by that column.  For example, click the 
column header labeled Patient to sort by patient name in alphabetical order starting 
with A (click the header again to sort in descending order starting with Z). 

 
Grid Columns  
Done This column displays information about whether the prescription has been dealt with 

or not. 
Note:  The prescriptions marked as Fax do not display Done information at this 
time. 

Date This column displays the date the prescription was written 
Prescription Displays the complete information about the prescription (the drug name, quantity, 

directions, refills, etc.) that is needed to call it in to the pharmacy. 
Brand Displays whether the provider is requiring a Brand drug or not.  If the column 

contains a check mark then the provider is requiring that the patient be given a 
brand rather than a generic drug. 

Prescriber Contains the name, license and DEA number (if required) of the provider prescribing 
the med. 

Patient Contains the patient’s name and date of birth. 
Pharmacy Contains the pharmacy name, address, phone and fax number. 
Notes Displays any notes related to the prescription. 

Setting Up Options 
There are some options that need to be set up before using the Phone In Scripts module.  These options 
will allow the application to be customized per user.  

Show Patients For 
• Non-provider: When a non-provider logs in to the Phone In Scripts module the “Show Patients 

For” field will default to (None) meaning that no providers are selected and the list of prescriptions 
designated to be phoned in to pharmacies will be empty. To monitor for phone in scripts the non-
provider user must select one or more providers from the drop down list in the “Show Patients 
For” field.  To do this, simply check the check box next to the name or names of the providers to 
be monitored.  Once this has been done the changes will be retained the next time the user logs 
in.   
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• Provider: In the case of a provider logging into the Phone in Scripts module the “Show Patients 
For” field will be defaulted to the provider that is logged in.  This allows providers to monitor their 
own list of phone in prescriptions.  If the provider needs to monitor other providers lists they can 
choose the other providers to monitor by selecting the provider name(s) from the drop down list in 
the Show Patients For” field.   

HIPAA Display 
Users can set up the module display to not show patient names, to only show patient initials or to 
show the full patient name.  To set up the default behavior of the HIPAA Compliance feature click File 
then Options and in the options screen select the appropriate compliance level.  This will become the 
default setting whenever the user logs in.  Changes can be made on the fly using the HIPAA buttons 
on the module toolbar but when the user logs out or when the system refreshes the setting will return 
to the default. 

Workload Display 
The Phone In Script module displays the number of pending scripts on its Dashboard button.  Users 
have the option to display this number in red if it exceeds a specified number (for example if there are 
more than 15 Phone In Scripts for the provider being monitored the user can set the option to turn the 
number red).  To set this up click File then Options and in the “Display Phone in Prescriptions Count 
in Red if greater than” field enter the desired number. 

Search Criteria 
When the Phone-In Scripts window is opened, the search criteria defaults to the settings listed below. 
These settings can be changed at any time. 

• Date Written is set to today’s date 

• Submit Method is set to Phone (versus Fax or All) 

• Status is set to Not Done (versus Done or All) 

• Order By is set to filter first by pharmacy name and then by patient’s name. The Prescriber Last 
Name, Patient Last Name and Pharmacy name are additional filters that can be set. For example, 
to search for a particular patient’s prescription, type the patient’s last name in the Patient Last 
Name box and then click Search. A list of scripts specific to that patient will be displayed.  

To add a prescription to the Phone-In List: 
1. When writing a prescription, select Phone in the Send Options. (see the Script Writer section for 

details.)  

2. A pharmacy field will become enabled. Type a pharmacy name or click the down arrow to select 
the pharmacy to which the prescription will be phoned in. 

Note:  If the patient has a DEFAULT pharmacy designated, the pharmacy field will be filled in 
automatically. 

3. It helps to add frequently used pharmacies (and their phone numbers) to the database ahead of 
time (see the Add/Edit/Delete Pharmacies section for details about adding pharmacies to the 
database). 

4. The prescription is then automatically routed to the Phone-In Script module.  

To use the Phone-In Scripts module: 
1. Click the Phone In Scripts button in the Dashboard 

OR 

In the main e-MDs Chart toolbar, click Tools and then select the Phone-In Scripts menu option. 
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The Phone-In Scripts window will open with a list of prescriptions written today and designated to 
be phoned in. 

2. Review the information for each prescription, including the date the prescription was written, 
prescription information (drug name, strength, quantity, directions, and refills), prescriber’s name, 
patient’s name, pharmacy name, phone number and fax number (if included when adding the 
pharmacy to the database), and notes.  This is the information you will give the pharmacy during 
the phone call. 

3. To add an internal-use-only note to the prescription entry, click the note section of the prescription 
entry to pop up the Notes screen. 

4. Type your comments in the bottom notes section and click OK to save the changes.   

The information entered in this section will be visible only at your facility and will not be printed on 
the outgoing prescription.  This note is permanently attached to the prescription and can be 
viewed from the Current Medications list. 

5. After calling in a prescription, click the check box in the Done column.   If you click the Search 
button to refresh the screen, all prescriptions that are marked as Done will be removed from the 
active phone-in prescriptions list. 

6. Click Exit to close the module when all tasks are complete. 

Reconciling Medication Lists 
When a patient is treated by providers from different facilities (specialists, other clinics, hospitals and so 
forth), different or additional medications may be prescribed for that patient.  To ensure that medications 
do not overlap or result in conflicts, a medication reconciliation should be performed during any transition 
period when care changes from one provider to another.  Solution Series provides a set of tools for 
importing external medical lists, comparing medications, adding medications to the patient's Current 
Medications list, discontinuing medications, and modifying medication strength and dosage, as needed.   

Importing Different Types of Medication Lists 
Because medication lists may come from multiple sources, multiple types of files can be captured and 
displayed for reconciliation.  This includes text-based XML files from SureScripts and RxHub, CCD, C-
CDA and CCR XML files.  Imported files may also be image files that contain non-text information that 
can be displayed for viewing and printing.  This includes files such as tiffs, MS Word files, PDFs and other 
images of documents or records that have been scanned into a system and transmitted.  

After medication lists are imported, users can compare the current medication list and the imported list to 
determine what is different.  This manual comparison is started by displaying the imported medication list 
in a viewer that is appropriate for the type of file imported (such as Acrobat for a .pdf file, MS Word for a 
.doc file, and so forth). 

Tracking and Reporting Medication Reconciliation Activities 
When you perform a Medication Reconciliation, the information will be captured in the Chart Audit trail.  
The Chart Audit trail includes information about the following: 

• Medications that have been documented in the patient's Current Medication list as a drug 
selected from the database, a free-text drug, or a sample drug. 

• Changes to dosage that occurred when existing prescriptions were edited. 

• Medications that have been stopped.  

Performing a Medication Reconciliation 
The Medication Reconciliation is performed from the Clinical Reconciliation window.   

To import a medication list from DocMan: 
1. In the patient's chart, click the Visit/Hs tab to show the Health Summary. 
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2. Click the plus sign (+) before the blue Current Medications label to expand the patient's 
medication list. 

3. Click the Med Rec button to open the Clinical Reconciliation window. 

The Clinical Reconciliation window will open to display the patient's current medications in the 
screen's left pane.  You can click the column headings to sort the list. 

Note:  To show past medications instead of current medications, click Past. 

4. Choose Import from DocMan to open the DocMan Fax Filing window. 

5. Click the name of the medication list file to be imported and click the green check mark icon to 
import the list. 

Depending on the type of file selected, the imported file will display in the right pane of the Clinical 
Reconciliation screen or a new window will open to display the file. 

6. Review the list of imported medications to identify medications that should be added to or deleted 
from the Current Medications list and medications that need to have their strength, dosage, or 
directions changed. 

7. Continue with To add, modify or discontinue drugs to make any necessary adjustments to 
reconcile the two medication lists. 

8. If no changes are needed, click Reconcile Medications at the bottom of window to retain the 
Medication Reconciliation results and close the window. 

To import a list from the Medication History: 
1. In the patient's chart, click the Visit/Hs tab to show the Health Summary. 

2. Click the plus sign (+) before the blue Current Medications label to expand the patient's 
medication list. 

3. Click the Med Rec button to open the Clinical Reconciliation window. 

The Medication Reconciliation window opens, displaying the patient's current medications in the 
screen's left pane.  You can click the column headings to sort the list. 

Note:  To show past medications instead of current medications, click Past. 

4. Choose Import from Medication History to open the RxHub window.  The Consent Selection 
Form box opens. 

5. Select the appropriate consent options and click OK to import the Medication History.  The 
Medication History appears in the right pane of the Medication Reconciliation screen. 

6. Review the list of imported medications to identify medications that should be added to or deleted 
from the Current Medications list and medications that need to have their strength, dosage, or 
directions changed. 

7. Continue with To add, modify or discontinue drugs to make any necessary adjustments to 
reconcile the two medication lists. 

8. If no changes are needed, click Reconcile Medications at the bottom of the window to retain the 
Medication Reconciliation results and close the window. 

To add, modify or discontinue drugs: 
1. After importing a medication list from either DocMan or the Medication History, review the list of 

imported medications. 

2. To add a medication to the list, click the Add button. 

OR 
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To modify a current medication (such as the dosage or strength), select the drug name and click 
the Edit button. 

OR 

To stop a current medication, select the drug name and click the Stop button. 

After selecting the icon, you will be taken to the Chart screen normally used to perform the 
selected task.   

3. Use the normal procedure for documenting a drug in the Current Medication list.  See Script 
Writer for more information. 

4. Click Reconcile Medications to retain the changes and close the window. 

Refill Request Module 
The Refill Request module is a workflow enhancement tool that provides an “at a glance” view of all 
prescription refill requests by one or more providers.  The requests are displayed in a grid similar to a 
spreadsheet.  Users are able to not only view requests but, by double-clicking a row, they can open the 
refill request and deal with it directly within the patient’s chart.   

Users can monitor lists for one or more providers at one time.  This allows clinical staff to work with 
multiple providers and for providers to cover for each other during vacations or other times when 
providers are out of the office. 

The Refill Request module also works in conjunction with the Chart View section of the patient’s chart. 
Within the Chart View section the Medications subsection now contains information about refill requests.  
When a user deals with a refill request from within the Refill Request module, a link between the request 
and the patient chart take the user directly to the Chart View section and displays the current medication 
list along with a list of medications that are being requested for refill. Since the user is taken directly to the 
patient’s chart, any additional information that needs to be reviewed is quickly available to the user. 

Understanding the Refill Request Module Interface 
The Refill Request module displays information about requested prescription refills in a grid display much 
like a spreadsheet.  The information is displayed by patient per provider so that only one record per 
patient will be displayed for a single provider although a patient’s name may appear more than once if 
they have made requests to more than one provider. 
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Menu Items 
Menu items appear as words across the top of the application starting at the top left corner.  Clicking a 
menu item will open a pop-up list of choices associated with the menu.  The menu item choices for the 
Refill Request module are listed below.  

File Menu  
Options The options menu choice will open the options window to allow the user to set 

preferences for how they want the program to work.  The choices for display options 
are listed below. 
Note:  Changes to the options screen are login specific and will not affect 
other users display. 

• Provider Setup:  In order to be able to add a refill request or refill a 
prescription, users MUST set up their list of providers (providers must set 
themselves up in this section as well).  This option allows users to select 
the provider or providers that they work with and to provide a short name or 
nickname for the provider if desired. 

• Display Refill Request Count in Red if greater than X:  This option can 
be used to set the behavior of the Refill Request button in the Dashboard.  
When requests are present for the selected provider (or providers), the 
Refill Request Dashboard button will display the number of refill request for 
the selected provider(s).  Ordinarily the number of refill requests shows up 
in black however users can use this preference to show the number in red 
if it exceeds a specified number.  For example a user can set this option to 
10 and once the number of refill requests reaches 11 the number displayed 
on the Dashboard button will appear in red.  This feature can be used as a 
prompt to the user to deal with items when they reach a certain workload. 

• Automatic Refresh:  The information in the grid can be refreshed 
manually by clicking the Refresh button on the toolbar (see toolbar section) 
but the information is also set to refresh on an automated schedule.  The 
default setting is for 2 minutes and cannot be set lower than that but it can 
be changed to a larger number.   

• Default HIPAA Compliance:  A user can decide to display No Patient 
Name, Initials Only or Full Patient Name in the Patient column of the grid.  
This is a common feature that is available in several of e-MDs applications 
and is useful for hiding or limiting the display of the patient name in 
situations where the computer screen can be seen by non-staff individuals 
such as visitors or other patients.  This option sets the preference for the 
default behavior of this feature.  The user can still temporarily change the 
setting “on the fly” by clicking the desired HIPAA icon on the toolbar (see 
Toolbar section) and this choice will be maintained as long as the current 
session of the application is open.  But if the application is closed the 
setting will always return to the default the next time it is opened.  The 
default setting for this feature is initially set to No Patient Name but can be 
changed by clicking the radio button next to the desired choice. 

Exit The exit menu choice will close the application. 
 
Find Menu  
Search The Search function is not currently being used. 
New The New menu item will open the patient search screen to start a new request. 
Edit The Edit menu item will open the highlighted refill request in edit mode. 
Select The Select menu item will open the highlighted refill request and it will open in Refill 

mode. 
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Help Menu  
Search Topics Selection of this choice will open the built in help files and allow users to search for 

help on specific topics. 
About Selection of this choice will display a screen that shows the current version number 

of the application.  This information can be helpful when tracking down problems 
and may be asked for by the support department. 

 
Toolbar Items  

New  The New button will open the patient search screen to start a new request. 

Edit  The Edit button will open the highlighted refill request in edit mode. 

Select  The Select button will open the highlighted refill request and it will open in Refill 
mode. 

Search  The Search function is not currently being used. 

Help  The Help button opens the built in help files 

Exit  The Exit button choice will close the application. 

Medical Facilities This field lists the medical facilities the logged-in user is authorized to access. 
Providers (Show Patients 
for) 

This field allows the user to select the provider or providers whose information will 
show up in the Refill Request grid.  When a provider logs in, this field should default 
to the name of the provider logged in.  If a non-provider logs in the field will default 
to having no names selected.  In either case, once the user is logged in they can 
select one or more providers from the dropdown list by checking the box to the left 
of the name.  Once selection of the name(s) is completed clicking outside of the 
dropdown box will refresh the grid and show the refill requests for the selected 
provider or providers.  A selection for All Providers is also available and may be 
handy for an administrator to monitor the information on a clinic wide basis.  The 
selection of multiple providers allows users to monitor refill requests for multiple 
providers. In the case of non-providers, this may be necessary when a nurse or 
assistant is working with multiple providers and monitoring pending refill requests for 
them.  In the case of providers this feature may be necessary when the provider is 
covering for another provider that is out of the clinic or when a provider is 
supervising physician extenders or residents. 

Date Range Filter By default the Refill Request grid displays ALL requests for the selected provider or 
providers.  Use of the Date Range Filter allows users to choose to see only the 
requests for the selected date range. 

HIPAA Patient Display This feature consists of a set of three icons that allow the user to select how the 
patient’s name will be displayed in the grid.  A user can decide to display No Patient 
Name, Initials Only or Full Patient Name by click the first, second or third icon 
respectively.  This is a common feature that is available in several of e-MDs 
applications and is useful for hiding or limiting the display of the patient name in 
situations where the computer screen can be seen by non-staff individuals such as 
visitors or other patients. 
Note:  The use of the HIPAA Patient Display icons is an “on the fly” feature and 
will only change the display temporarily.  The default setting for this feature is initially 
set to No Patient Name and changing the display via the buttons will only change 
the setting temporarily. The setting will revert to the default display setting on a 
refresh of the screen.  The default setting can be changed permanently in the 
Options screen of the Refill Request module (see Options).  Changes to the options 
screen are login specific and will not affect other user’s display. 
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Refresh The Refresh button redraws the screen and update any information that has 
changed since the module was opened or since the last refresh occurred.  Most 
actions that are taken within the Refill Request module will cause a refresh of the 
screen automatically but there may be occasions when a manual refresh is desired.  
In addition there is an automatic refresh of the screen that occurs based on a user 
specified time period.  The automatic refresh rate can be set in the Refill Request 
Options screen (see Options).  Changes to the Automatic Refresh rate are login 
specific and will not affect other users refresh rate.  The default refresh rate is set to 
2 minutes and while this value can be changed to a longer time frame it cannot be 
changed to a setting less than 2 minutes. 

Legend The Legend button accesses a list of icons that appear in the application along with 
explanations of what those icons represent. 

Unlinked Electronic Refill 
Request Available 

This message appears in red when unlinked requests are available for processing.  
When no unlinked requests are active, the message will appear in gray.  Click the 
red message or the Link Refill Requests button to open the Link Refill Request 
screen to manually link the available requests. 

Link Refill Requests This button opens the Link Refill Request window. This window allows users to 
manually link refill requests that cannot automatically be matched to a patient 
because of incomplete or contradictory information. This feature is only used in 
conjunction with electronic Refill Requests.  These electronic refill requests are 
initiated by a pharmacy and sent over a secured connection via the Internet. Refill 
Requests sent in this manner may not have sufficient patient identifiers to allow e-
MDs to positively identify the patient.  Any requests received that cannot be 
matched to the patient will show up in this section and a message indicating 
Unlinked Electronic Refill Requests Available will appear on the View Refill 
Request screen.  Click the message or the Link Refill Requests button to display the 
Link Refill Requests screen and manually match the patient on the request to a 
patient in the clinic database.   
Note:  The unlinked refill message will appear in red and be clickable only when 
unlinked requests currently reside on the system.  The Link Refill Request button is 
continuously active to allow you to open the Link Refill Requests screen at any time. 

Include inactive providers 
in list 

This option allows you to include inactive providers in your search to ensure that all 
possible providers can be found.  This is particularly important when processing 
prescription refills that may have been issued by providers who are no longer active 
in the practice. 

 
Grid Columns  
Priority When a refill request is created users have the choice of setting a priority status to. 

This status defaults to Normal but can be changed to Urgent or Stat.  When a 
priority setting other than normal is set an icon will be shown in the Priority column 
to draw attention to the request.  If the priority status is Normal this column will not 
display an icon.  If the priority is set to Urgent the column will display a single 
exclamation point icon .  If the priority is set to Stat the column will display a double 
exclamation point icon . 

Status Requests can be marked as “Unfinished” to denote that more information needs to 
be collected or some other issue needs to be dealt with before the request is ready 
to be refilled.  When a request is marked as “Unfinished” a clock icon will appear in 
the Status column of the request . 

Date This column displays the date that the refill request was created. 
Patient Name This column displays the name of the patient. 
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Pending Refills This column displays the number of medications that are queued up for refill for the 
patient listed.  This number is based on the requests made by a patient from a 
specific provider.  If a patient has requests for refill with different providers then the 
patient’s name would appear in the grid more than once with the number of refills 
per provider showing in the column.  For example if a patient has a request from Dr. 
Jones for one prescription and from Dr. Smith for two prescriptions then there would 
be two records in the refill request grid for the patient, one with the number one in 
the Pending Refills column and another with the number two displayed. 

Provider Name This column displays the name of the provider that the request is assigned to. 
Date of Last Appointment This column displays the date of the patient’s last scheduled appointment. 
Date of Next Appointment This column displays the date of the patient’s next scheduled appointment. 

  
Legend Icons  

 Urgent A single exclamation point icon in the Priority column means that the request has an 
urgent status. 

 Stat A double exclamation point icon in the Priority column means that the request has a 
stat priority status. 

 Note Attached A yellow piece of paper icon means that the request has a note associated with it. 
These notes are generated by the pharmacy and are only associated with electronic 
refill requests. The icon only shows in the Request Medication and Refill Medication 
subsections of Chart View. 

 Unfinished Request A clock icon means that the request requires that more information needs to be 
collected or some other issue needs to be dealt with before the request is ready to 
be refilled. 

 Refresh The refresh icon on the toolbar will refresh all the information in the grid when 
pressed. There is a built in auto refresh function but at times a manual refresh may 
be desired. 

 Display without Patient 
Names 

When this button is pressed the patient name will NOT be displayed in the Patient 
Name column of the grid. This is part of the HIPAA security module. 

 Display with Patient 
Initials 

When this button is pressed the patient’s initials will be displayed in the Patient 
Name column of the grid.  This is part of the HIPAA security module. 

 Display with Patient 
Name 

When this button is pressed the patient’s full name will be displayed in the grid.  This 
is part of the HIPAA security module. 

Sorting the Columns in the Grid 
The columns in the Refill Request grid are sorted by Priority, Status and then Date.  If there are any items 
marked as Urgent or Stat then they will show up first.  If there are no Priority items then any items marked 
with a Status will be listed first.  If there are no Priority or Status items then the requests will be listed by 
date with the oldest listed first.   

Columns can be sorted by the other columns as well in order to make information easier to locate.  For 
example to sort patient names by alphabetical order click the column labeled Patient Name (the header).  
This will sort the patient last names in an ascending alphabetical order (from A to Z).  Clicking the column 
header again will re-sort the list in descending alphabetical order (from Z to A).  Each of the columns can 
be sorted in this way by clicking the header of the column. 

Accessing the Refill Request Section of Chart View 
With the advent of the Refill Request module new subsections under the Medication section of Chart 
View have been added.  These new subsections of Medications are called Request Medication and Refill 
Medication and can be access on the Medications tab via radio button choices labeled Request 
Medication and Refill Medication.  When a record in the Refill Request grid is double-clicked, the 
associated patient’s chart is opened to the Refill Medication section of Chart View and when a new 
request is added or when request is edited the patient’s chart is opened to the Request Medication 
section.  In addition these new sections can be accessed anytime the user is in the Chart View section by 
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clicking the Medications tab and then selecting the Request Medication or Refill Medication radio button.  
When the Request Medication radio button is selected, it will display the patient’s refill request list. When 
the Refill Medication radio button is selected, it will display the patient’s current meds in the upper Grid 
and the request in the lower grid.  All of the functionality of the Refill Grid is present in the Refill 
Medications section just as if you were filling prescriptions from the Current Medications list in the Health 
Summary section of the patient’s chart. 

Using the Refill Request Module 
It is very important the all users set user preferences for themselves before beginning to use the Refill 
Request module.  It is important to set up the Provider List, which lists the physicians under whose name 
the requests will be made. If this preference is not set up users will have to search for the provider name 
each time they add a request to the module.  When the Provider List is filled out the user simply has to 
choose a provider from a drop down list.  In addition to the Provider List users must set up the “Show 
Providers For” list. This list filters the requests and only shows those that are for the provider or providers 
set up in the Show Providers For list.  If the user is a provider the list should default to their own name.  
However if the user is not a provider the list will default to show no names and will have to be set up.  For 
details on setting up each of these lists, please see the next two sections. 

Other items that may require setup are the Display Refill Request Count in Red if Greater Than X, the 
Refresh Rate and the HIPAA Compliance setup.  All these items except for the Show Providers For 
preference are part of the Options section of the Refill Request module.  See the Setting Up Options 
section for details about these preferences. 

Setting Up a Provider List 
The provider list is a short list of providers that can easily be selected to request a refill from. The Provider 
List is intended to be a fast and easy way for a user to pick a provider. It is very important that this list be 
set up before using the Refill Request module because otherwise the user submitting the request will 
have to search for a provider each time a request is made.  The search process is much slower than just 
picking the provider from a short list.   

Notes:   
• Once the provider list is created it will only show up in the Request Medication subsection of the 

Chart View section of a patient’s chart.  

• All lists are user specific and the list will only be accessible by the person that created it. 

To set up a provider list: 
1. On the main menu bar of the Refill Request module, click File then select Options from the pop-

up menu. The Primary provider s window will open. 

2. Locate the six drop-down fields labeled Provider 1 through Provider 6 at the screen left. 

3. To set up the first provider in the list, click the down arrow in the Provider 1 drop-down list.  A list 
of staff providers will appear. 

4. Select the name of the desired provider and it will populate the field.  Notice that, when the 
provider name is selected, the short name field to the right will also be populated by the same 
name. 

5. OPTIONAL: To set up a short name (a nickname) for a provider, click in the Short Name field and 
type in a new name (for example: Dr. B for Dr. Barnard, etc.) 

6. Set up the next provider by filling out the Provider 2 field and so on.  A total of six providers can 
be set up in this manner. 

7. Click Save when finished. 

Setting Up the Provider Field (Show Providers For List)  
This field allows the user to select the provider or providers whose information will show up in the Refill 
Request grid.  It is very important to set this list up since the Refill Request grid will only show requests for 
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those providers selected in the Show Providers For list.  If at least one provider is not selected the refill 
request grid will remain empty. 

By default, when a provider logs into the Refill Request module this field it default to show the name of 
the provider logged in.  If a non-provider logs in, the field will default to having no names selected.  In 
either case, once the user is logged in they can select one or more providers from the dropdown list by 
checking the box to the left of the name.  Once selection of the name(s) is completed clicking outside of 
the dropdown box will refresh the grid and show the refill requests for the selected provider or providers.  
A selection for All Providers is also available and may be handy for an administrator to monitor the 
information on a clinic wide basis.  The selection of multiple providers allows users to monitor refill 
requests for multiple providers. In the case of non-providers, this may be necessary when a nurse or 
assistant is working with multiple providers and monitoring pending refill requests for them.  In the case of 
providers this feature may be necessary when the provider is covering for another provider that is out of 
the clinic or when a provider is supervising physician extenders or residents. 

Note:  All lists are user specific and the list will only be accessible by the person that created it. 

To add providers to the Show Providers For list: 
1. On the Main toolbar of the Refill Request module, click the drop-down labeled Providers. 

A list of all staff providers in the clinic will appear with a check box to the left of each name. 

2. Click the check box next to the desired provider. 

Note:  Multiple providers can be selected by clicking the check box next to more than one name. 

3. A selection for All Providers is included to make it easy to monitor requests for all providers if 
necessary. 

4. Once all desired provider names are selected click anywhere outside the list (or the Refresh 
button) to refresh the grid. 

5. If refill requests exist for the provider or providers selected they will appear in the grid. 

Setting Options   
It is important to set up preferences for how the Refill Request module will perform.  These preferences 
can be found in the Options section of the Refill Request module.  It is not absolutely necessary to set up 
all of these preferences although it is highly recommended.   

Refill Request Options  
Display Refill Request 
Count in Red if Greater 
Than 

The Dashboard button for the Refill Request module will display the number of 
request that are pending for the providers set up in the Show Providers For field.  
This number can be set to display in red if the number exceeds a specified amount. 
This can provide a non-intrusive alert to a user about a possibly heavy workload. 

Refresh Rate There is an automatic refresh rate which will redraw the screen and update any 
information that has changed since the module was opened or since the last refresh 
occurred.  This refresh rate is set to 2 minutes by default and cannot be changed to 
a lower number but can be changed to a higher one.  Setting a higher refresh rate 
may be desired if there is a lot of traffic on the network and response times are slow.  
Constant refresh of any module that queries the database for a significant amount of 
information can case slowdowns in some cases. 

Default HIPAA Setting This feature allows the user to select how the patient’s name will be displayed in the 
grid.  The choices are to display No Patient Name, Initials Only or Full Patient 
Name.  Settings can be changed on the fly using the buttons on the toolbar but a 
choice can be set as the default in the Options screen. 

In order to filter your choices of providers for whom you will create a refill request, you should set up your 
Provider list as described below.  If you do not set up this list, you will still be able to select a provider but 
it will be from an unfiltered list of all providers. 
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To set up the Display Refill Request Count in Red if Greater Than: 
1. On the main menu bar of the Refill Request module, click File then select Options from the pop 

up menu.  The Primary provider s window will open. 

Below the Provider drop-down list there is a section labeled Display Refill Request Count in 
Red if greater than.  The default setting for this field is 0, meaning that any refill request will 
cause the Dashboard button to display the count in red, so it is important to change the number. 

2. Type the desired number in the field to set the count. 

3. Click Save when finished. 

To set up the refresh rate: 
1. On the main menu of the Refill Request module, click File then select Options from the pop-up 

menu.  The Primary provider s window will open.   

The second option from the bottom is the Refresh rate.  The default setting is for the module to 
refresh every 2 minutes. 

2. Type a number in the Refresh field to reset the rate. 

3. Click Save when finished. 

To set up the default HIPAA setting: 
1. On the main menu of the Refill Request module, click File then select Options from the pop-up 

menu.  The Primary provider s window will open. 

At the bottom of the window is the HIPAA compliance setting consisting of three radio buttons. 
The default setting is to not show any patient information but can be changed by clicking one of 
the other radio buttons. 

2. Select the desired setting by clicking one of the radio button choices. 

3. Click Save when finished. 

Short Names 
When setting up a Provider List for selection of provider name for refill requests, users have the choice of 
setting up Short Names.  These are nicknames that will appear in the Primary Provider List instead of the 
provider’s full name.  When a provider is added from the provider dropdown in the Options window, the 
Short Name field will default to the same as the Provider field (which shows up in LastName, FirstName 
format).  The Short Name feature allows users to reformat the name in any way they wish.  For example 
with a provider named Dr. Christian Barnard the default format would be Barnard, Christian but could be 
changed to Dr. Barnard, Dr. B, Christian, etc.   

To set up a short name: 
1. Click File on the menu in the Refill Request module, then select Options from the pop-up menu. 

2. Select a provider from the Provider drop-down list. 

3. The Short Name field will default to the provider name in LastName, FirstName format. 

4. To set the Short Name, type the desired name into the Short Name field to replace what is there. 

Adding a New Request 
New requests for a refill can be added directly within the Refill Request module OR from within the 
DocMan application. 

Some requests come in from pharmacies via fax.  DocMan can be set up to receive faxes electronically 
and when that happens users may need to access the Refill Request module while viewing the fax.  
DocMan now has access to the Refill Request module in order to accommodate this need. 
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To add a request in the Refill Request Module: 
1. On the main Refill Request toolbar, click the New button.  A patient search screen will open. 

2. Type in all or part of the patient’s last name and press the Enter key or click the Search  
button. 

3. In the Search results list, click the patient name and click the Select button OR double-click the 
patient name. 

4. The patient’s chart will open to the Request Medication subsection of Chart View. 

5. Select the provider under whose name the request is being made.  To do this, click the drop-
down arrow at the Primary provider field to open the Provider list.  

Note:  You must have your Provider List set up in order to see the provider names in this list. If 
you do not have a provider list set up you can still choose from a list of ALL providers in the clinic. 
This ALL list shows up in the request grid and is labeled Provider. 

6. Click the New button on the toolbar to open the patient’s Current Medications List. This form will 
default to the Current list, but you can select your request from the Past or All list by clicking the 
appropriate radio button.  

7. Select a medication in the displayed list and click Select OR double-click the medication name. 
The medication list window will close and the medication will drop into the Request list. 

 
8. After the medication has dropped into the request grid, you have the option to change the # 

Refills, Send method, Provider and Last (date) Refilled fields.  The editable fields will be 
highlighted with a yellow background. 

9. Set the priority of the request, if desired, by clicking the priority (!) column and select Normal, 
Urgent (!) or Stat (!!).   

The priority setting defaults to Normal but can be changed to Urgent or Stat if needed.  The 
higher priority items appear with the respective icons in the Refill Request grid to draw attention 
to them. 

10. The request can also be marked as Unfinished. Place a check mark in the unfinished column 
(denoted by a clock icon),  

11. If this column is checked, an unfinished icon  (clock icon) will appear in the Status column of 
the grid to show the item needs attention.  This status can be used when other information needs 
to be gathered before the request is ready to be dealt with. 

12. OPTIONAL: You can add a note to the patient chart but the note is not specific to any of the refills 
themselves. The note may refer to one or more of the requests. (See “Adding a Note to a 
Request” for details).  

13. Click the New button and repeat the process if you need to add more requests. 

14. When all of the information has been selected, click the Save button. 
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15. Click the X in the upper-right corner of the patient chart to close the chart and return to the Refill 
Request module. 

To add a request from DocMan: 
1. In DocMan, while viewing a faxed refill request, click the Refill Request button  on the 

document viewer toolbar.  A patient search screen will open. 

Note:  You must either have the document open OR have the Filing Preview window showing at 
the bottom of the Fax Filing window in DocMan in order to access the viewer and associated 
toolbar. 

2. Type all or part of the patient’s last name and press the Enter key OR click the Search  button. 

3. In the Search results, click the patient name and click the Select button OR double-click the 
patient name. 

4. The Refill Request form will open.  

Note:  In this case the patient’s chart will NOT open. Only the Refill Request form will open.  
This was done so that you can still see the faxed request at the same time as the form. The form 
can be moved around in order to be see the faxed request. 

5. Select the Provider under whose name the request is being made.  To do this, click the drop-
down arrow at the Primary provider field to open the Provider list.   

Note:  You must have your Provider List set up in order to see the provider names.  If you do 
not have a provider list set up you can still choose from a list of ALL providers in the clinic. This 
ALL list shows up in the request grid and is labeled Provider. 

6. Click the New button on the toolbar to open the patient’s Current Medications List.  

Note:  This form will default to the Current list but you can select your request from the Past or 
All list by clicking the appropriate radio button. Select a medication on list and click Select OR 
double-click the medication.  The list window will close and the medication will drop into the 
Request list. 

7. After the medication has dropped into the request grid, you have the option to change the # 
Refills, Send method, Provider and Last (date) Refilled fields.  The editable fields will be 
highlighted with a yellow background. 

8. If desired, click the priority (!) column and select Normal, Urgent (!) or Stat (!!) to set the priority 
of the request.   

The priority setting defaults to Normal but can be changed to Urgent or Stat if needed.  The 
higher priority items appear with the respective icons in the Refill Request grid to draw attention 
to them. 

9. To mark the request as Unfinished, place a check mark in the unfinished column (denoted by a 
clock icon),  

If this column is checked, an unfinished icon  (clock icon) will appear in the Status column of 
the grid to show the item needs attention.  This status can be used when other information needs 
to be gathered before the request is ready to be dealt with. 

10. OPTIONAL: You can add a note to the patient chart but the note is not specific to any of the refills 
themselves. The note may refer to one or more of the requests. (See Adding a Note to a Request 
for details).  

11. Click the New button and repeat the process if you need to add more requests. 

12. When all of the information has been selected, click the Save button and the window will close. 

Electronic Refill Requests (via SureScripts) 
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If a clinic has implemented electronic prescription functionality (via SureScripts), then electronic refill 
requests can also be sent from pharmacies through the same communication link.  These electronic refill 
requests will automatically show up in the Refill Request module for processing. These requests come 
directly from the pharmacies and contain the same information as a faxed or manually entered request 
and they are processed in the same manner as manually input requests. Electronic requests will be 
designated by having SureScripts appear in the Entered By column of a request rather than a user name 
for manually entered requests. 

Note:  SureScripts does not activate the refill request functionality until five new prescriptions per 
registered provider are sent from your e-MDs server. 

Important!  SureScripts requires that electronic refill requests be acted upon within 48 hours.  If refill 
requests remain outstanding beyond that time frame, SureScripts may deactivate the electronic refill 
functionality.  (e-MDs has no control over this process.)  To retain the electronic refill functionality, it is 
important to address unlinked requests daily so providers can approve or deny the refill requests. 

Request Mode 

When in the Medication subsection of Chart View of a patient’s chart, the chart can be in either a Request 
mode or a Refill mode.  When in a request mode, the Request Medication radio button will be selected 
and the program is set to only allow a request to be made.  
 
Note:  The user can click the Refill Medication radio button at any time and switch the functionality to 
allow the refill of medications IF they have scriptwriter privileges. 

 
Refill Mode 

When in the Medication subsection of Chart View of a patient’s chart, the chart can be in either a Request 
mode or a Refill mode.  When in the Refill mode, the Refill Medication radio button will be selected and 
the program is set to only allow medications to be refilled. 
 
Note:  The Request Medication button can be clicked at any time in order to switch the module into 
Request mode.  

 
At times the situation may arise where requests for a single patient come in under different providers at 
the same time.  To deal with that situation, you should first set up refill requests for the first provider, save 
them and then add requests for the other provider. 

To add requests for multiple providers: 
1. On the main Refill Request toolbar, click the New  button.  A patient search screen will open. 

2. Type in all or part of the patient’s last name and press the Enter key OR click the Search  
button. 

3. In the Search results list, click the patient name and click the Select button OR double-click the 
patient name.  The patient’s chart will open to the Request Medication section of Chart View. 

4. Select the first Provider’s name from the Provider List section by clicking the drop-down arrow in 
the Primary provider field to open the Provider list OR by choosing a provider from Provider 
drop-down in the refill request grid. This is an unfiltered list of ALL providers. 

5. Click the New button  on the toolbar to open the patient’s Current Medications List.  
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6. This form will default to the Current list but you can select your request from the Past or All lists 
by clicking the appropriate radio button. Select a medication on list and click Select or double-
click the medication, the list window will close and medication will drop into the Request list. 

7. After the medication has dropped into the request grid, you have the option to change the # 
Refills, Send method, Provider and Last (date) Refilled fields.  The editable fields will be 
highlighted with a yellow background. 

8. Click the priority (!) column and select Normal, Urgent (!) or Stat (!!) to set the priority of the 
request,  The priority setting defaults to Normal but can be changed to Urgent or Stat if needed.  
The higher priority items appear with the respective icons in the Refill Request grid to draw 
attention to them. 

9. Mark any other information such as Priority or Unfinished status. 

10. Click the Save button. 

11. Select the second provider’s name from the list and add requests for that provider as outlined 
above. 

12. Continue in this manner until all requests are complete. 

13. When all of the information has been selected, click the Save button. 

14. Click the red X in the upper right corner of the patient chart to close the chart and return to the 
Refill Request module. 

Linking Electronic Refill Requests 
When a refill request is received from SureScripts, the system searches the e-MDs Solution Series 
database for a patient name and prescription that exactly matches the name and prescription from 
SureScripts.  If no such match is found, the system cannot automatically link the refill request to the 
correct patient and prescription.  (This may occur if the patient’s name in the pharmacy records differs in 
some way from the patient’s name in e-MDs Solution Series, or if the details in the refill request differ in 
some way from the prescription in e-MDs Solution Series.)  Using the Link Refill Requests module, you 
can link an unmatched request to the correct patient and prescription, or you can deny the request. 

Important!  SureScripts requires that electronic refill requests be acted upon within 48 hours.  If refill 
requests remain outstanding beyond that time frame, SureScripts may deactivate the electronic refill 
functionality.  (e-MDs has no control over this process.)  To retain the electronic refill functionality, it is 
important to address unlinked requests daily so providers can approve or deny the refill requests. 

To link an unlinked refill request: 
Privileges Required:  Scriptwriter: SureScripts Patient Linking 
1. Access the Solution Series Dashboard and click Run > Refill Request.  The Refill Request 

module opens and the refill request count is shown at the top of the Dashboard; the first number 
indicates the total number of refill requests, and the second number indicates the number of 
unlinked requests from SureScripts. 

 
If unlinked requests are in the queue, the Unlinked Electronic Refill Requests Available 
message will also on the View Refill Request screen.  (If no unlinked electronic refill requests are 
available, the message text is gray and the link is not active.) 

2. Click the Link Refill Requests button or the red message itself to display the Link Refill 
Requests screen. 
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Note:  The Link Refill Requests screen automatically shows requests for All Facilities and All 
Providers.  To avoid missing a refill request, best practice is to leave this as the default setting.  
However, if you want to see refill requests only for selected facilities or providers, click the down 
arrow in the Medical Facilities field or the Providers field, then click the checkbox next to the 
desired selection(s). 

 
For each unlinked refill request, the system displays the patient name and requested medication. 

 
3. In the list of unlinked refill requests, click a request to select it. All information related to the 

selected request is displayed in the gray area above the list of request.  

4. In the Patient Name field, type the last name (or the first few letters of the last name) of the 
patient for whom the selected refill is requested and press the Enter key. 

 
The system displays a list of the patients in e-MDs Solution Series whose last name begins with 
the letters you typed. 
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5. Click the name of a patient in the middle column to select the most likely match and a complete 

list of that patient’s medications will appear in the far right column.   

 

Note:  If e-MDs Solution Series does not contain a record for the patient, but the provider has 
written a prescription for the patient, click the yellow plus sign (next to the Patient Name field) 
to access Chart Patient Maintenance screen and add the necessary demographic information.  
This scenario may occur when a provider sees a new patient in an emergency room and writes a 
prescription at that location. 

More information will be added to the top of the screen as the search results are narrowed. 

 

Important!  If you link a prescription to an incorrect patient name or medication, see Unlinking 
SureScripts Refill Requests for instructions on how to unlink the refill request. 

6. Do one of the following: 

○ If a prescription in e-MDs Solution Series matches the refill request, click the prescription in e-
MDs Solution Series that corresponds to the requested medication and then click Link. 
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Note:  If the pharmacy requesting the refill is not the same pharmacy that is currently 
associated with the prescription in Chart, the system displays an alert message, which allows 
you to automatically update the pharmacy in Chart to the requesting pharmacy. 

 If Solution Series contains a Demographics record for the requesting pharmacy, the 
message shown in the following image is displayed. 

 
- Clicking Yes adds the requesting pharmacy to the patient’s pharmacy list, changes the 
pharmacy associated with the prescription in Chart to the requesting pharmacy, and sends 
the approved refill to the requesting pharmacy. 

- Clicking No sends the refill to the pharmacy that is currently associated with the 
prescription in Chart. 

 If Solution Series does not contain a Demographics record for the requesting pharmacy, 
the message shown in the following image is displayed. 
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- Clicking Yes opens the Surescripts pharmacy matching screen. You can then search by 
pharmacy zip code or phone/fax number and then save the pharmacy as a new pharmacy. 

- Clicking No sends the refill to the pharmacy that is currently associated with the 
prescription in Chart. 

○ If no prescription in the e-MDs Solution Series list matches the requested medication, do one 
of the following: 

 If a prescription in the e-MDs Solution Series list shows the brand name, and the requested 
medication shows the generic name of the drug, but all other components of the 
prescription match, link the two prescriptions. 

 If you want to add the drug to the patient’s medication list and add the prescription to the 
Refill Request Module for review by the provider, click the New Drug button (the pink 
clipboard). 

 If you want to deny the refill, follow the steps in "To deny an unlinked refill request." 

7. When the confirmation screen appears, click Yes to confirm that you are sure this information is 
correct.  The completed refill request will appear in the View Review Request screen. 

8. Process the newly linked refill request as you would any linked electronic refill request. 

Note:  If you used new filter values for the facility or provider to locate the correct patient, the 
following message may display when you start to close the screen: 

 
9. Click Yes to save your filter options for the entire Refill Request module, click No to discard the 

options and revert back to the default options, or click Cancel to return to the Link Refill Request 
screen without saving any changes. Note that saving your options on this screen will also make 
them the default filters for the View Refill Request screen as well. 

 

To deny an unlinked refill request: 
1. Access the Refill Request Module, select the refill request and search for the corresponding 

patient and prescription in e-MDs Solution Series as described in the "To link an unlinked refill 
request." 



 

e-MDs Solution Series Chart User Guide 8.0 R01 224 

2. If there is no corresponding patient record in e-MDs Solution Series, do one of the following: 

○ To deny the request, click Denial. 

 
The system notifies the requesting pharmacy that the patient is unknown. 

OR 

○ If e-MDs Solution Series does not contain a record for the patient, but the provider has written 
a prescription for the patient, click the yellow plus sign (next to the Patient Name field) to 
access Chart Patient Maintenance and add demographic information.  This scenario may 
occur when a provider sees a new patient in an emergency room and writes a prescription at 
that location. 

Note:  Best practice is to notify the pharmacy by telephone if the patient is not part of your 
practice, so that they can identify the correct provider and resubmit the refill request. 

3. If there is no corresponding prescription for the patient in e-MDs Solution Series, do one of the 
following: 

○ To deny the refill request, click Denial. 

If you deny the refill request without first adding the drug to the patient’s medication list in e-
MDs Solution Series, the system transmits a denial message to the pharmacy.  If that 
happens, the denial message indicates that the patient is unknown. 

OR 

○ To add the drug to the patient’s medication list, click the New Drug button (the pink clipboard).  
Then link the refill request and access the Refill Request Module to deny the request. 

This method adds a record of the request to the patient’s chart, and sends the appropriate 
denial message to the pharmacy. 

Adding a Note to a Request 
Notes can be added to a refill request.  These notes get saved as Prescription notes. 

To add a note to a new request: 
1. Add a new request as described in prior sections. 

2. Once the request has been added, click the Save button. 

3. In the note area at the top right of the Request screen, click the yellow plus (+) icon and select 
Note from the pop-up menu (if a note already exists, choices for Note and Addendum may be 
available).  

The Edit Telephone/Log/Rx Note window will open. 

4. Select either Permanent or Sticky Prescription note  

5. Type in your message. 

6. Click Save. 

7. The message will be displayed in the Note section. 

8. Once the message has been saved, other icons will become enabled, allowing you to edit or 
delete the note (once a note is signed off, the Addendum button becomes enabled and you can 
add an addendum as well). 
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Notes:    
○ At the bottom left of the note section is a button  that toggles from Show All to Show 

Recent when pressed. When this button is depressed it will only display the most recent notes 
associated with the current requests in the list.  When toggled to Show All access to all the 
notes is provided.  

○ At the top of the note area are two arrows that point left and right. 

. 
These arrows allow users to browse and read past Prescription notes if they exist. 

9. Close the chart by clicking the X in the red box  at the top right corner of the chart  

Note:  DO NOT click the black X on the gray Dashboard toolbar unless you want to close the 
Dashboard and ALL applications. 

To add a note to an existing request: 
1. Click to select a request in the grid and click the Edit button.  The patient’s chart will open to the 

Request Medication section of Chart View. 

2. Highlight the request and click the yellow plus (+) icon and then select Note  

The Edit Telephone/Log/Rx Note window, which allows you to create Rx notes, will open. 

3. Select the type of note that you want to create -- Sticky or Permanent). 

4. Type in your message. 

5. Click Save.  The message will be displayed in the Note section. 

6. After the message has been saved, other icons will become enabled and these allow you to edit 
or delete the note (once a note is signed off the Addendum button becomes enabled and you 
can also add an addendum). 

7. Close the chart by clicking the X in the red box at the top right corner of the chart  

Note:  DO NOT click the black X on the gray Dashboard toolbar unless you want to close the 
Dashboard and ALL applications. 

Refilling a Prescription 
Prescriptions can be refilled by the provider they are assigned to.  In addition, clinical staff can refill these 
prescriptions IF they have the correct scriptwriter privileges. 

To refill a prescription: 
1. Click the request to be refilled and click the Select button  OR double-click the request.   

The patient’s chart will open to Refill Medication section of Chart View and the request will be in 
Refill mode.  The bottom grid will display the request(s) and the top grid will display patient’s 
medication list. 

2. Check the check box to the left of the requested medication(s) in bottom grid.  

This will cause the e medication that corresponds to the request to be highlighted and checked in 
the top grid (the patient’s current medication list). 

Note:  If the refill request was received electronically, and the substitution code in the request 
indicates that substitution should be acceptable, the “Sub?” check box is automatically selected 
in the bottom grid, but can be deselected by the user. 

3. If no changes are needed, click the Save button to refill the prescriptions. 
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4. If changes ARE needed, make those changes by clicking in the field that needs changing (for 
example, the pharmacy field to change pharmacies) and change the value. 

Important!  Requests will not always match the information in the medication list. Changes 
can be made to the number of refills, Send method, Pharmacy, etc. when the request is created.  
Providers have the last say in whether they want to make those changes so the changes are not 
automatically made to the actual medication.  If the provider wants to accept the changes they 
need to make the change manually to the patient’s medication. 

5. When finished, click Save.  A Sending Prescriptions dialog window will open with Send and 
Don’t Send choices.  

6. Click Send to send the prescription(s) OR click Don’t Send to just record the prescription(s). 

After the prescription is processed the dialog exits and the request is removed from the bottom 
grid. This dialog will only appear if the prescription(s) are using Print, Fax or Electronic send 
methods. If the prescription refill is to be phoned-in, the prescription will process without the 
dialog and the request is removed from the bottom grid.  

Note:  Depending on what is selected in the Send method field, sending could mean Printing, 
Faxing or Electronic) 

7. Click the X in the red box in the upper right corner of the patient chart to close the chart and 
return to the Refill Request module. 

Editing an Internal Refill Request 
After a refill request has been added by clinic staff, and it appears in the Refill Request grid, it can be 
edited and information can be changed, if necessary.  For example, if a request is initially marked as 
Unfinished and now needs to be changed, the request can be edited to do so.  You can also change the 
Priority status, the Unfinished status, add a note, add a new request, remove a request, or change the 
request to another provider. 

Note:  You can only edit refill requests submitted within the clinic, not requests received through 
SureScripts. 

To edit a request: 
1. In the Refill Request grid, click the request to be edited and then click the Edit button. 

Note:  DO NOT double-click the request.  Double-clicking will open the request in REFILL mode 
and not in Request mode and you will not be able to edit.  You can only refill without any 
changes. 

The patient’s chart will open to the Request Medication section of Chart View. 

2. The record will be in REQUEST mode; make the necessary changes. 

3. When finished making changes, click the Save button. 

Changing Providers on a Request 
At times a request may be inadvertently assigned to the wrong provider or it may be that a provider is 
covering for another and the request needs to be changed to a different provider.  The provider for a 
request can be changed by editing the request. 

To change a provider: 
1. In the Refill Request grid, click the request to be edited and then click the Edit button. 

Note:  DO NOT double-click the request.  Double-clicking will open the request in REFILL mode 
and not in Request mode and you will not be able to edit.  You can only refill without any 
changes. 
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The patient’s chart will open to the Request Medication section of Chart View.  The record will be 
in REQUEST mode and the initial provider’s name will be in the Provider field. 

2. In the Provider field, select another provider to whom the request is going to be reassigned. 

3. Click Save when finished. 

Important!  Currently the assigned provider cannot be changed for electronic refill requests. 

Deleting a Request 
Deleting a refill request will remove the request record for that patient.  

To delete a request: 
1. In the Refill Request grid, click the request to be edited and then click the Edit button.   

2. The patient’s chart will open to the Request Medication section of Chart View. 

3. Click to highlight the request to be deleted. 

4. Click the Delete button on the toolbar.  The request will be removed from the grid. 

Important!  Electronic refill requests CANNOT be deleted. They must be DENIED so that a 
message is sent back to the pharmacy denoting that the request was denied. 

Setting a Priority 
A priority setting can be added to a request. This priority can be Urgent, which will place a single 
exclamation point icon  in the Priority column of the grid, or it can be Stat, which will place a double 
exclamation point icon  in the Priority column.  Priority settings are useful to draw attention to a request 
that may need to be deal with quickly. 

To set a priority level on a NEW request: 
1. Add a new request as described in prior sections. 

2. Select the Priority column and select a priority level (Normal, Urgent or Stat) from the pop-up 
menu 

3. Click Save when all the information for the request has been added. 

To add a priority level to an existing request: 
1. In the Refill Request grid, click the request to be edited and then click the Edit button. 

2. The patient’s chart will open to Request Medication section of Chart View. 

3. Click the Priority column and select a priority level (Normal, Urgent or Stat) from the pop-up 
menu. 

4. Click Save when finished. 

Mark as Unfinished 
It may be necessary sometimes to mark a request as Unfinished.  This status can be used when a 
request has been added but when there is more information that needs to be collected before the request 
is ready to be dealt with.  For example when a request is added from DocMan the Refill Request form that 
opens does not contain the patient’s chart (it just contains the Current Med list).  In this case the user 
might want to mark the request as unfinished because there may be information from the chart that needs 
to be reviewed.  Once marked as Unfinished the request will appear in the Refill Request grid with an icon 
in the Status column denoting it is unfinished.  The user can then edit the record from the grid and access 
the patient’s chart. 

To mark a new request as unfinished: 
1. Add a new request as described in prior sections. 
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2. Click the Mark as Unfinished check box (clock column) . 

3. Click Save when all the information for the request has been added. 

To mark an existing request as unfinished: 
1. In the Refill Request grid, click the request to be edited and then click the Edit button. 

The patient’s chart will open to the Request Medication section of Chart View. 

2. Click the Mark as Unfinished check box (clock column) . 

3. Click Save when finished. 

Adding Refill Requests from DocMan 
Some requests come in from pharmacies via fax.  DocMan can be set up to receive faxes electronically 
and when that happens users may need to access the Refill Request module while viewing the fax.  
DocMan now has access to the Refill Request module in order to accommodate this need. 

To add a request from DocMan: 
1. In DocMan, while viewing a faxed refill request, click the Refill Request button  on the 

document viewer toolbar.  A patient search screen will open. 

Note:  You must either have the document opened OR have the Filing Preview window showing 
at the bottom of the Fax Filing window in DocMan in order to access the viewer and associated 
toolbar. 

2. Type all or part of the patient’s last name and press the Enter key or click the Search  button. 

3. In the Search results list, click the patient name and click the Select button OR double-click the 
patient name.  The Refill Request form will open.   

Note:  In this case the patient’s chart will NOT open. Only the Refill Request form will open.  
This was done so that you can still see the faxed request at the same time as the form. The form 
can be moved around in order to be able to see the faxed request. 

4. Select the Provider under whose name the request is being made.  To do this, click the drop-
down arrow at the Primary provider field to open the Provider list.   

Note:  You must have your Provider List set up in order to see the provider names.  If you do 
not have a provider list set up you can still choose from a list of ALL providers in the clinic. This 
ALL list shows up in the request grid and is labeled Provider. 

5. Click the New button  on the toolbar to open the patient’s Current Medications List.  

This form will default to the Current list but you can select your request from the Past or All lists 
by clicking the appropriate radio button. Select a medication on list and click Select or double-
click the medication.  The list window will close and the medication will drop into the Request list. 

6. Once the medication has dropped into the request grid, you have the option to change the # 
Refills, Send method, Provider and Last (date) Refilled fields.  The editable fields will be 
highlighted with a yellow background. 

7. Set the priority of the request, if desired, by clicking the priority (!) column and select Normal, 
Urgent (!) or Stat (!!).  The priority setting defaults to Normal but can be changed to Urgent or 
Stat if needed.  The higher priority items appear with the respective icons in the Refill Request 
grid to draw attention to them. 

8. The request can also be marked as Unfinished. Place a check mark in the unfinished column 
(denoted by a clock icon). If this column is checked, an unfinished icon  (clock icon) will appear 
in the Status column of the grid to show the item needs attention.  This status can be used when 
other information needs to be gathered before the request is ready to be dealt with. 
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9. OPTIONAL: A note can be added to the patient chart but the note is not specific to any of the refills 
themselves. The note may refer to one or more of the requests. (See “Adding a Note to a 
Request” for details).  

10. Click the New button and repeat the process if you need to add more requests. 

11. When all of the information has been selected, click the Save button and the window will close. 
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5 
Using the OB Module 

e-MDs OB module is designed to expedite the obstetric encounter.  This module 
provides an efficient method for data collection and offers other OB-specific tools to 
streamline the documentation process for prenatal encounters. 

Continued on the next page ... 
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Optimizing Performance 
Important!  Before you use e-MDs OB module the first time, confirm that optimization has been 
activated in e-MDs Chart. 

To activate optimization: 
1. In the menu bar of e-MDs Chart, click File > Options. 

2. On the Administration tab, select Perform OB Module Optimization.  

 
3. Click Save. 

Note:  The first time you access the OB module on a workstation, you may see the following 
message: 

 
 

This is an informational message about the way the computer is set up to display pictures.  If you 
click OK, the message will not appear again.  However, if you close the message window without 
clicking OK, the message will continue to appear until you click OK. 

Accessing the OB Module 
The OB module must be activated through the Vital Signs window in Chart before you use it the first time. 

To activate the OB module: 
1. Open the patient’s chart. 

2. Click the thermometer icon to access Vital Signs (or open from Visit or Order Note). 

3. If the OB-Gyn tab is not visible on the Vital Signs screen: 

a. Select User Preferences from the top toolbar. 

b. Click OB-Gyn Vitals. then click Save to retain that setting and activate the OB-Gyn tab.  
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4. On the Vital Signs screen, click the OB-Gyn tab.   

5. Check the box labeled Pregnant?.  This is what activates the OB module.  

 

Notes:   
○ If a date for the last menstrual period is entered, gestational age and estimated delivery date 

are automatically calculated.  Also, the date of the last menstrual period transfers to the 
Pregnancy Details Overview in the OB module.  No other data entered in this window transfers 
to the OB module. 

○ After any data is entered in the OB module, the Pregnant? check box cannot be deselected.  
To cancel this selection, you must access the OB Module Outcomes section to conclude the 
pregnancy. 

6. Click Save.  The Pregnancy Summary section is added to the Chart Health Summary. 

From this point on, as long as the patient is pregnant, the OB module overview page will display 
automatically whenever the Visit/HS tab is selected in Chart.   
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To toggle between the OB Module and Last Visit screens: 
Click the OB Module or Last Visit tab at the top of the patient's Chart screen. 

The Pregnancy Summary 
When a patient is marked pregnant on the OB-Gyn tab, a new 
section called Pregnancy Summary is added to the Health 
Summary in the patient’s chart. 

The Pregnancy Summary section displays: 

• Provider: The Provider displayed in the Pregnancy 
Summary is pulled from the Primary Provider field in 
e-MDs Chart Patient Maintenance window unless an 
OB Provider is selected on the OB module Pregnancy 
Details screen.  See the pregnancy details "Overview" 
for more information.   

• Repro Hx: Reproductive history (based on data 
entered in e-MDs OB module). 

• LMP: Last menstrual period date. 

• EDD: Current estimated delivery date. 

• GA: Gestational age. 

• Total weight change: Amount of weight change to date. 

• Risks: If risks are documented in the OB module, they are displayed in the Pregnancy Summary 
as well. 
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OB Module Interface Overview 
At the top of the OB module interface, the Patient Information header displays patient name, age, and 
date of birth, basic clinical data relative to the pregnancy, and certain insurance information. The Patient 
Information Header is visible from every section of the OB module. 

 
Clinical information displayed in the Patient Information header includes: 

• EDD:  Current estimated delivery date. 

• GA:  Gestational age. 

• Reproductive History:  Presented in the following order:  Gravida (total number of pregnancies), 
Para (number of full term births, number of preterm births, number of failed pregnancies, number 
of live children). 

• LMP:  Last menstrual period date. 

• Visit Weight:  Visit weight is calculated from the weight this visit and last visit. 

• Total Weight:  Total Weight is calculated from the pre-pregnancy weight and the weight this visit. 

• Risks:  When risks are added in the Risk Assessment section of the OB module, they are 
displayed here in red text. 

In addition to clinical information, the following insurance information appears, including Insurance 
company name, co-pay amount, percent paid by insurance after co-pay, and Super Bill Comment. The 
Super Bill comment is fully customizable for each patient.   
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To customize this comment: 
1. Go to Chart > Demographics > Patients and select a patient.   

2. In the Chart Patient Maintenance window, click the Misc. tab. 

3. Enter the comment in the Super Bill Comment field.  (For more information on editing or creating 
Super Bill comments, see e-MDs Bill User Guide.) 

Information in the OB module is presented in logical sections.  Each section can be accessed from the 
OB module menu bar located directly below the Patient Information Header. Sections included in the OB 
module are: 

• Pregnancy Details 

• Visit FlowSheet 

• Prenatal Labs 

• Patient Education 

• Problems 

• Generate Prenatal Record 

Documenting Pregnancy Details 
The Pregnancy Details section of e-MDs OB module consists of a series of subsections that can be 
accessed via the Pregnancy Details menu on the left side of the OB module interface. 

 

General Navigation 
For more rapid data entry, the OB module interface allows the user to tab from field to field, enter dates 
by typing or using the calendar, enter numbers by typing or using a keypad, and select radio buttons or 
check boxes by pressing the spacebar. 

For most fields with a dropdown list, the user can click in the field and type the first letters of the desired 
entry to display that entry, or simply click the dropdown list and select from the list. 
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To use the calendar to enter dates:  
1. Click the calendar icon to open the calendar. 

2. Select your date: 

○ To go forward or back by one month, click the small grey arrow to left 
of month or right of year. 

○ To change month, click the down arrow to right of month. 

○ To change year, click the down arrow to right of year. 

○ To choose a date, click that day on the calendar. 

3. If the selected date is invalid for the field, the system displays a red exclamation point to indicate 
that the date is invalid. 

A keypad appears when you click in a numeric field. 

To use the keypad:  
1. Click or tap on desired numbers and click Next when done. 

2. Click < to clear a number. 

3. Click the word Next to go the next field. 

Overview 
The Overview subsection of Pregnancy Details includes the following features: 

• Documentation of individual contact information for husband/partner, father of baby, and 
emergency contact. 

Note:  Contact information does not pull from any other fields in the system: The information 
must be entered here. 

• The Provider Selection section allows you to select an OB Provider for the patient that is 
different than the patient's Primary Provider.  This provider name will also appear in both the 
Pregnancy Summary section of the Visit/HS (Health Summary) pane of the patient's chart and the 
Prenatal Record report. 

 
Note that the OB Provider name will not appear in the Chart Visit/HS until the patient's chart has 
been closed and reopened after selecting that provider.  

• Selection of multiple gestation automatically adds additional FHR (fetal heart rate) and 
Presentation fields to the OB Module Visit FlowSheet and adds a section for each baby to the 
Outcome subsection of Pregnancy Details. 

Note:  Selection of Other (under Pregnancy Type) allows for documentation of quadruple 
pregnancy.  

• Documentation of weight in Prepregnancy Vital Signs allows the system to calculate the total 
weight gained or lost each time a weight is entered in a new FlowSheet.  (Total weight is 
displayed in the Patient Information Header at the top of the OB module.) 



 

e-MDs Solution Series Chart User Guide 8.0 R01 237 

The system automatically populates the following fields but you can change the data:  

• Pregnancy Type 

• LMP Description 

• Menses Monthly  

• On BCP (birth control pills) at conception 

You must enter all other data. 

EDD Calculation 
The EDD Calculation subsection offers automated calculation of initial EDD based on LMP, Initial Exam, 
or Ultrasound, and provides several options for 18-20 Week EDD update, including calculations based on 
Quickening, Fundal Height, or Ultrasound.  Other EDD Calculations supports unlimited additional EDD 
calculations by ultrasound. 

 

Note:  If the LMP is entered on the OB-Gyn tab of Vital Signs in Chart, the initial EDD is calculated 
based on that date.  This can be modified from the EDD Calculation subsection by changing the date. 

To update the EDD: 
1. Select the calculation method. 

2. Enter a new date. 

3. Click in the GA field to open the keypad.   

4. In the keypad, click the number of weeks and days, and then click Next. 

The EDD and GA as of current date are automatically calculated and displayed in the EDD 
Calculation window and in the Patient Information Header.  EDD and current GA are then 
automatically updated throughout the chart.  If the EDD is calculated based on anything other 
than LMP, a notation is displayed under the GA in the Patient Information Header.  
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OB Procedures 
In the OB Procedures subsection of Pregnancy Details, you can document all procedures, whether 
performed in the office or off site. 

 

Note:  Before you can document a procedure, at least one diagnosis must be specified in the 
Problems list (or one complaint in the Visit FlowSheet). 

To document a procedure: 
1. In the OB Procedures window, click Add Procedure.  The system displays the Add Procedure 

window. 

 
2. In the Add Procedure window: 

a. Enter the date. 

b. Enter the provider’s name.  (Type a few letters of the name or click the down arrow to select 
from the list.  Both staff and non-staff providers can be selected.) 

c. Select the procedure. 

d. Select the indication for the procedure. (Selections for indications are auto-populated from 
the Problems section of e-MDs OB module, as well as from the Complaints list in the Plan 
section of the Visit FlowSheet.) 

Note:  If no findings have been associated with this procedure, you must add new findings. 

3. To access the Add/Edit Findings window, click the Findings icon.  

4. To create a new procedure-specific finding, click Add New Finding. 
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5. Type the finding in the blank field and then click Save. 

 
The new finding is displayed in the Add Procedure window for the selected procedure type. 

Note:  After a new finding is added and saved for a specific procedure type, the finding is then 
available to all users when that specific procedure type is selected in the Add Procedure window. 

6. In the Add Procedure window, click the check box next to the finding.  (The finding will not display 
in the Results field of the OB Procedures window unless you select the finding by clicking in the 
check box.) 

 
7. Add more details, as needed. 

8. Click Save. 

Note:  The findings list must be created for each procedure.  After a finding is entered using 
Add New Finding, you can add that finding to any procedure type by clicking Add Existing 
Finding. 
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Currently, there is no edit feature for the Procedure Results list.  To change any information, you must 
delete the procedure and then add again. 

Medical History 
The Medical History subsection displays a list of common problems and issues that can be selected 
individually or marked All Negative with a single click. To clear a finding, click it again. You can add 
problems or issues and apply only to the current list or include as a default selection. 

 

To change the sequence of items in the Medical History list: 
1. Click the Edit icon located in upper right corner of the window.   

2. In the Edit window, select the item to be moved. 

3. Drag and drop the selected item to the desired sequence. 

To add another Medical History item: 
1. Click the Edit icon located in upper right corner of the window. 

2. Scroll to the bottom of the Edit window and click Add Another.  A blank field appears. 

 
3. Type the new medical history item in the new field. 

4. To designate an item a default selection, click in the check box labeled Default Question.  (If 
Default Question is selected, the question will appear in the Medical History list of every 
patient’s chart from this point forward.  The question will not be specific to the user who entered it, 
but will appear for all users.) 
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5. Click Add. 

6. Close the Edit window. 

Note:  The item can be deleted by clicking the red X. 

Physical Examination 
The Physical Examination subsection is provided for documentation of the initial physical exam for the 
pregnancy.  The list of exam findings can be selected individually or marked All Normal with one click.  
To clear a finding, click it a second time.  Some abnormal findings are listed and can be selected.  Where 
abnormal findings are not listed, you can document details in the Notes field. 

 
When vitals are taken and entered in the Visit FlowSheet section of the OB module on the same day as 
the OB physical exam, that data is captured and used to prepopulate the corresponding fields on the 
Physical Exam page.  For example, when the patient's blood pressure and weight are entered in the Visit 
FlowSheet as shown here: 

 
and the patient's height has already been entered in the patient's Chart, the information automatically 
appears in the OB Module Physical Exam screen: 

 
At the same time, the patient's Body Mass Index (BMI) is calculated from the patient's weight and height, 
and is also displayed on this screen. 

Risk Assessment 
Risk Assessment displays a list of risk factors that can be selected individually or marked All Negative 
with one click.  A finding can be cleared by clicking it again.  It is important to note that only risks added in 
this section are displayed in the Patient Information Header.  When risks are added in the Risk 
Assessment, the risk data in the Patient Information Header displays in red. 

General functionality for the Risk Assessment subsection is identical to that of the Medical History 
subsection.  The user can change the order in which the risk factors appear and can add new risk factors. 
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To change the sequence of items in the list of risk factors: 
1. Click the Edit icon located in upper right corner of the window. 

2. In the Edit window, select the item to be moved. 

3. Drag and drop the selected item to desired sequence. 

To add another risk factor: 
1. Click the Edit icon located in upper right corner of the window. 

2. Scroll to the bottom of the Edit window and click Add Another.  A blank field appears. 

3. Type the new risk factor item in this field. 

4. To include the item as a default selection, click the check box labeled Default Question.   

Note:  If Default Question is selected, the item will appear in the Risk Assessment list of every 
patient’s chart from this point forward.  This is a global change and not user-specific. 

5. Click Add. 

6. Close the Edit window. 

Note:  You can delete the item by clicking the red x. 

Genetic Screening 
The Genetic Screening subsection of Pregnancy Details offers the same general functionality as the 
Medical History and Risk Assessment subsections.  See these sections for instructions for adding items 
to the Genetic Screening list or for changing item sequence. 
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Past Pregnancies 
The Past Pregnancies subsection provides a means for documenting details of previous pregnancies, 
including date, gestational age, delivery details, and complications.  The system then displays a summary 
of pregnancy history information, along with the details of each pregnancy. 

To document past pregnancies: 
1. During the first visit for a new pregnancy, click the No Past Pregnancy (G1P0) check box if the 

patient indicates there have been no previous pregnancies. 

 
OR 
if the patient indicates there has been at least one past pregnancy, click Add Past Pregnancy. 
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2. In the Add Past Pregnancy window, click an item after Outcome Type.  (For a preterm 
pregnancy, select Full Term, and the system will update to preterm based on gestational age.) 

3. Click an item after Pregnancy Type. (The OB module supports documentation for up to a 
quadruplet pregnancy.) 

4. Click the Location field to select the location and click the Provider field to select the attending 
provider.  

Note:  Location pulls from the short list of external medical facilities, and Provider pulls both 
staff and non-staff providers.  (The short list is created by navigating to Chart > Demographics > 
Medical Facilities > External Facilities.) 

5. Complete the remaining details for each baby.  (For multiple gestation, when data is entered for 
Baby 1, the date, gestational age, delivery method, and type of anesthesia are automatically 
populated for additional babies, but can be edited.) 

Note:  Automatically Update GP is selected by default and allows the system to automatically 
update the patient’s gravida/para status on the Patient Information Header as well as in the 
Summary and Details sections of the Past Pregnancies window.   

6. Click Save.   

To edit documented past pregnancies: 
1. In the Past Pregnancies window, highlight the documented pregnancy to be edited. 

2. Click Edit. The Add Past Pregnancy window appears. 

3. Make your changes and then click Save. 

To delete documented past pregnancies: 
1. In the Past Pregnancies window, highlight the documented pregnancy to be deleted. 

2. Click Delete. 

Birth Planning 
The Birth Planning subsection allows you to record information regarding delivery plans, including contact 
information for the hospital and the newborn’s physician, status of consent form signatures, planned 
anesthesia, and other delivery details. 

 
For the Planned Delivery Location field, the hospital selections are pulled from the short list of external 
facilities.  (The short list is created in Chart > Demographics > Medical Facilities > External Facilities.)  
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Selections for the physician include staff and non-staff providers.  To select the hospital or physician, click 
in the field and select from the dropdown list, or type the first few letters of the name. 

Note:  In the Consent Forms list, the date for HIV Release of Records must be entered in order to 
include HIV results on the prenatal record.  If there is no indication that the consent is signed, the system 
displays the following message when the user attempts to generate the prenatal record. 

The current patient has not signed an HIV Consent Form. HIV information cannot 
be printed to the Prenatal Record. Do you want to continue? 

Outcome 
The Outcome subsection provides an area to document details of the delivery.  All fields in the Add Past 
Pregnancy window are also available in the Outcome window.  

 
You can conclude a pregnancy record only if all Visit FlowSheets have been signed off for this patient.  If 
you click Outcome while there are unsigned visits, a message indicating “You must sign off all FlowSheet 
visits to conclude the pregnancy” will appear at the bottom of this screen to the right of the Conclude 
Pregnancy button.  The Provider identified for each unsigned visit must sign off any outstanding notes 
before you can continue with the following steps. 

To document the pregnancy outcome: 
1. In the Outcome window, select a type after Pregnancy Outcome Type.  (For a preterm 

pregnancy, select Full Term, and the system will update to preterm based on gestational age.   

2. Click in Location and Attending Provider fields to access available selections.   

Note:  The Location value pulls from short list of external medical facilities and the Provider 
value pulls both staff and non-staff providers.  (The short list is created in Chart > Demographics 
> Medical Facilities > External Facilities.) 



 

e-MDs Solution Series Chart User Guide 8.0 R01 246 

3. Complete the remaining details for each baby.  (For multiple gestation, when data is entered for 
Baby 1, the date, gestational age, delivery method, and type of anesthesia are automatically 
populated for additional babies, but can be edited.) 

Note:  Automatically Update GP is selected by default and allows the system to automatically 
update the patient’s gravida/para status on the Patient Information Header as well as in the 
Summary and Details sections of the Past Pregnancies window.   

4. Click Save.   

Note:  Automatically Update GP is selected by default and allows the system to include this 
pregnancy in the Patient Information Header as well as in the Past Pregnancies summary and 
details. 

When you click the Conclude Pregnancy button in the Outcome subsection, the Conclude Pregnancy 
window opens, and all diagnoses from the current Problems list are displayed in the window.  You have 
the option to resolve each problem and include a reason for resolution.  Any unresolved problems transfer 
to the Problems list in e-MDs Chart.  Any staff provider can conclude the pregnancy. 

 
When you click the Conclude button, the OB module closes for this pregnancy.  A summary is stored in 
Chart and is available in Chart View, the Document folder, and the Other folder.  A summary is also 
available in DocMan. 
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Modifying ICD and CPT Codes for Use in the OB 
Module 
In both the Problems and Visit FlowSheet section, you can access ICD or CPT Common Lists.  These 
lists are pre-populated by e-MDs, but can be modified by an authorized user.  The following procedures 
describe how to add ICD codes to the OB module through Bill and Chart.  You can also access non-
pregnancy related ICD codes through the OB module.   

In order to add individual CPT codes, you must exit the OB module and go to the Reference menu in 
Chart or Bill.  See "To add CPT codes to the OB module" for more information. Regardless of the codes 
selected, the conditions or problems identified here will appear in the consolidated Chart and OB module 
problems list and will be accessible from both problem list screens. 

To add ICD codes to the OB module: 
1. In e-MDs Chart menu bar, click Reference, and then select ICD Search. 

2. In the ICD Search window, click Details. 

3. Highlight the ICD code and select OB Problem. 

 

Alternate Descriptions 
If you use the search function in ICD Search to find a particular symptom, the system displays a list 
containing the original ICD and all Alternate Descriptions, even if one of the Alternate Descriptions is 
selected, the system displays the Details pane for the original ICD. 
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For example, if you search for “dizziness”, the system displays the following: 

 
If you select Dizziness while pregnant, the Details pane is populated, but note that the Display 
Description, Billing Description, and Detail Description fields all specify “Dizziness.”  If you select OB 
problem in this Detail pane, “Dizziness” appears as the description in the OB module, rather than 
“Dizziness while pregnant.”  This is because “Dizziness while pregnant” is an Alternate Description of 
“Dizziness.” 
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To display the Alternate Description in the OB module, you must designate the description as an OB 
Problem in the Details pane specific to the Alternate Description.  To display the correct Details pane, 
click the plus sign next to Dizziness while pregnant, open the Alternate Descriptions folder, and select 
Dizziness while pregnant.  Note that all description fields are blank.  To add this description to the OB 
module, place a check mark in the box next to OB Problem.  (Click in the box to add a check mark.) 

 

Note:  This applies to any Alternate Descriptions for CPT codes as well. 

An Alternate Description inherits all attributes of the original ICD when the Alternate Description is 
created, but if the original ICD is changed at a later time, the changes are not applied to the Alternate 
Description. 

To add CPT codes to the OB module: 
1. In e-MDs Chart menu bar, click Reference, and then select CPT Search. 

2. In the CPT Search window, click Details. 

3. Highlight the CPT code and select OB Order (located in the lower right corner of the details 
pane). 
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Creating and Using a Visit FlowSheet 
The Visit FlowSheet supports rapid and consistent documentation of obstetric encounters.  The e-MDs 
OB Module Visit FlowSheet: 

• Provides a summary of each encounter in e-MDs Chart. 

• Displays visual cues for abnormal values based on gestational age. 

• Includes prompts for ordering appropriate labs and patient education based on gestational age. 

• Populates the Prenatal Record which can be printed or faxed. 

• Provides printing or faxing at note conclusion. 

For each patient encounter, you create a new Visit FlowSheet.  Creation of the FlowSheet automatically 
adds a Visit Note to e-MDs Chart in the Chart View section of the patient’s chart. 

 
To the left of each FlowSheet is a status icon. 

• A padlock icon means the Visit Note is locked because another user is currently accessing it. 
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• A plus sign means the visit is signed off, but it is still possible to add an addendum. 

• A pencil icon means that the visit is not signed and can be edited.   

Note:  To edit a visit, click the Edit icon. 

To create a new provider or nurse visit note: 
Note:  This note will also appear on the Visit Notes tab in the patient’s Chart view and the 
information will be added to the prenatal record. 

1. Click Add Provider Note or Add Nurse Note. 

 
2. In the Visit Details window, enter the following values, then click Save: 

○ Health Care Professional (Only this person will be allowed to sign off the visit note.) 

○ Supervisor (if applicable) 

○ Assistant 

○ Location 

○ Appointment 

Note:  After a user adds this information once, it will default for that user.  If the patient has an 
appointment for the current date in e-MDs Schedule, the appointment information will auto-
populate. 

3. In the Pregnancy Visit FlowSheet, enter the visit details.  (Leave fields blank if measurements 
were not taken.) 

○ Visit Date and GA are automatically entered. 

○ Three fields in Cervix Exam: first field is dilation, second is effacement, and third is station. 

○ For Edema, Urine Glucose, and Urine Protein, any result entered except negative will display 
as abnormal (displays text in red). 

○ The reference range for abnormals for each field changes based on GA. 
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To create a new Order Note: 
Note:  This note will also appear on the Visit Notes tab in the patient’s Chart view and the 
information will be added to the prenatal record. 

1. Click Add Order Note. 

 
2. In the Visit Details window, enter the following values, then click Save: 

○ Health Care Professional Type 

○ Type of Encounter 

○ Health Care Professional (Only this person will be allowed to sign off the Order Note.) 

○ Supervisor (if applicable) 

○ Assistant 

○ Location 

○ Appointment 

Note:  After a user adds this information once, it will default for that user.  If the patient has an 
appointment for the current date in e-MDs Schedule, the appointment information will auto-
populate. 

3. In the Pregnancy Visit FlowSheet, enter the visit details.  (Leave fields blank if measurements 
were not taken.) 

○ Visit Date and GA are automatically entered. 

○ Three fields in Cervix Exam: first field is dilation, second is effacement, and third is station. 

○ For Edema, Urine Glucose, and Urine Protein, any result entered except negative will display 
as abnormal (displays text in red). 

○ The reference range for abnormals for each field changes based on GA. 

Notes:   
• The Next Appt. field allows you to indicate when the next appointment should be scheduled, but 

does not automatically schedule the appointment. 
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• When a Nurse Note is signed and saved on the Pregnancy Visit FlowSheet grid, the cells are 
shaded to distinguish Nurse Notes from Provider Notes at a glance. 

To create a log, phone or prescription note: 
Note:  This note will also appear on the Log/Phone/Rx Notes tab in the patient’s Chart view and 
the information will be added to the prenatal record. 

1. Click Add Log/Phone/Rx Note. 

 
2. Select the class of note – Log, Phone, or Rx. 

3. Select the type of note – Permanent or Sticky.  (A Permanent note can be signed off by the 
user creating it but a Sticky note never has to be signed off.) 

4. Type the subject of the note.  This should be something short but meaningful.   

Notice that an OB- notation is added to the subject line automatically to highlight any logged 
information as being related to a pregnant patient.   

5. Type the note message. 

6. Click Save to save and close the note. 

OR 

Click Sign-Off and then Save to both complete the note and save it. 

OR 

Click Cancel to discard the note without saving it. 

To add an addendum to a note: 
1. Click the plus sign to the left of a signed-off note or the icon to the left of an unsigned note. 

Note:  After a note is signed off, more information can be added to the note as an addendum.  
Until it is signed off, the text of the original message can be modified as well. 

2. In the note window, type the additional information in the bottom field (for addendums) or modify 
the text of the note (for unsigned notes). 

3. Click Save. 
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Copying Visits 
To save steps, you can click Copy Last Visit to have the system create an exact copy of the most recent 
Pregnancy Visit FlowSheet.  You must then manually change the Visit Date, and then add visit 
information to the new Visit FlowSheet. 

Creating a Plan for the Visit 
After the Visit FlowSheet is created, you can then create a plan for the visit.  The plan includes 
documentation of orders, patient education, complaints, and assessments.  You can continue to enter 
data in the Visit FlowSheet while the Plan/Notes section is open. 

To add a plan: 
1. In the Pregnancy Visit FlowSheet, click the pencil icon in the Plan/Notes field to display the plan. 

Note:  If the icon in the Plan/Notes field is a sheet of paper rather than a pencil, click the edit 
icon (grey pencil button) before the note entry to change the plan icon to a pencil.  Then select 
the pencil in the Plan/Notes field. 

 
2. Select the desired orders in the Suggested Orders section.  
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3. If the desired order is not shown under the Suggested Orders, click Add Other to access the 
Add Labs window. 

 
4. In the Add Labs window: 

a. Click the first letter of the desired order.  The system displays a list of orders. 

b. Select a lab from the list, and click Save. 

Note:  Orders will not display in the OB module list of orders unless the CPT code has been 
selected as an OB Order in the Details pane of the CPT Search window in e-MDs Chart.  

5. To change the In House/Send Out status, click the down arrow to the right of the status, or 
change in the Visit Note Sign Off window when documentation is complete.   

Note:  The In House/Send Out status is pulled from the fee schedule associated with the 
patient’s insurance company.  The status is not displayed until the order is selected. 

 
6. Select the Patient Education to be provided.  Patient Education selections:  

○ Are specific to gestational age. 

○ Can be ordered more than once. 

○ Can be printed at note conclusion.  (Select in Visit Note Sign Off window.) 

○ Automatically adds the date in the Patient Education section of OB module and indicates that 
the selected education was given. 

Note:  Suggested Patient Education items that display in gray have been ordered for the patient 
previously, but can be ordered again. 

7. Select complaints to be noted for this visit.   
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Complaints are common symptoms associated with pregnancy.  Although pulled from the ICD list, 
these are not added to the Chart problem list and are not added as ICD for the visit, but are 
added to the Prenatal Record with the date of visit. 

 
Note:  To display more problems in the Complaints area: 

a. Click Add Other.   

b. In the Add Problem pop-up window, type the first letter of the desired complaint to display 
a list.   

c. Select from the list.  You can select both pregnancy and non-pregnancy codes from this 
list. 

8. In the Assessments section, select all billable diagnoses and ongoing problems for the 
pregnancy.  

Assessments shown in this window are pulled from the Problems section of e-MDs OB module. 

Note:  The first diagnosis listed is designated as the primary diagnosis for billing purposes.  A 
blue star marks the diagnosis as primary.  To change the primary diagnosis, select the new 
primary diagnosis and drag the blue star to that diagnosis. 

9. Click Save/Sign Visit to save the visit and display the Visit Note Sign Off window. 
OR 
Click Cancel to delete information entered for this visit.   
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10. When the Visit Note Sign Off window appears, select the appropriate options: 

a. Under Print Options, select the appropriate check box for those items to be printed or faxed.  
Visit or Order Note will print or fax a summary of FlowSheet information.  Note that selecting 
fax brings up the Fax Contacts list. 

Note:  Clicking the Visit Summary check box will cause an OB Visit Summary to be 
generated for this visit. This output is the OB module version of the Visit Summary normally 
created by Chart when concluding a visit. The generation of this OB Visit Summary will also 
be tracked on the Audit Log. For instructions on enabling or disabling this option, see Setting 
Preferences for Visit and Order Notes. Also see Printing and Saving a Visit Summary for 
more information. 

b. Select the desired sign-off option.  Permanent sign off is available only if the user currently 
logged in is the provider listed for the visit. 

c. If Close Note/Edit Later is selected, Ready to Bill is an option.  If this option is selected, a 
check mark is automatically generated in e-MDs Bill to indicate that an invoice can be created 
for this visit. 

d. Select the appropriate E&M Coding Options.   

The E&M codes displayed in the far left column change based on selection of Established or 
New.  (None clears the list.)  The four codes in the second column (0500F, 0501F, 0502F 
and 0503F) are permanent codes that can be used to add frequently used codes at note 
conclusion.  You can mouse over each of these four codes to see a short description of each 
code before selecting it. 
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Note:  To add another E&M code that does not normally appear here, select Other and type 
the code number in the field that follows that selection. 

e. Add the desired modifier to selected E&M codes.  

f. In the list of assessments, change In House status to Send Out or Send Out/Billable, if 
necessary.  (Note that you can move CPT codes to different ICD codes by dragging and 
dropping them.) 

Note:  To use the drag-and-drop functionality, left-click to select an item to move.  Continue 
holding down the left mouse button and drag the item to its new location in the list.  Release 
the mouse button to leave the item in its new position. 

11. Click OK.   

If Permanent Sign Off or Ready to Bill is selected, charges for this visit are immediately 
transferred to e-MDs Bill. 

Monitoring Prenatal Labs 
FlowSheets for pregnancy related labs, visit information, and vital signs are automatically displayed in the 
Prenatal Labs section of the OB module.  Any FlowSheets selected in the patient’s chart in e-MDs Chart 
will also be displayed in the Prenatal Labs section.  To allow for inclusion of chronic problems during the 
prenatal visit, all other e-MDs FlowSheets are accessible from the Prenatal Labs tab. For offices using a 
Lab interface, lab results will automatically populate the appropriate FlowSheets. 

To add a FlowSheet: 
1. On the OB Module tab, select Prenatal Labs. 

2. Click the Manage FlowSheets tab. 

 
3. Click Add FlowSheets to display the list of available FlowSheets. 

4. Select the desired FlowSheet and then click Add Selected. FlowSheets are added to current 
patient only. 
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Note:  You cannot edit or create these FlowSheets from the OB module.  Any edits to the 
FlowSheets must be done in e-MDs Chart.  For instructions, see the FlowSheet section of this 
guide.  

Tracking Patient Education 
The Patient Education section lists the recommended education for each trimester and tracks the date on 
which education is provided.  

 
Each time education is ordered in a Visit FlowSheet, a new column is displayed in the Patient Education 
window, with the date of the order at the top of the column.  For all education items ordered, “Given” 
appears next to the item. 
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Working with the Problem List 
The Problems section contains all current problems for this patient.  Problems in e-MDs Chart flow to the 
Problems section in e-MDs OB module. 

 

To add a problem: 
1. Click Add Common. 

2. In the Add Problem window, type the first few letters of the problem to display a list of available 
problems. 

3. Highlight the problem and click Save. (Use Ctrl+click to select multiple problems.) 

4. Select the problem status and severity.  These fields are optional. 

5. To type any additional notes, click under Plan/Notes and enter your text. 

Note:  To change the order in which the problems appear, select the problem and drag and drop 
it to the desired location.  The first problem in the list, designated with a blue star, is the primary. 

Resolving or Deleting Problems 
You can click the Resolve button to resolve a problem.  When a problem is resolved, the problem turns 
gray and moves to the bottom of the problem list.  You can also delete a problem by clicking the red x to 
the right of the Resolve button.  However, once a problem is used in a note, the problem cannot be 
deleted, and the red x is no longer visible. 

Note:  Problems will not display in e-MDs OB module list of orders unless the ICD code has been 
selected as an OB Problem in the Details pane of the ICD Search window in e-MDs Chart. 
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Generating Prenatal Records 
At any time during the pregnancy you can generate a prenatal record modeled on the standardized forms 
commonly used by obstetricians.  When the record is generated, the system automatically saves a copy 
to the patient’s chart in DocMan (Prenatal HX category) and displays the copy in Chart View and 
Documents.  The prenatal record can also be faxed from DocMan. 

Notes:    
• The Referred By field in the prenatal record will be populated based on the Default Referral 

entered in the General Tab of the Chart Patient Maintenance window. 

• In the Consent Forms list (located in the Birth Planning section), the date for HIV Release of 
Records must be entered in order to include HIV results on the prenatal record.  If there is no 
indication that the consent is signed, the system displays the following message when the user 
attempts to generate the prenatal record. 

The current patient has not signed an HIV Consent Form. HIV information 
cannot be printed to the Prenatal Record. Do you want to continue? 

 
If a Log/Phone/Rx Note has been entered for this patient, that information will appear in the prenatal 
record, similar to the following example: 
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The medications taken by the mother can have a major effect on the health and well being of the unborn 
child.  For that reason, the prenatal report includes an extensive record section tracking medications 
taken during pregnancy.  That section looks similar to the following report: 

 

Using Additional OB Module Features in Schedule and 
Chart 
While most OB module features are accessible from the module itself, additional features are also 
available in Chart and Schedule. 

Features in Schedule 
To assist in setting appointments at the appropriate gestational age, a Gestational Age Calculator is 
available in the Tools menu in Schedule. 
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Features in Chart 
The following OB-specific features are included in e-MDs Chart: 

• An icon specific to OB appears in the Chart View. 

• A summary of visit and order notes created in the OB module is automatically added to the Visit 
Notes section of Chart.  (These OB-specific notes are denoted by a stork icon.) 

• The audit function records every action (add, delete, etc.) taken in the OB module. 

• Gestational Age rules are available in Chart. 

• Two OB-specific Crystal Reports are available.  These reports are OB-Financial Analysis Report 
and OB-Monthly EDD Report.  
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6 
Using Templates 

Templates are documentation tools used in nearly every portion of the Visit and Order 
Notes. A template is an organized series of data points preceded by check boxes. 
Only those items that the user checks are added to the note. Sometimes when a box 
is checked, another "level" of the template opens, allowing more detailed 
documentation. For example, in an HPI template, if the user checks that the patient 
has had a cough, the next level may ask for details such as duration and character. 
For the most part, these details are not required documentation elements; a user can 
answer them if desired, or ignore them entirely. 

While e-MDs provides an extensive set of templates for use with Solution Series, you 
may find you need to create your own templates or customize existing templates.  To 
facilitate that functionality, Solution Series Chart also includes a Template Editor.  To 
learn more about how that tool works, see the e-MDs Solution Series Administration 
Guide for detailed instructions.  Note that you must have the appropriate privileges 
assigned to your user access to use that editor. 

Continued on the next page ... 
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Accessing Templates in Visit and Order Notes 
Templates belong to "categories" that determine where a particular template will appear in e-MDs Chart. 
A History of Present Illness (HPI) template, for example, will only show up in the HPI section of a note. 
Sections of e-MDs Chart that use templates will display a small template icon (a gray box with a check 
mark ). When the cursor is held over the template icon, the gray box is highlighted in yellow. Click this 
icon to display a list of linked templates.  

Templates may be linked to a patient based on the patient’s age and gender, such as with the Review of 
Systems (ROS) and Exam templates. For example, questions relating to ovarian cancer will be found only 
in the Adult Female ROS or Past Medical History templates, and not in the corresponding Pediatric or 
Male templates. Templates are also linked to ICD and CPT codes. That is, if the complaint documented in 
HPI is "ankle pain", specific templates for ankle pain will show up in HPI, Exam, and Plan sections. 

There could be a number of different reasons for being unable to find an appropriate template in the 
Template Links window.  

• It is possible that a template for the given condition does not exist. To look for a related template 
that might have inadvertently not been linked, click the Additional button. This will list all 
templates of the appropriate category type, age, and gender. In addition, Generic templates are 
always available in the Template Links window for the HPI and PLAN sections and are developed 
in a way that makes them usable for documenting almost any condition.  

• The template you are looking for may not be designated for the age or gender of the patient you 
are currently seeing. This can be resolved by editing the template to change the age and/or 
gender settings (this may not be appropriate in all cases since templates can be written to be very 
specific for age and gender).  

• It could be that the template is set to draft status and cannot be accessed from the chart.  To 
resolve this, you can edit the template and change the status to Complete (always verify that the 
template has truly been completed). 

Quick Launch Templates  
To the right of the Template Link icon there is a Quick Launch icon .  With the Quick Launch feature 
you can designate a single template to be launched as the default choice for the diagnosis being 
documented in the particular section of the note that you are working in (HPI, ROS, Plan, etc.). All Quick 
Launch templates are age and gender-specific, meaning that one can be chosen for pediatric male, 
pediatric female, adult male, and adult female patients for each diagnosis and section of the note.   

Notes:     
• Complaint-Specific Exam templates cannot be set for Quick Launch use.  

• If the template chosen is an Insurance-Specific Template, then the Quick Launch template will be 
insurance-specific as well (for more information, see the "Insurance-Specific Templates" section 
in the "Creating and Modifying Chart Templates" chapter of e-MDs Solution Series Administration 
Guide). 

Quick Launch templates will be provider-specific.  They can only be set up or changed by the provider, 
supervisor, or assistant listed in the visit details of an open note.  After being set, the icon will turn blue to 
indicate the presence of a Quick Launch template. 

To set a Quick Launch template: 
• From an open Visit or Order Note, click the Quick Launch icon and select the name of the 

template to so designated. 

The template will open and become the Quick Launch template for the provider listed for this visit. 

OR 
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• From an open visit note: 

a. Click the Template Link icon.   

A column of check boxes will appear on the left side of the Template Launch window. If no 
Quick Launch template has been designated, no check mark will appear in the check boxes. 

b. Click the check box next to the template you want to select as the Quick Launch template. 

c. Click the template name to open it. This will set the selected template as the Quick Launch 
template for the current provider. 

To change a Quick Launch template: 
1. From an open Visit or Order Note, click the Template Link icon. 

A check mark will appear in the check box next to the template that is currently designated as the 
Quick Launch template. Additionally, text will appear after the name of the template indentifying it 
as the Quick Launch template. 

2. Click the check box next to the template you want to designate as the Quick Launch template. 

3. Click the template name to open it. This will change the Quick Launch designation to the selected 
template. 

Blank Templates  
Before a template is opened, you must choose between a blank template, a pre-clicked template 
(accessed via the computer mouse icon), or a past template (accessed via the alarm clock icon). A blank 
template is simply a template that has not had any check boxes checked. 
 

 
 
After the template is open, click to select the appropriate check boxes.  You can click either a check box 
or the words next to it.   

 
In some templates, there is a check mark and an X, instead of just a check box.  This allows for 
documentation of pertinent negatives.  Clicking the check mark will document a positive (yes) response.  
Clicking the X will document a negative (no) response.    

To close the template when finished, click the exit X in the upper-right corner of the first template window 
or click anywhere outside of the template. If multiple template windows are open (as in a multi-level 
template), it is not necessary to close each window.  Subsequent level windows will automatically close 
when the top level window is closed. 

Pre-Clicked Templates 
Whenever you open a template you must choose between a blank template, a pre-clicked template, or a 
past template. A pre-clicked template is one where the answer set has already been created. For 
example, you can open a Review of Systems (ROS) template and check through the answers to generate 
a negative ROS. When the answer set is complete, give it a title and save it as a pre-clicked template. 
Later, when you want to use a ROS template in a note, you have the choice of dropping in that pre-
clicked template.  

A pre-clicked template should be treated as a "starting point" to assist in rapid documentation of common, 
repetitive data. If any pre-clicked answers do not apply to a given patient, the answer set can be rapidly 
amended to suit the situation, simply by clicking or un-clicking check boxes after the template has been 
dropped into the patient chart. Changes made for that patient do not change the pre-clicked template. 
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More About Pre-Clicked Templates 
Keep these points in mind when working with pre-clicked templates: 

• An unlimited number of pre-clicked templates can be created from a single template. For 
example, the Review of Systems (ROS) questions posed to an adolescent would be different than 
those asked of a geriatric patient. As a result, two different "Negative ROS" answer sets could be 
created. 

• Templates of every category can be used to create pre-clicked templates. In addition to ROS, 
other common uses for pre-clicked templates include normal physical exams, procedure notes, 
and common treatment plans. 

• Each pre-clicked template can be Author only (user specific) or Clinic wide (available to all users).   

The following procedures guide you through using a pre-clicked template, and creating or editing pre-
clicked templates on the fly. 

To use a pre-clicked template:  
1. To open a pre-clicked template, click the computer mouse icon , located to the left of the 

template title in the Template Links window. (See the Accessing Templates in a Visit or Order 
Note section for information about finding linked templates.) 

This opens a window displaying the titles of all pre-clicked versions of the selected template (plus 
a search field).  

Note:  If the computer mouse icon is disabled (appears gray and is inactive), this indicates that 
no pre-clicked versions of the selected template exist. 

2. Click the title of the desired pre-clicked template. 

Notes:    
○ Pre-clicked templates are not user-specific; therefore, pre-clicked templates created by other 

users will be visible. It is wise to include your name or initials in the title of any pre-clicked 
templates that you create. 

○ If none of the pre-clicked titles is appropriate, click Template Links at the bottom of the Pre-
Clicks window to return to the original Template Links window. 

3. The selected pre-clicked template will open. Make changes to the answer set, as necessary. 

4. To close the template when finished, click the X in the upper-right corner of the first template 
window or click anywhere outside the template. If multiple template windows are open (as in a 
multi-level template), it is not necessary to close each window. Subsequent level windows will 
automatically close when the top level window is closed. 

Pre-clicked versions of templates can be created in the Template Editor or created on the fly when a 
template is opened in a patient chart. The following instructions refer to creating a pre-clicked template in 
a patient chart. For information on creating them in the Template Editor, see the "Creating and Modifying 
Chart Templates" chapter in e-MDs Solution Series Administration Guide. 

To create a pre-clicked template on the fly: 
1. Open a template and check data points. 

2. When finished, click the chart icon  in the upper-left corner of the first template window to the 
left of the words "Level 1:" in the title bar of the template window. 

3. Select Save Pre-Clicks As from the menu. 

4. In the next window, supply a description for the pre-clicked template.  If you want to be the only 
person to be able to use this pre-clicked template, select Author only.  Be aware that no other 
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user will have access to view or use this pre-clicked template.  If this pre-clicked template needs 
to be accessible to all users, select Clinic-wide.    

5. Click OK. 

Note:  When choosing Clinic-wide, all users will have access to the pre-clicked template. If 
multiple providers will be generating pre-clicks, it is helpful to include their names or initials in the 
titles to aid in rapidly identifying the correct template in e-MDs Chart. 

6. When finished, close the template by clicking the X in the upper-right corner of the first template 
window or clicking anywhere outside the template. If multiple template windows are open (as in a 
multi-level template), it is not necessary to close each window. Subsequent level windows will 
automatically close when the top level window is closed 

From time to time pre-clicked answer sets must be changed to suit the individual situation. To do so, click 
or un-click check boxes after the template has been dropped into the patient chart and then close the 
template. Changes made for that patient do not change the pre-clicked template. On the other hand, if 
you want to make permanent changes to the pre-clicked template, you must save the changes prior to 
closing the template. 

To edit a pre-clicked template on the fly: 
1. Open a pre-clicked template. 

2. Make the appropriate changes by clicking or un-clicking check boxes in the template. 

3. When finished, click the orange chart icon  in the upper-left corner of the first template window. 
It is located to the left of the words "Level 1:" in the title bar of the template window. 

4. Select Save Pre-Clicks from the menu. This opens a window listing all pre-clicked versions of 
that template.  

5. Highlight the name of the pre-clicked template that was just altered and click Save. 

6. When finished, close the template by clicking the X in the upper-right corner of the first template 
window or click anywhere outside the template. If multiple template windows are open (as in a 
multi-level template), it is not necessary to close each window. Subsequent level windows will 
automatically close when the top level window is closed. 

Past Templates 
Before a template is opened, the user must choose between a blank template, a pre-clicked template, or 
a past template. A past template is an answer set from a prior time, when the selected template was used 
for the same patient. Answer sets are saved automatically whenever a template is used. 

To open and close a past template: 
1. Click the alarm clock icon , located to the left of the template title in the Template Links 

window. (See the Accessing Templates in a Visit or Order Note section for information about 
finding linked templates.) 

This opens a window displaying all previous dates that the selected template was used for this 
patient. Each date is followed by the diagnoses assigned at that visit. 

Note:  If the alarm clock icon is disabled (appears gray and is inactive), no past versions of the 
selected template exist. 

2. Click either the date or the associated diagnoses to open the past template.  The selected past 
template will open. 

Note:  If none of the past templates is appropriate, click Template Links at the bottom of the 
Pre-Clicks window to return to the original Template Links window. 
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3. Make changes to the answer set, as necessary. 

4. To close the template when finished, click the X in the upper-right corner of the first template 
window or click anywhere outside the template. If multiple template windows are open (as in a 
multi-level template), it is not necessary to close each window.  Subsequent level windows will 
automatically close when the top level window is closed. 

Generic Templates 
The History of Present Illness (HPI) and Plan templates are typically linked to ICD codes. Therefore, the 
Template Links windows in those sections of a note are populated with templates linked to the 
complaint(s) in HPI. If no templates exist for a complaint or diagnosis, a Generic Template can be used 
for basic documentation purposes. This usually reduces the amount of typing needed to complete the 
note. 

For example, a Generic Plan template might include commonly ordered labs and procedures, an 
extensive list of sub-specialists for referral purposes, and generic follow-up instructions. Likewise, a 
Generic HPI template will ask questions such as duration and associated symptoms. Therefore, 
regardless of the patient’s presentation, much of the template should be useful. 

Generic templates appear in every Linked Templates window whether or not there are other linked 
templates.  If there are diagnosis-specific templates linked to the diagnosis, the generic templates will 
appear at the bottom of the list after the diagnosis-specific templates.  Otherwise they will appear at the 
top of the list.   

To access generic templates: 
1. Click any Free Text icon (they appear as small gray circles that turn into yellow squares when the 

cursor passes over them). 

2. Select the Other Options button located in the bottom-left corner of the Free Text window. 

3. Select the Generic Template menu option.  

Note:  This menu option is only available in the HPI and Plan sections of a note for this usage. 
You may also notice that this menu option appears in Exam templates, but that option is for 
opening a "template within a template."  See Nested Templates for details. 

A Template Links window will open, listing any available Generic Templates appropriate for the 
given section of the note. If this window is empty, no Generic Templates exist. 
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Working with Diagnosis Navigator 
This feature takes the list of diagnoses that are in the Visit and Order Notes and presents them in a 
window that runs vertically down the left side of any open template.  Users can easily and quickly jump 
from one diagnosis to another to access diagnosis-specific templates without having to close the template 
and then reopen another one. 

In the following sample screen, the patient presents with a cough and fatigue. Notice that both the 
complaints are listed in the Navigator window on the left.  The cough complaint is highlighted in yellow to 
indicate it is the active template that is currently open (notice the template name on the header of the 
template).  You can document as much as needed in the cough template and then, by clicking the word 
"fatigue" or the template launch icon  in the left pane, open the fatigue template and begin documenting 
that complaint.  

 

Note:  In some cases the Diagnosis Navigator will appear with the wording “No Diagnosis Present in the 
Selection.” This happens with template categories that are not diagnosis dependent.  For example, the 
CC, ROS and Exam templates are not dependent on a diagnosis. They show up as template choices in a 
note based on the patient’s age and gender, and not based on a complaint or diagnosis. On the other 
hand, HPI, PLAN and Procedure templates do have a dependency on a diagnosis or complaint and will 
always have complaints listed in the Diagnosis Navigator. 

Turning Off the Diagnosis Navigator 
The Diagnosis Navigator window displays when a template is opened.  This window can be toggled off 
and on.  When the Navigator is toggled off, the Health Summary will appear in the left pane. The state of 
the Diagnosis Navigator (off or on) is retained from the prior session. If the Navigator was displayed the 
last time you were in a patient chart, then it will display the next time. If you always want the Health 
Summary to be displayed, click the Health Summary button to hide the Navigator and leave it that way. 
Each time you log in you will see the Health Summary section instead of the Navigator.  You can always 
toggle back and forth, but remember that the last setting will be the one that you see the next time. The 
sample screens below show the toggle buttons in both Navigator and Health Summary modes. 
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Generated Text 
As part of the Diagnosis Navigator display, you will see the generated text from the template at the same 
time that the template items are being checked. As illustrated in the earlier example, this Generated Text 
pane runs vertically at the left of the template and just below the Diagnosis Navigator. Text appears in this 
pane as questions in the template are answered, providing a real-time view of what text in the note will 
look like as it is being generated. In addition, some text will show up highlighted in green to identify a 
“Nested” template (see Nested Templates for details). Clicking this highlighted text will launch a nested 
template just as if the nested template icon were clicked from within a template. 

Note:  The option to reopen a template to a specific question by clicking the text for the answer (a 
feature of templates available in the Visit or Order Note) is not available in the Diagnosis Navigator 
Generated Text window. 

Legend 
A Legend feature is built into the Diagnosis Navigator.  It is found in the 
Generated Text section and is represented by a blue question mark  icon. 
The legend describes the function of the icons that are available in the 
templates.  

Navigating from Template to Template 
The Diagnosis Navigator lists any diagnoses or complaints that exist in a 
Visit or Order Note when an HPI, PLAN or Procedure Template is open.  
You can navigate between the templates that are linked to these 
diagnoses or complaints without closing the templates and returning to the 
note. 

To navigate between templates: 
1. In a Visit or Order Note that contains more than one diagnosis or complaint, with a template for 

one of those diagnoses or complaints open (the complaint whose template is open should be 
highlighted in yellow), click one of the other complaints in the list. 

2. If there is only one template associated with that complaint, the template will open and 
documentation can start. 
OR 
If there is more than one template associated, the Linked Template window will open and you can 
choose the appropriate template to start documentation.  

Closing Templates 
In most Windows-based programs, to close a window or form you must click the X in the top-right window 
corner or use a sequence of keystrokes (such as File and Exit).  The resolution of some computer 
screens makes it difficult to hit the X and tablet computers do not have easy access to keyboard. That 
makes the closing of items that are used frequently, such as templates, more difficult and time 
consuming.  To alleviate those issues, and to help speed documentation, the Template Launcher 
bypasses this requirement and allows a user to click anywhere outside of the template (and Diagnosis 
Navigator) to close the template.   
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Nesting Templates 
Nested Templates allow users to open a completely different template directly from within another 
template without closing the first template.  For example, from within a "cough" template a user can 
document that a patient has an associated symptom of fever.  The cough template only allows for a brief 
documentation of fever and, in order to document the fever in more detail, you might choose to open a 
complete fever template through a nested template.  In other products this might require that you close 
the cough template and select a fever template. With e-MDs Chart you can click an icon within the cough 
template and access a fever (or other linked template) directly from the current template. 

Note:  Nested templates have a one-to-one relationship with template questions.  In other words, only 
one template can be linked (or nested) to a template question. 

Accessing Nested Templates in a Note 
Nested Templates are launched directly from a template question.  
Nested Templates are linked to a template question in the Template 
Editor and are represented in the Template Launcher in Chart by an icon 
containing a piece of paper with a chain link across it .  This sample 
screen segment shows a template containing multiple questions that are 
linked to a nested template.  To launch a nested template, click the 
nested template icon  and the linked template will open immediately. 

Nested Template Text 
Any text generated from a nested template will be embedded within the text of the original template.  This 
text becomes part of the paragraph that appears under the original template’s diagnosis.  However, you 
also have an option to separate this text by dropping in a separate diagnosis for the nested template.  For 
example, if you open a nested template for fever from within a cough template, you can choose to drop 
fever in as a diagnosis of its own (by clicking a Process ICD icon in the template). When you do that, all 
the text associated with the fever template will be moved into a new paragraph under the fever diagnosis. 

To separate nested template text: 
1. Open a template that has a Nested Template available. 

2. Click the question with the nested template. 

If there is an ICD code associated with the question a gold cog  icon will be displayed to the 
right of the question. 

3. Click the Gold Cog icon to force the ICD to drop into the note as a separate diagnosis. 

4. Click the Nested Template icon to open the nested template and document, as needed. 

5. When the template is closed the ICD will appear in the note with the template-generated text 
under it. 

Nested Templates are linked to a template question in the Template Editor.  For more details on creating 
and editing templates in the Template Editor, see the "Individual Template Items" section of the "Creating 
and Modifying Chart Templates" chapter in e-MDs Solution Series Administration Guide.  Note that you 
must have the appropriate user access level to open and use the Template Editor. 

To add nested templates to a template item: 
1. Open the Template Editor. 

2. Edit a template. 

3. Choose the question to which you want to link a Nested Template. 
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4. In the Template Editor, highlight any template item and click the arrow next to Edit (located at the 
bottom of that level’s window). This opens the Edit Item Properties window.   

5. In the Edit Item Properties window, click Linked Template. 

6. Click the Link a Template to Item check box.  The Template Catalog window will open. 

7. Find the desired template, highlight the name and click the Select button at the bottom-right 
corner. 

OR  

Double-click the template name. 

The template name will be displayed in the Linked Template field. 

Editing Templates on the Fly 
The Template Launcher is the module that presents and displays the templates in a Visit or Order Note.  
The Template Editor is the module used to create and edit templates that are displayed in the Template 
Launcher.  You can switch between the functionality of the two on the fly while in a Visit or Order Note. 

Note:  Template editing on the fly is not available with ROS (Review of System) templates.  This is due 
to their potential relationship to Fast Forms.  If an ROS template that is linked to a Fast Form is edited, 
the linked Fast Forms will be deleted. 

You can easily add a new item to a template without switching to Editor mode by clicking the Add Item 
button at the bottom of the template level to which the item is to be added.  This is a quick and easy 
feature for adding template items that already exist in the Template Library. However, sometimes new 
items need to be added or existing items need to be edited or resequenced.  Switching to Editor mode 
allows more flexibility in created and editing template items. 

To access Editor Mode: 
1. While in a Visit or Order Note with a template open, click the 

Editor button at the bottom-right corner of the template level. 

The template will switch from Launcher to Editor mode. 

2. Make changes as necessary. 

Note:  While most of the functionality of the Template Editor is available with this feature, not all 
functionality is available here.  For example, you will not be able to create new templates in this 
manner. 

Important!  If the template that is being edited is a Generic type (either HPI or PLAN), a copy 
of the template will be made and you will be prompted for a name to use for the template.  This is 
done to prevent overwriting of Generic templates. 

At times, the addition of an existing template item is all that is needed in order to deal with a template that 
is missing information. 

To add an item to a template on the fly: 
1. While in a Visit or Order Note with a template open, click the Add Item button at the bottom-left 

corner of the template level. 

The Template Library Browser will open. Categories of reusable items are listed in the left pane. 

2. Click a category to display a list of reusable template items on the right. 

3. Click to select the reusable item, then click the Select button at the bottom-right corner of the 
Template Library Browser window. 



 

e-MDs Solution Series Chart User Guide 8.0 R01 274 

OR 

Double-click the desired reusable item. 

If a template item is inadvertently added to a template, or if you no longer need a template item, it can be 
deleted. 

To delete an item from a template on the fly: 
1. While in a Visit or Order Note with a template open, highlight the item to be deleted. 

2. Click the Delete Item button at the bottom-left corner of the template level. 

A confirmation window will appear that asks “Do you really want to delete the question “Item 
Name"? 

3. Click Delete to delete the item. 

OR 

Click Keep to cancel the deletion. 

Accessing FlowSheets in Templates 
To save time in capturing lab results from FlowSheets for inclusion in Visit or Order Notes, some 
templates contain links to the templates containing those FlowSheets.  Use the following steps to capture 
those lab results and insert the information in a Visit or Order Note. 

Note:  The following procedure only works when the FlowSheets Extended Attributes have been 
implemented in a template.  For details on how to set up this access, see "Adding Access to FlowSheets 
in Templates" in the "Creating and Modifying Chart Templates" chapter of the e-MDs Solution Series 
Administration Guide. 

To access and extract lab results from a FlowSheet: 
1. Open the appropriate template for the Chart task being performed.   

2. If only one FlowSheet is associated with the template, that FlowSheet will display automatically.   

Note:  If the single predefined FlowSheet is not currently in the patient's list of FlowSheets, all 
patient-specific FlowSheets will appear with the following message:  FlowSheet name is not 
currently in the patient's chart.  Please add this FlowSheet using the Add a FlowSheet 
button (blue plus icon) as necessary.   

If more than one patient-specific FlowSheet is available for access through the template, the 
entire list of FlowSheets displays, ready for you to access any listed templates to add or extract 
information. 

3. When the Lab/Results: FlowSheet window opens, click to select a template in the left pane to 
display available information. 

4. Perform any of the following tasks to add, modify or delete information in the FlowSheet and 
select it for inclusion in the note: 
○ To enter new data in an empty cell or modify existing data, double-click the cell and type the 

new data.  
○ To add a new date to the FlowSheet, click New Date in the screen toolbar and a new date 

column will be inserted.  (This works the same as adding a new date in a FlowSheet outside 
templates.) 

○ To delete data in a cell where data was entered by a user, click to highlight the cell and click 
Delete.   
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○ To set a date range preference for how far back the available lab results should be displayed, 
click Value Range and specify the begin and end dates to be used. 

When you perform any of the above tasks, the affected cell and value is automatically selected 
and a green check mark appears in the cell. 

5. To drop the selected values into a Visit or Order Note, click Select.  The data from the FlowSheet 
will be written to the note in the format similar to the following example: 
Weight (lb): 220.0 (09/25/2003), 222 (09/28/2003), 222.0 (11/01/2003) 218.0 
(11/05/2003); LDL: 130 (09/25/2003), 128 (09/28/2003), 99 (11/01/2003), 99 
(11/05/2003) 

Note that any abnormal results appear in bold font to highlight them in the V or Order Note. 

Processing ICD and CPT Codes 
Some templates, such as the HPI, have ICD codes linked to a question. Unlike a CC template where you 
always want the ICD to drop into the note if you choose the question, with an HPI template you might not 
want to drop an ICD in if you are only documenting a symptom.  A similar situation exists with CPT codes.  
Process icons in the templates allow you to choose whether to add the codes or not. 

With the Assert EA as Default option the cog is already displayed in the template as selected, thereby 
adding the code by default.  You still have to option to deselect that cog to not add the ICD or CPT code.   

HPI and Exam templates have a Process ICD option that is represented by a gold cog  icon. This 
option allows you to choose whether to drop an EA associated with a template question into the note. 
Exam, Procedure, and Plan templates also have a Process CPT option that is represented by a red cog 

 icon.   

To process an ICD code: 
1. Open an HPI or Exam template that has a question that has an associated ICD code. 

2. Click the question with the ICD code.  If there is an ICD code associated with the question, a gold 
cog  icon will be displayed to the right of the question. 

3. If you want to drop the ICD code into the note, click the gold cog icon if it is not already selected. 

OR 

If you do not want to drop the ICD code into the note, click the gold cog icon to clear (reset) the 
option. 

To process a CPT code: 
1. Open an Exam, Procedure or Plan template that has a question that has an associated CPT 

code. 

2. Click the question with the CPT code.  If there is a CPT code associated with the question, a red 
cog  icon will be displayed to the right of the question.  

3. If you want to drop the CPT code into the note, click the red cog icon if it is not already selected. 

OR 

If you do not want to drop the CPT code into the note, click the red cog icon to clear (reset) the 
option. 
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To add a process ICD or CPT code to a template: 
1. Open the desired template from within a Visit or Order Note. 

2. Click the Extended Attributes (rolodex card) icon next to the desired item.  This will launch the 
Select Extended Attributes window. 

3. Highlight either CPT or ICD, as applicable. 

4. Click OK to launch the CPT or ICD Search screen. 

5. Search for the desired code. 

6. Highlight the code and click Select. 

OR  

Double-click the code. 

7. If you want the code to be automatically added to the note every time (by default, the icon is  
depressed), click Assert EA as Default. 

8. Click OK. 

9. Click Launcher in the bottom-right corner to resume work in the note. 

Designating Items as Confidential 
Template questions can be designated as Confidential.  Setting a question to the confidential state 
causes the generated text to be hidden when the Confidential Item button is selected to hide confidential 
information.  When the information is hidden it will show up in the note but will be blacked out so that it 
cannot be identified.  Questions in templates can be set up to default to Confidential from within the 
Template Editor and “on the fly” from within a Visit or Order Note.  

Note:  The ability to view confidential items is a privilege that is set up through security and associated 
with your login.  If you are unable to view items set as confidential, see your administrator. 

Setting an item as confidential on the fly, from within a note, only marks that item as confidential for that 
patient in that note.  Items can also be set to be confidential permanently, but that must be done in the 
Template Editor. 

To set confidential items on the fly: 
1. While in a Visit or Order Note, open the template. 

2. Right-click the item to be marked as confidential. 

3. Select Temporarily Set as Confidential from the pop-up menu. 

Note:  You can also choose to Temporarily Set all items in this level as Confidential to set 
every question on the level as confidential (for example, all of Level 2 in a template). 

4. Questions marked as confidential will appear in green text in the template and will appear as 
blacked out items in the note itself (if the Confidentiality option is turned on). 

Template items can be permanently set to Confidential in the Template Editor. Some template items such 
questions about HIV or mental illnesses are candidates for permanent confidentiality status.  Marking the 
template questions in this manner assures that whenever the template is used the information will be set 
to confidential. 

To permanently set items as confidential: 
1. While in a Visit or Order Note, open the template. 

2. Click the Editor button. 
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OR 

In the Template Editor, open the template. 

3. Select the question to be marked as confidential. 

4. Click the Edit button at the bottom of the template level. 

5. Select the Set “Question Name” as Confidential Item menu choice. 

Note:  You can also choose to Set all items in this level as confidential. 

Removing a setting of "Confidential" on-the-fly from within a Visit or Order Note only marks that item as 
public for that patient in that note.  Items can also be permanently set to be public, but that must be done 
in the Template Editor. 

To temporarily change Confidential status: 
1. While in a Visit or Order Note, open the template. 

2. Right-click the item to be marked as Public. 

3. Select Revert back to Public Item from the pop-up menu. 

Note:  You can also select Revert back all items in this level as Public to remove the 
Confidential status for all questions in that level (for example, all of Level 2 in a template). 

Template items can be permanently set to Public in the Template Editor.  

To permanently change Confidential status: 
1. While in a Visit or Order Note, open the template and click the Editor button. 

OR  

While in the Template Editor, open the template. 

2. Select the question to be marked as Public. 

3. Click the Edit button at the bottom of the template level. 

4. Select the Set “Question Name” as Public Item menu choice. 

Note:  You can also select Set all items in this level as public. 

Managing Template Text 
In the HPI section, with the full generated text, it can sometimes be challenging to pick out pertinent 
information quickly.  The Outline Text feature allows you to decide if you want to see the HPI information 
in a Full Text view or an Outline view.  At its very basic level, the outline view places a carriage return 
after each sentence in the template for ease of viewing.  You can also set the template questions to 
generate a shorter, more concise text for the outline view.  For example, in Full Text view, generated text 
that reads:  

The problem has been present for 2 weeks. 

can be set to look like this: 

DURATION: 2 weeks 

By default the setting is to show the Full Text view that users are used to.  But the Outline View can be 
turned off and on “on the fly” by clicking a button at the top of the Visit or Order Note (Outline View or 
Full Text View). In addition, there is a user preference setting that allows you to permanently set your 
default to Outline View. 
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Setting Text to Bold 
This feature allows any template answer to be marked in bold text to draw attention to it.  In many cases 
this can be used to denote abnormal or positive findings but it may also be used for ANY situation where 
attention needs to be directed to text in a Visit or Order Note.  See "Individual Template Items" in the 
"Creating and Modifying Chart Templates" chapter of the e-MDs Solution Series Administration Guide for 
details.  

Randomly Changing Opening Text 
Templates have the option to randomly display opening paragraph text from templates in the HPI section.  
When the template is reopened, the text will change randomly to one of five phrases that were previously  
coded into the templates.   

For example, a paragraph generated from a Chest Pain template in the HPI section might start out with 
the opening text indicating "Patient complains of chest pain.”  However, if the template is reopened for 
editing, the text might change to “Patient to be evaluated for chest pain” or “Chest pain noted.”  

The random text feature works with opening text for Nested Templates as well.  With Nested Templates 
the random set of text is slightly different.  For example, in a nested template for depression the randomly 
generated text might be one of the following: 

"Regarding depression" 
"With regard to depression" 
"Per complaint of depression" 
"Per symptom of depression" 
"Concerning depression”  
“As for depression” 

Note:  This text is generated due to $OpeningSymptom and $OpeningCondition tokens being inserted 
into the Opening Text section of the HPI templates.  To view or modify them, open the template in 
Template Editor and go to Edit > Edit (at the top) and click Opening Text on the left. 

To remove some template text from a note: 
1. Click the template text in the note. The template will open. 

2. Clear any answers that are no longer needed. 

3. Close the template, when finished. 

To re-open a template to make changes: 
1. As the cursor hovers over template-generated text, text fragments highlight in green. With the 

mouse over any green-highlighted text fragment, left-click the highlighted text.  

The template will reopen, and the text fragment that was selected at the time of reopening will be 
highlighted.  

2. Make any desired changes. 

3. When finished, close the template by clicking the X in the upper-right corner of the first template 
window or click anywhere outside the template. If multiple template windows are open (as in a 
multi-level template), it is not necessary to close each window. Subsequent level windows will 
automatically close when the top-level window is closed. 

To completely remove a template from a note: 
1. Click the template text in the note. The template will open. 

2. Right-click any of the template questions. A pop-up menu will appear. 

3. Select Remove template from note. 
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OR 

As the cursor hovers over template-generated text, text fragments highlight in green. With the 
mouse over any green-highlighted text fragment, left-click the highlighted text. 

4. Click the icon at the top-left of the first template window. Depending on how the chart was 
opened, the icon is a either an orange chart icon (opened in Chart) or a purple person icon 
(opened in Tracking Board). The icon it is located to the left of the words "Level 1:" in the title bar 
of the template window. 

A pop-up menu will appear. 

5. Select the Remove Template from Note menu option. 

Viewing Template Messages 
Occasionally, when certain data elements are checked in templates, a yellow message box will appear in 
the lower-right portion of the screen. These messages are meant to be helpful hints for the healthcare 
provider and include items such as differential diagnosis hints or "best practices" guidelines. 

The message boxes cannot be turned off, though it is possible to remove individual messages, one at a 
time, from templates in the Template Editor. 

Caching and Flushing Templates 
In prior versions of e-MDs Chart, there was a noticeable lag when opening some of the larger templates 
(such as Exam and PMH templates). Because template speed is crucial, e-MDs Chart includes "template 
caching" to improve performance.  

Caching Templates 
When a template is cached, a copy of the template is downloaded from the server and stored or “cached” 
on the local workstation. This provides a faster response time when opening a template because the 
information is stored locally and does not have to be fetched from the server. Flushing the template cache 
becomes necessary when changes have been made to a template and a version that is newer than the 
one stored on the local workstation exists on the server.  

In previous versions users were required to manually flush the template cache any time a change to a 
template was made. In current versions of Chart, template caching has changed so that the application 
tracks the version of the template that is cached along with the version of the template that is stored on 
the database. Now, whenever a template is opened the application checks to see if a newer version 
exists on the database.  If a newer version does exist, the application automatically flushes the cache and 
downloads the newer version.  In most cases the addition of this feature eliminates the need to manually 
flush the cache when changes are made to a template. Since this flushing occurs whenever a version of a 
template that is newer than the version on the local workstation exists, it also eliminates the need to go to 
every workstation and flush the cache when changes are made. 

Keep in mind that template caching is machine-specific, and a separate cache is saved to each computer, 
depending on which templates have been used on that machine. 

Flushing Templates 
After a template has been used on a particular computer, it resides in the template cache of that 
computer. Suppose that you now use the Template Editor to make edits to that template. If the cache is 
not flushed after the changes are made, the next time that particular template is called, the computer will 
display the old, unedited version that still resides in the cache.  

Current versions of Chart have a template versioning feature that determines if a new version of a 
template exists anytime a template is opened.  If a new version does exist the program automatically 
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deletes the template cache for the selected template Only.  This avoids the need to flush the template 
cache manually.  However, there may be times when it is necessary to flush the cache manually. 

Note:  If it becomes necessary to flush the cache manually, it must be flushed on each machine. Realize 
that this flushes the entire cache, not just a specific template. Also, the first time you open any large 
template after manually flushing the cache, there may be a delay. 

To flush the template cache: 
1. Open e-MDs Chart. 

2. Click Tools on the main toolbar. 

3. Click the Flush Template Cache menu option. This will flush the cache immediately, though 
there is no visual confirmation of that fact. 
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7 
Tracking Patients and 

Workload with 
Tracking Board 

Tracking Board allows healthcare providers and administrative staff to see an 
overview of their daily workload and track patients through the clinic all on a single 
screen.  

Continued on the next page ... 
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Understanding the Tracking Board Interface 
The following is a brief overview of the various components, along with links to detailed instructions for 
each part. 

Main Page Menu  
File User Preference Options are accessed via the File menu.  Because Tracking Board 

involves e-MDs Schedule and tracking of patients through a facility, the Internal 
Facility must also be set.  The charts of any patients who do not appear on screen 
can also be opened from the File menu. 

Demographics Provides access to demographic search and maintenance windows for Patients, 
Guarantors/Policyholders, Persons/Contacts, Providers & Staff, Organizations and 
Medical Facilities. 

Reference The Reference menu provides access to the Rooms maintenance,  as well as the 
Clinical Reference Libraries which include the ICD-9 search, CPT search, HCPCS 
search, Medical Art, Patient Education, Curbside Consults, Drug Consults, Drug 
Education,  Patient Instructions and Policies. 

Tools This provides access to several tools that are used in Tracking Board and also 
provides access to other workflow modules.  The Tracking board specific tools are 
Refresh which refreshes the information in Tracking Board, Hide/Show Rules 
which turns the rule-based reminders section off or on and Clear Rooms from 
Previous Day which empties all rooms that may have had patients unintentionally 
left in them from previous days.  Other modules that are available from this menu 
are Letter Editor, Phone-in Scripts, DocMan, FlowSheets, TaskMan, Order Tracking, 
HealthCare Visit Signoff (Unsigned Notes module), Referrals/Authorizations, Flush 
Template Cache, Memory Monitor and Spell Check Configuration. 

Reports This provides access to the Reporting functionality of Chart.  This includes access to 
Unsigned Notes Report, Crystal Reports and Forms/Letters. 

Help This provides access to the Legend and the Help system. 
 
Main Page Toolbar  
Open Patient Chart  
(Yellow Chart) 

The first button on the toolbar allows the user to open a chart of any patient who 
does not appear on screen. 

Log Off 
(Gold Key) 

The second button allows the user to log off the application. 

Refresh 
(Gold Circle and Arrows) 

The third button is a Refresh.  Because patients appear in the Waiting Room (in 
Tracking Board) once they are “checked in” in e-MDs Schedule, the Tracking Board 
screen must refresh periodically for these new patients to appear.  The frequency of 
automatic refreshes can be set under Options, but a manual refresh will occur 
anytime this button is clicked. 

TaskMan 
(Envelop) 

The fourth button launches Task Man and opens the Inbox of the user who is logged 
in.  Note that the number of unaddressed messages and tasks can be viewed in the 
Workload section of Tracking Board, and TaskMan can also be launched directly 
from that window. 

Show Rules 
(Person and Check mark) 

The fifth button is a toggle that will turn the rule-based reminders (automated clinical 
reminders) section off or on. 

Show Patients For This field allows users to select the resources to be monitored. 
Custom Resource Filter This button allows users to create a “Custom/Multiple” list of resources to monitor. 



 

e-MDs Solution Series Chart User Guide 8.0 R01 284 

Patient Information 
Display Options 

This option allows users to choose how patient names are displayed in Tracking 
Board.  Choices are to not display the name, display as initials or as full name.  The 
default setting is dependent on the choice made in the Options screen under the 
Patient Names tab (see User Preference Options for details).  This prevents casual 
views of potentially sensitive protected health information (PHI).  Click the desired 
button to toggle between views. 

Legend This button opens a window that illustrates what each of the items in the Tracking 
Board represents. 

Help 
(Blue Circle with Question 
Mark) 

The sixth button launches the electronic Help files. 

Exit 
(Red X) 

The last button closes the Tracking Board application. 

The Waiting Room Once a patient is "checked in" in e-MDs Schedule (see the Help files for that 
application), he or she will appear in the Waiting Room section of Tracking Board. 

Room Status Patients can be moved from the Waiting Room into a treatment room. The Room 
Status window displays a multiple of information, including various types of time 
tracking, the reason for visit, whether or not the patient is overdue for preventive 
care or disease/drug management issues, and the status of physician orders. See 
that section for full details. 

Rules The bottom of the Tracking Board screen displays rule-based reminders (i.e. 
overdue or coming due preventive care measures, disease or drug management 
issues, or immunizations) and a photo of the selected patient. This window can be 
turned off. 

Checked Out When a patient is checked out of a room, he or she will then appear in the Checked 
Out list. Color coding here identifies whether the note has been permanently signed, 
creating an end-of-day chart "clean-up" list for the physician. 

Workload This window displays outstanding TaskMan messages and tasks and also identifies 
any urgent or STAT messages. Clicking the message folder will automatically 
launch TaskMan. 

Schedule An overview of the monthly schedule is visible in the lower left corner. E-MDs 
Schedule can be launched directly from here as well (see "View of e-MDs Schedule 
from Tracking Board" for full details). 

Selecting the Facility 
Because Tracking Board deals with e-MDs Schedule and patient tracking through a facility, the 
application cannot be used until a facility has been selected. 

To select a facility: 
1. Click File and then select the Change Internal Facilities menu option. 

2. Search for the desired facility in the Find Internal Facility window. Type part of the clinic name 
and hit Enter, or click Search for an entire list of available facilities. 

3. Highlight the correct facility from the search results and click Select. 

4. Click File and verify that the chosen facility name appears in parentheses after next to the 
Internal Facilities menu item. 
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Setting User Preference Options 
As a user preference the column widths in the grid areas of Tracking Board (Waiting Room, Room Status, 
Checked Out, etc.) can be resized.  These changes to the columns widths are saved as the preference 
for the user logged in when the changes are made. This allows users to customize the look of the 
application to better suit their workflow. 

Note:  To make changes to all of the options in Tracking Board, except Workload, a user MUST have 
the Tracking Board Administrator privilege. 

To set user preference options: 
Privileges Required:  Tracking Board Administrator 
1. Click File and then select the Options menu item. 

2. Click the Application tab. 

○ Application Timeout: This allows an automatic time-out that will log off the user after the set 
amount of seconds. This is a security feature that prevents unauthorized access to the 
application in the case that a user forgets to log off. If set to zero seconds (the default), there 
is no time-out. 

○ Auto-Refresh: Because patients appear in the Waiting Room section after they have been 
checked in through e-MDs Schedule, it is important that the Tracking Board screen refresh at 
a fairly frequent interval so that these patients appear without delay. The user will notice a 
quick flash on screen every time a refresh occurs. The default setting is 120 seconds but can 
be changed. 

○ Show Appointments: The typical clinic should choose For Today (the default setting), which 
ensures that all patients scheduled on a particular day will remain on screen in Tracking Board 
during that calendar day. However, the "day" ends at midnight, so for an urgent care facility 
that is open 24 hours a day, a "running schedule" should be set with any time span desired. 
For example, a facility may choose to show all patients scheduled "from 12 hours ago through 
12 hours from now." Remember that patients who have been Checked Out will “disappear” 
from that window after this time period. So, if a physician’s shift is longer than 12 hours, adjust 
the running schedule accordingly so that all patients seen during the shift will still be visible at 
the end of the shift, allowing the physician to verify that all documentation is complete and all 
notes are signed. 

3. Click the Check In tab. 

○ The second column in the Room Status window displays the patient’s Check In time. Because 
the actual appointment time is not displayed, color-coding of this text is used to identify 
whether the patient arrived early, on time, or late. The user chooses what time frame is 
considered early or late. The default setting is 15 minutes. In this case, patients checked-in 
more than 15 minutes before the scheduled appointment time will appear in green text, and 
those checked in more than 15 minutes late will be in red. 

4. Click the Room Status tab. 

○ When a patient is taken to an examination room, the clock measures the wait time from that 
point up until treatment begins. Background color-coding of the In Room column gives a visual 
indication of how long each patient has been waiting. After a moderate wait, the background 
turns yellow, and after a long wait, the box turns red. The user can decide the number of 
minutes considered to be "moderate" and "long", and enter this into the Moderate Wait and 
Long Wait fields. The default settings are 10 minutes for moderate, 20 minutes for long. 

○ Treatment Warning is visual indicator of how long the physician is spending with the patient in 
comparison to the time allotted for that appointment. The Treatment column identifies this with 
text and color. For example "15/20" indicates that treatment up to this point has taken 15 
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minutes, and the appointment is scheduled for 20 minutes. After a specified percentage of the 
appointment time has elapsed, the field will turn yellow, and if more than the allotted time has 
passed, the field turns red. The default setting for the yellow treatment warning is 75% of the 
allotted time. 

5. Click the Workload tab.  

○ The High Volume Warning refers to the number of unread messages and tasks waiting in the 
user’s Inbox. The Workload window in Tracking Board shows the actual number of messages 
and tasks waiting, and folders give a visual indication of the volume, as well. The folders are 
blue when empty, and will turn yellow when at least one message exists and red when the 
High Volume number is reached. 

○ There are three default folders that appear in the Workload window: The Messages folder is 
the “parent” folder and shows the total number of unread messages in TaskMan.  The Urgent 
(urgent and/or STAT messages), Overdue (overdue tasks assigned to the user or that the 
user assigned to someone else) are the other two folders.  These categories cannot be 
changed.  However, unlimited additional categories can be added.  (Remember that ALL 
messages will show up under the Messages folder, so it is not necessary to show specific 
message categories in all cases).  Click the down arrow in the Message/Task Categories 
field for a list of all TaskMan categories. Place check marks next to those that are to be added 
to the Workload field in Tracking Board.  Although an unlimited number can be chosen, for 
practical purposes, only two or three additional categories will show on screen at one time.  
Additional categories can be added and accessed by using the scroll bar. 

6. Click the Patient Names tab. 

○ This option allows users to choose how patient names are displayed in Tracking Board. This 
prevents casual views of potentially sensitive protected health information (PHI). Choices are 
to not display the name, display as initials or as full name.  Click the desired button to toggle 
between views.  The choice made here sets the default setting for this option.   Users can 
change the setting on the fly by selecting one of the 3 buttons on the main Tracking Board 
toolbar but when they log into Tracking Board the choice will revert to the default setting.  

Selecting Resources to View 
The Tracking Board view can be set to show a single resource schedule (provider, service or equipment), 
a custom list of multiple resources or the entire clinic schedule.  This option is helpful when nurses room 
patients for more than one provider and/or need to see patients who are scheduled for lab draws. 

To select a single resource or all resources: 
In the toolbar, click the down arrow in the “Show Patients For” field.  Select a single resource 
name, the custom/multiple choice or All Providers. 

To create a custom list of resources: 
1. Click the Groups button to the right of the Show Patients For field. 

2. This will open a window that displays a list of available resources (provider, service and 
equipment). 

3. Select the desired resources by clicking the check box to the right of the resource.  

4. When all the resources have been selected click the Save/Edit Group choice at the bottom of the 
list.   

5. This will open a pane with a choices for saving the group as: 
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○ Only me in Tracking Board (only the person logged in will see this group and only when in 
Tracking Board, not schedule) 

○ Only me, All Applications (only the person logged in will see this group in both Tracking 
Board and Schedule) 

○ All users of Tracking Board (this group will appear for all users in Tracking Board) 

○ All users, All Applications (this group will appear for all users of Tracking Board and 
Schedule) 

6. Choose who will see the group 

7. Next, type a name for the group in the Save Group As field. 

8. Click the Save Group As button (floppy disk icon) when finished. 

9. Click the Groups button again to close the window. 

This will save the selected resources as a custom group choice that will show up in the Show 
Patients For drop down list. 

Both the Waiting Room and Room Status windows contain a Provider column. If the All Provider view is 
chosen, click the Provider column to sort all patients by resource. 

The Appointment Schedule in the lower left window shows schedule density for either a single provider or 
for the entire clinic, depending on the view chosen. If the single physician view is selected, an additional 
graph below the calendar shows scheduling density per hour (for a 9-hour day). 

Note that the Workload window displays TaskMan messages and tasks for the person logged in, 
regardless of which view is chosen. So, for example, a nurse may use the single provider view to see the 
patients scheduled for the physician, but still has access to her own TaskMan messages (not the 
physician’s). 

Opening a Patient Chart from Tracking Board 
If a patient’s name appears anywhere within Tracking Board (i.e. in the Waiting Room, in an exam room, 
or Checked Out), click it and select Open Chart. 

To open any other patient, click File and then select Open Patient Chart. Or, click the Open Patient 
Chart button (the first button on the toolbar, with the yellow chart icon). Search for the patient, select the 
name from the search results, and click Select. 

Using the Waiting Room 
The upper left window in Tracking Board displays patients in the Waiting Room. Patients must be 
"checked in" in e-MDs Schedule in order to show up in the Waiting Room (see e-MDs Solution Series 
Schedule User Guide for detailed instructions). 

1. There is some intelligence built into patient sorting in the Waiting Room. In most cases, the 
patient at the top of the grid should be taken back to an examination room first. By default, the 
grid will sort in the order that the patients check in. For late and early shows, check-in sort order 
will be modified with the following default times. For each 10 minutes early, 5 minutes is 
subtracted from the scheduled appointment time (maximum of 20 minutes subtracted). For each 
10 minutes late, 10 minutes will be added to the scheduled appointment time (maximum of 30 
minutes added). 

2. Thus, if a patient has a 9:15 A.M. appointment and arrives at 9:05 (10 minutes early), for sorting 
purposes, his appointment will be seen as 9:10 (5 minutes subtracted). So, he will be put back 
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after a patient with a 9 A.M. appointment but before any other patients with a 9:15 A.M. 
appointment. 

3. Likewise, if a patient has a 9:15 A.M. appointment and arrives at 9:30 (15 minutes late), his 
appointment time will be seen as 9:25 A.M. (10 minutes added). So, other patients with a 9:15 
A.M. appointment who arrived on time will be moved into an exam room first, but he will still be 
put back before a 9:30 A.M. appointment. 

The columns in the Waiting Rooms are as follows: 

• Age/Sex: Displays patient demographics 

• Stat: Displays urgency of visit: green is routine, yellow is urgent, red is emergent. This 
determination is based on the status recorded in e-MDs Schedule; however, it can be changed in 
Tracking Board by clicking in that field and picking another status from the menu. 

• Patient: Shows patient name. Click the Patient column header to re-sort alphabetically. After 5 
seconds, the order will revert to the automatic sorting. 

• Provider: Displays the name of the provider the patient is scheduled to see (displayed as the first 
3 letters of the last name followed by the first initial of first name). Click the Provider column 
header to re-sort patients, grouping them by provider. After 5 seconds, the order will revert to the 
automatic sorting. 

Checking a Patient into a Room 
Rooms (number and description) for each facility are created in e-MDs Schedule. See the Help files for 
that application for full instructions. 

By a quick glance of the Room Status window, it is clear which rooms are available. Any rooms with a teal 
green background are empty. Brown rooms are those in which the patient has been checked out, but the 
room has not been cleaned.  

To mark a dirty room as clean: 
Click anywhere on the brown line and click the Room Clean menu option. (A patient can be checked 
into a room even if it is marked as Dirty.) 

To move a patient into a room: 
Click the patient name in the Waiting Room and select the In Room menu option. In the Select Room 
window, all room numbers and descriptions are displayed; rooms in red text are occupied. (However, 
it is possible to put more than one patient into a single room.) Highlight the desired room and click 
Select. 

To move a patient back to the waiting room: 
If a patient is inadvertently put into an exam room, they can be moved back to the waiting room.  To 
do this, click the patient name (in the Room Status) and select the Back to Waiting Room menu 
option. 

To move a patient to a different room: 
Click the patient name (in the Room Status) and select the Move Patient menu option. In the Select 
Room window, all room numbers and descriptions are displayed; rooms in red text are occupied. 
(However, it is possible to put more than one patient into a single room.) Highlight the desired room 
and click Select. 
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Marking a Patient as Next/Ready 
After a patient is checked into a room, initial information is collected and the patient is ready to be seen by 
the provider it is helpful to be able to mark that patient as next in line to be seen by the provider.  To do 
this click the patient’s name and select Ready for Provider from the pop up menu.  The first patient 
marked this way will show up with the designation Next with a green background in their Treatment 
column.  Any additional patients selected as Ready for Provider will show up with the designation Ready 
in their Treatment column.   

Once treatment has been started on a patient the Next/Ready designation will change to the normal 
display for the Treatment column.  The Treatment column displays two numbers separated by a forward 
slash.  The first number represents the amount of time since treatment was started.  The second number 
is the time allotted for that appointment.  For example, “15/20” indicates that the physician has spent 15 
minutes (and counting) with the patient and that the appointment is scheduled for a 20 minute slot. 

When a patient is marked as Next and treatment is started, the next patient marked as Ready will change 
to Next.  If multiple patients are marked as Ready, the one that is calculated to be next will be marked as 
Next.  This calculation is based on the patient’s appointment time and whether they were early or late 
being checked in.  This allows patients to be seen in the order they are scheduled. 

Understanding the Room Status Indicators 
The Room Status window is located at the upper right section of the Tracking Board application. It tracks 
the status of the facility’s rooms, patient wait times, and physician’s orders, among other things. An 
explanation of each column is below. 

Room Status Indicators  
Room Lists room number. Click column header to sort by numerical order. 
Orders Displays status of any physician Orders from the associated Visit or Order Note. 

Various icons denote a variety of order statuses. In addition, click anywhere in the 
Order field and select the Show Orders menu option for a list of the Orders. To 
change the status of any order, click it for a status menu, and then click the 
appropriate menu option. The various order statuses are explained below: 

• Not Yet Addressed: Unaddressed Orders are noted by a black check mark 
icon. In the Show Orders window, these Orders are displayed as black text 
on a white background. 

• STAT: Orders with a "STAT" priority are noted by a red exclamation point 
icon. In the Show Orders window, these Orders are displayed as white text 
on a red background. 

• Results Pending: Orders with pending results are noted by a clock icon. In 
the Show Orders window, these Orders are displayed as black text on a 
yellow background. This status is for labs or tests that are done in-house 
and the results returned before the patient leaves. This status indicates that 
the nurse has addressed the order (and for example, obtained a blood or 
urine sample), but that the results are not back. 

• Results Back: Orders with results back, awaiting physician review, are 
noted by a green back-arrow icon. In the Show Orders window, these Orders 
are displayed as white text on a green background.  

• Done: If an Order is done, there is no icon representation. (If all Orders are 
addressed, the black check mark disappears.) In the Show Orders window, 
these orders are displayed as gray text on a white background. 

Check In Displays the time that the patient checked in at the front desk. Green text indicates 
an early arrival, and red is late. Click column header to sort by time. 
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In Room Indicates the time that the patient was moved from the Waiting Room into an 
examination room. The background color of the cells is yellow if the patient has 
been waiting in the exam room for a moderate amount of time and red for a 
prolonged time. The number of minutes that determines a moderate or prolonged 
wait is a user preference (see the "User Preference Options" section of Tracking 
Board for details). Once treatment has begun, the background colors disappear for a 
less busy appearance on screen. Click column header to sort by time. 

Provider Displays the provider who the patient is scheduled to see (displayed as the first 3 
letters of the last name followed by the first initial of the first name). Click column 
header to sort by provider. 

Staff Determines where the provider in question last "started treatment." This is not 
determined by which workstation the provider is logged into, so it is not a fool-proof 
way to locate the staff member, but it helps. 

Age/Sex Displays the patients’ demographics. Click column header to sort by age.   
Patient Displays patients’ names. Click column header to sort alphabetically by patient 

name.  The background color of the patient name represents the Patient Type.  
Patient Type is a user customizable designation that can be set in Schedule.  For 
example a patient can be marked as “Handle With Care” and the background of the 
patient’s name will show up in the corresponding color.  A legend that explains the 
meaning of the specific colors is available in Schedule. 

Type Shows the type of visit (i.e. PE for Physical Exam, etc.) This is determined in e-MDs 
Schedule and Visit Types are a user preference. See that application’s Help files for 
details. Click column header to sort by type. 

Diagnosis Shows the reason for visit, as recorded in e-MDs Schedule. Click column header to 
sort alphabetically by diagnosis. 

Due Displays a red cell if the patient has outstanding rule-based reminders (i.e. overdue 
preventive care measures, disease or drug-management issues or immunizations). 
If the reminders window is turned on, these can be viewed at the bottom of the 
Tracking Board window. 

Physician/Provider Start After the patient is in the room and is marked as Next/Ready, the clinician clicks the 
patient’s name and selects Physician/Provider Start to open the note started by 
the nurse.  This action starts the clock running.  At this point, the Treatment column 
will display two numbers separated by a forward slash.  The first number represents 
the amount of time since treatment was started.  The second number is the time 
allotted for that appointment.  For example, “15/20” indicates that the physician has 
spent 15 minutes (and counting) with the patient and that the appointment is 
scheduled for a 20 minute slot.   
There is no background color if the physician is within the user defined “acceptable” 
time limits.  It turns yellow near the end of the allotted appointment time.  By default, 
the color turns yellow after 75% of the appointment time has elapsed, but this is a 
user specific option and can be changed.  The background turns red once more time 
has elapsed than has been allotted for this appointment.   For example, at 21 
minutes into a 20 minute appointment. 
Currently, there is no way to “stop” or “pause” the clock. If patients are sent to x-ray, 
for example, they will appear to have a longer treatment time than what was actually 
spent in treatment time with the provider. 
It is up to each clinic to set a policy regarding which actions constitute “treatment.”  
For example, a nurse may take the patient back to the room and collect vital signs, 
but the clinic may choose to start the clock counting when the physician opens the 
chart.  In this case, the nurse should select the Collect Vitals/Visit Note option to 
document the vitals. 
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Checking Patients Out 
When treatment is completed, a patient can be checked out by clicking his or her name in the Room 
Status window and selecting Check Out from the menu.  If Physician/Provider Start was never 
selected, the Check Out option will not be visible. 

The patient’s name will then appear in the Check Out window of Tracking Board (on the left side).  The 
name will not be highlighted if the note has been permanently signed off, but it will show up in red if it still 
needs to be signed.   

The Bill? column indicates whether the user has marked the Visit or Order Note as Ready to Bill.  This 
tells the billing staff that, even though the note is not permanently signed off, there will be no changes to 
the CPT or ICD-9 codes and an invoice can be created. 

The Orders column displays status of any Physician orders from the associated note. This is the same 
column that shows the Room Status (clean or dirty).  It enables tests and orders that may not have been 
completed prior to the patient being checked out to still be seen and dealt with from the Check Out 
window.  As in the Room Status area, various icons denote a variety of order statuses. Users can click 
anywhere in the Order field and select the Show Orders menu option for a list of the Orders. To change 
the status of any order, click it for a status menu, and then click the appropriate menu option. The various 
order statuses are explained below: 

This is a convenient end-of-day list for the physician. To reopen a note for signing, simply click the patient 
name and select the Collect Vitals/Visit Note menu option.  There is no need to “move” the patient out 
of the Checked Out window (and no way to do so).  At the end of the day (i.e. at midnight), this window 
will clear itself. 

Viewing a Patient Photo 
If a patient photograph has been saved with the Snapshot (Digicam) application, it will appear in the lower 
right corner of the Tracking Board window.  See e-MDs Solution Series Utilities Guide for Snapshot 
(Digicam) instructions.  Clicking the photo will cause it to appear in an enlarged format to make it easier to 
recognize the patient.  In addition to the photo, the appointment details for the patient will appear beneath 
the photo. 

Notes:    
• If the Show Patient Names is set to not show the patient names or to only the patient’s initials the 

patient photo will not appear.  However the photo can still be seen by clicking in the photo area.  
As long as the mouse button is held down the photo stay in view. 

• If Tracking Board is set to hide rule-based reminders, the photo will not appear.  To view both, 
click the fifth toolbar icon that looks like a blue person with a check mark. 

Viewing Rule-Based Reminders 
In Tracking Board, reminders generated by clinical rules display in the lower third of the window. To view 
an individual patient’s reminders, click the patient’s name.  Rules display must be activated in order to 
view rule-based reminders. (The Show Rules icon looks like a person with a check mark next to it.) 

Rule-based reminders are displayed in several views, and a set of action buttons is provided with each 
view. These views and action buttons are also available on the Reminders tab of the patient’s chart. For 
detailed information about the views and related action buttons, see the Rule-Based Reminders 
(Automated) section of chapter 3 in this user guide. 

To read more about rules, see the Using the Rule Manager chapter of this user guide. 
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Using Messaging and Task Management in Tracking 
Board 
The Workload window in Tracking Board (on the left side) displays visual indicators of the numbers of 
outstanding TaskMan messages and tasks to be addressed. The display reads from the Inbox of the 
logged-in user (not the Inbox of the physician selected at the top of the Tracking Board window). 

There are three default folders that appear in the Workload window: The Messages folder is the “parent” 
folder and shows the total number of unread messages in TaskMan.  The Urgent (urgent and/or STAT 
messages), Overdue (overdue tasks assigned to the user or that the user assigned to someone else) are 
the other two folders.  These categories cannot be changed.  However, unlimited additional categories 
can be added.  (Remember that ALL messages will show up under the Messages folder, so it is not 
necessary to show specific message categories in all cases). See "User Preference Options" to learn how 
to add additional categories. 

As the number of unread messages in each category increases the actual number of messages and 
tasks is displayed to the right of the folder.  The numbers will be displayed in parentheses and followed by 
a letter M or T to denote whether the items are messages or tasks. The color of a folder will change from 
blue (denotes no messages exist)  to yellow (at least one message exists) and then to red (denotes high 
volume based on User Preferences.   

Double click any folder to open the inbox category in TaskMan. 

Viewing e-MDs Schedule from Tracking Board 
A monthly calendar overview is present in the lower left corner of Tracking Board. Days in the past are 
represented by dark gray squares. Light gray represents those days in the future in which the clinic is 
closed (i.e. weekends). Teal green represents blocked days (holidays, personal days off, etc). If a red "a" 
or "p" appears in any square, it indicates that the AM or PM schedule (respectively) for that day is 
completely booked. 

Use the arrows and date fields at the top of the calendar to move forward or backward in time. 

Double-click the calendar to launch e-MDs Schedule. Schedule will open to the selected date. 

If the view of Tracking Board is set for a single provider, a status bar with 9 squares will appear below the 
calendar. This represents the schedule density (from green to yellow to red, with red being full) for each 
hour of the workday (for the current date). 

To the right of the calendar block is the number of Patients Scheduled for today (Sched), the number that 
have not yet been seen (not including no shows) or Checked Out (Left), and the number who did not 
show up (No Show). 
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8 
Tracking Orders 

The Order Tracking module is a workflow enhancement tool that provides an “at a 
glance” view of all tracked items from Visit or Order Notes. These tracked items can 
be tests, labs, procedures, referrals, consults or any other item that can be 
represented by a CPT, Custom CPT or HCPCS code and that requires tracking. 
Order Tracking works with the Lab Tracking module from previous versions of Chart 
to initially identify items that have been ordered for patients and then to provide 
feedback about whether the results are available or not.  In addition, information 
about abnormal and overdue results is available in order to provide the user with a 
mechanism to quickly identify and deal with situations that could affect patient safety. 
Other functionality allows the users (both providers and assistants) to communicate 
the status of the orders. For example assistants can change the status of a tracked 
order to notify the provider that the results are available, have been initially reviewed, 
any required additional information has been added and now the order is ready for 
the provider to review and deal with.  The provider then can access the results, 
perform a final review, document pertinent clinical information and then set the status 
to notify the assistant to contact the patient.  Other status indicators are available to 
mark the item to be held for review, if needed. 

The Order Tracking module also works in conjunction with the Chart View section of 
the patient’s chart. Within the Chart View section, a Lab/Test subsection now contains 
information about these Pending Labs.  When information needs to be reviewed from 
within the Order Tracking module, links with the patient chart take the user directly to 
the Chart View section and display the note, the tracked items and the results (when 
they become available).  Since the user is taken directly to the patient’s chart, any 
additional information that needs to be reviewed is quickly available to the user. 

Continued on the next page ...  
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Understanding the Order Tracking Interface 
The Order Tracking module displays information about tracked orders in a grid display much like a 
spreadsheet.  The information is displayed by patient per visit so that only one record per patient will be 
displayed for a single visit no matter how many orders are associated with that visit. 

Menu Items 
Menu items appear as words across the top of the application starting at the top left corner.  Clicking a 
menu item will display a list of choices associated with the menu.  The menu item choices for Order 
Tracking are listed below.  

File Menu  
Options See the Order Tracking Options section. 

 

Edit Menu  
Hold for Review This icon represents a status of Hold for Review and can be used anytime the 

record needs to be put on hold. 
Contact Patient A blue phone icon represents Contact Patient. This is used when the labs have 

been reviewed and are ready for the patient to be contacted with information 
concerning the results. 

Ready for Provider A green check mark icon represents that the record is Ready for Provider. This 
status can be used in situations where staff is tasked with reviewing information 
prior to a provider accessing it. 

Clear Status  Choosing this option will remove any status indicated in Order Tracking. 
Remove from list This will remove a highlighted row from the Order Tracking list.  However, results will 

still be present within DocMan and Chart View. 
Open patient visit  Upon highlighting a patient row and clicking this option, the user will be granted 

access to view the corresponding visit for which the highlighted labs and/or imaging 
orders were initially placed.  This allows a more comprehensive view of the 
circumstances and state of the patient leading to the placement of these orders. 

Add note This allows the user to make a note and attach it to the patient’s order results.  The 
Note Class allows for this to be categorized as a Log, Phone or Prescription Note 
and it can be permanent or temporary (sticky).  The checkboxes to the right of this 
window allow the user to mark the Note Confidential.  They can also Request and 
electronic copy of the Patient Summary or paper/fax versions of the patient’s 
medical record.  Once this note is signed-off by a provider, it will post within Order 
Tracking with the patient’s results. 

Refresh The Refresh button will redraw the screen and update any order-related information 
that has changed since the module was opened or since the last refresh occurred.  
Most actions that are taken within the Order Tracking module will cause a refresh of 
the screen automatically but there may be occasions when a manual refresh is 
desired.  In addition there is an automatic refresh of the screen that occurs based on 
a user specified time period.  The automatic refresh rate can be set in the Order 
Tracking Options screen (see Options).  Changes to the Automatic Refresh rate are 
login specific and will not affect other users’ refresh rate.  The default refresh rate is 
set to 2 minutes and while this value can be changed to a longer time frame it 
cannot be changed to a setting less than 2 minutes. 

 

Message  
New Message This opens a TaskMan window and allows the user to send a message to the staff 

or other providers. 
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New Message > Attach 
Chart 

This opens a TaskMan window and allows the user to send a message to the staff 
or other providers, with a specific patient’s chart attached. 

 

Task  
New Task This opens a TaskMan window and allows the user to send a task. 
New Task > Attach Chart This opens a TaskMan window and allows the user to send a task to the staff or 

other providers, with a specific patient’s chart attached. 
 

Tools  
Remove unmatched labs Users can select a date to change the status of and remove all pending unmatched 

orders.  This affects pending labs and radiology orders within the appropriate 
section of Chart View.  The dropdown will reveal a calendar by which a date can be 
selected for the removal of these items. 

Grid Settings • Restore Column Defaults: This will restore the default settings of the 
Order Tracking columns. 

• Apply Column Best Fit:  This option will help make the best use of space 
within the grid by auto-sizing the columns. 

• Toggle Grouping Panel: Sort the primary view by column headers. 
• Toggle Filter Panel: Add customized filters for the primary view. 
• Export to MS Excel: Save the primary view into an Excel spreadsheet. 

 
 

 

Help Menu  
Search Topics Selection of this choice will open the built in help files and allow users to search for 

help on specific topics. 
Legend The Legend button accesses a list of icons that appear in the application along with 

explanations of what those icons represent. 
About Selection of this choice will display a screen that shows the current version number 

of the application.  This information can be helpful when tracking down problems 
and may be asked for by the support department. 

 

Toolbar Items  
TaskMan This button allows the user to create either a blank Message or Task, with or without 

a patient’s chart attached. This can be useful in situations where issues arise that 
require a chart to be sent to another user in the clinic. 

Refresh The Refresh button will redraw the screen and update any order-related information 
that has changed since the module was opened or since the last refresh occurred.  
Most actions that are taken within the Order Tracking module will cause a refresh of 
the screen automatically but there may be occasions when a manual refresh is 
desired.  In addition there is an automatic refresh of the screen that occurs based on 
a user specified time period.  The automatic refresh rate can be set in the Order 
Tracking Options screen (see Options).  Changes to the Automatic Refresh rate are 
login specific and will not affect other users refresh rate.  The default refresh rate is 
set to 2 minutes and while this value can be changed to a longer time frame it 
cannot be changed to a setting less than 2 minutes. 

Legend The Legend button accesses a list of icons that appear in the application along with 
explanations of what those icons represent. 

Help The Help button accesses the built in e-MDs help files. 
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Patient Name Filter This filter allows the user to search by name to identify the patient all other patients 
from appearing within the Order Tracking window. 

Provider Filter This field allows the user to select the provider or providers whose information will 
show up in the Order Tracking grid.  When a provider logs in this field should default 
to the name of the provider logged in.  If a non-provider logs in the field will default 
to having no names selected.  In either case, once the user is logged in they can 
select one or more providers from the dropdown list by checking the box to the left 
of the name.  Once selection of the name(s) is completed clicking outside of the 
dropdown box will refresh the grid and show the pending labs for the selected 
provider or providers.  A selection for All Providers is also available and may be 
handy for an administrator to monitor the information on a clinic wide basis.  The 
selection of multiple providers allows users to monitor pending labs for multiple 
providers. In the case of non-providers this may be necessary when nurse or 
assistant is working with multiple providers and monitoring pending labs for them.  In 
the case of providers this feature may be necessary when the provider is covering 
for another provider that is out of the clinic or when a provider is supervising 
physician extenders or residents. 

Status Filter The Status filter allows the user to filter depending on different conditions associated 
with a patient’s results. See the next table, “Grid Columns,” for icon details. 

Date Ordered Filter The drop boxes within this section allow the user the ability to filter orders within the 
grid by a date range. Each dropdown will reveal a calendar. The first is for the user 
to select the beginning date in the range and the second (after the word ‘thru’) 
allows for the end range date to be specified. Once the desired time period has 
been indicated, click the Refresh button to see the filter results. The third ‘Presets’ 
dropdown allows for the quick selection of commonly used ranges. 

Order Type Filter If desired, this feature allows the user to filter their views.  Filters include All, Lab, 
Procedure and Radiology. 

HIPAA Patient Display This feature consists of a set of three icons that allow the user to select how 
the patient’s name will be displayed in the grid.  A user can select to show 
No Patient Name, Initials Only or Full Patient Name by clicking the first, 
second or third icon, respectively.  This is a common feature that is 
available in several e-MDs applications, useful for hiding or limiting the 
display of the patient name in situations where the computer screen can be 
seen by non-staff individuals such as visitors or other patients.   

 

Grid Columns  
Date Ordered This column displays the date that the pending orders were created. 
Overdue This column will display the Overdue icon IF at least one of the orders listed for the 

patient has not been marked as received, otherwise the cell will be empty. 
Determination of whether an order is overdue is based on information set up in the 
CPT and HCPCS search modules as described in the Lab Tracking help files (see 
Lab Tracking).  For example, a CBC may be set to be considered overdue if results 
have not been received within 7 days.  In this example on day 8 the cell in the 
Overdue column for that patient’s visit would display the Overdue icon. 

Abnormal This column will display the Abnormal icon if abnormal results return for a patient.  
Specifically, if at least one of the results linked to the displayed visit for a patient is 

abnormal, a red triangle  will appear in this column. If the clinic is using an e-
MDs lab interface, abnormal results will enter automatically, provided this data is 
sent by the lab processing the results.  If the clinic is receiving lab results via paper 
or fax, the abnormal flag must be set manually in DocMan for this column to be 
populated.  This usually occurs when the result is scanned into the patient’s chart, 
but can also be set after the fact. 
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Priority This column will display an icon if a priority has been indicated for one of the 
documents containing patient results. If the clinic is using an e-MDs lab interface, 
abnormal results will automatically result in a priority setting of Urgent (one red 
exclamation point ) if sent by the processing lab.  Otherwise priority icons can be 
set manually in DocMan at the time of scanning, filing or after editing a document 
into a patient chart. Statuse choices are Urgent  or Stat    

Status The Status column displays several different icons depending on different conditions 
associated with a patient’s results. The status icons that can be seen in this column 
are shown below: 

• No Icon: A blank cell in this column represents the fact that no results have 
been received for this patient. 

•  Clock Icon:  A clock icon represents the fact that SOME results have 
been received for the patient. 

•  Green Arrow Icon: A green arrow in the cell represents the fact that 
ALL results for this patient have been received.  

•  Green Check Mark Icon:  A green check mark icon represents that 
the record is Ready for Provider.  This status can be used in situations 
where staff is tasked with reviewing information prior to a provider 
accessing it. 

•  Blue Phone Icon:  A blue phone icon represents Contact Patient.  
This is used when the labs have been reviewed and is ready for the patient 
to be contacted with information concerning the results. 

•  Beaker with Clock Icon:  This icon represents a status of Hold for 
Review and can be used anytime the record needs to be put on hold, i.e. 
partial results awaiting final. 

•  Beaker with Triangle Icon:  This icon represents that there are 
Unmatched Labs linked to the patient.  An Unlinked Lab is a result that 
came in through one of the lab interfaces, but was not able to be 
automatically linked to a CPT code. These unlinked labs will be 
automatically linked to the correct patient and represented in the Order 
Tracking module with an Unmatched Lab icon. 

Patient Name The patient name is displayed in this column. 
Note If a note has been attached to the record a note icon  will be displayed in this 

column. 
Number of Orders A number representing the number of labs, tests or procedures that have been 

ordered for the patient (per a specific visit) will be displayed in this column. 
Provider The name of the ordering provider is displayed in this column. 
Order Descriptions Descriptions for each of the labs, tests or procedures that have been ordered for the 

patient will be displayed in this column. 
Last Appt This column displays the last valid appointment date for the patient. 
Next Appt This column displays the next scheduled appointment for the patient. 
Customize Located in the lower, right-hand corner, use this button to build your own filter. 

Simply click on each of the clauses, conditions or statements, pre-populated, and 
click apply and OK for the filter to be accessible.  
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Order Tracking Options 
Options for Order Tracking can bet set to allow the user some customization of how they would like the 
application to display and perform.  The choices for these options are described below. 

Note:  Changes to the options screen are login specific and will not affect other users’ display 

Order Tracking Options  
Display Order Tracking 
Count in Red if greater 
than X 

This option can be used to set the behavior of the Order Tracking button in the 
Dashboard.  When pending orders are present for the selected provider (or 
providers) the Order Tracking Dashboard button will display the number of pending 
orders for the selected provider(s).  Ordinarily the number of pending orders shows 
up in black however users can use this preference to show the number in red if it 
exceeds a specified number.  For example a user can set this option to 10 and once 
the number of pending orders reaches 11 the number displayed on the Dashboard 
button will appear in red.  This feature can be used as a prompt to the user to deal 
with items when they reach a certain workload. 

Automatic Refresh The information in the grid can be refreshed manually by clicking the Refresh button 
on the toolbar (see toolbar section) but the information is also set to refresh on an 
automated schedule.  The default setting is for 2 minutes and cannot be set lower 
than that but it can be changed to a larger number.   

Refresh Interval: Patient demographics touching Order Tracking update according to the Refresh 
Interval time settings. Privileged users can change the refresh interal minutes (See 
the Administration Guide, “Enabling Order Tracking Optimization” section.The 
automatic refresh default time is for 60 minutes and cannot be set lower than 5 
minutes. 

Default HIPAA Compliance A user can decide to display the Patient name within the respective column and are 
given the following choices: Show no patient name, Show patient initials only or 
Show full patient name.   

This is useful for hiding or limiting the display of the patient name in situations where 
a computer screen may be visible by non-staff individuals, e.g. visitors or other 
patients. This option sets the preference for the default behavior of this feature and 
the default setting Show full patient name. This can be readily changed by clicking 
the radio button next to the desired choice. Selections will be maintained after the 
application is closed. 

Sort Categories Upon hovering over the column headings, a dropdown will display within the 
following categories: Date Ordered, Overdue, Abnormal, Priority, Status, Patient 
Name, Note and # Orders. Each dropdown has relevant filter options respective to 
the individual category, allowing for the inclusion, or exclusion, of data. By default 
the grid in Order Tracking sorts based on the Abnormal, Priority and Overdue 
columns.  This means that Abnormal results are marked as a Priority items, followed 
by Overdue, and will always appear at the top of the list.  This order sort can be 
changed to accommodate the needs of different types of users by using the filters. 

Primary The Primary sort order default is <NoSort>.  To change the Primary sort order, click 
the dropdown to the right of the Primary category and choose another column to sort 
by. 

Secondary The Secondary sort order default is <NoSort>.  To change the Secondary sort order, 
click the dropdown to the right of the Secondary category and choose another 
column to sort by. 

Tertiary The Tertiary sort order default is <NoSort>.  To change the Tertiary sort order, click 
the dropdown to the right of the Tertiary category and choose another column to sort 
by. 

To turn on optimization in Order Tracking: 
1. Click File, then Options. 
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2. Click the Administration tab. You must have the correct privilege in order to see the 
Administration tab. 

3. Under Order Tracking Options, click the checkbox for Enable Order Tracking Optimization. The 
default setting is 60 minutes with a minimum allowable setting of 5 minutes.  

4. To disable optimization, simply uncheck the box.   
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Legend 
The legend displays explanations of the different icons used in the Order Tracking module.   These icons 
consist of items that represent the status of the pending order or the priority of the order. 

Order Tracking Options  
Status Icons 

No labs have been 
received 

A blank cell in this column represents the fact that no results have been received for 
this patient. 

 Some labs have been 
received 

A clock icon represents the fact that SOME results have been received for the 
patient. 

 All labs have been 
received 

A green arrow in the cell represents the fact that ALL results for this patient have 
been received. 

 Ready for Provider A green check mark icon represents that the record is Ready for Provider.  This 
status can be used in situations where staff is tasked with reviewing information 
prior to a provider accessing it. 

 Hold for Review This icon represents a status of Hold for Review and can be used anytime the 
record needs to be put on hold. 

 Contact Patient A blue phone icon represents Contact Patient.  This is used when the labs have 
been reviewed and is ready for the patient to be contacted with information 
concerning the results. 

 Unmatched labs exist 
for this patient 

This icon represents that there are Unmatched Labs linked to the patient.  An 
Unlinked Lab is a result that came in through one of the lab interfaces but was not 
able to be automatically linked to a CPT code. These unlinked labs will be 
automatically linked to the correct patient and represented in the Order Tracking 
module with an Unmatched Lab icon. 

Priority Icons 
Normal Priority A blank cell in the Priority column denotes that there is not a priority setting for the 

record. 

 Urgent Priority A single exclamation icon represents an urgent priority. 

 Stat Priority Two exclamation points represents a stat priority which is higher than an urgent 
status. 

 A note icon represents the fact that a note exists for these labs. 
 

Patient Name If the patient’s name appears in red in the Patient column it means that at least one 
of the patient’s results in that particular record is abnormal. 

Understanding the Pending Labs Section of Chart View 
With the advent of Order Tracking a new section of Chart View has been added.  This new section is a 
sub section of the Labs/Tests section of Chart View and it is called Pending Labs. On the Labs/Tests tab 
there is a new radio button choice labeled Pending Labs.  When a record in the Order Tracking grid is 
double clicked the associated patient’s chart is open to this new section of Chart View.  In addition this 
new section can be accessed anytime the user is in the Chart View section by clicking the Labs/Tests tab 
and then selecting the Pending Labs radio button.  This new section of Chart View displays CPT and 
HCPCS codes that are marked to be tracked as well as any associated Visit or Order Notes. 

When in the Pending Labs section the tracked information will be displayed in a tree format with the date 
and ordering provider’s name of the associated note displayed as the top level item.  To the left of the 
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note information is a status icon that displays one of 4 different icons depending on the status of the order 
as displayed below: 

Pending Lab Order 
Status 

 

 Default A green circle with a downward pointing arrow represents the default setting for a 
tracked order.  This corresponds to there being no information associated with the 
order. 

 Ready for Provider A green check mark icon represents that the record is Ready for Provider.  This 
status can be used in situations where staff is tasked with reviewing information 
prior to a provider accessing it. 

 Hold for Review This icon represents a status of Hold for Review and can be used anytime the 
record needs to be put on hold. 

 Contact Patient A blue phone icon represents Contact Patient.  This is used when the labs have 
been reviewed and is ready for the patient to be contacted with information 
concerning the results. 

 

Beneath the note, any diagnoses, CPT codes and HCPCS codes associated with the visit are displayed. 
Icons and color coding denote the status of the individual orders.  If there are linked items associated with 
an order, clicking the CPT or HCPCS code will display the linked image in the right pane of the Pending 
Labs section. 

Individual Orders 
Status 

 

 mm/dd/yyy 
ProviderLastName, 
ProviderFirstName 

This is the top level item and represents the Visit or Order Note date and ordering 
provider’s name. 

 A stethoscope icon represents an ICD code that is associated with the Visit or Order 
Note. 

 A test tube and beaker icon represent a CPT code associated with the Visit or Order 
Note. If the description of the CPT is not displayed in blue text the item is not a 
tracked item. 

Items displayed in BLACK Represents a regular item that is not being tracked. 
Items displayed in BLUE Represents a CPT or HCPCS code that is being tracked. 

 If there is no result linked to the order the icon to the left of the code will be 
displayed as a test tube and beaker with a circle with a slash across it.  

 If there ARE results linked to the order the icon to the left will be displayed as a test 
tube and beaker with a green check mark on top of it. 

Items displayed in RED Indicates there are abnormal results associated with the CPT or HCPCS code. 

 A pink piece of paper icon represents that a Log Note is linked to the order. 

 A yellow piece of paper icon represents that a Sticky Note is linked to the order. 

 A pink piece of paper with a blue phone handset icon represents that a Phone Note 
is linked to the order. 

 A yellow piece of piece of paper with a blue phone handset icon represents that a 
Sticky Phone Note is linked to the order. 

Unmatched Labs Lab results that come in through a lab interface and cannot be automatically linked 
to an order in the Visit or Order Note, will show up at the bottom of the tree view 
under a node labeled Unmatched Labs. 
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Example of the Pending Labs Section of Chart View 

 

Accessing a Patient’s Pending Labs 
The rows of information displayed in the Order Tracking module represent a patient visit that contains 
tracked orders. The names of the orders can be seen in the Order Descriptions column but users will 
need to access the patient chart to see the Visit or Order Note and the actual CPT or HCPCS codes and 
any results that are available. 

To access pending labs: 
Double-click the record (row) that displays the patient that is of interest.   

The patient’s chart will open to the Chart View section and the following will display: 

• The Pending Labs section which is a sub-section of the Labs/Test area of Chart View open. 

• Along the left side there will be a tree display of all of the patient’s visits that have tracked labs 
associated. 

• The specific visit that was chosen in the Order Tracking module will be highlighted in the left tree 
and the note will be displayed in the right pane. 

• Under the Visit or Order Note, any labs that were ordered in the note will be displayed and any 
order that is marked to be tracked will appear in Blue (unless there is an abnormal result linked to 
the order, in which case it will appear in Red). 

• If there is no result linked to the order the icon to the left will be displayed as a test tube and .  
beaker with a circle with a slash across it .  

• If there ARE results linked to the order the icon to the left will be displayed as a test tube and 
beaker with a green check mark on top of it . 

• If the order has results the user can click the order description and the result will appear in the 
right pane. 
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Marking the Status of Orders 
To provide feedback to users that are monitoring the Order Tracking module the status of the order can 
change based on information that obtained either automatically or manually. Lab results that are obtained 
via an electronic lab interface (Example: LabCorp, Quest, CPL, etc.) will cause the status to change 
automatically.  Manual changes to the status could also be lab results but in this case they would be 
results obtain on paper and scanned into the system.  Additional manual changes to the status would be 
performed by users such as providers and nurses.  These changes provide feed information such as 
whether the results are “ready for provider” or ready to “contact patient.”  Changing the status of the order 
will change the icon that is displayed in the status column of Order Tracking (see Legend section for 
details about the status icons).  More details about these manual status changes are explained below 
along with instruction on how to change the status. 

Marking Orders as "Ready for Provider" 
Depending on the workflow of the clinic, the provider may want to have the clinical staff review lab 
information and collect additional information prior to the provider themselves dealing with the results.  
The staff would then notify the provider that the results are ready to be dealt with. To accomplish this, the 
program was designed to allow the order status to be changed to “Ready for Provider.”  Changing the 
status of an order to Ready for Provider will place a green check mark icon in the status column.  
Providers would then monitor the Order Tracking module and look for orders that are marked as Ready 
for Provider. 

To mark orders as Ready for Provider: 
1. Double-click the desired row in Order Tracking to open the patient’s chart to the Pending Lab 

section of Chart View 

On the left side of the Pending Lab section of Chart View, the date and ordering provider’s name 
for the Visit or Order Note, with all associated orders listed below it, will be displayed.  To the left 
of the note date a green circle icon with a downward pointing arrow icon  will be displayed. 

2. To change the status of the order, click the green circle icon and select Ready for Provider from 
the pop up menu. 

After the new status is selected, the icon to the left of the visit date will change to a green check 
mark icon.  After the chart is closed, the icon in the status column will also change to a green 
check mark to denote that the order is ready for the provider to deal with.   

Note:  The icon will change depending on what is selected from the pop-up menu. 

Marking Orders as Contact Patient 
Depending on the workflow of the clinic, the clinical staff may be tasked with calling patients and letting 
them know what the results of their lab work is.  To notify the clinical staff that the lab results are ready for 
notification to the patient the status of the order can be changed to “Contact Patient.”  Changing the 
status of an order to Contact Patient will place a blue phone handset icon  in the status column.  Staff 
would then monitor the Order Tracking module and look for orders that are marked as Contact Patient. 

To mark items as Contact Patient: 
1. Double-click the desired row in Order Tracking to open the patient’s chart to the Pending Lab 

section of Chart View 

On the left side of the Pending Lab section of Chart View, the date and ordering provider’s name 
for the Visit or Order Note, with all associated orders listed below it, will be displayed.  To the left 
of the note date a green circle icon with a downward pointing arrow icon  will be displayed. 
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2. To change the status of the order, click the green circle icon and select Contact Patient from the 
pop-up menu. 

After the new status is selected the icon to the left of the visit date will change to a blue phone 
handset  icon.  After the chart is closed the icon in the status column will also change to a blue 
phone to denote that the order is ready for the provider to deal with.   

Note:  The icon will change depending on what is selected from the pop up menu. 

Marking Orders to Return to Default 
Before any changes to an order status such as Ready for Provider, Contact Patient, Hold for Review, etc. 
are ever made the status of an order is blank and is represented by a green circle with a downward 
pointing icon . Once a status changes the icon will change to represent that status and the green circle 
will no longer be visible.  If a status is mistakenly changed from the default status, it can be returned to 
the default. 

To mark items as Default: 
1. Double-click the desired row in Order Tracking to open the patient’s chart to the Pending Lab 

section of Chart View 

On the left side of the Pending Lab section of Chart View the date and ordering provider’s name 
for the Visit or Order Note, with all associated orders listed below it, will be displayed.  To the left 
of the note date an icon will be displayed. This icon may be a green check mark, blue phone or 
other icon depending on the status of the order. 

2. To change the status of the order back to the default setting click the displayed icon and select 
Default from the pop-up menu. 

Once the default status is selected the icon to the left of the visit date will change to a green circle 
with a downward pointing arrow  icon.  Once the chart is closed the icon in the status column 
will also change and no icon (or possibly an Unmatched Lab icon) will be displayed.   

Note:  If there are Unmatched Labs associated with the order an unmatched lab icon  will be 
displayed even if the status is set to something else. 

Adding a Note to a Pending Order 
In some cases communication between the provider and staff concerning the pending labs may need to 
occur.  In these cases a note can be added to the pending order.  This note can be either a Log or Phone 
note and can be designated as either a permanent or sticky note. Adding a note in this manner creates a 
Log or Phone note that is listed in the Pending Labs section of Chart View as well as in the Log and 
Phone Notes Section.  Once a note is added to a pending order a yellow note icon  will appear in the 
Note column of the Order Tracking grid to show that a note is attached. 

To add a note to an order: 
1. Double-click the desired row in Order Tracking to open the patient’s chart to the Pending Lab 

section of Chart View. 

On the left side of the Pending Lab section of Chart View the date and ordering provider’s name 
for the Visit or Order Note, with all associated orders listed below it, will be displayed.  To the left 
of the note date an icon will be displayed. This icon may be a green circle, green check mark, 
blue phone or other icon depending on the status of the order. 

2. To add a note, click the displayed icon and choose Add a Note from the pop-up menu. 

The Edit Chart Note window will open allowing the user to create a new Log or Phone note. 

3. After the note is created, click the Save button. 
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The Edit Chart Note will close and a new icon will be displayed at the bottom of the order tree.  
This note will be represented by one of four icons depending on the type of note that is added. 

○ A pink piece of paper icon  represents a Log Note. 

○ A yellow piece of paper icon  represents a Sticky Note. 

○ A pink piece of paper with a blue phone handset icon  represents a Phone Note. 

○ A yellow piece of piece of paper with a blue phone handset icon  represents a Sticky Phone 
Note. 

When the chart is closed and the user is returned to the Order Tracking module a yellow note 
icon  will appear in the Note column of the Order Tracking grid to show that a note is attached. 

Marking Orders as Hold for Review 
At times lab results for a patient may need to be put on hold (for example until more information is 
obtained or for some other reason).  In order to do this in the Order Tracking module a record can be set 
with a status of “Hold for Review.”   

To mark an order as Hold for Review: 
1. Double-click the desired row in Order Tracking to open the patient’s chart to the Pending Lab 

section of Chart View. 

On the left side of the Pending Lab section of Chart View, the date and ordering provider’s name 
for the Visit or Order Note, with all associated orders listed below it, will be displayed.  To the left 
of the note date an icon will be displayed. This icon may be a green circle, green check mark, 
blue phone or other icon depending on the status of the order. 

2. To change the status of the order, click the displayed icon and select Hold for Review from the 
pop up menu. 

After the new status is selected the icon to the left of the visit date will change to a test tube and 
beaker with a clock  icon.  After the chart is closed the icon in the status column will also 
change to a test tube and beaker with a clock to denote that the order is being held for review.   

Removing Orders from Tracking List 
Tracked Orders will remain the Order Tracking module until they are manually removed.  

To remove orders from Order Tracking: 
1. Double-click the desired row in Order Tracking to open the patient’s chart to the Pending Lab 

section of Chart View 

On the left side of the Pending Lab section of Chart View the date and ordering provider’s name 
for the Visit or Order Note, with all associated orders listed below it, will be displayed.  To the left 
of the note date an icon will be displayed. This icon may be a green circle, green check mark, 
blue phone or other icon depending on the status of the order. 

2. To remove the order from Order Tracking, click the displayed icon and select Remove from List 
from the pop-up menu. 

The Visit or Order Note and tracked orders will immediately be removed from the Pending Labs 
section of Chart View and when the chart is closed the Order Tracking module will no longer 
display the selected record. 



 

e-MDs Solution Series Chart User Guide 8.0 R01 306 

Managing Unmatched Labs 
The application will try to automatically match up orders in a Visit or Order Note with lab results that are 
received through an electronic lab interface. This automatic matching of lab results is not always possible.  
When a lab result comes in from a lab interface and it cannot be matched up to orders in a note, the 
application still will link to the patient.  These “unmatched” labs show up in the Pending Labs section of 
Chart View (see the Overview of Pending Labs section for details about the Pending Labs section).   

Note:  If a lab order is submitted by any means other than entering a CPT code, the electronic results of 
that lab will be “unmatched” because automatic matches require CPT codes.  When such electronic 
results are returned to the clinic, a TaskMan message is sent to the designated user, the results are 
entered in the patient’s chart, and the results are also entered in the Order Tracking module to ensure 
they are tracked. 

Unmatched labs can be linked to an order in a Visit or Order Note.  Patients that have unmatched labs 
will have an unmatched lab  icon show up in the status column of the Order Tracking module. 

To link unmatched labs: 
1. Double-click the patient record in Order Tracking. 

2. The patient’s chart will open to the Pending Labs section of Chart View. 

3. Click the Unmatched labs node of the tree on the left. 

4. Click the unmatched lab.  The results document will appear in the right pane. 

5. With the document in view, click the Lab Tracking icon  on the toolbar. 

6. Place a check mark in the check box next to the matching order. 

Removing Unmatched Labs 
Sometime labs will show up as unmatched but will not have a corresponding order that they can be 
matched to.  An example of this would be an order that was placed outside of a visit (on a paper 
requisition) or after a note has been signed off.  Another example would be an unsolicited reflex test that 
is run by the lab based on a protocol.  In these instances there will not be a corresponding order to link 
the results to. In these cases the user will need to remove the Unmatched lab from the Pending Labs 
area. 

To remove unmatched labs: 
1. In the Pending Labs subsection of Lab/Tests in Chart View, click the unmatched lab in the 

section at the bottom of the screen. 

2. Click the icon to the left of the Unmatched Lab that you want to remove. 

3. A pop-up menu item labeled Remove from Unlinked Labs View will appear. 

4. Click the menu item to remove the Unmatched Lab (see image below for an example). 

Note:  Removing an unmatched lab simply removes it from this view and prevents the 
Unmatched icon from masking other icons in Order Tracking (Ready for Provider, Contact 
Patient, etc.). The result itself is NOT deleted and is still accessible in the Documents section of 
Chart View and in DocMan. 
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9 
FlowSheets 

The FlowSheet module of e-MDs Chart is a very powerful and flexible component that 
allows users to define, capture and track virtually any type of clinical information.  This 
information can represent dates, date/time, numeric values, Yes/No values and free 
text answers.  The flexibility in the type of data values that can be entered allows for 
capture and display of virtually any type of data.  This information is displayed in a 
grid format much like a spreadsheet.  These grids display fields, that represent the 
type of information being tracked (vitals, labs, medications, etc), vertically down the 
left side of the grid and the date the information was collected horizontally across the 
top of the grid.  This allows users to view large amounts of data in a single, 
consolidated view.  

These FlowSheets and the fields that are used to represent clinical information are all 
fully customizable by the user.  e-MDs provides several FlowSheets as well as a large 
number of fields with the product and users can edit those or create their own if 
needed.  The ability to customize or create new FlowSheets makes this module a 
very flexible and useful component of the charting application. 

Continued on the next page ... 
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Understanding Patient Specific FlowSheets 
Patient specific FlowSheets are those FlowSheets that have been linked to a patient's chart.  Once a 
FlowSheet has been linked to a patient the data contained in it will be specific to the patient.  Patient 
specific FlowSheets can be edited to meet the needs of data capture for particular patients without 
changing the underlying original FlowSheet. 

Viewing Patient Specific FlowSheets 
FlowSheets can be added to any patient's chart to collect specific information about that patient.  In 
addition the FlowSheets can be opened from within DocMan to allow for documentation of information, 
such as lab values, while viewing the scanned or electronically imported document that contains the 
information. 

To view a patient-specific FlowSheet in Chart: 
1. Open the patient's chart 

2. Click the FlowSheet button to access the patient's FlowSheets.  Just to the right of the patient's 
photo and below the blue patient specific header bar (where the patient's name and demographic 
info is displayed) there are four buttons labeled Reminders, Visit/HS (Visit Note/Health Summary 
view), Chart View and FlowSheets. 

3. The FlowSheet view will open. 

4. A list of FlowSheets that are linked to the patient will be displayed in the left pane.  If no 
FlowSheets have been linked the pane will be empty. 

5. If one or more FlowSheets have been linked to the patient the first one in the list will be displayed 
in the right pane. To view one of the other FlowSheets, click the name of the FlowSheet in the left 
pane and the view on the right will change to reflect the selected FlowSheet. 

To view a patient-specific FlowSheet in DocMan: 
1. Open the Patient’s chart. 

2. Click the DocMan button on the patient specific toolbar (just below the blue header bar that 
contains the patient’s demographic information). 

3. When DocMan opens, double-click the document that contains the information. 

4. The selected document will open in the DocMan viewer. 

5. Click the FlowSheet icon on the DocMan viewer toolbar . 

6. The FlowSheet module will open hosted at the bottom of the DocMan viewer. 

7. Select the appropriate FlowSheet and enter data as necessary. 

Lab Link Message 
If a lab interface is being used in the clinic there is a chance that a warning message about lab results 
that are not linked to a FlowSheet existing in the system.  This message allows the user to open the Lab 
Linker window and deal with any unlinked results. See image below for example of the warning message. 
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In some clinics these types of linking issues are dealt with by a designated person in the clinic. In those 
cases the physicians and nurses may not want to see the pop up warning message.  If a user does not 
want to see the message that can choose to turn it off.  A check box option to not show the message is 
available at the bottom of the screen. Click this check box to not show the message. 

Note:  This option is user specific and only effects the person logged on when the check box is clicked. 

If you choose to NOT show this message you can still access the Lab Linker by clicking the Link Lab 
Items button on the FlowSheet toolbar (see image below).  The text on this button turns red if unidentified 
labs exist so even if you choose to turn off the active warning message a passive visual cue is still 
available. 

 

Adding a FlowSheet to a Patient's Chart 
Initially no FlowSheet will be linked to any patient's chart if this is a new install of the application, if 
upgrading from a version that did not have FlowSheets or if the chart is that of a new patient.  However 
users can easily add one or more FlowSheets to any patient's chart. 

To add a FlowSheet to a patient: 
1. Click the FlowSheet button within a patient's chart to open the FlowSheet view. 

2. In the right pane, click the blue plus sign Add button at the top of the pane. 

3. This will open the FlowSheet Select form. 

4. Type in all or part of the desired FlowSheet name and click the Search button. 

OR  

Click the Search button without typing in a name to see ALL of the available FlowSheets. 

5. From the search results, highlight the desired FlowSheet name and click the Select button or 
double click the desired FlowSheet name. 

6. This will add the selected FlowSheet to the patient's chart. 

7. To add multiple FlowSheets, repeat the steps listed above. 
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Deleting a FlowSheet from a Patient 
Once a FlowSheet is linked to a patient it can be removed.  For example if a FlowSheet were to be added 
to a patient by mistake the user can choose to delete it. 

Note:  Deleting a FlowSheet does not delete the information that is contained in the FlowSheet and if 
the FlowSheet is added again at some point, the values contained in it will still be available. 

To delete a patient-specific FlowSheet: 
1. Click the desired FlowSheet name in the left pane. 

2. Click the red minus sign Delete button at the top of the left pane. 

3. The FlowSheet will be removed without requiring a confirmation from the user.  

Editing a Patient's FlowSheet 
FlowSheets that are created in the FlowSheet Editor are global in nature, that is to say they are not 
specific to any one patient until they are added to a patient's chart.  However once a FlowSheet is added 
to a patient it can be edited and changed to reflect specific requirements of that patient without affecting 
the original "master" FlowSheet.  This allows users to customize a FlowSheet to capture data for a 
particular patient's needs in a manner slightly different from that of other patients without causing any 
changes to the same FlowSheet that is linked to other patients.  For example if a patient has hypertension 
and is also on Coumadin and the user wants to monitor information that is collected in both FlowSheets 
without having to display them separately they can edit one of the FlowSheets and simply add the desired 
fields from one to the other (ex. add the Coumadin dose field and the INR field to the Hypertension 
FlowSheet) to create a completely new FlowSheet FOR THIS PATIENT ONLY.   

Note:  Keep in mind that this action will not affect the original Hypertension FlowSheet that may be 
linked to other patients.  To change a FlowSheet so that the changes are reflected for ALL patients linked 
to that FlowSheet use the FlowSheet Editor to make these changes.  

In addition to adding fields other changes can also be made to the FlowSheets at the patient level. These 
changes include marking fields so that they do not show up in the FlowSheet (visible property), removing 
fields and re-sequencing or changing the order that the fields show up in the FlowSheet.  Instructions on 
how to make these changes are described in other sections of the help files. 

To edit a patient’s FlowSheet: 
1. Open the patient's chart. 

2. Click the FlowSheet button. 

3. Select the FlowSheet to be edited by highlighting the name in the left pane. 

4. Click the Edit button at the top of the left pane. 

The FlowSheet form will open and changes can be made. 

Adding Existing Fields to a Patient Specific FlowSheet 
The FlowSheet module comes pre-populated with FlowSheet fields that can be used to augment existing 
FlowSheets or to create new ones.  These fields cover a wide variety of data such as vital signs, lab tests, 
immunizations, best practice items, etc.  These pre-existing fields can easily be added to an existing or 
new FlowSheet.  
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To add an existing field: 
1. Click the desired FlowSheet name in the left pane. 

2. Click the Edit button at the top of the left pane. 

The FlowSheet form will open in edit mode.  The fields in the FlowSheet, along with details about 
each, will be listed in a grid on the right side of the form. 

3. Click the Add button in the left pane of the window to add an existing field. 

The Field Select window will open. 

4. Type the name of the field (full description or partial) that is to be added into the Name field. 

5. Click the Search button on the toolbar. 

OR  

Press the Enter key on your keyboard. 

6. Highlight the desired field from the search results and click the Select button on the toolbar  

OR  

Double-click the item. 

OR 

Press the Enter key on your keyboard to select the field. 

The field will be added to the list of fields already in the FlowSheet and placed in alphabetical 
order. 

7. The order that the field shows up in the FlowSheet can be changed by clicking the Sequence 
button. 

Adding New Fields to a Patient Specific FlowSheet 
Although e-MDs supplies a large number of pre-existing fields along with the FlowSheet module, the user 
may want to capture data outside of the fields supplied.  In anticipation of this and to make the module as 
flexible as possible e-MDs provides a mechanism for the user to create their own FlowSheet fields.  Users 
can create fields to capture virtually any type of data.  To learn how this feature works, seethe “Create a 
Field” section of the FlowSheet Editor chapter of e-MDs Solution Series Administration Guide. 

Marking Fields as Visible or Invisible 
When FlowSheets are created by e-MDs staff there are some instances where multiple fields that 
document the same information are added to FlowSheets.  These are cases where information can be 
documented in more than one way. For example, there are Weight fields for documenting in both pounds 
and kilograms (some users prefer to document pediatric patients in grams and kilograms rather than 
pounds). Another example would be where an immunization can be documented by a Yes/No field to 
allow a user to simply mark that Yes the patient has had the immunization or No they have not OR by a 
date field to allow the user to mark an immunization as being given on a particular date, in this case the 
absence of a date denotes that the immunization was not given.  In cases such as these, users may 
decide to use one method over another and in those cases may not want to see the alternate choice.  To 
provide this flexibility the module allows the user the option of marking items as Visible or not. To mark an 
item as such: 
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To mark fields as visible or invisible: 
1. Click the desired FlowSheet name in the left pane. 

2. Click the Edit button at the top of the left pane. 

The FlowSheet form will open in edit mode.  The fields in the FlowSheet, along with details about 
each, will be listed in a grid on the right side of the form.  To the left of each field there are check 
boxes in a column labeled Visible. If a check mark appears in the check box, the field is set to be 
visible in the FlowSheet.  If the check box is empty, the field will not show up. 

If there is no check mark in the check box, clicking in the box will add a check mark and if there is 
a check mark clicking in the box will remove it. 

3. To set a field as visible or not click in the check box to add or remove the check mark. 

Note:  The visible property is only available for FlowSheets that are linked to a patient.  The 
FlowSheet Editor does not have this functionality.  In the FlowSheet Editor users can remove any 
fields that they do not want.  

Removing Fields from a Patient-Specific FlowSheet 
The only fields that can be removed from a FlowSheet after it has been linked to a patient are those that 
were added to the FlowSheet after it was linked to the patient, to remove other fields users must do so in 
the FlowSheet Editor.  

To remove fields from a patient specific FlowSheet: 
1. Click the desired FlowSheet name in the left pane. 

2. Click the Edit button at the top of the left pane. 

The FlowSheet form will open in edit mode. 

3. Highlight the field to be removed by clicking it. 

4. Click the Remove button to delete the field from the FlowSheet. 

Notes:   
○ If the Remove button is disabled (grayed out) the field is part of the original "master" 

FlowSheet and cannot be removed from this screen.  Only fields that have been added 
AFTER the FlowSheet is linked to a patient can be removed.  To remove a field that is part of 
the original master FlowSheet use the FlowSheet Editor. 

○ Removing a field from a patient specific FlowSheet can only be done for items that have been 
added to the FlowSheet from within a patient's chart and this action only removes the field 
from that specific patient's FlowSheet. Removing fields under these conditions does not 
remove the field from the original "master" FlowSheet. To remove a field from the master 
FlowSheet use you must use the FlowSheet Editor. 
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Changing the Display Order of the Fields 
When editing a FlowSheet please note that in edit mode the fields are displayed alphabetical order and 
not necessarily in the order they are displayed in the FlowSheet when it is being used.  The order of the 
fields can be changed. 

To change the display order of fields: 
1. Click the desired FlowSheet name in the left pane. 

2. Click the Edit button at the top of the left pane. 

The FlowSheet form will open in edit mode. 

3. Click the Sequence button at the bottom of the left-side of the form. 

This will open the Field Sequence window with all the fields listed in the order that they display in 
the FlowSheet. 

4. Select the field to reorder by clicking it to highlight. 

5. Move the field to the desired location by using the blue up or down arrow at the top left side of the 
window. 

6. Repeat the process for any fields that need to be re-ordered. 

7. When finished, click the Save button to save changes. 

Editing Fields in a Patient-Specific FlowSheet 
The only FlowSheet Fields that can be edited in a FlowSheet once it has been linked to a patient are 
those that were added to the FlowSheet after it was linked to the patient, to edit other fields users must do 
so in the FlowSheet Editor.  

Important!  Currently the editing of any field, whether from the patient specific view OR from the 
FlowSheet Editor, will cause the changes that are made to be reflected in all FlowSheets that contain that 
field.  In other words fields cannot be changed to reflect a specific need for only one patient.  In cases 
where a patient specific field is required the user can create a completely new field and add it to the 
FlowSheet (see “Create and Add New Fields” in the FlowSheet Editor section for details).  For example if 
the patient always runs a low grade fever and you want to change the temperature field to reflect a 
normal temperature of 99 instead of 98 and you change the field to reflect that then every temperature 
field for every patient would be changed to a normal temperature of 99.  Instead you need to create a new 
field and name it something specific (Example: Low Grade Temp, Bob's Temp, etc.). 

To edit fields in a patient-specific FlowSheet: 
1. Click the desired FlowSheet name in the left pane. 

2. Click the Edit button at the top of the left pane. 

The FlowSheet form will open in edit mode. 

3. Click to highlight the field to be edited. 

4. Click the Edit button to the left of the list of fields. 

Note:  If the Edit button is disabled (grayed out) then the field is part of the original "master" 
FlowSheet and cannot be edited from this screen.  Only fields that have been added AFTER the 
FlowSheet is linked to a patient can be edited.  To edit a field that is part of the original master 
FlowSheet, use the FlowSheet Editor. 

The Field Maintenance form will open. 
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5. From the Field Maintenance form the user can edit any parts of the field including the Name of 
the field, the Display Name, the Data Element, the Note or the Validation (normal ranges).  To 
learn more about editing these fields see “Edit a Field” in the FlowSheet Editor section of help.  
See the IMPORTANT note above for cautionary information about changing these fields. 

Note:  Editing a field from a patient specific FlowSheet can only be done for items that were added to 
the FlowSheet from within a patient's chart. To edit a field in the master FlowSheet use the FlowSheet 
Editor. 

Adding Values to FlowSheet Fields 
Data for FlowSheets gets input directly into the desired cell.   

Note:  Information entered into the vitals section of a visit will automatically populate the Vitals 
FlowSheet.  In addition lab results that come in through an electronic lab interface will automatically 
populate lab FlowSheets.  Future versions of Chart will automatically read additional information from the 
database into the FlowSheets but at the moment only vitals and lab results do so.  

To add data to a FlowSheet: 
1. Select the FlowSheet to add data to by clicking the name in the left pane. 

2. If a column for the date under which you are entering data exists simply double click in the cell of 
the field that you want to add data to.  

3. If the column for the date under which you are entering data DOES NOT exist, click the New Date 
button on the FlowSheet Toolbar.  A New Date window will open.   

4. Select the desired date from the calendar.   

Note:  You can document information from the past by picking a date in the past but you cannot 
pick a future date. 

5. Once the date column is picked simply double click in the cell of the field that you want to add 
data to 

6. Depending on the type of data that the field represents you will be presented with a pick list, a 
calendar, a date/time mask or a field to type text or numbers into. 

7. Enter the desired information into the cell and press enter or click into another cell to save the 
data. 

8. Repeat for each cell where data is required. 

Deleting Values from FlowSheet Fields 
In this version users are able to delete any and all data from the FlowSheets.  Future versions will restrict 
or prohibit deletions depending on the type of data entered.  For example once automatic population of 
FlowSheets from database information occurs in a future version the user will not be able to delete that 
information from the FlowSheet itself. 

To delete data from a FlowSheet: 
1. Select the cell from which the data is to be deleted. 

2. Click the Delete button on the FlowSheet toolbar. 

The cell will be cleared of information. 



 

e-MDs Solution Series Chart User Guide 8.0 R01 316 

Auto-Populating FlowSheet Fields 
Information entered into the vitals section of a visit will automatically populate the Vitals FlowSheet.  In 
addition lab results that come in through an electronic lab interface will automatically populate lab 
FlowSheets.  Future versions of Chart will automatically read additional information from the database 
into the FlowSheets but at the moment only vitals and lab results do so. 

Setting the Value Range 
The Value Range is a feature that allows the user to specify the number of days, months or years worth 
of data to display in the FlowSheet within any one patient session.  The default value is set to 2 years 
worth of data but can be changed.   To change the value range setting click the Value Range button on 
the FlowSheet toolbar to open the Past Value Results window and then change the range by changing 
the values in the # Day, # Months or # Years fields. Currently, changing the values of these fields will only 
cause the changes to be in effect as long as the patient's chart is open. Once the patient's chart is closed 
the Value Range will revert to the default setting of 2 years. 

Initially use of this feature may not be necessary since most patients in a new installation will not have 
that much data entered.  The FlowSheet grid can only display a limited amount of information horizontally 
anyway (depending on the resolution of the workstation monitor) so not all of the information associated 
with a patient can be displayed on screen at one time no matter what the Value Range is set to.  However 
for purposes of browsing (using the scrollbars) or printing the data this feature can be used to limit the 
information that can be accessed in any one session. 

Graphing a FlowSheet 
FlowSheet data can be graphed to provide the user with a view of data that can be more easily 
understood.  Graphs can sometimes provide an alternate view of data that allows the user to see 
relationships between items or progress of disease states that cannot easily be seen in a table view of the 
same data. 

To graph data in a FlowSheet: 
1. Select the FlowSheet to be graphed by highlighting it. 

2. Click the Graph button on the FlowSheet toolbar. 

3. The FlowSheet Graphing window will open. 

4. A list of the fields that can be graphed will appear in the left pane of the window. 

5. The first field in the list will be selected by default and a graph of that field will appear in the right 
pane. 

6. To graph another field simply select it. 

7. Any data points that fall outside the field’s normal range (validation) will appear in red (or 
whatever color is selected to display out of range values in).  See Set Validation for a Field for 
details on setting normal ranges. 

Note:  Only fields with at least two data points can be graphed.  Fields with one data point or less 
will display a message reading "More than one data point must be available in order to create a 
graph" when selected. 
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Graphing Multiple Fields on One Graph 
It is possible to graph multiple fields on one graph by clicking the check boxes for the results to be 
graphed. There are check boxes on the left and right of the results.  If you check the box on the left the 
item will be graphed with its scale represented on the left axis. If you check the box on the right the item 
will be graphed with its scale represented on the right axis.   

There is no limit to the number of multiple items that can be selected but it is prudent to consider keeping 
the number to a minimum.  Too many items on one graph can make the information unreadable and 
unusable. 

Note:  It is best to keep results of like scale on the same axis. Items with drastically different scales can 
cause the graph to be difficult to read. For example, a HgbA1c value which can be in the range of 5 to 10 
is not a good candidate to pair on the same axis with something like weight which can be in the range of 
100 to 200 pounds.  These types or results would be better displayed if one were displayed on the left 
axis and the other on the right axis. Systolic and Diastolic blood pressure readings on the other hand 
would be well suited to be graphed on the same axis since their scales are similar. 

Printing a Graph 
Graphed data from FlowSheets can be printed.  The printed graph will look exactly like the screen 
version. 

Important!  To be able to print a graph, the FlowSheet Graphing window must be open. 

To print a FlowSheet graph: 
1. Select the FlowSheet to be graphed and click the Graph button on the FlowSheet toolbar. 

The FlowSheet Graphing window will open. 

2. Select the item or items to be graphed (the limitation at this time is that only two data items can 
be graphed on one graph). 

3. After the graphed items are displayed in the graph window, click the Print button on the main 
Graph toolbar. 

The graph will print to the default Windows printer set up on the current computer.  The graph will 
print just as it is displayed on the screen. 

Printing a FlowSheet 
FlowSheets can be printed.  The printed FlowSheet will look almost exactly like the screen version.  

To print a FlowSheet: 
1. Click the desired FlowSheet name in the left pane.  

2. Click the Print button on the FlowSheet toolbar. 

The FlowSheet will print to the default Windows printer set up on the computer. 
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Using the FlowSheet Editor 
The FlowSheet Editor is a module that is included with e-MDs Chart application.  It can be used to edit 
the existing FlowSheets that are provided with the product or to create completely new ones. 

Accessing the FlowSheet Editor 
The FlowSheet Editor can be opened as a standalone application or as a module from within Chart.  

To open the FlowSheet Editor in standalone mode: 
1. Click the Windows Start menu at the bottom left corner of your desktop 

2. Go to Programs > e-MDs > e-MDs FlowSheet Editor. 

The FlowSheet Editor will open 

To open the FlowSheet Editor from Chart: 
1. Login into Chart using your normal e-MDs username and password. 

2. From the main Chart menu system, click Tools then select FlowSheets from the pop-up menu. 

The FlowSheet Editor will open. 

To access a specific FlowSheet from a list of currently open FlowSheets: 
1. Click the drop-down arrow at the right-side of the field. 

The drop-down will open and display all opened FlowSheets. 

2. Click the desired FlowSheet to switch the view to that particular FlowSheet. 

Understanding the FlowSheet Editor Interface 
The main window of the FlowSheet Editor contains a File menu item in the top left corner, a FlowSheet 
selection drop down field and a Close all FlowSheets button. 

The File menu item contains menu selections that allow the user to Open a Patient FlowSheet, Open a 
FlowSheet, access Categories, access Data Elements and access Fields. 

File Menu  
Open Patient FlowSheet Allows the user to open a specific patient's FlowSheet from within the FlowSheet 

Editor.  The patient's chart does not have to be open to do this.   
Note:  Data entered into any of the fields of a patient FlowSheet will associate that 
information to the patient just as if you were in the patient's chart.  This IS NOT a 
test environment! 

Open FlowSheet Allows access to the FlowSheet Select window where you can search for and open 
a specific FlowSheet for editing purposes OR create a new FlowSheet from scratch. 

Categories Allows access to the Categories Select window. See the Categories section for 
details about categories. 

Data Elements Allows access to the Data Element Select window.  See the Data Element section 
for details about data elements. 

Fields Allows access to the Field Select window.  See the "Fields" section for details about 
FlowSheet fields. 

Exit Allows the user to close the FlowSheet Editor module.  This performs the same 
action as the X in the upper right corner of the module. 
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Tools Menu  
Lab Linker Accesses the Lab Linker module that allows users to link Data Elements to Master 

Lab Codes.  See Link a Data Element to a Master Lab Code for details. 
Merge Data Elements Allows access to a module that merges Data Elements.  Sometimes more than one 

Data Element that represents the same item will be created. Merging of these Data 
Elements takes all the information from the different elements and merges them into 
one. 

FlowSheet Selection 
Dropdown  

Allows users to access any FlowSheets that have been opened in the current 
session.  Multiple FlowSheets can be opened at one time within a session of the 
FlowSheet Editor and users can flip between them using the FlowSheet selection 
field. 

Close All FlowSheets 

Button  

If multiple FlowSheets are opened within a session of the FlowSheet Editor they can 
all be closed at one time by clicking the Close All FlowSheets button  

Editing the Details of a FlowSheet 
There are details associated with each FlowSheet that can be edited. These details include the 
FlowSheet Name, Description and Category.  

To edit the details of a FlowSheet: 
1. Open the FlowSheet Select window by clicking File in the main FlowSheet Editor module. 

2. Select Open FlowSheet from the pop up menu. 

3. The FlowSheet Select window will open. 

4. Type the name of the FlowSheet to be edited into the Name search field 

5. Click the Search button on the tool bar OR press the enter key on your keyboard. 

6. A list of FlowSheets matching the search criteria will appear in the bottom part of the form. 

7. Select the desired FlowSheet by clicking it and click the Edit button on the toolbar. 

8. The FlowSheet Maintenance form will open 

9. Make the desired changes to the Name or Description or change the designated Category. 

10. Click the Save button when finished. 

Editing a FlowSheet 
Once a FlowSheet has been created they may be a reason to edit it.  New FlowSheet fields may need to 
added or removed or the sequence of the fields may need to be changed.   

To edit a FlowSheet: 
1. Open the FlowSheet Select window by clicking File in the main FlowSheet Editor module. 

2. Select Open FlowSheet from the pop up menu. 

3. The FlowSheet Select window will open. 

4. Type the name of the FlowSheet to be edited into the Name search field 

5. Click the Search button on the tool bar OR press the enter key on your keyboard. 

6. A list of FlowSheets matching the search criteria will appear in the bottom part of the form. 

7. Select the desired FlowSheet by clicking it and click the Select button on the toolbar OR press 
the Enter key on your keyboard. 
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OR  

Double-click the name of the FlowSheet. 

8. The FlowSheet form will open. 

9. Changes to the FlowSheet or the FlowSheet Fields can be made.  See the following sections for 
details. 

10. When finished making changes simply close the FlowSheet by clicking the X on the blue 
FlowSheet header bar (the one where the FlowSheet name is displayed). 

Note:  Clicking the X and the top right corner (instead of the X on the blue FlowSheet header bar) will 
close the entire FlowSheet Editor module and not just the current FlowSheet. 

Adding Existing Fields to a FlowSheet 
The FlowSheet module comes pre-populated with FlowSheet fields that can be used to augment existing 
FlowSheets or to create new ones.  These fields cover a wide variety of data such as vital signs, lab tests, 
immunizations, best practice items, etc.  These pre-existing fields can easily be added to an existing or 
new FlowSheet.  

To add an existing field to a FlowSheet: 
1. Open the FlowSheet Select window by clicking File in the main FlowSheet Editor module. 

2. Select Open FlowSheet from the pop up menu. 

3. The FlowSheet Select window will open. 

4. Type the name of the FlowSheet to be edited into the Name search field 

5. Click the Search button on the tool bar  

OR  

Press the Enter key on your keyboard. 

6. A list of FlowSheets matching the search criteria will appear in the bottom part of the form. 

7. Select the desired FlowSheet by clicking it and click the Select button on the toolbar OR press 
the Enter key on your keyboard OR double-click the name of the FlowSheet. 

8. The FlowSheet form will open 

9. The fields in the FlowSheet, along with details about each, will be listed in a grid on the right side 
of the form. 

10. Click the Add button in the left pane of the window to add an existing field. 

11. The Field Select window will open. 

12. Type the name of the field (full description or partial) that is to be added into the Name field. 

13. Click the Search button on the toolbar OR hit the Enter key on your keyboard. 

14. Highlight the desired field from the search results and click the Select button on the toolbar OR 
double click the item OR hit the Enter key on your keyboard to select the field. 

15. The field will be added to the list of fields already in the FlowSheet and placed in alphabetical 
order. 

16. The sequence of items displayed in the FlowSheet can be changed by clicking the Sequence 
button (see "Change the Sequence of Fields" for details). 



 

e-MDs Solution Series Chart User Guide 8.0 R01 321 

Changing the Sequence of Fields 
When editing a FlowSheet please note that in edit mode the fields are displayed alphabetical order and 
not necessarily in the order they are displayed in the FlowSheet when it is being used.  The order of the 
fields can be changed. 

To change the FlowSheet field sequence: 
1. Open the FlowSheet Select window by clicking File in the main FlowSheet Editor module. 

2. Select Open FlowSheet from the pop-up menu. 

3. The FlowSheet Select window will open. 

4. Type the name of the FlowSheet to be edited into the Name search field 

5. Click the Search button on the tool bar. 

OR  

Press the enter key on your keyboard. 

A list of FlowSheets matching the search criteria will appear in the bottom part of the form. 

6. Select the desired FlowSheet by clicking it and click the Select button on the toolbar. 

OR 

Press the Enter key on your keyboard. 

OR 

Double-click the name of the FlowSheet. 

The FlowSheet form will open.  The fields in the FlowSheet, along with details about each, will be 
listed in a grid on the right side of the form. 

7. Click the Sequence button at the bottom of the left side of the form. 

This will open the Field Sequence window with all the fields listed in the order that they display in 
the FlowSheet. 

8. Select the field to reorder by clicking to highlight it. 

9. Move the field to the desired location by using the blue up or down arrow at the top left side of the 
window. 

10. Repeat the process for any fields that need to be re-ordered. 

11. When finished, click the Save button to save changes. 

Creating and Adding New Fields 
Fields can be created from within a FlowSheet at the time the FlowSheet is being created (on the fly). 

To add new fields: 
1. Edit the desired FlowSheet. 

2. Click the New button in the right pane. 

3. A New Field form will open. 

There are five choices for add a new Field. These choices allow the user to create a completely 
new Field from scratch or to copy certain parts of existing Fields to create new ones.  This 
functionality is intended to save time when creating FlowSheet Fields.  The five choices are 
described below. 
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○ Create a New Field and New Data Element:  This choice is the same as creating a new Field 
outside of a FlowSheet.  If this option is selected: 

 The Data Element Maintenance form will open and you can choose an existing Data 
Element or add a new one.  See “Add a New Data Element” for details. 

 Once a Data Element is chosen the Field Maintenance form will open and you can finish 
creating the Field.  See “Create a FlowSheet Field Outside a FlowSheet” for details. 

○ Copy an Existing Field:  This choice allows the user to copy an existing field and then make 
changes as necessary.  This can save time when creating a Field that is similar to an existing 
one but may only need small changes.  For example if you have a patient whose normal 
temperature us 99 you might want to copy the temperature Field, rename it (ex. Low Grade 
Temp) and make changes to the Validation so that 99 will show up as a normal value for this 
patient.  If this option is selected: 

The Field Select form will open and you can choose an existing Field to Edit.  See “Edit a 
FlowSheet Field” for details. 

○ Copy an Existing Field but create a New Data Element:  This choice can be used when you 
want keep the same Validation values (normal ranges or pick lists) but want to use a different 
Data Element.  Copying of a Field that contains a Yes/No type Data Element is a good 
example of this choice.  Rather than having to recreate the pick list for a Yes/No type question 
this option can be chosen and a different Yes/No type Data Element can be selected.  If this 
option is chosen: 

 The Field Select form will open and you can search for and choose an existing Field to use.   

 After a field is selected the Field Maintenance form will open will all the information filled out 
EXCEPT the Data Element. 

 Pick an existing Data Element to use or create a new one.  See “Add a New Data Element” 
for details. 

○ Create a New Field Based on an Existing Data Element:  This option allows the user to pick 
a Data Element first and then enter information into the FlowSheet Field properties to create 
the Field.  If this option is chosen: 

 The Data Element Select form will open. 

 Pick an existing Data Element or create a new one.  See “Add a New Data Element” for 
details. 

 After a Data Element is chosen the Field Maintenance window will open with ONLY the 
Data Element field filled out. 

 Fill out the required information for the Field.  See “Create a FlowSheet Field Outside a 
FlowSheet” for details. 

○ Create a New Field based on an Existing Field’s Data Element:  This option allows the 
user to select an existing Field and use ONLY its Data Element to create a new Field.  For 
example a Pulse FlowSheet Field exists that has an underlying Data Element called Heart 
Rate.  This is the same Data Element that would be used to create a Fetal Heart Rate 
FlowSheet Field.  Use of this option would allow you to pick the FlowSheet Pulse field so that 
you can use the Heart Rate Data Element to create a completely new FlowSheet Field. 

4. The Field Select form will open and you can search for and choose an existing Field that 
contains the Data Element you want to use. 

5. After the field is selected, the Field Maintenance window will open with ONLY the Data Element 
field filled out. 

6. Fill out the required information for the Field.  See “Create a FlowSheet Field Outside a 
FlowSheet” for details. 
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7. After one of these options is selected, the Field Maintenance form will open.  Depending on the 
choice made some, none or all of the fields on this form may be filled out. 

8. Make changes or additions to the fields as desired.  See the “General Tab” and “Validation Tab” 
sections for details. 

9. Click Save when finished. 

Editing Fields Associated with a FlowSheet 
From within the FlowSheet Editor, FlowSheet Fields can be edited at any point after they have been 
created.  However, from within a patient’s chart the only FlowSheet Fields that can be edited are those 
that have been specifically added to that patient’s chart. 

To edit a FlowSheet field: 
1. Edit the desired FlowSheet 

2. Select the Field to be edited by clicking it. 

3. Click the Edit button in the left pane. 

4. The Field Maintenance window will open with the selected Field displayed in Edit mode. 

5. Make desired changes to the items in the General tab (Name, Display Name, Data Element or 
Note) or to the items on the Validation tab (Range From, Range To, Abnormal Color, Valid 
Values, Valid Color, Invalid Values and Invalid Color).  See The Field Maintenance Form. 

Important!  Editing of a FlowSheet Field may affect data that has already been collected in some 
patient specific FlowSheets if the Field is part of that FlowSheet and depending on the changes that have 
been made to the FlowSheet Field.  Keep in mind that any changes to a field will b e transferred to every 
FlowSheet that the Field is linked to. 

Removing Fields from a FlowSheet 
Fields that are unneeded or unwanted can be removed from a FlowSheet. 

To remove a field from a FlowSheet: 
1. Edit the desired FlowSheet 

2. Select the Field to be removed by clicking it. 

3. Click the Remove button in the left pane. 

4. In the Remove confirmation window click Yes to remove the field. 

5. The field will be removed from the FlowSheet. 

Notes:    
○ The field will be simply removed from the FlowSheet but NOT deleted.  It will continue to exist 

in other FlowSheets and it can be added back to the FlowSheet it was deleted from if desired. 

○ Removing a field from an original or "master" FlowSheet will remove the field from every 
patient specific FlowSheet that the master FlowSheet is linked to.  Keep this in mind when 
removing fields.  

Adding a New FlowSheet 

To add a new FlowSheet: 
1. Open the FlowSheet Select window by clicking File in the main FlowSheet Editor module. 

2. Select Open FlowSheet from the pop up menu. 
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3. The FlowSheet Select window will open. 

4. Click the New button on the toolbar. 

5. The FlowSheet Maintenance window will open. 

6. Enter a name in the Name field and a description into the Description field. 

7. Select a Category from the Category drop down.  The Name and Category are required fields. 

8. Click Save when finished. 

Deleting a FlowSheet 

To delete a FlowSheet: 
1. Open the FlowSheet Select window by clicking File in the main FlowSheet Editor module. 

2. Select Open FlowSheet from the pop up menu. 

3. The FlowSheet Select window will open. 

4. Type the name of the FlowSheet to be deleted into the Name search field 

5. Click the Search button on the tool bar OR press the enter key on your keyboard. 

6. A list of FlowSheets matching the search criteria will appear in the bottom part of the form. 

7. Select the desired FlowSheet by clicking it and click the Delete button on the toolbar. 

8. Click Yes in the Deletion confirmation window. 

9. The FlowSheet will be deleted. 

Important!  Use caution when deleting FlowSheets.  Deletion of a FlowSheet will remove it from 
ALL patients’ charts.  The data associated with those patients will not be lost and may still be linked to the 
patient via other templates that have the same FlowSheet fields in them.  To recover ALL data associated 
with the patient the FlowSheet might have to be recreated or the fields associated with the FlowSheet will 
need to be added to another FlowSheet.  

Understanding FlowSheet and Category Linking 
Each FlowSheet is required to be linked to a Category.  This is required for future functionality to help in 
the organizing of FlowSheets. These categories are not currently being used but will be at a later date. 

To add a new category: 
1. Click the File menu in the main FlowSheet window. 

2. Select Categories from the menu. 

3. The Category Select window will open. 

4. Click the New button on the Category Select toolbar. 

5. The Category Maintenance window will open. 

6. Enter a name for the category in the Name field and a description of it (not required) in the 
Description field. 

7. Click the Save button to save the new category. 
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To edit a category: 
1. Click the File menu in the main FlowSheet window. 

2. Select Categories from the menu. 

3. The Category Select window will open. 

4. Enter the name of the Category in the Name field and click the Search button. 

5. In the search results select the desired category by clicking it. 

6. Click the Edit button on the Category Select toolbar. 

7. The Category Maintenance window will open. 

8. Make the desired changes to the Name and/or Description fields. 

9. Click Save when finished. 

To delete a category: 
1. Click the File menu in the main FlowSheet window. 

2. Select Categories from the menu. 

3. The Category Select window will open. 

4. Enter the name of the Category in the Name field and click the Search button. 

5. In the search results select the desired category by clicking it. 

6. Click the Delete button on the Category Select toolbar. 

1. Click Yes in the deletion confirmation window. 

Using Data Elements with FlowSheets 
Data Elements are the underlying data structures that contain information about what type of data is 
captured and stored in the database for any FlowSheet Field that is based on that particular Data 
Element. A Data Element can be used by any number of FlowSheet Fields but each Field can have one 
and only one Data Element associated with it.  The reason for having multiple Fields for a Data Element 
is because the Fields can be set to hold different Validation or normal ranges for the same Data Element.  
For example, a Data Element called Heart Rate exists in the FlowSheet module that is used by both the 
Pulse and Fetal Heart Rate FlowSheet Fields.  This allows the Pulse Field to have a normal Heart Rate 
range associated with adult patients and the Fetal Heart Rate to have a normal range associated with a 
fetus, yet both are stored as a single Heart Rate Data Element in the database.  The concept of Data 
Elements in conjunction with FlowSheets Fields provides for a high level of flexibility to capture and track 
virtually any type of clinical data. 

Data Elements can consist of seven different Data Types.  See the Types of Data Elements section for 
details of these types. 

Adding Lab Results in FlowSheets to Visit or Order 
Notes 
Lab results that are listed in patient-specific FlowSheets can be copied to Chart Visit or Order Notes 
through templates that use the FlowSheets Extended Attributes.  See the "Creating and Modifying Chart 
Templates" chapter in e-MDs Solution Series Administration Guide for information on how to add or 
modify those templates.  For instructions on using those templates, also see Accessing FlowSheets in 
Templates. 
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Understanding Types of Data Elements (Data Types) 
Data Elements can be designated as one of seven different Data Types depending on the kind of data to 
be tracked.  These seven types of data consist of Date, Date/Time, Decimal Number, Text, Time, 
Whole Number, Yes/No and Separator.  Each Data Type is defined below. 

• Date: The Date Data Type is used when a FlowSheet Field is going to be used to capture a 
specific date.  This can be used to document that a particular lab, test or immunization was 
performed on a specific date.  This can be especially helpful when the date that the item was 
performed was not on the date the information was documented.  Documentation today of an 
item such as an immunization, for example, that was performed in the past would by default have 
a date set to today but this date could easily be changed using the popup calendar associated 
with field. 

• Date/Time: The Date/Time Data Type is used when you want to capture a time along with a date. 

• Decimal Number:  A decimal number is used when an expected value can but will not 
necessarily be a whole number.  For example the value for a Hemoglobin A1c can be either 6 or 
6.3.  Use a decimal number when there is a possibility that the value will not be a whole number.  

• Text: The Text Data Type is used to document free text information. 

• Time: The Time Data Type is used to document a specific time that an item was performed. 

• Whole Number: This Data Type is used to document an item that is ALWAYS expected to be a 
whole number.  For example a Blood Pressure reading is never expected to be a decimal. 

• Yes/No:  This Data Type allows users to create a Data Element that expects a Yes or No as the 
value to be input into the FlowSheet Field that is linked to it.   See the section on Validation for 
details about setting these labels. 

• Separator:  This Data Type is used to provide some organization to a FlowSheet by acting as a 
separator between FlowSheet fields. 

To add a new data element:  
1. Click the File menu in the main FlowSheet window. 

2. Select Data Elements from the menu. 

3. The Data Elements Select window will open. 

4. Click New on the toolbar. 

5. The Data Element Maintenance window will open. 

6. Enter a Name and Description into the respective fields. 

7. Pick a Data Type from the dropdown menu. See Types of Data Elements for details about the 
different selections in this field. 

8. Click the search icon in the Associated Master Lab Code field if this is an element that needs to 
be linked to a Master Lab Code.  

Note:  Skip this step if the element is not being linked to a Master Lab Code. 

A Select Master Lab Code window will open. 

9. Search for and select the appropriate Master Lab Code. 

10. Click Save when finished. 
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To edit a data element: 
1. Click the File menu in the main FlowSheet window. 

2. Select Data Elements from the menu. 

3. The Data Elements Select window will open. 

4. Enter the name of the Data Element to be edited into the Name field and click Search. 

5. Select the desired Data Element from the search results by clicking it. 

6. Click the Edit button on the toolbar. 

7. The Data Element Maintenance window will open. 

8. Make any desired changes to the Name, Description, Associated Master Lab Code or Data 
Type. 

9. Click Save when finished. 

To delete a data element: 
1. Click the File menu in the main FlowSheet window. 

2. Select Data Elements from the menu. 

3. The Data Elements Select window will open. 

4. Enter the name of the Data Element to be deleted into the Name field and click Search. 

5. Select the desired Data Element from the search results by clicking it. 

6. Click the Delete button on the toolbar. 

7. Click Yes in the deletion confirmation window. 

Important!  Deletion of a Data Element can cause DATA LOSS if the Data Element is being used by 
FlowSheet Fields that contains patient data. 

Linking a Data Element to a Master Lab Code 
Lab tables that store lab results in the database have items call Master Lab Codes that identify lab tests.  
Lab companies throughout the country use different codes to identify lab tests. For example a CBC may 
have one ID code from laboratory A and a completely different one from Laboratory B even thought the ID 
codes are referring to the exact same order. This makes matching lab results that come in through a lab 
interface to a FlowSheet element difficult.  Master Lab Codes were designed to deal with this dissimilar 
way of identifying the same lab test.  One Master Lab code can be linked to many different laboratory ID 
codes (representing the same lab test) and acts as a single point of reference for those lab tests.  This 
allows a FlowSheet Data Element to be linked to only one item rather than to different ID codes from 
different lab companies. 

Note:  A Data Element can only be linked to one Master Lab Code and vice versa. 

To link a data element to a Master Lab Code: 
1. In the FlowSheet Editor, click Tools then choose Lab Linker from the menu. 

2. The Lab Linker window will open 

3. Make sure the Link radio button is selected 

4. The list of available Data Elements will be displayed down the left side and a list of available 
Master Lab Codes will be displayed down the right side. 
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5. Those Data Elements and Master Lab Codes that are already linked will appear with a chain link 
icon to the left of the description 

6. Select an unlinked item in either column and then select the corresponding item in the other 
column 

7. Click the Link button 

8. If you are sure you want to link the items, answer Yes in the confirmation window 

A Data Element or Master Lab Code can only be linked to one item.  Sometimes these links are incorrect 
and an item needs to link to a different item.  To do this you may first unlink the item. 

To unlink a data element from a Master Lab Code: 
1. In the FlowSheet Editor, click Tools then choose Lab Linker from the menu. 

2. The Lab Linker window will open 

3. Make sure the Unlink radio button is selected 

4. The list of available Data Elements will be displayed down the left side and a list of available 
Master Lab Codes will be displayed down the right side 

5. All the items will appear with a chain link icon since only the linked items will appear in this view 

6. Click an item in either column and the linked item will be highlighted and will move to the top of 
it’s respective list 

7. Click the Unlink button 

8. If you are sure you want to unlink these items, answer Yes at the confirmation window. 

Merging Data Elements 
Sometimes more than one Data Element that represents the same item can get created. For example two 
Data Elements for Sodium might be created.  These two Data Elements contain the same information but 
users would have to create two FlowSheet fields to display this information.  Merging of these Data 
Elements would take the all the information on Sodium and combine them into one Data Element.  

Important!  Merging of Data Elements CANNOT BE REVERSED and can cause LOSS OF DATA if 
done incorrectly.  Be sure of what you are doing before deciding to merge Data Elements. 

To merge data elements: 
1. In the FlowSheet Editor, click Tools then choose Merge Data Elements from the menu. 

2. The Merge Data Elements window will open 

3. At the top is a pane that is labeled Select Data Elements to Merge and it contains an 
alphabetical list of all data elements 

4. Next is a window labeled To Be Merged and it will be empty to start with 

5. As you select items in the Data Elements list they get added to the To Be Merged section 

6. For example if you had two items for Sodium called Sodium 1 and Sodium 2 you would see them 
in the Select Data Elements to Merge list and as you click one and then the other they would get 
added to the To Be Merged list 

7. At the bottom of the window is a field labeled Merged Data Element Name 

8. This field will default to the name of the first element that you select to be merged 
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9. In the example above with the Sodium 1 and 2, if you clicked on Sodium 1 first then that is what 
would default into the Merged Data Element Name field although you can type into the field to 
change the name if needed. 

Note:  If you inadvertently select a Data Element that you do not want to merge, simply click it 
again to remove it from the list. 

10. When you are finished selecting items to be merged, click the Merge button at the bottom. 

11. You will be presented with three confirmation warning messages 

12. If you are sure you want to merge these items click Yes to all three messages. 

Important!  Merging of Data Elements CANNOT BE REVERSED and can cause LOSS OF DATA if 
done incorrectly.  Be sure of what you are doing before deciding to merge Data Elements. 

Understanding FlowSheet Fields  
FlowSheet Fields are the items that are displayed in the FlowSheets and that hold the data being 
captured. These Fields also contain Validation rules or normal ranges for the underlying Data Element 
that represents the data in the database.  

The Field Maintenance Form 
The FlowSheet Field Maintenance form is the screen where new FlowSheet fields are created or existing 
FlowSheet fields are edited.  There are two tabs on this screen, a General tab and a Validation tab.   

General Tab 
The General tab contains information about the FlowSheet Field Name, Display Name, the underlying 
Data Element and a Note about the field.   

General Tab  
Name This is where the FlowSheet field name is entered.  The Name is not what is 

displayed in the FlowSheet itself (that would be the Display Name) but instead is 
used for organizational purposes in the FlowSheet Editor.  This is a required field. 

Display Name This is the name that is actually displayed in the FlowSheet.  The display name can 
be the same as the FlowSheet field Name if desired and in fact the Display Name 
defaults to the same text as the Name field when creating a new FlowSheet field. 
This is a required field. 

Data Element This is the underlying data structure that contains information about what type of 
data is captured and stored in the database for any FlowSheet Field that is based on 
that particular Data Element.  For more detailed information about Data Elements 
see “What are Data Elements?”   This is a required field. 

Note This field can be used to provide information about what the FlowSheet field is being 
used to capture and track. This field is NOT a required field and can be left blank if 
desired. 

Validation Tab 
The Validation tab contains information about what the normal Range From and Range To of the values 
for the data entered into the FlowSheet field should be in addition to forms to enter Valid and Invalid 
expected values. 

The Validation tab has a section for Range From and Range To values that allows the user to enter a 
normal expected range for the values that are input into the field and to pick an Abnormal Color to display 
out of range values.  In addition the Validation tab contains sections for input of Valid Values and Invalid 
Values along with pick lists for Valid Color and Invalid Color.  These fields allow the user to enter 
information about expected data input and abnormal input into FlowSheet fields that are not numeric OR 
where the values ARE numeric BUT they do not occur sequentially where they can be used in a range.  
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In other words, for text-based input (that does not fall into a normal range like a numeric value does) in 
FlowSheet fields you can still have information show up in a different color if the data is abnormal OR for 
numeric values that cannot be easily noted in a range (for example, a situation where the values 
expected are 10, 20, 30, etc).  See below for specifics on using validation. 

Validation Tab  
Range From and Range To Enter a range of expected values into these two fields to define the normal range for 

the specific FlowSheet field.  For example the normal range for Diastolic Blood 
Pressure could be considered to be from 40 mmHg to 80 mmHg.  To set this range 
for a FlowSheet field you would enter 40 in the Range From field and 80 in the 
Range To field.   
Note: The system does not currently take into account units so do not enter 
anything other than numeric values into these fields. 

Abnormal Color This field allows the user to select a color for the value entered into the FlowSheet 
field if it falls outside the normal range.  In the example above, the normal range for 
diastolic BP is set from 40 to 80.  If the value 81 were entered into this field it would 
show up in whatever color is selected to denote an abnormal value.  To set an 
Abnormal Color use the dropdown pick list and select the desired color.  Red is the 
default color set for this field. 

Valid Values This field is used to enter expected normal values for a FlowSheet field if the values 
to be entered are NOT numeric OR they are numeric but do not occur in a sequence 
that would easily fit in a range (use Range From and Range To for that purpose).  
The function of this field creates pick lists of items that can be chosen when entering 
information into the FlowSheet field within a FlowSheet.  For example for the 
FlowSheet field Karotype the expected values that can be entered are 46XX, 46XY, 
46XO and 47XXY.  These are a combination of alpha and numeric values and could 
not be documented in the Range From/Range To fields so they are entered into the 
Valid Values field.  This allows the user that is entering data into the FlowSheet to 
choose one of these values from a pick list that is created as a result of entering this 
information into the Valid Values field.  Another example would be any FlowSheet 
field that has a Data Element type of Yes/No.  For these FlowSheet fields user 
would input both Yes and No (or Positive and Negative, True and False, On and Off, 
etc.) into the Valid Values field to create a dropdown pick list of those two answers. 

Valid Color Users can set a color for any value that is input into the Valid Values field.  This field 
defaults to Black but can be changed if desired. To change the Valid Color use the 
dropdown pick list and select the desired color. 

Invalid Values This field can be used in conjunction with the Valid Values field to denote values that 
are considered abnormal or unwanted.  For example in the example about the 
Karotype FlowSheet field given in the Valid Values section a list of expected values 
are created that consist of  46XX, 46XY, 46XO and 47XXY.  All of these values will 
appear in the dropdown pick list for the Karotype field if it appears in a FlowSheet.  
Not all of these values are considered normal however.  The values 46XO and 
47XXY are considered abnormal values and if they are entered into the Invalid 
Values part of the validation field and then picked as a choice in a FlowSheet they 
will appear in whatever color is designated in the Invalid Color field.  Another 
example is a Yes/No choice in a FlowSheet.  For those FlowSheet fields with a Data 
Element of type Yes/No the Valid Values field would contain both Yes and No (or 
Positive and Negative, True and False, On and Off, etc.).  Then the Invalid Values 
field would be populated with the choice that is the one considered as abnormal or 
unwanted.  For example there is a Dilated Eye Exam field that can be used to 
denote whether a diabetic patient has had their expected yearly eye exam.  This is a 
Yes/No FlowSheet field that has both Yes and No entered into the Valid Values field 
but only No is entered into the Invalid Values field so that a No answer will show up 
in the FlowSheet in red to draw attention to the fact that the patient has not had the 
exam.  Other cases will exist where Yes would be the abnormal value and in those 
situations Yes would be entered into the Invalid Values field. 
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Invalid Color Users can set a color for any value that is input into the Invalid Values field.  This 
field defaults to Maroon but can be changed if desired. To change the Valid Color 
use the dropdown pick list and select the desired color.   
Note:  The Invalid Color will default to Red in future versions. 

To pick an existing data element: 
1. Click the magnifying glass icon on the Data Element field. 

The Data Element Select form will open 

2. Enter the name of the Data Element the Name field and click Search. 

3. Select the desired Data Element from the search results by clicking it. 

4. Click Select on the main toolbar OR press the Enter key on your keyboard OR double-click to 
add the Data Element to the Field. 

To create a new data element: 
1. Click the magnifying glass icon in the Data Element field. 

The Data Element Select form will open. 

2. Click New on the toolbar. 

The Data Element Maintenance window will open. 

3. Enter a Name and Description into the respective fields. 

4. Pick a Data Type from the dropdown menu. See Types of Data Elements for details about the 
different selections in this field. 

5. Click Save when finished. 

6. Highlight the new Data Element and click Select on the main toolbar OR press the Enter key on 
your keyboard OR double-click to add the Data Element to the Field. 

Creating a FlowSheet Field Outside a FlowSheet 
Fields can be created from within a FlowSheet at the time the FlowSheet is being created (on the fly) or 
outside of a FlowSheet as part of the regular process of creating items to be used in FlowSheets. 

To create a field outside a FlowSheet: 
1. Click the File menu in the main FlowSheet window. 

2. Select Fields from the menu. 

3. The Field Select window will open. 

4. Click the New button on the toolbar. 

5. The Field Maintenance window will open. 

6. The General tab will be selected by default. 

7. Fill out the Name, Display Name, Data Element and Note fields.  See the General Tab section 
for details. 

To pick an existing data element: 
1. Click the magnifying glass icon in the Data Element field. 

2. The Data Element Select form will open 
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3. Enter the name of the Data Element the Name field and click Search. 

4. Select the desired Data Element from the search results by clicking it. 

5. Click Select on the main toolbar OR press the Enter key on your keyboard OR double-click to 
add the Data Element to the Field. 

To pick a new data element: 
1. Click the magnifying glass icon in the Data Element field. 

The Data Element Select form will open 

2. Click New on the toolbar. 

The Data Element Maintenance window will open. 

3. Enter a Name and Description into the respective fields. 

4. Pick a Data Type from the dropdown menu. See Types of Data Elements for details about the 
different selections in this field. 

5. Click Save when finished. 

6. Highlight the new Data Element and click Select on the main toolbar OR press the Enter key on 
your keyboard OR double-click to add the Data Element to the Field. 

7. Click the Validation tab to enter information about normal/abnormal values or to create pick lists. 

8. Fill out the Range From, Range To, Abnormal Color, Valid Values, Valid Color, Invalid 
Values and Invalid Color fields on the Validation tab if desired.  See the Validation Tab section 
for details. 

9. Click the Save button when finished. 

Creating a FlowSheet Field on the Fly 

Fields can be created from within a FlowSheet at the time the FlowSheet is being created (on the fly). 

To add new fields: 
1. Edit the desired FlowSheet. 

2. Click the New button in the right pane. 

3. A New Field form will open. 

There are five choices for add a new field. These choices allow the user to create a completely 
new Field from scratch or to copy certain parts of existing Fields to create new ones.  This 
functionality is intended to save time when creating FlowSheet Fields.  The five choices are 
described below. 

○ Create a New Field and New Data Element:  This choice is the same as creating a new Field 
outside of a FlowSheet.  If this option is selected: 

 The Data Element Maintenance form will open and you can choose an existing Data 
Element or add a new one.  See Add a New Data Element for details. 

 Once a Data Element is chosen the Field Maintenance form will open and you can finish 
creating the Field.  See Create a FlowSheet Field Outside a FlowSheet for details. 

○ Copy an Existing Field:  This choice allows the user to copy an existing field and then make 
changes as necessary.  This can save time when creating a Field that is similar to an existing 
one but may only need small changes.  For example if you have a patient whose normal 
temperature us 99 you might want to copy the temperature Field, rename it (ex. Low Grade 
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Temp) and make changes to the Validation so that 99 will show up as a normal value for this 
patient.  If this option is selected: 

The Field Select form will open and you can choose an existing Field to Edit.  See Edit a 
FlowSheet Field for details. 

○ Copy an Existing Field but create a New Data Element:  This choice can be used when you 
want keep the same Validation values (normal ranges or pick lists) but want to use a different 
Data Element.  Copying of a Field that contains a Yes/No type Data Element is a good 
example of this choice.  Rather than having to recreate the pick list for a Yes/No type question 
this option can be chosen and a different Yes/No type Data Element can be selected.  If this 
option is chosen: 

 The Field Select form will open and you can search for and choose an existing Field to use.   

 After a Field is selected the Field Maintenance form will open will all the information filled 
out EXCEPT the Data Element. 

 Pick an existing Data Element to use or create a new one.  See Add a New Data Element 
for details. 

○ Create a New Field Based on an Existing Data Element:  This option allows the user to pick 
a Data Element first and then enter information into the FlowSheet Field properties to create 
the Field.  If this option is chosen: 

 The Data Element Select form will open. 

 Pick an existing Data Element or create a new one.  See Add a New Data Element for 
details. 

 Once a Data Element is chosen the Field Maintenance window will open with ONLY the 
Data Element field filled out. 

 Fill out the required information for the Field.  See “Create a FlowSheet Field Outside a 
FlowSheet” for details. 

○ Create a New Field based on an Existing Field’s Data Element:  This option allows the 
user to select an existing Field and use ONLY its Data Element to create a new Field.  For 
example a Pulse FlowSheet Field exists that has an underlying Data Element called Heart 
Rate.  This is the same Data Element that would be used to create a Fetal Heart Rate 
FlowSheet Field.  Use of this option would allow you to pick the FlowSheet Pulse field so that 
you can use the Heart Rate Data Element to create a completely new FlowSheet Field. 

 The Field Select form will open and you can search for and choose an existing Field that 
contains the Data Element you want to use. 

 Once the Field is selected the Field Maintenance window will open with ONLY the Data 
Element field filled out. 

 Fill out the required information for the Field.  See “Create a FlowSheet Field Outside a 
FlowSheet” for details. 

 Once one of these options is selected the Field Maintenance form will open.  Depending on 
the choice made some, none or all of the fields on this form may be filled out. 

 Make changes or additions to the fields as desired.  See the “General Tab” and “Validation 
Tab” sections for details. 

4. Click Save when finished. 
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Editing a FlowSheet Field 
FlowSheet Fields can be edited at any point after they have been created. 

To edit a FlowSheet field: 
1. Click the File menu in the main FlowSheet window. 

2. Select Fields from the menu. 

3. The Field Select window will open. 

4. Enter the name of the Field to be edited into the Name field and click the Search button on the 
toolbar OR press the Enter key on your keyboard. 

5. Highlight the desired Field in the search results and click the Edit button on the toolbar OR press 
the Enter key on your keyboard OR double-click the name of the Field. 

6. The Field Maintenance window will open with the selected Field displayed in Edit mode. 

7. Make desired changes to the items in the General tab (Name, Display Name, Data Element or 
Note) or to the items on the Validation tab (Range From, Range To, Abnormal Color, Valid 
Values, Valid Color, Invalid Values and Invalid Color).  See "The Field Maintenance Form" 
section for details. 

Important!  Editing of a FlowSheet Field may affect data that has already been collected in some 
patient specific FlowSheets if the Field is part of that FlowSheet and depending on the changes that have 
been made to the FlowSheet Field.  Keep in mind that any changes to a field will b e transferred to every 
FlowSheet that the Field is linked to. 

Setting Validation for a Field 
See Validation Tab for information on how to enter expected ranges for the values that are input in fields. 

Creating Pick Lists for Fields 
The Valid Values field lists possible Validation used to create pick lists of answers for a FlowSheet field.  
For example, for the FlowSheet field, Karotype, the expected values that can be entered are 46XX, 46XY, 
46XO and 47XXY.  These are a combination of alpha and numeric values that could not be documented 
in the Range From/Range To fields.  Alpha numeric or text choices must be entered into the Valid Values 
field.  This allows the user entering data into the FlowSheet to choose one of these values from a pick list.  
Another example would be any FlowSheet field that has a Data Element type of Yes/No.  For these 
FlowSheet fields the user would input both Yes and No (or Positive and Negative, True and False, On 
and Off, etc.) into the Valid Values field to create a dropdown pick list of those two answers.  From the 
Valid Values choices, items that indicate an abnormal result or outcome can be copied and pasted into 
Invalid Values.  Invalid values display in red when appearing in a FlowSheet providing a visual indicator of 
an abnormal result or outcome.  See the “Validation Tab” section for more details. 
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10 
Managing Visit and Order 
Notes with the Unsigned 

Notes Module 
Like the Unsigned Notes report the Healthcare Visit Sign Off module allows a provider 
to view all unsigned notes created under their name.  Unlike the unsigned notes 
report this module allows providers to also sign off on these notes.   Using this 
module a provider can either select notes individually or multiple selected them and 
permanently sign them off all at the same time.  Additional functionality allows the 
user to edit any of the notes in the list of unsigned notes. 

Note:  As with all permanently signed notes a password is required.  However the password 
needs only to be entered once.   

Continued on the next page ... 
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Accessing the Unsigned Notes Module 
The Healthcare Visit Sign Off module can be accessed from the Dashboard application and also from 
within the Chart application. 

To access the Healthcare Visit Sign Off module: 
1. With the Dashboard running, click Run. 

2. Choose Unsigned Notes from the menu. 

OR 

From the main Chart menu toolbar, click Tools then select Health Care Visit Sign Off from the 
drop-down menu. 

A window labeled Multiple Sign Off will open. 

Understanding the Unsigned Notes Module Interface 
File Menu  
Exit The exit menu choice will close the application. 

  
Help Menu  

Search Topics Selection of this choice will open the built in help files and allow users to search for 
help on specific topics. 

About Selection of this choice will display a screen that shows the current version number 
of the application.  This information can be helpful when tracking down problems 
and may be asked for by the support department. 

  
Toolbar Items  
Sign Off Button This button will sign off any selected notes (notes that have check marks in the 

check box to the left). 
Refresh Button This button will refresh the screen and show new data if it exists. 
Date Range Filter The Date Range Filter allows the user to enter a date range and then only see the 

unsigned notes for that time period.  To use the date range, click the check box and 
then enter a starting and ending date using the drop down calendar picker or by 
typing the date in the field. 
Note:  The application is set to show all unsigned notes by default. 

Visit Notes/Order Notes 
/Log/Rx Notes Choice 

Users can choose to see unsigned Visit Notes, Order Notes, Unsigned 
Log/Phone/Rx Notes or Both.  The default setting is to show Both but users can 
clear the check box next to the item the do not want to see. 

 

Grid Columns  
Check Box This column contains check boxes for each note.  Users can check a box and then 

click the Sign Off button to permanently sign off the note. 
Type This column shows the Type of note with icons representing the type.  Visit Notes, 

Order Notes, Permanent Log Notes, Permanent Phone Notes and Permanent 
Prescription Notes are the types currently available for sign off.   

Patient This column displays the name of the patient. 



 

e-MDs Solution Series Chart User Guide 8.0 R01 338 

Description This column displays a description of the note. Currently only the Visit or Order 
Notes will display a description. The description for the note is a list of the diagnoses 
that were documented in the note. 

Date Displays the date the note was created. 
Unlabeled Column The last column has no label.  An Edit icon (pencil) is displayed in this column.  

Users can click the Edit button to open the note in edit mode.  This allows the user 
to review the note and make changes, if necessary, prior to signing off. 

Note:  If any unsigned notes exist they will be listed by the date associated with the note with the oldest visits 
listed at the top and the more recent visits listed at the bottom of the list. 
The items listed in the grid can be reordered to show the visits alphabetically by patient or by date.  To list the visits 
alphabetically by patient click the Patient label at the top of the patient column.  To return to a list by date click the 
Date label at the top of the date column. 

 

Signing Off and Editing Unsigned Notes 
Unsigned notes can be signed off either individually or in groups by multiple selecting from within the 
Unsigned Notes module. 

To sign off an individual unsigned note: 
1. Click the check box to the left of the note to be signed 

2. Click the Sign Off button at the top left of the window 

3. Enter the password used to login to e-MDs applications 

4. Click the OK button 

To sign off multiple-select unsigned notes: 
1. Click the check box to the left of each of the notes to be signed. 

Note:  To select or unselect ALL notes at one time, click the check box icon at the top of the 
check box column. 

2. Once all the desired notes are marked with a check mark, click the Sign Off button at the top left 
of the window. 

3. Enter the password used to login to Chart. 

4. Click the OK button. 

Unsigned notes can be also edited from within this module. 

To edit an unsigned note: 
1. Click the pencil icon to the right of the visit to be edited 

2. The specified patient’s chart will open to the appropriate visit 

3. Make any changes as necessary 

Co-Signature Tab 
This feature is used when providers require supervisor review and sign off on their Visit or Order Notes.  
Under the Supervisors tab of Provider Demographics, check the box to the left of “Requires co-signature 
on visit notes” to activate this option.  The check box is located at the bottom of the window.  When set, 
all notes for this provider (resident, PA, NP, doctor, etc.) are routed to the supervisor designated in the 
note, as well as the rendering provider.  The supervisor can view the note under the co-signature tab in 
the Unsigned Notes module.  This tab will only display if notes requiring co-signature exist.  
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Toolbar Items  
Sign Off Button This button will sign off any selected notes (designated by a marked check box on 

the left side). 
Refresh Button This button will refresh the screen and show new data if any exists. 
Date Range Filter The Date Range Filter allows the user to choose a date range for the display of 

unsigned notes.  To indicate a date range, click the check box and enter a start/end 
date. Do this by using the drop down calendar display or by typing the date in the 
field. 
Note:  The application is set to show all unsigned notes by default. 

 
Grid Columns  

Check Box This column contains check boxes for each note.  Users can select the note for sign 
off by placing a check in the box and then click the Sign Off button.  This note is now 
permanently signed off.  This functions identically when co-signing the note. 

Type This icons displayed in this column indicate the Type of note requiring sign off.  Visit 
Notes, Order Notes, Permanent Log Notes, Permanent Phone Notes and 
Permanent Prescription display in this module.   

Red X This column allows the supervisor to remove the note from their unsigned notes list 
without co-signing the note. 

Patient This column displays the name of the patient. 
Description This column displays a description of the note. Currently, only the Visit or Order 

Notes will display with a description. The description for the note is a list of the 
diagnoses that were documented in the Visit or Order Note. 

Provider This column displays the rendering provider. 
Date Displays the date the note was created. 
Unlabeled Column The last column has no label.  A sunglasses icon (view) is displayed in this column.  

Users can click the View button to open the note.  This allows the supervisor to 
review the note, add an addendum and co-sign the Visit or Order Note. 

Note:  The items listed in the grid can be sorted to show the visits alphabetically by patient or by date.  To list the 
visits alphabetically by patient, click the Patient label at the top of the patient column.  To return to a list by date, 
click the Date label at the top of the date column. 

Co-Signing Chart Notes    
Unsigned notes can be co-signed either individually or in groups by multi-selecting from within the 
Unsigned Notes module. 

To co-sign an individual unsigned note: 
1. Click the check box to the left of the note to be signed. 

2. Click the Sign Off button at the top left of the window. 

3. Enter the password used to login to e-MDs applications. 

4. Click the OK button. 

To sign off multi-select unsigned notes: 
1. Click the check box to the left of each of the notes to be signed. 

2. To select or clear all notes at one time, click the check box icon at the top of the check box 
column. 
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3. Once all the desired notes are checked, click the Sign Off button at the top left of the window. 

4. Enter the password used to login to Chart. 

5. Click the OK button. 

If the Visit or Order Note does not need co-signature or if only a percentage of the list requires co-
signature, those notes can be removed from the unsigned notes list. 

To remove Visit or Order Notes from your unsigned notes: 
1. Check the box under the header with the Red X. 

2. Once all the desired notes are marked with a Red X, click the Sign Off button at the top left of the 
window. 

3. Enter the password used to login to Chart. 

4. Click the OK button. 

To review and add an addendum: 
1. Click the sunglasses icon to the right of the note. 

2. The specified patient’s chart will open to the appropriate visit. 

3. Click co-sign.  

4. Select which addendum should be added to the visit.  Free text can be used in this field. 

5. Enter the password used to login to Chart. 

6. Click the Save button. 

7. Close the patient’s chart. 
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11 
Accessing Art with the 

Medical Art Quick Selector 
The Medical Art Quick Selector is mechanism for accessing medical art images from 
the Medical Art Editor, from a directory on the user’s computer or network, or from a 
camera, that can be annotated and added to a patient’s chart record while generating 
a Visit or Order Note.  The Medical Art Quick Selector displays the figure of a man or 
woman, adult or child depending on the age and gender of the patient.  The figure 
contains “hotspots” that become enabled as the user passes the mouse cursor over 
them.  Clicking the hotspot will open a window that displays thumbnails of linked 
images.  These images are related to the body part represented by the hotspot.  For 
example, clicking the heart area “hotspot” of the body figure will display linked 
cardiovascular related images.  Users can select images from the link window to add 
to the note. Additionally users can annotate these images, e.g. adding text or 
drawings, to help illustrate points for the patient and/or provider.  

Continued on the next page ... 
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Understanding the Quick Selector Interface 
 

Toolbar Items 
 

Search (magnifying glass 
icon) 

Opens the Medical Art Editor window so that the end user can search for and add 
medical art images to this note, not currently linked to the Hotspots. 

Load (folder icon) Opens a browser window on this computer so that the end user can search, select 
and import an image file to this note, not currently linked to the Hotspots. 

Capture (camera icon) Opens the Image Capture window so that the end user can take a picture, 
using an installed camera, and add it to the Visit or Order Note, outside of 
the linked images stored in the Hotspots. 

Exit (boxed red X icon) Closes the Medical Art Quick Selector window without making any 
selection. 

Exam, Patient Ed, and 
Reference 

Hotspot Categories for linked images. 

Types of Linked Images 
There are three different types of Categories for these Hotspots: 

• Exam: Images that can be used by the medical staff to document a medical condition, e.g., noting 
the location of a lesion such as a tumor; to document the results of a procedure, e.g., noting the 
location of a laceration repair and sutures added; to document a planned procedure, e.g. noting 
the area on the liver to be biopsied; etc… 

• Patient Ed: Images that can be used by the medical staff to provide additional information 
regarding the patient’s medical condition, proposed therapies or instructions, exercises, anatomy 
information, etc… 

• Reference: Images that can provide medical reference information for the medical staff. 

Adding Medical Art to a Visit or Order Note 
To add medical art images to a Visit or Order Note : 
1. Log into Chart.   

2. Search/select a patient record and start a Visit or Order Note.   

3. Click the Art navigation button, located to the left of the Note.   

4. This opens the Medical Art Selector window.  The body figure launched is based on the patient’s 
age and gender. 
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5. Choose the category that corresponds to the type of medical art to be viewed.  Choices include 

Exam, Reference and Patient Ed.  The category selected will determine what image thumbnails 
are displayed. 

 

 
 

6. After the Category is selected, move the mouse cursor over the body of the figure.   

Note:  This “enables” the Hotspot for this body region.   

7. Click the “Hotspot” or body area associated with this medical art item to display all currently linked 
Medical Art Images. 
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8. Click the image desired.  This opens the image in the Medical Art Editor window. 

 

 
 

9. At this point, you can close the Medical Art Editor window (click the corner “X”) to add this image 
to the Medical Art Quick Selector Thumbnail Strip prior to adding it to the note. 
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10. If desired, repeat the steps above to add additional linked medical art images to the Thumbnail 
Strip.  These displayed images will also be added to the Visit or Order Note. 

11. When done, close the Medical Art Quick Selector window.  This adds the thumbnail(s) of the 
linked image(s) to a Strip at the bottom of the note. 
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Annotating Medical Art 
You can also make annotations to any of the linked medical art images either prior to adding them to the 
Visit or Order Note or afterwards, prior to sign-off. 

Remember that when clicking a thumbnail of a linked image in the Thumbnails window, the image is 
opened in the Medical Art Editor window.  At this point you can use the editing tools to add lines, squares, 
circles, to add text or to reduce/enlarge the image. 

 
 
Closing the Medical Art Editor window adds this thumbnail to the Medical Art Quick Selector Thumbnail 
Strip.  See “Medical Art Editor Help” section for more information regarding annotations. 
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Prior to closing the Medical Art Quick Selector window, you can click any of the listed thumbnails stored in 
the Thumbnail Strip.  This again opens the thumbnail image in the Medical Art Editor. 

When you close the Medical Art Quick Selector window, this adds the annotated image by thumbnail to 
the Visit or Order Note. 

 
 
After the thumbnail has been added to the Visit or Order Note, prior to sign-off, you can click any of the 
these thumbnails.  This opens the thumbnail image in the Medical Art Editor for annotations.  Closing the 
Medical Art Editor returns the thumbnail to the Chart Thumbnail Strip. 

Note:  If you re-open the Medical Art Quick Selector window, all thumbnails added to the note will be 
displayed here as well. 

Using the Medical Art Quick Selector Thumbnail Strip 
Located in the Medical Art Quick Selector Window and displays all of the medical art images that are to 
be added to the Visit or Order Note. You can annotate or remove the thumbnails through this strip. 

Removing Images from Medical Art Quick Selector Thumbnail Strip 
To remove any selected art from the Medical Art Quick Selector Thumbnail Strip, right-click over the 
thumbnail and select the Remove menu option.  
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Editing Images 
To edit any medical art images that have been either added to the Medical Art Quick Selector Thumbnail 
Strip or to a Visit or Order Note, simply click the Thumbnail to load it into the Medical Art Editor.  See the 
Medical Art Editor Help for assistance with performing annotations and edits. 

Removing Medical Art from a Visit or Order Note 
Within the Chart Visit or Order Note, right-click the Thumbnail in the Chart Thumbnail Strip and select the 
Remove menu option. 

 
 
OR 
Re-open the Medical Art Quick Selector Window and right-click the thumbnail listed in the Thumbnail 
Strip.  This will also remove the thumbnail from the Visit or Order Note. 

 



 

e-MDs Solution Series Chart User Guide 8.0 R01 350 

Adding/Removing Linked Images from the Medical Art 
Quick Selector 
In the Thumbnails window, there is an Edit button that is used to add or remove images from the Hotspot 
categories.  Click the Edit button and this makes both the Add and Remove buttons active.  

 
Click one or more of the thumbnails listed.  Notice now that they are highlighted. (To clear an image 
selection, simply re-click the thumbnail.) 

 
 
Clicking the Add button opens the Medical Art Editor.  Search for desired medical art image and click 
Select button.  This will add this medical art image as another thumbnail. 

To delete any thumbnail, click the Edit button to make the Add or Remove buttons active.  Then click the 
thumbnail of the medical art image to select it.  Click Remove button. Click Yes to confirm the deletion 
and this will remove the thumbnail from the thumbnail window. 

Note:  This does not delete the medical art image from the Medical Art Editor.  It only removes it from 
the Medical Art Quick Selector. 

Capturing Images Using a Web Camera 
To upload an image using a Web Camera, click the Camera Capture icon 
in the toolbar. 

In the Image Capture window, first click the Options button.   

Select a preference as to how you would like to “capture” or upload the 
image.  You can either choose to use the software utility used by the 
camera’s manufacture before uploading the image (allows you to use 
tools to edit image before uploading) or simply load the image from 
camera driver’s memory. 
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Note:  The default setting is to use the utility provided by the camera’s manufacturer.  So if you change it 
to “read directly from the camera’s memory”, after capturing an image and uploading it, you will need to 
reset this preference prior to capturing a new image. 

Next click the Select button.  This preference is to select the correct Twain driver for your installed 
camera.  Click the desired driver and click the Select button. 

Note:  This is very important as this computer may have multiple Twain drivers installed such as a 
scanner or other web camera on this computer.  Once you have selected the desired Twain driver, it will 
remain selected while using the camera through the Medical Art Quick Selector utility.  Remember to 
update this Twain preference when changing to another program that uses a different Twain driver such 
as DocMan or FastForm which uses a scanner Twain driver. 

 
 
Finally, click the Take (Camera icon) button.  If you chose to load the image from the camera driver’s 
memory, then this will automatically display the image captured in the lower screen of the Image Capture 
window.  

Click Accept (green check mark icon) button, add a 
description when prompted, and click OK button. 
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This then opens the image in the Medical Art Editor window. Make any annotations as desired and then 
close the Medical Art Editor Window. 

 
 
The captured image is then added the Medical Art Quick Selector Thumbnails Strip.  You can right-click 
the image to delete it or click it to annotate it again.  Once done, close the Medical Art Quick Selector 
window to add this captured image to the Visit or Order Note. 

Note:  This process does not add this image to the Medical Art Editor library of images. See the Medical 
Art editor for help with adding images to its library. 

If you selected to “use the utility provided by the camera’s manufacturer” the image will first be loaded into 
this utility’s viewer.  See your camera’s Help guide for modifying the image and capturing the image 
through this utility.  Once captured, the image will now be displayed in the lower half of the Image Capture 
window as when loading the image directly from the Camera driver’s memory. 

Note:  If you cancel the process through the manufacturer’s utility, this might generate an error message 
that an image could be retrieved from the camera or that there might be a problem with the camera 
installation or power resources. 
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Simply click OK button or whatever button is listed in the error message to close it.  There is conflict 
between the manufacturer’s utility cancel process and the Medical Art Quick Selector.  This error 
message generally does not indicate that there is a problem with the camera.  However, if you see this 
error message when attempting to capture the image, see your Camera manufacturer’s Help guide or 
Windows Help for troubleshooting your camera’s installation. 

Importing Images into a Visit or Order Note  
Medical Art Quick Selector also allows end users to import images stored on the hard drive of this 
computer or from any computer in this user’s network.  To import an image, click the Load button in the 
toolbar.  This opens the Browser window to search and select an image file.  Prior to importing the image, 
select it to preview its content in the viewer on the Right side of this Browser window. 

 
 
Note:  The user can import a variety of file types including .jpeg, .jpg, .bmp, .gif, .pox, .tiff, and .pang.  
The Medial Art Quick Selector converts these files to .jpg format prior to saving the image.  This might 
affect the resolution display of the original file after it has been imported. 

Once the correct image is located, click Open button and add a description to this image file. 

 
 
Click the OK button and this will load this image into the Medical Art Editor window. 
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Perform any desired annotations and close this window.  This adds this imported image to the Medical Art 
Quick Selector Thumbnail Strip.  Close this window to add the imported image to the Visit or Order Note. 

 
 
Note:  This imported image file is not loaded into the Medical Art Editor library.  It is only linked to this 
patient file.  See the Medical Art Editor Help section for assistance with importing image files to its library. 

Viewing Medical Art in Chart View 
To view the medical art image added to a Visit or Order Note, search and select the patient.  Click the 
Chart View button.  Click the tree (+ sign) to expand the note.  Any added medical art will be listed below 
the note as Figure 0 and the name of the medical art image.  Click the description of this medical art to 
view the image on the Right screen. 
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Printing Medical Art 
To print the linked medical art image, when concluding or signing-off the Visit or Order Note, check the 
box next to Medical Art option. 

OR 

From Chart View, select the Visit or Order Note and click Print.  Check the box next to Medical Art option 
to print all linked medical art images. 

 
 
The medical art image can also be printed when it is loaded into the Medical Art Editor.  Simply click the 
Printer icon located on the toolbar. 
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12 
Using the Rule Manager 

A rule is simply a set of parameters that allow the Solution Series software to 
automatically generate reminders. Those reminders contain information that alerts 
providers and clinical staff to such things as abnormal lab reports, best practices for 
preventive care and disease management, or forms to be completed. Reminders are 
displayed in the patient’s chart and in the Schedule and Tracking Board applications. 
They can also be made available on the Patient Portal.  

When rules are created, they run automatically (real-time) when the rule’s parameters 
are met. For example, if a rule is designed to generate a reminder for routine 
hemoglobin A1c lab tests based on a diagnosis of diabetes, and a user adds that 
diagnosis to a patient’s chart, the rule will run as soon as the diagnosis is saved to the 
patient’s chart. Rules can also be run on demand or can be set up to run on a daily, 
weekly, or monthly schedule. 

 The Rule Manager also includes functionality that allows users to generate reports 
and task lists. For example, the Notice Processor rule (available on the Tasks tab of 
the Rule Manager) generates a list that can be sent automatically to a user’s 
TaskMan inbox. 

The Rule Manager includes a number of rules created by e-MDs, and users can 
easily add new rules. 
 

 

Continued on the next page ... 
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Understanding Rule Types 
e-MDs Chart contains the following types of rules: Disease Management, Gestational Age, Health 
Maintenance (based on CPT), Immunizations/ Repetitive Testing Scenarios, Lab result (FlowSheet), Lab 
Tracking rule for over due CPT/HCPCS, Medication rule by CPT, Medication rule by CPT and ICD, 
Require Form (HIPAA, Advanced Directive, Portal) and Script Audit rule for overdue reports.  With the 
exception of the Script Audit and the Lab Tracking rule type, each of these rule modules can be used to 
generate an unlimited number of Rules.  

• Disease Management: Disease Management rules track whether recommended tests or 
procedures are being performed regularly on a patient with a certain diagnosis. Rule parameters 
include the diagnosis (one or more ICD codes), the tests or procedures recommended for proper 
disease management (one or more CPT codes), the age and gender of the patient, and the 
frequency that the test needs to be ordered. For example, a rule created using this module could 
be used to track whether all diabetic patients are getting an HgbA1c test every 3 months as 
recommended. 

• Gestational Age: This type of rule generates procedure/test reminders based on gestational age.  
Parameters include the patient’s age, the diagnosis (one or more ICD codes), the gestational age 
and the test or procedure (one or more CPT codes) that is due. 

• Health Maintenance: Health Maintenance rules determine whether the tests and procedures for 
detection or prevention of specific diseases are being performed regularly, according to 
recommended schedules. Parameters include the patient’s age and gender, the tests or 
procedures that are recommended (one or more CPT codes), and the frequency that these tests 
should be performed. For example, a rule created using this module could be used to track 
whether all female patients over the age of 50 have had a mammogram annually. 

• Immunizations/Repetitive Testing Scenarios: This type of rule is designed to track adherence 
to immunization schedules, but the rule could also be used to track other CPT related information. 
Parameters include the immunization type (one or more CPTs), the patient’s age, and the 
cumulative number of immunizations (of a specific type) that should be given by that age. For 
example, one Immunization rule might check that all infants have a total of 2 DTaP vaccinations 
by the age of 4 months; a second rule would verify a total of 3 DTaP vaccinations by age 6 
months, and so on. 

• Lab Result (FlowSheet): This type of rule tracks abnormal lab results. Parameters include 
patient’s age and gender, the diagnosis (one or more ICD codes), the specific lab test and lab 
value. Using the defined parameters, this rule searches the database for abnormal lab results and 
provides feedback within the patient’s chart. 

• Lab Tracking:  This type of rule tracks whether results have been received for labs, tests or 
procedures that were ordered within Chart. CPT and HCPCS codes that are considered 
"trackable" have parameters associated with them that denote a time frame for when the results 
for a lab, test or procedure should be expected back. Using these parameters this rule searches 
the database and messages users when something is deemed to be overdue.   

• Medication Management:  Currently there are two types of rules that can be used for 
medications management. 

○ Medication Rule by CPT:  Patients on particular medications may need to have tests or 
procedures performed regularly. This rule type tracks whether these tests or procedures are 
being performed in adherence to a recommended schedule. Parameters include patient’s age 
and gender, the medication, the recommended test or procedure (one or more CPT codes,) 
and the frequency with which the test or procedure should be performed. For example, this 
rule can be used to track whether a patient on Methotrexate has a liver and renal function test 
ordered at least every 3 months. 
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○ Medication Rule by CPT and ICD:  Patients with specific diagnoses AND on particular 
medications may need to have tests or procedures performed more frequently than those 
patients on the same medication but without the diagnosis.  This type of rule tracks whether 
these tests or procedures are being performed in adherence to a recommended schedule.  
Parameters include patient's age and gender, the medication, the diagnosis (one or more ICD 
codes), the recommended test or procedure (one or more CPT codes) and the frequency with 
which the test or procedure should be performed.  For example, a rule created using this 
module can be used to track whether a patient with Congestive Heart Failure (CHF) who is 
on Lotrel has a metabolic panel ordered at least every 2 months (patients without CHF who 
are on Lotrel are recommend to have the test every 6 months). 

• Require Form (HIPAA, Advanced Directive, Portal): If portal authorization, HIPAA 
authorization, or Advance Directives scanned into DocMan are expiring or not available, this rule 
allows users to get a message and/or populate the reminders section of their chart. 

• Script Audit: Users in Ohio are required to print a report of faxed prescriptions on a regular 
basis.  This rule acts as a tickler file by sending a TaskMan message if a report has not been 
printed in X number of days. 

Creating a New Clinical Rule 
To create a new rule: 
1. Open the Rule Manager module. (Click Run > Rules Manager). 

2. Click the Clinic tab located at the top of the Rule Manager window. A list of available Rules will 
be listed in the Rule Name column on the left side of window. 

3. Click New on the main Rule Manager toolbar. 

4. The Select Rule Module window will open. This window displays a list of all available rule types. 

5. Highlight the applicable rule type and click Select to open the New Rule window. 

Note: To see a brief explanation of the general functionality of the selected rule type, click the 
Info tab in the New Rule window. 

6. In the Rule Name field, type a name for the new rule. This name will be shown in the list of rules 
in the Rule Manager. 

7. In the Result Description field, type a description that clearly describes the focus of the rule and 
any actions that need to be taken. (For example, a health maintenance rule for mammograms is 
shipped with e-MDs Chart. The description for that rule reads: “MAMMOGRAM yearly for all 
female patients 50 and older.”) 

Note: The Result Description is the text that will appear in the rule-based reminder area of the 
Reminders tab in e-MDs Chart and is different from the Rule Name (although the Rule 
Description and Rule Name can be the same, if desired). 

8. Confirm that the Rule Active check box is checked. (If this check box does not contain a check 
mark, the rule will not run.) 

9. If the rule requires a vitals value or Flowsheet data to satisfy the rule, click the Require 
Flowsheet/Vitals to satisfy rule check box. (Clicking this check box activates the 
Flowsheet/Vitals Satisfiers tab. On that tab you can add the type(s) of vitals or lab results that will 
satisfy the rule.) 

10. Enter the remaining parameters for the rule. 

Various tabs are available in the New Rule window. On each tab, you can enter certain 
parameters for the rule. The parameters you enter determine how the rule will function. Some 
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parameters define the population for which the rule will run, some define the triggers that will 
cause the rule to generate a reminder, message, or report; and others define the action that 
needs to be taken to safisfy the rule. Tabs vary somewhat by rule type, and the parameters 
available on a tab also vary by rule type in a few instances. Most parameters are self-explanatory, 
but information about specific tabs and parameters is provided in the pages following these 
instructions. 

11. After you enter all the necessary parameters for the rule, click the Save button on the toolbar to 
finish the process and save the rule. 

Common Tabs and Parameters 
The New Rule window and the Edit Rule window include various tabs that display rule parameters and 
other information. For most rule types, tabs and parameters are very similar. Those common tabs and 
parameters are described in the following pages. However, two rule types (Lab Tracking and Script Audit) 
are significantly different, so tabs and parameters for those rule types are described separately. 

Note:  Rule parameters define how a rule will function. Parameters must be defined completely in order 
for the rule to generate reminders and for the actions based on those reminders to “satisfy” the rule (i.e, 
remove the rule-based reminder from the list of current reminders). 

Rule Tab 
The Rule tab is present for all rule types. Common parameters are described in the following table. A few 
parameters are available only for certain rule types; those rule types are identified in the table. 

Parameters  
Available to Portal Click this check box to display the rule reminder in the patient’s Portal.  
Portal Description If the reminder is to be displayed in the Portal, type the text to be displayed. (This 

parameter allows you to display reminder text in the Portal that is different from the 
reminder text that is displayed in Chart.) 

Gender Select the gender to which the rule applies. 
Minimum Age 
Maximum Age 

This parameter defines the age range for the patient population to which the rule will 
be applied.  Type the applicable numbers in the Week, Months, and Years columns 
for Minimum Age and Maximum Age. 
Note: To create a rule that applies to patients of all ages leave all fields at zero 
except the “Max age in years” field.  In that field fill in 100 (or older). 

Frequency 
(available only for certain 
rule types) 

This parameter defines how often the rule should run.  Type the applicable numbers 
in the Weeks, Months, and Years columns.  For example if a test or procedure is 
recommended to be run every 6 months, type “6” into the “Months” column for 
Frequency. 
The Frequency parameter is available for the following rule types: Disease 
Management, Health Maintenance, Medication by CPT, Medication by CPT and ICD 

User Roles The User Role parameter allows you to limit rule visibility to certain user roles. (Rule 
and rule reminders will be seen ONLY by the selected roles). Click the check box 
next to the role(s) for which the rule should be visible in Chart. 

Rule Reminder 
(not applicable to Lab Result 
rule type) 

This parameter defines the time period (number of days) that the automated 
reminder is to be generated and displayed before the related action is actually due.  
For example, if you type “90” in the Rule Reminder field, the reminder will be 
displayed in the patients’ charts 90 days before the test or procedure is actually due. 
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Tracking, Type of Form, and 
Action 
(available only in the 
Required Form rule type) 

The Tracking parameter includes two options: 
• The Track only patients with expired forms option tells the system to 

generate a reminder and/or taskman message only if the selected form 
type exists in the patient’s DocMan and the current date is past the 
expiration date. 

• The Track all patients (create rule results) option tells the system to 
generate a reminder if the selected form type exists in the patient’s 
DocMan, but is expired or if the selected form type does not exist in the 
patient’s DocMan. 

The Type of Form parameter defines the type of form the rule will look for. Click the 
radio button next to the form name to select that form. Only one form can be 
selected per rule. 
The Action parameter determines whether the rule will generate a reminder or 
TaskMan message or both. If the rule is to send a TaskMan message, the user must 
also enter a recipient for the message. 

Number of Times 
(available only in the 
Immunizations rule type) 

This parameter allows you to define the total number of times a patient needs to 
have a test or immunization. When the applicable CPT or immunization has been 
ordered the defined number of time, reminders will no longer be generated for that 
CPT or immunization. 

Lab Test Result and Lab 
Value 
(available only in the Lab 
Result rule type) 

These parameters allow you to define a rule that will generate a notification if lab 
results are received that fall outside of a defined range (i.e., less than, equal to, or 
greater than a specified value). 
Click the Lab button to select the lab test result for which you want to receive 
notification if the result falls outside of the range defined in the Lab Value parameter. 
Select (click) one of the Lab Value range options (i.e., Less Than, Greater Than, 
etc.) and then type the number in the Value field. 
For example if you want to be notified if the selected lab result is >200, then select > 
greater than and type 200 in the Value field.  

Gestational Age 
(available only in the 
Gestational Age rule type) 

The rule will run only when a patient’s gestational age falls within the selected time 
frame. 

Medication 
(available only in the two 
Medication rule types) 

When the selected medication is included in a patient’s chart, the rule generates a 
reminder that the test or procedure selected on the CPT Satisfiers tab should be 
performed.  
Click the Medication button to open the Select a Drug screen in which you can 
search for and select the medication. 
Note: Only one medication can be selected for each rule written.  All medications in 
the database that have the same ingredients will be included in the rule.  For 
example, picking Proventil would cause the rule to be run for not only Proventil, but 
also Ventolin and all brands of albuterol. Also keep in mind that the drug rule is NOT 
form or strength specific.  In the example above, a reminder would be generated for 
any patient on any form of albuterol (inhaler, nasal spray or tablets). 

Patient Only (Optional) 
(not applicable to Required 
Form rule type) 

This parameter allows you to create a rule that will be applied to ONLY one patient. 
In other words, if this field contains a patient name, then the rule becomes specific 
for that patient only and will no longer be run on all patients. Click the Patient button 
to launch the Find Patient window.  Search for and select the correct patient. (For 
detailed instructions, see the Creating a Patient-Specific Rule section in this chapter 
of the user guide.) 
Note: Before you convert an existing rule to a patient specific rule, ALWAYS COPY 
THE EXISTING RULE FIRST.  Otherwise the original rule will no longer be valid for 
ALL patients.  
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ICD Triggers Tab 
This tab is available for Disease Management, Gestational Age, Lab Result, Medication by CPT and ICD, 
and Required Form rule types. The parameters on the ICD Triggers tab allow you to select the diagnoses 
that will cause a rule to run. You can select primary ICD codes and you can enter alternate descriptions. 

 

Parameters  
PRIMARY Health Condition 
Lookup (ICD-9) 
 

Click the PRIMARY Health Condition Lookup ICD-9 radio button to activate the 
Add and Delete buttons for the Primary ICD. Then click the Add button (blue plus 
sign) to open the ICD Search window in which you can search for and select one 
or more ICD codes. 
Note: To add multiple codes at once:  Search for a code. In the search results, 
highlight all codes that you want to add and then right-click on the highlighted 
codes. An “Add Code(s) to Select List” pop-up box will be displayed. Click that 
pop-up box. A “Select List” pop-up box will be displayed. This pop-up box contains 
all selected codes. To add the codes shown in that pop-up box, click the Select 
button at the top of the ICD Search window.   

ICD Alt Description This field allows for the input of an ICD alternate description.  Alternate 
descriptions can be used to specify non-specific codes.  For example code 281.9, 
which is officially described as Unspecified Deficiency Anemia, can become 
Megaloblastic Anemia by use of an alternate description.  Use of alternate 
descriptions in Clinical Rules allows for tracking of diagnoses that would otherwise 
not be trackable. 
To enter an alternate description, click the ICD Alt Description radio button. This 
activates the ICD Alt Description field and associated buttons. 
Click the Alt ICD button to search for and select an alternate ID. 

 

Drug Allergy Triggers Tab and Non-Drug Allergy Triggers Tab 
These tabs are available for all rule types except Lab tracking and Script Audit. Allergy triggers can be 
used in a variety of ways. For example, suppose a certain type of immunization is contraindicated for 
patients who are allergic eggs. If you add eggs as a non-drug allergy trigger, and you enter the CPT code 
for the contraindicated immunization on the CPT Satisfier tab, the rule will look for charts in which an egg 
allergy is documented. If an egg allergy is documented, and the CPT code for the immunization does not 
exist in the order history, the rule will generate a reminder (warning) and display it on the Reminders tab 
of the chart. 

The only parameter that can be defined on the Drug Allergy Triggers Tab and the Non-Drug Allergy 
Triggers tab are allergy triggers.  

You can add multiple allergy triggers. To search for and select a drug or non-drug allergen to add, click 
the Add button (blue plus sign). 

CPT Satisfiers Tab 
This tab is available for Disease Management, Gestational Age, Health Maintenance, Immunizations, 
Medication by CPT, and Medication by CPT and ICD rule types. Certain rules are “satisfied” (i.e., are 
removed from the Current view on the Reminders tab of the patient’s chart) by adding a CPT code to the 
chart. For example, if the trigger for a rule to run is a diagnosis of diabetes, and the rule is designed to 
generate a reminder that an A1c lab test needs to be ordered, adding the CPT code for that lab test will 
satisfy the rule. Multiple CPT codes can be selected, and adding any of them to the chart will satisfy the 
rule. 

Click the Add button (blue plus sign) to search for and select CPT codes. 

Flowsheet/Vitals Satisfiers Tab 
This tab is available for Disease Management, Gestational Age, Health Maintenance, Medication by CPT, 
and Medication by CPT and ICD rule types, and is activated by clicking the Require Flowsheet/Vitals to 
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satisfy rule check box.  On this tab, you can define a Flowsheet data element as the rule satisfier. When 
that data element is added to the patient’s Flowsheets, the reminder generated by the rule is removed 
from the Current view on the Reminder’s tab of the patient’s chart. 

To select a data element, click the Add button (blue plus sign) to open a window in which you can search 
for and select the data element that will satisfy the rule. 

Result Tab 
This tab is available for Disease Management, Gestational Age, Health Maintenance, Immunizations, Lab 
Result, Medication by CPT, and Medication by CPT and ICD rule types. On the Result tab, you can select 
a specific ICD code and CPT code. If the user clicks the Order button on the Reminders tab of the chart, 
the selected codes will be added to the Cached CPT list linked to the patient’s chart. (Functionality 
described below.) This parameter is optional; you do not have to add these codes if you do not want to 
use the Cached CPT functionality to address reminders generated by the rule. 

To search for and select an ICD code or a CPT code, click the ICD or CPT button, respectively. 

Note: Only one ICD/CPT combination can be defined. (The Clear button removes all selected codes.) 

Cached CPT Functionality 

• When the user selects a reminder and clicks the Order button, the ICD/CPT codes defined on the 
Result tab are added to the Cached CPT list. 

•  The next time the provider opens a note, the system will display a pop-up window indicating that 
CPT codes are pending for the patient. (See example below.) 
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• If the provider clicks Yes, the Outstanding Orders/Cached CPT Codes window will be displayed. 
(See example below.) 

 
• The provider can then drop the order into the note, remove it from the list of outstanding 

orders/cached CPT codes, or click Cancel to leave the CPT in the list for future action. 

Specialty Tab 
This tab is available for all rule types except Lab Tracking. If you link a rule to a specific specialty, that 
specialty is displayed on this tab.  (A rule can be linked to multiple specialties.) When a rule is linked to a 
specialty (or specialties), then only providers and clinical staff that are associated with the linked specialty 
will be able to see (or act on) reminders that are generated by the rule. Other specialties will not see the 
reminders. 

For example, an Immunization rule for children could be linked to Pediatric and Family Practice 
specialties but not Cardiology. In this situation the Cardiologist (or any other specialty besides Pediatric or 
Family Practice) would not see any reminders generated by the immunization rule. 

Instructions for linking rules to specialties are provided in the Making a Rule Specialty Specific section of 
this chapter of the user guide. 

Note:  No rules that ship with the product have been set up as specialty specific. Each practice or clinic 
can choose to make certain rules specialty specific. 

Info Tab 
This tab is available for all rule types. Click the Info tab to see a brief explanation of what the rule type is 
intended to do. 

Source Tab 
This tab is available for all rule types except Lab Tracking and Script Audit. On the Source tab, you can 
add information about the source of the clinical guidelines on which the rule is based. 
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Tabs and Paramaters Specific to Script Audit Rule Type 
Rule Tab 
The Rule tab for the Script Audit rule for overdue reports rule type includes only two parameters: 

• Due Date (Days) – This parameter tells the TaskMan message recipient if the prescription audit 
report has been run within x days. For example, if you type “90” in theDue Date field, the 
TaskMan message will tell the recipient if the prescription audit report has been run within the 
past 90 days. 

• Message To – Select the user who will receive the TaskMan message. Only one user can be 
selected. 

Specialty Tab 
The Specialty tab displays any specialties to which the rule has been linked. 

A rule can be linked to multiple specialties. When a rule is linked to a specialty (or specialties), then only 
providers and clinical staff that are associated with the linked specialty will be able to see (or act on) 
reminders that are generated by the rule. Other specialties will not see the reminders. 

For example, an Immunization rule for children could be linked to Pediatric and Family Practice 
specialties but not Cardiology. In this situation the Cardiologist (or any other specialty besides Pediatric or 
Family Practice) would not see any reminders generated by the immunization rule. 

Instructions for linking rules to specialties are provided in the Making a Rule Specialty Specific section of 
this chapter of the user guide. 

Note:  No rules that ship with the product have been set up as specialty specific. Each practice or clinic 
can choose to make certain rules specialty specific 

Info Tab 
The Info tab displays a brief explanation of what the rule type is intended to do. 

Tabs and Parameters Specific to Lab Tracking Rule Type 
IMPORTANT! The Lab Tracking Rule module CANNOT be used to create new rules.  

Rule Tab 
On the Rule tab, there is a Reset Lab Tracking button.  This button will set all labs to a status of NOT 
being tracked and will also delete any automated Overdue Lab TaskMan messages that were sent notify 
users of overdue labs.  This feature allows users to reset the system to start lab tracking over. It is 
especially useful in cases where Lab Tracking is not turned on immediately after the Chart product is 
installed.  In those cases a large number of Overdue lab messages can accumulate. 

Info Tab 
The Info tab displays a brief explanation of what the rule type is intended to do. 

Creating a Patient-Specific Rule 
Rules that are shipped with e-MDs Chart are not patient specific and will return results for ALL patients 
that meet the criteria set out in the rule.  However, existing rules can be edited or new rules can be 
created to be specific for an individual patient.  Reasons for making rules specific to individual patients 
include situations where patients with certain conditions require monitoring more frequently than patients 
without that condition.  For example a patient that has had colon cancer may require a colonoscopy more 
frequently than patients without that diagnosis. 

WARNING:  When editing existing rules to make them patient specific, ALWAYS COPY the existing 
rule first.  Making a change to an existing rule to make it patient specific will invalidate that rule for all 
other patients because the rule now will only be run for the specified patient. 
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To edit an existing rule to make it specific to an individual patient: 
1. Open the Rule Manager.   

2. Click Start > Programs > e-MDs.  Select the Rule Manager menu item.  Log in using the same 
user name and password used for e-MDs Chart.  

3. With the Rule Manager module open, click any rule to select it and then click the Rule menu item 
and select Copy Rule from the popup menu or click the Copy Rule button on the toolbar. 

4. Click Yes in the confirmation window. 

The Edit Rule window will open with all of the fields filled out with the values from the rule being 
copied.  The Result Description name will be changed to “copy of” in front of the old rule name. 

5. Make changes to the Rule Name and Result Description fields to reflect that this is rule will now 
be a patient specific one. 

6. Make any other necessary changes to the other parameter.  For example, make changes to the 
Frequency field to reflect that this patient requires monitoring more frequently than other patients. 

7. OPTIONAL: In the Run rule on this patient only field, click the Patient button to open the Find 
Patient window. 

8. In the Find Patient window, type all or part of the patient’s last name in the Name field and click 
the Search button. 

9. Highlight the desired patient’s name from the search results and click the Select button. 

The Find Patient window will close and the program will return to the Edit Rule window with the 
selected patient’s name filled out in the OPTIONAL field. 

10. Click the Save button to save any changes. 

To create a new rule for a specific patient: 
1. Open the Rule Manager.   

2. Click Start > Programs > e-MDs.  Select the Rule Manager menu item.  Log in using the same 
user name and password used for e-MDs Chart.  

After the Rule Manager window is open, a list of available Rules will be listed in the left 
windowpane. 

3. Click New Rule on the main Rule Manager toolbar.  

A Select Rule module window will open.  The window will open with all available rule modules 
listed.   

4. Type part of the name of the rule module in the Name field and then click the Search icon (the 
magnifying glass) to find a specific rule module or click Search without typing any criteria into the 
Name field to display all available modules.   

5. Highlight the appropriate rule module and click Select or double click to open the New Rule 
window.   

The New Rule window will open.   

6. Fill out the Rule Name and other fields as appropriate (see "Create a New Rule" for details). 

7. OPTIONAL: In the Run rule on this patient only field, click the Patient button to open the Find 
Patient window. 

8. In the Find Patient window, type all or part of the patient’s last name in the Name field and click 
the Search button. 

9. Highlight the desired patient’s name from the search results and click the Select button. 
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The Find Patient window will close and the program will return to the Edit Rule window with the 
selected patient’s name filled out in the OPTIONAL field. 

10. Click the Save button to save any changes. 

Copying, Editing and Deleting a Rule 
The Rule Manager module includes the capability to copy an existing rule.  This simplifies the process of 
creating new rules from existing rules that have similar functionality.  

To copy a rule: 
1. Open the Rule Manager.   

2. Click Start > Programs > e-MDs.  Select the Rule Manager menu item.  Log in using the same 
user name and password used for e-MDs Chart.  

3. With the Rule Manager module open, click any rule to select it and then click the Rule menu item 
and select Copy Rule from the popup menu, or click Copy Rule button on toolbar. 

4. Click Yes in the confirmation window. 

5. The Edit Rule window will open with all of the fields filled out with the values from the rule being 
copied. 

6. The Result Description name will be changed to “copy of” in front of the old rule name. 

7. Make necessary changes to any of the fields. 

8. Click the Save button to save any changes. 

Note:  Before converting an existing rule to a patient specific rule ALWAYS COPY AND 
RENAME THE EXISTING RULE FIRST.  Otherwise the original rule will no longer be valid for 
ALL patients. 

To edit a rule: 
1. Open the Rule Manager.   

2. Click Start > Programs > e-MDs.  Select the Rule Manager menu item.  Log in using the same 
user name and password used for e-MDs Chart.  

3. With the Rule Manager module open, click any rule to select it and then click the Edit button on 
the main Rule Manager toolbar. 

The Edit Rule window will open. 

4. Make necessary changes to any of the fields. 

5. Click the Save button to save any changes. 

To delete a rule: 
1. Open the Rule Manager.   

2. Go to Start > Programs > e-MDs > Rule Manager.   

3. Log in using the same user name and password used for e-MDs Chart.  

4. With the Rule Manager module open, click any rule to select it and then click the Delete button on 
the main Rule Manager toolbar. 

5. At the confirmation window, click Yes. 
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WARNING:  DO NOT DELETE THE LAB TRACKING RULE.  See the "Lab Tracking Rule" section for 
instructions on turning off Lab Tracking. 

Making a Rule Specialty-Specific 
Rules can be made specialty specific so that only providers (and other clinical staff) that are associated 
with the linked specialty will see the reminders generated by that rule. 

To make a rule specialty-specific: 
1. Create a new rule or edit an existing rule that you want to make specialty specific. 

2. In the Edit Rule maintenance form for that rule, click the Specialty tab. 

If there are specialties already associated with the rule they will be listed in the Linked 
Specialties pane. 

3. To add a specialty, click the Specialty button on the toolbar. 

The Select Specialty window will open. 

4. In the Subset field, pick a subset of specialties.   

Note:  This field groups specialties together to make it easier to add multiple specialties to a 
rule. For example a subset called Primary Care can contain Pediatrics, Family Practice and 
Internal Medicine specialties. 

5. The list of specialties associated with the selected subset will appear in the left pane.  

Note:  If no subsets appear or if you want to add new subsets, see To Create/Edit a Specialty 
Subset. 

6. Select the desired specialty by clicking it. Select multiple specialties by clicking each one while 
holding down the Control key. 

7. After all the specialties are highlighted, click the Add arrow to add them to the Linked Rule 
Specialties pane on the right. 

8. Once all changes are made, click the Exit button to return to the Specialty tab of the Edit Rule 
screen.  

Note:  There is no Save button so changes are saved automatically. 

To create/edit a specialty subset: 
1. In the Edit Rule maintenance form for the selected rule, click the Specialty tab. 

2. Click the Specialty button on the toolbar. 

The Select Specialty window will open. 

3. Click the Subset button on the toolbar. 

The Specialty Subset maintenance window will open. 

4. To create a new subset, click the plus icon (+) and enter a subset name into the next screen. 

The new subset name will show up in the Subset pane at the top-left of the screen. 

5. Highlight the appropriate specialties from the Specialties list at the bottom right and click the Add 
arrow to add them to the Specialty Subset pane at the right. 

6. To edit a subset, highlight the subset in the Subset pane and then add or remove specialties by 
using the Add and Delete arrows. 
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7. After all changes are made, click the Exit button to return to the Select Specialty maintenance 
screen.  

Note:  There is no Save button; changes are saved automatically. 

8. The new (or edited) subset will appear in the Subset drop-down list. 

Setting Up the Rule Schedule 
Rules can be run manually "on demand" through the Rule Manager module or automatically at pre-
specified times by using the Windows Scheduler. 

To run rules manually: 
1. Open the Rule Manager. Click Start > Programs > e-MDs. Select the Rule Manager menu item. 

Log in using the same user name and password used for e-MDs Chart.  

2. With the Rule Manager module open, click any rule to select it and then click the Run button on 
the main Rule Manager toolbar. Or, run all rules simultaneously by clicking the Run All button. 
Depending on the number of patient records, running all of the rules at once can take awhile and 
cause a slow down of the other programs running on the server. Ideally, these reports should not 
be run during business hours. 

Rule Manager has a "silent mode" that allows the program to run automatically through the Microsoft 
Window's Scheduler. This silent mode allows the program to run on at a scheduled interval without user 
intervention. For Rule Manager to run in silent mode, setup information must be input in both Rule 
Manager and in the Windows Scheduler. This setup needs to be done on one computer on the network; 
setting the silent mode on more than one computer can cause the program to fail to run. 

To run rules automatically: 
1. On the computer where the Windows Scheduler will be running, log in to Rule Manager using the 

same user name and password used for e-MDs Chart. 

2. To set up the Windows Scheduler, open the scheduler by going to Start > Programs > 
Accessories > System Tools > Scheduled Tasks.  

3. In the Scheduled Tasks window, click the Add Scheduled Task button. This will open a 
Scheduled Task Wizard.  

4. Click Next in the first window.  

5. In the second window, browse to the folder where Rule Manager is stored and select it (by 
default, the program is stored in Program Files\e-MDs\Solution Series\Apps\). Select the Rule 
Manager file and click Next. 

6. In the next screen, type in a name for the task to be scheduled (The task name can be the same 
as the program name), and select how often the task should be run. It is highly suggested that 
these rules be run daily. Then click Next. 

7. In the next screen, pick the start time and the frequency with which the task should be run (ex. 
Everyday, Weekdays, or Every x days) and the date the task should start running. Keep in mind 
that in clinics with a large patent population, the rules may take as long as 2 to 3 hours to run. 
Because of the amount of "processing time" that the rules demand from the computer, it is best to 
schedule these tasks to be run at night or during other off hours. Since these times are also when 
most businesses run their database backups and because the backups also require a lot of 
processing time, it is necessary to separate the scheduled times of these tasks. For example if a 
typical database backup starts at 10pm and takes about 2 hours, it would be necessary to either 
start the rule task after midnight or sometime well before 10PM, depending on the amount of time 
the rules take to run. 
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8. The next screen prompts for a username and password. The task will run as if it were started by 
that user. This username and password is the same one that would be used to log into the 
Windows network-- not one that is used to log into e-MDs Chart or Rule Manager. 

9. Click Finish at the next screen. 

10. There is one more step to be done before the setup is complete. In the Scheduled Task window 
there will now be an icon representing the task that was just created. Double-click this icon to 
open the Properties window of the scheduled task.  

11. In the Properties window there will be a field labeled Run: with the path to the Rule Manager file 
and another field below it labeled Start in: that also shows the path but without the executable 
listed. The following is an example of what the two fields MIGHT look like (depending on your 
setup): 

Run:     "C:\Program Files\e-MDs\Solution Series\Apps\RuleManager.exe" 
Start in: "C:\Program Files\e-MDs\Solution Series\Apps" 

Important!  For the Rule Manager to run in silent mode, a space, forward slash, and the letter 
"s" ( /s) must be added to the end of the Run: path. This needs to be added OUTSIDE of the 
quotation marks. The following is an example of what the complete path should look like 
(depending on your setup): 

Run: "C:\Program Files\e-MDs\Solution Series\Apps\RuleManager.exe" /s 

12. After the /s is added, the properties window can be closed and the Scheduler will run the rules 
automatically according to the time and frequency that were set up. This properties window can 
also be used to change the time and frequency of the scheduled task at a later date if necessary. 

Addressing Rule-Based Reminders 
Rule-based reminders are displayed on the Reminders tab in the patient’s chart and also in the Tracking 
Board. 

You can address most clinical rule-based reminders in three ways: 

• You can satisfy the rule by ordering the lab or test (CPT code) required by the rule. 

• You can override the reminder (when the lab or test is refused, deferred or waived). 

• You can take no action. 

For detailed information about addressing these reminders, see the Rule-Based Reminders (Automated) 
section in chapter 3 of this user guide. 
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13 
Putting It All Together with 
Patient Case Management 

The patient case management system gives you the ability to link multiple visits 
together to achieve billing, clinical, and other efficiencies.  Cases can be set up to 
include demographics for other responsible parties (guarantors, and insurances).You 
can also link multiple referrals/authorizations to a case and switch them as each 
terminates.  The case can also be set up with various rules including required 
providers, specialties and locations.  You can also link policies with their associated 
requirements to a case so that staff can follow designated protocols to ensure 
appropriate standards of care, take care of paperwork and other requirements, and 
expedite billing.  Appointments, chart notes and invoices for each encounter related to 
a case as well as any DocMan scans/forms are also available from within a single 
interactive window as well as a report.  This ability to access all information without 
having to bounce around to different modules is extremely efficient. 

Continued on the next page ... 
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Understanding Case Management 
Some examples of the use of the case management system include: 

• Cross Billing:  The demographics elements that you can set up for a case will override the 
patient’s defaults when invoices are generated.  This makes it a useful tool for cross billing 
scenarios like workers comp (WC or WMC), motor vehicle accident (MVA), personal injury (PI) 
litigation or other scenarios.  Defaults set up in a case override normal patient defaults.  These 
include: 

○ Injury/Illness Date:  You do not have to look this up for each encounter. 

○ Guarantor and Insurance:  You do not have to switch this each time you generate an 
encounter for the case, and then back again for other encounter types. 

○ Referrals/Authorizations:  Can also be case based and override other patient defaults. 

○ Copay, Patient %:  This overrides the defaults from the insurance. 

○ Financial Group:  Depending on claims filing and reporting requirements, you may need a 
special financial group on an invoice. 

○ Clinical case grouping:  If you want to link visits of a particular type together so you have 
another dimension to track and view the case history.  An example is for clinical research 
patients (drug trials) who may be receiving other medical care at your office.  The multiple 
referral capability of a the case system also lends it to normal treatments where there may be 
multiple authorizations required for each visit (e.g. B12 shots). 

• Ensuring policy requirements are met:  If you have demanding administrative and clinical 
requirements associated with certain visit types, the requirements for the policy are tracked and 
will notify users when they have not been met.  Requirements can be simple prompts, or can be 
forms based where a scan or Word Form must be linked to the requirement and saved in 
DocMan. 

The case management system is accessible from many places in e-MDs Solution Series: 

• Schedule:  The current patient case for the encounter can be seen in the Edit Appointment 
window.  You can also access the full case management system to view details for the patient or 
set up additional cases from this window, the Check In module and the Tools menu.  Any case 
alerts are also presented when scheduling.  These may be in the CPT/HCPCS alert window, or a 
case specific alert. 

• Chart:  All notes that were done for a specific case can be viewed together in the Cases tab 
under Chart View. 

• Bill:  The current case is seen when generating an invoice.  As with appointments, you can 
access all cases from this field and case based alerts may appear when starting or saving the 
invoice.  Cases are also available under the Tools menu. 

• Demographics:  This Misc. tab in the patient’s demographics gives access to the complete case 
management system.  This technically means you can review case information from anywhere 
that you can access a patient. 

• DocMan:  Although there is no direct link to cases in DocMan other than from the patient 
demographics, form or scan case requirements are added to the ABN/Forms Manager work list. 
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Linking Encounter Data and Satisfying Requirements 
The case management system can link all information related to a case together so that you can review it 
all from one screen.  Depending on where and how the data is entered, there are a few ways that it 
accomplishes this: 

• Appointments and Chart Notes: An appointment has a field from which you can select the case 
for the encounter.  When the appointment is saved the case ID is saved with it so this part is 
relatively simple.  A chart progress note is linked to the case via the appointment.  The Note 
Details window that is used to start a note and identify the provider also has a field to link an 
appointment.  This is typically set automatically based on date and other parameters although 
you can change it.  Thus, if you want to align cases to progress notes, you must create 
appointments in Schedule.  Likewise, if you change the case for an appointment, you are also 
doing it for the linked chart note. 

• Invoices: These also have a field that lets you select the case manually.  However, if you build 
invoices from Chart or use the Daily Work List, the system automatically sets the case to one the 
one for the appointment. 

• Documents:  A case can have a number of requirements if you link it to a policy.  When forms, 
scans or other files are linked to requirements that need these, they appear in the patient’s 
DocMan folders in the specified category folders for those requirements.  The case management 
window also gives you direct access to the forms via the requirements.  You can fill out or print 
and scan forms from a case or from the ABN/Forms manager. 

This appointment ID-based linking is important because of any requirements or other rules related to the 
case (including one that may be fee schedule based).  By default, the system sets the case for a new 
appointment to the last active case used for the patient.  When the case has requirements, they might be 
satisfied in Schedule, Chart or Bill, or using the ABN/Forms manager which is also available in DocMan.  
The common link means that users will not get prompted for rules and requirements when the flagged 
item has already been addressed. 

Thus, if a scheduler or check in staff member managed to get a form filled out, the doctors and billers will 
not be prompted to get this information again.  This obviously has significant ramifications for how you set 
up requirements and office work flow to accommodate the collection of information.  In general, it is better 
to gather information in advance of a visit or at check.  If clinicians are trying to get this information it is 
likely to take longer because they might not have access to the necessary forms, etc.  Using physician 
time to take care of administrative tasks is also costly due to relative reimbursement rates.  Likewise 
some requirements may require direct interaction with a patient (filling out a form, answering questions) 
so expecting a biller to do that makes that person’s job much harder too and may delay claims 
processing. 

Thus, having a good understanding of how the system tracks cases through an encounter and designing 
your policies, cases and workflow to optimize productivity and data collection is well worth the effort. 
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Patient Case Window 

 
The Patient Case window is a single screen that gives you the ability to review and manage almost 
everything related to the case from one place. 

Case Information 
Options 

 

# The case number is set automatically by the system to the next case in the 
sequence for a patient, but you can overtype this with your own number.  You can 
not duplicate an existing case number for a patient. 

Description This should tell you something about the case.  For example: “Back Pain”, “Asthma 
Drug Trial.” 

Active? When the box is checked, the case is available on list boxes in appointments and 
invoices.  Once a case is completed, this should be cleared so that it is not picked 
by mistake.  By default, the system automatically links the last active case for the 
patient for new encounters. 

Type The type is an additional identifier which you can set up for reference and to classify 
a case.  Examples are “WMC” or “WC” for workers comp, “MVA” for auto accident, 
“Research”, and so on.  To set up your types, click the Edit Case Types button and 
add them in the editor that opens. 

Injury/Illness Date This is the first date for the case.  This field is very important.  It will save you from 
having to look up the injury date when billing because it sets this date in claims for 
the case. 
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General Information 
Options 

 

Guarantor & Insurance For a new case these fields are defaulted to the patient’s guarantor and insurance.  
If another party is responsible for the visits such as for workers comp or a third party 
auto accident, click Find Guarantor and select that person or organization.  The 
insurances in the case are set to those for the guarantor.  When a case is linked to 
an invoice, the guarantor and insurance override the patient defaults. 

Referral/Authorization You can link multiple referrals to a case.  An example of this is where some 
insurances might authorize multiple encounters or procedures like B12 shots, but 
require a separate referral number to be sent on each claim for each one.  The one 
used by default is the one in the Referral/Authorization.  It overrides any other 
authorizations that the patient might have.  See below for how to switch referrals for 
different encounters. 

Attorney If an attorney is involved in the case, link one here using the Find Person tool.  This 
person is added as the Legal Referral in the claim prep for invoices generated under 
the case. 

Required DOS Provider, 
Specialty, Supervising 
Provider and Medical 
Facility 

If there are specific treating, supervising/billing physician, or location requirements 
on the case, select from the list.  If users attempt to schedule appointments or 
generate claims for different providers, specialties or locations they will be warned 
about these requirements. 

Copay, Patient % These will override the defaults in the primary insurance on any claims generated 
under the case.  This can save you from having to manually modify patient due 
responsibilities if they are not always the same. 

Deductible This is an information only field. 
Financial Group This will set the financial group for invoices under the case.  Thus, it is extremely 

important that this is set correctly since many paper and electronic claims definitions 
are based on the financial group.  It can also be used as a reports segregator. 

Contact Info You can set up one or more contacts on a case.  These are used for both look 
up/reference purposes for your staff as well as by the case report faxing system.  All 
contacts that have a work fax can be faxed with one click.  Examples of case 
contacts are a claims adjuster or nurse manager. 

Primary Case Contact This is the person you will most frequently speak with about the case. 
Other A window where you can add and view a list of other contacts and their description 

can be accessed via this button. 
Case Policy Requirements A case can be linked to a policy which has one or more requirements. 
Requirements The requirements are listed in the middle section of the window.  The list shows the 

requirement itself along with a due date, form or image scan requirements with the 
scan category; whether it is required (mandatory) or not; if it has been completed 
and by whom and when; and also the actual name of the image linked to the 
requirement. 

Due Date Each policy requirement can have a due date.  This is set in the case by adding the 
number of days in the requirement master file to the date that the case is created.  
When the current date/time is after the Due Date, it is displayed in red.  You can 
change the due date details for a specific requirement by selecting it, setting the 
date above the list and clicking Change Due Date. 

Scanning/Forms 
Functions 

If a requirement requires a Word Form or other image scan/file import, you can do 
this from within the case management window using the Load Word Form, Scan and 
View buttons. 

Complete/Incomplete 
Requirements 

When a requirement is satisfied, you can select it and click the Complete button at 
right.  This changes the Completed setting to Yes and also adds the user name and 
date/time.  The Complete button changes to Incomplete if a completed requirement 
is selected so you can reverse the status and clear this information. 

DocMan Access The Open/Scan Documents button opens the patient’s complete document folders 
in DocMan if you have licensed this module. 
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Case Notes The case notes section of the patient case window is where you can view 
appointments, chart notes and invoices that are linked to the case.  These include 
the user who created or last updated the record and the activity date so you can sort 
by user, type, or chronologically.  You can also create manual case notes.  The list 
can be sorted ascending or descending by clicking any of the column headings. 

Appointments The note shows that made the appointment and the resource.  For example: 
“Appointment created for 09:30am on 12/31/2005 for Smith, John resource.”  To 
open the actual Edit Appointment Detail window, click Open Appointment. 

Chart Notes Note shows the doctor.  For example: “Chart note created by Smith, John.”  To open 
the patient chart with this specific note selected in Chart View, click Open Chart. 

Invoices Note shows the invoice number.  For example: “Invoice #1234 created.”  To open 
the invoice, click Open Invoice. 

 

Notes:     
• Manual notes to document other activity on the case are added by clicking the Add Case Note 

button to the right.  The window that appears permits up to 5,000 characters of free text.  The 
window is also spell check and macro enabled. 

• Depending on your screen resolution and personal preferences, you can size the whole Patient 
Case window.  You can also set the requirements and case notes section columns by dragging 
the vertical bars between each column.  After setting your preferences, click the X at the top right 
of the window to save the preference. 

Maintaining Cases 
Cases can be added for a patient from any of the access points described above.  You can also add and 
edit cases on the fly where needed.  Copy functions that speed up the process are also available. 

For specific descriptions of each field, see the "Patient Case Window" section above. 

To add or edit a case: 
1. Go to Tools > Patient Case Management. 

2. Search for and select the patient. 

3. Click New in the Case Search window.  If you are editing a case, select it from the list and click 
Edit. 

4. Fill out the Case Info, Guarantor and Insurance fields. 

5. Add any Referral/Authorization information necessary for the case by clicking the Find 
Authorization button and then adding and selecting a referral from the main authorizations 
window.  Additional authorizations for the case are added using the Ext button and adding them 
to this list. 

6. Add an attorney, if needed (for example, in personal injury cases). 

7. Add case contact information.  The primary contact is added by clicking Find Contact and 
selecting the person from the person search.  The person’s work phone and email are shown on 
screen.   

8. To add additional contacts: 

a. Click the Other button.   

b. In the Contacts Manager window, click New.   
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c. Select Find Person and search.  A description such as “Benefits Adjuster” can be added for 
each contact.  If you think you are going to fax a case report to contacts, make sure they 
have an Office Fax in their files. 

d. Add Required DOS Provider, Specialty, Supervisor or Medical Facility field values, if 
necessary, by selecting from the list boxes.  Users are warned if they schedule or bill for 
invalid entries. 

9. Add Copay and Patient % field values. These override the primary insurance on invoices. 

10. Add a deductible amount if required.  This is for information only. 

11. Set a financial group that will be used on claims. 

12. If you need to link a policy to the case, click Link Policy and select the appropriate one.  Any 
requirements for the policy are listed in the middle of the screen.  The due dates for each are set 
based on their default Days Due property from the current date.  You can change this for a 
specific requirement by selecting it, setting the due date and clicking Change Due Date. 

13. Click Save. 

Copying Cases 
The copy functions are very useful for adding new cases that are very similar to other ones.  You can 
copy a case for the same patient, and from one patient to another.  Examples of the usefulness of 
copying are treating patients for WC injuries where the employer is the same, or multiple patients for the 
same clinical trial. 

The following elements of the case are copied: 

• Description 

• Injury/Illness date 

• Guarantor and insurance 

• Primary referral 

• Lawyer 

• Contacts 

• Required providers and facility 

• Copay, patient %, deductible and financial group 

There are three ways you can copy: 

• To copy to same patient, go to Tools > Patient Case Management, search for patient, select 
case and click Copy. 

• To copy to another patient, go to Tools > Patient Case Management, search for patient who has 
case, click Copy To, search for other patient and select who needs the case. 

• To copy from another patient, go to Tools > Patient Case Management, search for patient who 
needs the case setup, click Copy from, search for and select patient who has the case. 

Reviewing Cases 
There are multiple ways that you can review patient cases.  These range from simply reviewing a list of 
cases for a patient to a complete detail with total access to all case related data.  Bear in mind that you 
can access a patient’s cases from demographics (Misc. tab), the Tools menu in Bill & Schedule, 
appointments, invoices, and also Chart View.  You can also open them from the CPT/HCPCS Alert 
warning window. 
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• Simple list of cases for patient:  This uses the Case Search window for a patient.  Go to Tools 
> Patient Case Management.  You can filter the search by create date range, active or active 
and inactive cases, and description.  The list includes the case #, description, create date, create 
user, active status and number of appointments and invoices on the case.  Of course you can 
open each case in edit mode to see the detail. 

• Case Detail:  As described previously, the Patient Case window provides a complete detail of all 
case setup data as well as links to forms, scans, appointments, chart note and invoices 
generated under the case. 

• Chart View:  The Cases tab in Chart view groups displays progress notes by specific case.  
Each case has a gold “book” in the tree with the case description.  Expanding the tree shows the 
progress notes, diagnoses, orders, etc.  It’s similar to the Visit Notes or Chronology views but you 
do not have to wade your way through any other data in the tree which is not pertinent to the 
case. 

Receiving Case Alerts 
If a patient has a case where certain requirements are not met, or other parameters or not met, users will 
get warnings at different places to let them know.  Keep in mind that if a patient has multiple cases, the 
last one used is retrieved by the system. 

• Referral Warnings:  If the referral on the case has expired an alert appears when scheduling 
and appointment or saving an invoice.  You can change the case from here too.  Per an example 
described previously, it is possible to have multiple referrals on a case which need to be switched 
for each appointment.  Because each referral is set up with a specific date or visit count 
parameter, the warning appears and lets you know that you need to set the correct one.  You can 
do this by opening the case, then click the Ext button for the case Referral field and selecting the 
next one. 

• CPT/HCPCS Alert:  This appears when saving an appointment or invoice for the patient, or when 
an order is made in Chart where the P button (for Plan) gets a red border and/or the specific ICD 
or CPT entered is displayed with a yellow triangular icon.  You can click the icon or the plan menu 
Process Alerts option.  Any case alerts are displayed in the Case Match section.  You can switch 
cases using the View Case button at the bottom of the alert window.  The same window also 
shows and policy requirements.  You can deal with these by opening the case from here. 

• Invoice Case Warning: This may appear when you start a new invoice.  It is a simple prompt 
that lists the problem.  For example it may show that the referral is not set up correctly.  You can 
continue, cancel or view and edit the case information from this prompt. 

Generating Case Reports 
There are two reports that can currently be used to show a case history for a patient: 

• Patient Case Report: This report includes all the details of the case as well as case 
requirements and case notes.  If the case notes include invoices, details such as ICD and CPT 
codes are shown.  The report can be printed and also faxed automatically to all the contacts on a 
case.  See the reports section. 

• Statement:  A statement for a patient can be filtered for a specific case.  This is a good way to 
present billing only data for a case. 
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14 
Doctor’s Office Quality – 
Information Technology 

(DOQ-IT) 
DOQ-IT stands for Doctor's Office Quality Information Technology and it is a project 
that is designed to improve quality of care, patient safety, and efficiency for services 
provided to Medicare beneficiaries by promoting the adoption of Electronic Health 
Record (EHR) systems and information technology (IT) in small-to-medium sized 
primary care physician offices.  This adoption push is part of a vision of enhancing 
access to patient information, decision support, and reference data, as well as 
improving patient-clinician communications. 

The DOQ-IT project offers an integrated approach to improving care for Medicare 
beneficiaries in the areas of diabetes, heart failure, coronary artery disease, 
hypertension, and preventive care and is intended to educate physician offices on 
EHR system solutions and alternatives, as well as to provide implementation and 
quality improvement assistance.  Quality measures developed in this project will be 
reported by participating practices to the Quality Improvement Organization (QIO) 
Clinical Warehouse. The QIO Clinical Warehouse will receive, review and validate 
electronically transmitted information regarding practitioner performance and identify 
opportunities for improvement. 

This is a pilot project that promotes Pay for Performance (P4P) as a result of 
providing quality care to patients with the above specified diseases.  In anticipation of 
widespread adoption of this type of program, e-MDs has developed the DOQ-IT 
module to help users track quality measurements. 

You must register with your local QIO in order to participate in DOQ-IT.  Once you are 
registered you will be given instructions on how to submit the reports generated by e-
MDs DOQ-IT module.  e-MDs is not responsible for the mechanism that is used to 
submit reports. 

For more information you can visit the following web sites: 
www.qualitynet.org 
http://www.lumetra.com/doq-it/index.asp 

Continued on the next page ... 
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Tracking Patients and Quality Measurements 
• Identifies patients meeting quality topic measurement criteria (HF, CAD, DM, HTN, PC,) 

• Generates: 

○ A file for upload to the QIO Clinical Warehouse 

○ Internal pdf reports for topic compliance 

• Tools for follow up include: 

○ An interactive patient recall list 

○ Ability to open a chart to document follow-up interaction 

○ Ability to make appointment 

○ Access to demographics 

○ Access to forms/letters 

• Report Manager DOQ-IT Functionality: The report manager tool is now accessible from the 
Schedule Reports menu and can be used to schedule DOQ-IT reports. 

Configuring DOQ-IT 
To register a facility: 
1. Click the Configure button on the DOQ-IT toolbar. 

2. Click the Change Facility button on the DOQ-IT Facility Registration window. 

3. Search for and select the desired medical facility. 

4. Select the quality measures the facility is registering for (at least one is required to register a 
facility). 

5. In the Enrollment Information section enter a start date and stop date (Start Date defaults to 
today’s date and the End Date defaults to indefinite). 

6. Enter the facility group NPI in the Primary Clinic NPI field. 

7. Click the Search icon (magnifying glass) in the DOQ-IT Admin field. 

8. Search for and select a person to be the DOQ-IT administrator. 

9. If desired, select a default output folder in the Configuration Options section. 

10. Click Save to register the facility. 

To change a facility: 
1. Click the Configure button on the DOQ-IT toolbar. 

2. Click the Change Facility button on the DOQ-IT Facility Registration window. 

3. Search for and select the desired medical facility. 
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Creating a File 
To create a file for a single patient: 
1. Click the Create File button on the DOQ-IT toolbar.  

2. To change Register facilities, you must go to the Configure screen. 

3. In the Date Range section select a begin date and an end date. 

4. Click the Single Patient check box. 

5. Enter the name of an eligible patient (last name, first name format) and press the Enter key. 

6. Select the patient in the Find Patient window. 

7. Select a file location in the File Directory field (if this was not already set on the Configure 
screen). 

8. Enter a file name in the File Name field (i.e. Jan2008).  

9. Click the Go button to generate the DOQ-IT HL7 file. 

10. Go to the file directory location to open the file. 

11. The HL7 File is now ready to be uploaded to the QIO Warehouse via QualityNet. 

To create a file for all eligible patients: 
1. Click the Create File button on the DOQ-IT toolbar.  

2. To change Register facilities, you must go to the Configure screen. 

3. In the Date Range section select a begin date and an end date. 

4. Select a file location in the File Directory field (if this was not already set on the Configure 
screen).  

5. Enter a file name in the File Name field (i.e. Jan2008). 

6. Click the Go button to generate the DOQ-IT HL7 file for all eligible patients in the system. 

7. Go to the file directory location to open the file. 

8. The HL7 File is now ready to be uploaded to the QIO Warehouse via QualityNet. 

Creating a Report 
To create a report for a single patient: 
1. Click the Create Report button on the DOQ-IT toolbar.  

2. To change Register facilities, you must go to the Configure screen. 

3. In the Date Range section select a begin date and an end date. 

4. Click the Single Patient check box. 

5. Enter the name of an eligible patient (last name, first name format) and press the Enter key. 

6. Select the patient in the Find Patient window. 

7. In the Quality Topics section, select the quality topics to be reported (Notice that you only have 
access to those Quality Topics registered on the Configuration screen). 

8. Select the Report Options to appear on the report.  

9. Select a file location in the File Directory field (if this was not already set on the Configure 
screen). 
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10. Enter a file name in the File Name field. 

11. Click the “Show file after creation” check box. 

12. Click the Go button to generate the DOQ-IT report. 

13. The report automatically displays on the screen. 

To create a report for all eligible patients: 
1. Click the Create Report button on the DOQ-IT toolbar.  

2. To change Register facilities, you must go to the Configure screen. 

3. In the Date Range section select a begin date and an end date. 

4. In the Quality Topics section, select the quality topics to be reported (Notice that you only have 
access to those Quality Topics registered on the Configuration screen). 

5. Select the Report Options to appear on the report.  

6. Select a file location in the File Directory field (if this was not already set on the Configure 
screen). 

7. Enter a file name in the File Name field. 

8. Select the “Show file after creation” check box. 

9. Click the Go button to generate the DOQ-IT report. 

10. The report automatically displays on the screen.  

Using the Patient Browser 
To specify a registered facility: 
• This is the registered facility set in the Configure screen of e-MDs DOQ-IT. 

• To change facilities go to the Configure screen. 

Searching for a Single Patient 
To search for a single patient: 
1. To load demographic and DOQ-IT data for a single patient, click the check box next to the Single 

Patient field. 

2. Click the Search button in the Single Patient field. 

3. Search for the patient in the Find Chart Patient field. 

4. Highlight the desired patient and click the Select icon on the toolbar. 

5. The patient’s demographic data and exclusion/inclusion status appear near the center of the 
screen. 

6. To see the patient’s DOQ-IT eligibility and compliance information click the Refresh button on the 
toolbar.  

Note:  This only includes data added to the database prior to midnight of the current date.  
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To set exclusions:  
1. To load demographic and DOQ-IT data for a single patient, click the check box next to the Single 

Patient field. 

2. Click the Search icon in the Single Patient field. 

3. Search for the patient in the Find Chart Patient field. 

4. Highlight the desired patient and click the Select icon on the toolbar. 

5. Click the Excluded check box in the patient demographics section. 

6. Choose an exclusion reason or type one into the provided field and click OK. 

7. This patient’s data will now be excluded from the DOQ-IT program. 

 

Searching for Multiple Patients 

To filter by name: 
1. Click the Filter Patient Name check box. 

2. Enter the last name of patients to be searched for. 

3. Set the DOQ-IT Inclusion/Exclusion Status. 

4. Set the Eligibility/Compliance Status. 

5. In the Topic Measures section, select either “Any” or “All.” If the option, “Any” is selected, then the 
system will return patients who have any matches to the topic measures selected. If “All” is 
chosen then the patient’s data has to match every selected topic measure. 

6. Select desired topic measures to search by. 

7. Click the Retrieve icon on the toolbar. 

To filter all patients: 
1. Set the DOQ-IT Inclusion/Exclusion Status. 

2. Set the Eligibility/Compliance Status. 

3. In the Topic Measures section select either “Any” or “All.” If the option, “Any” is selected, then the 
system will return patients who have any matches to the topic measures selected. If “All” is 
chosen then the patient’s data has to match every selected topic measure. 

4. Select desired topic measures to search by. 

5. Click the Retrieve icon on the toolbar. 
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Toolbar Functions 
Click the Single Patient check box. Search for and select a patient.  The toolbar functions are listed 
below. 

Toolbar Items  
Edit The patient’s demographic file appears and allows for edits to the information. 
Chart Opens the patient’s chart. 
Schedule Opens schedule so that an appointment can be scheduled. 
Forms Loads the Select Form/Letter window so that the user can print patient specific word 

forms. 
Legend Legend that shows what the icons used in the Status/Measures section correspond 

to on the Patient Browser. 
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Appendix A  
Clinical Reference Libraries 

Searching for Codes 
Locations of the ICD-9 Search 
The ICD-9 Search can be found in several locations: 

In References:  
Click Reference on the main e-MDs Chart toolbar, and select the ICD Search menu option. 

In the Current Problems section of a patient’s Health Summary:  
Click New to launch the search. 

In the HPI and Assessment sections of a Visit or Order Note:  
Click New to launch the search in either area. 

Searching for an ICD-9 Code 
Find an ICD-9 Code by searching the ICD Outline or by entering keywords into the Full Search or a user-
defined Short Search. 

To search by outline: 
1. Click the Outline button on the ICD-9 Search toolbar to display the entire ICD-9 database in 

outline form. The first level of the outline lists general categories (for example, Infectious and 
Parasitic Diseases, ICD code range 001-139). 

2. Click the plus sign next to any category to further expand the tree, displaying the subcategories 
(for example, Intestinal Infectious Diseases, ICD code range 001-009).  

3. Continue clicking the plus signs to drill down to individual codes. 

4. At the level of an individual ICD code, click the plus sign to expand the tree and reveal two 
additional nodes, labeled Alternate Descriptions and Search Keywords. Alternate Descriptions 
lists synonyms for the selected diagnosis. Search Keywords shows words that are linked to this 
diagnosis, which, when typed into the search field, will return this ICD code in the search results. 

To search by keyword: 
1. Determine whether to search the full database (by clicking the Full toolbar button) or only the pre-

defined list of favorite codes (by clicking Short). 

Note:  If a Short List search is initiated and no matches are found, the search automatically 
converts to a full database search. 

2. Determine whether the search will look for items that Begin With the letters typed into the search 
field, that Contain those letters, or that are an Exact Match.  

OR 
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Choose to search by actual ICD number. Mark your preference by clicking one of the four buttons 
in the second horizontal toolbar, located after the words Search By. 

3. Type your search criteria into the Keywords field.  

Search Hints: 

○ The search utilizes the words in the official description of each code in addition to the linked 
keywords.  

○ Do not include non-descriptive words (i.e. "the") and conjunctions (i.e. "and") in the search.  

○ Many abbreviations have been added to the keyword list (i.e. "ARF" for Acute Renal Failure).  

○ Full words are not necessary; typing the first few letters of a word is adequate and lessens the 
chances of spelling errors.  

○ The search is case-insensitive, meaning there is no need to capitalize any word. If more than 
one word is entered, separate each with a space. For example, to search for "diabetes with 
renal complications", enter the search criteria "diab ren comp."  

○ When listing more than one word (or group of letters), the order of the words does not matter. 
For example, in the search just described, "ren comp diab" would return the same search 
results as "diab ren comp."  

○ In multiple-word searches, the default search mode returns only those results that contain all 
of the words.  

○ To search for entries that match any (rather than all) of the keywords, change the Search 
Criteria (in the second horizontal toolbar) from And to Or.  

4. To perform the search, press Enter or click Search. Previous search criteria are saved in the 
keyword drop-down list and can be cleared by clicking Clear Dropdown. 

Using the "Parent" Button 
Highlight any item in an ICD-9 search result and click Parent to display the code that immediately 
precedes the selected code in the tree hierarchy. This is useful when a search returns an unspecified 
code (represented by a yellow icon), as this function will then display more specific, related codes that are 
more appropriate for billing purposes. For example, a search for "colon cancer" returns the four-digit, 
unspecified code 153.9: Malignant Neoplasm of the Colon" (among other items). Highlight this result and 
click Parent to display the three-digit parent ICD code, 153. Then click the plus sign next to this parent 
code to expand the tree and reveal all of the four-digit children codes, including the more specific, billable 
choices. 

Eliminating Nonspecific and Unspecified Codes from Searches 
Non-specified codes, represented by green icons, are used when the ICD database does not contain a 
specific code for the diagnosis in question. These codes are acceptable to most third-party payers, but 
medical documentation should accompany the claim. Unspecified codes, identified by yellow icons, 
should be avoided at all costs as many insurance companies automatically deny payment when the 
documentation is not more specific.  

When ICD searches are performed, the results are returned along with the colored icons. To avoid 
reimbursement delays, avoid the use of codes with green or yellow icons whenever possible. To further 
ensure that these problematic codes are not used, click the green and yellow Exclude button on the 
toolbar. Then select either or both of the menu options, Other Specified Codes and Unspecified Codes. 
When selected, check marks will appear next to these options, and codes with those color icons will be 
excluded from the search results.  
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Searching Current or Previous Year's ICD Codes 
Each ICD code is identified by the date that it was added to the database. Searches automatically default 
to searching the database for current codes. To view codes that were valid in a previous year, click the 
button labeled View, and then select the Previous Codes option. A check mark will appear next to the 
option once it has been selected. This is a valuable tool when resubmitting claims from a previous year, 
and for use during the first quarter of the year, when some carriers recognize new codes while other 
payers have not yet converted from the old ones. 

Identifying Billing Status by Color Coded Icons 
Whether searching by Outline or by Keyword, individual ICD codes are displayed with color-coded icons. 
To review the meaning of these colors, click the toolbar button labeled Legend.  

Button Legend  
White The white icon signifies billable codes. 
Red Red identifies non-billable, three or four-digit codes that must be further specified by 

a fourth or fifth digit, respectively. Payers uniformly reject these codes. Click the plus 
sign next to any red code to expand the tree and display the more specific four and 
five-digit code choices. 

Green Non-specified codes, represented by green icons, are used when the ICD database 
does not contain a specific code for the diagnosis in question. For example, expand 
the three-digit ICD code 250: Diabetes. Specific four-digit codes identify various 
diabetic complications (for example, 250.1: Diabetes with Ketoacidosis). However, 
some fairly specific diagnoses (for example, Cardiovascular Complications of 
Diabetes) do not have a corresponding code. In this case, the most appropriate 
code is the non-specified code 250.8: Diabetes with Other Specified Manifestation. 
These codes are acceptable to most third-party payers, but medical documentation 
should accompany the claim. 

Yellow Unspecified codes, identified by yellow icons, should be avoided at all costs 
because many insurance companies automatically deny payment of CPT codes 
linked to these unspecified diagnoses. Typically, more specific codes exist in the 
same code family and should be used instead. For example, avoid the yellow code 
461.0: Acute Sinusitis, Unspecified. Instead, choose a more specific, billable 
diagnosis, such as 461.0: Acute Maxillary Sinusitis. 

Blue Blue icons represent manifestation codes, which identify conditions caused by 
another disease. The causative disease must be coded along with the manifestation 
code. For example, the manifestation code 366.41: Diabetic Cataract must be 
accompanied by a code from the 250: Diabetes code family. 

Viewing the Billing Details of an ICD-9 Code 
Click the Details toolbar button to review detailed billing notes for each ICD code. Click the button a 
second time to close the Details window, if desired. The individual fields in the Details window are 
explained below. 

Billing Details Options  
Display Description In e-MDs Chart, this description appears in the Assessment section of a Visit or 

Order Note and in the Current Problem list. This field is non-editable for e-MDs-
entered codes. This is a calculated description whose appearance depends on 
which of the display-building buttons (labeled Self, Parent, and Parent, Self) is 
selected. If Self is chosen, the display description will be the same as the official 
description that is entered in the ICD outline tree (see ICD code 001 for an 
example). If Parent is selected, that particular item will display the description of its 
parent code, which is the code immediately preceding in the tree hierarchy (see ICD 
code 001.9 for an example.) If Parent, Self is chosen, the description will be that of 
the parent code, followed by a comma, and then the official description (see ICD 
code 001.0 for an example.) 
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Billing Description In e-MDs Bill, this description appears in the billing invoice. 
Detail Description Official, full-text, detailed description of the individual code. This field is unalterable 

for e-MDs-entered codes. For user-entered codes, free-text descriptions up to 255 
characters in length may be typed. 

Billing Status The colored-coded billing status of each ICD code is set in this window (see the 
Legend for an explanation of the colors.) These selections are unalterable for e-
MDs-entered codes, but the window is active for user-entered codes. 

Code Valid This field indicates the date range in which each code is active. For example, if a 
new code is adopted on January 1st, 2001, that date will appear in the "From" field. 
When codes are discontinued, the discontinuation date (typically December 31st) will 
appear in the "Through" field. 
Note:  You may notice that the "Through" date field is running date- i.e. always 
shows the current date. If a code has been discontinued, the "Through" check box 
will be checked, and the actual discontinuation date displayed.) These dates cannot 
be edited for e-MDs-entered codes, but the field is active for user-entered codes. 

Billing Rules This window, accessed by clicking the Billing Rules tab, displays helpful billing rules 
and tips. Many codes have official billing rules entered by e-MDs, although this 
section is editable by the user. 

Includes This window, opened by clicking the Includes tab, lists related diseases that are 
encompassed by the selected ICD code. Many codes have Includes text entered by 
e-MDs, although this section is editable by the user. 

Excludes This window, opened by clicking the Excludes tab, lists diseases that are similar to 
the selected code, but which have their own ICD codes. These diseases should not 
be billed with the selected code. In most cases, the appropriate ICD code follows the 
disease description in parentheses. Many codes have Excludes text entered by e-
MDs, although this section is editable by the user. 

Notes This is a free-text memo field with a 255-character length. Billing memos of any type 
related to the selected ICD code may be entered. 

Adding an ICD-9 Code to Your "Short List" 
Get quicker results and greater precision by searching only your pre-defined list of favorite codes, rather 
than the full database. (Perform this type of search by clicking Short on the toolbar.)  

• To add an individual ICD code to your favorites list, simply click the check box located to the left 
of that code description in the tree.  

• To remove an ICD code from your favorites list, clear the same box.  

Adding an Alternate Description to an ICD-9 Code 
Many ICD codes already have alternate descriptions listed. Click the plus sign next to an individual ICD 
code to expand the tree and reveal a node labeled Alternate Descriptions. Click the plus sign next to this 
node to view all synonyms currently linked to this ICD code. You may want to add more synonyms, such 
as commonly used descriptions in your individual practice, to assist the billing staff in correct coding. 

To add a synonym: 
1. Highlight and right-click Alternate Descriptions.  

2. Select Add an Alternate Description.  

3. In the pop-up window that appears, enter the description.  

4. Press either the Enter or Tab key to save the synonym.  

Note:  Remember to add keywords from your new description to the Search Keyword list, so 
that a search for your alternate description returns the correct ICD code. (See the "Add and 
Delete Search Keywords" section.) 
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To edit an Alternate Description: 
1. Right click to select the alternate description. 

2. Select Edit Description.  

3. Make your changes as desired in the pop-up window that appears.  

4. Press either the Enter or Tab key to save the updated description. 

To delete an Alternate Description: 
1. Right click to select the alternate description. 

2. Select Delete Description. 

Adding a Search Keyword to an ICD-9 Code 
Although keywords have already been linked to each ICD code, additional words may be added, if 
needed, to improve search results. Click the plus sign next to any ICD code to expand the tree and reveal 
a node labeled Search Keywords. Click the plus sign next to this node to display all words currently linked 
to this code. 

To add a search keyword: 
1. Highlight and right-click Search Keywords.  

2. Select Add Linked Keywords.  

3. In the pop-up window that appears, enter your keywords. To add more than one word, separate 
words with a space.  

4. Press either the Enter or Tab key to save the search keyword(s). 

When linking the same set of keywords to multiple codes, simplify the task by creating a Keyword Copy 
List.  

To create a keyword copy list: 
1. Right-click any keyword and go to Keyword Copylist Operations > Add Selected Keyword(s) to 

List.  

2. Add multiple keywords to the list by holding down the Control key and then clicking any two 
keywords, which will highlight the entire group of keywords residing in the tree between the two 
selected words.  

OR 

Hold down the Shift key and click multiple, noncontiguous keywords.  

3. Once a group of keywords is highlighted, right-click and select the Keyword Copylist 
Operations > Add Selected Keyword(s) to List.  

4. Insert this copy list elsewhere by right-clicking the Search Keywords node of another document.  

5. Select the Keyword Copylist Operations > Insert Copylist > Insert All Items menu options. 

When a new ICD code is added to the database, its description will automatically be parsed into the 
keyword list. However, if that description is edited at any point, the new words will not automatically be 
added. At that point, simplify the task of adding the new keywords by right-clicking the description and 
selecting the menu option labeled Parse Title into Keyword List. 

To remove an individual keyword: 
1. Right-click the keyword.  

2. Select Remove Keyword Link. 



 

e-MDs Solution Series Chart User Guide 8.0 R01 390 

Adding New ICD Categories 
The ICD table is divided into categories and subcategories, each representing a range of related 
diagnosis codes. The category ranges created by e-MDs cannot be altered, but new categories can be 
added. The main ICD outline contains 19 pre-defined parent-level categories. Any new category that is 
added must fall within one of these parent ranges.  

To add new ICD categories: 
1. Select and right-click an existing code range.  

2. Select Add Category.  

3. In the pop-up Category Entry window that appears, enter the ICD code range in the From and To 
fields and enter a description for that category range.  

4. Press either the Enter or Tab key to save the new categories.  

Editing and Deleting ICD Categories 
ICD categories created by e-MDs cannot be edited.  

To edit either the numerical range or the description of a category created by the 
user: 
1. Select and right-click the category.  

2. Select Edit Category. This will open the Category Entry window.  

3. Make the desired changes and press either the Enter or Tab key to save your changes.. 

ICD categories created by e-MDs cannot be deleted.  

To delete a category created by the user: 
1. Select and right-click the category.  

2. Select Delete Category. 

Adding New ICD Codes 
The ICD database is divided into categories, each representing a range of related ICD codes. Each 
individual ICD falls within one of these categories. For example, the ICD code 008 falls within the pre-
defined 001-009 range.  

To add new ICD codes: 
1. Find the appropriate category (or subcategory) range for the new ICD code.  

Note:  If the ICD does not fit within a pre-defined category range, first create a new category. 

2. Select and right-click the category.  

3. Select Add ICD.  

4. In the pop-up Add ICD window that appears, enter the ICD code and its description (limited to 
100 characters).  

5. Press either the Enter or Tab key to save the new codes 
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Editing and Deleting ICD Codes 
ICD codes created by e-MDs cannot be edited (although Alternate Descriptions and Keywords can be 
added to those codes).  

To edit a code created by the user: 
1. Select and right-click the code.  

2. Select Edit ICD.  

3. Make the desired changes in the pop-up window that appears.  

4. Press either the Enter or Tab key to save your changes. 

ICD codes created by e-MDs cannot be deleted.  

To delete a code created by the user: 
1. Select and right-click the code.  

2. Select Delete ICD. 

Entering the Billing Details of a New ICD Code 
Enter the billing details of the new code in the Billing Details window. If this window is not visible, click 
Details on the toolbar. The various data fields in the Details window are described below. 

Billing Details Options  
Display Description In e-MDs Chart, a separate application, this description appears in the Assessment 

section of a Visit or Order Note, as well as in the Current Problem list. This is a 
calculated description whose appearance depends upon which of the display-
building buttons (labeled Self, Parent, and Parent, Self) is selected.  

• If Self is selected, the display description will be the same as the official 
description entered in the ICD outline tree (see ICD code 001 for an 
example).  

• If Parent is selected, that particular item will display the description of its 
parent code, which is the code immediately preceding in the tree hierarchy 
(see ICD code 001.9 for an example).  

• If Parent, Self is chosen, the description will be that of the parent code, 
followed by a comma, and then by the official description (see ICD code 
001.0 for an example.) Again, the Display Description is irrelevant in the 
independent e-MDs Search module. 

Billing Description In e-MDs Bill, this description appears in the billing invoice. 
Detail Description Official, full-text, detailed description of the individual code. Free-text descriptions up 

to 255 characters in length may be typed. 
Billing Status Set the colored-coded billing status of the ICD code in this window (See the Legend 

for an explanation of the colors.) 
Code Valid Enter the date that this code became valid in the From field. If any code is later 

discontinued, enter the discontinuation date in the Through field. 
Note:  You may notice that the "Through" date field is running date - i.e. always 
shows the current date. If a code has been discontinued, the "Through" check box 
will be checked, and the actual discontinuation date displayed. 
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Billing Rules Enter helpful billing rules and tips in this window. There is no character limit to this 
field. If a four or five-digit code is added whose billing rules are the same as those of 
the parent code (i.e. the corresponding three or four-digit code immediately 
preceding this code in the tree hierarchy), these may be easily copied. Highlight the 
new ICD code and right-click. Select the Inherit > Billing Rules menu options. 
Another option is to highlight the parent ICD code, right-click, and select the 
Cascade > Billing Rules menu options. Be careful, though, as this will cascade the 
parent information to all children codes, not just to the newly entered code. 

Includes In this window, list related diseases that are encompassed by the selected ICD 
code. There is no character limit to this field. If a four or five-digit code is added 
whose Includes text is the same as those of the parent code (i.e. the corresponding 
three or four-digit code immediately preceding this code in the tree hierarchy), this 
may be easily copied. Highlight the new ICD code and right click. Go to the Inherit > 
Includes menu options. Another option is to highlight the parent ICD code, right-
click and select Cascade, and then Includes options. Be careful, though, as this will 
cascade the parent information to all children codes, not just to the newly entered 
code. 

Excludes In this window, list diseases that are similar to the selected code, but which have 
their own ICD codes. It is helpful to include the appropriate ICD code in 
parentheses. There is no character limit to this field. If a four or five-digit code is 
added whose Excludes text is the same as those of the parent code (i.e. the 
corresponding three or four-digit code immediately preceding this code in the tree 
hierarchy), this may be easily copied. Highlight the new ICD code and right click. 
Select the Inherit > Excludes menu options. Another option is to highlight the 
parent ICD code, right click, and select the Cascade > Excludes menu options. Be 
careful, though, as this will cascade the parent information to all children codes, not 
just to the newly entered code. 

Notes This is a free-text memo field with a 255-character length. Billing memos of any type 
related to the selected ICD code may be entered. 

Searching for CPT Codes 
The CPT Search functionality can be found in several locations: 

In References:  
Click Reference on the main e-MDs Chart toolbar, and select the CPT Search menu option. 

In the Plan section of a Visit or Order Note, linked to a diagnosis:  
1. Under a diagnosis header in Plan, click Orders to see a list of CPT codes linked to that 

diagnosis.  

2. Click Add CPT to launch the full CPT Search.  

3. Note that any CPT codes selected from this Search will automatically be linked to the selected 
diagnosis. 

In the Plan section of a Visit or Order Note, unlinked to any diagnoses: 
1. To launch the CPT Search without linking a CPT to an ICD code, click the Other Orders section 

of Plan. 

2. Click New (CPT Search). 

Find a CPT Code by searching the CPT Outline or by entering keywords into the Full Search or a user-
defined Short Search. 
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To search by outline: 
1. Click the Outline button on the toolbar to display the entire CPT database in outline form. The 

first level of the outline lists general categories (for example, Anesthesia: CPT code range 00100-
01999).  

2. Click the plus sign (+) next to any category to further expand the tree, displaying the 
subcategories (for example, Head: CPT code range 00100-00222).  

3. Continue clicking the plus signs to drill down to individual codes. 

4. At the level of an individual CPT code, click the plus sign to expand the tree and reveal two 
additional nodes, labeled Alternate Descriptions and Search Keywords. Alternate Descriptions 
lists synonyms for the selected code. Search Keywords lists words that are linked to this code, 
which, when typed into the search field, will return this CPT code in the search results. 

To search by keyword: 
1. Decide whether to search the full database (by clicking the Full toolbar button) or only your pre-

defined list of favorite codes (by clicking Short).  

Note:  If a Short List search is initiated and no matches are found, the search automatically 
converts to a full database search. 

2. Define whether the search will look for items that Begin With the letters typed into the search 
field, that Contain those letters, or that are an Exact Match. You can also choose to search by 
actual ICD number.  

Mark your preference by clicking one of the four buttons in the second horizontal toolbar, located 
after the words Search By. 

3. Type your search criteria into the Keywords field.  

Search Hints: 

○ The search utilizes the words in the official description of each code in addition to the linked 
keywords.  

○ Do not include non-descriptive words (i.e. "the") and conjunctions (i.e. "and") in the search.  

○ Many abbreviations have been added to the keyword list (i.e. "MRI" for "Magnetic Resonance 
Imaging").  

○ Full words are not necessary; typing the first few letters of a word is adequate and lessens the 
chances of spelling errors.  

○ The search is case-insensitive, meaning there is no need to capitalize any word.  

○ If more than one word is entered, separate each with a space. For example, to search for 
"magnetic resonance imaging of the knee", enter the search criteria "mri knee."  

○ When listing more than one word (or group of letters), the order of the words does not matter. 
For example, in the search just described, "knee mri" would return the same search result as 
"mri knee."  

○ In multiple-word searches, the default search mode returns only those results that contain all 
of the words. To search for entries that match any (rather than all) of the keywords, change 
the Search Criteria (in the second horizontal toolbar) from And to Or.  

4. To perform the search, press Enter or click Search. Previous search criteria are saved in the 
keyword drop-down list and can be cleared by clicking Clear Dropdown. 
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Searching Current or Previous Year's CPT Codes 
Each CPT code is identified by the date that it was added to the database. Searches automatically default 
to searching the database for current codes.  

To view codes that were valid in a previous year, click the button labeled View, and then select the 
Previous Codes option. A black check mark will appear next to this menu item once it has been 
selected. This is a valuable tool when resubmitting claims from a previous year, and for use during the 
first quarter of the year, when some carriers recognize new codes while other payers have not yet 
converted from the old ones. 

Viewing the Billing Details of a CPT Code 
Click the Details toolbar button to review detailed billing notes for each CPT code. Click the button a 
second time to close the Details window, if desired. The individual fields in the Details window are 
explained below. 

Billing Details Options  
Kind of Service Allows the CPT table to be subdivided by Labs, Tests, and Procedures. Has some 

bearing on which modifiers are attached to individual CPT codes. 
In House Identify individual CPT tests that are typically performed in-house (and, therefore, 

billed) by checking the In House box. 
Type of Service Type of Service is required when billing a CPT code. A default Type of Service has 

been chosen for each CPT, though users may click the small down arrow to reveal 
other choices and change this. 

Place of Service Place of Service is required when billing a CPT code. A default Place of Service has 
been chosen for ach CPT, though users may click the small down arrow to reveal 
other choices and change this. 

Billing Description  In e-MDs Bill, this description appears in the billing invoice. 
Detail Description Official, full-text, detailed description of the individual code. This field is unalterable 

for e-MDs-entered codes. For user-entered codes, free-text descriptions up to 255 
characters in length may be typed. 

Code Valid This field indicates the date range in which each code is active. For example, if a 
new code is adopted on January 1st, 2001, that date will appear in the "From" field. 
When codes are discontinued, the discontinuation date (typically December 31st) will 
appear in the "Through" field. These dates cannot be edited for e-MDs-entered 
codes, but the field is active for user-entered codes. 
Note:  You may notice that the "Through" date field is running date - i.e. always 
shows the current date. If a code has been discontinued, the "Through" check box 
will be checked, and the actual discontinuation date displayed.  

Lab Tracking This section has 2 fields. One field designates whether or not the item is tracked 
through the Lab Tracking module.  The other field is used to indicate the number of 
days that the Lab Tracking module uses to determine whether an item is considered 
overdue. 

Private/Cost/ABU If desired, the private fee schedule, internal cost, and anesthesia billing unit for each 
CPT procedure may be entered into the appropriate fields. 

Relative Value Unit If desired, the determining factors for the Relative Value Unit (RVU) assigned to 
each CPT may be entered into the appropriate fields. The fields represent the total 
RVU, the Work portion, Practice Expense, and Malpractice Cost. 

Categorical Modifiers Modifiers that apply to the entire category in which a particular CPT falls can be 
listed in this field. Some modifiers have already been assigned, but the user can add 
additional modifiers. 

Notes This is a free-text memo field with a 255-character length. Billing memos of any type 
related to the selected CPT code may be entered. 
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You can get quicker results and greater precision by searching only your pre-defined list of favorite codes, 
rather than the full database. (Perform this type of search by clicking Short on the toolbar.)  

To add a CPT code to your "Short List": 
• To add an individual CPT code to your favorites list, simply click the check box located to the left 

of that code description in the tree.  

• To remove a CPT code from your favorites list, clear the same box.  

Many CPT codes already have alternate descriptions listed.  

To add an alternate description for a CPT code: 
• Click the plus sign next to an individual CPT code to expand the tree and reveal a node labeled 

Alternate Descriptions.  

• Click the plus sign next to this node to view all synonyms currently linked to this CPT code.  

You may want to add more synonyms, such as commonly used descriptions in your individual practice, to 
assist the billing staff in correct coding. 

To add a synonym: 
1. Highlight and right-click Alternate Descriptions.  

2. Select Add an Alternate Description.  

3. In the pop-up window that appears, enter the description.  

4. Press either the Enter or Tab key to save the new synonym.  

Note:  Remember to add keywords from your new description to the Search Keyword list, so that a 
search for your alternate description returns the correct CPT code. (See the “Add and Delete Search 
Keywords” section.) 

To edit an alternate description: 
1. Select and right-click the alternate description.  

2. Select Edit Description.  

3. Make changes as desired in the pop-up window that appears.  

4. Press either the Enter or Tab key to save your changes. 

To delete an alternate description:  
1. Select and right-click the description. 

2. Select Delete Description. 

Adding a Search Keyword to a CPT Code 
Although keywords have already been linked to each CPT code, additional words may be added, if 
needed, to improve search results.  

• Click the plus sign (+) next to any CPT code to expand the tree and reveal a node labeled Search 
Keywords.  

• Click the plus sign (+) next to this node to display all words currently linked to this code. 

To add a keyword: 
1. Highlight and right-click Search Keywords.  

2. Select Add Linked Keywords.  



 

e-MDs Solution Series Chart User Guide 8.0 R01 396 

3. In the pop-up window that appears, enter the keywords. If more than one word is added, separate 
words with a space.  

4. Press either the Enter or Tab key to save the new keyword(s). 

When linking the same set of keywords to multiple codes, simplify the task by creating a Keyword 
Copy List.  

To create a Keyword Copy List: 
1. Right-click any keyword and go to Keyword Copylist Operations > Add Selected Keyword(s) 

to List.  

2. Add multiple keywords to the list by holding down the Control key and then clicking any two 
keywords, which will highlight the entire group of keywords residing in the tree between the two 
selected words.  

OR 

Hold down the Shift key and click multiple, noncontiguous keywords.  

3. After a group of keywords is highlighted, right-click and go to Keyword Copylist Operations > 
Add Selected Keyword(s) to List.  

4. Insert this copy list elsewhere by right-clicking the Search Keywords node of another document.  

5. Go to Keyword Copylist Operations > Insert Copylist > Insert All Items. 

When a new CPT is added to the database, its description will automatically be parsed into the keyword 
list. However, if that description is edited at any point, the new words will not automatically be added. At 
that point, simplify the task of adding the new keywords by right clicking the description and selecting the 
menu option labeled Parse Title into Keyword List. 

To remove an individual keyword: 
1. Select and right-click the keyword.  

2. Select Remove Keyword Link. 

Adding and Deleting CPT Codes 
Adding New CPT Categories 
The CPT table is divided into categories and subcategories, each representing a range of related 
procedure codes. The category ranges created by e-MDs cannot be altered, but new categories may be 
added. The main CPT outline contains six pre-defined parent-level categories. Any new category that is 
added must fall within one of these parent ranges.  

To add new CPT categories: 
1. Select and right-click an existing code range.  

2. Select Add Sub Category.  

3. In the pop-up Category Entry window that appears, enter the CPT code range in the From and 
To fields and enter a description for that category range.  

4. Press either the Enter or Tab key to save the new category.  
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Editing and Deleting CPT Categories 
CPT categories created by e-MDs cannot be edited or deleted, but user-created categories can be. 

To edit either the numerical range or the description of a category created by the 
user: 
1. Select and right-click the category.  

2. Select Edit Category. This will open the Category Entry window.  

3. Make the desired changes and press either the Enter or Tab key to save your changes. 

To delete a category created by the user: 
1. Select and right-click the category.  

2. Select Delete Category. 

Adding New CPT Codes  
The CPT database is divided into categories, each representing a range of related CPT codes. Each 
individual CPT falls within one of these categories. For example, the CPT code 00100 falls within the pre-
defined 00100-00222 range.  

To add new CPT codes: 
1. Find the appropriate category (or subcategory) range for the new CPT code.  

Note:  If the CPT does not fit within a pre-defined category range, first create a new category. 
See the “Add a New ICD Category” section. 

2. Select and right-click the category.  

3. Select Add CPT. 

4. In the pop-up Add CPT window, enter the CPT code and its description (limited to 100 
characters).  

5. Press either the Enter or Tab key to save the new code. 

Editing and Deleting CPT Codes 
CPT codes created by e-MDs cannot be edited (although Alternate Descriptions and Keywords can be 
added to those codes), but user-created codes can be edited.  

To edit a code created by the user: 
1. Select and right-click the code.  

2. Select Edit a CPT.  

3. Make desired changes in the pop-up window that appears.  

4. Press either the Enter or Tab key to save the updated code. 

CPT codes created by e-MDs cannot be deleted, but user-created codes can be deleted.  

To delete a code created by the user: 
1. Select and right-click the code.  

2. Select Delete CPT. 
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Entering the Billing Details of a New CPT Code 
Enter the billing details of the new CPT code in the Billing Details window. If this window is not visible, 
click Details on the toolbar. The various data fields in the Details window are described below. 

Billing Details Options  
Kind of Service Allows the CPT table to be subdivided by Labs, Tests, and Procedures. Has some 

bearing on which modifiers are attached to individual CPT codes. 
In House Identify individual CPT tests that are typically performed in-house (and, therefore, 

billed) by checking the In House box. 
Type of Service Type of Service is required when billing a CPT code. A default Type of Service has 

been chosen for each CPT, though users may click the small down arrow to reveal 
other choices and change this. 

Place of Service Place of Service is required when billing a CPT code. A default Place of Service has 
been chosen for ach CPT, though users may click the small down arrow to reveal 
other choices and change this. 

Billing Description In e-MDs Bill, this description appears in the billing invoice. 
Detail Description Official, full-text, detailed description of the individual code. Free-text descriptions up 

to 255 characters in length may be typed. 
Code Valid Enter the date that this code became valid in the From field. If any code is later 

discontinued, enter the discontinuation date in the Through field. 
Note:  The current date will always show in the Through field until a code has 
been discontinued. 

Private/Cost/ABU If desired, the private fee schedule, internal cost, and anesthesia billing unit for the 
CPT procedure may be entered into the appropriate fields. 

Relative Value Unit If desired, the determining factors for the Relative Value Unit (RVU) assigned to the 
CPT may be entered into the appropriate fields. The fields represent the total RVU, 
the Work portion, Practice Expense, and Malpractice Cost. 

Categorical Modifiers Modifiers that apply to the entire category in which a particular CPT falls can be 
listed in this field. Right click within the Categorical Modifiers field and select the 
Insert Modifier menu option. This will open a window listing all possible modifiers. 
Click the desired modifier; this will close the window and add that modifier to the 
CPT. Remember, this modifier will be added to every CPT code within that category. 
To remove a modifier, select it, right click, and choose the Remove Modifier menu 
option. This will remove that modifier from every CPT code within that category. 
Note:  This is a free-text memo field with a 255-character length. Billing memos of 
any type related to the selected CPT code may be entered. 

Searching for HCPCS Codes 
The HCPCS Search can be found in several locations: 

In References:  
Click Reference on the main e-MDs Chart toolbar, and select the HCPCS Search menu option. 

In the Plan section of a Visit or Order Note, linked to an order (i.e. linked to a CPT 
code):  
1. Click any particular order in Plan, and then select the HCPCS menu option. This will open a 

window displaying all HCPCS codes linked to that particular CPT code.  

2. Click Add HCPCS to launch the HCPCS Search.  

Note:  Any HCPCS codes selected in this Search will automatically be linked to that CPT code. 
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Find a HCPCS Code by searching the HCPCS Outline or by entering keywords into the Full Search or a 
user-defined Short Search. 

To search by outline: 
1. Click the Outline button on the toolbar to display the entire HCPCS database in outline form. The 

first level of the outline lists general categories (for example, Medical and Surgical Supplies: 
HCPCS code range A4000-A8999).  

2. Click the plus sign next to any category to further expand the tree, displaying the subcategories 
(for example, Miscellaneous Supplies: HCPCS code range A4206-A4290).  

3. Continue clicking the plus signs to drill down to individual codes. 

4. At the level of an individual HCPCS code, click the plus sign to expand the tree and reveal two 
additional nodes, labeled Alternate Descriptions and Search Keywords. Alternate Descriptions 
list synonyms for the selected code.  

5. Search Keywords lists words that are linked to this code, which, when typed into the search field, 
will return this HCPCS code in the search results.  

To search by keyword: 
1. Choose whether to search the full database (by clicking the Full toolbar button) or only your pre-

defined list of favorite codes (by clicking Short).  

Note:  If a Short List search is initiated and no matches are found, the search automatically 
converts to a full database search. 

2. Determine if the search will look for items that Begin With the letters typed into the search field, 
that Contain those letters, or that are an Exact Match.  

You may also choose to search by actual ICD number. Mark your preference by clicking one of 
the four buttons in the second horizontal toolbar, located after the words Search By. 

3. Type your search criteria in the Keywords field.  

Search Hints: 

○ The search utilizes the words in the official description of each code in addition to the linked 
keywords.  

○ Do not include non-descriptive words (i.e. "the") and conjunctions (i.e. "and") in the search.  

○ Many abbreviations have been added to the keyword list (i.e. "MDI" for "Metered Dose 
Inhaler").  

○ Full words are not necessary; typing the first few letters of a word is adequate and lessens the 
chances of spelling errors.  

○ The search is case-insensitive, meaning there is no need to capitalize any word.  

○ If more than one word is entered, separate each with a space. For example, to search for 
"spacer for metered dose inhaler", enter the search criteria "spacer mdi."  

○ When listing more than one word (or group of letters), the order of the words does not matter. 
For example, in the search just described, "mdi spacer" would return the same search result 
as "spacer mdi."  

○ In multiple-word searches, the default search mode returns only those results that contain all 
of the words.  

○ To search for entries that match any (rather than all) of the keywords, change the Search 
Criteria (in the second horizontal toolbar) from And to Or.  
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4. To perform the search, press Enter or click Search. Previous search criteria are saved in the 
keyword drop-down list and can be cleared by clicking Clear Dropdown. 

Searching Current or Previous Year's HCPCS Codes 
Each HCPCS code is identified by the date that it was added to the database. Searches automatically 
default to searching the database for current codes. To view codes that were valid in a previous year, 
click the button labeled View, and then select the Previous Codes option. A check mark will be displayed 
next to this option once it is selected. This is a valuable tool when resubmitting claims from a previous 
year, and for use during the first quarter of the year, when some carriers recognize new codes while other 
payers have not yet  

Viewing the Billing Details of a HCPCS Code 
Click the Details toolbar button to review detailed billing notes for each HCPCS code. Click the button a 
second time to close the Details window, if desired. The individual fields in the Details window are 
explained below. 

Billing Details Options  
Type of Service This option is required when billing a HCPCS code. A default Type of Service has 

been chosen for each HCPCS, though the user can click the small down arrow to 
reveal other choices and change this. 

Place of Service This option is required when billing a HCPCS code. A default Place of Service has 
been chosen for each HCPCS, though the user can click the small down arrow to 
reveal other choices and change this. 

Billing Description In e-MDs Bill, this description appears in the billing invoice. 
Detail Description Official, full-text, detailed description of the individual code. This field is unalterable 

for e-MDs-entered codes. For user-entered codes, free-text descriptions up to 255 
characters in length may be typed. 

Code Valid This field indicates the date range in which each code is active. For example, if a 
new code is adopted on January 1st, 2001, that date will appear in the "From" field. 
When codes are discontinued, the discontinuation date (typically December 31st) 
will appear in the "Through" field.  These dates cannot be edited for e-MDs-entered 
codes, but the field is active for user-entered codes. 
Note:  You may notice that the "Through" date field is running date (that is, it 
always shows the current date). If a code has been discontinued, the "Through" 
check box will be checked, and the actual discontinuation date displayed.  

Private/Cost If desired, the private fee schedule and internal cost of each HCPCS procedure may 
be entered into the appropriate fields. 

Relative Value Unit When applicable, the determining factors for the Relative Value Unit (RVU) assigned 
to a HCPCS code may be entered into the appropriate fields. The fields represent 
the total RVU, the Work portion, Practice Expense, and Malpractice Cost. 

Categorical Modifiers Modifiers that apply to the entire category in which a particular HCPCS code falls 
can be listed in this field. Some modifiers have already been assigned, but the user 
can add additional modifiers (see the "Enter the Billing Details of a New HCPCS 
Code" section). 
Note:  This is a free-text memo field with a 255-character length. Billing memos of 
any type related to the selected HCPCS code may be entered. 

Adding a HCPCS Code to Your "Short List" 
Get quicker results and greater precision by searching only your pre-defined list of favorite codes, rather 
than the full database. (Perform this type of search by clicking Short on the toolbar.) To add an individual 
HCPCS code to your favorites list, simply click the check box located to the left of the code description in 
the tree. To remove a HCPCS code from your favorites list, clear the same box.  
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Adding an Alternate Description to a HCPCS Code 
Many HCPCS codes already have alternate descriptions listed. Click the plus sign next to an individual 
HCPCS code to expand the tree and reveal a node labeled Alternate Descriptions. Click the plus sign 
next to this node to view all synonyms currently linked to this HCPCS code. You may want to add more 
synonyms, such as commonly used descriptions in your individual practice, to assist the billing staff in 
correct coding. 

To add a synonym: 
1. Highlight and right-click Alternate Descriptions.  

2. Select Add an Alternate Description.  

3. In the pop-up window that appears, enter the description.  

4. Press either the Enter or Tab key to save the new synonym.  

Note:  Remember to add keywords from your new description to the Search Keyword list, so 
that a search for your alternate description returns the correct HCPCS code. (See the “Add and 
Delete Search Keywords” section.) 

To edit an Alternate Description: 
1. Select and right-click the alternate description. 

2. Select Edit Description.  

3. Make changes as desired in the pop-up window that appears.  

4. Press either the Enter or Tab key to save your changes. 

To delete and Alternate Description: 
1. Select and right-click the alternate description. 

2. Select Delete Description. 

Adding a Search Keyword to a HCPCS Code 
Although keywords have already been linked to each HCPCS code, additional words may be added, if 
needed, to improve search results. Click the plus sign next to any HCPCS code to expand the tree and 
reveal a node labeled Search Keywords. Click the plus sign next to this node to display all words currently 
linked to this code. 

To add a keyword: 
1. Highlight and right-click Search Keywords. 

2. Select Add Linked Keywords.  

3. In the pop-up window that appears, enter the keyword(s). If more than one word is added, 
separate words with a space.  

4. Press either the Enter or Tab key to save the keyword. 

When linking the same set of keywords to multiple codes, simplify the task by creating a Keyword Copy 
List.  

To create a Keyword Copy List: 
1. Right-click any keyword and choose the Keyword Copylist Operations > Add Selected 

Keyword(s) to List.  
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2. Add multiple keywords to the list by holding down the Control key and then clicking any two 
keywords, which will highlight the entire group of keywords residing in the tree between the two 
selected words.  

OR 

Hold down the Shift key and click multiple, noncontiguous keywords.  

3. After a group of keywords is highlighted, right-click and select Keyword Copylist Operations > 
Add Selected Keyword(s) to List.  

4. Insert this copy list elsewhere by right-clicking the Search Keywords node of another document.  

5. Select the Keyword Copylist Operations > Insert Copylist > Insert All Items menu options. 

When a new HCPCS code is added to the database, its description will automatically be parsed into the 
keyword list. However, if that description is edited at any point, the new words will not automatically be 
added. At that point, simplify the task of adding the new keywords by right-clicking the description and 
selecting the menu option labeled Parse Title into Keyword List. 

To remove an individual keyword:  
1. Select and right-click the keyword.  

2. Select Remove Keyword Link. 

Adding, Editing and Deleting HCPCS Codes 
Adding New HCPCS Categories 
The HCPCS table is divided into categories and subcategories, each representing a range of related 
procedure or supply codes. The category ranges created by e-MDs cannot be altered, but new categories 
may be added. The main HCPCS outline contains 21 pre-defined parent-level categories. Any new 
category that is added must fall within one of these parent ranges.  

To add new HCPCS categories: 
1. Select and right-click an existing code range. 

2. Select Add Sub Category.  

3. In the pop-up Category Entry window, enter the HCPCS code range in the From and To fields 
and enter a description for that category range.  

4. Press either the Enter or Tab key to save the new category.  

Editing and Deleting HCPCS Categories 
HCPCS categories created by e-MDs cannot be edited or deleted but user-created categories can be. 

To edit the numerical range or the description of a category created by the user: 
1. Select and right-click the category.  

2. Select Edit Category. This will open the Category Entry window.  

3. Make desired changes and press either the Enter or Tab key to save your changes. 

To delete a category created by the user: 
1. Select and right-click the category. 

2. Select Delete Category. 
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Adding New HCPCS Codes  
The HCPCS table is divided into categories, each representing a range of related HCPCS codes. Each 
individual HCPCS falls within one of these categories. For example, the HCPCS code A0021 falls within 
the pre-defined A0000-A0999 range.  

To add new HCPCS codes: 
1. Find the appropriate category (or subcategory) range for the new CPT code.  

2. If your HCPCS does not fit within a pre-defined category range, first create a new category.  See 
the “Add a New HCPCS Category” section. 

3. Select and right-click the category.  

4. Select Add HCPCS.  

5. In the pop-up Add HCPCS window that appears, enter the HCPCS code and its description 
(limited to 100 characters).  

6. Press either the Enter or Tab key to save the new code.  

Editing and Deleting HCPCS Codes 
HCPCS codes created by e-MDs cannot be edited (although Alternate Descriptions and Keywords can be 
added to those codes) or deleted, but user-created codes can be. 

To edit a code created by the user: 
1. Select and right-click the code.  

2. Select Edit a HCPCS.  

3. Make the desired changes in the pop-up window that appears.  

4. Press either the Enter or Tab key to save the updated code. 

To delete a code created by the user: 
1. Select and right-click the code.  

2. Select Delete HCPCS. 

Entering the Billing Details of a New HCPCS Code 
Enter the billing details of the new code in the Billing Details window. If this window is not visible, click 
Details on the toolbar. The various data fields in the Details window are described below. 

Billing Details Options  
Type of Service This option is required when billing a HCPCS code. A default Type of Service has 

been chosen for each HCPCS, though the user can click the small down arrow to 
reveal other choices and change this. 

Place of Service This option is required when billing a HCPCS code. A default Place of Service has 
been chosen for each HCPCS, though the user can click the small down arrow to 
reveal other choices and change this. 

Billing Description In e-MDs Bill, this description appears in the billing invoice. 
Detail Description Official, full-text, detailed description of the individual code. This field is unalterable 

for e-MDs-entered codes. For user-entered codes, free-text descriptions up to 255 
characters in length may be typed. 
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Code Valid This field indicates the date range in which each code is active. For example, if a 
new code is adopted on January 1st, 2001, that date will appear in the "From" field. 
When codes are discontinued, the discontinuation date (typically December 31st) 
will appear in the "Through" field.  These dates cannot be edited for e-MDs-entered 
codes, but the field is active for user-entered codes. 
Note:  You may notice that the "Through" date field is running date (that is, it 
always shows the current date). If a code has been discontinued, the "Through" 
check box will be checked, and the actual discontinuation date displayed.  

Lab Tracking This section has 2 fields. One field designates whether or not the item is tracked 
through the Lab Tracking module.  The other field is used to indicate the number of 
days that the Lab Tracking module uses to determine whether an item is considered 
overdue. 

Private/Cost If desired, the private fee schedule and internal cost of each HCPCS procedure may 
be entered into the appropriate fields. 

Relative Value Unit When applicable, the determining factors for the Relative Value Unit (RVU) assigned 
to a HCPCS code may be entered into the appropriate fields. The fields represent 
the total RVU, the Work portion, Practice Expense, and Malpractice Cost. 

Categorical Modifiers Modifiers that apply to the entire category in which a particular HCPCS falls can be 
listed in this field. Right click within the Categorical Modifiers field and select the 
Insert Modifier menu option. This will open a window listing all possible modifiers. 
Click the desired modifier; this will close the window and add that modifier to the 
HCPCS. Remember, this modifier will be added to every HCPCS code within that 
category. To remove a modifier, select it, right click, and choose the Remove 
Modifier menu option. This will remove that modifier from every HCPCS code within 
that category.  
Note:  This is a free-text memo field with a 255-character length. Billing memos of 
any type related to the selected HCPCS code may be entered. 

Locating Medical Art 
Medical Art can be found in several locations: 

In References:  
1. Click Reference on the main e-MDs Chart toolbar. 

2. Select Medical Art. 

On the Visit Note Navigation bar:  
(buttons that run vertically down the left side of an OPEN note):  
1. Click the Art button to open the Medical Art Quick Selector.   

2. In the Medical Art Quick Selector window, click the Search button on the toolbar . 

In the HPI, Exam, Procedure, and Plan sections of a Visit or Order Note:  
1. In any of these sections, click any free text icon (the gray circles that turn into yellow squares 

when hovered over).  

2. Click the Other Options button located at the bottom of the Free Text window. 

3. Select Medical Art. 
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Searching for Medical Art 
Find a Medical Art document by searching the document Outline or by entering keywords into the Full 
Search or a user-defined Short Search. 

To search by outline: 
1. Click the Outline button on the toolbar to display the entire Medical Art database in outline form. 

Documents are arranged alphabetically.  

2. Click the plus sign next to any document title to expand the tree and reveal a node labeled 
Search Keywords.  

3. Search Keywords lists words that are linked to this document, which, when typed into the Search 
field, will return this document in the search results.  

To search by keyword: 
1. Determine whether to search the full database (by clicking the Full toolbar button) or only your 

pre-defined list of favorite documents (by clicking Short).  

Note:  If a Short List search is initiated and no matches are found, the search automatically 
converts to a full database search. 

2. Determine whether the search will look for items that Begin With the letters typed into the search 
field, that Contain those letters, or that are an Exact Match. Mark your preference by clicking one 
of the three buttons in the second horizontal toolbar, located after the words Search By. 

3. Type your search criteria into the Keywords field.  

Search Hints: 

○ The search utilizes the words in the official title of each document in addition to the linked 
keywords.  

○ Do not include non-descriptive words (i.e. "the") and conjunctions (i.e. "and") in the search.  

○ Full words are not necessary; typing the first few letters of a word is adequate and lessens the 
chances of spelling errors.  

○ The search is case-insensitive, meaning there is no need to capitalize any word.  

○ If more than one word is entered, separate each with a space.  

○ When listing more than one word (or group of letters), the order of the words does not matter.  

○ In multiple-word searches, the default search mode returns only those results that contain all 
of the words.  

○ To search for entries that match any (rather than all) of the keywords, change the Search 
Criteria (in the second horizontal toolbar) from And to Or.  

7. To perform the search, press Enter or click Search. Previous search criteria are saved in the 
keyword drop-down list and can be cleared by clicking Clear Dropdown. 

To view documents: 
1. Find the desired document by performing an Outline or Keyword Search.  

2. Right-click the title of the document.  

3. Select Display Selected Medical Art.  
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Adding Medical Art to Your "Short List" 
Get quicker results and greater precision by searching only your pre-defined list of favorite Medical Art 
images, rather than the full database. (Perform this type of search by clicking Short on the toolbar.)  

• To add an individual document to your favorites list, click the check box located to the left of the 
document title in the tree.  

• To remove a document from your favorites list, clear the same box. 

Editing Medical Art 
e-MDs provides Medical Art images as part of the clinical content.  These images cannot be altered, 
although copies can be made and those can be edited.  

To copy and edit an image: 
1. Right-click the title of the original image.  

2. Select Copy Selected Medical Art.  

3. When a pop-up window prompts for a description; enter an image title and press Enter.  This 
copies the Medical Art, applies the new title, and enters the copied image into the Medical Art 
Outline. 

Note:  The title cannot be identical to the description of the original artwork. 

4. Right-click the description of the copied image and select the Display Selected Medical Art.  

5. Edit the art by drawing or adding text, and click Save (the button with the floppy disk icon.) 

Adding a Search Keyword to Medical Art 
Although some keywords have already been linked to each Medical Art image, additional words may be 
added, if needed, to improve search results. Click the plus sign next to an image title to expand the tree 
and reveal a node labeled Search Keywords. Click the plus sign next to this node to display all words 
currently linked to this image. 

To add a keyword: 
1. Highlight and right-click Search Keywords.  

2. Select Add Linked Keywords.  

3. In the pop-up window that appears, enter your keywords. If more than one word is added, 
separate words with a space.  

4. Press either the Enter or Tab key to save your keywords. 

When linking the same set of keywords to multiple images, simplify the task by creating a Keyword Copy 
List.  

To create a Keyword Copy List: 
1. Right-click any keyword and select Keyword Copylist Operations > Add Selected Keyword(s) to 

List.  

2. Add multiple keywords to the list by holding down the Control key and then clicking any two 
keywords, which will highlight the entire group of keywords residing in the tree between the two 
selected words. 

OR 

Hold down the Shift key and click multiple, noncontiguous keywords.  
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3. Once a group of keywords is highlighted, right-click and select Keyword Copylist Operations > 
Add Selected Keyword(s) to List.  

4. Insert this copy list elsewhere by right-clicking the Search Keywords node of another image.  

5. Select Keyword Copylist Operations > Insert Copylist > Insert All Items. 

When a new Medical Art image is added to the database, its title will automatically be parsed into the 
keyword list. However, if that title is edited at any point, the new words will not automatically be added. At 
that point, simplify the task of adding the new keywords by right-clicking the title and selecting the menu 
option labeled Parse Title into Keyword List. 

To remove an individual keyword: 
1. Select and right-click the keyword.  

2. Select Remove Keyword Link. 

Adding New Medical Art 
Adding New Medical Art Categories 
The Medical Art database is divided into categories and subcategories, each representing a group of 
related images. The main outline contains categories labeled by organ system. Subcategories divide the 
images into three types: Exam, Medical Reference, and Patient Ed.  

To add new medical art categories: 
1. Select and right-click an existing category or subcategory (or the main Medical Art Outline node 

at the top of the outline).  

2. Select and right-click Add Category.  

3. In the pop-up Category Entry window that appears, enter a description for the category.  

4. Press either the Enter or Tab key to save the new category.  

Adding New Medical Art Images 
Images stored in an electronic format can be imported into the Medical Art database.  

To add new medical art images: 
1. Find the appropriate category (or subcategory) for the new image.  

2. Right-click the category and select Add Medical Art.  

3. When the Medical Art Loader window opens, browse files on your computer (or network).  

4. Select the desired file and click Open.  The Medical Art Description window opens, with a default 
description automatically entered (based on the title of the file).  

5. Type the image description, if desired.  

6. When the description is correct, press either the Enter or Tab key to save the new image. 

Locating Patient Education Documentation 
Patient Education documents can be found in several locations: 

In References:  
1. Click Reference on the main e-MDs Chart toolbar. 

2. Select the Patient Education menu option. 
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In the Plan section of a Visit or Order Note, linked to a diagnosis:  
1. Under a diagnosis header in Plan, click Patient Education Handouts. 

2. Select Patient Education to see a list of documents linked to that diagnosis.  

3. Click Add Patient Ed to launch the full Patient Education Search.   

Note that any Patient Education document selected from this search will automatically be linked 
to the selected diagnosis. 

In the Plan section of a Visit or Order Note, unlinked to any diagnoses:  
1. To launch the Patient Education Search without linking a document to an ICD code, click the 

Other Patient Education Handouts section of Plan. 

2. Click Patient Education. 

Accessing Krames Patient Education Documents 
In addition to the e-MDs created Patient Education documents, you can also access Krames patient 
education documents. e-MDs provides access to Krames as part of the Solution Series offering. Krames 
is an industry leader in providing evidence-based, peer-reviewed patient education content that supports 
health literacy, increases compliance and motivates behavior change. 

To access Krames from a Visit or Order Note: 
1. In the Plan section of a Visit or Order Note, under a diagnosis header in Plan, click the header 

labeled Patient Education Handouts. 

2. Select Patient Education from the pop-up menu. 

3. In the Linked Patient Education window, click the button at the top right labeled Krames. 

4. A Web page will open displaying a list of patient education documents that match the diagnoses 
(ICD codes) and or procedures (CPT codes) that are in the note. 

Note:  In addition to the linked documents, a search tab is available to allow searching on 
keywords and a browse tab is available to search by alphabetical listing. 

5. Type a search keyword in the Search field (for example. Diabetes) and press Enter to see a list 
of available patient education documents related to the keyword. 

In the Browse tab, a list from A to Z is displayed.   

6. Click a letter to see documents whose keyword start with the letter. 

To access Krames from outside a patient chart: 
1. On the main Chart menu, click References, then select Krames Patient Education. 

2. A Web page will open to a search tab to allow searching on keywords and a Browse tab is 
available to search by alphabetical listing. 

3. Type a search keyword in the Search field (for example, Diabetes) and press Enter to see a list 
of available patient education documents related to the keyword. 



 

e-MDs Solution Series Chart User Guide 8.0 R01 409 

Searching for a Patient Education Document 
Find a Patient Education document by searching the document Outline or by entering keywords into the 
Full Search or a user-defined Short Search. 

To search by outline: 
1. Click the Outline button on the toolbar to display the entire Patient Education database in outline 

form. Documents are arranged alphabetically.  

2. Click the plus sign next to any document title to expand the tree and reveal two nodes labeled 
Translations and Search Keywords.  

3. Click Translations to view the document’s Spanish equivalent. Search Keywords lists words that 
are linked to this document, which, when typed into the search field, will return this document in 
the search results.  

To search by keyword: 
1. Determine whether to search the full database (by clicking the Full toolbar button) or only your 

pre-defined list of favorite documents (by clicking Short).  

Note:  If a Short List search is initiated and no matches are found, the search automatically 
converts to a full database search. 

2. Determine whether the search will look for items that Begin With the letters typed into the search 
field, that Contain those letters, or that are an Exact Match. Mark your preference by clicking one 
of the three buttons in the second horizontal toolbar, located after the words Search By. 

3. Type your search criteria in the Keywords field.  

Search Hints: 

○ The search utilizes the words in the official title of each document in addition to the linked 
keywords.  

○ Do not include non-descriptive words (i.e. "the") and conjunctions (i.e. "and") in the search.  

○ Full words are not necessary; typing the first few letters of a word is adequate and lessens the 
chances of spelling errors.  

○ The search is case-insensitive, meaning there is no need to capitalize any word.  

○ If more than one word is entered, separate each with a space. For example, to search for 
"acute bronchitis", enter the search criteria "acu bronc."  

○ When listing more than one word (or group of letters), the order of the words does not matter. 
For example, in the search just described, "acu bronc" would return the same search result as 
"bronc acu." In multiple-word searches, the default search mode returns only those results that 
contain all of the words.  

○ To search for entries that match any (rather than all) of the keywords, change the Search 
Criteria (in the second horizontal toolbar) from And to Or.  

4. To perform the search, press Enter or click Search. Previous search criteria are saved in the 
keyword drop-down list and can be cleared by clicking Clear Dropdown. 
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Viewing Documents 
Find the desired document by performing an Outline or Keyword Search.  

To view documents: 
1. Highlight the title of the document and then click View on the toolbar.  

OR 

Right-click the title and select View Document.  

Note:  Although the View window allows editing and printing of documents, edits are not saved.  

2. Close the View window by clicking either the X in the upper right corner or the Exit button (with 
the open door icon). 

Finding Spanish Translations of Documents 
Most documents in the Patient Education module include a Spanish translation. Spanish handouts are 
linked to their English counterparts. The keyword search, however, does not include any Spanish terms.  

To find Spanish translations of documents: 
1. Find the desired document in English (see the “Search for a Patient Education Document” 

section).  

2. Click the plus sign next to the English-titled document to expand the tree and reveal the 
Translations node.  

3. Click the plus sign next to the Translations node to display the Spanish document title.  

The content of the Spanish documents is essentially identical to their English equivalents. If 
desired, Spanish keywords can be linked to any document if you plan to perform document 
searches in Spanish (see the “Add Keywords” section).  

Adding a Patient Education Document to Your "Short List" 
Get quicker results and greater precision by searching only your predefined list of favorite documents, 
rather than the full database. (Perform this type of search by clicking Short on the toolbar.)  

• To add an individual document to your favorites list, simply click the check box located to the left 
of the document title in the tree.  

• To remove a document from your favorites list, clear the same box. 

Note:  Because Spanish educational handouts are linked to their corresponding English documents in 
the tree, individual Spanish documents cannot be added to the short list. Instead, add the English 
document to the favorites list, which will, in effect, also add the associated Spanish translation. 

Editing a Patient Education Document 
To make minor changes to an e-MDs’ source document, the easiest solution is to edit a source document 
rather than to add a custom document (which involves creation of a new document from scratch).  

Note:  Source documents are not actually alterable. Instead, an editable copy of a document is 
spawned. The original source document will remain in the database, along with the edited copy. The 
edited version appears as a new document in the tree, flagged with a yellow book icon, distinguishing it 
from e-MDs’ source documents, which are noted by blue books. 

The new title of the edited document will automatically be parsed into the keyword list. To add additional 
search keywords, see the “Add a Search Keyword” section. The edited version of the source document is 
now considered to be a Custom Document. 
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To edit a source document: 
1. Highlight the source document and either click Copy on the toolbar, or right-click and select 

Create Copy of Document. The copied document will automatically be titled the same as the 
original followed by the addition of ".1".  

2. If desired, change the title in the pop-up window and press either the Tab or Enter key. The new 
title cannot be exactly the same as that of the source document.  

Note:  "Title" refers to the document’s database title, as it appears in the outline. The "title" or 
header that appears on the printed Patient Education handout is unaffected by changing the 
database title. 

Selecting a title opens a word processor window containing the original document. Typical word 
processor functionality, such as various fonts, styles, colors, formatting, and highlighting is 
available.  

3. Make changes as desired. When finished, save the document by clicking the Save button (with 
the floppy disk icon) or by clicking File > Save and Exit. 

OR 

To delete the new document before it has been entered into the database, click the Delete button 
(with the red X) within the word processor window.  

Adding a Search Keyword to a Patient Education Document 
Although some keywords have already been linked to each document, additional words may be added, if 
needed, to improve search results. Click the plus sign next to a document title to expand the tree and 
reveal a node labeled Search Keywords. Click the plus sign next to this node to display all words currently 
linked to this document. 

To add a keyword: 
1. Highlight and right-click Search Keywords.  

2. Select Add Linked Keywords.  

3. In the pop-up window that appears, enter your keywords. If more than one word is added, 
separate words with a space.  

4. Press either the Enter or Tab key to save the new keywords. 

When linking the same set of keywords to multiple documents, simplify the task by creating a Keyword 
Copy List.  

To create a Keyword Copy List: 
1. Right-click any keyword and select Keyword Copylist Operations > Add Selected Keyword(s) 

to List.  

2. Add multiple keywords to the list by holding down the Control key and then clicking any two 
keywords, which will highlight the entire group of keywords residing in the tree between the two 
selected words.  

OR 

Hold down the Shift key and click multiple, noncontiguous keywords.  

3. After a group of keywords is highlighted, right-click and select Keyword Copylist Operations > 
Add Selected Keyword(s) to List.  

4. Insert this copy list elsewhere by right-clicking the Search Keywords node of another document.  

5. Select the Keyword Copylist Operations > Insert Copylist > Insert All Items menu options. 
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When a new document is added to the database, its title will automatically be parsed into the keyword list. 
However, if that title is edited at any point, the new words will not automatically be added. At that point, 
simplify the task of adding the new keywords by right-clicking the title and selecting the menu option 
labeled Parse Title into Keyword List. 

To remove an individual keyword: 
1. Select and right-click the keyword.  

2. Select Remove Keyword Link. 

Adding, Editing and Deleting Custom Patient Education Documents 

To add a custom document: 
1. Add a custom Patient Education document by clicking the Add button on the toolbar.  

(Documents cannot be added from the Search screen. If the Add button is disabled, first click 
Outline.) 

OR 

Right-click any document title in the outline and select Add Document.  

2. Enter the new document’s title in the pop-up window that appears (limited to 100 characters), and 
press either the Tab or Enter key.  

Note:  The title cannot match that of any existing titles in the database.  

Selecting a title will open the word processor window. Typical word processor functionality, such 
as various fonts, styles, colors, formatting, and highlighting is available. 

3. Create the document by typing into the word processor, pasting text from another source, or 
loading an electronic document from another location (that is, click File > Load, browse for the 
desired text (.txt) or rich text (.rtf) document, and click Open).  

4. When finished, save the document by clicking the Save button (with the floppy disk icon) or by 
clicking File > Save and Exit. 

Custom documents will appear in the tree with a yellow book icon, distinguishing them from e-MDs’ 
source documents, which are noted by blue books. The title of the document will automatically be parsed 
into the keyword list. To add additional search keywords, see the “Add and Delete Search Keywords” 
section. 

To edit the title of a custom document: 
Right-click the custom document title and select Edit Title. Titles have a 100-character limit in length.  

Note:  This changes only the database title of the document, and does not affect the title that 
appears on the printed Patient Education handout. 

Titles of e-MDs’ source documents, which are identified by blue book icons, cannot be edited.  

To edit the content of a custom document: 
1. Highlight the document title and either click Edit on the toolbar, or right-click and select Edit 

Document.  

2. Make your changes in the word processor window.  

3. Save the document by clicking the Save button (with the floppy disk icon) or by clicking File > 
Save and Exit. 

To delete a custom document: 
Highlight the document title and either click Delete on the toolbar. 
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OR 

Right-click and select Delete Document. e-MDs’ source documents, which are identified by blue 
book icons, cannot be deleted.  

Note:  Any edits made in the View window will not be saved. Use the word processor via the steps 
outlined above, rather than the View window, for editing. 

Locating Curbside Consults Documentation 
Curbside Consults can be found in several locations: 

In References:  
1. Click Reference on the main e-MDs Chart toolbar. 

2. Select the Curbside Consults menu option. 

In the HPI, Assessment, and Plan sections of a Visit or Order Note:  
1. Click the bold black diagnosis description in any of these sections and select the Curbside 

Consults menu option. This will display a window listing Curbside documents linked to that 
diagnosis.  

2. Click Add Consult to launch the full Curbside Consult Search.  Note that any Consult document 
selected from this search will automatically be linked to the selected diagnosis. 

Searching for a Curbside Consult 
Find a Curbside Consult document by searching the document Outline or by entering keywords into the 
Full Search or a user-defined Short Search. 

To search by outline: 
1. Click the Outline button on the toolbar to display the entire Curbside Consult database in outline 

form. Documents are arranged alphabetically.  

2. Click the plus sign next to any document title to expand the tree and reveal a node labeled 
Search Keywords.  

Search Keywords lists words that are linked to this document, which, when typed into the Search 
field, will return this document in the search results.  

To search by keyword: 
1. Determine whether to search the full database (by clicking the Full toolbar button) or only your 

pre-defined list of favorite documents (by clicking Short).  

Note:  If a Short List search is initiated and no matches are found, the search automatically 
converts to a full database search. 

2. Determine whether the search will look for items that Begin With the letters typed into the search 
field, that Contain those letters, or that are an Exact Match. Mark your preference by clicking one 
of the three buttons in the second horizontal toolbar, located after the words Search By. 

3. Type your search criteria in the Keywords field.  

Search Hints: 

○ The search utilizes the words in the official title of each document in addition to the linked 
keywords.  

○ Do not include non-descriptive words (i.e. "the") and conjunctions (i.e. "and") in the search.  
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○ Full words are not necessary; typing the first few letters of a word is adequate and lessens the 
chances of spelling errors.  

○ The search is case-insensitive, meaning there is no need to capitalize any word.  

○ If more than one word is entered, separate each with a space. For example, to search for 
"acute bronchitis", enter the search criteria "acu bronc."  

○ When listing more than one word (or group of letters), the order of the words does not matter. 
For example, in the search just described, "acu bronc" would return the same search result as 
"bronc acu."  

○ In multiple-word searches, the default search mode returns only those results that contain all 
of the words.  

○ To search for entries that match any (rather than all) of the keywords, change the Search 
Criteria (in the second horizontal toolbar) from And to Or.  

4. To perform the search, press Enter or click Search. Previous search criteria are saved in the 
keyword drop-down list and can be cleared by clicking Clear Dropdown. 

To view documents: 
1. Find the desired document by performing an Outline or Keyword Search.  

2. Highlight the title of the document and then click View on the toolbar.  

OR 

Right-click the title and select View Document. Although the View window allows editing and 
printing of documents, edits are not saved.  

3. Close the View window by clicking either the X in the upper right corner, or the Exit button (with 
the open door icon). 

Add a Curbside Consult to Your "Short List" 
Get quicker results and greater precision by searching only your pre-defined list of favorite documents, 
rather than the full database. (Perform this type of search by clicking Short on the toolbar.)  

• To add an individual document to your favorites list, simply click the check box located to the left 
of the document title in the tree.  

• To remove a document from your favorites list, clear the same box. 

Edit a Curbside Consult 
To make minor changes to an e-MDs’ source document, the easiest solution is to edit a source document 
rather than to add a custom document (which involves creation of a new document from scratch).  

Note:  Source documents are not actually alterable. Instead, an editable copy of a document is 
spawned. The original source document will remain in the database, along with the edited copy. The 
edited version appears as a new document in the tree, flagged with a yellow book icon, distinguishing it 
from e-MDs’ source documents, which are noted by blue books. 

To edit a source document: 
1. Highlight the source document and either click Copy on the toolbar, or right-click and select 

Create Copy of Document. The copied document will automatically be titled the same as the 
original followed by the addition of ".1".  

2. If desired, change the document title in the pop-up window and press either the Tab or Enter key. 
The new title cannot be exactly the same as that of the source document.  
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Note:  "Title" refers to the document’s database title, as it appears in the outline. The "title" or 
header that appears on the Curbside Consult itself is unaffected by changing the database title. 

Selecting a title opens a word processor window containing the original document. Typical word 
processor functionality, such as various fonts, styles, colors, formatting, and highlighting is 
available.  

3. Make document changes as desired.  

4. When finished, save the document by clicking the Save button (with the floppy disk icon) or by 
going to File > Save and Exit. 

5. To delete the new document before it has been entered into the database, click the Delete button 
(with the red X) within the word processor window. 

The new title of the edited document will automatically be parsed into the keyword list. To add additional 
search keywords, see the “Add and Delete Search Keywords” section. The edited version of the source 
document is now considered to be a Custom Document.  

Add a Search Keyword to a Curbside Consult 
Although some keywords have already been linked to each document, additional words may be added, if 
needed, to improve search results. Click the plus sign next to a document title to expand the tree and 
reveal a node labeled Search Keywords. Click the plus sign next to this node to display all words currently 
linked to this document. 

To add a keyword: 
1. Highlight and right-click Search Keywords.  

2. Select Add Linked Keywords.  

3. In the pop-up window that appears, enter your new keywords. If more than one word is added, 
separate words with a space.  

4. Press either the Enter or Tab key to save the new keyword(s). 

When linking the same set of keywords to multiple documents, simplify the task by creating a Keyword 
Copy List.  

To create a Keyword Copy List: 
1. Right-click any keyword and choose the Keyword Copylist Operations > Add Selected 

Keyword(s) to List.  

2. Add multiple keywords to the list by holding down the Control key and then clicking any two 
keywords, which will highlight the entire group of keywords residing in the tree between the two 
selected words. 

OR 

Hold down the Shift key and click multiple, noncontiguous keywords.  

3. After a group of keywords is highlighted, right-click and select Keyword Copylist Operations > 
Add Selected Keyword(s) to List.  

4. Insert this copy list elsewhere by right-clicking the Search Keywords node of another document 
and selecting Keyword Copylist Operations > Insert Copylist > Insert All Items. 

When a new document is added to the database, its title will automatically be parsed into the keyword list. 
However, if that title is edited at any point, the new words will not automatically be added. At that point, 
simplify the task of adding the new keywords by right-clicking the title and selecting the menu option 
labeled Parse Title into Keyword List. 
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To remove an individual keyword: 
1. Select and right-click the keyword.  

2. Select Remove Keyword Link. 

Add, Edit and Delete Curbside Consult Documents 
Custom documents will appear in the tree with a yellow book icon, distinguishing them from e-MDs’ 
source documents, which are noted by blue books. The title of the document will automatically be parsed 
into the keyword list when the custom document is created. To add additional search keywords, see the 
“Add and Delete Search Keywords” section. 

To add a custom Curbside Consult document: 
1. Click the Add button on the toolbar.  

Note:  Documents cannot be added from the Search screen. If the Add button is disabled, first 
click Outline. 

OR 

Right-click any document title in the outline and select Add Document.  

2. Enter the new document’s title in the pop-up window that appears (limited to 100 characters), and 
press either the Tab or Enter key.  

Note:  The title cannot match that of any existing titles in the database. 

Selecting a title will open the word processor window. Typical word processor functionality, such 
as various fonts, styles, colors, formatting, and highlighting is available. 

3. Create the document by typing into the word processor, pasting text from another source, or 
loading an electronic document from another location (that is, click File > Load, browse for the 
desired text (.txt) or rich text (.rtf) document, and click Open).  

4. When finished, save the document by clicking the Save button (with the floppy disk icon) or by 
going to File > Save and Exit. 

To edit the title of a custom Curbside Consult document: 
1. Right-click the document title and select Edit Title. Titles have a 100-character limit in length.  

Note:  This changes only the database title of the document, and does not affect the title that 
appears on the printed Patient Education handout.  Titles of e-MDs’ source documents, which are 
identified by blue book icons, cannot be edited.  

2. Save the document by clicking the Save button (with the floppy disk icon) or by clicking File > 
Save and Exit. 

To edit the content of a custom Curbside Consult document: 
1. Highlight the document title and either click Edit on the toolbar, or right-click and select Edit 

Document. 

2. Make your changes in the word processor window.  

3. When finished, save the document by clicking the Save button (with the floppy disk icon) or by 
going to File > Save and Exit. 

To delete a custom Curbside Consult document: 
Highlight the document title and either click Delete on the toolbar, or right-click and select Delete 
Document.  
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e-MDs’ source documents, that are identified by blue book icons, cannot be deleted.  

Note:  Any edits made in the View window will not be saved. Use the word processor via the steps 
outlined above, rather than the View window, for editing. 

Locating Drug Education Documentation 
Drug Education documents can be found in several locations: 

In References:  
Click Reference on the main e-MDs Chart toolbar, and select the Drug Education menu option. 

In the Plan section of a Visit or Order Note, linked to a diagnosis:  
1. Under a diagnosis header in Plan, click Patient Education Handouts and then select Drug 

Education to see a list of documents linked to that diagnosis.  

2. Click Add Drug Ed to launch the full Drug Education Search.  

Note that any Drug Education document selected from this search will automatically be linked to 
the selected diagnosis. 

In the Plan section of a Visit or Order Note, unlinked to any diagnoses:  
To launch the Drug Education Search without linking a document to an ICD code, click the Other 
Patient Education Handouts section of Plan and then click Drug Education. 

Searching for a Drug Education Document 
Find a Drug Education document by searching the document Outline or by entering keywords into the Full 
Search or a user-defined Short Search. 

To search by outline: 
1. Click the Outline button on the toolbar to display the entire Drug Education database in outline 

form. Documents are arranged alphabetically.  

2. Click the plus sign next to any document title to expand the tree and reveal two nodes, labeled 
Translations and Search Keywords.  

3. Click Translations to view the document’s Spanish equivalent. Click Search Keywords to list 
words that are linked to this document, which, when typed into the Search field, will return this 
document in the search results.  

To search by keyword: 
1. Determine whether to search the full database (by clicking the Full toolbar button) or only your 

pre-defined list of favorite documents (by clicking Short).  

Note:  If a Short List search is initiated and no matches are found, the search automatically 
converts to a full database search. 

2. Determine whether the search will look for items that Begin With the letters typed into the search 
field, that Contain those letters, or that are an Exact Match. Mark your preference by clicking one 
of the three buttons in the second horizontal toolbar, located after the words Search By. 

3. Type your search criteria in the Keywords field.  

Search Hints: 

○ The search utilizes the words in the official title of each document in addition to the linked 
keywords.  
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○ Do not include non-descriptive words (i.e. "the") and conjunctions (i.e. "and") in the search.  

○ Full words are not necessary; typing the first few letters of a word is adequate and lessens the 
chances of spelling errors.  

○ The search is case-insensitive, meaning there is no need to capitalize any word.  

○ If more than one word is entered, separate each with a space. For example, to search for 
"acute bronchitis", enter the search criteria "acu bronc."  

○ When listing more than one word (or group of letters), the order of the words does not matter. 
For example, in the search just described, "acu bronc" would return the same search result as 
"bronc acu."  

○ In multiple-word searches, the default search mode returns only those results that contain all 
of the words.  

○ To search for entries that match any (rather than all) of the keywords, change the Search 
Criteria (in the second horizontal toolbar) from And to Or.  

4. To perform the search, press Enter or click Search. Previous search criteria are saved in the 
keyword drop-down list and can be cleared by clicking Clear Dropdown. 

To view documents: 
1. Find the desired document by performing an Outline or Keyword Search.  

2. Highlight the title of the document and then click View on the toolbar.  

OR 

Right-click the title and select View Document.  

Although the View window allows editing and printing of documents, edits are not saved.  

3. Close the View window by clicking either the X in the upper right corner or the Exit button (with 
the open door icon). 

Finding Spanish Translations of Drug Education Documents 
Most documents in the Drug Education module include a Spanish translation. Spanish handouts are 
linked to their English counterparts. The keyword search, however, does not include any Spanish terms.  

To find Spanish translations of Drug Education documents: 
1. Locate the desired document in English (see the “Search for a Drug Education Document” 

section).  

2. Click the plus sign next to the English-titled document to expand the tree and reveal the 
Translations node.  

3. Click the plus sign next to this node to display the Spanish document title.  

The content of the Spanish documents is essentially identical to their English equivalents. If desired, 
Spanish keywords can be linked to any document if you plan to perform document searches in 
Spanish (see the “Add Keywords” section).  

Adding a Drug Education Document to Your "Short List" 
Get quicker results and greater precision by searching only your predefined list of favorite documents, 
rather than the full database. (Perform this type of search by clicking Short on the toolbar.)  

• To add an individual document to your favorites list, simply click the check box located to the left 
of the document title in the tree.  

• To remove a document from your favorites list, clear the same box. 
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Note:  Because Spanish educational handouts are linked to their corresponding English documents in 
the tree, individual Spanish documents cannot be added to the short list. Instead, add the English 
document to the favorites list, which will, in effect, also add the associated Spanish translation. 

Editing a Drug Education Document 
To make minor changes to an e-MDs’ source document, the easiest solution is to edit a source document 
rather than to add a custom document (which involves creation of a new document from scratch).  

Note:  Source documents are not actually alterable. Instead, an editable copy of a document is 
spawned. The original source document will remain in the database, along with the edited copy. The 
edited version appears as a new document in the tree, flagged with a yellow book icon, distinguishing it 
from e-MDs’ source documents, which are noted by blue books. 

The new title of the edited document will automatically be parsed into the keyword list. To add additional 
search keywords, see the “Add a Search Keyword?" section. The edited version of the source document 
is now considered to be a Custom Document.  

To edit a source document: 
1. Highlight the source document and either click Copy on the toolbar or right-click and select 

Create Copy of Document.  

The copied document will automatically be titled the same as the original followed by the addition 
of ".1".  

2. If desired, change the document title in the pop-up window and press either the Tab or Enter key. 
The new title cannot be exactly the same as that of the source document.  

Note:  "Title" refers to the document’s database title, as it appears in the outline. The "title" or 
header that appears on the printed Drug Education handout is unaffected by changing the 
database title.  

Selecting a title opens a word processor window containing the original document. Typical word 
processor functionality, such as various fonts, styles, colors, formatting, and highlighting is 
available.  

3. Make changes as desired.  

4. Save the document by clicking the Save button (with the floppy disk icon) or by clicking File > 
Save and Exit. 

5. To delete the new document before it has been entered into the database, click the Delete button 
(with the red X) within the word processor window. 

Adding a Search Keyword to a Drug Education Document 
Although some keywords have already been linked to each document, additional words may be added, if 
needed, to improve search results. Click the plus sign next to a document title to expand the tree and 
reveal a node labeled Search Keywords. Click the plus sign next to this node to display all words currently 
linked to this document. 

To add a keyword: 
1. Highlight and right-click Search Keywords.  

2. Select Add Linked Keywords.  

3. In the pop-up window that appears, enter your keywords. If more than one word is added, 
separate words with a space.  

4. Press either the Enter or Tab key to save the new keyword(s). 
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When linking the same set of keywords to multiple documents, simplify the task by creating a Keyword 
Copy List.  

To create a Keyword Copy List: 
1. Right-click any keyword and select Keyword Copylist Operations > Add Selected Keyword(s) 

to List.  

2. Add multiple keywords to the list by holding down the Control key and then clicking any two 
keywords, which will highlight the entire group of keywords residing in the tree between the two 
selected words.  

OR 

Hold down the Shift key and click multiple, noncontiguous keywords.  

3. After a group of keywords is highlighted, right-click and select Keyword Copylist Operations > 
Add Selected Keyword(s) to List.  

4. Insert this copy list elsewhere by right-clicking the Search Keywords node of another document.  

5. Select the Keyword Copylist Operations > Insert Copylist > Insert All Items menu options. 

When a new document is added to the database, its title will automatically be parsed into the keyword list. 
However, if that title is edited at any point, the new words will not automatically be added. At that point, 
simplify the task of adding the new keywords by right-clicking the title and selecting the menu option 
labeled Parse Title into Keyword List. 

To remove an individual keyword: 
1. Select and right-click the keyword. 

2. Select Remove Keyword Link. 

Adding New Drug Education Documents 

To add a custom Drug Education document: 
1. Click the Add button on the toolbar.  

Note:  Documents cannot be added from the Search screen. If the Add button is disabled, first 
click Outline. 

OR 

Right-click any document title in the outline and select Add Document.  

2. Enter the new document’s title in the pop-up window (limited to 100 characters), and press either 
the Tab or Enter key.  

Note:  The title cannot match that of any existing titles in the database. 

Selecting a title will open the word processor window. Typical word processor functionality, such 
as various fonts, styles, colors, formatting, and highlighting is available. 

3. Create the document by typing into the word processor, pasting text from another source, or 
loading an electronic document from another location (that is, click File > Load, browse for the 
desired text (.txt) or rich text (.rtf) document, and click Open).  

4. Save the document by clicking the Save button (with the floppy disk icon) or by clicking File > 
Save and Exit. 

Custom documents will appear in the tree with a yellow book icon, distinguishing them from e-MDs’ 
source documents, which are noted by blue books. The title of the document will automatically be 



 

e-MDs Solution Series Chart User Guide 8.0 R01 421 

parsed into the keyword list. To add additional search keywords, see the “Add a Search Keyword” 
section. 

To edit the title of a custom document: 
1. Right-click the document title and select Edit Title. Titles have a 100-character limit in length.  

Note:  This changes only the database title of the document, and does not affect the title that 
appears on the printed Drug Education handout. 

Titles of e-MDs’ source documents, which are identified by blue book icons, cannot be edited.  

2. Save the document by clicking the Save button (with the floppy disk icon) or by clicking File > 
Save and Exit. 

To edit the content of a custom document: 
1. Highlight the document title and either click Edit on the toolbar, or right-click and select Edit 

Document.  

2. Make your changes in the word processor window.  

3. Save the document by clicking the Save button (with the floppy disk icon) or by clicking File > 
Save and Exit. 

To delete a custom document: 
Highlight the document title and either click Delete on the toolbar, or right-click and select Delete 
Document.  

e-MDs’ source documents, which are identified by blue book icons, cannot be deleted.  

Note:  Any edits made in the View window will not be saved. Use the word processor via the steps 
outlined above, rather than the View window, for editing. 

Locating Patient Instructions 
Patient Instructions are used in e-MDs schedule to inform patients about preparing for appointments.  A 
default patient instruction is provided with the system but users can add their own or edit the provided 
one. See “Add New Patient Instructions Documents” for details. 

Currently the Patient Instructions Document Editor can only be accessed from within the Code Linker 
module. 

To access the patient instructions document editor: 
1. Open the Code Linker by clicking Tools on the main Chart toolbar and selecting Code Linker. 

2. Log in to Code Linker using the same login name and password as Chart. 

3. In the Code Linker window, click the text along the left side of the window labeled Patient Ins.  

4. The Document Maintenance - Patient Instructions window will open. 

Searching for a Patient Instructions Document 
Find a Patient Instructions document by searching the document Outline or by entering keywords into the 
Full Search or a user-defined Short Search. 

To search by outline: 
1. Click the Outline button on the toolbar to display the entire Patient Instructions database in 

outline form.  Documents are arranged alphabetically.   
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2. Click the plus sign next to any document title to expand the tree and reveal two nodes, labeled 
Translations and Search Keywords.   

3. Click Translations to view the document’s Spanish equivalent.  Click Search Keywords to list 
words that are linked to this document, which, when typed into the search field, will return this 
document in the search results.   

To search by keyword: 
1. Determine whether to search the full database (by clicking the Full toolbar button) or only your 

pre-defined list of favorite documents (by clicking Short).   

Note:  If a Short List search is initiated and no matches are found, the search automatically 
converts to a full database search. 

2. Determine whether the search will look for items that Begin With the letters typed into the search 
field, that Contain those letters, or that are an Exact Match.  Mark your preference by clicking one 
of the three buttons in the second horizontal toolbar, located after the words Search By. 

3. Type your search criteria in the Keywords field.   

Search Hints: 

○ The search utilizes the words in the official title of each document in addition to the linked 
keywords.   

○ Do not include non-descriptive words (i.e. “the”) and conjunctions (i.e. “and”) in the search.   

○ Full words are not necessary; typing the first few letters of a word is adequate and lessens the 
chances of spelling errors.   

○ The search is case-insensitive, meaning there is no need to capitalize any word.   

○ If more than one word is entered, separate each with a space.  For example, to search for 
“acute bronchitis”, enter the search criteria “acu bronc.”   

○ When listing more than one word (or group of letters), the order of the words does not matter.  
For example, in the search just described, “acu bronc” would return the same search result as 
“bronc acu.”   

○ In multiple-word searches, the default search mode returns only those results that contain all 
of the words.   

○ To search for entries that match any (rather than all) of the keywords, change the Search 
Criteria (in the second horizontal toolbar) from And to Or.   

4. To perform the search, press Enter or click Search.  Previous search criteria are saved in the 
keyword drop-down list and can be cleared by clicking Clear Dropdown. 

To view documents: 
1. Locate the desired document by performing an Outline or Keyword Search.   

2. Highlight the title of the document and then click View on the toolbar.   

OR 

Right-click the title and select View Document.   

Although the View window allows editing and printing of documents, edits are not saved.   

3. Close the View window by clicking either the X in the upper right corner or the Exit button (with 
the open door icon). 



 

e-MDs Solution Series Chart User Guide 8.0 R01 423 

Finding Spanish Translations of Patient Instructions Documents 
Documents in the Patient Instructions module can include a Spanish translation.  Spanish instructions can 
be linked to their English counterparts.   

To find Spanish translations of patient instructions documents: 
1. Locate the desired document in English (see the “Search for a Patient Instructions Document” 

section).   

2. Click the plus sign next to the English-titled document to expand the tree and reveal the 
Translations node.   

3. Click the plus sign next to this node to display the Spanish document title.   

If desired, Spanish keywords can be linked to any document if you plan to perform document 
searches in Spanish (see the “Add a Search Keyword to a Patient Instructions Document” 
section).   

Adding a Patient Instructions Document to Your Short List 
Get quicker results and greater precision by searching only your predefined list of favorite documents, 
rather than the full database. (Perform this type of search by clicking Short on the toolbar.)   

• To add an individual document to your favorites list, click the check box located to the left of the 
document title in the tree.   

• To remove a document from your favorites list, clear the same box. 

Note:  Because Spanish patient instructions are linked to their corresponding English documents in the 
tree, individual Spanish documents cannot be added to the short list.  Instead, add the English document 
to the favorites list, which will, in effect, also add the associated Spanish translation. 

Editing a Patient Instructions Document 
To make minor changes to an e-MDs’ source document, the easiest solution is to edit a source document 
rather than to add a custom document (which involves creation of a new document from scratch).   

Note:  Source documents are not actually alterable.  Instead, an editable copy of a document is 
spawned.  The original source document will remain in the database, along with the edited copy.  The 
edited version appears as a new document in the tree, flagged with a yellow book icon, distinguishing it 
from e-MDs’ source documents, which are noted by blue books. 

The new title of the edited document will automatically be parsed into the keyword list.  To add additional 
search keywords, see the "Add a Search Keyword to a Patient Instructions Document" section. The 
edited version of the source document is now considered to be a Custom Document.   

To edit a Patient Instructions source document: 
1. Highlight the source document and either click Copy on the toolbar or right-click and select 

Create Copy of Document.   

The copied document will automatically be titled the same as the original followed by the addition 
of “.1”.   

2. If desired, change the title in the pop-up window and press either the Tab or Enter key.   

The new title cannot be exactly the same as that of the source document.   

Note:  “Title” refers to the document’s database title, as it appears in the outline.  The “title” or 
header that appears on the printed Patient Instructions Document is unaffected by changing the 
database title. 



 

e-MDs Solution Series Chart User Guide 8.0 R01 424 

3. Selecting a title opens a word processor window containing the original document.  Typical word 
processor functionality, such as various fonts, styles, colors, formatting, and highlighting is 
available.  Make changes as desired.   

4. Save the document by clicking the Save button (with the floppy disk icon) or by clicking File > 
Save and Exit. 

5. To delete the new document before it has been entered into the database, click the Delete button 
(with the red X) within the word processor window. 

Adding a Search Keyword to a Patient Instructions Document 
Although some keywords may have already been linked to each document, additional words may be 
added, if needed, to improve search results.  Click the plus sign next to a document title to expand the 
tree and reveal a node labeled Search Keywords.  Click the plus sign next to this node to display all 
words currently linked to this document. 

To add a keyword: 
1. Highlight and right-click Search Keywords.   

2. Select Add Linked Keywords.   

3. In the pop-up window that appears, type your keywords.  If more than one word is added, 
separate words with a space.   

4. Press either the Enter or Tab key to save the new keyword(s). 

When linking the same set of keywords to multiple documents, simplify the task by creating a Keyword 
Copy List.   

To create a Keyword Copy List: 
1. Right-click any keyword and select Keyword Copylist Operations > Add Selected Keyword(s) 

to List.   

2. Add multiple keywords to the list by holding down the Control key and then clicking any two 
keywords, which will highlight the entire group of keywords residing in the tree between the two 
selected words.   

OR 

Hold down the Shift key and click multiple, noncontiguous keywords.   

3. After a group of keywords is highlighted, right-click and select Keyword Copylist Operations > 
Add Selected Keyword(s) to List.   

4. Insert this copy list elsewhere by right-clicking the Search Keywords node of another document.   

5. Select the Keyword Copylist Operations > Insert Copylist > Insert All Items menu options. 

When a new document is added to the database, its title will automatically be parsed into the keyword list.  
However, if that title is edited at any point, the new words will not automatically be added.  At that point, 
simplify the task of adding the new keywords by right-clicking the title and selecting the menu option 
labeled Parse Title into Keyword List. 

To remove an individual keyword: 
1. Select and right-click the keyword.   

2. Select Remove Keyword Link. 
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Adding a New Patient Instructions Document 

To add a new patient Instructions custom document: 
1. Click the Add button on the toolbar.   

Note:  Documents cannot be added from the Search screen.  If the Add button is disabled, first 
click Outline. 

OR 

Right-click any document title in the outline and select Add Document.     

2. Enter the new document’s title in the pop-up window (limited to 100 characters), and press either 
the Tab or Enter key.   

Note:  The title cannot match that of any existing titles in the database.   

Selecting a title will open the word processor window.  Typical word processor functionality, such 
as various fonts, styles, colors, formatting, and highlighting is available. 

3. Create the document by typing into the word processor, pasting text from another source, or 
loading an electronic document from another location (that is click File > Load, browse for the 
desired text (.txt) or rich text (.rtf) document, and click Open).   

4. Save the document by clicking the Save button (with the floppy disk icon) or by clicking File > 
Save and Exit. 

Custom documents will appear in the tree with a yellow book icon, distinguishing them from e-MDs’ 
source documents, which are noted by blue books.  The title of the document will automatically be parsed 
into the keyword list.  To add additional search keywords, see the Add a Search Keyword section. 

To edit the title of a custom document: 
1. Right-click the document title and select Edit Title.  Titles have a 100-character limit in length.   

Note:  This changes only the database title of the document, and does not affect the title that 
appears on the printed Drug Education handout.)  Titles of e-MDs’ source documents, which are 
identified by blue book icons, cannot be edited.   

2. Save the document by clicking the Save button (with the floppy disc icon) or by clicking File > 
Save and Exit. 

To edit the content of a custom document: 
1. Highlight the document title and either click Edit on the toolbar, or right-click and select Edit 

Document.   

2. Make your changes in the word processor window.  

3. Save the document by clicking the Save button (with the floppy disk icon) or by clicking File > 
Save and Exit. 

To delete a custom document: 
Highlight the document title and either click Delete on the toolbar, or right-click and select Delete 
Document .  

e-MDs’ source documents, which are identified by blue book icons, cannot be deleted.   

Any edits made in the View window will not be saved.  Use the word processor via the steps outlined 
above, rather than the View window, for editing. 
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add problem to current list, 110 
add procedure note to visit, 72 
add provider fax contact, 18 
add providers to Show Providers list, 214 
add refill request from DocMan, 228 
add request in refill module, 216 
add request in refill module from DocMan, 217 
add requests for multiple providers, 218 
add search keyword (ICD-9), 389 
add speech recognition-generated text, 48 
add vitals outside Visit or Order Note, 66 
add vitals to Visit or Order Note, 67 
add, edit or delete history items, 128 
add, modify or discontinue drugs, 207 
alphabetize differentials, 80 
chaange FlowSheet field sequence, 321 
change a facility (DOQ-IT), 380 
change a provider in refill request, 226 
change a Quick Launch template, 266 
change diagnosis code, 75 
change differential diagnosis, 81 
change FlowSheet field display order, 314 
change list of risk factors sequence, 242 
change Medical History item sequence, 240 
change opening text, 278 
change screen font size, 25 
choose refill denial reason, 121 
choose stop allergy reason, 117 
choose Stop Medication reason, 125 
close a past template, 268 
close a patient's chart, 21 
close all open charts, 22 
copy a rule, 366 
copy and edit images, 406 
copy existing prescription, 178 
copy patient account, 19 
co-sign individual unsigned notes, 339 
create a keyword copy list, 406 

create a Keyword Copy List, 396, 420, 424 
create a Keyword Copy List (HCPCS), 401 
create a pre-clicked template, 267 
create a referral/consult letter, 139 
create a single patient (DOQ-IT), 381 
create a specialty rule subset, 367 
create custom list of resources, 286 
create Fast Form, 34 
create field outside a FlowSheet, 331 
create file for eligible patients (DOQ-IT), 381 
create Keyword Copy List, 415 
create keyword copy list (ICD-9), 389 
create Keyword Copy List (Patient Education), 411 
create new data element, 331 
create new OB visit note, 251 
create new OB Visit or Order Note, 252 
create new prescription, 178 
create new refill denial reason, 121 
create new rule, 358, 365 
create new stop allergy reason, 117 
create new Stop Medication reason, 125 
create Quick Pick list, 201 
create report for eligible patients (DOQ-IT), 382 
create report for single patient (DOQ-IT), 381 
create thumbnail view of Fast Forms, 37 
create user preferences for adding Health Summary, 42 
customize Deny a Refill Reason screen, 122 
customize order of differentials, 80 
customize Stop Allergy Reason screeen, 118 
customize Stop Medication Reason screen, 125 
customize Superbill comment, 235 
delee current problem list, 62 
delete a category, 325 
delete a custom document, 412, 421, 425 
delete a diagnosis, 73, 82 
delete a FlowSheet, 324 
delete a Log/Phone/Rx Note, 135 
delete a prescription, 86 
delete a problem, 112 
delete a refill request, 227 
delete a reminder, 29 
delete a rule, 366 
delete allergies from Visit or Order Note, 64 
delete alternate description (ICD-9), 389 
delete an alternate description, 395 
delete an item from a template, 274 
delete category (ICD-9), 390 
delete code created by user, 391 
delete codes from cached CPT, 93 
delete current medications, 65 
delete custom Curbside Consult document, 416 
delete data from a FlowSheet, 315 
delete documented past pregnancies, 244 
delete Fast Form, 36 
delete FlowSheet data element, 327 
delete immunization log from Visit or Order Note, 63 
delete incorrectly linked order, 88 
delete linked differential diagnosis, 79 
delete medical history, 61 
delete order from a note, 88 
delete patient-specific FlowSheet, 311 
delete pending Fast Form, 39 
delete Quick Pick, 201 
delete user-added drug in database, 202 
delete user-created category, 402 
delete user-created CPT code, 397 
delete user-created HCPCS codes, 403 
deny prescription refill, 120 
deny unlinked refill request, 223 
designate patient as multi-racial, 17 
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discontinue a medication from Refill Grid, 124 
display Superbill, 102 
document an OB procedure, 238 
document lab results, 65 
document past pregnancies, 243 
document physical exams, 71 
document pregnancy outcome, 245 
document test results, 65 
document the HPI, 58 
document the plan, 84 
document the ROS, 58 
drop cached CPT CODE into note, 93 
edit a FlowSheet, 319 
edit a FlowSheet category, 325 
edit a FlowSheet field, 323 
edit a Log/Phone/Rx Note, 134 
edit a pre-clicked template, 268 
edit a prescription, 86 
edit a refill request, 226 
edit a rule, 366 
edit a source document, 414 
edit a source drug education document, 419 
edit a specialty rule subset, 367 
edit allergies in Visit or Order Note, 64 
edit alternate description (ICD-9), 389 
edit an alternate description, 395 
edit code created by user, 391 
edit content of a custom document, 421, 425 
edit content of custom Curbside Consult document, 416 
edit contents of custom document, 412 
edit CPT numerical range, 397 
edit current medication, 123 
edit current medications, 65 
edit current problems, 62 
edit description of a category (ICD-9), 390 
edit description of category (HCPCS), 402 
edit description of CPT category, 397 
edit diagnosis description, 74 
edit diagnosis properties, 74 
edit documented past pregnancies, 244 
edit existing rule, 365 
edit Fast Form, 35 
edit fields in patient-specific FlowSheet, 314 
edit FlowSheet data element, 327 
edit FlowSheet details, 319 
edit FlowSheet field, 334 
edit immunization log, 63 
edit medical history, 61 
edit numerical range (HCPCS), 402 
edit numerical range (ICD-9), 390 
edit or delete a note, 132 
edit or delete a referral/consult letter, 139 
edit or delete allergy or adverse reaction, 115 
edit or delete free text from templates, 47 
edit or delete patient account, 17 
edit or delete vitals, 67 
edit order description, 90 
edit order properties, 88 
edit patient education source documents, 411 
edit patient instructions source document, 423 
edit patient's FlowSheet, 311 
edit problem properties, 111 
edit reminders, 29 
edit title of a custom document, 421 
edit title of Curbside Consult document, 416 
edit title of custom document, 412, 425 
edit unsigned note, 108, 338 
edit user-added drug in database, 202 
edit user-created CPT code, 397 
edit user-created HCPCS codes, 403 

edit/insert sig window, 199 
enter lab/test/procedure results, 137 
extract lab results from a FlowSheet, 274 
find generic templates, 269 
find Spanish translation of education documents, 410 
find Spanish translations of drug education documents, 

418 
find Spanish translatons of patient instruction documents, 

423 
flush template cache, 280 
for rules, order lab or test, 32 
graph data in a FlowSheet, 316 
import list from Medication History, 207 
import medication list from DocMan, 206 
include or exclude sections in Clinical (Visit) Summary, 

107 
insert addendum to a Signed Off Note, 133 
link data element to Master Lab Code, 327 
link unlinked refill request, 219 
link unmatched labs, 306 
load past visit, 54 
load shortcut visit, 55 
locate curbside consults documentation, 413 
locate drug education documentation, 417 
locate medical art, 404 
locate patient education documentation, 407 
log in/out of Dashboard, 6 
make a rule specialty specific, 367 
mark a dirty room as clean, 288 
mark chart as NKM, 119 
mark existing request as unfinished, 228 
mark field as visible or invisible, 313 
mark items as Contact Patient, 303 
mark items as Default (Lab Tracking), 304 
mark new request as unfinished, 227 
mark order as Hold for Review, 305 
mark order as Ready for Provider, 303 
mark Visit or Order Note as NKDA, 113 
merge data elements, 328 
move a patient to a room, 288 
move a patient to waiting room, 288 
move diagnosis to first position, 76 
move education handout to different diagnosis, 101 
move order to different diagnosis, 91 
move patient to different room, 288 
move prescription to different diagnosis, 86 
move reminder to Old Reminders folder, 29 
navigate between templates, 271 
open a past template, 268 
open Fast Form Processor, 36 
open multiple patient charts, 21 
open new Visit or Order Note, 51 
open patient chart, 21 
open the FlowSheet Editor, 318 
paste text into a chart, 47 
permanently remove Confidential status, 277 
pick existing data element, 331 
pick new data element, 332 
plot past points, 70 
print a FlowSheet, 317 
print a FlowSheet graph, 317 
print and fax visit items, 105 
print Fast Form template, 38 
print or fax referral/consult letter, 140 
process a CPT code, 275 
process an ICD code, 275 
record additional vitals, 68 
recover resolved problem, 110 
refill past meds from Refill Grid, 183 
refill prescription from current meds list, 180 
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refill prescription from Visit or Order Note, 181 
refill prescription in refill module, 225 
refill prescriptions, 120 
refill with changes/notes, 182 
refresh note, 61, 62 
register a facility (DOQ-IT), 380 
remove a FlowSheet field, 323 
remove a problem from chart, 57 
remove an individual keyword, 396, 407, 424 
remove education handout from Visit or Order Note, 101 
remove fields from patient-specific FlowSheet, 313 
remove individual keyword, 412, 416 
remove individual keyword (HCPCS), 402 
remove individual keyword (ICD-9), 389 
remove individual keywords, 420 
remove order from Order Tracking, 305 
remove some template text from a note, 278 
remove template from note, 278 
remove unmatched labs, 306 
remove Visit or Order Notes from unsigned notes, 340 
reopen template to make changes, 278 
resend/reprint a prescription, 126 
resolve a diagnosis, 112 
review ambiguous answers, 37 
review Health Summary, 113 
review icons meaning, 194 
review Visit or Order Note, 340 
rule-based reminders, take no action, 33 
rules, document refusal/deferral/waiver, 33 
rules, reset reminder, 34 
run rules automatically, 368 
run rules manually, 368 
scan completed Fast Form, 39 
scan Fast Form template, 38 
search by keyword (ICD-9), 385, 393 
search by outline (ICD-9), 385 
search for a drug, 173 
search for curbside consult documents, 413 
search for drug education documents, 417 
search for HCPCS codes, 398 
search for patient education documents, 409 
search for patient instruction documents, 421 
search for patients, 10 
search for single patient (DOQ-IT), 382 
search online resource through Dashboard, 9 
search, filter all patients (DOQ-IT), 383 
search, filter by name (DOQ-IT), 383 
searching by outline (ICD-9), 393 
searching for CPT codes, 392 
select a facility (Tracking Board), 284 
select resources (Tracking Board), 286 
separate nested template text, 272 
set a Quick Launch template, 265 
set bolded text in a template, 278 
set confidential items, 276 
set Dashboard applications and preferences, 7 
set exclusions (DOQ-IT), 383 
set Health Summary options, 46 
set Health Summary report print options, 46 
set priority level on request, 227 
set up a provider list, 213 
set up default HIPAA settings, 215 
set up display refill list, 215 
set up printer, 36 
set up refill module short name, 215 
set up refill refresh rate, 215 
set up temporary Fast Forms file, 36 
set user preference options (Tracking Board), 285 
set user preferences for pop-up reminders, 103 
set user preferences in vitals, 66 

show hidden Health Summary information, 24 
sign off a Log/Phone/Rx Note, 135 
sign off individual unsigned notes, 338 
sign off multiple unsigned notes, 338 
sign off multi-select unsigned notes, 339 
sign off Visit or Order Notes, 106 
specify registered facility (DOQ-IT), 382 
stop a medication from current list, 124 
substitute more specific diagnosis, 82 
temporarily remove Confidential status, 277 
test Answer Set settings, 37 
turn off add a problem option, 111, 298 
turn on Detail View, 109 
turn on Detail View as default, 110 
unlink data element from Master Lab Code, 328 
update the EDD, 237 
use a CC template, 56 
use a pre-clicked template, 267 
use calendar to enter dates, 236 
use Dose Calculator, 197 
use Fast Form template in Visit or Order Note, 40 
use free text, 56 
use numeric keypad, 236 
use Phone-In Script module, 205 
use Spanish education handouts, 101 
validate ambiguous answers, 37, 40 
view a document in Chart View, 140 
view all discontinued medications, 127 
view all med strengths and forms, 201 
view all notes in chronological order, 135 
view diagnoses, 137 
view documents (medical art), 405 
view drugs in same class, 201 
view full text of a note, 133 
view historial vitals, 67 
view history of single medication, 126 
view icon legend, 127 
view labs/tests/procedures, 136 
view legacy history after data conversion, 129 
view medications, 138 
view notes in a grid, 132 
view notes in a tree, 132 
view or hide non-drug allergies, 116 
view outline text of a note, 133 
view patient education documents, 410 
view patient instruction documents, 422 
view patient-specific FlowSheet in Chart, 309 
view patient-specific FlowSheet in DocMan, 309 
view prior Log/Phone/Rx Notes, 134 
view resolved problems, 110 
view summary of a note, 133 
write and fax prescripiton with Script Writer, 185 
write new prescription from current meds list, 174 
write new prescription from template, 176 
write new prescription from Visit or Order Note, 176 
write new script outside Visit or Order Note, 119 
write prescription from template, 85 
write prescription linked to diagnosis, 84 
write prescription without linked diagnosis, 85 

Radiology Order Forms, 102 
Registry 

Based on rules, 356 
scanning Fast Forms, 38 
Search Bar, 8 
SureScripts, 185 
transmitting prescriptions electronically, 185 
Troubleshooter, 4 
UpToDate database, 8 
Visit and Order Notes, 41, 63, 257 
Visit Notes, 26 
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Visit or Order Notes, 62, 64 
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